VOLUME 1

Preface

Preface ............................................................... i

Chapter 1

Introduction ......................................................... 1 – 1
Human Resource Management .................................. 1 – 2
  Separate v. Integrated HRMS Systems ................. 1 – 3
  Human Resources and Payroll Activity Cycles ......... 1 – 4
Introduction to the HRMS Model ......................... 1 – 6
Managing Change Over Time ................................... 1 – 9
  Dated Information and Hierarchy Versions .......... 1 – 10
  DateTrack ......................................................... 1 – 10
  Setting Your Effective Date ............................... 1 – 11
    To set your effective date: ............................ 1 – 11
  Viewing Datetracked Information and History ....... 1 – 13
    To view DateTrack History: ............................ 1 – 13
  Updating and Correcting Datetracked Information .... 1 – 14
  Deleting Datetracked Information ...................... 1 – 15
    To remove an end date: ................................. 1 – 16
Work Structures and Key Flexfields ....................... 1 – 17

Chapter 2

The Employer and Other Organizations ...................... 2 – 1
Site Locations ..................................................... 2 – 2
Setting Up Site Locations ........................................ 2 – 2
   To enter a work location and its address: .................. 2 – 3
   To remove an address from the Location list: .......... 2 – 3
Representing the Employer: The Business Group ...... 2 – 4
   Key Flexfields for the Business Group ............... 2 – 4
   Single or Multiple Business Groups .................... 2 – 6
   Defaults for the Business Group ......................... 2 – 7
Representing the Employer: GREs .......................... 2 – 9
   Enterprises with One GRE ................................ 2 – 10
   Enterprises with Multiple GREs ......................... 2 – 10
   GREs and Tax Groups ...................................... 2 – 12
Representing Organizations ................................... 2 – 14
   Levels of Internal Organizations ....................... 2 – 14
   Internal Organizations and Cost Centers ............. 2 – 16
   External Organizations ................................... 2 – 17
Employer and Organization Setup ........................ 2 – 18
   Accessing Business Groups ............................... 2 – 18
       To define a “view–all” responsibility: ............. 2 – 18
Creating an Organization ....................................... 2 – 20
   To create a new organization: ............................ 2 – 22
   To enter additional information: .......................... 2 – 24
Additional Information for Business Groups .......... 2 – 24
   To enter basic, required information for the Business Group: .... 2 – 24
   To enter defaults for human resource budget values: .... 2 – 24
   To enter defaults for work day start and end times: ... 2 – 24
   To register Reporting Categories and Statuses: ....... 2 – 24
   To enter training default values for Oracle Training Administration: ........ 2 – 24
Additional Information for GREs ...................... 2 – 25
   To enter the unique IRS identification number (EIN): .... 2 – 25
   To enter data for EEO, VETS and New Hire reporting: .... 2 – 25
   To enter tax rules: ......................................... 2 – 25
   To enter data for wage and tax reporting: ............ 2 – 25
   To enter data for NACHA tapes: .......................... 2 – 25
Additional Information for HR Organizations .......... 2 – 25
   To enter cost codes for collection of costing information: .... 2 – 25
   To place the organization in hierarchies: .............. 2 – 25
   To enter default work day start and end times: ......... 2 – 25
   To enter a default work schedule: ....................... 2 – 26
Additional Information for Reporting Establishments .... 2 – 26
   To enter filing data for EEO and VETS reports: ....... 2 – 26
   To place Reporting Establishments in hierarchies: .... 2 – 26
To enter filing data for Multiple Worksite reports: 2 – 26
Additional Information for AAP Organizations 2 – 26
To enter the AAP the organization represents. 2 – 26
To place AAP Organizations in hierarchies: 2 – 26
Entering Business Group Information 2 – 26
To enter Business Group information: 2 – 26
Business Groups: Entering Budget Value Defaults 2 – 27
To define budget value defaults: 2 – 28
Business Groups and HR Organizations: Work Day Defaults 2 – 28
To define work day defaults: 2 – 29
GREs: Entering the IRS Identification Number 2 – 30
To enter the unique identification number for the GRE: 2 – 30
HR Organizations: Entering Costing Information 2 – 30
To enter costing information: 2 – 30
HR Organizations: Entering Parent Organizations 2 – 31
To enter a parent organization: 2 – 31
HR Organizations: Entering a Work Schedule 2 – 31
To select a work schedule for an HR Organization: 2 – 32
Deleting an Organization 2 – 33
Organization Hierarchies 2 – 34
Multiple Hierarchies 2 – 35
Organizational Change and Version Control 2 – 36
Creating Organization Hierarchies 2 – 37
To set up a new organization hierarchy: 2 – 37
To create a new version of an existing hierarchy: 2 – 38
To copy an existing hierarchy: 2 – 38
Changing Organization Hierarchies 2 – 39
Deleting Organization Hierarchies 2 – 39
Organization Hierarchy Report 2 – 39
To run the Organization Hierarchy Report: 2 – 39

Chapter 3

Jobs and Positions 3 – 1
Representing Jobs and Positions 3 – 2
Position Reporting Structures 3 – 3
Deciding How to Use Organizations, Jobs, and Positions 3 – 4
Job and Position Names 3 – 5
Adding Information About Jobs and Positions 3 – 6
Defining Jobs 3 – 8
To define a job: 3 – 8
Defining Positions 3 – 11
To define a position: 3 – 11
Evaluating Jobs and Positions ................................. 3 – 14
Setting Up an Evaluation System ............................ 3 – 14
To set up an evaluation system: ............................ 3 – 14
Entering Evaluation Information ............................. 3 – 15
To enter a job or position evaluation: ...................... 3 – 15
Valid Grades .................................................. 3 – 16
To enter valid grades: ...................................... 3 – 16
Entering Job and Position Requirements .................... 3 – 17
To enter job or position requirements: ..................... 3 – 17
Entering Work Choices for a Job or Position ................ 3 – 18
To enter work choices for a job or position: ............... 3 – 18
Viewing Position Occupancy ............................... 3 – 20
To view occupants of a position: ......................... 3 – 20
To see further details of occupants or applicants: ........ 3 – 20
Creating Position Hierarchies .............................. 3 – 21
To create a new position hierarchy: ....................... 3 – 21
To create a new version of an existing hierarchy: ........ 3 – 22
To copy an existing hierarchy: ............................ 3 – 23
Changing Position Hierarchies ............................ 3 – 23
Deleting Position Hierarchies ............................ 3 – 23
Position Hierarchy Report ................................ 3 – 24
To run the Position Hierarchy Report: .................... 3 – 24
Making Mass Updates ...................................... 3 – 25
Preparing for Your Mass Move .............................. 3 – 26
Performing Mass Move Tasks ............................... 3 – 28
Describing Your Mass Move ................................ 3 – 28
To describe your mass move: .............................. 3 – 28
Identifying Your Source Positions ....................... 3 – 29
To identify your source positions: ....................... 3 – 29
Identifying Your Target Positions ....................... 3 – 30
To identify your target positions: ....................... 3 – 30
Verifying Transferring Assignments for Each Source Position 3 – 31
To verify transferring assignments for each source position: 3 – 31
Verifying or Adding Valid Grades for Each Target Position 3 – 33
Executing the Mass Move ................................ 3 – 33
Reviewing the Mass Move ................................ 3 – 34
To review the mass move: ................................ 3 – 34
Resolving Problems and Reexecuting a Mass Move .... 3 – 34
To reexecute a mass move: ................................ 3 – 35
Managing Your Mass Move Collection .................... 3 – 35
<table>
<thead>
<tr>
<th>Chapter 6</th>
<th>HRMS Implementations and Enterprise Culture</th>
<th>6 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project Based Enterprises</td>
<td>6 – 2</td>
<td></td>
</tr>
<tr>
<td>Rule Based Enterprises</td>
<td>6 – 6</td>
<td></td>
</tr>
<tr>
<td>Hybrid Enterprise Structures</td>
<td>6 – 10</td>
<td></td>
</tr>
<tr>
<td>Contract Staff and Other Non-standard Assignments</td>
<td>6 – 12</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 7</th>
<th>Elements: Foundation of Compensation and Benefits</th>
<th>7 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Elements</td>
<td>7 – 2</td>
<td></td>
</tr>
<tr>
<td>The Structure of Elements</td>
<td>7 – 3</td>
<td></td>
</tr>
<tr>
<td>Creation of Elements: Definition or Initiation</td>
<td>7 – 4</td>
<td></td>
</tr>
<tr>
<td>Using Elements</td>
<td>7 – 6</td>
<td></td>
</tr>
<tr>
<td>Element Classifications and Categories</td>
<td>7 – 8</td>
<td></td>
</tr>
<tr>
<td>Survey of the Classifications</td>
<td>7 – 10</td>
<td></td>
</tr>
<tr>
<td>Classifications and Payroll Run Processing Priorities</td>
<td>7 – 14</td>
<td></td>
</tr>
<tr>
<td>Element Input Values</td>
<td>7 – 16</td>
<td></td>
</tr>
<tr>
<td>Validation for Input Value Entries</td>
<td>7 – 16</td>
<td></td>
</tr>
<tr>
<td>Default Entries for Input Values</td>
<td>7 – 17</td>
<td></td>
</tr>
<tr>
<td>Pay Values and Payroll Run Processing</td>
<td>7 – 19</td>
<td></td>
</tr>
<tr>
<td>Elements and Formulas</td>
<td>7 – 21</td>
<td></td>
</tr>
<tr>
<td>Oracle FastFormula</td>
<td>7 – 21</td>
<td></td>
</tr>
<tr>
<td>Element Processing Types</td>
<td>7 – 23</td>
<td></td>
</tr>
<tr>
<td>Element Links and Employee Eligibility Rules</td>
<td>7 – 25</td>
<td></td>
</tr>
<tr>
<td>Element Entries for Eligible Employees</td>
<td>7 – 27</td>
<td></td>
</tr>
<tr>
<td>Manual Element Entry for Individual Employees</td>
<td>7 – 27</td>
<td></td>
</tr>
<tr>
<td>Automatic Entry of Elements and Default Values</td>
<td>7 – 27</td>
<td></td>
</tr>
<tr>
<td>Batch Element Entry Using MIX Facilities</td>
<td>7 – 29</td>
<td></td>
</tr>
<tr>
<td>Entry as an Indirect Result of Payroll Processing</td>
<td>7 – 29</td>
<td></td>
</tr>
<tr>
<td>Element Definition</td>
<td>7 – 31</td>
<td></td>
</tr>
<tr>
<td>Defining an Element to Hold Information</td>
<td>7 – 32</td>
<td></td>
</tr>
<tr>
<td>To identify and classify the element:</td>
<td>7 – 33</td>
<td></td>
</tr>
<tr>
<td>To enter processing information:</td>
<td>7 – 33</td>
<td></td>
</tr>
<tr>
<td>To establish currencies and qualifying conditions:</td>
<td>7 – 34</td>
<td></td>
</tr>
<tr>
<td>To enter a category and benefits carrier</td>
<td>7 – 34</td>
<td></td>
</tr>
<tr>
<td>To set up input values for the element:</td>
<td>7 – 35</td>
<td></td>
</tr>
<tr>
<td>To enter an element–level default for an input value:</td>
<td>7 – 35</td>
<td></td>
</tr>
<tr>
<td>To establish validation for input value entries:</td>
<td>7 – 35</td>
<td></td>
</tr>
<tr>
<td>Deleting an Element Entry</td>
<td>7 – 35</td>
<td></td>
</tr>
<tr>
<td>To delete an element entry:</td>
<td>7 – 35</td>
<td></td>
</tr>
<tr>
<td>Deleting an Element</td>
<td>7 – 36</td>
<td></td>
</tr>
<tr>
<td>To delete an element:</td>
<td>7 – 36</td>
<td></td>
</tr>
<tr>
<td>Chapter 10</td>
<td>Benefits Administration .............................................. 10 – 1</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>Benefits Administration Overview ................................... 10 – 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benefits Classifications ............................................. 10 – 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benefits Enrollment .................................................. 10 – 3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation of Elements for Benefits ..................................... 10 – 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Initiation of Benefit Deductions with Oracle Payroll ................. 10 – 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Definition of Benefit Elements at Sites with HR Only ............... 10 – 6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Benefits Table Entries for Health Care Plans ......................... 10 – 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Defining Benefit Plan Elements at Sites with HR Only ............... 10 – 8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To identify and classify the element: ................................ 10 – 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To enter processing information: ................................... 10 – 9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To establish currencies and qualifying conditions: .................... 10 – 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To identify the benefit carrier and contribution frequency: ........... 10 – 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To determine the units of input values created for the element: ...... 10 – 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To create additional input values for the element: .................... 10 – 10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To enter a default for an additional input value: ...................... 10 – 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To set up validation for entries to additional input values: ........... 10 – 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establishing Plan Coverage and Default Contributions ................ 10 – 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To enter plan coverage levels and contribution amounts: .............. 10 – 12</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enrolling Employees in a Health Care Benefit Plan .................... 10 – 13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To enroll an employee in a benefit plan: ............................ 10 – 13</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reviewing Employee Enrollment in Benefit Plans ...................... 10 – 14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reports on Health Care Plan Eligibility and Enrollment .............. 10 – 14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To run the Eligibility Listing or Enrollment Register: ............... 10 – 14</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Establishing Benefit Coverage for Dependents ......................... 10 – 15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To establish benefit coverage for a dependent: ....................... 10 – 15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stopping Employee and Dependent Coverage .......................... 10 – 16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stopping Dependent Coverage Only ................................... 10 – 16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To stop dependent coverage: ...................................... 10 – 16</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recording Beneficiaries for Benefits .................................. 10 – 18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To record a beneficiary for a benefit: ................................ 10 – 18</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Removing Beneficiaries When Employee Benefits Stop ................ 10 – 19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Removing Beneficiaries When Employee Benefits Continue .......... 10 – 19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To remove a beneficiary while maintaining coverage: ................. 10 – 19</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management of COBRA–Eligible Benefits .............................. 10 – 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Employer Responsibilities under COBRA .............................. 10 – 20</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Administering COBRA .................................................. 10 – 21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recording Qualifying Events .......................................... 10 – 21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To record a qualifying event and its date: ............................ 10 – 21</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Changing Coverage Statuses ......................................... 10 – 22</td>
<td></td>
<td></td>
</tr>
<tr>
<td>To make changes to the status of COBRA coverage: ................... 10 – 22</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Setting Up Continued Coverage under COBRA ............... 10 – 30
To set up continued coverage under COBRA ............... 10 – 30
Establishing a Payments Schedule and Recording Receipts .. 10 – 31
To schedule premium payments and record receipts: ........ 10 – 31
Obtaining COBRA Reports and Standard Letters ............. 10 – 32
To run the COBRA Coverage or Payments report: ........... 10 – 32
To obtain a COBRA standard letter: ......................... 10 – 32

Chapter 11

Labor Costs ......................................................... 11 – 1
Labor Costs in Oracle HRMS ...................................... 11 – 2
The Oracle HRMS Cost Allocation Key Flexfield .............. 11 – 2
Use of the Cost Allocation Key Flexfield ....................... 11 – 5
Costing Data at the Payroll Level ............................ 11 – 6
Costing Data at the Element Link Level ....................... 11 – 7
Costing Data at the Organization and Assignment Levels ... 11 – 9
Costing Data at the Element Entry Level ..................... 11 – 10
Setting Up the Cost Allocation Key Flexfield ................. 11 – 11
Controlling the Display of Flexfield Segments ................. 11 – 11
Costing for Taxes .................................................. 11 – 14
Costing All Taxes by Tax Type .................................. 11 – 15
Costing State and Local Taxes by Jurisdiction ............... 11 – 15
Accumulation and Transfer of Payroll Costs .................. 11 – 17
Example of Labor Cost Allocation ............................ 11 – 18
Example of Employer Charge Distribution .................... 11 – 19
Running the Costing Processes ............................. 11 – 22
To run the Costing process: .................................. 11 – 22
Reviewing Costing Process Results ........................... 11 – 22
To run a Cost Breakdown Summary report: ................... 11 – 23
Transferring Costs to Oracle General Ledger ................. 11 – 24
To map Cost Allocation to Accounting flexfield segments: 11 – 24
To run the Transfer to GL process: ......................... 11 – 25

Chapter 12

Human Resource Budgets ......................................... 12 – 1
Human Resource Budgets ........................................ 12 – 2
Entering Actual Values Against Budgets ....................... 12 – 2
To override the default for an assignment: .................. 12 – 3
Setting Up Budgets ............................................. 12 – 3
To set up a human resource budget: ......................... 12 – 3
Salary Review Report .......................................... 12 – 4
To run the Salary Review Report: ......................... 12 – 4
Salary Budgeting .................................................. 12 – 5
Reviewing and Renaming Period Types ...................... 12 – 6
Defining Calendars ................................................. 12 – 7
   To define a budgetary calendar: ................................. 12 – 7
Defining Human Resource Budgets ............................. 12 – 8
   To define a budget: ................................................. 12 – 8
Viewing and Reporting Budget Variances .................... 12 – 9
List Position Budget Variance .................................. 12 – 9
   To view position variances within a hierarchy: ............ 12 – 9
List Budget Variance by Organization .......................... 12 – 10
   To view position variances within an organization: ...... 12 – 10
Staffing Budget Details Report ................................. 12 – 11
   To run the Staffing Budget Details report: ................... 12 – 11

Chapter 13  

Personal Information ............................................. 13 – 1
Displaying Personal Information ................................. 13 – 2
Using the Find Person Window .................................. 13 – 2
   To query a person using the Find Person window: ........ 13 – 2
People Folders ....................................................... 13 – 3
Entering Personal Information ................................... 13 – 4
Entering New People ................................................ 13 – 5
   To enter a new person: .............................................. 13 – 5
   To enter employment information for an employee: ...... 13 – 6
   To enter office location information for a new hire or an existing employee: ................................. 13 – 8
   To enter information for an applicant: ....................... 13 – 8
   To enter information concerning the background check for an employee: ....................................... 13 – 8
   To enter rehire recommendation information for an applicant who was a former employee: ....................... 13 – 8
   To enter further name information: ............................. 13 – 8
   To enter medical information for an employee: ............ 13 – 9
   To enter other information for a person: ..................... 13 – 9
Hiring ................................................................. 13 – 10
   To hire an employee: ............................................. 13 – 10
   To hire an applicant: ............................................... 13 – 10
   To rehire an ex–employee: ....................................... 13 – 10
   To cancel a hire: .................................................... 13 – 10
Entering People’s Addresses at Sites without Oracle Payroll .... 13 – 11
   To enter a generic address: ..................................... 13 – 11
Entering People’s Addresses at Sites with Oracle Payroll .... 13 – 12
To enter a US or Canadian address with full validation: 13 – 13
Adding a City for Addresses 13 – 14
Adding Telephone Information 13 – 15
To enter a telephone number: 13 – 15
Entering Pictures 13 – 16
To enter a person’s picture in Oracle HRMS: 13 – 16
Entering Dependents, Beneficiaries and Other Contacts 13 – 16
To enter a contact: 13 – 17
Competence Profiles, Qualifications, School Attendances
and Work Choices 13 – 19
Creating a Competence Profile 13 – 20
To create a competence profile: 13 – 20
To copy competencies from requirements: 13 – 21
To update a competence profile: 13 – 21
Entering Work Choices 13 – 21
To enter work choices for a person: 13 – 22
Entering Qualifications 13 – 23
To enter qualifications: 13 – 23
To enter tuition fees for reimbursement: 13 – 23
To enter training details: 13 – 24
To enter license details: 13 – 24
To enter subjects: 13 – 24
Entering Schools and Colleges Attended 13 – 24
To enter schools and colleges attended: 13 – 25
Entering Special Information 13 – 26
To enter special information for a person: 13 – 27
Listing People by Special Information 13 – 28
To list people by special information: 13 – 28
Tracking People’s Roles and Activities 13 – 30
Full Personal Details Report Set 13 – 31
To run the Full Personal Details report set: 13 – 31
New Hire Reporting 13 – 32
Setup Steps for New Hire Reporting 13 – 33
To set up for New Hire reporting: 13 – 33
Entering a New Hire Report Contact for a GRE 13 – 33
To enter a GRE’s contact person for new hire reporting: 13 – 34
Entering New Hire Report Data for Current Employees 13 – 34
To enter New Hire reporting data for current employees: 13 – 34
Obtaining New Hire Reports 13 – 35
To run a New Hire report for a GRE and state: 13 – 35
Deleting a Person from the System 13 – 37
To delete all records of a person: 13 – 37
Chapter 14

Employment Information .................................. 14 – 1
Managing Employment Information .................. 14 – 2
The Employee Assignment ................................. 14 – 4
Components of the Assignment .......................... 14 – 5
Using Multiple Assignments .............................. 14 – 6
Identifying Employees and Assignments ............... 14 – 7
Entering a New Assignment ............................... 14 – 9

To enter a new assignment: .............................. 14 – 9
To enter information in the window GREs and Other Data: ................................. 14 – 10
Changing Assignment Information ..................... 14 – 14
To change a primary assignment: ........................ 14 – 15
Ending an Assignment .................................. 14 – 16
To end one of many assignments: ..................... 14 – 16
Ending Employment ...................................... 14 – 17
To terminate an employee: ............................... 14 – 17
Cancelling a Termination ................................. 14 – 18
To cancel a termination: ................................. 14 – 18
To change the termination date: ......................... 14 – 18
Terminations Report ..................................... 14 – 19
To run the Terminations Report: ....................... 14 – 19

Additional Employment Information .................. 14 – 20
Entering Payment Methods for an Employee Assignment .......... 14 – 22
To enter a personal payment method for remuneration: ........ 14 – 23
To enter a third party payment method: .................. 14 – 24
Entering Secondary Assignment Statuses ................ 14 – 24
To give a secondary status to an assignment: ................ 14 – 25
Inquiring and Reporting on Employment Information .......... 14 – 26
Listing Assignments ..................................... 14 – 26
To produce lists of assignments: ......................... 14 – 28
Listing Employees by Organization .................... 14 – 29
To list employees in several organizations: ............... 14 – 29
To list employees in one organization only: ............ 14 – 29
Listing Employees by Position ......................... 14 – 31
To view employee names by position: .................. 14 – 31
To view lists of positions within a position hierarchy: ........ 14 – 32
Assignment Status Report .............................. 14 – 33
To run the Assignment Status Report: .................. 14 – 33
Employee Summary Report ............................ 14 – 34
To run the Employee Summary Report: ................ 14 – 34
Employee Movements Report ........................... 14 – 34
To run the Employee Organization Movements Report: ....... 14 – 34
To run the Employee Payroll Movements Report: 14 – 35
Assignment History 14 – 36
To view an employee’s assignment history: 14 – 36

Chapter 15

Recruitment 15 – 1
The Recruitment Cycle 15 – 2
Recruitment Preparation 15 – 4
Raising Requisitions for Vacancies 15 – 7
To create a requisition and vacancy: 15 – 7
Defining Recruitment Activities 15 – 8
To define recruitment activities: 15 – 8
Viewing Vacancies 15 – 9
To view vacancies: 15 – 9
Selection Processing 15 – 10
Making Quick Applicant Entries 15 – 11
To record an application quickly: 15 – 11
Entering Full Application Information 15 – 12
To enter an application: 15 – 13
Tracking Applicant Progress 15 – 15
Interviewing Applicants 15 – 17
To schedule applicant interviews: 15 – 17
Mass Update of Applicants 15 – 19
To update a group of applicant assignments: 15 – 19
Hiring Applicants 15 – 19
Ending Applications 15 – 21
To terminate an applicant: 15 – 21
Requisition Summary Report 15 – 22
To run the Requisition Summary Report: 15 – 22

Chapter 16

Overview of Government–Mandated HR Reporting 16 – 1
Government–Required HR Reporting 16 – 2
Reporting Categories and Statuses 16 – 3
Reporting Organizations 16 – 3
Establishment Hierarchies 16 – 4
Varieties of Establishment Hierarchies 16 – 6
The Single–Establishment Hierarchy 16 – 6
Multi–Establishment Hierarchies 16 – 7
The Headquarters Hierarchy 16 – 10
Preparing for Government–Mandated HR Reporting 16 – 12
Registering Reporting Categories and Statuses 16 – 13
Associating Jobs with AAP Reporting Information ............. 17 – 18
To associate jobs with AAP reporting information: ............. 17 – 19
Obtaining AAP Reports ............................................................ 17 – 19
To run the AAP–Workforce Analysis report: ....................... 17 – 19
To run the AAP–Job Group Analysis report: ....................... 17 – 20
VETS–100 Reporting .......................................................... 17 – 21
Data for VETS–100 Reports .............................................. 17 – 21
Setup Steps for VETS–100 Reporting ................................ 17 – 23
Entering VETS–100 Information for a GRE .................... 17 – 23
To enter information for a GRE for EEO reporting: .......... 17 – 24
Obtaining VETS–100 Reports .............................................. 17 – 25
To run a report for a single hiring location: ..................... 17 – 25
To run a headquarters report for multiple hiring locations: 17 – 26
To run reports for locations with 50 or more employees: .... 17 – 26
To run a listing of locations with less than 50 employees: .... 17 – 27
ADA (Americans with Disabilities Act) Reporting .......... 17 – 28
Information for ADA Reporting ........................................ 17 – 28
Setup Steps for ADA Reporting ....................................... 17 – 30
Registering Employees as Disabled ................................. 17 – 31
Entering Information about Disabilities ......................... 17 – 31
To enter information about a person’s disability type: ....... 17 – 31
Entering Requests for Disability Accommodation ........... 17 – 31
To enter information about accommodation requests: .... 17 – 32
Obtaining ADA Reports ................................................ 17 – 32
To run an ADA report: ......................................................... 17 – 32
OSHA (Occupational Safety and Health Act) Reporting .... 17 – 34
OSHA Data ................................................................. 17 – 34
Setup Steps for OSHA Reporting ................................. 17 – 36
Entering Information about Work–related Injury or Illness .. 17 – 36
To enter data on an OSHA–reportable incident: .......... 17 – 36
OSHA Categories of Illness ........................................ 17 – 37
Obtaining OSHA Reports ............................................... 17 – 38
To run OSHA Form 200 or Form 101 Reports: .............. 17 – 39

Index
Chapter 18  
Introducing Career Management Activities .......................... 18 – 1  
Advantages of the Common Competence Framework .... 18 – 2  
Career Management – A Fully Tailorable, Proactive  
Management Tool ..................................................... 18 – 3  
Web and Workflow Access (LMDA and EDA) ............. 18 – 4  
Which Activities are Available Using Windows,  
LMDA and EDA? .................................................... 18 – 5  
Configurable Web Interface ........................................ 18 – 7  
Defining Your Competence–Based Operation .............. 18 – 8  
Identifying Your Business Goals Before Implementing the  
Competence Approach .............................................. 18 – 9  
Defining Your Enterprises Competencies ................. 18 – 10  
Defining Your Competence Requirements ............ 18 – 10  
Designing Your Methods of Measurement .............. 18 – 11  
Assessments and Appraisals ..................................... 18 – 12  
Describing and Assessing Measurable Behavior .......... 18 – 13  
Identifying Qualifications and Delivering Competencies . 18 – 14  
Career and Succession Planning ............................... 18 – 14  
Career Management Extensible and User–Defined  
QuickCodes .............................................................. 18 – 15  
Understanding The Business Cycle ....................... 18 – 17

Chapter 19  
Designing Methods of Measurement and Creating Competencies .... 19 – 1  
What Are Competencies? ............................................ 19 – 2  
Competencies, Proficiency Levels and Indicators .... 19 – 2  
Structuring Your Competencies .............................. 19 – 4  
Which Method Should You Use? ............................ 19 – 6  
General Rating Scales ............................................. 19 – 7  
Different Rating Scales ............................................. 19 – 7  
Creating Rating Scales ............................................. 19 – 8  
To create rating scales: .................................. 19 – 8  
Competencies ......................................................... 19 – 10  
Creating Competencies ........................................ 19 – 11  
To create competencies: ................................ 19 – 11  
To Enter a Rating Scale ......................................... 19 – 11
### Chapter 20  Defining Competence Requirements  

- Competence Requirements ........................................ 20 – 1
- Why Define Competence Requirements? ......................... 20 – 2
- Can You Copy Competencies? ........................................ 20 – 3
- Defining Competence Requirements – Core or Generic Competencies ........................................ 20 – 4
- To define competence requirements (with core or generic competencies) ........................................ 20 – 5
- Copying Existing Competencies from an Organization, Job or Position ........................................ 20 – 6
  
  - Copying the competencies from an organization, job or position ........................................ 20 – 7
- Defining Competence Requirements – No Core Competencies ........................................ 20 – 8
  
  - To define competence requirements (no core competencies) ........................................ 20 – 9
- Viewing Competencies at Organization, Job or Position ........................................ 20 – 10
  
  - To view competencies held at organization, job or position level: ........................................ 20 – 10

### Chapter 21  Identifying Qualifications and Delivering Competencies  

- Identifying Qualifications and Delivering Competencies ........................................ 21 – 1
- Creating Qualification Types ........................................ 21 – 2
- Creating Schools and Colleges ........................................ 21 – 3
  
  - To create qualification types: ........................................ 21 – 4
  - To create establishments: ........................................ 21 – 5

### Chapter 22  Assessing and Appraising People  

- Assessing and Appraising People ........................................ 22 – 1
- Competence–Based Assessments ........................................ 22 – 2
- Why is Measurement Useful? ........................................ 22 – 3
- Templates for Different Assessments ........................................ 22 – 4
- What Type of Assessment do you Want to Perform? ........................................ 22 – 5
- Identifying Proficiency Levels in the Assessment Template ........................................ 22 – 6
- Identifying Competence Types and Competencies in the Assessment Template ........................................ 22 – 6
<table>
<thead>
<tr>
<th>Chapter 27 Administering Events and Attendance</th>
<th>27 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up Events</td>
<td>27 – 2</td>
</tr>
<tr>
<td>To create an event:</td>
<td>27 – 3</td>
</tr>
<tr>
<td>Managing Bookings and Attendance</td>
<td>27 – 3</td>
</tr>
<tr>
<td>Employee Reviews</td>
<td>27 – 4</td>
</tr>
<tr>
<td>Entering an Employee Review</td>
<td>27 – 4</td>
</tr>
<tr>
<td>To enter a review for an employee:</td>
<td>27 – 5</td>
</tr>
<tr>
<td>Entering Performance Ratings</td>
<td>27 – 5</td>
</tr>
<tr>
<td>To enter a performance rating:</td>
<td>27 – 6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 28 Setup for Personal and Assignment Information</th>
<th>28 – 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Types</td>
<td>28 – 2</td>
</tr>
<tr>
<td>Defining Person Types</td>
<td>28 – 3</td>
</tr>
<tr>
<td>To change a user name for a person type:</td>
<td>28 – 3</td>
</tr>
<tr>
<td>To map other user names to a person-type system name:</td>
<td>28 – 3</td>
</tr>
<tr>
<td>Person Types and Information Management</td>
<td>28 – 3</td>
</tr>
<tr>
<td>Assignment Statuses</td>
<td>28 – 5</td>
</tr>
<tr>
<td>Defining Assignment Statuses</td>
<td>28 – 7</td>
</tr>
<tr>
<td>To rename a user status:</td>
<td>28 – 7</td>
</tr>
<tr>
<td>To supply additional user statuses for a system status:</td>
<td>28 – 7</td>
</tr>
<tr>
<td>To create a secondary status:</td>
<td>28 – 8</td>
</tr>
<tr>
<td>Setup To Allow Processing After Termination</td>
<td>28 – 8</td>
</tr>
<tr>
<td>Defining Special Information Types</td>
<td>28 – 10</td>
</tr>
<tr>
<td>To set up Special Information Types:</td>
<td>28 – 10</td>
</tr>
<tr>
<td>Enabling Special Information Types</td>
<td>28 – 11</td>
</tr>
<tr>
<td>To enable Special Information Types:</td>
<td>28 – 11</td>
</tr>
</tbody>
</table>
Chapter 29  System Administration .............................. 29 – 1
The Role of the System Administrator ......................... 29 – 2
Setting User Profile Options ................................. 29 – 4
Enabling Currencies ............................................. 29 – 7
To enable a currency: ............................................. 29 – 7
To disable a currency: ............................................. 29 – 7

Chapter 30  Reports and Inquiries ................................. 30 – 1
Overview of Inquiry and Reporting Tools .................... 30 – 2
Inquiry Windows and Folders ................................. 30 – 3
Predefined and User Defined Reports ....................... 30 – 5
QuickPaint ....................................................... 30 – 8
Defining QuickPaint Reports ..................................... 30 – 9
To define a QuickPaint Report: ............................... 30 – 9
Running QuickPaint Reports .................................. 30 – 12
To run a report for one assignment: .......................... 30 – 12
To run a report for an assignment set: ....................... 30 – 13
Creating an Assignment Set .................................... 30 – 14
To define an assignment set using criteria for a formula: .. 30 – 14
To define a set by including or excluding assignments: .. 30 – 16
Custom Reports .................................................. 30 – 18
To submit a Custom Report: .................................... 30 – 18
To register a new Custom Report with parameters: .... 30 – 19

Chapter 31  Customizing Windows and Menus ................... 31 – 1
Adding New Fields to Windows ................................. 31 – 2
Restricting the Data Displayed in a Window ................. 31 – 3
Types of Data Restrictions ..................................... 31 – 4
Defining an Element or Distribution Set ..................... 31 – 5
To define an element or distribution set: ................... 31 – 6
Defining Customized Forms .................................... 31 – 7
To define a customized version of a form: ................. 31 – 7
Linking Windows in Task Flows ............................... 31 – 9
Windows You Can Use in Task Flows ..................... 31 – 10
Defining Task Flow Nodes ..................................... 31 – 12
To create a task flow node: .................................. 31 – 13
Defining Task Flows .......................................... 31 – 14
To define a task flow: ......................................... 31 – 15
To copy an existing task flow: ............................... 31 – 16
Linking the SQL*Plus Script With a Letter for MultiMate or WordPerfect

To define a standard letter type: .............................................. 33 – 18
Writing a Skeleton Letter ......................................................... 33 – 18
Requesting Letters for MultiMate or WordPerfect ....................... 33 – 19
To submit an automatic letter request: .................................... 33 – 20
To create a manual letter request: .......................................... 33 – 20
Merging the Data File With the Standard Letter MultiMate or WordPerfect .................................................. 33 – 21
Writing a SQL*Plus Script for Microsoft Word ......................... 33 – 23
To write a SQL*Plus script for Microsoft Word: ........................ 33 – 24
Generating a Microsoft Word Letter ........................................ 33 – 25
To generate and merge a Microsoft Word document: ................. 33 – 25
Using Oracle Reports ............................................................... 33 – 27
Planning the Content and Layout ............................................. 33 – 27
Writing the Report ................................................................. 33 – 28
Registering the Report .......................................................... 33 – 28
Linking the Report With a Letter ............................................. 33 – 28
To define a standard letter type: ............................................. 33 – 29
Running the Report .............................................................. 33 – 29
To submit an automatic letter request: .................................... 33 – 30
To create a manual letter request: .......................................... 33 – 30

Chapter 34

Security and Control ............................................................... 34 – 1
Security in Oracle HRMS ......................................................... 34 – 2
Access Control through User Responsibilities .......................... 34 – 2
Security Profiles ................................................................. 34 – 4
Database Access Without Online Access ................................. 34 – 8
Menu Structures ................................................................. 34 – 8
Security Groups ................................................................. 34 – 9
Setting Up Security in Oracle HRMS ....................................... 34 – 10
To set up a new responsibility for Oracle HRMS: ..................... 34 – 11
To set up a new reporting user: .............................................. 34 – 11
Defining Security Profiles ...................................................... 34 – 13
To define a security profile: .................................................. 34 – 13
Running the HRMS Security Processes .................................. 34 – 15

Chapter 35

Audit ................................................................. 35 – 1
AuditTrail ................................................................. 35 – 2
Setting Up AuditTrail ........................................... 35 – 2
To set up AuditTrail: ........................................... 35 – 2
Reporting on Audit Information ............................... 35 – 4
To run the predefined audit report: ......................... 35 – 5
Designing Your Own Audit Report ......................... 35 – 6

Appendix A

Default Menus .................................................. A − 1
Default Navigation Menus for HR with Payroll Responsibility A − 2
Windows and their Navigation Paths ......................... A − 10

Appendix B

Key and Descriptive Flexfields .............................. B − 1
User Definable Key Flexfields ............................... B − 2
User Definable Descriptive Flexfields ...................... B − 5
List of Descriptive Flexfields ............................... B − 6
Descriptive Flexfields with Startup Data ................. B − 9
Changing Address Styles ..................................... B − 9
Protected Flexfields ........................................... B − 10

Appendix C

Database Items .................................................. C − 1
Static Database Items ......................................... C − 2
Applicant Information ......................................... C − 2
Employee Assignment Information ....................... C − 2
Contact Addresses ............................................ C − 7
Contact Information ........................................... C − 8
Employee Hire Information ................................ C − 10
Location Details ............................................... C − 10
Payroll Details ................................................ C − 12
People Addresses ............................................. C − 13
People Information ............................................ C − 15
Recruiter Information ........................................ C − 17
Supervisor Information ...................................... C − 18
Date Information .............................................. C − 18
Dynamic Database Items ................................... C − 19
Element Database Items ..................................... C − 19
Grade Rate Database Items ................................. C − 22
Pay Scale Rate Database Items ............................ C − 22
Descriptive Flexfield Database Items .................... C − 23
Key Flexfield Database Items ............................... C − 25
Absence Database Items ..................................... C − 26
Appendix D

Template SQL*Plus Scripts ............................. D – 1
Template SQL*Plus PERWPOUK .......................... D – 2
Template SQL*Plus Script PERPWUK ..................... D – 6
OTA SQL*Plus Script to Produce Confirmation Letters ...... D – 8

Index
Preface


This guide includes the information you need to set up Oracle Human Resources to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies and people on the system and use this information to manage your payroll. It contains detailed information about the following:

- Overview and reference information
- Oracle Human Resources implementation suggestions
- Specific tasks you can accomplish using Oracle Human Resources
- How to use Oracle Human Resources forms and windows
- Oracle Human Resources programs, reports, and listings
- Oracle Human Resources functions and features

This preface explains how this user’s guide is organized and introduces other sources of information that can help you.
About This User’s Guide

The first part of this guide explains how you can set up Oracle Human Resources to represent your enterprise structures and policies, and how you relate these to the people in your system.

- Chapter 1 describes the requirements of human resource and payroll management, and the processes they involve. This provides the context for the information model you can construct in Oracle HRMS.
- Chapters 2 through 5 explain how to represent your enterprise structures, including organizations, jobs and positions, grades, and payrolls.
- Chapter 6 describes three models appropriate to three different types of enterprise. It covers the set up of each of these structures, explains how to set up the system to collect costing information during a payroll run.
- Chapters 7 through 9 explain how you can represent your compensation and benefit policies in the system and enter and report on compensation and benefit information for your employees.

Once you have set up this key information in the system, you can consider how to use Oracle Human Resources to help you with the main HR management tasks.

- Chapters 10 through 12 cover setting up and using salary administration, cost control and human resource budgets.
- Chapters 13 and 14 explain how you can enter people on the system, assign them to work structures, and hold various kinds of information about them. These chapters also introduce you to the basics of hiring, redeploying, and termination of employment.
- Chapters 15 through 25 cover the key management processes and how you might use Oracle HRMS to support them. These include:
  - Absence and attendance
  - Manpower planning and budgeting
  - Cost control
  - Recruitment
  - Training administration and other special information
Skills matching
Succession planning
Career planning
Job evaluation
Government Mandated HR Reporting

The final chapters of the guide focus on tasks for the system administrator and setup team.

- Chapter 28 explains how to set up person types and assignment statuses, and how to define special information types.
- Chapter 29 describes the role of the System Administrator.
- Chapters 30 and 31 explain how you can customize the way information is entered and extracted from the system. This includes:
  - customizing inquiry windows and writing reports
  - using batch input
  - customizing the user interface
  - adding your own fields to windows
- Chapter 32 explains how to set up QuickCodes and user tables to add lists and tables of valid values to the system.
- Chapters 33 through 35 look at how you can integrate Oracle Human Resources with Oracle Payroll, and use it with other software such as word processors and spreadsheets. These chapters also consider how you control security of access, set up security, and set up an audit trail.

The Appendixes provide a reference source about the default menus, and about flexfields and database items in Oracle HRMS. Appendix D provides a template SQL*Plus script for use with standard letters.

---

**Audience for this Guide**

This guide assumes you have a working knowledge of the following:

- the principles and customary practices of your business area
- Oracle Human Resources
If you have not yet used Oracle Human Resources we suggest you attend one or more of the training classes for this product available through Oracle Education.

- the Oracle Applications graphical user interface.

To learn more about this, read the *Oracle Applications User’s Guide*.

See Other Information Sources below for further details of Oracle Applications product information.

---

**Do Not Use Database Tools to Modify Oracle Applications Data**

Oracle provides powerful tools you can use to create, store, change, retrieve and maintain information in an Oracle database. But if you use Oracle tools like SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using an Oracle Applications form can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications forms, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications forms to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. But, if you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.

*Consequently, we STRONGLY RECOMMEND that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications tables, unless we tell you to do so in our manuals.*
Other Information Sources

You can choose from many sources of information, including documentation, training, and support services, to increase your knowledge and understanding of Oracle Human Resources.

Online Documentation

All Oracle Applications user’s guides are available online, in both HTML and Adobe Acrobat format. Most other Oracle Applications documentation is available in Adobe Acrobat format.

The paper and online versions of this manual have identical content, and you can use whichever format is more convenient.

The HTML version of this book is optimized for on–screen reading, and lets you follow hypertext links for easy access to books across our entire library. You can also search for words and phrases if your national language is supported by Oracle’s Information Navigator. The HTML documentation is available from the Oracle Applications toolbar, or from a URL provided by your system administrator. Note that the HTML documentation is translated into over twenty languages.

You can order an Oracle Applications Documentation Library CD containing Adobe Acrobat versions of each manual in the Oracle Applications documentation set. Using this CD, you can search for information, read it on–screen, and print individual pages, sections, or entire books. When you print from Adobe Acrobat, the resulting printouts look just like pages from an Oracle Applications hardcopy manual.

Most Oracle Applications documentation is available in Adobe Acrobat format on the Oracle Applications Documentation Library CD. We supply this CD with every software shipment.

If this guide refers you to other Oracle Applications documentation, use only the Release 11 versions of those books unless we specify otherwise.

Related User’s Guides

Oracle Human Resources shares business and setup information with other Oracle Applications products. Even if you have not installed them as separate products, your Oracle Human Resources application includes some forms and functionality from other Oracle Applications.
Therefore, you may want to refer to other user’s guides when you set up and use Oracle Human Resources.

If you do not have the hardcopy versions of these manuals, you can read them by choosing Library from the Help menu, or by reading from the Oracle Applications Document Library CD, or by using a web browser with a URL that your system administrator provides.

**Oracle Payroll User’s Guide**

This guide is aimed at Payroll managers and explains how to set up and use Oracle Payroll to pay your employees and meet necessary legislative requirements.

**Oracle Human Resources User’s Guide**

This guide is aimed at HR managers and explains how to set up and use Oracle Human Resources to meet the requirements of your enterprise. It describes how you can represent your enterprise structures, policies, and people on the system and use this information to manage your human resources.

**Oracle Training Administration User’s Guide**

This guide explains how you can use OTA with Oracle HR to support each part of your enterprise’s training cycle.

**Application Data Export User’s Guide**

This guide is aimed at end–users, system administrators and consultants. It describes how you can use ADE to export data from Oracle Human Resources into either a spreadsheet or mail merge application. It also contains information on how to install ADE.

**Oracle HRMS Implementation Guide**

This guide includes modular implementation flowcharts and checklists to assist with your project planning. It contains a summary of the sequence of recommended steps for implementing Oracle Human Resources and Oracle Payroll. Full instructions for each implementation step are contained in the User’s Guide.
Oracle Applications User’s Guide

This guide explains how to navigate, enter data, query, run reports, and introduces other basic features of the graphical user interface (GUI) available with this release of Oracle Applications. It also includes information on setting user profiles, as well as running and reviewing reports and concurrent requests.

You can access this guide online by choosing “Getting Started with Oracle Applications” from any Oracle Applications help file.

Oracle Applications Flexfields Guide

This guide provides flexfields planning, setup, and reference information for your implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This guide also provides information on creating custom reports on flexfields data.

Oracle Workflow Guide

This manual explains how to define new workflow business processes as well as customize existing Oracle Applications–embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow–enabled processes.

Oracle Alert User’s Guide

Use this manual to define periodic and event alerts that monitor the status of your Oracle Applications data.

Country–Specific Manuals

Use these manuals to meet statutory requirements and common business practices in your country or region. They also describe additional features added to Oracle Human Resources to meet those requirements. Look for a User’s Guide appropriate to your country. For example, Oracle user’s guides for Japanese users exist in the Japanese language.

Oracle Applications Implementation Wizard User’s Guide

If you are implementing more than one Oracle product, you can use the Oracle Applications Implementation Wizard to coordinate your setup activities. This guide describes how to use the wizard.
Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards. It also provides information to help you build your custom Developer/2000 forms so that they integrate with Oracle Applications.

Oracle Applications User Interface Standards
This manual contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms 4.5.

Installation and System Administration

Oracle Applications Installation Manual
This manual and the accompanying release notes provide information you need to successfully install Oracle Financials, Oracle Government Financials, Oracle Manufacturing, or Oracle Human Resources in your specific hardware and operating system software environment.

Oracle Applications Upgrade Manual
This manual explains how to prepare your Oracle Applications products for an upgrade. It also contains information on finishing the upgrade procedure for each product. Refer to this manual and the Oracle Applications Installation Manual when you plan to upgrade your products.

Oracle Applications System Administrator’s Guide
This manual provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage processing.

This manual contains database diagrams and a description of Oracle HRMS database tables, forms, reports, and programs. This information
helps you convert data from your existing applications, integrate Oracle HRMS with other non–Oracle applications, and write custom reports.

You can order a technical reference manual for any product you have licensed. Technical reference manuals are available in paper format only.

Other Information

Training
Oracle Education offers a complete set of training courses to help you and your staff master Oracle Applications. We can help you develop a training plan that provides thorough training for both your project team and your end users. We will work with you to organize courses appropriate to your job or area of responsibility.

Training professionals can show you how to plan your training throughout the implementation process so that the right amount of information is delivered to key people when they need it the most. You can attend courses at any one of our many Educational Centers, or you can arrange for our trainers to teach at your facility. In addition, we can tailor standard courses or develop custom courses to meet your needs.

Support
From on–site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Human Resources working for you. This team includes your Technical Representative, Account Manager, and Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle server, and your hardware and software environment.

Finding the Latest Information
For information about any new features that were not available when this user’s guide was printed, look at the What’s New? section on the main Help menu. This information is updated for each new release of Oracle Human Resources HTML Help.
About Oracle

Oracle develops and markets an integrated line of software products for database management, applications development, decision support, and office automation, as well as a complete family of financial, manufacturing, and human resource applications.

Oracle products are available for mainframes, minicomputers, personal computers, network computers, and personal digital assistants, allowing organizations to integrate different computers, different operating systems, different networks, and even different database management systems, into a single, unified computing and information resource.

Oracle offers its products, along with related consulting, education, and support services, in over 140 countries around the world. Oracle Corporation is the world’s leading supplier of software for information management, and is the world’s second largest software company.

Thank You

Thank you for using Oracle Human Resources and this user’s guide. We value your comments and feedback. At the end of this manual is a Reader’s Comment Form you can use to explain what you like or dislike about Oracle Human Resources or this user’s guide. Mail your comments to the following address or call us directly at (650) 506–7000.

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Or, send electronic mail to appsdoc@us.oracle.com.
Oracle Human Resource Management Systems is the family name for an integrated group of applications that support the management of people. This chapter reviews the business needs of human resource management and how they are met by Oracle HRMS. It provides an introduction to key components and special features of the system.
Human Resource Management

The term Human Resource Management owes much to the view that employees are an asset to be managed in the same way as other, non-human, assets.

When the emphasis is on Resource Management, then in the formal accounts of any enterprise, people appear only as costs. However, they can also be thought of as assets in the sense that they are a productive resource, requiring proper maintenance and renewal.

People Management

The management of people within any enterprise involves a complex and dynamic inter-relationship of management and personal skills. This complexity results in a unique set of structures and policies within each enterprise.

This unique identity is often referred to as the culture of the enterprise, and as the enterprise develops so does its unique culture.

Company Culture

The organizational structures of an enterprise, the ways in which its employees work, and its compensation policies all reflect its unique culture. This culture is also evident in more subtle ways, including enterprise policies on information sharing and decision making.

The cultural diversity of enterprises is reflected in their implementation and use of information systems. It is generally true that all companies need a human resource information system. However, the information they require, its structure, and the means by which they obtain it, produce a different system in every case.

Packaged systems solutions like Oracle HRMS provide a core system, which each enterprise customizes to meet its own needs. Customization involves the definition of special information requirements, structures, and processes. It also involves analysis of the working practices associated with day-to-day maintenance and use of the system.

Changing Role of Human Resource Management

Human resource management was originally an administrative and welfare role within an enterprise. This often included recruitment and record-keeping functions.

This role was primarily reactive in nature. Human Resources responded to the needs of both managers and employees, but did not anticipate them.
In the last few decades, human resource management has evolved and assumed a more proactive role. This reflects the recognition of the importance of managing people in the successful achievement of enterprise objectives.

The result now is that this function within many enterprises encompasses responsibilities that include a wide ranging spectrum of activities.

**Payroll Management**

In contrast, payroll management has traditionally been a function of the Finance Group in most enterprises. It has been responsible for the correct payment of employees in line with local and national legislation as well as company policy.

Often this has been a reactive and operational role in which payroll staff responded to the needs of both line managers and employees.

**Separate v. Integrated HRMS Systems**

Traditionally, Human Resources and Payroll groups have both been responsible for holding and managing human resource information – often in separate systems.

There is growing acknowledgement of the importance of complete, accurate, and timely information about the people within an enterprise. This has led to a greater demand for information derived from both Human Resources and Payroll sources.

Historically this was achieved by the development of *Interface* products, which allowed technical specialists to transfer data between the two systems.

Many systems attempt to simplify the transfer of data between two systems. Oracle HRMS is one of the first to provide a truly integrated system, which both functions can genuinely share. At the same time, it is flexible enough to be implemented for use in a human resources only or a payroll only environment. In each case you have access to the full range of functionality associated with human resources or payroll.
Human Resources and Payroll Activity Cycles

We can look at the range of human resource activities as an inter-related cycle of functions, as shown in Figure 1 – 1.

The payroll user is concerned with operational and legislative aspects, which introduce a number of external factors that the information system must deal with. These include legislative requirements, auditing requirements and payroll costing. We can look at the operational factors and the effects of the external factors as an interrelated cycle of functions, as shown in Figure 1 – 2.
Figure 1 – 2
The Payroll Cycle

- Define and Administer Payrolls
- Define and Maintain Organization Structures
- Set Objectives
- Define and Administer Earnings & Deductions
- Maintain Employee Records
- Process Payrolls
- Reconcile Payrolls
- Cost Payroll Transactions and Transfer to External Systems

- Legislation: Tax and Insurance
- Statutory Reporting
- Auditing
- Ad hoc Reporting
Introduction to the HRMS Model

With Oracle HRMS you can define your own human resource model to reflect your own enterprise structures and policies. This information model lets you record the personal, work, and pay information for all the people you want to hold and process.

The model is both flexible and adaptable. It is flexible, so that you can reflect the needs of different companies, or different groups within the same company. It is adaptable, so that you can easily change the basic model as your enterprise changes.

See: Managing Change Over Time: page 1 – 9

Figure 1 – 3
Modelling Human Resource Information

People

In Oracle HRMS, you can hold information about current and former employees, applicants, external contacts such as contractors, and employee contacts such as relatives and dependents.
In addition to standard information such as addresses, nationality, interview records, qualifications, and absence information, you can define any other special information you need to hold for people. For example, you can define what information to hold on medical history, previous employment, or outside interests.

See:
- Entering Personal Information: page 13 – 4
- Entering Special Information: page 13 – 26

**Work Structures**

Work structures represent the different ways in which employees can work within your enterprise. They provide the framework for defining the work assignments of your employees. They also enable you to manage the information about your enterprise that is independent of your employees.

The work structures include your internal organizations (such as departments or divisions), payrolls, jobs or positions, grading structures, and any special employee groupings that you use in your enterprise.

See:
- Representing the Employer: Business Groups: page 2 – 4
- Representing the Employer: GRES: page 2 – 9
- Representing Organizations: page 2 – 14
- Representing Jobs and Positions: page 3 – 2
- Representing Grade Structures: page 4 – 2
- Representing Payrolls: page 5 – 2
- Representing Other Employee Groups: page 5 – 10

**Compensation and Benefits**

In Oracle HRMS you can define your own types of compensation and benefits, and the business rules you want to apply to them. As you change policies, move people within your enterprise, and adjust their individual remuneration packages, the system maintains their compensation and benefit history.

For example, suppose you want to define a special type of payment and make this available only to employees who work at a particular location. In Oracle HRMS you use a compensation element to represent
the payment. You define the business rule as a link between the element and the specific location. Then when you assign employees to the location, they automatically become eligible for the payment.

See:
Overview of Elements: page 7 – 2
Using Elements: page 7 – 6
Grade Relationships to Compensation and Benefits: page 4 – 6
Salary Administration and Performance Reviews: page 9 – 2

Assignments

In Oracle HRMS, the assignment describes employees’ places within the enterprise: the organization for which they work, their role, grade, location, and so on. As you change the assignment information for an employee, you automatically build up his or her work history.

Your compensation eligibility rules link compensation and benefits to work structures, such as jobs or grades. The assignment places employees within the work structures of the enterprise. In this way, an employee’s assignment determines his or her eligibility for compensation and benefits.

You can use assignments to identify major employee groups within the enterprise for management, for reporting and costing, and for compensation and benefit planning and administration.

See: The Employee Assignment: page 14 – 4
Managing Change Over Time

A key requirement for any enterprise is the ability to manage change confidently and effectively. Typical enterprise changes include corporate restructuring, departmental reorganization, mergers and de-mergers of companies, centralization or decentralization of control and decision making, employee development and turnover.

In Oracle HRMS, you can change each of the major parts of your enterprise model without having to redefine the other parts.

Work Structures

You can attach dates to your work structures to manage different versions over time. You retain previous versions for historical information and you can create future-dated versions to prepare for reorganization in advance.

You can also set up in advance the business rules, including compensation and benefits, associated with the new structures. These become effective on the date you specify, avoiding a workload peak.

People, Assignments, and Compensation and Benefits

In contrast to work structures, which are simply dated, other key dynamic information in Oracle HRMS is datetracked. This includes information on employees, assignments, and compensation and benefits. DateTrack allows you to maintain a continuous history of the information over time.

When reviewing, entering, changing or deleting datetracked data, you can set an effective date in the past or future. The system uses only information in effect as of that date for whatever you do. When you make a change, you can choose whether it is a correction to the last update or a new update to be recorded in the history of the record. You can use DateTrack History to view a report of every update ever made to a record.

You can identify windows containing datetracked, rather than dated, information by the presence of a region labelled Effective Dates.
Dated Information and Hierarchy Versions

The information in Oracle HRMS about your locations, organizations, jobs, positions, grades, payrolls and other work structures is dated information. All dated information has From and To dates, that is, dates from and to which it is in effect in your enterprise. For example, when defining a position, you enter a date from which it starts. To close it down, you give it a date to which it remains valid.

Oracle HRMS does not permit you to assign employees to structures on dates earlier than their Date From, or later than their Date To. Similarly, the system protects you from building eligibility rules for compensation and benefits based on work structures that have not yet gone into effect, or are out of date.

**Suggestion:** Consider using a fixed date, such as 01–JAN–1901 as the start date for all your initial work structures. By choosing a date like this you can immediately identify all of your implementation definitions. You should use accurate dates for all subsequent definitions.

Dated Versions of Hierarchies

You can structure the organizations and positions you enter in Oracle HRMS into organization or position hierarchies that serve various purposes. Reporting hierarchies, for example, reflect reporting lines within your enterprise.

You maintain both dates and version numbers for these hierarchies, to keep a history of your hierarchies as they change over time.

To build a new version of a hierarchy, you can copy an existing one and make the necessary changes to it. When you save the new version the system automatically gives the previous version an end date.

DateTrack

All important dynamic information in Oracle HRMS is datetracked, including information about people, assignments, payrolls, and compensation and benefits.

You can enter datetracked information or make changes to it at any time. When you set an effective date for your work, DateTrack ensures that only information effective on that day is used for any processing, validation, and reporting you carry out. You can view a history of every change made to datetracked information.
Setting Your Effective Date

When you log on to Oracle HRMS, your effective date is always today’s date. To view information current at another date, or to make retrospective or future-dated changes, you need to change your effective date.

There is a **DateTrack:Date Security** user profile option, which determines whether you can change your effective date. Your system administrator sets this profile option. You can check its value on the Personal Profile Values window. There are four possible values:

- **All**: You can change to any other effective date.
- **Future**: You can change between today’s date and any future dates.
- **Past**: You can change between today’s date and any past dates.
- **Present**: You cannot change to a date other than today.

To set your effective date:

1. Save any outstanding information you have entered or changed, then choose the Alter Effective Date icon from the Toolbar. The Alter Effective Date window opens.
2. Enter a new effective date and choose OK.

   If your current window is a “top–level” window (one called directly from the Navigator), your new effective date remains in place until you reset it or exit Oracle HRMS. If your current window is not a top–level window, your new effective date only applies while you are working in the current window and any windows subsidiary to it. When you return to a top–level window, your effective date is reset to its previous value.

   **Note**: In certain special cases, when you change your effective date on a subsidiary window, Oracle HRMS returns you to the previous window, and you may have to requery the records.
you want to view or update. This protects the integrity of these records.

So long as your effective date remains different from today’s date, it is displayed in the title bar of every window.

Effective Date Reminder

When you are new to DateTrack, you may find it useful to be reminded of your effective date whenever you open a window that contains datetracked information. The reminder appears in a Decision window and asks whether you want to change your effective date. If you choose Yes, the Alter Effective Date window displays.

There is a user profile option called **DateTrack:Reminder** that determines when the Decision window appears. There are three possible values for this profile option:

- Always
- Never
- Not Today

The Not Today value causes the reminder to appear when you navigate to a datetracked window and your effective date is not today’s date.

You can set the value of this profile option in the Personal Profile Values window.
Viewing Datetracked Information and History

Oracle HRMS maintains a continuous record of changes made to datetracked information. When you view a record in a datetracked window, it shows you a snapshot of the information on your effective date. The Effective Dates region on the datetracked window shows you the dates between which the snapshot is valid.

Suppose you are viewing an assignment with an effective start date of 01–JAN–1987 and no effective end date. This means that the assignment was created or last changed on 1 January 1987, and the snapshot information you are viewing is still valid. There have been no changes to the assignment since 1 January 1987, and there are no future dated changes.

To find out whether the assignment existed before 1 January 1987, you should use DateTrack History.

If there is an effective end date, you know that the record was either deleted or changed on the next day. To find out whether the record continues to exist, you can set your effective date to the day after this end date, or use DateTrack History.

Viewing the History of Datetracked Information

To see all the changes made to a datetracked record over time, use DateTrack History.

► To view DateTrack History:
1. Choose the DateTrack History icon from the Toolbar. The DateTrack History Change Field Summary window opens. Each row shows which fields were changed on the From date.
2. Choose the Full History button if you want to open a DateTrack History folder showing the value of each field between the effective
dates. The row for the current snapshot (corresponding to your effective date) is highlighted.

You can use the Folder menu to select the fields to view in the folder.

**Note:** It is possible to customize the information displayed in the Folder by modifying the DateTrack History view for the underlying table.

See: How To Create and Modify DateTrack History Views, *(Oracle HRMS Implementation Guide)*

---

**Updating and Correcting Datetracked Information**

When you update datetracked information, you are prompted to choose between Update and Correction.

If you choose Update, Oracle HRMS changes the record as from your effective date, but preserves the previous information. If you choose Correction, Oracle HRMS overrides the previous information with your new changes. The start and end dates of the snapshot you have corrected remain the same.

**Example**

Suppose you hire two new employees, Jack Lee and Julie Summers. A few weeks later Julie gets married. At the same time you discover an error in Jack’s record relating to his nationality.

You update Julie’s information by setting your effective date to the date of her wedding and entering her new married status, her change of name, and new next of kin information. Her previous personal information, which was valid until her wedding, remains in her record.

You correct Jack’s wrong nationality by setting your effective date to his hire date and entering the correct nationality. By choosing Correction, you put the record right, from the beginning. You should check whether there is an end date in the Effective Dates region of Jack’s record. If there is, you have only corrected the first snapshot of the record. Set your effective date to the day after the end date, and make the correction again. Continue in this way until the To field is blank, indicating that you have reached the last snapshot of this record.

**Updating a New Record**

You cannot create a record and then update it on the same day. If you try to do this, Oracle HRMS warns you that the old record will be
overridden, and then changes Update to Correction. This is because DateTrack maintains records for a minimum of a day at a time.

Future Updates

Using DateTrack, you can make future updates. For example, suppose you are relocating an employee, with six months notice. You decide to enter the relocation on the system straight away. So you set your effective date to the first day when the employee will be at the new location, and change the location on the assignment.

Later that month you promote the employee to a new grade. So you set your effective date to today’s date and change the grade on the assignment. Oracle HRMS checks to see whether the record has a future update scheduled. It finds that the location changes in the future and prompts you for the type of update you now want to make. You have two choices:

- **Insert**: This simply inserts the change before the next scheduled change. This is the correct choice for the example. The employee would be promoted from today. The future-dated relocation still takes place in six months time.
- **Replace**: This change replaces all future-dated changes. In the example, the employee would be promoted from today. However, the record of the relocation would be completely removed from the system.

Deleting Datetracked Information

When you delete datetracked information, Oracle HRMS prompts you with the following options:

- **End Date**: This ends the record on your effective date. When you query the record, this end date displays in the To field.
- **Purge**: This totally removes the record from your database.

If there are any future updates to the record after your effective date, Oracle HRMS may prompt you with another two options:

- **All**: This removes all future updates to the record. The current snapshot is valid until you make another change.
- **Next**: This removes the next future update to the record. It then resets the current snapshot’s end date to the end date of the deleted update.
Note: You do not always see all of these options when you choose to delete. Some windows do not allow all four operations.

Removing an End Date

If you have mistakenly set an end date on a datetracked record, you can remove it.

To remove an end date:

1. Set your effective date to the day the record ends.
2. Choose Delete Record from the Edit menu.
3. Choose the DateTrack delete option Next. This removes the next change to the record, which is the end date. Save your work.
Work Structures and Key Flexfields

Before you begin defining your enterprise’s work structures, you set up some key flexfields.

Key flexfields are a special feature of Oracle Applications. They help you customize applications, by holding particular information your enterprise needs where you need it. A key flexfield can hold as many as 30 separate segments of information. You can determine exactly what information to hold and how it must be entered.

Oracle HRMS includes six user–definable key flexfields. These are especially useful in helping you build information on work structures that suit the mission and culture of your enterprise.

Job and Position Name

Using these key flexfields, you determine the number of segments in your job and position names or codes, and the valid values for each segment.

For example, you may want names that are simple titles using one flexfield segment only, such as Account Manager or Programmer. Or, you may want multiple–segment names that convey more information, such as Senior.Account Manager or Part–time.Trainee.Programmer.

See: Representing Jobs and Positions: page 3 – 2

Personal Analysis

The Personal Analysis key flexfield is for holding information about:

- the various requirements for your jobs and positions, such as educational attainment, certification or license types and levels, or language skills
- the educational levels, qualifications, skills and other personal attributes of your employees or applicants, which match your job or position requirements
- a wide range of other types of information you need to keep on record for your workforce, for example, company car usage, workplace accidents, and immunizations for communicable diseases.

You can define up to 30 instances of the Personal Analysis flexfield structure, each holding one special information type.

See: Defining Special Information Types: page 28 – 10
Grade Name

You may want to use simple, single-segment grade names (A, B, C), or more complex grade names (Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2).

See: Representing Grade Structures: page 4–2

People Group

The People Group key flexfield is for setting up special groupings of employees. For example, you can set up a segment of this flexfield to hold all the unions present at your enterprise. When you give an employee an assignment, you can use this segment to record his or her union membership.

As another example, you can set up a segment as Company, holding a list of the companies comprising your enterprise. You can then use this group to assign each employee to a company.

See: Representing Other Employee Groups: page 5–10

Cost Allocation

The Cost Allocation key flexfield is for maintaining data needed to transfer information on employee costs from your payrolls to the general ledger, and to labor distribution systems.

For example, you might define one segment of the Cost Allocation flexfield to hold a list of your cost centers, another to hold GL account codes, and a third to hold labor distribution codes.

You would then make choices from these lists to tell the system how to collect payroll costs. For example, when you enter a department into Oracle HRMS, you could select the cost center against which to collect the employee costs of the department.

If you are using Oracle General Ledger, you can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: Costing in Oracle HRMS: page 11–2

See Also

Oracle Applications Flexfields Guide
This chapter explains how to represent your enterprise in Oracle HRMS, and how to set up default information applicable across the enterprise.

It further explains how to represent:

- the physical work locations of your employees
- organizations internal to your enterprise, such as companies, departments, divisions, units, and if needed, retirement organizations
- external organizations of importance to human resource management, such as recruitment agencies, insurance providers and tax authorities
- reporting lines and other relationships among these organizations. You represent these relationships by building organization hierarchies.
Site Locations

In Oracle HRMS, you set up each physical site where your employees work as a separate location. Similarly, you enter the addresses of external organizations that you want to maintain in your system, such as employment agencies, tax authorities, and insurance or benefits carriers. When setting up internal or external organizations, you pick from a list of these locations.

This approach has these advantages:

- You enter information about each location only once, thereby saving data entry time.
- Central maintenance of locations ensures consistency of address standards.
- Your work sites exist as separate structures identifiable for reporting purposes, and for use in the rules that determine employee eligibility for various types of compensation and benefits.

Setting Up Site Locations

Enter site addresses in the Location window.

Locations are shared across Business Groups in Oracle HRMS and with two other Oracle applications: Inventory and Purchasing. Oracle HRMS does not use some of the fields in the Location window. These fields are disabled for HRMS users.
To enter a work location and its address:

1. Enter the name of the location, and a description if required.
2. Select a national address style from the list.
   A window opens with the address format for the country you select.
3. Enter address information in this window and choose the OK button.

   Additional Information: Default address styles are predefined for many countries. You can add address styles for other countries, if required.

Removing Site Locations

You cannot delete locations, but you can make them inactive.

To remove an address from the Location list:
- Enter an inactive date from which the location is no longer in use in your enterprise.
Representing the Employer: The Business Group

The largest organizational unit you set up in Oracle HRMS to represent your enterprise as an employer is the Business Group. A Business Group may correspond to a company or corporation, or in large enterprises, to a holding or parent company or corporation.

By default, all employees you enter in Oracle HRMS receive an assignment to their Business Group. When you give them assignments to internal organizations such as divisions or departments, these replace the default assignment, but their records continue to exist within the Business Group.

Within a Business Group, you set up one or more Government Reporting Entities (GREs). A GRE represents an employer the federal government recognizes as being responsible for paying employees and for filing a variety of reports government agencies require, and is distinguished by having a unique IRS (Internal Revenue Service) identification number.

A Business Group with companies or divisions that have their own IRS identification numbers includes a GRE for each one. However all these GREs use the body of information on work structures and employees, and the single set of key flexfields, established for the entire Business Group.

Representing the Employer: Government Reporting Entities (GREs): page 2 – 9

Key Flexfields for the Business Group

Key flexfields are a special feature of Oracle Applications. Unlike regular information fields that hold just one unit of information, key flexfields can hold as many as 30 separate units, or segments, of information. The ability to hold multiple segments of information in a field is one of the features of Oracle Applications that facilitates localization of the software in different countries, and customization of the software at for each enterprise using it. Oracle HRMS includes six key flexfields:

- Job, Position, and Grade
- People Group
- Personal Analysis
- Cost Allocation.

Key Flexfields for Job, Position, and Grade Names

These three key flexfields give you the option of using either simple (single segment) or more complex (multiple segment) names for jobs,
positions, and grades, depending on the particular requirements and policies of your Business Group.

For example, you can decide on names for your jobs or positions such as Programmer and Machinist, or on names incorporating additional information, such as Machinist.Certified.Level3 or Programmer.Trainee. Likewise, you can use grade names such as A, B, and C, or names providing more information, such as Manual.A.1, Manual.A.2, Clerical.C.1, Clerical.C.2.

See:
Job and Position Names: page 3 – 5
Representing Grade Structures: page 4 – 2

**The People Group Key Flexfield**

This key flexfield provides an easy way to set up whatever special groupings of employees the Business Group requires. For example, a segment of this flexfield can hold all the unions employees belong to. When you give employees assignments, you can select their union from this segment.

Similarly, a segment of this flexfield can hold a list of the companies in a multi–company Business Group. You select from this segment each employee’s company, which can in turn control the employee’s eligibility for elements of compensation and benefits.

See: Setting Up the People Group Flexfield: page 5 – 10

**The Personal Analysis Key Flexfield**

This key flexfield holds special types of information about:

- the Business Group’s employees or applicants, as for example their educational levels, qualifications, and skills that may match job or position requirements
- requirements for the Business Group’s jobs and positions, for example, educational attainment, certification or license types and levels, and foreign language ability
- a wide range of other matters on record for the Business Group’s workforce, for example, information on company cars, workplace accidents, and employee requests for accommodations for disabilities.

The Personal Analysis flexfield structure can hold as many as 30 different information topics.
The Cost Allocation Key Flexfield

This key flexfield is used to collect information on labor costs within a Business Group. For example, an enterprise can define segments of this flexfield as follows:

- one segment to hold cost center codes, such as Sls (Sales), Eng (Engineering), and Prd (Production).
- another segment to hold GL account codes, for accounts such as Wages, Production Bonus or Union Dues Deduction.
- a third segment to hold codes used in a labor distribution system, such as 31, 32, and 33 (for product lines 31, 32, and 33).

After this flexfield is set up, you can access it at a number of points in the system. For example, when entering a department into Oracle HRMS as an internal organization, you can select from the flexfield the cost center to which the employee costs of the department go. When giving employees their assignments, you have the option of selecting from the flexfield the product lines they work on, and entering the percentage of time on each.

At installations including Oracle Payroll, the payroll run collects labor costs using the codes in the Cost Allocation key flexfield, for transfer to the general ledger and labor distribution or project management systems. Enterprises using both Oracle Payroll and Oracle General Ledger can map segments of the Cost Allocation flexfield to segments of the GL Accounting flexfield.

See: The Oracle HRMS Cost Allocation Key Flexfield: page 11 – 2
See: Costing in Oracle HRMS: page 11 – 2

See Also

User Definable Key Flexfields: page B – 2

Oracle Applications Flexfields Guide

Single or Multiple Business Groups

Each Business Group can have just one particular set of segments defined for its Job, Position, Grade, Employee Group and Cost
Allocation key flexfields. You set up the key flexfields for a Business Group before setting up the Business Group itself.

Many enterprises decide to use a single Business Group to hold ‘live’ information, so they can display, report and manage information from all parts of the enterprise at the same time.

**Note:** You cannot view information online for more than one Business Group at a time.

However, there are reasons for setting up multiple Business Groups in the same installation, such as the following:

- You want to have a copy of your live system with example records for training or testing purposes.
- You are a holding company or a corporation with a number of subsidiary companies. Each subsidiary has its own structures, employees, and compensation and benefit policies. If your subsidiaries are in different countries you also have to deal with local legislative requirements.
- You are acquiring a company or merging with another company, and you want to maintain separate structures and compensation and benefits during the transition process.

**The Startup Business Group**

Oracle HRMS comes with one Business Group supplied as startup data. You can use this Business Group and its default definitions as the starting point for your own Business Group, or you can create a new Business Group.

If you create a new Business Group, you must create a new responsibility (or edit the default responsibility) to allow access to it, before beginning to create other work structures.

**See Also**

Accessing Business Groups: page 2 – 18

**Defaults for the Business Group**

You can enter certain types of information for the Business Group to appear as defaults throughout your enterprise structures:

- You can select a default currency.
• You can enter a default for the value each assignment contributes towards each staffing budget that you define. For example, by default an assignment may count as one for a headcount budget.

• You can enter default working hours for all the employees in the Business Group. You can override these defaults at organization, position, and assignment levels.

• For certain HR reporting purposes you can register for the Business Group, Reporting Categories and Reporting Statuses. These include employment categories such as Full Time or Part Time that cover employees who are not temporary workers, and assignment statuses such as Active or Paid Leave that cover employees who are not at a terminated status.

• You can register for the Business Group, the names of the segments of its Cost Allocation key flexfield that hold cost center and labor distribution codes. This customizes the names that appear as field prompts in your PayMIX Windows.

**Employee and Applicant Identification Numbers**

When defining a Business Group, you choose a method of creating identifying numbers for its employees and applicants. The choices are:

• automatic number generation

• manual entry

• for employees only, automatic use of a national identifier, such as the US social security number or the UK National Insurance number.

**Note:** Once you save an automatic number generation method, you can later change only to manual entry.
Representing the Employer: GREs

After defining one or more Business Groups for your enterprise, you set up one or more Government Reporting Entities (GREs) within each Business Group. The GRE is the organization that federal, state and local governments recognize as the employer who:

- issues pay to employees
- withholds taxes from employees’ pay and is liable for employer taxes and tax reporting
- provides other government-mandated reporting, such as EEO-1, OSHA, and New Hire reports.

Each GRE has a unique 9-digit number (sometimes called the employer identification number or taxpayer identification number) issued by the IRS. Your enterprise may have just one such number, in which case your Business Group and GRE are the same organization.

Large enterprises may include a number of different divisions or companies each with its own identification number from the IRS, in which case you set up a GRE for each. You can associate several GREs together as a Tax Group, for which one of the GREs can serve as the common paymaster.

See: GREs, Tax Groups, and Common Paymasters: page 2 – 12

Information for Taxes, NACHA, and Reporting

Because a GRE is responsible for paying employees and withholding their taxes, you enter for it basic rules affecting calculation of federal, state and local taxes, and information for tax reporting. Also, each GRE holds information required for labelling NACHA tapes used to pay employees by direct deposit into their bank accounts.

Because a GRE also functions as a reporting unit for government mandated reporting on matters such as employees’ work-related injuries, equal employment opportunities, and obligations to pay child support, you enter for it certain information required for submission of these types of reports.

Attention: The GRE in the Oracle HRMS products is the same organization as the Legal Entity that appears in the Oracle Financials products, holding the taxpayer identification number. For this reason, the GRE may appear as GRE/Legal Entity on pick lists.

Enterprises using Oracle HRMS and Oracle Financials products should define only one GRE/Legal Entity to represent each employer organization with a unique IRS identification number.
Enterprises with One GRE

Enterprises with only one identification number from the IRS need only one GRE in which to place all employees. In Oracle HRMS, the Business Group and the GRE are the same organization. Appearing below is an example organization chart for a Business Group with one GRE.

In a company like this, some employees can have assignments to the Business Group organization itself, if it also has the classification HR Organization. Most have an assignment to one of the various HR Organizations subordinate to the Business Group. All employees belong to the same GRE, which pays them, withholds their taxes, and provides reports on various matters concerning them to government agencies.

Enterprises with Multiple GREs

For large enterprises that include several different employers with their own IRS identification numbers, all the employees in each company may be paid by that company, and hence all require an assignment to a
GRE that coincides with their company. In this case you set up within the Business Group, a GRE for each separate employer, as seen below in Figure 10–2.

In enterprises like this, all employees assigned to an HR Organization within a company have an assignment to the same GRE, and conversely, all employees in a given GRE belong to the same company.

**Figure 2 – 2**
GREs Coincident with Companies

Alternative Structuring of Companies and GREs

In other large enterprises, the GREs responsible for paying groups of employees are not the same as the companies within the Business Group, which may be organized, for example, according to the particular types of work or projects they undertake. Figure 10–2 still reflects the structure of the companies in this type of enterprise. But the GREs representing the employing organizations that pay employees have a separate structure that is independent of the companies, as in Figure 10–3:

In other large enterprises, the GREs responsible for paying groups of employees are not the same as the companies within the Business Group, which may be organized, for example, according to the particular types of work or projects they undertake. The figure above still reflects the structure of the companies in this type of enterprise. But the GREs representing the employing organizations that pay employees
have a separate structure that is independent of the companies, as in the figure below.

![Diagram of GREs Independent of Companies](image)

In this type of enterprise, employees assigned to a particular GRE can have a work assignment to any of the different companies constituting the enterprise, and a particular company can include employees assigned to several different GREs.

In enterprises like this, employees are clear about which company they are working in, but may be unaware of their membership in a separate GRE. Because the functions of GREs relate to payroll administration and governmental reporting, they have little direct impact on employees’ daily lives at work.

Business Groups with multiple GREs often associate some GREs together in a Tax Group with a common paymaster

---

**GREs and Tax Groups**

Enterprises with multiple GREs can place certain GREs together in **Tax Groups**. The Tax Group takes the name you give it.

**Attention:** The Tax Group name must be consistent in spelling and case for all GREs to be included. For example, “My Tax Group” is not the same as “my tax group.”

When multiple GREs are included in a tax group, the taxable limits for FUTA and SS are maintained at a Tax Group Level. Using tax groups allows employers to give employees moving within GREs credit towards their Social Security, and Federal Unemployment Tax Act (FUTA) taxes.

At the same time that you enter federal tax rules for a GRE, you can place the GRE in a Tax Group.
See Also

Additional Information for GREs: page 2–25
Representing Organizations

In Oracle HRMS, the organizations you set up to represent your enterprise as an employer are the Business Group, and one or more GREs within the Business Group.

Below this level, you represent the groupings in which employees work, such as branches, departments or sections, by means of internal organizations. To enable the assignment of employees to an internal organization, you classify it as an HR Organization.

You also maintain information in the system about various types of external organizations relevant to human resources and payroll management and administration. You can never assign employees to external organizations, even those classified as HR Organizations.

Organization Types

When setting up an organization you can give it an organization type. The type may, for example, identify the function an organization performs, such as Administration or Service, or the level of each organization in your enterprise, such as Division, Department or Cost Center.

You create the organization types you require by entering values for the QuickCode Type ORG_TYPE.

Levels of Internal Organizations

You decide for yourself the level of organization detail your enterprise needs in Oracle HRMS.

At one extreme, a Business Group/GRE can be the only organization defined in the system. However this will severely limit your ability to manage and report on employee assignment and payroll information, and to control access to HRMS records. At the other extreme, you can define an organization for every grouping of employees, however small. But the costs of maintaining organizations at this level will probably outweigh the benefits.

When thinking about the internal organizations to set up for your enterprise in Oracle HRMS, consider what your current managerial groupings are. Then you can adjust up or down to determine the best level or organizational detail for your enterprise to maintain.

See Also

Organization Hierarchies: page 2 – 34
Representing Companies in Multi–Company Business Groups

When the configuration of your enterprise warrants, you can use both internal organizations and the People Group key flexfield to represent the entities appearing on your organization chart. For example, suppose your enterprise includes two companies, each with its own internal groupings and compensation and benefits policies:

![A Multi–Company Enterprise Diagram]

When you set up both the companies and the subordinate organizations within each company as entities to which you can assign employees, you can create rules governing eligibility for compensation and benefits using both the companies and their subordinate organizations.

To represent the branches, administrative and sales groups, and departments within the companies in Oracle HRMS, you can define internal organizations. To represent the companies, you can use the People Group key flexfield, defining a segment of this flexfield as Company, and listing your companies in it:

**People Group Key Flexfield**

*Segment 1: Company*

- Company 1
- Company 2

This setup permits you to assign each employee both to a company and a subordinate organization within the company, and hence to control
or her eligibility for elements of compensation and benefits both by company, and by organization within the company.

See Also

Setting Up the People Group Flexfield: page 5 – 10
Using Elements: page 7 – 6

Internal Organizations and Cost Centers

Depending on the structure of your enterprise and your decisions about which organizations to represent in Oracle HRMS, there may not be a one–to–one correspondence between your cost centers and the organizations you enter.

When defining an internal organization, you can identify one cost center against which the payroll costs of the employees assigned to the organization should be collected. You simply select the cost center from a list in a segment of the Cost Allocation key flexfield.

For example, suppose you are defining in Oracle HRMS the organization Product Assembly, whose employee payroll costs go to the cost center Production. When entering the organization Product Assembly, you select Production from the list of cost centers in the Cost Allocation flexfield:

Cost Allocation Key Flexfield

Segment 1: Cost Center

410–Accounting
425–Production
503–Public Relations

Note: If employees’ costs are charged to cost centers other than those of their organizations, or if they work in an organization only part time, you can enter other cost centers, and the percentage of time to be charged to each, on their employee assignments. Costing information entered for employee assignments overrides that entered for organizations.

See Also

Setting Up the Cost Allocation Key Flexfield: page 11 – 11
External Organizations

Oracle HRMS can hold basic information on organizations not part of your own enterprise, such as training vendors, tax offices, benefits carriers or certification bodies.

You define external organizations in the same way as internal organizations. External organizations can appear in your organization hierarchies together with internal organizations.

Attention: The main difference in the system between internal and external organizations is that you cannot assign people to an external organization.
Employer and Organization Setup

Use the Organization window to set up:

- Business Groups
- GREs (Government Reporting Entities)
- internal organizations
- external organizations

The nature of each organization is determined by the classification you select for it. The setup information you enter for an organization depends in large part on its classification.

You must create a Business Group and a responsibility to allow access to it, before you create other organizations.

Accessing Business Groups

You access the startup Business Group using the default 'Oracle Human Resources' responsibility. A responsibility is linked to a security profile, which determines which records you can see. The default Oracle HRMS responsibilities allow you to see all the records for the startup Business Group.

You can adapt the startup Business Group or create a new one for your enterprise.

If you are creating a new Business Group, your system administrator must create a new responsibility for it after you save it, but before you use it. This responsibility must give access to all the records in the Business Group. Alternatively, the system administrator can simply update the default Oracle Human Resources responsibility by changing the HR:Security Profile user profile option to the name of the view–all security profile generated for the new Business Group (see steps 8 to 10 below).

To define a “view–all” responsibility:

1. Navigate to the Responsibilities window.
2. Enter a Name for the responsibility and select the application for which you are defining it (such as Oracle Human Resources) in the Application field.
3. In the Menu field, select F4 HRMS Top Menu.
4. In the Report Group field, select one of the seeded report groups (such as US HRMS Reports and Processes).
5. Save your work.

6. Navigate to the System Profile Values window.

7. Select your new responsibility and query the HR:Security Profile option.

8. Enter the name of the view–all security profile for your new Business Group. By default this is the name of your Business Group.

9. Save your work.

See Also

Access Control Through User Responsibilities: page 34 – 2
Creating an Organization

- retirement organizations for retiree processing

To determine the purpose and uses in the system of each organization you create, you give it one or more classifications:

- For Business Groups and GREs, you use the classifications Business Group and Government Reporting Entity.
- For internal organizations such as departments, sections, and project teams to which employees have assignments, you use the classification HR Organization.
- To make organizations available for use in certain types of reporting, you use the classifications Reporting Establishment, Corporate Headquarters, and AAP Organization.
- So that you can query or select certain external organizations at appropriate points in the system, you use the classifications Workers Compensation Carrier, Benefits Carrier, Beneficiary Organization, and Payee Organization.

To set up an organization, use the Organization window.

Prerequisites for All Organizations

- Enter the names and addresses of your work sites in the Location window.
  
  If you are using Oracle Payroll, every organization to which employees can have assignments, including Business Groups, must have on record a location with a complete address. This is because the system uses the location of the organization of the employee’s primary assignment to determine employee work locations for tax purposes.

  Note: This does not apply to GREs, because the assignment to a GRE exists in addition to the assignment to an organization.

  See: Setting Up Site Locations: page 2 – 2

- Enter organization types you need in the QuickCodes window, for the QuickCode Type ORG_TYPE.

  See: Adding QuickCode Values: page 32 – 3

Prerequisites for Business Groups

- Enable the currencies you need. Normally your system administrator does this.

  See: Enabling Currencies: page 29 – 7
Note: Oracle Payroll is capable of paying employees working in other countries in the currencies of these countries, but does not provide the formulas needed to process taxes for employees paid in foreign currencies under other national legislations. You can write your own formulas in Oracle FastFormula, or contract with local third party vendors for the installation of tax routines.

- Define the structures for the Job, Position and Grade Name key flexfields, and define the structures and at least one segment for the People Group and Cost Allocation key flexfields.
  
  See: Key Flexfields for the Business Group: page 2 – 4

- Make entries for the QuickCode Types FREQUENCY and BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
  
  See: Adding QuickCode Values: page 32 – 3

Prerequisite for GREs

- Enterprises with multiple GREs often associate some together in Tax Groups. Plan in advance which GREs will constitute each Tax Group, and which GRE will be the tax group leader.
  
  See: GREs and Tax Groups: page 2 – 12

Prerequisites for HR Organizations

- To enter cost codes for these organizations, check that the Cost Allocation key flexfield includes a cost code segment, with a qualifier of Organization. This qualifier must be present for the segment to appear in the Organization window.
  
  See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

- In the Table Structure window, query the table COMPANY WORK SCHEDULES, and check whether the work schedules supplied with the system meet your requirements.
  
  Work schedules show the number of working hours scheduled each day of the week for employees, starting with Monday. For example, 775 means a scheduled work day of 7 hours and 45 minutes. If you need additional work schedules, you can create them in the Table Structures window.
  
  See: Setting Up User Tables: page 32 – 14

Prerequisites for Reporting Establishments, Corporate Headquarters, and AAP Organizations

See:
To create a new organization:

1. Enter a name that is unique within the Business Group, and optionally select an organization type.

   **Note:** All Oracle applications you install share the information entered in the Organization window. Therefore organization names must be unique within a Business Group, and Business Group names must be unique across your applications network.

2. Enter a start date early enough for any historical information you must enter.

   You cannot assign an employee to an organization before the start date of the organization.

3. Select a location to record the site address, if one exists. You can also enter an internal address to add more details such as a floor or office number.

4. Select Internal or External. You cannot assign people to an external organization.

   Examples of external organizations that may require entry are benefits carriers, Workers Compensation insurance carriers,
organizations employees name as beneficiaries of certain employee benefits, and organizations that are recipients of third party payments from employees’ pay.

5. Save the organization. Then select at least one classification and enable it.

Note: Your system administrator can limit the classifications you see to those relevant at your installation.

- Select **Business Group** to define a Business Group.

  **Attention:** Classifying an organization as a Business Group is not reversible. Employees, organizations, and other data are partitioned by Business Group. Each Business Group must be viewed using a separate responsibility.

- Select **Government Reporting Entity** to define a GRE.

- Select **HR Organization** for all organizations (including Business Groups and GRES) to which you intend to assign employees.

- Select **Reporting Establishment, Corporate Headquarters or AAP Organization** when defining reporting organizations, that is, organizations required for the production of certain reports for government agencies.

  See: Reporting Organizations: page 16 – 3

- Select **Benefits Carrier, Workers Compensation Carrier, or Beneficiary Organization** when defining an external organization belonging in one of these classifications. You can then select the organization when defining a benefit, entering information for Workers Compensation calculations, or recording beneficiaries employees have named for certain benefits.

  See:

  Benefits Administration Overview: page 10 – 2

  Setup Steps for Workers Compensation Calculations *(Oracle Payroll User’s Guide)*

  Recording Beneficiaries for Benefits: page 10 – 20

- Select **Payee Organization** when defining an external organization that is the recipient of a third party payment from an employee, for example a court–ordered payment. You can then select this organization on the Personal Payment Method window when entering a third party payment method.

  See: Entering Payment Methods for an Employee Assignment: page 14 – 22
6. Save all enabled classifications for this organization.

▶ **To enter additional information:**

   **Note:** There is no additional information to add from the Organization window for the classification Corporate Headquarters, or for external organizations with the classifications Payee Organization, Benefits Carrier, Workers Compensation Carrier, or Beneficiary Organization.

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select the classification for which to enter additional information, and choose the Others button to open the Additional Organization Information window.

2. This window displays the entry options available for the selected classification. Choose the option you want. Another Additional Organization Information window opens. Click in a field of this window to open a window for information entry.

3. Enter additional information for the classification.

---

**Additional Information for Business Groups**

▶ **To enter basic, required information for the Business Group:**

   See: Entering Business Group Information: page 2 – 26

▶ **To enter defaults for human resource budget values:**

   See: Business Groups: Entering Budget Value Defaults: page 2 – 27

▶ **To enter defaults for work day start and end times:**


▶ **To register Reporting Categories and Statuses:**

▶ **To enter training default values for Oracle Training Administration:**

Additional Information for GREs

► To enter the unique IRS identification number (EIN):
   See: GREs: Entering the IRS Identification Number: page 2 – 30

► To enter data for EEO, VETS and New Hire reporting:
   See:
   Entering EEO–1 Information for a GRE: page 17 – 5
   Entering VETS–100 Information for a GRE: page 17 – 23
   Entering a New Hire Report Contact for a GRE: page 13 – 33

► To enter tax rules:
   See: Entering Federal State and Local Tax Rules for GREs (Oracle Payroll User’s Guide)

► To enter data for wage and tax reporting:
   See:
   MWS (Multiple Worksite) Reporting on Magnetic Tape (Oracle Payroll User’s Guide)
   State Quarterly Wage Listings (SQWL) Reporting on Magnetic Tape (Oracle Payroll User’s Guide)
   W–2 Reporting on Magnetic Tape (Oracle Payroll User’s Guide)

► To enter data for NACHA tapes:
   See: Entering NACHA Tape Data for GREs: page 5 – 5

Additional Information for HR Organizations

► To enter cost codes for collection of costing information:
   See: HR Organizations: Entering Costing Information: page 2 – 30

► To place the organization in hierarchies :
   See: HR Organizations: Entering Parent Organizations: page 2 – 31

► To enter default work day start and end times.
To enter a default work schedule:

See: HR Organizations: Entering a Work Schedule: page 2 – 31

---

### Additional Information for Reporting Establishments

- **To enter filing data for EEO and VETS reports:**
  
  See: Setting Up Reporting Establishments: page 16 – 15

- **To place Reporting Establishments in hierarchies:**
  
  See: Placing Subordinate Reporting Organizations in Hierarchies: page 16 – 19

- **To enter filing data for Multiple Worksite reports:**
  
  See: MWS Reporting on Magnetic Tape (Oracle Payroll User’s Guide)

---

### Additional Information for AAP Organizations

- **To enter the AAP the organization represents.**
  
  See: Setting Up AAP Organizations: page 16 – 18

- **To place AAP Organizations in hierarchies:**
  
  See: Placing Subordinate Reporting Organizations in Hierarchies: page 16 – 19

---

### Entering Business Group Information

- **To enter Business Group information:**
  
  1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Business Group Information.
  
  2. Click in a field of the Additional Organization Information window to open the Business Group Information window.
3. You can enter a short name for the Business Group. Release 10 does not use this name. It is provided for compatibility with earlier releases, where it appeared in the header line of each form.

4. Select the method of creating identifying numbers for employees and applicants. The choices are:
   - automatic number generation
   - manual entry
   - automatic use of the national identifier (for example, the social security number in the US, and the NI number in the UK). This option is available for employees only.

   **Attention:** Once you save your method, you cannot later change to either of the automatic options. You can only change to manual entry.

5. Select the names of the key flexfield structures you want to use in this Business Group.

6. Select the appropriate Legislation Code and default currency.
   The Legislation Code determines the startup data you can access and the contents of some legislation–specific windows.

   **Attention:** Selecting the correct legislation code is essential for the correct functioning of Oracle HRMS. You cannot change the legislation code after entering employees against the Business Group.

7. To maintain fiscal year balances in Oracle Payroll if your fiscal year is different from the calendar year, enter the fiscal year start date.

8. You can enter a Minimum and Maximum Working Age for the Business Group. When you enter or hire employees, you receive a warning if the person’s age is outside this range.

9. Save your work.

---

**Business Groups: Entering Budget Value Defaults**

You can set up budgets for non–monetary measures such as headcount or full–time equivalent. When you enter employee assignments to define the work an employee does for your enterprise, you can specify the value of the assignment towards these budgets. For example, all assignments typically count as one for headcount budgets, but may count as less than one for full–time equivalent budgets.

To remove the requirement to enter these values for every assignment, you can enter defaults for the whole Business Group. You can override the defaults for individual assignments.
Prerequisites

- Define units of measure (such as Headcount) by adding values to the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.

To define budget value defaults:

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Budget Value Defaults.

2. Click in a field of the Additional Organization Information window to open the Budget Value Defaults window.

3. In the Units field, select a measurement type, such as Full Time Equivalent or Headcount.

4. Enter a default value in the Value field.

You can enter a default value for as many budgetary units as you plan to use for the Business Group.

See Also

Human Resource Budgets: page 12 – 2

Business Groups and HR Organizations: Work Day Defaults

You can set up default working hours for all employees in the Business Group or in an HR Organization, saving data entry at lower levels.
When necessary, you can override the defaults at lower levels, for example, for individual positions or employees.

The Salary Administration process uses working hours information to prorate the salary values against which it validates any salary proposals.

**To define work day defaults:**

1. In the Organization window, query the Business Group if it does not already appear there. In the Organization Classifications region, select Business Group, choose the Others button, and select Work Day Information.

2. Click in a field of the Additional Organization Information window to open the Work Day Information window.

3. Enter the normal start and end times in 24 hour format. For example, for 5.30 p.m., enter 17:30.

4. Enter a number in the Working Hours field, and select the corresponding period of time in the Frequency field. For example, enter 40 and select Week.

You can add to the list of available frequencies by making entries for the QuickCode Type FREQUENCY, using the QuickCodes window.
GREs: Entering the IRS Identification Number

To enter the unique identification number for the GRE:

1. In the Organization window, query the GRE if it does not already appear there. In the Organization Classifications region, select Government Reporting Entity, choose the Others button, and select Employer Identification.

2. Click in a field of the Additional Organization Information window to open the Employer Identification window.

3. Enter the identification number the IRS has issued for the GRE.

   Note: A Retirement Organization may have the same Employer Identification Number as an existing GRE, if required.

HR Organizations: Entering Costing Information

To enter costing information:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organizations, choose Others, and select Costing Information.

2. Click in the Additional Information window to display the segments of the Cost Allocation flexfield set up with the qualifier of Organization.

3. Select the appropriate cost code in each segment.

   For individual employees, you can override these organization–level codes by entering costing information on their assignments.
HR Organizations: Entering Parent Organizations

After you set up organization hierarchies, use the Parent Organization window to place a subordinate organization in hierarchies by naming its immediate parent in each hierarchy.

To enter a parent organization:

1. In the Organization window, query the HR Organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose Others, and select Parent Organization to open the Parent Organization window.
2. Select the hierarchy name.
3. Select the name of the parent organization to which the HR Organization is subordinate in this hierarchy.
4. To enter the HR Organization in another hierarchy, repeat steps 2 and 3.

See Also

Organization Hierarchies: page 2 – 34

HR Organizations: Entering a Work Schedule

Work schedules show the number of working hours scheduled each day of the week for employees, starting with Monday. For example, for an
employee who works 7 hours and 45 minutes each day Sunday through Thursday, with Friday and Saturday off, the work schedule is: 775–775–775–0–0–775.

Oracle Payroll uses work schedules to prorate pay for employees who do not submit timecards. The startup data you receive with Oracle Payroll includes several work schedules in common use, entered in the table COMPANY WORK SCHEDULES.

To select a work schedule for an HR Organization:

1. In the Organization window, query the organization if it does not already appear there. In the Organization Classifications region, select HR Organization, choose the Others button, and select Work Schedule.
2. Click in a field in the Additional Organization Information window to open the Work Schedule window.
3. Select the default work schedule for the organization.
   You can override this default for individual employees on their assignments.

If the work schedule you need is not on the list, go to the Table Structure window, query the table COMPANY WORK SCHEDULES, and enter the new work schedule.

See Also

User–defined Tables: page 32 – 10
Deleting an Organization

To remove an organization from the list of organizations available for employee assignments, enter an end date (Date To) on the organization record.

To entirely delete an organization from the system, you must first:

- remove any employee assignments to the organization
- remove the organization from any hierarchies
- disable its organization classifications in the Organization window.
Organization Hierarchies

In Oracle HRMS, organization hierarchies show reporting lines and other hierarchical relationships among the organizations in your enterprise.

You set up a *primary reporting hierarchy* reflecting the main reporting lines in your enterprise, as established in the organization chart of your enterprise. Below is an example of an organization chart showing the reporting lines of a single–company enterprise.

Figure 2 – 5
Chart Showing Primary Reporting Lines
Multiple Hierarchies

In addition to the primary reporting hierarchy, you can set up in Oracle HRMS as many other organization hierarchies as you need.

Hierarchies for Matrix Management

Your enterprise may have a matrix management structure in which organizations have more than one reporting line. For example, looking at the organization chart in Figure 2–5, the HR organization under Production may have a dotted–line reporting relationship to the organization Company HR. You can set up additional hierarchies to reflect secondary reporting relationships within your enterprise.

Security Hierarchies

As well as constructing hierarchies to reflect reporting lines, in Oracle HRMS you use hierarchies to control access to information. For example, in a decentralized enterprise you might want to give each regional manager access to the records of the employees in the organizations in his or her region.

Looking again at the organization chart in Figure 2–5, you want managers in the Sales East office to have access to the records of all employees in the eastern region sales groups. You can do this by building a geographical hierarchy of your regions and the organizations in each.

See: Security Profiles: page 34–4

Hierarchies for Reporting

When you run some of the Oracle HRMS standard reports, you can specify an organization hierarchy to determine which organizations and employees the report covers. You can also use this approach in your own standard or ad hoc reports. You can create additional organization hierarchies just for analysis and inquiry purposes.

To produce reporting for government authorities, for example EEO-1 and VETS-100 reports, you build special establishment hierarchies to obtain the correct coverage of employees.

See Also

Establishment Hierarchies: page 16–4
Organizational Change and Version Control

Changing your hierarchies to reflect simple changes in reporting lines is not difficult. You create a new *version* of your existing hierarchy and modify parts of its structure. The system retains earlier versions of hierarchies for historical information.

However when you experience a major restructuring, it is often best to create new work structures, including new organizations and reporting lines.

**Suggestion:** You can create future–dated versions of your organization structures and use these to prepare for reorganization in advance. You retain previous versions of your hierarchies for historical information.

See Also

Dated Information and Hierarchy Versions: page 1 – 10
Creating Organization Hierarchies

You can create all types of organization hierarchies in two ways:

- using the Organization Hierarchy window
- using the Organization Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your organization hierarchies graphically and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Organization Hierarchy window. Always define hierarchies from the top organization down.

Prerequisites

- Define the top organization in the hierarchy, and at least one organization subordinate to it.

►To set up a new organization hierarchy:

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.
You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.
4. In the Subordinates block, select the immediate subordinates for the top organization.
5. To add organizations below one of these immediate subordinates, check the Down check box for the organization.

The Organization block now displays the organization you selected. You can add subordinates to *this* organization. To return to the previous level, check the Up check box.

**Attention:** The list of organizations from which you can select in the Subordinates block includes organizations that are already in the hierarchy. If you select such an organization, you will move it and all its subordinates within the hierarchy.

See: Changing Organization Hierarchies: page 2 – 39

---

**To create a new version of an existing hierarchy:**

1. Query the name of the hierarchy.
2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

**Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

You can copy an existing hierarchy. See: **To copy an existing hierarchy**, below.

3. Query the top organization name into the Organization block.
4. In the Subordinates block, select the immediate subordinates for the top organization.
5. To add organizations below one of these immediate subordinates, select the Down check box for the organization.

The Organization block now displays the organization you selected. You can add subordinates to *this* organization. To return to the previous level, select the Up check box.

---

**To copy an existing hierarchy:**

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Organization and Subordinates blocks. You can change these.

### Changing Organization Hierarchies

To add new organizations to an existing hierarchy, query the hierarchy and version you want to change, query the parent organization for the one you are adding, and select the new organization in the Subordinates block.

To change the top organization of an existing hierarchy, query the hierarchy and version you want to change, query the new top organization, and select the previous top organization in the Subordinates block.

You can move an organization and all of its subordinates within a hierarchy. To move an organization, query the hierarchy and version you want to change, query the new parent organization for the one you want to move, and select the organization to move in the Subordinates block.

### Deleting Organization Hierarchies

To delete an organization hierarchy, you must first remove the subordinate organizations from the hierarchy, starting at the lowest level. You cannot delete an organization hierarchy if other versions exist, or a security profile uses it.

### Organization Hierarchy Report

Oracle HRMS includes a standard Organization Hierarchy Report to display the relationships between organizations in a hierarchy.

You run reports from the Submit Requests window.

To run the Organization Hierarchy Report:

1. In the Name field, select Organization Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.

4. In the Organization Structure field, select the hierarchy. If there are multiple versions, select a version.
   
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.

5. In the Parent Organization field, select the highest organization in the hierarchy that you want to see on the report.

6. Enter Yes in the Managers Shown field to see managers’ names.
   
   If there are more than ten managers, you see the number of managers only.

7. Choose the Submit button.
This chapter explains the concepts of jobs and positions in Oracle HRMS and how you can use these work structures to represent the roles of your employees.

It further explains how to:

- use the Job Name and Position Name key flexfields to identify groups of employees in your enterprise
- hold information associated with jobs and positions, such as job descriptions, and standard working hours for positions
- represent the reporting lines and other relationships among positions. You represent these relationships by building position hierarchies
- reorganize jobs, positions and assignments within your Business Group.
Representing Jobs and Positions

In many enterprises the basic management units are roles, not individuals. In theory at least, organizations are able to continue in unchanged existence, in spite of frequent changes in staff. However, the definition of a ‘role’ varies from one enterprise to another. Like organization structures, it reflects the culture of the enterprise.

You define roles to represent the ways that different groups of employees work. In Oracle HRMS you can use jobs or positions, or a combination, to define roles.

**Job**  
A job is a generic role within a Business Group, which is independent of any single organization. For example, the jobs ‘Manager’ and ‘Consultant’ can occur in many organizations.

**Position**  
A position is a specific occurrence of one job, fixed within one organization. For example, the position ‘Finance Manager’ would be an instance of the job of ‘Manager’ in the ‘Finance’ organization. The position belongs to the organization. There may be one, many, or no holders of a position at any time.

**Example**

In a large structured organization, you may have a permanent establishment of positions for most of your employees.

However, you may also have groups of employees hired to perform specific tasks. This can be on a temporary or a permanent basis. Staff in this category can include agency workers, consultants and contractors. For these staff, you can define the role more flexibly as a job.
Position Reporting Structures

If you use positions to define roles, you can define *position hierarchies* to show the detailed line management reporting in each organization or throughout the enterprise.

Position hierarchies are very like organization hierarchies. You can set up a primary hierarchy and multiple secondary hierarchies to show reporting lines, including ‘dotted line’ reporting, and to control access to information.

Position hierarchies are dated, so you can create future-dated versions to prepare for reorganization in advance, and can retain previous versions for historical information.

![Position Hierarchies](image-url)
Deciding How to Use Organizations, Jobs, and Positions

When you plan how to model your organizations and roles, consider the following points:

- Positions are normally used in role–based enterprise structures where clearly defined rules largely determine the ways employees work, and the compensation and benefits they receive.
- To manage fixed establishments of posts that exist independently of the employee assignment, it is best to use positions.

If you decide to use positions to represent your enterprise structures you need to consider carefully how to use organizations.

Positions provide you with a finer degree of structural definition and control than organizations on their own. You can use both organizations and positions to represent your reporting structures. However, if you define both, you must also maintain both over time. This may lead you into duplication of effort and information.

**Suggestion:** If you decide to use positions to represent how people work in your enterprise, it is best to define most of the detail at the level of the position. Do not duplicate this detail in organization structures.

Use organizations to show your highest level of departments or divisions. Use positions and position hierarchies to show the reporting groups existing in your enterprise.

See Also

Rule Based Enterprises: page 6 – 6
Job and Position Names

Before you define your jobs and positions, decide whether you want to use simple names and codes, or multi-segment job and position names to hold more information.

The name can be a title only, as for example:

- Director
- Analyst
- Training Manager

You can add another segment to categorize the jobs or positions. In this way, you can use segments to identify subgroups of employees within your enterprise. For example, a job name can comprise a title and a job type, such as:

- Director of Finance.Director
- Assistant Director of Finance.Director
- Finance Officer.Professional

Similarly, a position name can comprise a title, a position number, and an indicator showing whether the position is part-time. For example:

- Training Manager.020001.F/T
- Secretary to the Training Manager.020013.P/T

You define the segments of the job and position names and their valid values by setting up the Job Name key flexfield and the Position Name key flexfield. Normally your system administrator does this.

See Also

User Definable Key Flexfields: page B – 2
Adding Information About Jobs and Positions

As you define roles in your enterprise, you can describe their responsibilities, requirements, and working conditions. There are a number of ways to add information about a role:

- For positions, you can enter in standard fields, the location, probation period, and working hours. Entering location and working hours for an organization provides a default for all positions within that organization.
- You can attach documents (such as word processed documents, spreadsheets, or simple text comments) to each job or position record. For example, you might attach text describing the objectives and tasks of the job or position.
  See: Using Attachments: page 33 – 6
- You can add up to twenty additional fields to each window to hold extra information you require. These fields can be global (they always appear), or context-sensitive (they appear only when triggered by another piece of information).
  For example, these fields can record the health and safety requirements of a position, or its suitability for job share. The additional fields appear in a descriptive flexfield.
  See: Adding New Fields to Windows: page 31 – 2
- You may need to add other information, such as required qualifications or valid experience, to help match people to roles. You define the sorts of Special Information Types you want to hold and set them up using a special field called the Personal Analysis key flexfield. For each job or position, you select the requirements from your Special Information Types relevant to that role.
  See: Matching People to Vacancies: page 25 – 2

Comparing and Relating Roles

You may also want to relate roles to each other and define the relative grading of the roles. You can relate roles in the following ways:

- By forming multiple hierarchies of positions to show reporting relationships or career paths.
  See: Creating Position Hierarchies: page 3 – 21
- By linking jobs into multiple career paths to show suggested progression paths.
See: Defining Career Paths: page 23 – 7

- By recording successor positions and relief positions (to cover in the case of absence) against each position.
  See: Defining Positions: page 3 – 11
- By recording the grades that are valid for each job and position.
  See: Valid Grades: page 3 – 16
- If you use an evaluation system (such as the Hay Evaluation System) to compare roles, you can set up fields to hold evaluation information and an overall score for each job and position.
  See: Evaluating Jobs and Positions: page 3 – 14
Defining Jobs

You use the Job window to define jobs, the skills that jobholders require, and the grades to which they can be assigned. You can also enter job evaluation scores, if you have set up a job evaluation system.

Additionally, you can enter in the Further Information field of the Job window:

- an FLSA (Fair Labor Standards Act) code indicating whether the job is exempt from payment for overtime work
- an EEO job category, needed for production of EEO–1, AAP, and VETS–100 reports, and a job group, line of progression and salary code, needed for AAP reports
- information relating to the use of a job as a survey benchmark.

Prerequisites

- Define all the segments of the Job Name key flexfield that you want to use for the job name.
- If there are one or more valid grades to enter for this job, check that these grades are defined.

To define a job:

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the job. If there is more than one segment in the Job Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Click in the Further Information field to open the Further Job Information window. Here you can:
   • mark the job for use as a survey benchmark
   • select an FLSA code of Exempt or Nonexempt
     See The Earnings Type Overtime (Oracle Payroll User’s Guide)
   • select an EEO code for the job
     See: Associating Jobs with EEO Job Categories: page 17 – 6
   • select a job group, line of progression, and salary code for the job
     See: Data for AAP Reporting: page 17 – 15

4. Save the job.

5. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the job.

6. Choose the Requirements button to enter job requirements, such as required qualifications or valid experience, to help you match people to roles.

   **Note:** Check with your HR manager or system administrator whether this is the right window for entering job requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

7. Choose the Valid Grades button to enter the grades to which jobholders can be assigned.

   **Note:** For calculation of the Workers Compensation liability of your enterprise, you must associate this job with the work classification code of one or more states.

   See Jobs and WC State Codes and Rates (Oracle Payroll User’s Guide)
See Also

- Entering Evaluation Information: page 3 – 15
- Entering Job and Position Skill Requirements: page 3 – 17
- Valid Grades: page 3 – 16
- Entering Work Choices for a Job or Position: page 3 – 18
Defining Positions

You use the Position window to define positions within your organizations and to add them to position hierarchies. You can also enter the skills that position holders require and the grades to which they can be assigned. You can enter position evaluation scores, if you have set up a position evaluation system.

**Prerequisites**

- Define all the segments of the Position Name key flexfield that you want to use for the position name.
- Define the organizations for the Business Group.
- Define the jobs for the Business Group.
- If you want to hold probation periods for positions, enter the units in which you measure probation periods as values for the QuickCode Type QUALIFYING_UNITS.
- If you want to add the position to a position hierarchy, define the hierarchy in the Position Hierarchy window.

**To define a position:**

1. Enter a start date early enough to handle any historical information you want to enter.
2. Enter a unique name for the position.
   
   If there is more than one segment in the Position Name flexfield, a window opens when you enter the Name field. You must enter a unique combination of segments in this window.
3. Select the organization and job for this position. They must have a start date on or before the start date of this position.

Attention: You cannot change the organization or job once you have saved the definition.

You can set up several positions that have the same job in the same organization. Each position name must be unique.

4. Optionally, select a status for the position. If the status is Valid or blank, employees can be assigned to the position. If the status is Invalid or any other status defined at your site, employees cannot be assigned to the position.

5. Location and Standard Conditions default from the organization, but you can override the defaults.

6. If there is a probation period for this position, you can enter its length in the Probation Period alternative region.

7. In the Absence alternative region, select Yes in the Replacement Required field if you want users to be warned that they should enter the name of a replacement when they enter an absence for a holder of this position. You might want to do this for positions where it is essential that a person is ‘in charge’ at all times.

You can select the position that should be held by the person to cover as relief in case of absence.

8. In the Planned Successor alternative region, you can select the position from which a successor will move to fill this position.

9. Save your position.

10. If you want to add the position to one or more position hierarchies, choose the Reporting To button. Select a hierarchy and the name of the position to which this position reports.

11. Choose the Evaluation button to enter evaluation information and an overall evaluation score for the position.

12. Choose the Requirements button to enter position requirements, such as required qualifications or valid experience, to help you match people to roles.

   Note: Check with your HR manager or system administrator whether this is the right window for entering position requirements. You use this window if requirements were defined using Special Information Types. You use the Competency Requirements window if you have implemented Career Management.

13. Choose the Valid Grades button to enter the grades to which position holders can be assigned.
See Also

Entering Evaluation Information: page 3 – 15
Valid Grades: page 3 – 16
Entering Work Choices for a Job or Position: page 3 – 18
Evaluating Jobs and Positions

Evaluation systems are common in large enterprises, which compare the responsibilities of roles to help in the definition of grades. Directly or indirectly, the evaluation can also contribute to setting compensation levels. The UK’s Local Government Scheme and the Hay Evaluation System, used internationally, are examples of evaluation systems.

Evaluation systems normally use a set of formal and systematic procedures to perform a comparison of roles. As such, evaluation is primarily concerned with the definition of the relative status of a role, and not with a set of absolutes. The objective of all evaluation systems is to place a role in a grading or salary structure.

There are two main types of evaluation system:

**Factor**
Key roles are examined factor by factor and a rank comparison order produced for each factor. A complex comparison of weighted factors then follows.

**Points Rating**
A wider range of factors is used. Each factor is weighted and has a numerical scoring system. The total points scored determines the placement of the role in a grade or salary structure.

These systems might incorporate benchmarking, where a few key roles determine the rank of all the others. Grades and compensation levels are determined after the evaluation and ranking of the jobs.

Setting Up an Evaluation System

To set up an evaluation system:

1. Decide whether to hold the evaluation information for jobs or for positions, depending on your own definitions of employees’ roles within the enterprise model.

2. Define values for the QuickCodes Types EVAL_SYSTEM (evaluation system name) and EVAL_SYSTEM_MEAS (the units in which to measure the evaluation). If you use more than one system, you can define multiple values to provide a list of values in the Job Evaluation and Position Evaluation windows.

   See: Adding QuickCode Values: page 32 – 3

3. Define the structure and segments of the Additional Evaluation Details descriptive flexfield, which holds the evaluation
information. This descriptive flexfield displays on the Job Evaluation and Position Evaluation windows.

For example, you could define the following segments:

- Responsibility
- Problem Solving
- Know How
- Related Grade

If you are using more than one evaluation system in your enterprise, you should make the flexfield segments context sensitive to the evaluation system. Context sensitive segments ensure that each system has its own distinct set of evaluation information.

Your system administrator usually carries out this task as it requires access to parts of the system that control how Oracle Human Resources works.

## Entering Evaluation Information

Enter evaluation scores and details in the Job Evaluation or Position Evaluation window.

### Prerequisites

- An evaluation system must be implemented.

![Job Evaluation Window](image)

- **System**: White collar internal
- **Overall Score**: 91
- **Date Evaluated**: 02-FEB-1996

**To enter a job or position evaluation:**

1. Select the evaluation system used to evaluate this job or position.
2. Enter the overall score and select the units of measurement.
3. Enter the date of the evaluation.
4. Open the descriptive flexfield window, and enter the information it prompts you for.

Valid Grades

When you have evaluated the relative status of your roles (using an evaluation system or some other approach), you can associate valid grades with each role. You may choose to define valid grades for a few key roles and then use these as benchmarks for all other roles.

When you assign an employee to a grade, the list of grades you select from indicates which grades are valid for the employee’s job or position.

You enter valid grades in the Valid Grades window for a job or position.

► To enter valid grades:
  - Select as many valid grades as you require.
  - The Date From defaults to the date the job or position becomes active, or the date the grade becomes active, if this is later. You can change this date.
**Entering Job and Position Requirements**

Using the Job Requirements window and Position Requirements window, you can store any personal attributes or experience required by a job or position. You can then use this information to list employees or applicants who might be suitable to hold the job or position.

*Note:* If you are using Career Management for suitability matching, enter competence requirements for jobs and positions in the Competence Requirements window.

- The implementation team at your site must set up one or more special information types to hold the requirements information.

  See: Defining Special Information Types: page 28 – 10

---

**To enter job or position requirements:**

1. Select the name of a special information type.
2. Enter the Requirements field to open the window corresponding to this special information type.
3. In this window, enter the precise requirement of the job or position and choose OK.
4. If the requirement is essential to the job or position, check the Essential check box. This information is used in the Skills Matching Report.
5. Save the requirements.
Entering Work Choices for a Job or Position

You can enter work choices that can affect an employee’s, applicant’s, contractor’s, or ex-employee’s capacity to be deployed within your enterprise (or a customer’s). Work Choices include willingness to travel, willingness to relocate, and preferred working hours and work schedule. You can enter work choices for a job or position, and compare these with the personal work choices entered for people.

You enter this information in the Work Choices window, accessed from the Job or Position window.

Prerequisites

You need to enter enter the following QuickCodes for work factors:

- Define time scales as values for the QuickCode Type PER_TIME_SCALES.
- Define work schedules as values for the QuickCode Type PER_WORK_SCHEDULE.
- Define working hours as values for the QuickCode Type PER_WORK_HOURS.
- Define the full time equivalents as values for the QuickCode Type PER_FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER_RELOCATION_PREFERENCES.
- Define lengths of service as values for the QuickCode Type PER_LENGTHS_OF_SERVICE.

To enter work choices for a job or position:

1. Check the relevant work requirements boxes if the job or position requires the holder to:
   - work in all locations
   - relocate
   - be willing to relocate
   - travel
• hold a passport

2. Enter the length of time the jobholder must perform the job or position, for example, indefinite or two years.

3. Enter the normal working hours (for example, 9.00 to 5.30), the work schedule (the working days in the week or pattern of shifts), the proportion of full time hours required, and the minimum length of service required.

4. Check the relevant international deployment boxes if the job or position requires the jobholder to:
   • work in all countries
   • be willing to relocate

5. Select the countries to which the jobholder might be relocated.

6. Select the locations to which the jobholder might be relocated.

7. Enter any further job or position requirements, if required.

See Also

Entering Work Choices (Person): page 13 – 21
Viewing Position Occupancy

The Position Occupancy folder lists all those people who have held a selected position or who are applying for it, and the dates of their occupancy. This information could be relevant for selecting people with the necessary skills for similar positions.

**Note:** As supplied, this folder displays employees who have held the selected position or who are scheduled to hold it. Your system administrator can create a customized version of the form to display applicants who are currently applying for the position.

The supplied folder also contains a button to open the People window to see further details of an occupant. Your system administrator can change the buttons displayed on this window.

**To view occupants of a position:**

- In the Position window, query a position and choose the Occupancy button.

  Occupants are listed in reverse date order. Where a person has occupied the same position at different times, a separate record is created for each occupancy.

**To see further details of occupants or applicants:**

- Select the person’s record in the Position Occupancy folder and choose the Person button.

  **Note:** There is no restriction on the assignments you can view in the Position Occupancy folder. However, you cannot view further details if you do not have clearance to view that person’s records.
Creating Position Hierarchies

You can create and maintain your reporting structures in two ways:

- using the Position Hierarchy window
- using the Position Hierarchy Diagrammer

The Hierarchy Diagrammer, included with Oracle HRMS, enables you to create your position hierarchies graphically, and make intuitive drag-and-drop changes to them.

See: Hierarchy Diagrammers Online Help

This topic explains how to use the Position Hierarchy window. Always define hierarchies from the top position down.

Prerequisites

- Define the top position in the hierarchy, and at least one position subordinate to it.

To create a new position hierarchy:

1. Enter a unique name, and check Primary if it is your main reporting hierarchy.
2. Enter the version number and start date for the hierarchy.

You can copy an existing hierarchy. See: To copy an existing hierarchy, below.
3. Query the top position name into the Position block.
   The Holder field displays the name of the employee who holds this position. If there is more than one holder, this field displays the number of holders. You can choose the List icon from the toolbar to display the list of holders.

4. In the Subordinates block, select the immediate subordinates for the top position.

5. To add organizations below one of these immediate subordinates, check the Down check box for the position.
   The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.

   **Attention:** The list of positions from which you can select in the Subordinates block includes positions that are already in the hierarchy. If you select such a position, you will move it and all its subordinates within the hierarchy.

   See: Changing Position Hierarchies: page 3 – 23

▶ To create a new version of an existing hierarchy:

   1. Query the name of the hierarchy.
   
   2. In the Version field, use the Down Arrow to move through existing versions of the hierarchy until you reach a version number for which no other data appears. Enter the start date for the new version.

   **Note:** Overlapping versions of a hierarchy cannot exist. Whenever you enter a new version of a hierarchy, the system automatically gives an end date to the existing version. Oracle HRMS retains the records of obsolete hierarchies so you do not lose historical information you may need.

   You can copy an existing hierarchy. See: To copy an existing hierarchy, below.

   3. Query the top position name into the Position block.
   
   4. In the Subordinates block, select the immediate subordinates for the top position.
   
   5. To add positions below one of these immediate subordinates, check the Down check box for the position.

   The Position block now displays the position you selected. You can add subordinates to this position. To return to the previous level, check the Up check box.
To copy an existing hierarchy:

1. Enter or query the name and number of your new hierarchy version and choose the Copy Hierarchy button.
2. Select the name and version number of the hierarchy you want to copy.

Details of this hierarchy then appear in the Position and Subordinates blocks. You can change these.

See Also

Dated Information and Hierarchy Versions: page 1 – 10

Changing Position Hierarchies

To add new positions to an existing hierarchy, query the hierarchy and version you want to change, query the parent position for the one you want to add, and select the new position in the Subordinates block.

To change the top position in an existing hierarchy, query the hierarchy and version you want to change, query the new top position, and select the previous top position in the Subordinates block.

You can move a position and all of its subordinates within a hierarchy. To move a position, query the hierarchy and version you want to change, query the new parent position for the one you want to move, and select the position to move in the Subordinates block.

Deleting Position Hierarchies

To delete a position hierarchy, you must first remove the subordinate positions from the hierarchy, starting at the lowest level. You cannot delete a position hierarchy if other versions exist, or if a security profile uses it.
Position Hierarchy Report

Oracle HRMS includes a standard Position Hierarchy Report to display the relationship between the positions in a hierarchy. The report also lists the current holders of each position in the hierarchy.

You run reports in the Submit Requests window.

To run the Position Hierarchy Report:

1. In the Name field, select Position Hierarchy.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Position Structure field, select the hierarchy. If there are multiple versions, select a version.
   If the effective date lies between the version’s start and end dates, the report shows information for the effective date. If it lies outside these dates, the report shows information for the start date of the version.
5. In the Parent Position field, select the highest position in the hierarchy that you want to see on the report.
6. Enter Yes in the Holders Shown field to see holders’ names.
   If there are more than ten holders, you see the number of holders only.
7. Choose the Submit button.
Making Mass Updates

You can use the Mass Move feature to reorganize your Business Group, either within an organization or between organizations.

You can move assignments between existing positions, create new positions in which to move assignments, and change the grade, GRE/Legal Entity, or location and standard conditions of an assignment.

Business Group reorganizations often entail changing many employee records in the same way. Because Mass Move allows you to modify multiple employee records at once, you can make such changes conveniently.

These topics are covered:

- Preparing for your mass move: page 3 – 26
- Performing tasks to complete your mass move: page 3 – 28
- Managing your collection of mass moves: page 3 – 35
Preparing for Your Mass Move

To prepare for your mass move, you must make certain decisions and ensure that certain prerequisites are in place.

Making Decisions for Your Mass Move

- What is my source organization? (The mass move transfers assignments from the source organization.)
- What is my target organization? (The mass move transfers assignments to the target organization. The target organization can differ from or be the same as the source organization.)
- What is the effective date for the mass move?
- What are the source position(s)? (The mass move transfers assignments from the source position(s) within the source organization).
- Do you want to deactivate the source position?
- What are my target position(s)?
- If my target position(s) are new, will their location and standard conditions be copied from the source position, target organization, or Business Group?
- What grades are valid for the target position(s)?
- Which assignment(s) will transfer from my source position(s) to my target position(s).
- Will the grade of any transferring assignment change during the mass move?
- Will the GRE/Legal Entity of any transferring assignment change during the mass move?
- Will the location and standard conditions of any transferring assignment change during the mass move?

Prerequisites for Your Mass Move

To prepare for your mass move:

- Make sure you have access to a responsibility linked to the Business Group within which the mass move will take place.
  See: Accessing Business Groups: page 2 – 18
- Check that the source and target organizations for your mass move already exist in the HRMS database.
  See: Creating an Organization: page 2 – 20
See Also

Performing Mass Move Tasks: page 3 – 28
Performing Mass Move Tasks

Executing a mass move includes the following tasks:
1. Describe your mass move: page 3 – 28
2. Identify your source position(s): page 3 – 29
3. Identify your target position(s): page 3 – 30
4. For each source position, verify the transferring assignments: page 3 – 31
5. For each target position, verify or add valid grades: page 3 – 33
6. Execute the mass move: page 3 – 33
7. Review the mass move: page 3 – 34
8. If necessary, resolve any problems and then reexecute the mass move: page 3 – 34

Describing Your Mass Move

To define your mass move, the first task involves entering a description, determining the source and target organizations for the mass move, and specifying the date on which the mass move will take effect.

To describe your mass move:
1. Navigate to the Mass Move window.
2. Enter a description of the mass move you want to perform.
   
   You can change this description at any time before the mass move is processed.
3. Select the source and target organizations for the mass move.
   
   The source and target organizations can differ or be the same. The lists includes organizations that have been defined for the Business Group.
   
   Note: You cannot create a target organization "on the fly."

   You can change the source and target organizations for this mass move at any time until you choose the Find button on the Find Positions window. These definitions then become part of the permanent definition of the mass move and cannot be changed.

   Status is a display field that indicates whether the mass move has not yet been executed (Unprocessed), successfully executed without
errors or warnings (Complete), successfully executed without errors but with warnings (Complete with Warnings), or unsuccessfully executed with no changes made (In Error).

4. If necessary, adjust the effective date of the mass move.
   You can adjust the effective date at any time before the mass move is processed.

5. Save your work.

---

**Identifying Your Source Positions**

After describing your mass move, you must identify source position(s) to be moved.

► **To identify your source positions:**

1. In the Mass Move window, choose the Positions button.

2. In the resulting Find Positions window, select source job(s) and the source position(s) associated with those job(s).
   
   You can select from a list of existing job(s) and position(s) in the source organization, or you can use generic search criteria (wildcards) to identify a pool of source jobs and source positions from which you will select your source positions in Step 3.

3. Choose the Find button.
   
   When the Mass Move – Positions window is populated with information, the source and target organizations you defined in the Mass Move window appear in display fields.

4. If you used search criteria to identify a pool of source jobs and positions, make sure that the list includes all of the source jobs and positions you want to include in this mass move.

   **Attention:** If you want to add source jobs or positions to this list, you must delete this mass move and define a new mass move; source job(s) and position(s) cannot be added to this list.

5. In the move check boxes, check each of the source positions you want to move.
   
   Assignments associated with unchecked source positions will not be affected by the mass move in any way.

6. If you want to deactivate any source position on the effective date for the mass move, check the Deactivate Old Position check box when that position is selected.
Selected: Deactivating a source position does not delete it from the HRMS database, but enters the mass move effective date as the end date for the position.

Unselected: Leaving this check box unchecked allows assignments to be assigned to this source position after the effective date of the mass move, even though the source position may have no assignments immediately following the mass move.

Attention: Unchecking the Move check box for a record restores the original values for that record.

See Also

Defining Positions: page 3 – 11
Managing Your Mass Move Collection: page 3 – 35

Identifying Your Target Positions

Now that you have identified the source position(s) for your mass move, you are ready to identify its target position(s). For each of the target positions you will define, perform the following steps:

To identify your target positions:

1. On the Mass Move – Positions window, select one source position for your mass move.
2. Select a target job to correspond with that source position. The list includes existing jobs within the Business Group. Note: You cannot create a target job “on the fly.”
3. Choose Edit Field to enter a new target position, or select a target position. The list includes existing positions in the target organization. Note: Each source position can only have one target position. However you can use the same target position for multiple source positions.
4. Select the location and standard conditions for this target position. If this target position is a new position, you can enter location and standard conditions as follows:

Source Position: Indicates that the location and standard conditions of the source position will be applied to the new target position when the mass move takes effect.
Target Organization: Indicates that the location and standard conditions of the target organization will be applied to the new target position when the mass move takes effect.

Business Group: Indicates that the location and standard conditions of the Business Group will be applied to the new target position when the mass move takes effect.

Attention: Unchecking the Move check box for a record restores the original values for that record.

5. When you have identified each of your source and target positions, choose the Assignments button.

See Also

Verifying Transferring Assignments for Each Source Position: page 3 – 31
Defining Positions: page 3 – 11

Verifying Transferring Assignments for Each Source Position

The content of the Mass Move – Assignments window depends on the source position you last selected in the Mass Move – Positions window. The Mass Move – Assignments window displays that selected source position, and its corresponding source organization and source job. It also displays the target position you have entered for this selected source position, and the target organization and job associated with this target position.

All of the (applicant as well as employee) assignments associated with the source position you selected in the Mass Move – Positions window are also displayed.

As the Move check boxes show, by default all assignments associated with this source position are selected to move to the target position. The Mass Move – Assignments window allows you to verify these assignments, indicate which ones, if any, will not be moving to the target position, and change the grade, GRE/Legal Entity, location and standard conditions for any of the assignments to be moved.

To verify transferring assignments for each source position:

1. If you want to prevent any of these assignments from moving to the target position, uncheck the appropriate Move check boxes.
2. If you want to change the grade for any transferring assignment, select the assignment, and then select another grade for that assignment.

3. If you want to change the GRE/Legal Entity for any transferring assignment, select the assignment, and then select another GRE/Legal Entity for that assignment.

4. If you want to copy location and standard conditions for a transferring assignment from an entity other than the current assignment (default), select the assignment, and then select the new location and standard conditions for that assignment. The options follow:

   **Current Assignment**: Indicates that the transferring assignment will maintain its current location and standard conditions when the mass move takes effect.

   **Source Position**: Indicates that the location and standard conditions of the source position will be applied to the transferring assignment when the mass move takes effect.

   **Target Organization**: Indicates that the location and standard conditions of the target organization will be applied to the transferring assignment when the mass move takes effect.

   **Business Group**: Indicates that the location and standard conditions of the Business Group will be applied to the transferring assignment when the mass move takes effect.

   **Attention**: Unchecking the Move check box for a record restores the original values for that record.

5. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Assignment window.

   When the Mass Move – Positions window reappears, you can repeat the above steps for any other source positions whose transferring assignments you choose to verify. Otherwise, you are ready to verify or add valid grades for any target(s) jobs/positions.

See Also

- Entering a New Assignment: page 14 – 9
- Representing the Employer: GREs: page 2 – 9
- Site Locations: page 2 – 2
Verifying or Adding Valid Grades for Each Target Position

Because it is possible for the grade of a transferring assignment to be outside the bounds of the valid grades for the target job or target position, you can use Mass Move to add valid grades to the target position.

1. On the Mass Move – Positions window, choose the Valid Grades button.

   The resulting Mass Move – Valid Grades window displays information for the source position you last selected in the Mass Moves – Positions window. It displays the valid grades for the target position:

   • A newly-created target position has the same valid grades as the source position.
   • An existing target position retains its existing valid grades and Mass Move adds any other grades that are valid for the source position.

   Thus Mass Move accommodates the grade(s) of the transferring assignment(s). You cannot delete any of the valid grades.

2. Optionally, select additional valid grades for the target position.

3. To save your work and then return to the Mass Move – Positions window, close the Mass Move – Valid Grade window.

   When the Mass Move – Positions window reappears, you can select any other records, to verify or add valid grades for that target position.

See Also

Valid Grades: page 3 – 16

Executing the Mass Move

2. Save your work when prompted to do so.
3. On the Mass Move window, choose the Execute button.

   If the number of changes being made is large, executing the mass move may take some time.
Reviewing the Mass Move

After you have chosen the Execute button on the Mass Move window, you are ready to review the results.

To review the mass move:

1. On the Mass Move window, review the contents of the Status field.
   - **Unprocessed**: Indicates that you have not yet executed the mass move.
   - **Complete**: Indicates that the mass move completed successfully without errors. For historical purposes, completed mass moves are automatically archived and cannot be modified.
   - **Complete with Warnings**: Indicates that the mass move completed successfully. Nevertheless, you should still review any warning messages the mass move generates. It is possible for a mass move to execute with Status=Complete with Warnings, yet without all assignments moving as you intended.
   - **In Error**: Indicates that the mass move did not complete successfully and that no changes took effect. You must first resolve the offending conditions before you can successfully reexecute the mass move.

   **Attention**: If the Status field shows In Error or Complete with Warnings, the Message button appears next to the Positions button.

2. If the Message button is displayed, review the messages.
   The Message window that appears includes the following fields:
   - **Type**: Type of message; Warning or Error.
   - **Row Information**: If this field displays a position name, the message applies to a source position. If this field displays the name of a person, this field applies to the assignment associated with that person.
   - **Message**: Text of the message.
   - **Note**: The Explain button on the Message window is disabled if no additional information is available.

3. If the Status field shows Complete or Complete with Warnings, navigate to the Mass Move – Assignments window and verify that the mass move changes you wanted to make did in fact take effect. Then navigate back to the Mass Move window.

Resolving Problems and Reexecuting a Mass Move

If the Status field on the Mass Move window shows In Error, you need to resolve the problems and reexecute the mass move until the Status
field shows Complete or Complete with Warnings. If the Status field shows Complete with Warnings, you will want to investigate those Warnings, and then determine whether you want to resolve the warning conditions and reexecute the mass move to eliminate the warnings. (However, it is important to remember that a mass move complete with warnings has in fact executed successfully.)

Resolving problems may require that you exit Mass Move. For example, an applicant assignment associated with a vacancy will not move during a mass move. To move that assignment to the target position, you would need to use the Assignment window to disassociate this applicant assignment from the source position, and then assign this applicant to a target position.

To reexecute a mass move:
1. Navigate to the Mass Move window.
2. Query the mass move that you previously saved and want to reexecute.
3. After the Mass Move window is populated with data, make whatever changes you need to make to correct the mass move definition.

Attention: Since assignments are datetracked, you may only update a given assignment once a day. To bypass this rule, you can alter the mass move effective date.

If you query a previously saved mass move and then choose the Positions button, the Find Positions window is not displayed. Instead, the Mass Move – Assignments window immediately appears and is populated with data.
4. Choose the Re–execute button.
5. Review your mass move in the standard manner.

Managing Your Mass Move Collection

As you reorganize your Business Group over time, you will develop an historical archive of mass moves. This archive consists of:

- All executed mass moves for which Status=Complete
- Any executed mass moves for which Status=Complete with Warnings
- Any saved but unexecuted mass moves (Status=Unprocessed or Status=In Error) that you have not deleted
Because it is important to maintain an historical record of Business Group reorganizations, you cannot delete a mass move when its status is Complete or Complete with Warnings. However, you can delete any unexecuted mass moves you chose to save but which have a status of Unprocessed or In Error.

Reexecuting a mass move overwrites its original contents. Thus, only the latest reexecution of that mass move would appear in the historical archive.
Grades and Their Relationship to Pay

This chapter explains how to represent the grade structures used in your enterprise and how to relate compensation to grades. You can relate compensation to grades directly, using grade rates, or indirectly, using grade scales.
Representing Grade Structures

Grades can have different levels of complexity, which need to be represented in the overall structure of the grade.

In its simplest form, a grade can be a single character, or number, in a logical sequence. For example:

- grade A
- grade B
- grade C

By adding a second segment to the grade name, you can identify sub–grades, such as:

- grades A.1, A.2, A.3, and A.4
- grades B.1 and B.2
- grades C.1, C.2, and C.3

A more complex structure could be used to distinguish grades for different staff groups, such as:

- Clerical.C.1 and Clerical.C.2

In this example, there are three segments in the grade name. A grade is the combination of segments you define. You set up the segments and their valid values using the Grade Name Key Flexfield. Normally this is done by the system administrator.
Using Grades

Grades are normally used to record the relative status of employee assignments and to determine compensation and benefits, such as salary, overtime rates, and company car.

Using Grades to Compare Roles

You can define one or more valid grades for each job or position. You enter this information in the Valid Grades window, which opens from the Job window or the Position window.

When you enter a grade assignment, the list of grades shows which ones are valid for the job or position you select.

See: Valid Grades: page 3 – 16

Associating Grades with Compensation and Benefits

You can associate compensation and benefits with your grades. For example, you can record a minimum or maximum salary for a grade. There are two approaches:

- Using grade rates, you can either enter a fixed value for each grade, or you can enter a minimum, maximum, and mid-point values for each grade.

- Using grade scales, you can associate each grade with several points on a pay scale, and enter compensation values for these points.

Attention: The compensation information can change independently of the grade. Therefore, you should not define it as part of the grade name. Instead you should relate it to the grade, either directly or indirectly.
Defining Grades

Prerequisites

- Define all the segments of the Grade Name key flexfield that you want to use for the grade name.

To define a grade:

1. Enter your grades in sequence number order.
   
   The sequence number can be any number from 1 upwards. The number indicates the rank order of the grade; 1 indicates the highest grade.

   This is the sequence in which the grades appear to users in lists of values.

   Consider sequencing each grade at intervals of 10 or more, to accommodate any future changes to grades.

2. Enter a unique name for the grade. If there is more than one segment in the grade name structure, a window opens when you enter the Name field. You must enter a unique combination of segments.

3. Enter a start date early enough to handle any historical information you want to enter.

4. Save your work.
Deleting Grades

To remove a grade from the list of grades to which employees can be assigned, enter an end date against the grade.

To delete a grade entirely from the system, you must first reassign anyone assigned to the grade. If you have historical records using the grade, you cannot delete it. Instead, enter an end date.
Grade Relationships to Compensation and Benefits

In many enterprises there are rule based reward structures based on grade. These rules can relate grades and pay directly or indirectly.

Direct Relationship

You may have a salary administration system in which the actual level of pay normally falls between a minimum and a maximum value for a grade. Regular performance reviews and ratings can involve comparison with the mid-point value of pay for your grade. In Oracle HRMS, this is a grade rate.

Indirect Relationship

You may be using a step based system of progression points within grades, in which each point has a fixed value in a pay schedule or table. In Oracle HRMS this is a pay scale.
Relating pay to grades indirectly is common in government, education and health enterprises. It is also common in large commercial enterprises that negotiate pay levels with staff or union representatives.
Relating Pay to Grades Directly: Using Grade Rates

In Oracle HRMS, you can set up a table of values related to each grade. These are called grade rates. You can enter a fixed value or a range of valid values for each grade.

For example, you might define a salary rate and an overtime rate of pay for every grade, with minimum, maximum, and midpoint values. Both rates would be in monetary units. However, you can also define rates with non–monetary units, such as days, hours, or numbers.

Grade rates are datetracked and this means that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

You can use your grade rate values:
- as part of a QuickPaint report or inquiry
- to validate salary proposals
- to validate other compensation entries you make for employees
The salary administration process validates salary proposals automatically against the appropriate grade rate. You can use *formula validation* to check other compensation entries.

**See Also**

Salary Administration and Performance Reviews: page 9 – 2
Using Oracle FastFormula for Validation, Oracle FastFormula User’s Guide

---

**Defining Grade Rates**

You define grade rates in the Grade Rate window. When you save your definition, an automatic process creates corresponding *database items* that formulas can access.


---

To define grade rates:

1. Set your effective date to a date early enough for any historical information you want to enter.
2. Enter a name for the grade rate and select the units for measuring it. Save your new rate.
3. In the Grade Rate Values block, select the grades for which you want to define rates. For each grade, enter a fixed value and/or a minimum, maximum and mid value.
To use this grade rate to validate salary proposals entered in the Salary Administration window, you must enter a minimum and maximum value.

To view comparison values using this grade rate, you must enter a mid value.

See Also

Viewing Grade Comparisons

The View Employee Grade Comparison window compares the compensation values you enter for employees with the minimum, maximum, and mid values you define for their grades.

Prerequisites

- Define a grade rate and enter minimum, maximum, and mid values for each grade.

- Enter salary or other compensation values for your employees.

To view employee grade comparison values:

1. Select an element, an input value, and a grade.

   The inquiry finds assignments that are on this grade and that have an entry for this input value.
2. Select a grade rate for which you have defined a range of valid values.

The inquiry compares the minimum, maximum, and mid values for your chosen grade with the element entries of the list of assignments.

3. Choose the Find button to run the inquiry.

The folder in the lower part of the window lists the assignments that match your selection criteria:

- The value is the element entry value for each assignment.
- The comparatio shows the assignment’s element entry as a percentage of the mid–value defined for the grade rate.
- The percent of range shows the position of the assignment’s element entry between the minimum value for the grade rate (0%) and the maximum value (100%).

**Part Time Employees**

Employee are part time if the hours on their assignment’s standard conditions are less than the work day hours entered for their organization. For part time employees, the system prorates the minimum, maximum, and mid grade rate values before calculating the comparatio and percent of range.
Relating Pay to Grades Indirectly: Using Pay Scales

If you are involved in negotiating pay levels with staff or union groups, you may be using a system of grade steps or points with specific values of pay for each step, or point. For example, you may have negotiated different pay scales with different union groups. Or, you may have negotiated a single set of pay points for all of your employees.

Typically, employees are placed on a step within their grade. They move up the steps for the grade by a periodic incrementing process. This process might run automatically at a fixed time each year or it might be based on a review process specific to the employee.

In Oracle HRMS you set up a pay scale to show the separate points and the value negotiated for each point. You can set up any number of pay scales, for example for negotiated pay scales with different unions.

Setting Up Pay Scales

To set up a pay scale:

1. Create the pay scale itself, which is a set of progression points.
2. Define one or more rates associated with the pay scale, entering a value for each progression point.
3. Define your grade scales, which are the points of the pay scale that are valid for each grade.

You can define the rates before or after you define the grade scales.

Using Pay Scales

You manually place an employee on the appropriate grade step. You can use a process to automate the periodic incrementing of the grade step placements for some or all employees.

See Also

Incrementing Grade Step Placements: page 4 – 18
Placing an Employee on a Grade Step: page 4 – 16
Defining a Pay Scale

You define a pay scale, which is a set of progression points for compensation, in the Pay Scale window.

To define a pay scale:

1. Enter a unique name for the pay scale.
2. Enter the Increment Frequency for this pay scale. For example, if you want to increment the placement of assignments on the pay scale once each year, enter 1 in the Number field and select Year in the Per Period field.

   **Note:** These values provide information only. You can use the Submit Requests window to set up automatic regular incrementing of grade step placements by the Increment Progression Points process.

   See: Incrementing Grade Step Placements: page 4 – 18

   The Automatic Increment field shows the date of the last automatic increment.

3. Save the pay scale.
4. Enter the names of the points (or steps) of the scale. The Point names can be numeric or alphanumeric. Enter them in ascending order.
5. Enter a sequence number, in ascending order, for each point. The sequence determines the progression order for the incrementing process. Then save the scale again.

**Suggestion:** Enter sequence numbers in multiples of 5 or 10, for example 5, 10, 15, 20. This makes it easier to enter new points between existing points in the sequence if you need to in the future.

---

**Defining Scale Rates**

In the Scale Rate window, you can create a rate and enter a fixed value for each progression point on a pay scale. You can create as many rates as you require, such as one for a shift allowance, and another for overtime. Notice that, unlike grade rates, you can only enter a fixed value for each point; you cannot enter a range of valid values.

The values are datetracked so that you can keep the history of the actual values you use. You can also set up rate values at a future date and be sure that this information will automatically take effect on the date you set, and not before.

The rates can be defined in monetary units, or as integers, numbers, days, or hours, in various formats. For example, you could define a rate in hours to specify the maximum number of overtime hours that can be worked per week.

When you define rates, an automatic process creates corresponding *database items* that formulas can access.

See: Dynamic Database Items: page C – 19
To create a scale rate:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Enter a unique Name for the rate.
3. Select the Units for measuring the rate, such as hours, money, or integer.
4. Select the Pay Scale for which you are defining the rate.
5. Save the rate.
6. In the Progression Point Values block, select the points for which you want to define rates. For each point, enter a fixed value. Save the rate again.

Relating Grades to Progression Points

A pay scale defines a complete set of progression points. You can associate a subset of these points with each grade.

The group of points valid for a grade is called a *grade scale*. Each point in the grade scale is called a *step* because it represents the steps for incrementing an employee’s pay. The steps must follow the sequence of points on the pay scale but they can jump several points, if appropriate to the specific grade.
To create a grade scale:

1. Set your effective date early enough to handle any historical information you want to enter.
2. Select a grade, and select the pay scale from which you want to choose progression points.
3. Select the highest point (or ceiling) to which employees on this grade can be automatically incremented by the Increment Progression Points process. Save the grade scale. You can override this ceiling for individual employee assignments.
4. In the Grade Steps block, select the points you want to include on this grade scale.

When you save, the system sorts the points into ascending order by their sequence numbers (defined in the Pay Scale window).

Placing an Employee on a Grade Step

If you include a grade as part of an employee’s assignment, you can place the employee on a step on the associated grade scale.

You place an employee using the Grade Step Placement window. When you open this window, information about the grade and scale
appears automatically. By default, the ceiling point is the one you defined for the grade. However, you can enter a special ceiling point for individual employees in the Assignment window.

To place an employee on a grade step:

1. Set your effective date to the date when the placement should come into effect.
2. Select the point or step on which to place the employee assignment.
3. If you want the employee’s placement to increment automatically when you run the Increment Progression Points Process, check Auto-Increment.
4. You can select a reason for manually entering a placement. You can add values to the list of valid reasons by defining values for the QuickCode Type PLACEMENT_REASON.
5. Save your work.

The Progression Point Values block displays the rates you have defined for the pay scale, and the values corresponding to the selected progression point.
Incrementing Grade Step Placements

You can increment grade step placements manually, using the Grade Step Placement window, or automatically, by running the Increment Progression Points process.

To run the Increment Progression Points process:

1. Navigate to the Submit Requests window.
2. In the Name field, select Increment Progression Points.
3. Enter the Parameters field to open the Parameters window.
4. Enter the name of the pay scale.
5. Enter the date on which the increment becomes effective.
6. You can also enter values for some or all of the segments of your People Group Flexfield. This restricts the assignments incremented by the process to those in the group matching the values you enter.

Attention: An assignment’s grade step placement is incremented automatically only if:
   • it is still below the ceiling point, and
   • the automatic increment check box on the Grade Step Placement window is checked for the assignment, and
   • there are no future changes or deletions to the assignment’s grade step placement, or to the assignment itself, or to the grade scale for the assignment’s grade, or to the new grade step for the assignment.

Oracle HRMS supplies two predefined reports to help you predict and check the results of the Increment Progression Points process.

Current and Projected Progression Point Values Report

Run this report before running the Increment Progression Points process, to assess its effects. The report shows what changes would be made by the process and how much it would cost for a particular scale rate, such as salary, or for all rates.

You run reports in the Submit Requests window.

To run the Points Values Report:

1. In the Name field, select Current and Projected Progression Points Values Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and enter the date on which the increment would become effective.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.

**Employee Increment Results Report**

Run this report after running the Increment Progression Points process. This report shows the results of the process.

You run reports in the Submit Requests window.

➢ **To run the Employee Increment Results Report:**

1. In the Name field, select Employee Increment Results Report.
2. Enter the Parameters field to open the Parameters window.
3. Select a Pay Scale and the increment process run for which you want to see the results.
4. You can also select an organization, a group, and a rate, to reduce the scope of the report.
5. Choose the Submit button.
Payrolls and Other Employee Groups

This chapter explains how to set up payrolls to pay your employees and to define groups of employees who are eligible to receive particular compensation and benefit elements. It also explains how to define payment methods for paying employees and making third party payments.

Using all the work structures you set up, you can identify groups of employees by organization, job, position, grade, employment category, salary basis, or payroll. Additionally, you may need to set up your own groups, for example to identify employees within a trade union, or a pension group. This chapter explains how you can set up your own groups using the People Group Key Flexfield.
Representing Payrolls

In Oracle Payroll you set up payrolls to pay your employees. An employee must have an assignment to a payroll in order to receive pay. Both human resources and payroll users can also use payrolls for other purposes:

- to identify specific groups of employees for inquiry or reporting purposes
- to define eligibility for certain compensation elements
- as part of security definitions, to restrict access to the records of certain groups of employees on the system.

**Note:** You must define payrolls in order to use nonrecurring elements. You can use these elements to represent types of compensation and benefits, and to maintain absence balances for your employees.

See: Element Processing Types: page 7 – 23

You can define as many payrolls as you require to represent groups within your workforce. You might need to define multiple payrolls for the following reasons:

- You require different payment frequencies (weekly or monthly) for different groups of employees.
- You need to restrict access to certain payroll information for reasons of confidentiality.

*Figure 5 – 1  
Multiple Payrolls in a Business Group

Each payroll has its own processing calendar, key dates, costing information, and valid methods of making payments to its employees.*
Payroll Setup Steps

1. Define the various payment methods in use in your GREs.
   See: Defining Payment Methods for the Enterprise: page 5 – 3
2. For GREs using payrolls with payment methods of the type NACHA to pay employees, enter data for the NACHA tape batch headers.
   See: Entering NACHA Tape Data for GREs: page 5 – 5
3. Define the payrolls in use in your GREs.
   See: Defining a Payroll: page 5 – 6

Defining Payment Methods for the Enterprise

Each payment method has a type of either check, NACHA, or cash. Within these payment method types, you can define as many payment methods as you require for your enterprise. When you create a payroll you can select which of these methods are valid for employees assigned to that payroll. You select one of these methods as the default method for the payroll.

Employees can be paid by one or more of the valid methods for their payroll. You select the appropriate methods and enter bank account information, if required, in the Personal Payment Method window. If you do not enter any personal payment methods, the employee is paid using the default method for his or her payroll.

You can also define payment methods for third party payments, such as court-ordered wage attachments. Third party payments are always made by check, so methods for these payments must have the type Check.
Define payment methods for the enterprise in the Organizational Payment Method window.

To define a payment method:

1. Set your effective date to the date you want to begin using the payment method.
2. Enter a name for the payment method, and select its type.
   You can create as many payment methods for each type as you require. For example, if you have different source bank accounts for different payrolls, you must create separate payment methods.
   For a third party payment method, select the type Check.
3. The base currency for the Business Group appears. For some payment methods, you can select another currency.
4. To define a third party payment method, for example for a garnishment or a payments to a benefits carrier, check the Third Party Payment box.
5. Enter the Bank Details field to open the Bank Details window. Enter information about the account from which payments are coming.
   
   **Note:** The Further Information field is not activated for US installations, so you cannot make entries in it.
6. Save your work.

See Also

Entering Payment Methods for an Employee Assignment: page 14 – 22
Entering NACHA Tape Data for GREs

For GREs using payrolls with payment methods of the type NACHA, enter information for the NACHA tape batch headers in the NACHA Rules window.

To enter NACHA rules for a GRE:

1. In the Organization window, query the GRE if it does not already appear there. In the Organization Classifications region, place the cursor on Government Reporting Entity, choose the Others button, and select NACHA Rules to open the NACHA Rules window.

2. Enter the Company Name, which is the name of the GRE making this batch of direct deposit payments to employees.

3. Select Mixed Debit and Credit Entries, Debit Entries Only or Credit Entries Only in the Service Class Code field.

4. Select either Cash Concentration and Disbursement or Prearranged Payment and Deposit Entry in the NACHA Standard Entry Class Code field.

5. Enter the Company Identification number of the GRE making this batch of payments.

6. In the Company Discretionary Data field, you can enter codes of significance to you, to enable special handling of all subsequent entries in the batch. This field has no standard interpretation.

7. In the Message Authentication Code, you can enter an 8-character code you derive, whose purpose is to validate the authenticity of Automated Clearing House (ACH) entries. This field has no standard interpretation.
Defining a Payroll

A payroll is a set of employees whose pay you process with a single frequency, for example, weekly or monthly. You can define as many payrolls as you require to meet the pay policies of your enterprise. You put an employee on a payroll by assigning him or her to the payroll.

Use the Payroll window to define a payroll, including its calendar and valid payment methods.

Period Types and Calendars

Since a payroll has only one pay frequency, you must define at least one payroll for each pay frequency you use. Table 5 – 1 shows the valid period types for pay frequency.

<table>
<thead>
<tr>
<th>Payroll Period Types</th>
<th>Periods per Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>1</td>
</tr>
<tr>
<td>Semi-Year</td>
<td>2</td>
</tr>
<tr>
<td>Quarter</td>
<td>4</td>
</tr>
<tr>
<td>Bi-Month</td>
<td>6</td>
</tr>
<tr>
<td>Calendar Month</td>
<td>12</td>
</tr>
<tr>
<td>Lunar Month</td>
<td>13</td>
</tr>
<tr>
<td>Semi-Month</td>
<td>24</td>
</tr>
<tr>
<td>Bi-Week</td>
<td>26</td>
</tr>
<tr>
<td>Week</td>
<td>52</td>
</tr>
</tbody>
</table>

Table 5 – 1 Payroll Period Types

Prerequisites

- Define the payment methods available for your employees.
  
  See: Defining Payment Methods for the Enterprise
To create a new payroll:

1. Set your effective date to a date early enough to handle any historical information you want to enter. Your effective date must be on or before the first period start date of the payroll calendar.

2. Enter the payroll’s name and select its period type from the list.

3. Enter the end date of the payroll’s first period, and the number of years for which the system should initially generate the payroll’s calendar. You can increase this number later to generate additional years.

   When you enter the First Period End Date, make sure that the corresponding start date of the first period is after the start date of the payroll.

4. In the Date Offset region, you can change the zero default to a negative or positive number of days before or after the period end date. For example, for a semi–monthly payroll, the Cut Off date can be 3 days before the period end date (–3), while the Scheduled Run and Check dates can be 5 and 7 days after this date, respectively.

   • The Check Date, sometimes called Pay Date, is the date of constructive receipt of pay, on which paychecks become negotiable.

   • The Scheduled Run Date is the date scheduled for the Regular run of this payroll each period.

   See Regular and Supplemental Runs (Oracle Payroll User’s Guide)

   • The Cut Off date, included for your reference, is the final date for entering or changing payroll information before a run.
These offsets are the defaults for the calendar. You can manually make date changes in the calendar, for example when an offset date falls on a weekend or holiday, by choosing the Period Dates button.

5. Select a default payment method for employees who have no valid personal payment method. You cannot select a method using magnetic tape because this requires information about employees’ bank accounts.

6. Select a default consolidation set for this payroll. One consolidation set is created automatically when you define your Business Group. Oracle Payroll users can create other consolidation sets for payroll processing.

See: Consolidating Payroll Information (Oracle Payroll User’s Guide)

7. In the Costing region, you can enter information about the set of books and suspense account holding costing information for this payroll.

The information you enter here depends on the setup of your Cost Allocation key flexfield.

See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

8. Save your work.

9. Choose the Period Dates button to view the calendar generated for your payroll. In the Period Dates window:

• You can view the default offset dates for every period, and you can manually override any of these dates in any record.

• You can change the payroll’s default Open status in any period to Closed to prevent further element entries. You can also reopen the period if necessary.

Attention: Use this feature with caution. When you perform certain important tasks in Oracle HRMS, the system may automatically create or delete element entries. These tasks include hiring and terminating people, and updating assignments. You cannot change any element entries that span a closed payroll period, and so you may be prevented from performing these tasks.

10. Choose the Valid Payment Methods button to add valid payment methods for this payroll.

In the Valid Payment Methods window, the default payment method for the payroll appears automatically. You can add other methods. First set your effective date to the date you want the method to become valid.

Note: An employee assigned to this payroll can have any number of personal payment methods chosen from those you enter here for the payroll.
Deleting Payrolls

You can delete a payroll if there are no active employee assignments or element links to it. However, if you have run processing for a payroll it is not advisable to delete it. If necessary, define a new payroll and simply discontinue use of the old payroll.
Representing Other Employee Groups

All the work structures provide ways of defining groups of employees at your enterprise, such as groups working at a particular location, or on a certain grade, or in a department. You create the groups by assigning employees to the work structures in the Assignment window.

You can also assign people to:

- an employment category: full-time – regular, full-time – temporary, part time – regular, or part time – temporary
- a salary basis, such as weekly or annual, which defines the duration for which the employee’s salary is quoted

See: Components of the Assignment: page 14 – 5

Oracle HRMS provides a special structure you can use to define any other special groupings of employees your enterprise requires. This structure is called the People Group. Just as with payrolls and other work structures, you can assign employees to these groups, and use them to define employee eligibility for compensation and benefits elements.

Examples of group definitions might be:

- the companies to which employees belong in multi–company enterprises
- members of a union
- members of a pension plan.

Setting Up the People Group Flexfield

The People Group is a key flexfield, like Job Name, Position Name, and Grade Name. As with these other key flexfields, you can define up to 30 segments to hold information you use to identify employee groups in your enterprise.

Using the People Group key flexfield to define your groups is a powerful mechanism because you can:

- link elements to Group flexfield segments so that only employees within the group are eligible for the elements
- inquire and report on individual segments in Inquiry windows and in reports
- use DateTrack to build up a history of the group information
If your enterprise uses pay scales to relate compensation levels to grades indirectly, you can use a People Group segment to specify which employees are processed by the Increment Progression Points process.

Once you decide how to define the Group key flexfield structure and segments, it is the responsibility of the System Administrator to set up this and the other key flexfields. At least one segment of this flexfield must be set up before you can begin entering employee assignments.

**Attention:** If you make any of the People Group segments required, they are required in the Element Link window, as well as the Assignment window. This means that you may have to create multiple element links if you want to use a People Group segment in the eligibility criteria for a link.

For example, suppose you have defined two segments: a Yes/No segment called Fast Track, which is required, and a segment called Pension Plan, which is not required. You want to make an element available only to members of a certain pension plan. However, you must create two element links: one for members of the pension plan who are on the Fast Track, and another for members who are not on the Fast Track.

If there are many possible values for the required segment, the maintenance of multiple links can become a burden so be cautious in making segments of this flexfield required.

**See Also**

*Oracle Applications Flexfield Guide*
Each enterprise has its own unique ‘culture’, which is reflected in the organization of work and in the management of people within the enterprise. Culture also affects the reward systems in operation and the control systems that are required. Although each enterprise is unique, it is possible to identify some common types of enterprise.

This chapter describes three typical enterprise models and suggests how you might implement Oracle HRMS for each of these.

These suggestions are not intended to provide a blueprint for your own implementation, but they should help you to see how you can implement and use different combinations of organizations and jobs, or positions in your own situation.
Project Based Enterprises

Project based enterprises are typically service based industries in which flexibility and organizational change is a key feature. Examples of this type of enterprise are consultancy or construction companies, or small manufacturing or software companies.

At its simplest level, an employee is assigned to work on a single project for a given period of time. For example, an engineer working on a large scale construction project might be assigned to the project for a period of six months. All of his or her work, and costs, are associated with this one project. When this is complete the employee moves on to perform a similar role in another project. In this example you would expect the employee to have a single assignment, with 100% of the assignment costs allocated to a single project. The employee assignment might also contain project specific information, such as location or group information.

In a different situation, an employee might be assigned to a number of projects at the same time. For example, consider an Applications Consultant working for Oracle Corporation. This person is employed as a consultant by a specific organization within Oracle but the project work is undertaken outside Oracle. The consultant performs similar tasks in different implementation projects, and costs are allocated on the basis of actual time spent working on each project. In this example you would expect the consultant to have a single assignment in Oracle HRMS and the project allocation and costs to be entered as timecard information.

In both of these examples, employees perform specific roles, but they work on different tasks or projects at different times. Project based enterprises normally have a fluid organization structure with regularly changing reporting and management lines. This fluidity provides the flexibility required to compete in rapidly changing markets.

Organizations can be formed or transformed at short notice as different projects or management groups are formed. Employees can be assigned and reassigned to these organizations, also at short notice, although they normally retain their basic role, or job.

Representing Organizations and Jobs

In both of the examples given, you need the ability to define and change organization structures easily and quickly. You also must be able to move employees between organizations while keeping the same job. For both of these reasons, you would probably use organizations and jobs to show how people are assigned and managed.
Jobs are independent of organizations. In the Assignment window, you can change the assignment organization or job independently.

![Project based assignments diagram](image)

Typically, you would not define Positions to show this type of working. Positions require additional definition and maintenance, and do not reflect the sort of flexible working environment found in this type of enterprise.

Working with organizations and jobs as the basis of the employee assignment, you can also consider how you would reflect the assignment of the employee to individual projects. There are a number of possible options to consider.

- Use organizations to show actual projects, and assign employees to projects.
  - Useful for single projects. For multiple project assignments you would need to use multiple assignments.
- Use a People Group flexfield segment to hold the project code.
  - An alternative for single projects, where you want to use the organization to show internal management structures. However, for multiple project assignments you would still need to use multiple assignments.
- Use a Cost Allocation Flexfield segment to hold the project code.
  - Useful for both single and multiple project assignments. You can collect project cost information at the work assignment or the timecard entry level.

**Organization Structures**

You should define organizations down to the level of individual managers, and use the manager flag on the Assignment window to identify the manager of each organization. Also, define your primary organization hierarchy to show the detailed management reporting lines among organizations and managers. In this way you can show that employees assigned to an organization are managed by the organization’s manager.
Attention: It is best not to use the Supervisor field of the assignment window to identify managers for individual employees. This field is used to identify a personal supervisor for an employee and is not updated if the supervisor moves to another job or organization.

Job Structures

In this type of environment, jobs show the specific roles employees perform. Therefore, you are likely to have multi-segment job names to distinguish different types and different levels of jobs in the enterprise. For example, you might define a three segment job name with Job Group, Title, and Job Level. An actual job combination might then be ‘Applications.Consultant.Senior’.

Project Allocation and Costing

With this type of implementation, you would probably use the assignment to identify management type reporting. You would identify project-working using a segment of the Cost Allocation flexfield to show Project Code for each assignment.

If you set the qualifier Assignment to Yes for this segment, you could enter percentage costs for the assignment to different project codes. If you set the qualifier Element Entry to Yes for this segment, you could use a timecard element to record and cost the actual hours worked on each project.

See: Costing Information at the Organization and Assignment Levels: page 11 – 9

Other Management Issues

When you consider this environment there are other areas your decisions may affect:

Remuneration Policies

Individual compensation and benefits are often based on personal negotiation, or performance reviews. Therefore you will probably have fewer rules to determine policy and more consideration of the actual values entered for an employee.

Grades and Jobs

Typically grades and jobs are very closely linked. For example, the name Senior Consultant may identify both the role of an employee and his or her relative status and eligibility for compensation and benefits.
You may decide to set up the same structures for both the job and the grade. This will be true if you want to set up rates of pay with minimum and maximum values associated with your grades.

### Budgets

Headcount budgets are usually allocated at the level of the organization, or to the combination of organization and job.

You can calculate your salary budgets from the definition of organization and job headcount budgets, combined with valid grades and grade rate information.

Actual salary costs in an HR environment can be calculated from the actual salaries of assigned employees.

Actual salary costs in an environment including Oracle Payroll can be calculated directly from payroll results.

See: Salary Budgeting: page 9 – 16

### Vacancies and Recruitment

Vacancies are not created by default whenever an employee leaves. Managers often have the freedom to decide if they want to replace an employee, or to recruit to a different role.

The recruitment process is often informal and allows for recruitment by resume, or cv. Individual managers are usually responsible for interviewing and selecting candidates. This may be on a one-to-one basis.

### Career Planning and Development

The need for individual career planning and development is matched by the need to identify skilled employees for specific projects.

Using *Special Information Types* you can easily define experience, education, qualifications or skills requirements for different jobs. Using these sane information types you can enter information under these headings for individual employees. Oracle HRMS includes a skills matching report.
Rule Based Enterprises

The rule-based enterprise is typically a highly structured environment in which all aspects of work and remuneration are well organized and regulated. Common examples of this type of enterprise are found in government, education, health and other public sector industries. A key feature of this type of enterprise is the concern with managing positions, or posts. Positions exist, and are managed independently of people in post.

You can picture the role type organization as a ‘Greek temple’, which rests its strength in its pillars. These pillars are the specialist functions or departments that exist within the enterprise. They are strong and almost independent organizations. For example, the Finance department would have very little involvement in the working of the HR department.

Coordination between the groups takes place at the top of the structure by a narrow band of senior management – the pediment. In this environment it is assumed that this should be the only personal coordination needed. “If the separate pillars do their job, as laid down by the rules and procedures, the ultimate result will be predictable.”

Roles are usually more important than individuals. People are selected for satisfactory performance of a role, which is described so that a range of individuals could fill it. Reward systems are likely to be role or rule-based.

Often, clearly defined procedures exist for every task and process within the enterprise. For example, job descriptions and job evaluation procedures define individual roles and positions of authority. Also, it is common to find that procedures exist to govern communications, such as colored and numbered forms, committee reports, and so forth.

Representing Positions

‘Positions’ are most appropriate for this type of enterprise and provide the finer detail on work structure and line management that is needed in a fixed establishment. Employees are assigned to a position, and by definition to the organization and job for that position.
Because you are focussing on the use of positions and position hierarchies you define organizations to show only the major divisions in your enterprise. You can model the details of these departments and sections using your position hierarchies. (If you also define detailed organizations and hierarchies, you are defining the same structural information twice.)

In this situation, jobs provide an additional level of information for positions, which is independent of any specific organization. For example, you might want to define job types of 'Managerial', 'Executive' or 'Clerical' so that you can identify skill requirements and levels of benefits for each job.

**Position Name**

In this environment you should consider using the segments of the position name to hold other key information about the position. For example you might want to consider using the following as segment values:

- **Cost Code**
  You might want to show the cost center, or a cost code for each position in your establishment. Using the segment of the key flexfield you could use the same list of cost codes as your general ledger.

- **Funding Organization.**
  You might have funding for a position from an external source. For example, government funding.

- **Multiple assignments allowed – Y/N?**
  In Oracle HRMS a position can have any number of holders. You can set headcount budget values to track any variance on budget, or you could use this type of segment to prompt users.
• Current status.
  As part of your position control procedures you may need to mark the status of a position for reporting or management purposes. For example, you can label a position as 'Frozen', 'Vacant' or 'Active'.

  **Note:** You can use the Additional Position Details descriptive flexfield to hold this type of information about positions if you do not want the information to be visible to all users.

**Management Reporting Lines**

You can define a primary position hierarchy to show the management reporting lines for all of your positions. You should find that most of your security and reporting needs are based on this primary hierarchy. Groups are identified by selecting a manager and all the positions that report to it in this hierarchy.

**Other Management Issues**

When you consider this environment there are other areas your decisions may affect:

<table>
<thead>
<tr>
<th>Remuneration Policies</th>
<th>Individual compensation and benefits are often regulated, or based on union negotiated agreements. Reward systems are usually based on the role performed rather than on personal or performance assessment. This may mean that you have to define detailed eligibility rules for compensation and benefits.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comparative Grades and Positions</td>
<td>Valid grades are defined for positions and it is common to use grade steps and progression points. National or union pay scales establish actual rates of pay for a grade and this is independent of performance. An employee is paid the rate for his or her grade and step. Incrementing rules, which determine progression to the next step, are usually part of the plan and are often time-based. Job evaluation methods exist to compare roles across the industry with agreed grading structures and rates of pay.</td>
</tr>
<tr>
<td>Budgeting</td>
<td>Headcount or full-time equivalent budgets are usually set for each position.</td>
</tr>
</tbody>
</table>
You can calculate your Salary budgets from the position budgets, combined with valid grades and progression point information.

In an HR environment you would calculate actual salary costs, at any time, from the current salaries of assigned employees.

In an environment including Oracle Payroll, you would calculate actual salary costs directly from payroll run results.

See: Salary Budgeting: page 9 – 16

**Vacancies and Recruitment**

There is an automatic vacancy when an employee terminates employment. The position exists even when there are no holders.

The stages of the recruitment process and the procedures surrounding these are probably well defined and regulated.

Standard letters for each stage of the process are also likely to be well established.

In this environment people are recruited for their ability to perform a role. You would hold job descriptions and skill requirements for each position using attachments for text and the Special Information Type for structured data.

**Standard Reports**

Typically there is a well defined set of standard reports needed in this environment. Often these are required by government.
Hybrid Enterprise Structures

Many enterprises combine different types of structure for different groups of employees. Typical of these hybrid types are large manufacturing or corporate enterprises where management and administrative roles are fixed into specific organizations, but other roles are managed in a more flexible manner.

In Oracle HRMS you would set up this type of hybrid enterprise using positions for some groups of employees, and organization and jobs for others. For example, in one factory organization you might define a position for the Production Manager, and one job for all production line workers.

Employee Assignments

In this type of enterprise most of your workers would be assigned to an organization and a job. However you would define management positions because they have the characteristics of fixed roles within specific organizations, including the idea of automatic vacancy on termination of the assignment. In each organization you would have only one position. This would be the manager, and by default, any other employee who works in the organization would report to the manager.

Other Management Issues

Other issues for managing groups of employees by position, or by organization and job are the same as for the previous examples.
<table>
<thead>
<tr>
<th>Remuneration Policy</th>
<th>Employees working in unionized jobs participate in negotiated rates of pay and conditions. You would define grade rates or progression points to deal with negotiated pay rates for workers in jobs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salary Administration</td>
<td>Employees in management positions are more likely to have their salary administered personally and be reviewed on their performance. You define grade rates and salary bases to deal with salary administration for employees in positions.</td>
</tr>
</tbody>
</table>
Contract Staff and Other Non-standard Assignments

It is common to find individuals working within an enterprise who do not fit into the general definition of work structures. For example, you may have agency or contract staff working temporarily to cover a vacancy, or you may have external contract staff working as part of a project team.

The way in which you record information for these individuals depends on how you manage them:

- You can treat the assignment for this type of employee in exactly the same way as any regular employee.
- Alternatively, you could set up a different person type to distinguish this type of employee.
- You could define your own types of employment category to distinguish different ways of working at the assignment level.
- You could define and use your own assignment statuses to identify different ways of working in a particular job or position.

However, you might decide that the person does not work in a predefined role, but is simply working in a particular organization for a set period of time. To do this you would assign the employee to an organization only, and focus on the other assignment information for further information.

Attention: A basic rule in Oracle HRMS is that an employee must have an assignment. The minimum work structure required for an assignment is the Business Group.
Elements are special information structures that Oracle HRMS uses to:

- represent the various types of compensation and benefits that make up your employees’ remuneration packages
- represent tangible items distributed to employees, such as uniforms or company cars
- maintain information on employee absences, and represent plans for accrual of paid time off
- build the earnings types, deductions, non-payroll payments and other items that the payroll run processes

This chapter discusses the creation and use of elements in Oracle HRMS.
Overview of Elements

Oracle HRMS products use specially designed data structures called elements to hold information about the items included in the remuneration packages available to your employees, and indeed about all the items your enterprise distributes to employees.

Figure 7 – 1
Elements in Oracle HR

In **Oracle HR**, elements provide a versatile and efficient way to represent the following:

- compensation types, including earnings such as salary, wages and bonuses
- benefits such as employee stock purchase and pension plans, and benefit plans for health care coverage, such as medical or dental plans
- employee absences from work
- non-payroll payments such as expense reimbursements
- tangible items you provide to employees, such as tools, uniforms or computers.

In **Oracle Payroll**, elements constitute the underlying structures of all the items the payroll run processes, including the following:

- earnings, supplemental earnings and imputed earnings
• tax credits and non–payroll payments
• voluntary and involuntary deductions, as well as pre–tax and tax deductions
• employer taxes and other employer liabilities.

Features of Elements

Each element has a classification such as Earnings, Voluntary Deduction or Information that determines its particular use. It has input values into which you enter values that can feed into formulas which can, for example, prescribe payroll run calculations for the element. It has a processing type that controls whether it needs new entries in a payroll period to process in that period. Additionally, you supply other rules that determine whether, when and how the element can process, and to whom it can apply.

The remainder of this chapter provides all the basic information you need to understand the use of elements in Oracle HRMS.

The Structure of Elements

To meet the needs of all Oracle HRMS users, elements include the following structural features:

• Classification and category. Every element has a primary classification that determines whether it represents some type of earnings, deduction, payment, benefit or accrual plan, or holds information about tangible items such as company–provided uniforms or tools.

Elements representing benefits additionally have a benefits classification, to indicate the type of benefit they stand for.

Within many primary classifications there are subgroups called categories. Categories further define an element’s purpose, and can help to determine applicable processing or tax rules.

See: Element Classifications and Categories: page 7 – 8

• Input values. An element’s input values exist to receive entries of relevant data for the employees eligible for the element.

For example, the element Annual Salary would likely have an input value Amount, for entries of employees’ yearly salary amounts, while the element Wages would have the input value Hours Worked, for entry of employees’ hours worked each
period. The element Company Car could have the input values Make, Model, Year and Registration Number.

See: Element Input Values: page 7 – 16

• **Formulas.** In Oracle Payroll, entries to an element’s input values can feed into one or more formulas attached to the element, which prescribe calculations for the payroll run to perform. For example, entries of hours worked can feed into a formula that multiplies them by a wage rate, so the payroll run can produce employees’ wages.

See: Elements and Formulas: page 7 – 21

• **Processing types.** Every element has a processing type, to indicate the duration of its entries. An element’s entries for employees may last for one pay period only, such as entries from timesheets of hours worked in a week, or entries of the amounts of a one-time bonus. In this case, the processing type is nonrecurring. Alternatively, an element’s entries may last through many pay periods until they are changed or ended. Examples are entries of annual salary, or of company car make and model. Elements with entries like this have the processing type recurring.

See: Element Processing Types: page 7 – 23

• **Other rules.** In addition to the above, elements can have a number of rules that determine a range of matters, such as:
  - whether the element can process in the payroll run
  - whether it can accept multiple entries in a pay period
  - whether employees must complete a specified length of service before receiving entries of the element.

---

**Creation of Elements: Definition or Initiation**

- when Oracle HRMS users manually define them
- when Oracle Payroll generates them in response to users’ initiation of earnings types, deductions, non-payroll payments made through payroll, or other items that process in payroll runs.

**Element Definition**

At Oracle HRMS installations either with or without Oracle Payroll, users define elements that do not process in the payroll run, but do
hold information on things like compensation and benefits, employees’ hours or days absent, and tangible items distributed to employees.

To define an element, use the Element window to perform these basic steps:

- selecting the element classification, and category, if any
- selecting the processing type, and the particular rules applicable to the element.
- setting up each input value the element requires.

See:

- Defining an Element to Hold Information: page 7 – 32
- Defining Benefit Plan Elements at Sites with HR Only: page 10 – 8
- Defining and Linking an Absence Element: page 26 – 9

**System Generation**

In some circumstances the system generates elements, so that users do not need to define them. To set up a plan for employee accrual of PTO (paid time off), the system generates elements needed for plan administration, in response to entry of certain information about the plan.

At installations including Oracle Payroll, the system generates all the elements that process in the payroll run, in response to users’ initiation of the earnings, non-payroll payments and non-tax deductions their enterprise requires. On the basis of information entered in the Earnings or Deduction window, the system generates both the element and other essential components of an earnings, payment or deduction. Altogether, the generated components include:

- the element for the earnings, payment or deduction, with its necessary input values, processing type and rules, and balance feeds already in place
- a basic formula for the element, together with the formula processing rules.

If necessary, a generated element or formula can be modified to exactly meet user requirements.

**Elements Included in Oracle HRMS**

Users at Oracle HRMS installations without Oracle Payroll have two elements already generated for them, Regular Salary and Regular
Wages. These elements are available to use with the salary administration features of Oracle HRMS.

See: Setting Up Salary Administration: page 9–4

Installations with Oracle Payroll include not only Regular Salary and Regular Wages, but also Overtime, Shift Pay, GTL Imputed Income, and Company Car, as well as some basic deductions for garnishments, already generated and available for use.

**Using Elements**

Once an element exists, whether by definition or by generation, you prepare it for use by setting up *links* for it, to specify the eligibility rules that determine which employees in your database can receive entries of it. After its links are in place, you can make *entries* to the element’s input values for eligible employees.

**Figure 7–2**

*Element Utilization*

- **Elements**
  - Structure
    - classification and category
    - processing types and rules
    - input values, and formulas for payroll processing
  - Link
    - eligibility rules
  - Entry
    - manual, automatic
    - batch entry via MIX or PayMIX
    - in payroll runs, entry of indirect results of formulas

**Links for Eligibility Rules**

While an element may occasionally represent a compensation type, benefit, piece of equipment or deduction available to every one of the employees in your enterprise, many of your elements are likely available only to certain groupings of employees. For example, a holiday bonus may be payable just to those employees who work full time. Or, your enterprise may provide company cars only to employees in the Sales Department.
To determine which employee groupings are eligible for an element, you build *links* to the assignment components employees must have to receive entries for the element. For example, the Holiday Bonus element can have a link to the employment category Full Time, or a Radiation Badge element, to the organization Operations Group. Links rule out the possibility of employees getting element entries by mistake.

See: Element Links and Employee Eligibility Rules: page 7 – 25

**Element Entries**

After an element is created and linked, its input values can receive entries for the employees eligible for it. Various ways to make these entries are available. You can manually enter input values for individual employees, or in certain cases set up automatic element entry for all eligible employees. Additionally, the payroll run can itself enter an indirect result of one element’s formula to an input value of another element.

For batch element entry, Oracle HRMS MIX (Mass Information Exchange) provides two facilities:

- the BEE facility, for elements that do not process in the payroll run
- the PayMIX facility, for elements the payroll run processes.

See: Element Entries for Eligible Employees: page 7 – 27
Element Classifications and Categories

Every element has a primary classification, to establish what it represents. Your Oracle HRMS installation includes a set of classifications developed in accordance with US legislative requirements. You cannot add or make changes to this classification set. The table below lists the US element classifications. There is no limit to the number of different elements you can have in any given classification, and no limit on the total number of elements you can use at an installation.

You see that most US classifications are subdivided into several categories. Categories go further than the classifications in determining a particular element’s function. They are also useful for determining how certain rules, such as tax rules, apply to elements within a classification.

See: Maintaining Taxability Rules (Oracle Payroll User’s Guide)

You can make your own additions to the list of available categories as you require.

<table>
<thead>
<tr>
<th>Classification</th>
<th>Categories</th>
</tr>
</thead>
<tbody>
<tr>
<td>Earnings</td>
<td>Regular</td>
</tr>
<tr>
<td></td>
<td>Overtime</td>
</tr>
<tr>
<td></td>
<td>Shift Pay</td>
</tr>
<tr>
<td>Supplemental Earnings</td>
<td>Dismissal Payments</td>
</tr>
<tr>
<td></td>
<td>Educational Assistance</td>
</tr>
<tr>
<td></td>
<td>Deferred Compensation Plans</td>
</tr>
<tr>
<td></td>
<td>Jury Duty Pay</td>
</tr>
<tr>
<td></td>
<td>Moving Expense Reimbursement</td>
</tr>
<tr>
<td></td>
<td>Pensions/Annuities</td>
</tr>
<tr>
<td></td>
<td>Awards and Prizes</td>
</tr>
<tr>
<td></td>
<td>Bonuses</td>
</tr>
<tr>
<td></td>
<td>Commissions</td>
</tr>
<tr>
<td></td>
<td>Cafeteria Plans</td>
</tr>
<tr>
<td></td>
<td>Deceased Employee Wages</td>
</tr>
<tr>
<td>Classification</td>
<td>Categories</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Sick Pay</td>
<td>Group Term Life Insurance</td>
</tr>
<tr>
<td>Travel Expense Reimbursement</td>
<td>Personal Use of Company Car</td>
</tr>
<tr>
<td>Vacation Pay</td>
<td>Non–cash Awards</td>
</tr>
<tr>
<td>Imputed Earnings</td>
<td>PTO Accruals</td>
</tr>
<tr>
<td></td>
<td>Vacation</td>
</tr>
<tr>
<td></td>
<td>Sick</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>Involuntary Deductions</td>
</tr>
<tr>
<td></td>
<td>Garnishments</td>
</tr>
<tr>
<td></td>
<td>Bankruptcy Order</td>
</tr>
<tr>
<td></td>
<td>Federal Tax Levy</td>
</tr>
<tr>
<td></td>
<td>State Tax Levy</td>
</tr>
<tr>
<td></td>
<td>Local Tax Levy</td>
</tr>
<tr>
<td></td>
<td>Child Support Order</td>
</tr>
<tr>
<td></td>
<td>Spousal Support Order</td>
</tr>
<tr>
<td></td>
<td>Alimony</td>
</tr>
<tr>
<td></td>
<td>School Loan</td>
</tr>
<tr>
<td></td>
<td>Credit Debt</td>
</tr>
<tr>
<td></td>
<td>Employee–Requested Payment</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>Deferred Comp 401k</td>
</tr>
<tr>
<td></td>
<td>Health Care 125</td>
</tr>
<tr>
<td></td>
<td>Dependent Care 125</td>
</tr>
</tbody>
</table>
Survey of the Classifications

Each classification, and category within the classification, holds elements with a distinct function.

Earnings, Supplemental Earnings, Imputed Earnings

There are three classifications of earnings types: Earnings, Supplemental Earnings and Imputed Earnings.

Earnings classification elements represent earnings for time worked, as for example salary and hourly wages. The Supplemental Earnings classification includes a variety of special earnings paid in addition to earnings for time worked, as for example bonuses or sick pay.
Elements in the classification Imputed Earnings are for non–cash remuneration such as personal use of a company–provided car, or company–paid premiums for group term life insurance.

Paid Time Off (PTO) Accruals

Elements the system generates to represent plans for accrual of PTO for vacation or sick leave have the classification PTO Accruals, and the category of either Vacation or Sick. You use these elements to enroll employees in the accrual plans. The system also generates elements (with the classification Information) to hold accrued time that employees can carry over to the new year, and accrued time they cannot carry over.

See: Defining a PTO Accrual Plan: page 26 – 24

For entry of amounts of accrued time employees take for vacation or sick leave, you define for each accrual plan an absence element with the classification Information.

See: Defining and Linking an Absence Element: page 26 – 9

Pre–Tax and After Tax Deductions

Elements for deductions taken before taxes, as for example deductions for 401(k) plans or for health care or dependent care reimbursement, fall into the classification Pre–Tax Deductions.

Other non–tax deduction elements fall into one of two classifications, either Voluntary Deductions or Involuntary Deductions. Loan repayments, credit union deductions, insurance premiums and charitable contributions are examples of voluntary deductions. Deductions for court–ordered wage attachments, as for example for tax levies, child or spousal support, or bankruptcy orders, fall into the classification Involuntary Deductions.

Non–Payroll Payments

Elements in this classification produce payments made to employees through the payroll system that are not true earnings. For example, the Expense Reimbursement category of this classification covers non–taxable expense reimbursements.

Because payments in this classification are not earnings, they are never subject to taxes and never feed balances of taxable pay. Payments resulting from the processing of Non–Payroll Payments elements always appear separately from earnings in reports and balance totals.
Tax Deductions, Tax Credits, Employer Taxes

Deductions for employee tax withholding fall into the classification Tax Deductions. Oracle Payroll includes elements representing deductions for the following federal taxes:

- Federal Income Tax (FIT)
- Federal Unemployment Tax Act taxes (FUTA)
- Social Security (FICA–OASDI)
- Medicare (FICA–HI)

At the state level, Oracle Payroll includes elements representing deductions for:

- State Income Tax (SIT)
- State Unemployment Insurance (SUI)
- State Disability Insurance (SDI)
- Workers Compensation (WC).

At the local level, Oracle Payroll includes elements for:

- city tax
- county tax
- school district tax
- head tax.

Tax credits you pay to employees belong in the Tax Credits classification. These are, for example, payments of credits due in accordance with the Earned Income Credit (EIC) plan.

For employer payments for Social Security and Medicare, and for Workers Compensation, SUI and SDI, Oracle Payroll uses elements in the classification Employer Taxes.

Oracle Payroll comes with all the necessary elements and calculations for tax deductions, tax credits and employer taxes already in place. As tax information changes, you receive the necessary updates. Oracle has concluded an agreement with Vertex Inc. making Vertex the supplier of all tax calculations and updates for Oracle Payroll.

See: Tax Balances (Oracle Payroll User’s Guide)

Employer–paid Benefits and Employer Overhead

Elements producing non–tax payments employers make on behalf of their employees belong in the classification Employer Liabilities. The
category Benefits within this classification covers employer payments toward employee benefits such as health insurance or pension plans.

The category Overhead covers charges employers incur for employees apart from benefits payments. For example, an element in this classification can represent the cost of required employee safety equipment.

Information Elements

Many elements may not belong in any of the classifications described above, but nonetheless hold many different types of information you need. These elements belong in the classification Information.

This classification is especially useful for elements that do not process in Oracle Payroll. Such elements might, for example, hold information about tangible items issued to employees, such as cellular phones, identification badges or company cars. Sites that do not include Oracle Payroll use elements in this classification to hold information about employee compensation and benefits.

See: Defining an Element to Hold Information: page 7 – 32

Absence Category

Elements in the Absence Hours category of the Information classification hold hours of time that employees are absent from work.

Straight-time Overtime Hours Category

Elements in the Straight Time Portion of Overtime Pay category hold amounts of straight time pay needed in some states for the calculation of Workers Compensation premiums.

See: Data for Calculation of WC Premiums (Oracle Payroll User’s Guide)

Tax Balance Figures

Elements in this category hold figures resulting from tax calculations. Oracle Payroll uses these figures to feed various tax balances that appear in inquiry windows and on reports.

See: Viewing Tax Balances (Oracle Payroll User’s Guide)

Labor Hours and Regular Hours Categories

The category Labor Hours exists for the predefined element Labor Recording, used to receive entries of salaried employees’ hours worked on a project, when you require this information for transfer to a project accounting or labor distribution system.
The category Regular Hours exists for the predefined element Regular Hours Worked, which receives information on employees’ hours worked during the payroll run, for use in reports.

See: The Earnings Types Regular Salary and Regular Wages *(Oracle Payroll User’s Guide)*

### Classifications and Payroll Run Processing Priorities

An element’s primary classification provides a default processing priority for the element in payroll runs. The default priorities for the element classifications appear in the table below. Lower priority numbers process first.

You can overwrite an element’s default processing priority with another number, when you need to establish the order in which the element processes with respect to other elements. However, because of their special processing requirements, elements in the classifications Tax Deductions, Employer Taxes, and Tax Credits all have the same priority number, which you cannot change.

Sometimes you must prioritize the processing of certain elements for an individual employee. For example, you may need to determine the precise order in which deductions taken for wage attachments process for an employee. You can change the priority numbers of elements entered for an employee using the Entry Values window (accessible from the Element Entries window).

#### Table of Classification Priorities

<table>
<thead>
<tr>
<th>Classification</th>
<th>Priority</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information</td>
<td>0 – 500</td>
<td>250</td>
</tr>
<tr>
<td>Non–payroll</td>
<td>501 – 1000</td>
<td>750</td>
</tr>
<tr>
<td>PTO Accruals</td>
<td>1001 – 1500</td>
<td>1250</td>
</tr>
<tr>
<td>Earnings</td>
<td>1501 – 2000</td>
<td>1750</td>
</tr>
<tr>
<td>Supplemental Earnings</td>
<td>2001 – 3000</td>
<td>2500</td>
</tr>
<tr>
<td>Imputed Earnings</td>
<td>3001 – 3500</td>
<td>3250</td>
</tr>
<tr>
<td>Pre–Tax Deductions</td>
<td>3501 – 4000</td>
<td>3750</td>
</tr>
<tr>
<td>Tax Deductions</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Employer Taxes</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Classification</td>
<td>Priority</td>
<td>Default</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------</td>
<td>---------</td>
</tr>
<tr>
<td>Tax Credits</td>
<td>(no range)</td>
<td>4250</td>
</tr>
<tr>
<td>Involuntary Deductions</td>
<td>5001 – 5500</td>
<td>5250</td>
</tr>
<tr>
<td>Voluntary Deductions</td>
<td>5501 – 6000</td>
<td>5750</td>
</tr>
<tr>
<td>Employer Liabilities</td>
<td>6001 – 7000</td>
<td>6500</td>
</tr>
</tbody>
</table>
Element Input Values

To hold information, elements can have as many as 15 different input values. The particular type of information an input value can accept is determined when it is set up. An input value can accept information with any one of these units of measure:

- alphabetic characters or words
- integers or numbers
- money
- hours and minutes
- date, day or time.

For example, an element to maintain information about company cars can have input values for entries of the car make, model and year, its registration state, the date of its issue to the employee, and its mileage when issued to an employee:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
</tr>
</tbody>
</table>

Example Car Element

Validation for Input Value Entries

To ensure that an input value does not receive incorrect entries, its setup can include one of these ways of validating its entries:

- entry of minimum and maximum values within which entries must fall
- provision of a lookup, that is, a list of values from which an entry must come
- provision of a validation formula that validates entries, written using Oracle FastFormula. For example, for entries of the
amount of a bonus, the formula could check amounts entered against each employee’s length of service and current salary.

For the Company Car element, you can establish validation for input values as in this example:

For the Government Car element, you can establish validation for input values as in this example:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
</tr>
</tbody>
</table>

Example Input Values Validation for Government Car Element

Example Input Values Validation for Company Car Element

Example Input Values Validation for Government Car Elements

### Default Entries for Input Values

The setup of an input value can include entry of a default for the input value. For example, suppose that for most of the employees eligible for company cars, the make is Ford and the Registration State is Massachusetts.

On the Company Car element’s setup, you can enter defaults for its input values as follows:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
</tbody>
</table>

Example Default Entries for Input Values
Default Entries on Element Links

You can supply default entries for input values not only as a part of the basic element setup, but also as a part of setting up the element links that determine an element’s eligibility rules. This means you can enter different defaults for different employee groups.

For example, suppose two groups of employees are eligible for company cars, those on the Monthly payroll and those on the Executive payroll. While most Monthly payroll employees receive a Ford Escort, most executives receive a Ford Mustang. The element for Company Car with a link to the Monthly Payroll looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td>Escort</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
<td></td>
</tr>
</tbody>
</table>

Whereas the link to the Monthly payroll includes the default entries shown above, the Company Car element with a link to the Executive Payroll includes these defaults:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Validation</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Character</td>
<td>Lookup</td>
<td>Ford</td>
</tr>
<tr>
<td>Model</td>
<td>Character</td>
<td>Lookup</td>
<td>Mustang</td>
</tr>
<tr>
<td>Input Value</td>
<td>Unit of Measure</td>
<td>Validation</td>
<td>Default Entry</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------</td>
<td>------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Year</td>
<td>Integer</td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td>Character</td>
<td>Lookup</td>
<td>MA</td>
</tr>
<tr>
<td>Date of Issue</td>
<td>MM–DD–YY</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mileage at Issue</td>
<td>Number</td>
<td>Minimum/Maximum</td>
<td></td>
</tr>
</tbody>
</table>

**Example Default Entries on Executive Payroll Link**

You also enter costing information on a link. For example, if the company car costs for executives are chargeable to a different cost center than the car costs for the Monthly Payroll employees, you can enter the correct cost center on each link.

**See Also**

Making Changes to Links: page 7 – 39

**Pay Values and Payroll Run Processing**

When you have occasion to look at the structure of an element online, you may see an input value named Pay Value at the top of its input value listing. Although the Pay Value appears as an input value, it is different from other input values.

The essential purpose of the Pay Value is to store an element’s run result. For example, suppose the formula for the Wages element is:

\[
\text{Wages} = \text{Hours Worked} \times \text{Wage Rate}
\]

If an employee whose wage rate is $10/hour works 40 hours in a week, the payroll run produces a run result of $400 for him or her. It stores this result in the element’s Pay Value. After the run, you see 400.00 as the Pay Value for Wages.

However, if you give an entry to a Pay Value before a run, during the run this entry becomes the element’s run result. For example, suppose you enter 40 in the Time Worked input value of the Wages element for an employee who earns $10/hour, but also enter $100 in the element’s Pay Value. The run ignores the entry of hours worked and the Wages formula, and simply produces a run result of $100 for this employee.

**Enterable and Non–Enterable Pay Values**

Pay Values sometimes appear as the first input value for elements having the rule Process in Run, providing a place to store run results.
For some elements with the Process in Run rule the Pay Value may be enterable, so you can put in it a run result amount when the element has no formula, or when you do not want its formula to process.

However for generated elements, the Pay Value is usually not enterable. This is because Oracle Payroll provides other ways for you to supply run result amounts for these elements when formulas are unnecessary, or when you need to add to, subtract from or replace calculated run results.

See: Changes to Earnings or Deductions Before a Run (Oracle Payroll User’s Guide)
Elements and Formulas

In Oracle Payroll, you can associate elements with formulas that specify how the payroll run should perform calculations for the element. For example, this is a basic formula for the calculation for the element Wages:

\[ \text{Wages} = \text{Hours Worked in Week} \times \text{Wage Rate} \]

To do their work, formulas must have data inputs. The simple wages formula above needs two inputs for each employee, the employee’s hours worked in the week, and his or her wage rate.

Formula Inputs from Input Values or Database Items

Formulas obtain some of the data they need from entries to their element’s input values. The Wages formula, for example, could locate each employee’s hours worked as an entry to the input value Hours of the Wages element.

As well as getting inputs from input values, formulas can obtain information from database items. These are information items held in the Oracle HRMS database in such a way that formulas can locate and use them. Much database information, including extensive information on employees and their assignments, is available in this form. For example, the Wages formula can locate each employee’s wage rate as a database item.

Oracle FastFormula

The tool for developing Oracle HRMS formulas is Oracle FastFormula. This is a sophisticated product capable of producing all the calculations payrolls require, as for example the calculation of shift differentials or complex overtime payments.

Conditional Logic

Formulas written using Oracle FastFormula can employ conditional logic, so they can produce different run results for different employees or employee groups depending on characteristics of the employees or groups. For example, a formula could determine employees' pay rates by accessing the database items for their job class and length of service.

See: Oracle FastFormula User’s Guide
Formulas for Different Employee Statuses

An element can have several associated formulas, whose applicability depends on the particular status of an employee. For example, the earnings Salary can have a formula that processes for employees whose status is Active, and a different formula for employees with a status of On Leave who are not receiving their full pay. A formula's processing rules determine the employee statuses for which the formula can process.

See: Defining Formula Processing and Result Rules (Oracle Payroll User’s Guide)

Types of Formula Results

Formulas can produce different types of run results. The direct result is the amount of an earnings or deduction, for example, the dollar amount of wages an employee has earned this week. As well as direct results, a formula can also produce indirect results, updates, and stops. The payroll run sends indirect results or updates as entries to the input values of other elements for their formulas to use. It sends stops to other elements to prevent their processing in the run.

Another type of formula result is a message. For example, you can write a formula that checks the length of a text string, and have it issue a message for payroll users if the string is too short or too long. You set up formula result rules to determine the type of each result, and the names and input values of any other elements the result may affect.

See: Defining Formula Processing and Result Rules (Oracle Payroll User’s Guide)

Formulas Included in Oracle Payroll Startup Data

Oracle Payroll comes with formulas already written for most types of earnings and deductions; you select the appropriate one when initiating a particular earnings or deduction.

The system also comes with the calculations for employee tax withholding and employer taxes already in place. When there are changes to taxes, you receive updates. You never need to write or modify tax formulas.

See: Earnings and Deductions Overview (Oracle Payroll User’s Guide)
Element Processing Types

Entries for some elements remain valid until you change them or they reach their end date. For example, if your employees usually get salary increases once a year, entries to the input value Amount of the element Annual Salary are usually good for a year. Entries to the input values Make and Model of the element Company Car remain valid as long as an employee has the same car.

Elements with entries that can remain valid over a number of pay periods, whether the periods are weekly, monthly, or some other length of time, have the processing type recurring.

For other elements, entries are good for one pay period only. These could be, for example, entries of regular hours worked in a period to the Hours Worked input value of the Wages element, or entries of overtime hours worked to the Hours Worked input value of the Overtime element. Entries to these elements should process once only, to produce employees’ wages or overtime pay for a period.

Elements with entries that are valid in one period only have the processing type nonrecurring.

All elements require a processing type of either recurring or nonrecurring.

Frequency Rules for Recurring Deductions

In addition to a processing type, certain elements that process in payroll runs may require frequency rules. These rules are needed for
recurring deductions that should process at regular intervals, but not in every pay period.

For example, you may need to take a recurring deduction for medical insurance just once each month for employees on the Weekly payroll. In this case you give the deduction a frequency rule specifying for this payroll, which period in a month the recurring deduction element should process.

See: Deduction Frequency Rules (Oracle Payroll User’s Guide)
Element Links and Employee Eligibility Rules

Some elements representing earnings, deductions or benefits may be applicable to all your employees, but it is likely that many are available only to certain groupings of employees. To set eligibility rules for elements, you build element links. A link lists one or more assignment components that must be included in an employee’s assignment for him or her to be eligible for the element.

You can build several links for an element, but Oracle HRMS enforces the rule that you cannot build links making employees eligible for an element more than once. For example, if you link the Wages element to the Weekly payroll, the system stops you from building a second link for Wages to the Production Department, because this link would allow Production Department employees on the Weekly payroll to be eligible for Wages twice.

Note: During the installation of Oracle Payroll at your enterprise, creation of links to the Vertex tax elements and to the Workers Compensation elements occurs.

Eligibility Criteria

The assignment components to which you can link elements are:

- the employee’s payroll. If employees on all your payrolls are eligible for an element, you can link it to all payrolls.
- the employee’s salary basis, which establishes the period of time, often hours or months, for which you quote the employee’s salary or wages.
- the employment category, for example, Full Time–Regular or Part Time–Temporary.
- the organization, for example department or section, in which employees work.
- employees’ work location.
- the employee’s job, for example, Associate Professor or Secretary.
- his or her grade.
- one or more groups to which the employee belongs. You set up all the groups that are appropriate for your enterprise. For example, you could decide to group employees by company within a multi–company enterprise, and by union membership.
- employees’ positions. A position is a class of job performed in a particular organization, for example, Associate Professor of Chemistry, or Finance Department Secretary.
Default Input Value Entries and Costing Information on Links

When you build a link for an element, you can make entries of default values to the element’s input values, and you also enter costing information on the link. When necessary you can make changes to the input values or costing information of existing links.

See Also

Default Entries on Element Links: page 7 – 18
Making Changes to Links: page 7 – 39
Element Entries for Eligible Employees

An element’s links establish which employees it can apply to, but do not necessarily determine the employees it actually does apply to. For elements to actually apply to employees, they must receive entries to the element’s input values. Oracle HRMS includes several different ways to make element entries.

Manual Element Entry for Individual Employees

Oracle HR and Oracle Payroll users with access to an employee’s record can use the Element Entries window at any time to make entries to the input values of the elements for which this employee is eligible.

Entries made for elements with the processing type Nonrecurring are valid only for the pay period in which you enter them. Entries for elements with the processing type Recurring remain in effect until you change them, or until they reach their effective end date. To supply an end date for an entry, you delete the entry as of the end date.

See: Deleting Datetracked Information: page 1 – 15

For entry and maintenance of employees’ regular salaries or wage rates, you use the Oracle HRMS feature salary administration. You can enter both starting salaries or wages, and proposals for pay increases (or decreases) using the Salary Administration window. This window gives you the option of coordinating proposed pay changes with the results of performance reviews.

See:

Making Manual Element Entries: page 7 – 41
Salary Administration and Performance Reviews: page 9 – 2

Automatic Entry of Elements and Default Values

For elements with the processing type of recurring, a special type of element link is available to both Oracle HR and Oracle Payroll users, the standard link. The standard link makes element entry automatic for all eligible employees. With this link, the element and all its default input value entries automatically go on record for all eligible employees now and in the future.

For recurring elements that should process for all eligible employees, and that have default input value entries applicable to all or almost all of these employees, standard links save time and help avoid errors.
Example Standard Link for HR Use

Suppose your enterprise has a policy of providing every salesperson with a company car, a Honda Accord. To maintain car information, your HR Department uses the element Company Car with a number of input values, among which are Make, Model, Year and Registration Number.

Suppose your enterprise has a policy of providing every eligible employee with a Ford Escort. To maintain car information, your HR Department uses the element Government Car with a number of input values, such as Make, Model, Year, and Registration Number.

You can make a link for Company Car to the job Salesperson, enter Honda and Accord as defaults for the input values Make and Model, and mark the link as Standard. With this link, the Company Car element and its default input value entries automatically go on record both for every employee currently assigned to the job Salesperson, and for every employee assigned this job in the future.

The Company Car element with a standard link to the job Salesperson looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make</td>
<td>Honda</td>
</tr>
<tr>
<td>Model</td>
<td>Accord</td>
</tr>
<tr>
<td>Year</td>
<td></td>
</tr>
<tr>
<td>Registration State</td>
<td></td>
</tr>
</tbody>
</table>

Example Standard HR Link

Example Standard Link for Payroll Use

Suppose your enterprise has an employee Sports Club, whose members all agree to pay $5 club dues each month by payroll deduction. You record participation in the Sports Club by setting it up as a kind of employee group, and including membership in this group in employees’ assignments.

After initiating a recurring voluntary deduction called Sports Club Dues, you can link the deduction element to the employee group Sports Club, mark this link as Standard, and make a default entry of $5.00 to the input value Amount. Because the link is Standard, the deduction with its default amount of $5 goes automatically on the records of all current and future club members.
The Sports Club Dues element with a standard link to the group Sports Club looks like this:

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Default Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>$5.00</td>
</tr>
</tbody>
</table>

**Example Standard Payroll Link**

**Batch Element Entry Using MIX Facilities**

For a number of different purposes, you need a way to rapidly make entries to elements for many employees at once. Oracle HRMS MIX includes the **BEE** (Batch Element Entry) and **PayMIX** facilities for batch element entry. BEE is used for non-payroll element entries, for example, entries that serve to enroll employees in benefits or accrual plans. PayMIX is available for Oracle Payroll users for batch entry of:

- timecard data
- amounts for a nonrecurring earnings or deduction
- changes to existing entries of a recurring earnings or deduction.

PayMIX entries can include entry of information needed for the transfer of payroll costing information to the general ledger and to labor distribution systems.

Data typed into a BEE or PayMIX entry window goes to a special table. There you can validate it, make corrections, and validate again, before transferring the data to the HRMS database. After the transfer, you can see the entries in the HRMS database using Element Entries window.

**See Also**

MIX Facilities for Batch Element Entries: page 8 – 2

**Entry as an Indirect Result of Payroll Processing**

For nonrecurring elements that process in the payroll run, input value entry can occur during processing. When payroll runs, these elements can receive entries to their input values as *indirect results* of the processing of other elements.

For example, when the payroll run processes the formula for the earnings types Regular Salary, it sends entries of an employee’s hours...
worked in a period to the element Regular Hours Worked as an indirect result.

Then when the report processes for the statement of earnings and the Earnings Audit run, they can go to the Regular Hours Worked element to find employees’ regular hours worked each period.

You mark formula results as indirect, and specify the element input value to which an indirect result should go, using the Formula Result Rules window.

See Also

Formula Results: page 7 – 22

Regular Salary and Regular Wages (*Oracle Payroll User’s Guide*)
Element Definition

The types of element definition you do depends to some extent on the nature of your Oracle HRMS installation.

Installations without Oracle Payroll

Users at these installations use the Element window to define all the elements they need to hold information on the following:

- employee compensation and benefits
- medical, dental and vision benefit plans
- employee absences
- tangible items distributed to employees, such as tools or uniforms.

At these installations, users obviously have no need for elements for Oracle Payroll to process in payroll runs.

Installations including Oracle Payroll

Users at these sites similarly define elements to hold information on employee absences and on tangible items distributed to employees. However these sites also use elements that process in the payroll run to represent:

- compensation types
- non-payroll payments such as reimbursements
- benefits toward whose cost employees and employers may contribute
- other employee deductions and employer liabilities.

The system generates these elements, together with the necessary balances, formulas, and formula result rules, when users initiate earnings, other payments and deductions using the Earnings or Deduction window.

See Also

Definition of Benefit Elements at Sites with HR Only page 10 – 6
Defining and Linking an Absence Element: page 26 – 9
Defining an Element to Hold Information

Use the procedure below to define most elements that hold information but do not process in payroll runs.

**Note:** To define information elements for health care benefit plans (elements with the benefit classification Medical, Dental or Vision), or elements for absence types, use different procedures.

See:
- Definition of Benefit Plan Elements at Sites with HR Only: page 10 – 8
- Defining and Linking an Absence Element: page 26 – 9

To define an element, use the Element window.

**Attention:** The version of the Element window you see depends on your HR User Type profile option. With the profile option **HR User**, you see and access only those fields needed to define elements that hold information or represent benefit plans or absence types. With the profile options **Payroll User** and **HR with Payroll User**, you see and access all available fields.

**Prerequisites**

- Decide what validation you need for entries to the element’s input values.
  - To restrict entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter the valid values for this lookup in the QuickCodes window.
  - To validate values using formulas, write the validation formulas using the Formulas window.
    
    See: *Oracle FastFormula User’s Guide*

- If you need a new category within the Information classification for this element, add it in the QuickCodes window for the QuickCode type **US_INFORMATION**.
  
  See: Information Elements: page 7 – 13

- If this element represents a benefit for which you want to enter a carrier, set up the carrier as an external organization with the classification Benefits Carrier.
  
  See: Creating an Organization: page 2 – 20
Identifying the Information Element and its Processing Rules

To identify and classify the element:
1. Set the effective date early enough for any historical element entries.
2. Enter a unique name starting with a letter of the alphabet (not a number or symbol). You can optionally enter a reporting name and description. The reporting name is a short name that appears on reports.
3. Select Information as the primary classification for the element. Also select a benefits classification if this element represents a benefit other than a medical, dental or vision benefit plan.
   See: Benefits Carriers: page 10 – 2

To enter processing information:

Note: The rule Additional Entry Allowed has no applicability for US installations. It is available for use at non-US sites.
1. Select Recurring as the processing type, so that entries to this element’s input values will remain in effect until you end them. If you select Nonrecurring, entries to the element are effective only for the pay period in which you make them.
2. Select Actual Termination as the termination rule.
3. For the element to receive more than one entry at the same time, check the Multiple Entries Allowed box.

4. If at some time you need to prevent the element from accepting any new entries, either temporarily or permanently, check the Closed for Entry box. This does not affect any existing element entries.

To establish currencies and qualifying conditions:

1. The Input and Output Currencies appear as USD (US dollars) and you cannot change these defaults.

2. If there is a minimum age for employees to receive the element, enter it in the Age field.

3. If employees must complete a minimum length of service before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.

4. For the system to automatically enter the element and its default values for all eligible employees, check the Standard box.

   See: Automatic Entry of Default Values: page 7 – 27

5. Save the element definition.

To enter a category and benefits carrier

1. Click in the Further Information field to open the Further Element Information window. In the Category field, select a category.

2. For an element representing a benefit that does not have the benefit classification Medical, Dental or Vision, you can select a benefits carrier in the Benefits Carrier field.

3. Complete the definition of the element by setting up its input values.

Establishing the Information Element’s Input Values
To set up input values for the element:
1. Enter a name for the input value and select a unit of measure for it (money, hours, character, date, number or time).
2. You can enter number in the Sequence field to designate the order in which the Element Entries window displays the input values.
3. If the input value must have an entry, check the Required box.

To enter an element–level default for an input value:
1. Make the entry in the Default field.
2. For automatic update of existing entries of a default whenever you change the default, check the Hot Default box. Hot defaults appear in the Element Entries window in quotation marks.

Warning: If you override a hot default appearing as an entry for an employee, any further changes to the element’s default value do not affect this entry. For this reason, it is best to make changes to a default value for large groups of employees using a MIX batch entry facility rather than the hot default feature.

To establish validation for input value entries:
1. Choose one of these approaches:
   - Enter maximum and minimum values for the entry
   - Select a QuickCode Type to act as a lookup for an input value whose type is Character
   - Select a formula to validate entries. Formulas can return messages about the success or failure of the validation.
2. Choose Warning for the system to warn of an invalid entry, or Error if it should not save a valid entry. You cannot select Warning or Error when using a lookup for validation, because in this case an invalid entry is impossible.
3. Choose Done when you are finished. Your definition of an element to hold information is complete.

Deleting an Element Entry

Perform this task from the Element Entries window.

To delete an element entry:
1. Query the element entry in the Element Entries window.
2. Select Delete Record.
3. Select the Save icon to save this change.

Deleting an Element

Before you delete an element, you must ensure that no employees have the element in their record and that no links to the element exist in the Link window. If either of these conditions exist, you must first delete the element entry and the element link before you can delete the element itself.

See Also:
Deleting an Element Link: page 7 – 40
Deleting an Element Entry: page 7 – 35

Once there are no links or element entries you can delete an element.

Use the following process to delete an element that was defined in any of the following windows:

• Element Description window,
• Earnings window
• Deduction window

To delete an element:
1. Query the element in the appropriate window.
2. Select Delete Record.
   
   The system prompts you to either End Date the element or Purge it.
   
   **Note:** Select End Date if you want the element to remain in the system but be effective through a certain date. Select Purge if you made a mistake defining the element and you want to delete it from the system altogether.

3. Select Save to save this change.
Defining Element Links

To determine the groups of employees eligible for an element, you define links for the element in the Element Link window.

Prerequisite

- If the link should have Distributed as its costable type, define the set of earnings types (the distribution set) over which the system should distribute the element’s payroll costs.

  See: Costing Information at the Element Link Level: page 11 – 7

To define an element link:

1. In the Element Name field, select the element for which you are defining a link.
2. Check the Standard box only if you want automatic entry of the element and its default entries for all eligible employees. Standard links are possible for recurring elements that do not have the rule Multiple Entries Allowed.
3. In the Eligibility Criteria region, select the assignment components that constitute this eligibility rule.

   You can link to all payrolls or to a specific payroll:

   - Leave the Payroll field blank and check the Link to all Payrolls box if you want employees assigned to any payroll to be eligible. This rule excludes employees with no payroll assignment.
• Select the name of a specific payroll to make employees assigned to that payroll eligible for the element.

Costing Information

► To enter costing information for the link:

1. Select the Costable Type. The default is Not Costed, meaning that the system maintains no costing information for the element.
   • To allow entry of costing information for this element at all levels, including the assignment and element entry levels, select Costed. This is the appropriate selection for most elements representing earnings types.
   • To allow entry of costing information for this element at the payroll, element link and organization levels only, select Fixed Costed. This is the appropriate selection for most elements representing deductions.
   • Select Distributed to have the element’s costs distributed proportionally over a specified set of earnings types. This Payroll User and HR with Payroll Use selection is appropriate for elements representing various types of employer charges and liabilities. For a link with the costable type Distributed, select the distribution set in the Distribution Set field.

See: Costing Information at the Element Link Level: page 11 – 7

2. If the payroll run results from this link should be transferred to the general ledger, check the Transfer to GL box.

3. In the Costing field, select a GL account code and if present, account codes of labor distribution or other systems in which to collect the run results of this element.
   Use the Balancing field to select the code for the GL account that balances the GL account selected in the Costing field.
   To select costing and balancing GL accounts for an element in the classification Pre–Tax Deduction, Voluntary Deduction or Involuntary Deduction:
   • Select the code for the GL account to credit in the Costing field, and the code for the account to debit in the Balancing field.
   To select costing and balancing GL accounts for elements in all other classifications:
   • Select the code for the GL account code to debit in the Costing field, and the code for the account to credit in the Balancing field.
Qualifying Conditions

► To enter qualifying conditions for the link:
  ■ Go to the Qualifying Conditions alternative region. Here you can add or change age or length of service requirements for this particular eligibility rule.

Link Level Changes to Input Values

Use the Link Input Values window.

You can:
  • enter a new default or change one entered at the element level
  • check the Costed box to maintain costing information for an input value
  • change the maximum, minimum or both for an input value. Logically, the new values should be within the range you defined for the element as a whole. However the system does not enforce this.

Reviewing Element Links

The Element Link Details Report is available for reviewing element links. To obtain the report you select an element classification, and can further select only recurring or nonrecurring elements in the classification, or just a single element. You can choose whether to see only standard or non–standard links, and only active or inactive links. Further, you can choose whether to see links for payrolls or a job or organization.

Run reports from the Run Requests window.

► To obtain the Element Link Details Report:
  1. In the Name field, select Element Link Details Report. The parameters window opens.
  2. Enter the effective date for the report.
  3. Select the element classification to report on. Optionally, select an element processing type (recurring or nonrecurring) or an individual element to report on.
  4. To report only on standard links, select Yes in the Standard Link field. Select No to report only on non–standard links. Leave blank to report on all links.
5. Select a link status to report only on links that are either active or inactive as of the report’s effective date.

6. To report on links to payrolls:
   - For links to one payroll only, select No in the All Payrolls field and select the payroll in the Payroll field.
   - For links to all payrolls, select Yes in the All Payrolls field and leave the Payroll field blank.
   - To see links irrespective of their payroll criteria, select No in the All Payrolls field and leave the Payroll field blank.

7. To report on links to a particular job or organization, select the job or organization.

8. Choose the Submit button.

---

**Deleting an Element Link**

Perform this task from the Element Link window.

1. **To delete an element link:**
   1. Query the element link in the Element Link window.
   2. Select Delete Record.
   3. Select the Save icon to save this change.
Making Manual Element Entries

You use the Element Entries window to make and review manual entries to element input values for individual employees.

Customizing the Element Entries Window

Your system administrator can create customized versions of the Element Entries window to restrict the elements that particular users can enter. Reducing the elements available for entry in this window enhances speed, usability, and security for specific data entry scenarios.

You can restrict element entry by:

- element set (a group of elements that you define)
- element type (recurring or nonrecurring)
- element classification.

Your system administrator can include several versions of the Element Entries window in your menus.

See: Restricting the Data Displayed in a Window: page 31 – 3
Completing or Inquiring on Entries

To manually enter elements for an employee, and to inquire on existing entries, use the Element Entries window.

▲ To inquire on an element entry:
- You can use the Period field, Classification field, and Processing Types option buttons to view the entries for the employee in any one pay period.

▲ To enter an element for an employee:
1. If necessary, change your effective date to the correct date for making the element entry.
   - If the pay period is closed at your effective date, you cannot make any nonrecurring entries of elements that process in payroll runs.
2. To reduce the list of element to choose from, select a classification, a processing type, or both in the first region.
3. In the Element Name field, select an element.
   - **Note:** Elements this employee is eligible for by means of a standard link appear automatically.
   - The system displays a warning message if the employee fails to meet any qualifying conditions for the element of age or length of service.
4. If the Costing field is enterable, you can enter cost codes, for example to indicate the cost center the employee’s time should be charged to.
   - See: Costing Information at the Element Entry Level: page 11 – 10
5. You can select a reason for an element entry you make or update.
   - As part of your system setup, you can enter valid reasons for the QuickCode Type ELE_ENTRY_REASON.
   - **Note:** There is no use for the Override, Additional, or Show Adjustment check boxes at US installations.
6. Choose the Entry Values button to open the Entry Values window.
7. Make entries in the Entry Value fields. Notice that:
   - some fields may not be enterable.
   - Some fields may be required.
   - Some fields may have a list of values; others may be validated as you leave the field. You receive a message if your entry is not valid.
• Some fields may contain default values. If the default value is in quotation marks, it is a "hot default".

Attention: You should consider carefully before overriding a hot default. If you override it, then any subsequent changes to the default value on the element or element link definition will not affect this element entry.

8. To establish an earned date for an earnings element that is outside of the current payroll period, make a selection in the Date Earned field.

9. To enter information about a third party recipient of a payment resulting from a deduction element, select in the Payee Details field, the name of the third party payment method set up for this payment.

See: Defining Payment Methods for the Enterprise: page 5 – 3

10. To change the default processing priority of this element in the payroll run, enter a new priority number in the Processing Priority field. Lower priority numbers process first.

See Also

Reviewing Element Entries: page 7 – 44
Reviewing Element Entries

In the View Element Entry History window, you can see a history of entries for an employee, and in the List Employees by Element window, you can see a list of employees receiving entries to an element in a time period you set.

You can use the Element Entries window to review existing entries for an employee in a specified pay period.

Viewing Element Entry History

In the View Element Entry History window you can see a history of entries for an employee for:

- one element
- all recurring elements, all nonrecurring elements, or both
- elements from a selected classification

To view element entry history for an employee:

1. Enter your selection criteria. You can:
   - Select a classification.
Select a processing type.

Enter a date range. The end date defaults to your effective date.

2. Run the query.

The window displays all entries of the types of element you selected within the time period, including datetracked updates to entries. New entries are shown in bold to contrast with datetracked updates, which are listed under the initial entry.

3. Select an entry and choose the Entry Values button to view the entry values.

Listing Employees by Element

In the List Employees by Element window, you can view a list of the employees with entries to an element in any period of time you choose. You can also see the last entry value for each assignment.

To view a list of employees receiving an element:

1. Select an element.

2. Select Current Employees, Ex-employees, or both.

3. You can also enter a date range. Both date fields default to your effective date.
4. You can enter additional query criteria in the Element Entries region.

5. Run the query.

The Element Entries region displays all entries of the element for employees of the type you selected in the chosen time period.

**Note:** This window does not display datetracked updates to recurring element entries. You only see the *latest* value (within your chosen time period) of each element entry. The date of the last datetracked update may vary from employee to employee.
For batch entry of information held in element input values or elsewhere on elements, Oracle HRMS MIX (Mass Information Exchange) provides special facilities. Using **BEE** (Batch Element Entry) for elements that do not process in payroll runs, or **PayMIX** for elements that do process in runs, users can:

- rapidly enter batches of information for entry to elements into a temporary table
- validate, correct, and update the information in this table
- transfer validated information from this table to elements in the HRMS database.

This chapter explains how to use BEE and PayMIX for batch element entry.
MIX Facilities for Batch Element Entry

At many enterprises, Oracle Payroll users must make batch element entries in each payroll period, in order to:

- **record timecard data** needed for regular pay processing, such as hours worked, location or shift worked, and costing or labor distribution data
- **enter special nonrecurring earnings or deductions** to be processed in the period
- **enter one–time changes** to recurring earnings or deductions.

For batch element entry in Oracle Payroll, Oracle HRMS MIX includes the **PayMIX** facility.

Non–payroll users of Oracle HRMS may also require the ability to make element entries in batch mode, as for example:

- **staff responsible for absence management**, who must make entries to elements representing absence types to record employees’ hours or days absent
- **benefits administrators**, who must make entries to elements representing benefits, such as stock purchase plans, 401(k) plans and health care plans, in order to enroll employees in these benefits
- **salary administrators** at installations without Oracle Payroll, who must make entries to elements representing salary, bonuses, commissions, and other types of earnings to maintain information about employee compensation.

For non–payroll users, MIX includes the **BEE** (Batch Element Entry) facility.

**See Also**

Making Non–Payroll Batch Entries Using BEE: page 8 – 3

PayMIX for Payroll Batch Entry: page 8 – 12
Making Non–Payroll Batch Entries Using BEE

For element entries that record absence information, enroll employees in benefits, maintain compensation information, or perform other non–payroll functions, you use the Batch Header and Batch Lines windows of BEE.

Information batches entered using BEE can include as many elements and assignments as necessary. To speed entry, you can supply defaults for any value, changing defaults as necessary when working through a batch. Use the Batch Lines window to choose the input values to display.

Validation of Batch Entries

To validate a batch after saving it, you run the BEE validation process from the Batch Header window. This process checks the header and each line of the batch. For example, it checks that each assignment number exists in the database, and that you have specified values for all required input values.

You can add your own validation procedures to the standard process. For example, you can set up control types, such as record counts, and write a validation procedure to check that the batch matches the control totals you enter for each type. You can also add any business validation you require, for example to check that amounts entered for a bonus do not exceed a maximum, or that an assignment’s paid time off entitlement is sufficient to cover time taken.

When the batch is ready for transfer to the database, you run the BEE transfer process from the Batch Header window. This process first performs the same checks as the validation process. If it finds no errors, it transfers the element entries from the temporary tables to the Entries table in Oracle HRMS.

You can choose whether the transfer process automatically purges the entries from the temporary tables after transfer. You can also run a separate purge process.

Batch Statuses

The Batch Status depends on the status of the batch header, all the batch lines, and any control totals specified for the batch. On the Batch Header window, you can see the following status values:

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid</td>
<td>All of the lines, control totals, and header are valid.</td>
</tr>
</tbody>
</table>
Creating and Updating Batches of Element Entries

You can enter batches of element entries in the Batch Header and Batch Lines windows.

Prerequisites

- You can create additional validation procedures for checking the batch header and lines, and for validating the batch against control totals.
- If you want to use control totals to validate the batch, enter values for the QuickCode Type CONTROL_TYPE.

Entering a Batch Header

The header identifies the batch and determines what happens if any of the batch lines duplicate existing element entries.
To enter a batch header and control totals:

1. Set your effective date to the date when you want the entries to take effect.

2. Enter a name for the batch, and enter a reference number and the source of the batch, if you require these for your own reference.

3. Select what action the process should take if one of the batch lines matches an existing element entry for an assignment at the effective date.
   - Create New Entry – The process creates a new entry if multiple entries of the element are allowed by the element definition. If multiple entries are not allowed, the process sets the status of the batch line to Error.
   - Reject Entry – The process sets the status of the batch line to Error.
   - Change Existing Entry – The process corrects or updates the existing entry. If there is more than one existing entry, the process sets the status of the batch line to Error.
   - The Undefined option is display-only (for batches created using SQL*Plus or a similar tool).

4. If you selected Change Existing Entry, select the type of date effective change to be made to recurring entries:
   - Update – The process changes the existing entry from the effective date, but preserves the previous information. If there are future-dated changes to the existing entry, the process inserts the change before the next scheduled change.
• Correct – The process corrects the existing entry from its start
date through to its end date. Any future-dated changes are
unaffected.

• Override – The process changes the existing entry from the
effective date, but preserves the previous information. If there
are future-dated changes to the existing entry, the process
replaces all future-dated changes with the batch line.

Notice that if you select this option, you cannot check the Reject
if Future Changes check box.

The Undefined option is display-only (for batches created using
SQL*Plus or a similar tool).

5. If you want to reject batch lines that match entries that start in the
future or for which future changes are scheduled, check the Reject
if Future Changes check box.

Notice that if you check this box, you cannot select the Override
option.

6. If you want the batch to be purged from the temporary tables after
successful transfer to Oracle HRMS, check the Purge After Transfer
check box.

7. If you have set up control types to validate the batch before
transfer, choose the Totals button. Select a batch control type and
enter the total for the batch. You can enter as many types and
totals as you require.

Entering Batch Lines

A batch line is one element entry for an assignment.

Use the Create Batch Lines window to create identical lines for all
assignments identified by an assignment set. This is a quick way to
create many lines for an element. If the input values need to vary
between assignments, you can leave these blank and add them later
using the Batch Lines window.

In the Batch Lines window, you can enter new lines for individual
assignments, and you can view and edit lines created automatically for
an assignment set. You can speed up entry of new lines by entering
default input values

Note: A batch can contain lines for as many elements as you
require. Lines within a batch can have different effective dates.

To navigate to these windows, first create and save a batch header in
the Batch Header window. Then choose the Create Lines button (for
the Create Batch Lines window) or the Lines button (for the Batch Lines window).

► **To enter batch lines for an assignment set:**
1. Select the assignment set and payroll which identify the employees you want to create lines for.
2. Select the element for the batch lines and enter input values as appropriate.
3. Change the effective date if required.
4. Choose the Process button to submit a concurrent process called Create Batches. Confirm that you want the system to create the lines.

   The Batch Lines window now closes, taking you back to the Batch Header window.
5. Choose the Create Lines button again if you want to add lines for another element. Requery your batch and choose the Lines button if you want to view and edit the lines created by the process.

► **To enter batch lines manually:**
1. Choose the Lines button.
2. Select the element for which you want to make entries.
3. To enter default values to speed up the data entry, choose the Defaults button. The Defaults window displays the input values for the selected element.

4. Enter default values in any of the fields in the Defaults window. These defaults apply to all new entries in the batch, but not to any entries you have already made. You can change the defaults at any time during your data entry.

5. Uncheck the Display check box for any field that you do not want to display in the Lines window. You might want to hide any fields for which the default is correct for every entry.

6. In the Lines window, enter the data required for the batch. Lists of values are available on some fields, but no validation is enforced during data entry.
   
   You can override the Effective Date for any line. This is the effective start date for a new entry or the effective date of an update.

7. Save your entries. If you want to make entries for another element, select the element, enter new defaults, enter the lines, then save again.

**Retrieving Existing Batch Lines**

Use the Batch Lines window to view existing batch lines.

**To retrieve existing batch lines:**

1. Do one of the following:
   
   • Select the element in the Element field.
   
   • Check the Unknown Elements check box if you are querying batch lines entered for an invalid element (or no element) by SQL*Plus or another tool.

2. Choose the Find button.

**Updating a Batch**

You can update a batch at any time before you transfer it. If you make any changes to a batch with the status Validated or Error, the batch status changes to Unprocessed.

**Validating a BEE Batch**

You can validate a batch with the status Unprocessed, Error, or Valid. The validation process tests each batch line against certain predefined
rules about element entries, and also against your own rules if you have created additional validation procedures.

**To validate a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.

2. Select Validate, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

3. When the concurrent request is completed, query the batch in the Batch Header window.

   If the Batch Status is Valid, the validation was successful. If the Batch Status is Error, at least one line, control total, or the header is in error.

4. To view the status of individual lines in the batch, choose the Lines button. In the Batch Lines window, select an element and choose Find.

5. If you entered control totals for the batch, choose the Totals button on the Batch Header window to view the status for each control type.

6. To view messages for the whole batch, or all lines, or control totals, choose the Messages button. Use the option group at the top of the Messages window to control which messages are displayed.

---

**Transferring a BEE Batch**

A batch exists in the temporary BEE tables only until you run the transfer process to create element entries in the Oracle HRMS Entries table.

**To transfer a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.

2. Select Transfer, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

3. When the concurrent request is completed, query the batch in the Batch Header window.
If the Batch Status is Transferred, there were no errors in the batch and the process has created the element entries. The process may have issued messages associated with the batch header, lines, or control totals.

If the Batch Status is Error, the process has set the status of at least one line, or control total to Error. Check the status fields in the Batch Lines window and the Control Totals window, and review the messages issued by the process.

### Purging a Batch From the BEE Tables

If the Purge After Transfer check box on the Batch Header window is checked when you run the transfer process, the batch is deleted from the MIX tables automatically after the transfer. If the box is not checked, you can purge the batch by running a separate process.

You can purge a batch with any status.

**To purge a batch:**

1. Query the batch in the Batch Header window, and choose the Process button.
2. Select Purge, and choose Start. The system displays the concurrent request ID so that you can query it on the Requests window.

   When the concurrent request is completed, the batch is purged.

### Rolling Back a MIX Process

You can roll back a MIX process if you want to completely remove it after it successfully completes. You have a choice of deleting the batch header as well or of keeping the header after the rollback.

The process interlock rule (which prevents you rolling back a payroll process if any further processing has taken place) does not apply to MIX Rollback. You can still perform the rollback even if run results from payroll processing exist for any of the lines.

You run the MIX Rollback process from the Submit Requests window.

**To roll back a MIX process:**

1. Select the batch header name of the process you want to roll back.
2. Enter Yes to cancel the rollback process if the system detects run results for any of the batch lines. Enter No if you want the system to complete the rollback even though run results exist.

3. Enter Yes to keep the batch after the rollback. Enter No to delete the batch after the rollback.
PayMIX for Payroll Batch Entry

Oracle Payroll’s PayMIX facility provides for rapid entry of these types of data batches:

- timecard data showing hours worked, and possibly other information, for a period
- data for a one-time earnings or deduction entry or change

A unique number identifies each separate batch of data you enter. This number increments automatically.

Heads Down Data Entry

To facilitate rapid data entry, PayMIX lets you provide as many defaults as possible each information batch. Defaults appear as entries for every line in the batch entry window. You can overwrite them when necessary. For example, if the hours worked entered on most of the timecards in a batch is 40, you can enter a default of 40 for Hours.

Another way that PayMIX supports rapid data entry is by deferring all validation until entry is complete. After saving a batch you can both check it against batch totals, and run a validation process for it.

Balancing to Batch Totals

Your enterprise may check data totals and line counts for a batch against externally determined totals and counts. For example, you may know that the total of hours entered on a batch of timecards is 500, or that the total of amounts entered for a bonus is $35,000. You can supply user totals and line counts for a batch when you identify it.

The system displays batch totals and counts when you save a batch, together with any discrepancies to the user totals and counts. You can then make and save changes to line information. PayMIX automatically adjusts its system-generated totals and counts.

Validating Batch Entries

After saving an information batch in PayMIX, you launch a validation process to check whether the entries are correct, and mark any that are in error. For each batch line, this process verifies that:

- there are no outstanding discrepancies between external and system-generated totals
- the employee’s assignment number exists in the database
• an element exists to receive the data entered through PayMIX
• the employee has not already received for this period, an earnings being entered through PayMIX
• for values entered as overrides, that other values exist to be overridden.

**Note:** It is not difficult add steps to, or remove steps from, this basic validation process. Its program consists of a series of statements written in PL/SQL that follow clear coding standards. Your MIS staff can insert new statements or remove statements as necessary.

**See Also**

Completing Batch Element Entries Using PayMIX: page 8 – 23
PayMIX Timecard Entries

Each batch line entered from timecards has an entry of:

- an employee’s assignment number
- the number of hours
- the type of hours being entered. This entry determines the element to which the line’s entries go. The element must be nonrecurring, have an input value Hours, and be marked to accept PayMIX entries.

For example, to process the predefined earnings Regular Wages for employees, you can make entries through PayMIX to the Time Entry Wages element. To track accounting and labor distribution information for employees receiving Regular Salary, you make entries to the element Labor Recording. You can also use PayMIX to enter absence elements set up to record the use of sick or vacation time accrued under a PTO accrual plan.

See:

The Earnings Types Regular Salary and Regular Wages (Oracle Payroll User's Guide)
Defining and Linking an Absence Element: page 26 – 9
Recording Accrued Time Taken: page 26 – 30

Additional Timecard Information

PayMIX can also accept entry of extra timecard data employees supply to ensure correct calculation of pay and taxes, or accurate recording of labor distribution and cost center information.

<table>
<thead>
<tr>
<th>Field in Time Entry Windows</th>
<th>Entry Goes To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate Code</td>
<td>Input value Rate Code (as on the earnings Time Entry Wages, Overtime, Shift Pay). A rate code entry gives the element’s formula a code by which to locate a rate in the Wage Rates table.</td>
</tr>
<tr>
<td>Hourly Rate</td>
<td>Input value Rate (as on Time Entry Wages, Overtime, Shift Pay). Entry of a rate overrides an existing rate code entry.</td>
</tr>
</tbody>
</table>

Table 8 – 1 Additional Information for PayMIX Time Entry
<table>
<thead>
<tr>
<th>Field in Time Entry Windows</th>
<th>Entry Goes To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shift</td>
<td>Input value Shift (as on Time Entry Wages, Labor Recording, Shift Pay) for locating shift differential in the Shift Differentials table, if no entry exists for Rate or Rate Code.</td>
</tr>
<tr>
<td>Amount</td>
<td>Pay Value of Time Entry Wages element, which feeds it directly into the Regular Pay balance for the employee. Useful for paying someone a fixed dollar amount regardless of time worked. See: Pay Values and Payroll Run Processing: page 7 – 19</td>
</tr>
<tr>
<td>Multiple</td>
<td>Input value Multiple (as on Overtime). An entry here gives the element’s formula a rate or other multiple.</td>
</tr>
<tr>
<td>Separate Check</td>
<td>Input value Separate Check (on all earnings). Check this box for payment of this earnings type by separate check. See: Input Value for Payments by Separate Check (Oracle Payroll User’s Guide)</td>
</tr>
<tr>
<td>Tax Rule</td>
<td>Input value Deduction Processing (on all earnings). Possible entries are Tax and Pretax Only or Tax Only. See: Input Values to Control Deduction Processing (Oracle Payroll User’s Guide)</td>
</tr>
<tr>
<td>Location</td>
<td>The table of jurisdiction codes, and sends the correct code for the location to the input value Jurisdiction (as on Time Entry Wages, Overtime, Shift Pay). An entry here overrides the jurisdiction code of the employee’s regular work location.</td>
</tr>
<tr>
<td>Cost Center Code</td>
<td>Cost Allocation key flexfield, segment for cost center codes. See: Use of the Cost Allocation Key Flexfield: page 11 – 5</td>
</tr>
<tr>
<td>From</td>
<td>The beginning date of the pay period for the time card entry.</td>
</tr>
<tr>
<td>To</td>
<td>Input value Date Earned (as on Time Entry Wages, Overtime, Shift Pay). This should be in the same pay period as indicated in the From field.</td>
</tr>
</tbody>
</table>

Table 8 – 1 Additional Information for PayMIX Time Entry

**Dates of Time Entry Batch Lines**

Timecard entries of a To date (or From and To dates) signal that the card’s information is for a period other than the current one. When you enter a To date in a PayMIX Time Entry batch line, the system gives this line the end date of the period in which the Date Earned falls. For lines with no Date Earned entry, the system supplies one when you run the Validation or Transfer process. The date supplied is the end...
date of the period in which the effective date of the Validation or Transfer process falls.
One–Time Batch Entries for Earnings and Deductions

Using the PayMIX Earnings Entry and Deductions Entry windows, you can make new entries for nonrecurring earnings and deductions, or entries to change the run results of recurring earnings and deductions.

New Entries for Nonrecurring Earnings or Deductions

When entering an amount for a nonrecurring earnings or deduction through PayMIX, the calculation or amount rule of the earnings or deduction determines the input value this amount should go to. Possible input values for receiving the amount are Amount, Percentage, or Pay Value. PayMIX routes the amount entry as follows:

- If the earnings or deduction has the input value **Amount**, the amount entered goes here. All earnings and deductions with the calculation or amount rule Flat Amount have an input value Amount.
- If the earnings or deduction does not have the input value Amount but does have the input value **Percentage**, the amount entered goes here. All earnings and deductions with the rule Percentage have an input value Percentage.
- If the earnings or deduction does not have the input values Amount or Percentage, the amount entered goes to the **Pay Value**.

See:

- Earnings or Payments with the Calculation Rule Flat Amount (Oracle Payroll User’s Guide)
- Earnings with the Calculation Rule Percentage of Earnings (Oracle Payroll User’s Guide)

When you make a new entry to an input value of a nonrecurring earnings or deduction through PayMIX, the system considers that you are replacing a null entry, and calls the action a replacement. You can select Replace in the Action field of the PayMIX entry window, but it is not necessary to do so because the default action is Replacement.

Changes to Recurring Earnings or Deduction Results

Suppose that for this quarter only, some employees will receive additions to their regular, recurring quarterly bonuses, while others will receive lump sum payments instead of a percentage of their regular pay. A few employees will suffer a reduction of the bonus amount. You can rapidly enter all these changes to a recurring element using the PayMIX Earnings Entry window.
Amounts you enter via PayMIX to add to, subtract from or replace the calculated result of a recurring earnings or deduction go either to the Additional Amount or Replacement Amount input value of the earnings or deduction’s special inputs element. The batch line’s Action field determines the line’s routing:

- **To add or subtract the amount to the run result** of the earnings or deduction, you type `inc` (Increase) or `dec` (Decrease) in the Action field. The amount goes to the Additional Amount input value of the special inputs element.

- **To have the amount replace the run result** of the earnings or deduction, you leave the Action field blank, or type in Replace (`rep`). In either case, the line’s amount goes to the Replacement Amount input value of the special inputs element.

See: Changes to Earnings or Deductions Before a Run (*Oracle Payroll User’s Guide*)

### Additional Information for Earnings or Deductions Entries

When using PayMIX to make entries to earnings and deductions, you must enter employees’ assignment numbers, the earnings or deduction element name and the amount. You may need to enter other information as well. For an earnings type, this additional information entry is possible:

<table>
<thead>
<tr>
<th>Field in Earnings Entry Window</th>
<th>Entry Goes To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Center</td>
<td>Cost Allocation key flexfield, segment for cost center codes. See: Use of the Cost Allocation Key Flexfield: page 11 – 5</td>
</tr>
<tr>
<td>Action</td>
<td>System, causing it to route amount either to the input value Replacement Amount or Additional Amount of the special inputs element. See: Changes to Earnings or Deductions Before a Run (<em>Oracle Payroll User’s Guide</em>)</td>
</tr>
<tr>
<td>Tax Rule</td>
<td>Input value Deduction Processing (on all earnings). Possible entries are <em>Tax and Pretax Only</em> or <em>Tax Only</em>. See: Input Values to Control Deduction Processing (<em>Oracle Payroll User’s Guide</em>)</td>
</tr>
</tbody>
</table>

Table 8 – 2 Additional Information for PayMIX Earnings Entry
The table of jurisdiction codes, and sends the correct code for the location to the input value Jurisdiction (as on Time Entry Wages, Overtime, Shift Pay). An entry here overrides the code of the employee’s regular work location.

See: The Earnings Types Regular Salary and Regular Wage (Oracle Payroll User’s Guide)
The Earnings Type Overtime (Oracle Payroll User’s Guide)
The Earnings Type Shift Pay (Oracle Payroll User’s Guide)

Date Earned

Input value Date Earned (as on Time Entry Wages, Overtime Shift Pay).

Separate Check

Input value Separate Check (on all earnings). Check this box for payment of this earnings type by separate check.

See: Input Value for Payments by Separate Check (Oracle Payroll User’s Guide)

Tax Separately

Input value Tax Separately. Check this box for supplemental withholding to apply to this earnings even when it is processed in Regular runs.

See: Input Value for Supplemental Withholding (Oracle Payroll User’s Guide)

Table 8 – 2 Additional Information for PayMIX Earnings Entry

For a deduction, there is a limited amount of additional information that you can enter:

Field in Deduction Entry Window | Entry Goes To
--- | ---
Cost Center | Costing flexfield, Account Code segment.
See: Use of the Cost Allocation Key Flexfield: page 11 – 5

Accrued Balance Override | System, to prevent increment of the balance for deductions with the stop rule Total Reached that normally accumulates deduction amounts.
See: Input Values to Control Deduction Processing (Oracle Payroll User’s Guide)

Table 8 – 3 Additional Information for PayMIX Deductions Entry

**Dates of Earnings and Deductions Entry Batch Lines**

When you supply an earned date for a batch line in the PayMIX Earnings Entry window, the entry goes to the input value Earned Date, and PayMIX gives this line the end date of the period in which the
Earned Date falls. For lines in the Earnings Entry window with no Earned Date entry, and for all lines in the Deductions Entry window, the system supplies a date when you run the validation or transfer process. This date is the end date of the period in which the effective date of the process falls.
You can use PayMIX to enter, validate and correct information batches in a payroll period until you reach the payroll cutoff date, which can be just one or two days before the payroll run date.

Between the cutoff date and the run date, you can transfer all validated information batches into the HRMS database. Since the data is already validated, you can anticipate few if any transfer process failures.

The ability to validate, correct and again validate batches before the payroll run date can help even out the payroll department’s workload.

When the validation process finds problems in batch lines, it gives the lines a status of either Error or Warning. When any line’s status is Error, the status for the whole batch goes to Error. An Error status signals the presence of one or more major errors you must correct before you can transfer the batch. You cannot override the Error status and transfer the batch with lines marked Error still uncorrected.

When the validation process gives some lines a status of Warning, but none a status of Error, the batch status goes to Warning. If necessary, you can change a Warning status to Ready and transfer the batch to the database before correcting the conditions causing the warnings. In this case, the transferred batch has the status Transferred with Warnings.

It is of course always preferable to correct all problems before transferring data and initiating a payroll run. If you transfer batches with warnings uncorrected, you risk getting errors on the payroll run. After a transfer, it is no longer possible to make any corrections to batch data using PayMIX windows.

You decide which types of problems warrant an Error or Warning status at your installation.

At entry, a batch’s status is Hold, meaning it is not yet ready for further processing. When a batch is either completely entered and ready for validation, or validated and ready for transfer, you change its status to Ready. You can initiate the PayMIX Batch Process in either the Validate mode or the Transfer mode for batches at Ready status.
When you run the process in Validate mode for a batch and it finds no problems, the batch status goes to Validated. Batches at this status are ready for transfer. If your calendar permits, you can hold these batches in the PayMIX table and continue to enter any changes that come in until the payroll cutoff date.

Before the payroll run, you transfer all relevant batches from the PayMIX table to the HRMS database. To do this you initiate the PayMIX Batch Process in Transfer mode. In this mode, the process first invokes the validation process. If the validation process finds no problems, the transfer process moves the batch to the HRMS database.

When transfer is complete, the batch status goes to Transferred. You can still see the batch in PayMIX windows, but you can no longer add to, change or delete data in these windows. At this point you must use the windows to which the information in the batch has been transferred.
Completing Batch Element Entries Using PayMIX

To make batch element entries for Oracle Payroll, this is the overall procedure:

1. Identify each batch, supply any external totals against which to balance it, and enter any defaults for it.
   See: Identifying PayMIX Batches and Entering Defaults: page 8 – 23

2. Enter the batch.
   See:
   Entering Batches of Timecard Data: page 8 – 26
   Making Batch Entries for Earnings Types: page 8 – 27
   Making Batch Entries for Deductions: page 8 – 28

3. Run the PayMIX Batch Process in Validate mode to validate the batch.
   See: Running the PayMIX Batch Process: page 8 – 29

4. Review the results of this process and correct any lines with a status of Error. If time permits, also correct lines with a status of Warning.

5. Run the PayMIX Batch Process in Transfer mode to validate and transfer the batch.

Identifying PayMIX Batches and Entering Defaults

To enter a batch of information for payroll processing, start with the PayMIX Batch Information window to do the following:

• identify the batch you are entering

• supply any external totals you are using to validate these entries

• provide default values for the batch.
To identify a batch and enter user counts and totals:

1. Select the payroll for which you are entering this batch.
2. Select the batch type:
   - *Time* to make entries from timecards of time worked
   - *Earnings or Deductions* to make one–time entries or changes to an earnings type or deduction.
   
The batch number, used to identify the batch, automatically increments.

Note: For convenience, your system administrator can change your menus so that you select the batch type you are entering directly from the menu.


3. In the Reference field, optionally enter an identifying code or any other data relevant to this batch. For example, for batches coming from your manufacturing facility in Detroit, you could enter the reference Detroit Plant.

4. At entry, the batch status defaults to Hold, meaning the batch is not ready for further processing. Change the status to Ready when the batch is:
   - completely entered and ready for validation, or
   - validated and ready for transfer.

5. In the Batch Totals region, you can enter externally determined counts of hours and batch lines and batch amount totals for Time type batches, or line counts and amount totals for Earnings or Deductions type batches.
When you complete entry of the batch and save it, this region displays the corresponding system totals and any differences between the user and system totals.

**Entering Default Values for a Batch**

Choose the Defaults button to open the Batch Entry Default Values window, in which you can enter defaults for the batch. If there are no defaults to enter for this batch, choose the Detail button to open the Time Entry, Earnings Entry or Deductions Entry window.

![Batch Entry Default Values Window](image)

1. In the Batch Entry Default Values window, select the payroll for the batch, and the batch type of Time, Earnings or Deductions for the large alternative region in this window.
2. In the alternative region, enter any default values appropriate for all or most of the lines in this batch.
   For example, to make Time entries for a batch of timecards most of which have 40 as the entry for Hours, enter 40 as a default in the Hours field. You can overwrite the default on any batch line.

**To provide default entries for the batch:**

1. In the Batch Entry Default Values window, select the payroll for the batch, and the batch type of Time, Earnings or Deductions for the large alternative region in this window.
2. In the alternative region, enter any default values appropriate for all or most of the lines in this batch.
   For example, to make Time entries for a batch of timecards most of which have 40 as the entry for Hours, enter 40 as a default in the Hours field. You can overwrite the default on any batch line.
3. Return to the PayMIX Batch Information window and choose the Detail button to open the Time Entry, Earnings Entry or Deduction Entry window.

Entering Batches of Timecard Data

To enter timecard data via PayMIX for payroll processing, use the Time Entry window.

To make time entries from timecards:

1. Make these entries on each line:
   - the employee assignment number, in the Assignment field
   - the name of the element to which the line’s entries are going, in the Hours Type field. For example, to enter hours taken as sick or vacation time, the element might be Sick Hours Taken or Vacation Hours Taken
   - the number of hours in the Hours field.

   Note: If you are making an entry of hours worked for an employee to receive the predefined earnings types Regular Wages or Regular Salary, you make the entry to the element Time Entry Wages.

   See: The Earnings Types Regular Salary and Regular Wages (Oracle Payroll User’s Guide)
2. If a timecard contains additional information about these hours, as for example a rate code or rate for these hours or a location where they were worked, enter this information in the Additional Information region.

3. To remove all unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

**Making Batch Entries for Earnings Types**

To enter batch data via PayMIX for one–time processing of an earnings type, use the Earnings Entry window.

► **To make one–time entries or changes to an earnings type:**

1. Make these entries on each line:
   - the employee assignment number, in the Assignment field
   - the name of the element to which the line’s entries are going, in the Earnings Name field

2. To enter a replacement for an existing entry, a null entry, or a calculated amount, enter the replacement amount in the Amount field.
field. By default, this amount replaces an existing or null entry, or a calculated amount.

OR

To enter an **addition to** or **subtraction from** an existing or calculated amount, enter the amount to add or subtract in the Amount field, and enter **inc** (Increase) or **dec** (Decrease) in the Action field of the Additional Information region.

3. Enter any further information required for this earnings type, as for example an indication to pay the earnings by a separate check, in the Additional Information region.

   **Note:** To remove any unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, choose OK. Save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, choose OK and save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

### Making Batch Entries for Deductions

To enter batch data via PayMIX for one–time processing of a deduction, use the Deductions Entry window.

To make one–time entries or changes to a deduction:

1. Make these entries on each line:
1. Enter the employee assignment number, in the Assignment field
2. Enter the name of the element to which the line’s entries are going, in the Deduction Name field

2. To enter a replacement for an existing entry, a null entry, or a calculated amount, enter the replacement amount in the Amount field. By default, this amount replaces an existing or null entry, or a calculated amount.

OR

To enter an addition to or subtraction from an existing or calculated amount, enter the amount to add or subtract in the Amount field, and enter inc (Increase) or dec (Decrease) in the Action field of the Additional Information region.

3. If further information is required for this deduction, as for example a cost center override, enter this information.

Note: To remove all unsaved entries and return to the PayMIX Batch Information window, choose Cancel.

4. When entry is complete, choose OK. Save the batch, and change its status to Ready in the PayMIX Batch Information window. To stop entering a batch partway through, choose OK and save the existing entries but keep the status at Hold. You can then query this batch and make further entries later.

Running the PayMIX Batch Process

Prerequisites

☐ Save the batches for which you are running the process, and if necessary, reconcile the user and system totals appearing in the Batch Totals region.

☐ Change the status of the batches to Ready, and save this change.

Run this process from the Submit Requests window.

1. In the Name field, select PayMIX Batch Process. If the Parameters box does not appear automatically, click in the Parameters field.

2. Select the payroll for which you are validating or transferring batches.

3. Enter the starting and ending numbers of the range of batches to process. To process just one batch, enter its number in the Starting Batch Number field.
4. Select the status, either Ready or Validated, of the batches to process.

5. Optionally enter a reference to further identify the batches to process.

   For example, to validate all the batches from numbers 50 through 70 coming from your Detroit facility, enter 50 and 70 as the starting and ending batch numbers, and Detroit Plant as the batch reference.

6. Choose the process mode of either Validate or Transfer. Choose Validate for the process to validate but not transfer the batches identified. Choose Transfer for the process to validate the batches and then immediately transfer all those passing validation.

7. Choose Submit.
Reviewing and Correcting PayMIX Process Results

To review the results of the PayMIX Batch Process run, use the PayMIX Batch Summary window. To view batch line error messages, use the PayMIX Batch Line Errors window.

To review and correct PayMIX entries:

1. In the PayMIX Batch Summary window, query a processed batch using its batch number, and check its status. To review a batch with a status of Error or Warning, choose the View Batch button to open the PayMIX Batch Information window.

2. Information for the batch displays in the PayMIX Batch Information window. To see errors for this batch, choose the Batch Errors button. If there is an error affecting the entire batch, the PayMIX Batch Header Errors window opens and displays the error message.

   For batch line errors, the batch entry window opens. For each line with a problem, the line status is marked E (Error) or W (Warning), and the line displays in a contrasting color.

3. If the problem with a line is obvious, correct it and save the correction. If it is not obvious, choose Show Error. This opens the PayMIX Batch Line Errors window and displays the appropriate error messages. Make the necessary corrections and save them.

4. Run the PayMIX Batch Process again as needed.
CHAPTER 9

Salary Administration and Budgeting

This chapter explains how to set up your system for salary administration and budgeting. It also explains how to enter and approve salary proposals for individual employees, and how to review salaries for groups of employees.
Salary Administration and Performance Reviews

In Oracle HRMS you use salary administration to:

• enter salary amounts or wage rates for newly hired employees.
• enter and approve proposals for salary or wage increases (or decreases) for current employees. You can associate a salary change with the result of a performance review.

Oracle HRMS includes the earnings elements Regular Salary and Regular Wages, which you set up for entry of salary amounts using salary administration.

To administer salaries for employees, you first assign them to a salary basis. This determines the duration for which their salaries are quoted, such as hourly or monthly. Then for new employees, you enter starting salary amounts, which receive approval automatically.

For current employees, you enter proposed salary changes, expressed either as a new amount or a change amount or percentage. If necessary, you can break down a salary change into two or more components, to reflect different reasons for the change. For example, you might define components for Cost of Living and Merit. You can approve each component of the proposal separately. When all components are approved, you can approve the proposal as a whole. Proposals do not take effect until they receive approval.

Optionally, you can select a performance review to associate with a salary change. When you set up salary administration, you can enter grade rate ranges against which the system validates salary proposals.

See Also

Grade Relationships to Compensation and Benefits: page 4 – 6

Reviewing Current Salaries

Before entering salary proposals, you can review the current salaries of comparable groups of employees. There are a number of ways to do this:

• Query a list of assignments in the Salary Management folder to view their current salaries and any existing salary proposals. You can view up to ten salary components (such as Cost of Living, Location Adjustment, or Promotion) for each proposal.
• Query lists of assignments receiving a particular salary element on the List Employees by Element window. This shows the latest approved salary for each assignment in the date range you select.

• Run the Salary Review Report to view current and previous salaries for all employees, or for employees assigned to a selected organization, job, position, and/or grade.


• Query a list of assignments in the Assignments folder then view the salary history for each assignment in the list, individually, using the Salary History window. This window displays the dates, reasons, and amounts of each approved salary change, and of any new salary proposal.

See: Viewing Salary History: page 9 – 14

• If you use grade rates, you can view the salaries of all employees on a certain grade receiving a particular salary element, using the View Employee Grade Comparatio window. This window also displays each employee’s salary as a percentage of the midpoint defined for the grade.

See: Viewing Grade Comparatios: page 4 – 10

• If you use pay scale rates for salaries, you can report on the salaries of all employees or a group of employees using the Employee Increment Results report.

See: Employee Increment Results Report: page 4 – 19
Setting Up Salary Administration

This setup involves:

- creating element links for each earnings element that is to receive entries of salary amounts through the Salary Administration window. Links determine which employees are eligible to receive each element.
- defining a salary basis for each element that is to receive entries using salary administration.
- checking the seeded salary components and changing them if necessary
- using function security to control which users can approve salary proposals
- assigning employees to their appropriate salary basis.

Regular Salary and Regular Wages

Use the earnings elements Regular Salary and Regular Wages in your salary administration setup. These elements belong to the classification Earnings and the category Regular. They both have the processing type Recurring.

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides Regular Salary run result.</td>
</tr>
<tr>
<td>Monthly Salary</td>
<td>Can accept monthly salary amount from salary administration. In payroll processing, gives amount of employee’s monthly salary to formula for salary calculation.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Taxation code entry here overrides employee’s regular work location taxation code.</td>
</tr>
</tbody>
</table>

Table 9 – 1 Regular Salary Input Values

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pay Value</td>
<td>Short-circuits formula and provides Regular Hourly Wage run result.</td>
</tr>
<tr>
<td>Rate</td>
<td>Can accept hourly salary amount (hourly rate) from salary administration. In payroll processing, gives formula the rates to use for calculation of wages. Entries here override Rate Code entries.</td>
</tr>
</tbody>
</table>

Table 9 – 2 Regular Wages Input Values
Salary Administration and Budgeting

### Purpose of Entry

<table>
<thead>
<tr>
<th>Name</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monthly Salary</td>
<td>In payroll processing, gives formula for calculation of wages, the codes by which to locate rates in the Wage Rates table.</td>
</tr>
<tr>
<td>Jurisdiction</td>
<td>Taxation code entry here overrides employee’s regular work location taxation code.</td>
</tr>
</tbody>
</table>

Table 9 – 2  Regular Wages Input Values

If you need additional elements to enter annual salary amounts or amounts based on a pay period such as bi-weekly or semi-monthly, create them using the Regular Salary element as a model.

See: Creation of Elements: page 7 – 4

### Setup Steps

Before entering salaries for new hires and salary proposals for current employees using salary administration, complete the following setup steps.

**To set up salary administration:**

1. Establish employee eligibility rules for Regular Salary, Regular Wages, and any other elements created for use in salary administration. You do this by building links for them using the Element Link window. Notice that you do not need to link the elements to a salary basis; all link components are optional.

   **Attention:** Do not check the Standard box for these element links.

   Eligible employees receive entries for these elements only when you enter salary amounts or wage rates for them using the Salary Administration window.

2. Define a salary basis for Regular Salary and Regular Wages elements, and any other elements intended for use in salary administration.

3. Review the seeded salary components, which are defined as values for the QuickCode Type PROPOSAL_REASON. If necessary, create your own salary components.

   **Note:** If you want your new components to be displayed in the Salary Management folder, you must also change a view.

   See: Changing Salary Components: page 9 – 7

4. If you want to record performance ratings such as Outstanding, Superior and Average, enter them in the QuickCodes window for the QuickCode Type PERFORMANCE_RATING.
5. Add the function Salary Administration: Approve to the menu of responsibilities that should be able to approve salary proposals. Without this function, users can enter salary proposals but they cannot approve them.

6. Assign employees to a salary basis using the Salary Information region of the Assignment window. Also assign employees to a grade, if you have associated a grade rate with the salary basis.

See Also

Entering a New Assignment: page 14 – 9

Defining Salary Bases

The salary basis establishes the duration for which a salary is quoted, for example, hourly, monthly or annually. Notice that an employee’s salary basis is not necessarily the same as the pay periods of his or her payroll. For example, an employee with an hourly pay rate has the salary basis Hourly Salary, but can have an assignment to a weekly payroll.

You associate Regular Salary, Regular Wages, and any other elements you are using in salary administration, with just one salary basis each. After completing its salary basis definition, you can make entries to one of these elements using the Salary Administration window.

Note: You cannot use the Element Entries window or PayMIX facility to make entries to any elements associated with salary bases.

You define a salary basis in the Salary Basis window.

To define a salary basis:

1. For the element Regular Salary, enter a salary basis name and select the basis Monthly Salary. For the element Regular Wages, enter a different salary basis name and select the basis Hourly Salary. For any other elements created for use in salary administration, enter a salary basis name and select the salary basis Annual Salary or Period Salary.

2. In the Element region, select the element Regular Salary and the input value Monthly Salary, or the element Regular Wages and the input value Rate.

When you enter a monthly salary amount in the Salary Administration window for an employee receiving the earnings
Regular Salary, the entry goes to the input value Monthly Salary. When you enter an hourly wage amount in this window for someone receiving the earnings Regular Wages, the entry goes to the input value Rate.

If you have created other elements that are to receive entries through salary administration, you can also select one of them here, together with the input value that is to receive entries using salary administration.

3. Optionally, select a grade rate to associate with the salary basis.
Oracle HRMS uses the grade rate to validate your salary proposals. You receive a warning if the salary you enter for an employee is not within the grade rate range defined for the employee’s grade.

In doing this check, the system takes account of the hours in the employee’s regular workweek. It looks at the hours on the employee’s work schedule, or if there is none, at the regular working hours per week entered on the employee’s assignment, and compares them with those entered for his or her organization.

If the employee works fewer than the standard hours per week for the organization, the system prorates the permissible minimum and maximum grade rate values before validating the salary.

4. If you selected a grade rate, select the Basis (Hourly, Monthly, Annual, or Period) for the rate. For example, if your grade rate specifies the valid *monthly* salary ranges for each grade, select Monthly Salary in the Grade Rate Basis field.

5. If either the Basis or the Grade Rate Basis is Hourly Salary (but not both), you must enter a value in the Annualized Hours field. This records the number of working hours in a year (and hence in a month). The system uses this figure to convert salary entries and grade rate values to the same basis when it validates a new salary entry.

### Changing Salary Components

Salary changes can be broken down into two or more components, to reflect different reasons for the change. You can approve each component of the proposal separately.

Ten salary components are predefined, as shown in Table 9 – 3. You can create as many additional components as you require. However, only ten components can be displayed in the Salary Management folder. If you want your new components to be displayed in the folder instead of the default components, you must update a view.
This task is for system administrators.

### Table 9–3 Predefined Salary Components

<table>
<thead>
<tr>
<th>Predefined Salary Component</th>
<th>QuickCode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost of Living</td>
<td>COL</td>
</tr>
<tr>
<td>Job Evaluation</td>
<td>JOEV</td>
</tr>
<tr>
<td>Location Adjustment</td>
<td>LOAD</td>
</tr>
<tr>
<td>Market Adjustment</td>
<td>MKAD</td>
</tr>
<tr>
<td>New Hire</td>
<td>NEWH</td>
</tr>
<tr>
<td>Performance</td>
<td>PERF</td>
</tr>
<tr>
<td>Periodic Review</td>
<td>PERE</td>
</tr>
<tr>
<td>Progression</td>
<td>PROG</td>
</tr>
<tr>
<td>Promotion</td>
<td>PROM</td>
</tr>
<tr>
<td>Transfer Adjustment</td>
<td>TRAD</td>
</tr>
</tbody>
</table>

To create new salary components to display in the folder:

1. Query the QuickCode Type PROPOSAL_REASON in the QuickCodes window and add a new code for each new component.
2. In a text editor, open the View file peupl01v.sql.
3. Go to the component reason list and replace the default QuickCodes with the new codes you have created.
   
   **Note:** There are two places in the file where you need to change these codes.
4. Go into SQL*Plus as hr user and run the edited script.
5. Change the column names in the Salary Management folder by choosing Change Prompts from the Folder menu.

### Entering Salaries and Salary Changes

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

Use the Salary Management folder to approve multiple salary proposals or to download salary information to a spreadsheet. In the spreadsheet...
you can enter new proposals, edit existing proposals, and approve salary components. Then you can upload your changes to the database.

If you want to hold multiple reasons for a salary change, you can break down a proposal into two or more components. Each component represents a different reason for changing the salary. You can define as many reasons as you require using the QuickCode Type PROPOSAL_REASON. Examples might be Merit Award and Cost of Living.

From the Salary Administration window, you can open the Performance window. You can associate a salary proposal with a performance review in two ways:

- You can simply enter the date of the review and a performance rating in the Performance window.
- If you use the Employee Review window to schedule and record performance reviews, you can select a review by type in the Performance window.

To review the history of an employee’s salary and performance reviews, use the Salary History window.

---

Using the Salary Administration Window

Use the Salary Administration window to enter a salary amount for a new employee, to propose a salary change for a current employee, or to approve a salary proposal.

Entering an Approved New Salary

Use the procedure below to enter:

- a starting salary amount for a newly hired employee, or
- a salary amount for a current employee assigned to a new salary basis. This could be, for example, an employee moving from an hourly wage to a monthly salary.

Notice that you cannot enter multiple components of a starting salary for a newly hired employee or one assigned to a new salary basis.

To enter a salary for a new employee, or one assigned to a new salary basis:

1. Enter the start date for the salary. For a new hire, this is usually the hire date.
2. Enter the amount of the salary in the New Amount field.
3. You can select a reason.
4. Save the new salary. Its approval is automatic.

**Entering a Salary Proposal**

You can propose a salary change for someone at any time. If you entered intervals for regular salary reviews in the Salary Information region of the Assignment window, Oracle HRMS uses this information to display the date of the next scheduled salary review. However, you can override this date, provided that the date you enter is after the date of the last approved salary.

If there is an unapproved salary proposal recorded for the assignment, you must approve or delete this proposal before you can enter a new proposal.

You can enter a salary proposal as a new amount, a single change amount or percentage, or multiple change amounts or percentages (reflecting different reasons, such as a merit award and a cost of living component).

▶ **To propose a salary change:**

1. In the Salary region, enter the date when the new salary should come into effect.
2. If you want to hold multiple reasons for a salary change, check the Use Multiple Components check box.
3. Do one of the following:
   - If you did not check the Use Multiple Components box, enter the salary change in the Salary region. You can enter a new salary amount, or the amount or percentage of the proposed change.
   - If you did check the Use Multiple Components box, use the Components region. Select the reason for each component of the proposal and the amount or percentage of each proposed change. Notice that each percentage is applied to the last approved salary. For example, if the last approved salary is 3000 and there are two components of 10% and 5%, the new amount is $3000 + 300 + 150.

To effect a salary decrease, enter a negative number in the Change Amount or Change Percent field.

4. You can select a reason for the overall salary change.
5. If you entered a time period for regular salary reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.
6. To associate the salary change with a performance review, choose the Performance button. Enter the date of the review and select a performance rating. In the Interview region, you can select a review that was recorded in the Employee Review window.

7. If you entered a time period for regular performance reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.

8. Save your proposal.

**Approving a Salary Change**

A salary proposal does not go into effect until it receives approval. If you have recorded multiple components of a salary proposal, you can approve each component independently. However, none of them goes into effect until you approve the overall proposal.

When you approve a proposal, Oracle HRMS makes or updates an entry to the Monthly Amount input value of the Regular Salary element, to the Rate input value of the Regular Wages element, or to a designated input value of any other element you have created and associated with a salary basis.

*Note:* You may not be able to approve salaries. This is controlled by a menu function set up by your system administrator.

To approve a salary change:

- Query the proposal, check the Approved box, and save. If some individual components were not already approved, you are warned and they are automatically approved if you continue.

**Using the Salary Management Folder**

Using the Salary Management Folder, you can select sets of assignments for which you want to enter or approve salary proposals. For each assignment, the folder can display the current approved salary and proposed new salary, including up to ten salary components.

Using Application Data Export (ADE), you can download this information from the folder to a spreadsheet. Here you can manipulate the data to create new salary proposals or to modify existing proposals. You can then upload your revised salary information to the database. If your responsibility permits, you can approve all or selected proposals in the folder.
Manipulating Salary Information in a Spreadsheet

You can use a spreadsheet application to enter or update salary proposals for groups of employees. The changes you make in the spreadsheet are checked when you upload them to the database. To minimize errors, follow these rules:

• Do not enter components for a first salary (for example, for a new hire). Enter a proposed amount and change date only.
• Enter changes for the full salary or for components but not for both.
• If you enter components, make sure you enter a value (Y or N) in the Approved field for each component.
• Do not alter a Change Date that was downloaded from the database.
• Do not enter information in the grey fields (except for Change Date).
• Note that the Change Amount is given precedence over the Change Percentage. If you enter inconsistent values, the upload process records the new change amount and adjusts the percentage to match. If you want to record a percentage change, clear the amount field.
• If you want to delete a component, clear both the change amount and percentage fields for that component.

To manipulate salary proposals in a spreadsheet:

1. In the Salary Management folder, query the assignments you want to process.
2. Click on the ADE icon on the Oracle HRMS tool bar.
3. In the ADE Fetch Data window, select the style Salary Proposals and select the action Spreadsheet. Choose Start.
   This launches your spreadsheet application and iconizes ADE.
4. Edit the data in the spreadsheet, following the rules outlined above. Save the spreadsheet with a new name (to prevent it being overwritten the next time ADE is run).
5. Exit your spreadsheet application.
6. In ADE, choose the Upload button.
   Note: If the Upload button is not available, ask your system administrator to create the function HR_HRIO_ENABLE_UPLOAD and add it to your menu.
7. Choose Load and select the spreadsheet that you saved. You can review your changes in the built-in ADE spreadsheet. The Status column shows which rows have been updated.

8. Choose Upload. The updated information is uploaded to the database. The Status column records any errors encountered during the upload.

9. To view your new proposals in the Salary Management folder, requery the data.

Approving Multiple Salary Proposals

If the Approve button is displayed in the Salary Management folder, you can select multiple assignments in the folder and approve them.

Note: If the Approve button is not displayed, you cannot approve salaries. This is controlled by a menu function set up by your system administrator.

When you approve a proposal, Oracle HRMS makes or updates an entry to the Monthly Amount input value of the Regular Salary element, to the Rate input value of the Regular Wages element, or to a designated input value of any other element you have created and associated with a salary basis.

To approve multiple salary proposals:

1. In the Salary Management folder, query the assignments you want to process.
2. Select the assignments you want to approve and choose the Approve button. To select multiple assignments, hold down the CTRL key and click on the assignment records you want to select.

Correcting a Salary Entry

You enter and approve salary proposals in the Salary Administration window. You can also correct salary entries in this window.

To correct a salary proposal:

- Enter the correct value in the New Amount field.

To correct an approved salary:

1. Delete the salary record and enter a new one.
2. If you discover an error in a proposal approved in the past, after which more recent approved proposals are on record, you must delete and reenter every proposal from the one last approved back through the incorrect one.

3. When you delete an approved proposal that the payroll run has processed, you receive a warning message. You can continue to delete the record, but you must of course correct the processing.

---

### Viewing Salary History

Oracle HRMS maintains a complete history of approved salary changes for an employee, along with associated performance reviews. In the Salary History window, you can view the dates, reasons, and amounts of each approved salary change, and of any new salary proposal.

The Salary History window contains a folder. You can enter a query in the folder to reduce the list of salary changes displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the folder menu.

The **Change** field shows the amount of the salary change, and the **Actual** field shows the new salary effective from the **Change Date**. The **Hourly**, **Monthly**, **Annual**, and **Payroll** fields show the salary prorated to these periods. The **Mid**, **Minimum**, and **Maximum** fields show values from the grade rate for the employee’s grade. The **Comparatio** field shows the salary as a percentage of the midpoint defined for the grade rate.
Salary Review Report

Use this report to see current and past salaries, and salary proposals, for some or all of your employees. You can restrict the employees to those assigned to a selected organization, job, position, or grade. You can also restrict the report to showing only employees receiving the maximum salary for their grade (defined by the grade rate). You can use the report to show all salaries (approved and proposed) or to show unapproved salary proposals only.

You run reports from the Submit Requests window.

To run the Salary Review Report:

1. In the Name field, select Salary Review Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally select an organization, job, position, and/or grade to restrict the scope of the report to employees assigned to these components.
5. If you want to restrict the report to showing salary proposals, select Yes in the Unapproved Proposals Only field.
6. If you want to restrict the report to showing employees receiving the maximum salary for their grade (defined by the grade rate), or a higher salary, select Yes in the Grade Rate Maximum Only field.
7. Choose the Submit button.
Salary Budgeting

Using Oracle Human Resources, you can set up human resource budgets for headcounts and full time equivalents at various levels of the organization.

See: Human Resource Budgets: page 12 – 2
See: Human Resource Budgets (Oracle Human Resources User’s Guide)

Most enterprises need to add salary estimates to these headcount budgets to provide salary budgets. Oracle Human Resources provides you with the key information you require to define your salary budgets:

- headcount or FTE budget for a defined period of time
- valid grades for jobs and positions
- grade rates or pay scale rates to show salary values

However, the detailed process of salary budgeting varies from one enterprise to another according to the enterprise size, type, and culture. This topic looks at three types of enterprise to suggest different ways in which you could use the information held in Oracle Human Resources to derive your salary budgets.

Note: The calculation of actual salary values happens during the payroll run. To help you compare planned versus actual spending, Oracle Payroll provides the following information:
- actual pay values for each assignment in the payroll run
- balances to show to date totals
- costs accumulated to the cost centers and project codes you set up in the Cost Allocation Flexfield

Budgeting Approach in a Government Agency

A typical government agency has a rule–based structure based on organizations, positions, and grading structures. In this type of enterprise, salary budgets are usually set for each position, then rolled up to the organization level.

Starting from the position definition, you can extract the list of valid grades and the grade rate values for each of these grades. If you use grade scales, you can use the midpoint value from the range defined for each grade.

To calculate the salary budget for each position, you multiply the position headcount by one of the values for the grade. Typically you would use the value for the middle grade. However, you might choose
the lowest grade if you are making entry-level assignments to new positions.

When you have established the relationship between these various items in the database, you can automate the budgeting through the creation of a standard reporting view, using SQL*Plus.

**Budgeting Approach in a Centralized Management Company**

The company with a centralized management structure has a more flexible approach to roles, frequently using jobs rather than positions. There is more emphasis on recruiting the 'right people' and on individual responsibility and initiative. Reward systems are usually performance related.

Salary budgets are typically set for each organization, based on a headcount budget for jobs and organizations. The budget for each organization is calculated from the midpoint grade rate value for the valid grades for each job multiplied by the planned headcount for each organization and job combination.

**Budgeting Approach in a Devolved Management Company**

In this type of enterprise, local managers are expected to decide on the composition of their own workforce in response to market requirements, and to set their staff's compensation levels, within an overall budget. Control is exercised through the allocation of a budget, but administration of the budget is left to the discretion of the local manager.

Current expenditure in each organization is used as the starting point for budgeting. This cost is projected on the basis of plans for expansion or reduction, with some inflationary factor added.

One approach to budgeting in this environment is to download current salary values from Oracle Human Resources to a spreadsheet. You can use Oracle Glue to create an interface from Oracle Human Resources to your spreadsheet system. The spreadsheet facilities are well suited to the application of various percentages to try out salary and headcount change proposals.

**See Also**

Using Oracle HRMS with Spreadsheets: page 33 – 5
The administration of a variety of employee benefits, such as pension plans, stock purchase plans, and plans providing health care coverage, is a major concern of human resource management.

Also significant in this area is the management of COBRA–eligible benefit plans. These are plans for which employees and dependents can obtain continued coverage after employee termination, or certain other changes.

This chapter explains how to administer benefits in Oracle HRMS.
Benefits Administration Overview

In Oracle HRMS you use elements to represent the various benefits available to your employees. Elements can represent benefits ranging from tangible items such as lunch vouchers and company cars, to perquisites such as company stock purchase or life insurance, to health care coverage plans for employees and their dependents.

Elements representing benefits have a benefits classification, in addition to their primary classification.

Eligibility for Benefits

You establish employee eligibility for benefits in the same way that you set eligibility rules for any element, that is, by building element links. Links define the components that must be present in employees’ assignments for the employees to be eligible for entries to the element. For example, if group life insurance is available only to employees who work full time, you can build a link for the element for this benefit to the employment category Full Time.

See: Element Links and Employee Eligibility Rules: page 7 – 25

To enroll employees in benefits, you make entries to the benefits elements to which their assignments have links.

Benefits Carriers

Using the Organization window, you enter benefits carriers into the database as external organizations with the classification Benefits Carrier. You can then associate the appropriate carrier with an element representing a benefit or benefit plan, by selecting the carrier from a list when you create the benefit element.

See:

Creating an Organization: page 2 – 20
Identifying the Information Element and Its Processing Rules: page 7 – 33

See Also

Creation of Elements for Benefits
Management of COBRA–Eligible Benefits
Benefits Classifications

Oracle HRMS comes with these classifications available for elements representing benefits that are not tangible items:

- **Medical, Dental, Vision.** These three classifications are for health care insurance plans that can include dependent as well as employee coverage. Employees and employers usually share the costs. Plans may offer employee pre–tax contributions under Section 125 of the Internal Revenue Code.

  **Note:** Oracle HRMS automatically marks as COBRA–eligible plans with a benefits classification of Medical, Dental or Vision.


- **401(k).** For employer–sponsored Defined Contribution plans for retirement savings, in which employees can participate using pre–tax earnings. Can also have employer contributions.

- **Profit Sharing.** For plans under which the employer sets aside a percentage of profits for distribution to employees, for retirement savings. May be included within a 401(k) plan.

- **Pension.** For Defined Benefit pension plans for employees, usually fully funded by the employer.

- **Stock Purchase.** For plans under which employees can purchase stock in the enterprise, often at a discount, usually without brokers’ fees.

- **Vacation Purchase.** For plans under which the employer purchases accrued but unused vacation time from employees, or employees purchase additional vacation time from the employer.

- **Life.** For group life insurance plans that are often employer–paid, but can have employee contributions. Some plans permit employees to purchase policies for dependents.

- **AD&D.** For plans frequently offered in conjunction with life insurance, to insure against accidental death or dismemberment. Often employer–paid, but can have employee contributions.

- **LTD.** For plans to insure against long–term disability. Often employer–paid, but can have employee contributions.

- **Other.** For any benefits not covered by other classifications.

Benefits Enrollment

To enroll eligible employees in a benefit, you make entries for them to the benefit element’s input values. For example, for insurance plans
providing coverage for medical, dental or vision care, enrollment occurs when you make an entry for an employee to the plan’s input value Coverage Level (employee only, employee and family etc.). Other classifications of benefits require entries to other input values.

See:

Entering Elements for Eligible Employees: page 7 – 27
Enrolling Employees in a Health Care Benefit Plan: page 10 – 14
Deleting Datetracked Information: page 1 – 15

**Dependent Coverage**

After enrolling an employee in a benefit that provides dependent coverage, you set up coverage as appropriate for his or her dependents. Before setting up this coverage, you enter the dependents into the database as contacts of the employee.

See: Establishing Benefit Coverage for Dependents: page 10 – 16

**Beneficiaries of Benefits**

After enrolling someone in a benefit for which there can be beneficiaries, you record the employee’s named beneficiaries. Employees can name both individuals and organizations as beneficiaries. Further, they can specify a benefit percentage for each beneficiary, and name both primary beneficiaries and those at lower levels.

You enter individuals named as beneficiaries into the database as contacts of the employee, and organizations or institutions named as beneficiaries as organizations with the classification Beneficiary Organization.

See: Recording Beneficiaries for Benefits: page 10 – 20
Creation of Elements for Benefits

The method used to create elements representing benefits depends on whether your Oracle HRMS installation includes Oracle Payroll, or is a site with Oracle HR only.

Regardless of the way the elements representing your benefits are created, you always link the benefits elements to establish their eligibility rules, and enroll employees in a benefit by making entries for the employees to the input values of the benefit element.

Initiation of Benefit Deductions with Oracle Payroll

At Oracle HRMS installations including Oracle Payroll, the system generates elements representing benefits when you initiate deductions for payments toward the cost of benefits. To initiate a deduction for a benefit that is not a plan for health care coverage, you enter in the Deductions window:

- the primary classification Voluntary Deductions
- the benefits classification
- the rule for the deduction amount:
  - Flat Amount
  - % of Earnings
  - Payroll Table

The system then generates an element that represents the benefit and the deduction, together with an associated formula.

Deductions for Health Care Plans

To initiate a deduction for benefit plans offering coverage for health care at installations with Oracle Payroll, you follow a special procedure, entering in the Deductions window:

- the primary classification Voluntary Deductions
- the benefits classification Medical, Dental or Vision
- the amount rule Benefits Table.

The element the system generates to represent the plan always includes these three input values:

- Coverage, to hold plan coverage levels such as Employee Only, Employee and Spouse, Employee and Family
• *EE Contr* and *ER Contr* (Employee and Employer Contribution), to hold either default dollar amounts or percentages, as you choose, for employee deductions and/or employer payments at a given coverage level taken to pay for the plan.

If necessary, you can make modifications to the generated element and formula.

**See Also**

Input Values for the Amount Rule Benefits Table (*Oracle Payroll User’s Guide*)

Benefits Table Entries for Health Care Plans: page 10 – 7

---

**Definition of Benefit Elements at Sites with HR Only**

At Oracle HRMS sites that do not include Oracle Payroll but maintain information on benefits and benefit plans in Oracle HR, you define elements to represent benefits and benefit plans using the Element window.

For elements representing most classifications of benefits, you follow the procedure for defining any element that holds information, giving these elements:

- the primary classification Information
- the appropriate benefits classification.

See: Defining an Element to Hold Information: page 7 – 32

**Defining Elements for Health Care Plans**

To define elements representing benefit plans for health care coverage, you follow a special procedure, entering in the Element window:

- the primary classification Information
- the benefits classification Medical, Dental or Vision.

The system then automatically creates the element with the input values *Coverage*, *EE Contr* and *ER Contr*:

- *Coverage*, to hold plan coverage levels such as Employee Only, Employee and Spouse, Employee and Family
- *EE Contr* and *ER Contr* (Employee and Employer Contribution), to hold default values, either dollar amounts or percentages, for
employee deductions and/or employer payments at a given coverage level taken to pay for the plan.

Notice that these automatically generated input values are not subject to change or deletion. However you can define additional input values for the element if you require them.

See Also

Defining Benefit Plan Elements at Sites with HR Only: page 10 – 8

Benefits Table Entries for Health Care Plans

All Oracle HRMS installations, with or without Oracle Payroll, use the Benefit Contributions window to enter health care plan information into the Oracle HRMS Benefits Table. For each plan, this table holds:

- the list of coverage levels available for the plan
- for each coverage level, the default employee and employer contributions toward the plan’s cost (which can, in either case, be zero).

Once coverage levels and default contributions exist in the Benefits Table, you enroll an employee in a medical, dental or vision benefit plan by selecting a coverage level for him or her, in the Coverage input value of the element representing the plan.

Note: You cannot make or change default entries to the input values Coverage, ER Contr and EE Contr using the Input Values windows that are available from the Element and Element Link windows.

See Also

Establishing Health Care Benefit Coverage and Default Contributions
Defining Benefit Plan Elements at Sites with HR Only

At HR installations that do not include Oracle Payroll, use the procedure below to define elements representing medical, dental or vision benefit plans. To define other types of benefits at these installations, use the procedure for defining elements to hold information.

See: Defining an Element to Hold Information: page 7 – 32

Note: To create elements for benefits at installations that include Oracle Payroll, initiate deductions for the benefit.

See: Initiation of Benefit Deductions with Oracle Payroll: page 10 – 5

To define benefit plan elements, use the Element window.

Prerequisites

- If a plan element you are defining needs input values in addition to Coverage, Employee Contribution and Employer Contribution, decide whether and how to validate entries to the additional input values.
- To restrict their entries to a list of valid values, use the QuickCode Types window to define a new lookup. Then enter the valid values for this lookup in the QuickCodes window.
  See: Defining QuickCode Types: page 32 – 5
- To validate values using formulas, write the validation formulas using the Formulas window.
Note: As this type of element definition occurs only at Oracle HRMS installations without Oracle Payroll, users carrying out this definition likely have the HR User Type profile option HR User. With this option, you do not see or have access to fields in the Element window needed to define elements for processing in payroll runs.

Identifying the Element and Entering Processing Rules

▶ To identify and classify the element:

1. Set the effective date early enough for any historical element entries.

2. Enter a unique name starting with a letter of the alphabet (not a number or symbol). You can optionally enter a reporting name and description. The reporting name is a short name that appears on reports, and on the statement of earnings if the element processes in the payroll run.

3. Select Information as the primary classification for the element, and Medical, Dental or Vision as its benefit classification.

▶ To enter processing information:

Note: The rule Additional Entry Allowed has no applicability for US installations. It is available for use at non-US sites.
1. Select Recurring as the element’s processing type.
2. Select Final Close as the termination rule.

**To establish currencies and qualifying conditions:**
1. The Input and Output Currencies appear as USD (US dollars) and you cannot change these defaults.
2. If there is a minimum age for employees to receive the element, enter it in the Age field.
3. If employees must complete a minimum length of service before receiving the element, enter a number in the Length of Service field and select a unit of measure (such as months or years) in the Units field.
4. Save the element definition.
   
   **Note:** As elements representing health care benefit plans cannot have standard links, the system does not allow you to check the Standard box.

**To identify the benefit carrier and contribution frequency:**
1. Click in the Further Information field to open the Further Element Information window.
2. In the Benefits Carrier field, select the name of the carrier for this plan.
3. In the Period Type field, select a period type to identify the frequency of employee contributions to the plan.
   
   For example, many health care plans require monthly contributions from employees. In this case, select the period type Calendar Month.
4. Save these entries. You can now set up the element’s input values.

**Setting Up Health Care Plan Input Values**

**To determine the units of input values created for the element:**
1. Choose the Input Values button.
2. You see that the system has created for this element, the input values Coverage, ER Contr and EE Contr. The unit of measure for the input values ER Contr (Employer Contribution) and EE Contr (Employee Contribution) is Money.
If this element needs additional input values, you can put them in now, in accordance with the procedures following Step 3.

If the element does not need additional input values:

3. Save your work. If it is not necessary to create any additional input values for the element, you are ready to enter coverage levels and default contributions for the plan and then enroll employees in the plan.

If you do need to create additional input values for the element, continue with the following procedure.

Creating Additional Input Values

► To create additional input values for the element:

1. Enter a name for the input value and select a unit of measure for it (money, hours, character, date, number or time).

2. You can enter number in the Sequence field to designate the order in which the Element Entries window displays the additional input values. The input values Coverage, ER Contr and EE Contr have the sequence numbers 1, 2 and 3, respectively, and you cannot change them.

3. If the input value must have an entry, check the Required box.

► To enter a default for an additional input value:

Note: The system does not allow you to make new entries of defaults for the input values Coverage, ER Contr and EE Contr using the Input Values windows available from the Element and Element Link windows. However you can use these windows to overwrite existing defaults.

1. Make the entry in the Default field.

2. For automatic update of existing entries of a default whenever you change the default, check the Hot Default box. Hot defaults appear in the Element Entries window in quotation marks.

⚠️ Warning: If you override a hot default appearing as an entry for an employee, any further changes to the element’s default value do not affect this entry. For this reason, it is best to make changes to a default value for large groups of employees using the BEE facility rather than the hot default feature.

► To set up validation for entries to additional input values:

1. Choose one of these approaches:
- Enter maximum and minimum values for the entry
- Select a QuickCode Type to act as a lookup for an input value whose type is Character
- Select a formula to validate entries. Formulas can return messages about the success or failure of the validation.

2. Choose Warning for the system to warn of an invalid entry, or Error if it should not save a valid entry. You cannot select Warning or Error when using a lookup for validation, because in this case an invalid entry is impossible.

3. Choose Done when you are finished. You are ready to enter coverage levels and default contributions for the plan, enroll employees in it, and establish coverage for their eligible dependents.

### Establishing Plan Coverage and Default Contributions

To enter coverage levels and default employee and employer contribution amounts for a health care benefit plan into the Oracle HRMS Benefits Table, use the Benefit Contributions window.

To enter plan coverage levels and contribution amounts:

1. Query the benefit plan in the Benefit Contributions window. In the Coverage field, enter the coverage levels available for it.
2. For each coverage level, enter an employee and an employer contribution amount. Enter an amount of zero when a plan has no contribution from the employer or from the employee.

3. Save your work. You are now ready to enroll employees in this plan.
Enrolling Employees in a Health Care Benefit Plan

The information entered in the Benefit Contributions window regarding the coverage levels and contribution amounts of a health care benefit plan goes into the Oracle HRMS Benefits table. Oracle HRMS accesses this information when you enroll an employee in the plan. To do this enrollment for individual employees, use the Element Entries window. For batch enrollments, use the BEE facility of Oracle HRMS MIX.

After you complete the enrollment of employees in health care plans, you can set up plan coverage for their eligible dependents.

To enroll an employee in a benefit plan:

1. Query the element representing the benefit plan.
2. Select the correct coverage level for the employee from the list available for the Coverage input value of the plan.

After you enroll an employee by entering his or her coverage level, the plan deduction’s input values Employer and Employee Contributions automatically receive entries of the default contribution amounts entered for the level in the Benefits Table. You can overwrite these defaults for individual employees.

After you enroll an employee by entering the plan deduction’s input values. Employer and Employee Contributions automatically receive entries of the default contribution amounts entered for the level in the Benefits Table. You can overwrite these defaults for individual employees.

To enroll a batch of employees in a benefit plan, you can use the BEE facility.

See Also

Making Non–Payroll Batch Entries Using BEE: page 8 – 3

Reviewing Employee Enrollment in Benefit Plans

You can review an employee’s enrollment in health care benefit plans using the View Employee Dental, Medical and Vision Benefits window. You select the employee assignment to view from the Assignments folder. You can then see for this employee the plan name, benefit classification and COBRA eligibility for each plan in which he or she is enrolled.
For each plan you see as well, the coverage level, the employer and employee contributions at this level, the total contribution, and the unit of measure for the contributions, which is usually money.

Note: To review coverage of an employee’s dependents in a health care plan, use the Covered Dependents window.

See: Establishing Benefit Coverage for Dependents: page 10 – 16

---

Reports on Health Care Plan Eligibility and Enrollment

Reports are available listing the employees eligible for enrollment in a health care benefit plan, and showing those actually enrolled in a benefit plan. These are the Employee Benefit Eligibility Listing and the Employee Benefit Enrollment Register.

Request reports from the Submit Requests window.

To run the Eligibility Listing or Enrollment Register:

1. In the Name field, select the report name. Click in the Parameters field to open the Parameters window if it does not open automatically.

2. In the Organization Structure and Version fields, select the name and version of the organization hierarchy you are using to determine the employees for the report to cover. In the Parent Organization field, select the organization in the hierarchy that is the highest one whose employees the report should cover.

3. In the Benefit Classification and Benefit Plan fields, select the classification and name of the plan for which you are running the report. Choose OK when you finish your entries. Then choose Submit.
Establishing Benefit Coverage for Dependents

Benefits in the following five benefits classifications can provide coverage both to employees and their dependents:

- Medical, Dental, Vision (health care coverage)
- Life (insurance coverage)
- AD&D (insurance coverage for accidental death or dismemberment)

After enrolling an employee in one of these benefits by making entries to the benefit element’s input values, you establish coverage for the employee’s dependents using the Covered Dependents window. You access this window from the Element Entries window.

See:
- Entering Elements for Eligible Employees: page 7 – 27
- Enrolling Employees in a Health Care Benefit Plan: page 10 – 14

To establish benefit coverage for dependents, start from the Element Entries window.

Prerequisite

- Enter the employee’s dependents into the system using the Contact window. Be sure to check the Dependent box for each person, and to enter his or her gender, birth date, social security number, and address.

See: Entering Dependents, Beneficiaries, and Other Contacts: page 13 – 16

Note: Entering someone as a dependent in the Contact window does not establish any benefit coverage for the dependent. For each separate benefit of an employee that offers dependent coverage, you must establish coverage for the employee’s dependents using the Covered Dependents window.

To establish benefit coverage for a dependent:

1. Set your effective date to the date this insurance coverage begins for the dependent.
2. In the Element Entries window for the employee’s primary assignment, select the element representing the benefit for which you are entering dependent coverage. Choose the Others button and select Dependent Coverage to open the Covered Dependents window.
3. In the Full Name field of the Covered Dependents window, select the dependent’s name. The social security number, relationship, and coverage start date all display.

**Note:** The name of a dependent who already has coverage in effect as of the effective date does not appear on the list. The name of a dependent with coverage scheduled to begin on a future date does appear. You receive a message about the previously scheduled coverage when saving your entries in this window.

4. To establish coverage under this benefit for another dependent of the employee, repeat step 3.

5. Save your work.

**Note:** To purge a dependent from the database, you must first purge his or her record as a covered dependent, and then purge him or her as a contact.

### Stopping Employee and Dependent Coverage

To stop a particular benefit for an employee, you place an end date on the element entry enrolling the employee in the benefit. To accomplish this you delete the entry as of the end date. This end date then automatically applies to the coverage of the employee’s dependents under this benefit, and appears in the Covered Dependents window.

For example, if you put in an end date for an element entry that enrolls an employee in Dental Plan A, coverage of the employee’s dependents under this plan automatically receives this end date also. This ensures that when the employee’s benefit coverage ends, the coverage of his or her dependents also automatically ends. However a record of the dependent remains in the database.

If you must later change or remove an end date placed on the employee’s element entry, perhaps to correct an error, the change or removal automatically applies to the coverage of the employee’s dependents. So, if you later remove the end date from the employee’s element entry for Dental Plan A, the system automatically removes any end dates it finds for coverage of the employee’s dependents under Dental Plan A.

This means that if you must correct or remove an end date of an element entry that enrolls an employee in a benefit, and must for other reasons end the coverage of one or more dependents of the employee, you should complete the work on the element entry before ending coverage for individual dependents.
Stopping Dependent Coverage Only

To stop benefit coverage for a dependent while the employee’s coverage remains in effect, you must use the Covered Dependents window. Unchecking the Dependent box in the Contact window for a dependent with existing dependent coverage prevents this person from receiving new dependent coverage, but is not sufficient to stop existing coverage.

To stop dependent coverage:

1. Enter or query the employee in question, and select the Assignment button.
2. Set the effective date to the stop date of the dependent’s coverage.
3. In the Element Entries window for the employee’s primary assignment, select the element representing the benefit for which you are stopping dependent coverage. Choose the Others button and select Dependent Coverage to open the Covered Dependents window.
4. Query the dependent whose coverage is stopping and choose Edit – Delete Record.
5. To retain a record of this person in the database as a dependent, choose End Date and save. If he or she is no longer a dependent of the employee, go to the Contact window, uncheck the Dependent box, and save.

Note: The person must remain in the database as a contact if any of the following apply:
- he or she is still covered as a dependent under other benefits or the employee, or is eligible for, or receiving, continued benefit coverage under COBRA

• he or she is the recipient of a garnishment payment or other payment from the employee
• he or she is named as a beneficiary for one or more of the employee’s benefits
• he or she is a primary contact of the employee.
Recording Beneficiaries for Benefits

Employees may name beneficiaries for benefits in these classifications:

- AD&D (insurance coverage for accidental death or dismemberment)
- Life (insurance coverage)
- 401(k) (Defined Contribution plans for retirement savings)
- Pension (Defined Benefit pension plan)
- Profit Sharing (plan distributing a percentage of profits to employees for retirement savings)
- Stock Purchase (plan for employee purchase of company stock)

After enrolling employees in one of these benefits by making entries for them to the benefit element, you record in the Beneficiaries window, information about the beneficiaries each employee has named for the benefit.

See:

Entering Elements for Eligible Employees: page 7 – 27
Enrolling Employees in a Health Care Benefit Plan: page 10 – 14

Employees may name as their beneficiaries both individuals and organizations, such as charities, hospitals, and educational or religious institutions. To record beneficiaries, start from the Element Entries window.

Prerequisites

- Enter individuals who are beneficiaries into the system using the Contact window. Be sure to check the Beneficiaries box for each person, and to enter his or her gender, birth date, social security number, and address.
  
  See: Entering Dependents, Beneficiaries, and Other Contacts: page 13 – 16

- Enter organizations that are beneficiaries into the system using the Organization window, giving them the classification Beneficiary Organization. Be sure to enter a location with an address for the organization.

  See: Creating an Organization: page 2 – 20

  **Note:** Marking people or organizations as beneficiaries does not make them beneficiaries for any particular benefit. You must list in the Beneficiaries window, the employee’s named beneficiaries for each of his or her benefits.
To record a beneficiary for a benefit:

1. Set your effective date to the date the person or organization becomes a beneficiary of the benefit.

2. In the Element Entries window for the employee’s primary assignment, select the element representing the benefit. Choose the Others button and select Beneficiaries to open the Beneficiaries window.

3. In the Level field, select Primary, Second, Third, or Fourth as the level of the beneficiary you are entering. All primary–level beneficiaries who survive the employee become the actual beneficiaries of the benefit.

   If no primary beneficiaries survive the employee, the second–level beneficiaries become the actual beneficiaries, and so forth through levels three and four. There is no limit on the number of beneficiaries you can enter at a level.

4. In the Name field, select the name of the beneficiary. The list includes all contacts marked as beneficiaries for this employee, and all organizations with the classification Beneficiary Organization. The system displays the beneficiary’s type (contact or organization) and start date.

   **Note:** A beneficiary already on record as of the current effective date for this benefit of the employee does not appear on the list. A beneficiary already entered to go into effect on a future date does appear. You receive a message about the previously entered beneficiary when saving your entries in this window.

5. In the Percentage field, enter to two decimal places the percentage of the benefit to which this beneficiary is entitled. For example, for 33.34% enter 33.34. If the total of percentages entered for beneficiaries at a level does not equal 100.00 as of the current effective date, you receive an error message.

   If you enter a percentage that causes the total for beneficiaries at this level to be greater or less than 100.00 as of another date, the system notifies you of the date but permits you to save the entry. Change your effective date to this date, and make the necessary adjustments.

   **Note:** If some but not all of the beneficiaries at a level predecease the employee and he or she does not specify an adjustment of the percentages for the remaining beneficiaries, such adjustment must be done off line.

6. To list additional beneficiaries for this benefit, repeat steps 3 through 5.
7. Save your work.

   **Note:** To purge a beneficiary from the database, you must first purge the record of the person or organization as a beneficiary, and then purge the entry of a contact or an organization.

---

**Removing Beneficiaries When Employee Benefits Stop**

To stop a benefit for an employee, you place an end date on the element entry enrolling the employee in the benefit. To accomplish this you delete the entry as of the end date. This end date then automatically applies to the beneficiaries for this benefit named in the Beneficiaries window. If you later change or remove the end date placed on the employee’s element entry, perhaps to correct an error, the change or removal automatically applies as well to end dates existing for the beneficiaries.

The automatic entry, change or removal of the beneficiaries’ end date ensures that people and organizations do not remain in the system as beneficiaries of benefits that no longer cover the employee.

If you must correct or remove an end date of an element entry that enrolls an employee in a benefit, and must for other reasons supply an end date for one or more beneficiaries named for the benefit, you should complete the work on the element entry before providing end dates for the beneficiaries.

See:

Deleting Datetracked Information: page 1 – 15

Updating and Correcting Datetracked Information: page 1 – 14

---

**Removing Beneficiaries When Employee Benefits Continue**

To remove a beneficiary while a benefit remains in effect for the employee, you must use the Beneficiaries window. Unchecking the Beneficiary box in the Contact window prevents a person from being named as a beneficiary in the future, and removing the classification Beneficiary Organization prevents an organization from being named as a beneficiary in the future. However these actions are not sufficient to remove the person or organization as a currently–named beneficiary.

▶ To remove a beneficiary while maintaining coverage:

1. Enter or query the employee, and choose the Assignment button.
2. Set your effective date to the end date for the beneficiary.

3. In the Element Entries window for the employee’s primary assignment, select the element representing the benefit for which you are removing the beneficiary. Choose the Others button and select Beneficiaries to open the Beneficiaries window.

4. Query the beneficiary to be removed, choose Edit – Delete Record, and save.

   See: Deleting Datetracked Information: page 1 – 15

5. To retain a historical record of the removed beneficiary, select End Date and save.

6. If the removed beneficiary is no longer a beneficiary of any of the employee’s benefits, go to the Contact window, uncheck the Beneficiary box, and save.

   Note: A contact removed as a beneficiary of a benefit must remain in the database as a contact if any of the following apply:

   • he or she is currently receiving benefit coverage as a dependent of the employee, or is eligible for, or is receiving, continued benefit coverage under COBRA

   • he or she is the recipient of a garnishment payment or other payment from the employee

   • he or she is named as a beneficiary for any other benefits of the employee

   • he or she is a primary contact of the employee.
Management of COBRA–Eligible Benefits

COBRA is the term commonly used to reference the Consolidated Omnibus Budget Reconciliation Act of 1985. Under this federal legislation, most employers who provide health insurance plans to employees must offer continued access to this insurance when certain changes (qualifying events) occur to the status of employees or their dependents.

Under COBRA, employers must offer continued access to group health insurance in accordance with these rules:

- Employees and their dependents must be offered continued access for 18 months after:
  - the employees’ hours are reduced, or
  - they become unemployed for any reason other than gross misconduct.

- Continued access for 36 months must be offered to
  - the dependents of deceased employees
  - an employee’s former spouse following divorce or legal separation
  - dependent children after they cease to be dependent
  - active employees who become entitled to Medicare.

If one of these qualifying events occurs, each qualified beneficiary must be offered an opportunity to elect to continue to receive the group health plan coverage that he or she received immediately before the qualifying event. If the plan has a core/noncore feature, the beneficiary may elect core coverage only. At the end of the 18– or 36–month period, employers must offer conversion to an individual policy if the group plan permits conversion.

To cover their administrative costs, employers can require employees and dependents electing continued coverage to pay up to 102% of the insurance premiums. In addition, employers can require disabled employees to pay up to 150% of the insurance premiums after the first 18 months of COBRA coverage.

COBRA does not affect employers with fewer than 20 employees or those with church plans. Nor does it apply to plans maintained by US federal, state or local governments.

Employer Responsibilities under COBRA

To administer continued health plan coverage under COBRA, you do the following:
• identify which of your benefit plans are COBRA–eligible
• enter and maintain information about employees’ dependents
• record the events that qualify employees or dependents for continued coverage as they occur, and the qualifying dates
• notify employees, former employees and dependents of their eligibility for continued insurance coverage, and record their acceptance or rejection of such coverage. Oracle HR includes a standard COBRA notification letter you can use.

Employees and dependents have 60 days from their qualifying date or the date they receive their notification letter, whichever is later, in which to elect continued coverage. For those who make this choice, you must:
• determine and schedule the premium payments to be made for continued coverage, and record the receipt of these payments.
• record the eventual termination of their continued coverage.

Standard Letters for COBRA Notification and Termination
Oracle HR provides standard letters for informing employees or dependents of their eligibility for continued coverage, or of pending termination of this coverage. You can modify these letters as you wish using SQL*ReportWriter 2.0. The standard letters are:
• The COBRA Notification Letter, informing people of their eligibility for continued coverage under COBRA.
• The COBRA Grace Period Expiration Letter, informing people electing continued coverage that a premium payment is overdue, and that nonpayment will result in termination of the continued coverage.
• The COBRA Expiration Letter, informing people electing continued coverage that this coverage will terminate soon, because the time period over which it was available (18 or 36 months) is ending.

See: Obtaining COBRA Reports and Standard Letters: page 10 – 32

Standard COBRA Reports
The COBRA Coverage Report
This report shows information about the employees and dependents eligible for continued coverage under COBRA whom you have entered
into the system. This report shows employees’ names and assignment numbers, or dependents’ names and relationships, as well as their qualifying events and dates, their notification date and their COBRA status.

For those who elect continued coverage, it shows the start and end dates of the coverage period, the benefit plan names, and the premium amounts charged.

**The COBRA Payments Report**

This report shows information about COBRA payments due and payments received, after you have entered this information into the system. As well as the name and assignment number or relationship of covered employees and dependents, it displays their qualifying events and dates, their amounts due and due dates, and dates of payment receipts, amounts received and amounts outstanding.

See: Obtaining COBRA Reports and Standard Letters: page 10 – 32
Administering COBRA

To administer COBRA–eligible benefit plans, you start from the COBRA Coverage window to do the following:

- Record qualifying events
- Change COBRA coverage statuses to track notification of eligibility for continued coverage, acceptance or rejection of this coverage, and eventual termination of accepted coverage
- Set up continued coverage, establish payment schedules, and record receipts.

Prerequisites

- Create your COBRA–eligible benefit plans. The system automatically identifies as COBRA–eligible, plans with one of these benefit classifications:
  - Medical
  - Dental
  - Vision

  Installations including Oracle Payroll create these plans in a different way from those without Oracle Payroll.

  See: Creation of Elements for Benefits: page 10 – 5

- Enroll employees and their eligible dependents in the plans.

  See:

  Enrolling Employees in a Health Care Benefit Plan: page 10 – 14
  Establishing Benefit Coverage for Dependents: page 10 – 16

- If necessary, make additions to the list of reasons for terminating continued coverage under COBRA. Oracle HRMS includes two reasons:
  - End of Coverage. The maximum period of coverage (18 or 36 months) has been reached.
  - Non–Payment. The employee or dependent has failed to pay the coverage premium.

  Use the QuickCodes window to enter more reasons for the QuickCode type US_COBRA_TERM_REASON.

  See: Adding QuickCode Values: page 32 – 3
Recording Qualifying Events

To record a qualifying event and its date:

1. For all qualifying events except termination, set your effective date to the qualifying date. This is the day after the date of the qualifying event, that is, the day on which current benefit coverage would cease.

   After terminating an employee using the Termination window, you can navigate directly to the COBRA Coverage window. The qualifying date automatically defaults to the day after the termination date.

2. In the COBRA Coverage window, select the qualifying event from the list. The following events require you to offer continued coverage of COBRA-eligible benefit plans to employees, together with any dependents previously included in their coverage:
   - Medicare entitlement
   - Reduced work hours which result in the loss of coverage
   - Termination

   When selecting one of these events, do not enter a dependent’s name or relationship.
Note: For the events Reduced Hours and Termination, the system checks for a reduction in the employee’s standard working hours or for a termination. If it finds no hours reduction or termination, it issues an error message.

The following events require you to offer continued coverage to dependents:

• Death of Employee
• Divorce or Legal Separation
• No Longer Dependent

For one of these events, select also the name and relationship of the dependent responsible for electing and paying for any continued coverage, for example, the spouse of a deceased employee. If it is unclear which dependent to select, for example if all the dependents of a deceased employee are minor children, consult your Benefits Administrator.

3. The status of COBRA coverage resulting from entry of the qualifying event defaults to Awaiting Notification, as of the effective date. Save your work at this status. After sending out notification of eligibility for continued coverage, and when this coverage is rejected or accepted, enter status changes.

Changing Coverage Statuses

After notifying employees or dependents of eligibility for continued coverage, change the COBRA coverage status from Awaiting Notification to Notified. Depending on what people choose to do, the next status change is to Rejected or Elected.

When elected coverage terminates, either because the maximum time period allowed (18 or 36 months) is up or because of failure to pay premiums, change the coverage status to Terminated and select a reason for this change.

You can quickly change a status in the COBRA Coverage window. To see a history of COBRA status changes for an employee or dependent when making a status change, use the COBRA Statuses window.

To make changes to the status of COBRA coverage:

1. To quickly enter a status change without reviewing previous changes, use the COBRA Coverage window. Set the effective date, choose the Notify, Elect, Reject or Terminate button, and save the
change. For a change to the status Terminated, entry of a reason is required.

2. To see a history of previous status changes for this coverage, choose the Statutes button to go to the COBRA Statutes window. After reviewing the changes to date, you can select another change from the list, enter the effective date and save your work.

3. After recording a status change indicating election of continued coverage, set up continued coverage for the employee or dependent.

---

**Setting Up Continued Coverage under COBRA**

To do this, start from the COBRA Coverage window and then go to the COBRA Benefits window.

- **To set up continued coverage under COBRA**

  1. For an employee or dependent who elects continued coverage, enter in the COBRA Coverage window the Period Start Date from which the coverage will continue. The system automatically supplies the end date of the continued coverage period (either 18 or 36 months after the period start date).

  2. In the COBRA Coverage window, choose the Benefits button to go to the COBRA Benefits window, which displays all the benefit plans eligible for continued coverage in which the employee was enrolled before the COBRA qualifying date.

    The Basic column of the Costs region displays each plan’s basic cost, that is, the total of employee and employer contributions toward the plan.
3. Check the Accepted box for each plan for which the employee or dependent is electing continued coverage. Under Coverage, select the level of the continued coverage, which must be equal to or lower than the employee’s original coverage.

4. Under COBRA in the Costs region, enter the premium for continued coverage of this plan. If the amount entered exceeds 102% of the basic cost of the plan, you receive a warning message, which you can override. Save your work.

5. When you finish setting up continued coverage, establish a payment schedule for the coverage. Then use this schedule to record payments as you receive them.

---

Establishing a Payments Schedule and Recording Receipts

To set up the payments schedule, use the COBRA Coverage window. To review the generated schedule and enter payments, go to the COBRA Payments window.

To schedule premium payments and record receipts:

1. Go to the Payment region of the COBRA Coverage window. In the Amount Charged field of this region, the system displays the total amount required to pay the premiums for the continued coverage elected. In the First Due Date field in this region, enter the due date of the first premium payment.

2. In the Grace Period field of the Payment region, enter the maximum number of days that can elapse after the due date before you receive the premium payment.

3. Save your work.
4. Choose the Payments button to go to the COBRA Payments window. Use this window to review the generated schedule of due dates, premium amounts and grace dates, and to enter premium amounts and dates received.

Obtaining COBRA Reports and Standard Letters

To obtain these reports and letters, use the Submit Requests window.

Prerequisite

- Before running a COBRA report or letter, ensure that the information needed in the report or letter is entered in Oracle HRMS.

▶ To run the COBRA Coverage or Payments report:

1. In the Name field of the Submit Requests window, choose the report name. If the Parameters window does not automatically open, click in the Parameters field.
2. Control the list of employees and dependents the report covers by the report parameters. For example, if Termination is the parameter for Qualifying Event, the report lists only those employees and dependents eligible for continued coverage under COBRA whose qualifying event is employee termination.

▶ To obtain a COBRA standard letter:

1. In the Name field of the Submit Requests window, choose the letter type. The available types are:
   - COBRA Notification Letter
• COBRA Grace Period Expiration Letter
• COBRA Expiration Letter

If the Parameters window does not automatically open, click in the Parameters field.

2. Enter the appropriate parameters for the letter and choose Submit. The letter prints out just as a report does. These letters do not include address information for employees or dependents.
Labor Costs

You must be able to enter and maintain information relating to the labor costs associated with your employees. In Oracle HRMS, you set up segments of the Cost Allocation key flexfield to identify the work structures that constitute your cost centers and the GL account codes to use for entry of labor costs.

Installations including Oracle Payroll use post-payroll run processes to accumulate information on payroll costs by cost center, GL account code, and labor distribution codes, and to transfer information to Oracle General Ledger.

This chapter explains the setup for collection of labor costs in Oracle HRMS, and the Oracle Payroll processes for accumulating and transferring these costs.
Labor Costs in Oracle HRMS

At all installations of Oracle HR, you can allocate employee costs to cost centers, GL codes and labor distribution codes. If your installation does not include Oracle Payroll or Oracle General Ledger, you must consider how to relate information on labor costs entered in Oracle Human Resources to your payroll and financial systems.

If your installation includes Oracle Payroll, you use a post-payroll run process to accumulate payroll costs by cost center, GL account code, and the labor distribution codes in use at your enterprise. For installations that also include Oracle General Ledger, another post-payroll run process is available to facilitate the transfer of information on payroll transactions to Oracle General Ledger.

For the allocation of labor costs, all installations of Oracle HRMS, use the Cost Allocation key flexfield.

The Oracle HRMS Cost Allocation Key Flexfield

In this flexfield you set up as many segments as you need to identify:

- the companies or sets of books for which your enterprise collects labor costs
- the work structures, such as departments, sections, or projects that constitute the cost centers of your enterprise
- the GL codes and labor distribution codes against which you collect labor costs.

Example Cost Allocation Flexfields

To construct a simple example of a Cost Allocation flexfield, suppose that the departments of a hypothetical enterprise each constitutes a cost center, and the general ledger accounts receiving labor costs are Salaries, Wages, Overtime, Bonuses, Union Dues Liability and Clearing.

Note: The Clearing account in this example represents a single account set up for entry of:

- credits, in order to balance debits to accounts for earnings types, for example Salaries, Wages, Overtime and Bonuses
- debits, in order to balance credits to accounts for deductions, for example Union Dues Liability.

After running payroll and the Costing process, you can make journal entries to credit or debit each individual balancing
account, making corresponding debits or credits to the Clearing account.

This example enterprise must transfer to the general ledger, information such as the following:

- the totals of salaries and wages paid in its departments/cost centers, to go as debits to the Salaries and Wages accounts, and as balancing credits to the Clearing account
- the total of bonuses paid to employees, to go as a debit to the account Bonuses, and as a balancing credit to the Clearing account
- the total deducted from employees in Production and Quality Control to pay their union dues, to go as a credit to the Dues Liability account, and as a balancing debit to the Clearing account.

To collect information for transfer to the general ledger, this enterprise can construct a Cost Allocation flexfield with two segments, one for identifying cost centers and one for GL costing and balancing codes, as follows:

<table>
<thead>
<tr>
<th>Seg. 1 Cost Center</th>
<th>Seg. 2 GL Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting</td>
<td>Salaries</td>
</tr>
<tr>
<td>Production</td>
<td>Wages</td>
</tr>
<tr>
<td>Public Relations</td>
<td>Overtime</td>
</tr>
<tr>
<td>Quality Control</td>
<td>Bonuses</td>
</tr>
<tr>
<td>Sales</td>
<td>Dues Liability</td>
</tr>
<tr>
<td></td>
<td>Clearing</td>
</tr>
</tbody>
</table>

Table 11–1 Example Cost Allocation Flexfield

Now suppose that for labor distribution purposes, this enterprise accumulates labor costs not just by cost center and GL account, but also by its product lines, represented by the labor distribution codes H201, H202, H305, H307 and H310. The enterprise requires product line costing information such as the following:

- total wages paid to produce product line H201, and to check its quality
- total paid for overtime to produce product line H201
- total paid for salaries and bonuses to sell product line H201

Since this enterprise uses its GL codes for labor distribution, it does not need another segment to hold a separate list of codes. However, it must add another segment to hold product line codes, as follows:
Similarly, if this enterprise needed to identify for each of its payrolls a particular company or set of books to which all the information on labor costs should go, it could define another segment of the Cost Allocation flexfield such as Company or Set of Books, to contain a list of the appropriate codes.

**Note:** Installations including both Oracle HRMS and Oracle General Ledger should take the GL codes for the Oracle HRMS Cost Allocation flexfield and for the Oracle General Ledger Accounting flexfield from the same table. Installations without Oracle GL can set up their own tables of GL codes, possibly populating these tables from their existing financial systems.

See: User-defined Tables: page 32–10
Use of the Cost Allocation Key Flexfield

When implementing and using Oracle HRMS, you make selections from the lists in the Cost Allocation flexfield segments as follows:

- **When defining a payroll,** you can select a code for the company or set of books holding the labor costs from the payroll.

- **When linking an element** representing an earnings type such as Regular Salary, a deduction such as Union Dues, or an employer charge such as a benefit plan contribution, you select a GL code that the element’s results should debit or credit, and a code for the balancing GL account to credit or debit.

  **Note:** As well as making entries to the Cost Allocation flexfield at the element link level, you also enter on each link, essential information about the **type** of costing the system should do for the link. Available types include Costed, Fixed Costed, and Distributed.

  See: Costing Information at the Element Link Level: page 11 – 7

- **When defining an internal organization or entering an employee assignment,** you can select codes for the cost centers, product lines or other structures for which to collect the labor costs of the organization or assignment.

- **When entering timecard data** in Oracle Payroll, you can select codes for accounts, cost centers, product lines and other items listed in the flexfield segments to show how to collect labor costs for particular hours worked.

The different points at which you can make entries to segments of the Cost Allocation flexfield exist as related **entry levels.** Ranging from top to bottom, the five entry levels are these:

<table>
<thead>
<tr>
<th>Entry Level</th>
<th>Windows</th>
<th>Purpose of Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payroll</td>
<td>Payroll</td>
<td>Identifies company or set of books to which all costs from this payroll should go.</td>
</tr>
<tr>
<td>Link</td>
<td>Element Link</td>
<td>Identifies a GL account to debit and a balancing account to credit, or for deductions, an account to credit and a balancing account to debit. Other entries can identify any other accounts into which run results of the element should go.</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization</td>
<td>Identifies structures such as cost centers against which to charge the payroll costs of employees in the organization.</td>
</tr>
</tbody>
</table>

Table 11 – 3 Cost Allocation Flexfield Entry Levels
Purpose of Entry

Windows

Assignment

Costing

Entry Level

Identifies structures such as cost centers and product lines against which to regularly charge payroll costs of this assignment.

Assignment

Costing

Entry Level

Identifies structures such as cost centers and product lines against which to charge payroll costs of an employee assignment for a period. Entries often taken from timecards.

PayMIX Time

Entry,

Element

Entries

Table 11 – 3 Cost Allocation Flexfield Entry Levels

Note: You enable a qualifier for each segment of your Cost Allocation flexfield to control whether it appears at a given entry level. For example for the Cost Center segment of your flexfield, which receives entries only at the organization, assignment and element entry levels, you enable only the Organization, Assignment and Element Entry qualifiers. This segment then appears only at these levels.

See: Setting Up the Cost Allocation Key Flexfield: page 11 – 11

Cost Allocation Flexfield Entry Overrides

A key feature of the Cost Allocation flexfield is that entries made to its segments at lower levels, override any entries at higher levels. Thus, entries from timecards made in a particular segment at the Element Entry level override any entries to this segment made at the employee assignment, organization, link and payroll levels.

This helps to keep your costing information accurate. For example, if employees temporarily work at cost centers or on product lines different from those entered for their organizations or assignments, they can enter the cost center or product line codes together with their time worked on their timecards. On receipt of this costing information at the element entry level, the system correctly charges their time for the period, using this information rather than any entered at the organization or assignment levels.

Costing Data at the Payroll Level

Sometimes the labor costs from a payroll should all be charged to a particular company within your enterprise, or all be entered in a particular set of books. In this case, you select the code for the company or set of books from the appropriate segment of the Cost Allocation flexfield when defining the payroll.
Also at the payroll level, you can select codes for *suspense accounts*. A suspense account is one that collects costs from the payroll if segment entries at lower levels are missing. For example, if an employee receives a Special Production Bonus but no GL code for this earnings type to debit in the Cost Allocation flexfield, the cost of the bonus goes into the suspense account.

Entries of sums in a suspense account alert you to missing codes, and provide a way to hold unallocated costs until you can make manual journal entries to the correct accounts. Since codes entered in the Cost Allocation flexfield at levels below the payroll level override any entered at the payroll level, costs go to a suspense account only when the correct account codes are not entered at the element link level.

**See Also**

Defining a Payroll: page 5 – 6

### Costing Data at the Element Link Level

You enter the important costing information for an element on its links. This means that **all elements for which you must maintain costing information must have at least one link**, even those that receive entries during the payroll run as indirect results of the processing of other elements.

See: Entry as an Indirect Result of Formula Processing: page 7 – 29

When defining a link for an element, you select a *costable type* that determines whether the payroll run should collect the results of this link for costing purposes. By default, a link’s costable type is *Not Costed*. For the results of elements that process in payroll runs to be collected for accumulation and transfer, you must change this default to a costable type of either *Costed*, *Fixed Costed* or *Distributed*.

**Costable Type: *Costed* and *Fixed Costed***

When processing an element for an employee with a link marked Costed, the payroll run checks for Cost Allocation flexfield entries affecting the employee at every level—payroll, organization, assignment, and element entry. Since earnings types may well receive override entries of information for labor distribution purposes at the lower levels of Assignment or Element Entry, the costable type Costed is likely to be best for the links of elements representing earnings.
however, deduction amounts are usually irrelevant to labor distribution analyses, so elements representing deductions seldom receive lower level entries of costing information. Accordingly, the costable type Fixed Costing may be best for these elements’ links. When processing elements marked for Fixed Costing, the system looks for costing information at the payroll, element link and organization levels only, not the assignment or element entry levels.

**Costable Type: Distributed**

For labor distribution analysis, you can distribute employer charges, such as employer payments for FUTA, Social Security, or employee benefits, as overhead costs to be added to employees’ earnings. The links of elements representing employer charges you want to distribute in this way require the costing type Distributed.

For each employee, Oracle Payroll distributes the run results of elements with this costable type proportionally over a set of earnings types you specify. This *distribution set* of earnings types could include, for example, Wages, Overtime and Shift Pay. When you select Distributed as the costable type of a link, you must also enter the name of the distribution set of earnings over which the run results of the link are to be distributed.

See: Defining an Element or Distribution Set: page 31 – 5

**Costing and Balancing GL Accounts**

For element links whose run results should go to the general ledger, you enter in the Costing field of the link, the GL account to debit or credit, and in the Balancing field, the account to correspondingly credit or debit.

For earnings types and non–payroll payments, the GL account to debit (for example, Salaries) goes in the Costing field, and the account to credit (for example, Clearing) goes in the Balancing field. For deductions, the account to credit (for example, Clearing) goes in the Costing field, and the account to debit (for example, Union Dues Liabilities) goes in the Balancing field.

**See Also**

Defining Element Links: page 7 – 37

Example of Employer Charge Distribution: page 11 – 19
Costing Data at the Organization and Assignment Levels

When setting up an internal organization for which most or all labor costs go to the same cost center, select that cost center from the appropriate segment of the Cost Allocation flexfield when defining the organization.

For example, if the labor costs of most of the employees in the Commercial Sales Group go against the cost center Sales, select Sales from the list of cost centers when defining the organization Commercial Sales Group. This means that by default, the system accumulates labor costs for each employee assigned to the Commercial Sales Group for the cost center Sales.

Perhaps the costs of some employees assigned to this group should exceptionally be charged to a different cost center. For these employees, you can enter the correct costing information on their assignments. Entries at the assignment level override entries at the organization level.

There may also be employees regularly assigned to work in this group only part time, who work elsewhere the rest of the time. In cases like these, it is not necessary to give employees two assignments. You can enter a number of cost centers for one assignment, specifying the percentage of labor costs to charge to each:

<table>
<thead>
<tr>
<th>Proportion</th>
<th>Seg. 1 Cost Center</th>
</tr>
</thead>
<tbody>
<tr>
<td>50%</td>
<td>Sales</td>
</tr>
<tr>
<td>50%</td>
<td>Public Relations</td>
</tr>
</tbody>
</table>

Table 11 – 4 Example Cost Center Information at the Assignment Level

You can also enter other types of costing information at the assignment level. For example, if a Production Department employee regularly works 80% of the time on one product line and 20% on another, you can enter this on her assignment.

<table>
<thead>
<tr>
<th>Proportion</th>
<th>Seg. 3 Labor Dist. Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>80%</td>
<td>H201</td>
</tr>
<tr>
<td>20%</td>
<td>H202</td>
</tr>
</tbody>
</table>

Table 11 – 5 Example Labor Distribution Information at the Assignment Level

Notice that assignment level entries are datetracked, so you can enter changes ahead of time.
See Also

HR Organizations: Entering Costing Information: page 2 – 30

Costing Data at the Element Entry Level

When you make entries to elements with links marked as Costed for individual employees using the Element Entries window, or for many employees at once using the PayMIX windows, you can at the same time supply costing information. Information entered at this level overrides any information entered at other levels. For example, if an employee has costing information on record in a Cost Allocation flexfield segment at the organization or assignment level, an entry of timecard information in this segment at the element entry level overrides the organization or assignment-level information.

See Also

Making Manual Element Entries: page 7 – 41
PayMIX Timecard Entries: page 8 – 14
Setting Up the Cost Allocation Key Flexfield

You must define at least one segment of the Cost Allocation key flexfield; you may define as many as 30 segments. To set up this flexfield, consult the explanations and procedures given in the *Oracle Applications Flexfields Manual*.

You can control which segments of the Cost Allocation flexfield appear in each of the windows from which users can make entries to this flexfield.

Controlling the Display of Flexfield Segments

Oracle HRMS implementors and users make selections from the lists in the Cost Allocation flexfield’s segments at different levels, that is, in several different Oracle HRMS windows. However in a particular window, they usually need to access only certain segments of the flexfield.

For example, when defining a payroll you need only the segment containing the companies or sets of books to which a payroll’s labor costs should go. When defining a link for an earnings or deduction element, you may need only the segment containing the list of the costing and balancing GL codes. You likely need the segment containing the list of cost centers only when defining an organization or employee assignment, or making an element entry.

You control the appearance of a Cost Allocation flexfield segment in a particular window by enabling *qualifiers* for the segment. When you enable a particular qualifier for a segment, this causes the segment to appear and be available for entry in a particular window, as follows:

<table>
<thead>
<tr>
<th>Qualifier</th>
<th>Enables Segment's Appearance in</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Element Link window</td>
</tr>
<tr>
<td>Balancing</td>
<td>Element Link window</td>
</tr>
<tr>
<td>Payroll</td>
<td>Payroll window</td>
</tr>
<tr>
<td>Organization</td>
<td>Organization window</td>
</tr>
<tr>
<td>Assignment</td>
<td>Assignment Costing window</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Element Entries window</td>
</tr>
</tbody>
</table>

*Table 11–6 Qualifiers for Cost Allocation Flexfield Segments*

You can enable as many qualifiers as necessary for a particular segment. Consider this example:
Table 11 – 7 Example Cost Allocation Flexfield

For the segments of this flexfield, qualifiers would likely be enabled as follows:

<table>
<thead>
<tr>
<th>Segment</th>
<th>Qualifiers Enabled</th>
<th>Windows Displayed in</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Cost Center</td>
<td>Organization</td>
<td>Organization</td>
</tr>
<tr>
<td></td>
<td>Assignment</td>
<td>Assignment Costing</td>
</tr>
<tr>
<td></td>
<td>Element Entry</td>
<td>Element Entries</td>
</tr>
<tr>
<td>2. GL Code</td>
<td>Element</td>
<td>Element Link</td>
</tr>
<tr>
<td></td>
<td>Balancing</td>
<td></td>
</tr>
<tr>
<td>3. Labor Dist.</td>
<td>Organization</td>
<td>Organization</td>
</tr>
<tr>
<td>Code</td>
<td>Assignment</td>
<td>Assignment Costing</td>
</tr>
<tr>
<td></td>
<td>Element Entry</td>
<td>Element Entries</td>
</tr>
</tbody>
</table>

Table 11 – 8 Qualifiers for Example Cost Allocation Flexfield

Enabling the qualifiers Organization, Assignment and Element Entry for the Cost Center segment and the Labor Distribution Code segment causes these segments to appear in the Organization, Assignment Costing and Element Entries windows, but not in the Payroll or Element Link windows.

Enabling the qualifiers Element and Balancing for the GL Code segment causes this segment to appear in the Costing and Balancing fields of the Element Link window, but not in the Payroll, Organization, Assignment Costing or Element Entry windows.

**Note:** Since this example Cost Allocation flexfield has no segments set up to hold payroll–level information such as sets...
of books, there is no need to enable the qualifier Payroll for a segment of this flexfield.
Costing for Taxes

The setup for maintaining costing information on employer and employee federal tax liabilities is straightforward. However, the setup for costing state and local taxes depends on the way your general ledger holds this information.

On the one hand, just as you enter a total into a GL account for a federal tax type, your enterprise may enter a total into a GL account for one or more state or local tax types, regardless of the states or localities levying the taxes. For example, you enter a single total for amounts withheld for employees’ federal income tax (FIT), and may similarly enter a single total for amounts withheld for employees’ state income tax (SIT), regardless of the states in which these taxes are owed. Alternatively, you may make entries for state and local taxes for each state, or state and locality, in which these taxes are owed. In this case, your setup for costing these taxes will differ from that used for federal taxes.

Elements for Taxes

Oracle Payroll comes with the elements for the following taxes already defined (EE = employee tax, ER = employer tax):

Federal taxes
- Federal Income Tax (FIT) – EE
- Federal Unemployment Tax Act (FUTA) – ER
- Social Security (SS) – EE and ER
- Medicare – EE and ER
- Earned Income Credit (EIC) – EE

State taxes
- State Income Tax (SIT) – EE
- State Unemployment Insurance (SUI) – ER, EE in some states
- State Disability Insurance (SDI) – EE, ER in some states

Local taxes
- City Tax – EE. Includes coverage of Head Tax – ER.
- County Tax – EE. Includes coverage of School District Tax – EE

Links to all payrolls for the elements for each of these taxes are usually created during the implementation of Oracle HRMS for your enterprise.
Costing All Taxes by Tax Type

You maintain costing for federal taxes by the tax type, and can similarly hold costing information for state and local taxes by type only (not by the state or locality to which they are payable). To do this you enter on the link for the tax type’s element the code for the general ledger account to which amounts of the tax should go.

For example, suppose that:
- the segment of the Cost Allocation key flexfield that holds GL codes has the name GL Code
- all amounts withheld for FIT should go to the GL account code 123fit, and all amounts for SIT, should go to 123sit.

To collect costing information for both these taxes, you do the following:
- ensure that links to all payrolls exist for the elements FIT and SIT. These are usually created during implementation of Oracle Payroll.
- if the possible entries to the GL Code segment exist in value sets validated by entries existing in a table or on a predefined list, ensure that the codes 123sit and 123fit appear in the table or list.

See: Values and Value Sets (Oracle Applications Flexfields Guide)
- Query the FIT or SIT element in the Element Link window. In the Costing region, choose the tax type Fixed Costed. The Transfer to GL box is automatically checked.
- For the FIT element, select in the Costing field, the account code 123fit. For the SIT element, select the code 123sit.

With this setup, when the Costing process runs, it will collect all amounts withheld for FIT and SIT under the GL codes 123fit and 123sit.

Costing State and Local Taxes by Jurisdiction

If your general ledger maintains tax totals by state, or by state and locality, you follow a different setup procedure for costing these taxes. You still must ensure that links to all payrolls exist for the tax elements.
Additionally, you must set up one or more special segments of the Cost Allocation key flexfield to collect the required jurisdiction information. These special segments must be named as follows:

- **State Code.** If your requirement is to collect state and local tax costs by state but not locality, set up only this segment.
- **County Code, City Code, School District Code.** Set up these three segments if you must collect tax amounts not only by state, but also by locality.

**Attention:** In setting up these segments, do not mark them as required. Also, do not enable any qualifiers for them, as they should not appear in any Oracle HRMS windows.

See: Controlling the Display of Flexfield Segments: page 11 – 11

These segments are special in that you never make any entries in them at any of the entry levels (Payroll, Element Link, Organization, Assignment, or Element Entry). Instead, these segments receive entries directly from the payroll run.

Payroll runs enter the appropriate jurisdiction code for each of the state and local taxes it processes:

- into the State Code segment, if the other segments are not defined, or
- into the State Code, County Code, City Code, and School District Code, if these are all defined.

When the Costing process runs, it collects the amounts for each state and local tax under the jurisdiction code of the state or locality. For example, the jurisdiction code of the state of Illinois is 14, for Kane County in this state the code is 089, and for the town of Geneva in this county the code is 1110.

It is your responsibility to set up matches between your GL account codes and the jurisdiction codes the Costing process uses, and to develop a process for transferring Costing process results to the appropriate accounts in your general ledger. A complete listing of US jurisdiction codes used in Oracle HRMS is available in the GeoCoder Master List from Vertex Inc.
Accumulation and Transfer of Payroll Costs

At installations including Oracle Payroll, you initiate the post–run process Costing following payroll runs to accumulate costing results for transfer to the GL and other systems. This process sorts the run results by company or set of books, cost center, and GL and labor distribution accounts, in accordance with the information you have selected from the Cost Allocation flexfield at all levels.

The sections that follow contain examples of the cost allocation of payroll results, and of the distribution of employer charges over selected employee earnings.

If your installation also includes Oracle General Ledger, following the Costing process you can run the process Transfer to GL, to facilitate the transfer of the results from the Costing process to Oracle General Ledger.
Example of Labor Cost Allocation

The Sample Payroll Results table below displays payroll run results for four employees, using accounts and work structures identified using the Cost Allocation key flexfield. The Example Costing Process Results table shows how the Costing process allocates these payroll results:

- to accounts and cost centers, for the general ledger
- to accounts for cost centers and product lines within cost centers, for labor distribution purposes.

<table>
<thead>
<tr>
<th>Employee</th>
<th>Work Structure</th>
<th>Earnings &amp; Deductions</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cost Center</td>
<td>Product Line</td>
<td>Salary</td>
</tr>
<tr>
<td>Employee 1</td>
<td>Production</td>
<td>H201 100%</td>
<td>1,000</td>
</tr>
<tr>
<td>Employee 2</td>
<td>Sales</td>
<td>H305 100%</td>
<td>1,500</td>
</tr>
<tr>
<td>Employee 3</td>
<td>Production</td>
<td>H201 50% H202 50%</td>
<td>2,000</td>
</tr>
<tr>
<td>Employee 4</td>
<td>Sales</td>
<td>H305 20% H310 40%</td>
<td>1,000</td>
</tr>
</tbody>
</table>

Table 11 – 9
The table below shows the allocation of costs from the sample run results displayed above.

<table>
<thead>
<tr>
<th>Account Code</th>
<th>Cost Center</th>
<th>Product Line</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Production</td>
<td>H201</td>
</tr>
<tr>
<td>Salaries</td>
<td>2,500</td>
<td>1,700</td>
</tr>
<tr>
<td>Wages</td>
<td>3,000</td>
<td>2,000</td>
</tr>
<tr>
<td>Overtime</td>
<td>1,000</td>
<td>700</td>
</tr>
<tr>
<td>Union Dues</td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>Liability</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clearing</td>
<td>(Account contains balancing credits for earnings Salary, Wages and Overtime, and balancing debit for deduction Union Dues.)</td>
<td></td>
</tr>
</tbody>
</table>

Table 11 – 10

**Example of Employer Charge Distribution**

When you give links for elements representing employer charges the costable type Distributed, the Costing process distributes the employer charges as overhead for each employee, over a set of employees’ earnings.

See: Costing Information at the Element Link Level: page 11 – 7

This example shows how employer payments totalling $100 are distributed over a set of earnings including wages and overtime, for the cost center Production and the product lines H201 and H202.

**Overhead Distribution for the Production Cost Center**

Total paid to Production Cost Center as Wages run result: $3,000.00

Total paid to Production Cost Center as Overtime run result: $1,000.00

Total for Earnings types specified for distribution: $4,000.00

Ratio for Wages distribution, Production Cost Center = 3000/4000 = .75

Wages overhead = Pension Charge $100 x .75 = $75.00
Ratio for Overtime distribution, Production Cost Center =
1000/4000 = .25
Overtime overhead = Pension Charge $100 x .25 = $25.00

**Overhead Distribution for Product Lines H210 and H202**

Total paid for Product Line H201 as Wages run result: $2,000.00
Total paid for Product Line H202 as Wages run result: $1,000.00
Total paid for Product Lines 201 and 202 for Wages: $3,000.00

Ratio for Wages distribution, Product Line H201 = 2000/3000 = 0.6667
Product Line H201 overhead = Total Wages overhead $75 x .6667 = $50.00
Ratio for Wages distribution, Product Line H202 = 1000/3000 = .3334
Product Line H202 overhead = Total Wages overhead $75 x .3334 = $25.00

Total paid for Product Line H201 as Overtime run result: $700.00
Total paid for Product Line H202 as Overtime run result: $300.00
Total paid for Product Lines H201 and H202 as Overtime: $1,000.00

Ratio for Overhead distribution, Product Line H201 = 700/1000 = .7
Product Line H201 overhead = Total Overtime overhead $25 x .7 = $17.50
Ratio for Overhead distribution, Product Line H202 = 300/1000 = .3
Product Line H202 overhead = Total Overtime overhead $25 x .3 = $7.50
### Distribution of Overhead over Cost Center and Product Line Totals

<table>
<thead>
<tr>
<th>Account Code</th>
<th>Cost Center</th>
<th>Product Line</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Production</td>
<td>H201</td>
</tr>
<tr>
<td>Wages</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3,000</td>
<td>2,000</td>
</tr>
<tr>
<td>Employer Liability Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>75</td>
<td>50</td>
</tr>
<tr>
<td>Overtime</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1,000</td>
<td>700</td>
</tr>
<tr>
<td>Employer Liability Distribution</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>17.50</td>
</tr>
</tbody>
</table>

Table 11 – 11
Running the Costing Processes

Run the Costing process from the Submit Requests window.

To run the Costing process:

1. Select Costing in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. In the Parameters window, select the payroll or consolidation set for which you are running the Costing process. If you select a payroll, the name of its consolidation set appears in the Consolidation Set field.

3. In the Start and End Date fields, enter the start and end dates of the period of time for which you want to see costing results. Choose Submit.

Reviewing Costing Process Results

To review these results online, use the Costing Breakdown window and the Costing window. Standard reports on these results include Costing Breakdown Summary, Costing Breakdown for Costing Run, and Costing Breakdown for Date Range.

Online Results

The Costing Breakdown window summarizes the results of a run of the Costing process.

See: Reviewing Process–Level Results (Oracle Payroll User’s Guide)

The Costing window displays complete results of the Costing process for an individual employee assignment.

See: Reviewing Assignment–Level Result (Oracle Payroll User’s Guide)
The Cost Breakdown Summary Reports

The Cost Breakdown Summary reports are Cost Breakdown Report for Costing Run and Cost Breakdown Report for Date Range. They show for a payroll, a consolidation set, a GRE, or all GREs, summarized totals either from one run of the Costing process, or from all the Costing processes run during a specified date range. For GL accounts, debits and credits appear separately.

Run this report from the Submit Requests window.

To run a Cost Breakdown Summary report:

1. In the Name field, select either Cost Breakdown Report for Costing Run or Cost Breakdown Report for Date Range. Click in the Parameters field if a window containing the parameters for this report does not appear.

2. For the Cost Breakdown for Costing Run report, select the Costing Process. To see results from this process for a single GRE only, select this GRE in the GRE field. Choose OK, then Submit.

3. For the Cost Breakdown for Date Range report, enter the start and end dates of the date range. To see results from processes run in this range for a single consolidation set, payroll, or GRE, select the GRE, consolidation set or payroll. Otherwise, the report covers all GREs’ results for the date range. Choose OK, then Submit.
Transferring Costs to Oracle General Ledger

If your installation includes Oracle General Ledger, you can run the Transfer to GL process to facilitate transfer of the results of the Costing process for a payroll to the Accounting flexfield of Oracle General Ledger.

Mapping Flexfield Segments

Before running this process, for each payroll you must map segments of the Cost Allocation flexfield to the corresponding segments of the GL Accounting flexfield. To accomplish this mapping, use the GL Map window.

Prerequisites

- Complete the setup of the Cost Allocation key flexfield in Oracle Payroll.
- Complete the setup of your sets of books and Accounting key flexfield in Oracle General Ledger.
- Check that the Oracle Payroll currency codes match those of Oracle General Ledger. Using the international set of currency codes for both ensures that they match.

To map Cost Allocation to Accounting flexfield segments:

1. Set your effective date to the date from which this mapping should take effect.
2. Query the payroll for which you are performing the mapping. Its period type appears in the Period field.

3. Select the set of books for whose Accounting flexfield you are performing the mapping. Costing information from a payroll can go to only one set of books. The payroll and set of books must have the same currency code.

4. Select the name of a Cost Allocation flexfield segment in the Payroll Costing Segment field for which a corresponding segment exists in the Accounting flexfield. Select the name of the corresponding segment in the GL Chart of Accounts Segment field. Repeat this process for all the Cost Allocation flexfield segments for which there is a corresponding segment in the Accounting flexfield.

5. Save your entries.

Running the Transfer to GL Process

Run this process from the Submit Requests window.

To run the Transfer to GL process:

1. Select Transfer to GL in the Name field. If the Parameters window does not open automatically, click in the Parameters field.

2. In the Parameters window, select the payroll or consolidation set for which you are running the Transfer to GL process. If you select a payroll, the name of its consolidation set appears in the Consolidation Set field.

3. In the Start and End Date fields, enter the start and end dates of the period of time for which you want to see costing results. Choose Submit.
In Oracle Human Resources, you can define non-monetary budgets, such as headcount or full-time equivalents, that are based on your work structures. This chapter explains how to set up budgets and to report on budget variances.
Human Resource Budgets

In Oracle Human Resources, you can define non–monetary budgets, such as headcount or full–time equivalents, that are based on your work structures.

You can define budgets against an organization, job, grade, position, or any combination of these. You can monitor the budgets by comparing the budget values with actual values derived from employee assignments.

For example, you might define a headcount budget of two for the position Marketing Manager. The variance of the actual value from the budget value depends on the number of employees assigned to that position at any time. A negative variance indicates a vacancy.

Entering Actual Values Against Budgets

You can monitor human resource budgets by comparing the budget values with actual values derived from employee assignments.

In the calculation of actual values, an assignment does not always count as one. For example, if an assignment is part–time, it should count as less than one for a Full Time Equivalent type of budget. At the Business Group level, you can enter the default value of an assignment for each budget type. Then you can override the default for particular assignments in the Assignment Budget Values window.
To override the default for an assignment:
- Select a budget type in the Units field and enter the value of the assignment for this budget in the Value field.

**Attention:** If you do not enter a default value at the Business Group level, you must be careful to enter a value for every assignment. If there is no value entered in the Assignment Budget Values window, that assignment is not counted when calculating actual values for the budget.

---

**Setting Up Budgets**

**To set up a human resource budget:**

1. Define values for the QuickCode Type BUDGET_MEASUREMENT_TYPE in the QuickCodes window.
2. Review the period types defined on the system. You can rename them to match the names you use in your enterprise.
3. Define calendars to determine the start date and period type of your budgets.
4. Define your budgets.
Salary Review Report

Use this report to see current and past salaries, and salary proposals, for some or all of your employees. You can restrict the employees to those assigned to a selected organization, job, position, or grade. You can also restrict the report to showing only employees receiving the maximum salary for their grade (defined by the grade rate). You can use the report to show all salaries (approved and proposed) or to show unapproved salary proposals only.

You run reports from the Submit Requests window.

To run the Salary Review Report:

1. In the Name field, select Salary Review Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally select an organization, job, position, and/or grade to restrict the scope of the report to employees assigned to these components.
5. If you want to restrict the report to showing salary proposals, select Yes in the Unapproved Proposals Only field.
6. If you want to restrict the report to showing employees receiving the maximum salary for their grade (defined by the grade rate), or a higher salary, select Yes in the Grade Rate Maximum Only field.
7. Choose the Submit button.
Salary Budgeting

Using Oracle Human Resources, you can set up human resource budgets for headcounts and full time equivalents at various levels of the organization.

See: Human Resource Budgets: page 12 – 2
See: Human Resource Budgets (Oracle Human Resources User’s Guide)

Most enterprises need to add salary estimates to these headcount budgets to provide salary budgets. Oracle Human Resources provides you with the key information you require to define your salary budgets:

- headcount or FTE budget for a defined period of time
- valid grades for jobs and positions
- grade rates or pay scale rates to show salary values

However, the detailed process of salary budgeting varies from one enterprise to another according to the enterprise size, type, and culture. This topic looks at three types of enterprise to suggest different ways in which you could use the information held in Oracle Human Resources to derive your salary budgets.

Note: The calculation of actual salary values happens during the payroll run. To help you compare planned versus actual spending, Oracle Payroll provides the following information:
- actual pay values for each assignment in the payroll run
- balances to show to date totals
- costs accumulated to the cost centers and project codes you set up in the Cost Allocation Flexfield

Budgeting Approach in a Government Agency

A typical government agency has a rule–based structure based on organizations, positions, and grading structures. In this type of enterprise, salary budgets are usually set for each position, then rolled up to the organization level.

Starting from the position definition, you can extract the list of valid grades and the grade rate values for each of these grades. If you use grade scales, you can use the midpoint value from the range defined for each grade.

To calculate the salary budget for each position, you multiply the position headcount by one of the values for the grade. Typically you
would use the value for the middle grade. However, you might choose the lowest grade if you are making entry-level assignments to new positions.

**Reviewing and Renaming Period Types**

Budgetary calendars and payroll calendars are based on a period, such as a Quarter or a Year. Standard period types are seeded with the system. If you want to use a different name for a period type, enter the name in the Period Types window.

You cannot remove the names that are already defined, but you can insert a new record and select the appropriate Number Per Year.
Defining Calendars

You can define calendars for human resource budgets in the Budgetary Calendar window.

1. Enter the name, and start date for your calendar. Check that the start date year is early enough to cope with your historic data. Once you define the calendar, you cannot change the start date.
2. Select a period type. If you select Semi–monthly, enter a value between 1 and 28 in the Midpoint Offset field to determine the start date of the second time period each month. For example, if you enter the value 15, the second time period each month begins on the 16th.
3. Save the calendar. The system automatically creates the time period details. You can alter the default names for each time period.
4. If you want to add years to, or delete years from, the end of the calendar, choose the Change Calendar button.
5. When you have defined your calendars, you are ready to define your budgets.

To define a budgetary calendar:

1. Enter the name, and start date for your calendar.
   Check that the start date year is early enough to cope with your historic data. Once you define the calendar, you cannot change the start date.
2. Select a period type. If you select Semi–monthly, enter a value between 1 and 28 in the Midpoint Offset field to determine the start date of the second time period each month. For example, if you enter the value 15, the second time period each month begins on the 16th.
3. Save the calendar.
   The system automatically creates the time period details. You can alter the default names for each time period.
4. If you want to add years to, or delete years from, the end of the calendar, choose the Change Calendar button.
5. When you have defined your calendars, you are ready to define your budgets.
Defining Human Resource Budgets

You define human resource budgets in the Budget window.

During the time period of the budget, it may be necessary to adjust the budget values as a result of organizational or financial change. You can create multiple versions of a single budget for comparison purposes.

To define a budget:

1. Enter the name of the budget, and select a measurement type and calendar. Save the budget.

2. Enter a version number and start date for this budget version. Save the new version.

3. Select the components for which you want to produce budget element information, and save your work.

   You can enter any combination of organization, job, position, and grade. You must select a value for at least one of the fields.

4. In the Budget Values block, select a specific time period from your calendar. Enter a numeric budget value for your selected budget element for that period.

   The system automatically gets the actual values and calculates the Variance as an absolute value and a percentage value.
5. Select other time periods for this budget element, as you require, and enter your budget values. Save your values.

6. Repeat steps 3 and 4 as necessary for other budget elements. Save your work.

Viewing and Reporting Budget Variances

You can view the variance for any budgets in the Budget window. If you are using positions, you can view the variance between your budget and the actual values for positions using two other windows:

- List Position Budget Variance
- List Budget Variance by Organization.

You can report on variances using the Staffing Budget Details report.

List Position Budget Variance

To view position variances within a hierarchy:

1. In the List Position Budget Variance window, select a position hierarchy and a position from the hierarchy.
The inquiry will return the budget variance for this position and its subordinates in the hierarchy.

2. Select a budget and the budget period for which you want to view variances. Choose the Find button.

The folder displays the actual number of holders at the start and end of the period, the number of new starters and leavers during the period, and the variance between the budget value and the actual value at the period end.

List Budget Variance by Organization

To view position variances within an organization:

1. In the List Budget Variance by Organization window, do one of the following:
   - Select an organization hierarchy and an organization from the hierarchy. The inquiry returns the budget variance for all positions within this organization and its subordinates in the hierarchy.
   - Select an organization. The inquiry returns the budget variance for all positions within this organization.
2. Select a budget and the budget period for which you want to view variances. Choose the Find button.

The folder displays the actual number of holders at the start and end of the period, the number of new starters and leavers during the period, and the variance between the budget value and the actual value at the period end.

**Staffing Budget Details Report**

You can use the standard Staffing Budget Details report to compare your actual staffing levels with budgeted levels for a specified range of periods.

You run reports in the Submit Requests window.

**To run the Staffing Budget Details report:**

1. In the Name field, select Staffing Budget Details report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select the budget and version.
5. Select the start and end periods to include in the report.
6. Choose the Submit button.
This chapter focuses on how to enter people and personal information on the system. You can choose to hold a wide range of personal information, such as medical details, work schedule, and preferred language for correspondence, as well as the basics such as date of birth, employee number, and addresses.

It also explains how to hire people, how to enter personal contacts, including dependents and beneficiaries, and how to inquire and report on the people held in the system.

For people who are your employees, there is assignment information and other information to hold. Chapter 14 Employment Information looks at information to record specifically for employees.
Displaying Personal Information

There are lots of ways to view information about people held in Oracle HRMS. For example, you can:

- use Employee Direct Access to view and update your own personal details using a web browser
- use Line Manager Direct Access to view information about people in your organization
- use the Find Person window or a People folder to display the people who interest you, then ‘drill down’. by clicking on buttons, to the information you need
- use an inquiry window to view specific information about a person, such as employment or absence history
- use QuickPaint to design a report incorporating personal, assignment, application, or compensation information

See Also

Web and Workflow Access: page 18 – 4
Inquiry Windows and Folders: page 30 – 3
QuickPaint: page 30 – 8

Using the Find Person Window

When you navigate to the People window, the Find Person window automatically displays in front of it.

To query a person using the Find Person window:

1. Do one or both of the following:
   - Enter a full or partial query on the person’s name. Where a prefix has been defined for the person, a full name query should be in the format ‘Maddox, Miss Julie’.
   - If relevant, enter a query on employee number, applicant number or social security number.

2. Choose the Find button.

The person or people found by the query are displayed in the People window. If the query found more than one person, you can
use the [Down Arrow] key or choose Next Record from the Go menu to display the next person.

People Folders

Using the People Folder window, you can enter inquiries about the people held on Oracle HRMS. You select the fields of personal information you want to see, and position them in the order you prefer. For example, you can produce an alphabetical listing of all applicants and their gender, nationality, and disability registration.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.

Note: The system administrator can create customized versions of the People Folder window so that you use each version for one person type only.
Entering Personal Information

Every enterprise must be able to record personal information for its employees, applicants, and contacts. Some of this information is standard, including basic information such as name, address, birth date, hire date, and nationality.

Oracle HRMS enables you to enter and update this information for all person types on one form – the People window. You can also use this window to update people’s statuses, for example, from applicant to employee.

Note: The system administrator can create customized versions of the People window so that you use each version for certain person types only or for certain functions only (entering employees, entering applicants, or hiring applicants).
Entering New People

Use the People window to enter and maintain basic personal information for all person types, including employees.

The minimum information to enter for all categories of people is name and type. In addition, for employees you must enter gender, employee number and date of birth (for assignment to a payroll). All other personal information is optional.

To enter a new person:

1. If the Find Person window opens, choose New.

2. Set your effective date to the appropriate date for adding the person to the system. If you are entering an employee, this should be his or her hire date.

   Note: Before making a change to a hire date already entered for an employee, ensure that the start date of the employee’s primary address is the same as or earlier than the new hire date. This preserves the integrity of the employee’s tax records.

3. Enter the person’s name and other details in the Name region.

   • You can use the Title field to enter a title such as Mrs. or Doctor for the person.

   • You can use the Prefix field to enter the first part of the person’s name, such as Van or De. This field allows you to sort by the main part of the last name, Zee instead of van der Zee, if you choose to do so.

   • You can use the Suffix field to hold part of the last name, such as Junior or II. This enables the suffix to be reported on separately, as required in some government–mandated reports.

4. For an employee, you must select the gender, Male, Female or Unknown Gender, from the list.

5. Select a type. If you select Employee, the Hire Date field displays your effective date. You can change the hire date, and this changes the employee’s effective start date.

6. Enter the person’s identification information in the Identification region.

   If your enterprise uses manual number entry, use the Employee or Applicant fields to enter an employee or applicant number as appropriate. If your enterprise uses automatic number generation,
the employee or applicant number automatically displays when you save your entries in this window.

7. Enter details for the person as required in the Personal Information region:
   • To assign an employee to a payroll, you must enter his or her date of birth.
   • In the Mail To field, select Home or Office to indicate the person’s preferred mail destination
   • In the Date Last Verified field, you can enter the date the person last checked this personal information for accuracy.
   • In the Status field, select the person’s marital status
   • In the Email field, enter the person’s email ID

8. At the request of an applicant or employee, you can register him or her as disabled by checking the Has Disability box. The Americans with Disabilities Act (ADA) Report includes employees registered as disabled in its listing of disabled employees.
   
   See: ADA (Americans with Disabilities Act) Reporting: page 17 – 28

Optionally, you can enter additional information for people in the alternative regions described in the following steps.

To enter employment information for an employee:

Prerequisite

❑ The system comes with these reasons for excluding a newly hired employee from the New Hire report:
   • Age less than state minimum
   • Wages less than state minimum
   • Hours worked less than state minimum

   If you require other reasons, enter them for the QuickCode type US_NEW_HIRE_EXCEPTIONS.
   
   See: Adding QuickCode Values: page 32 – 3

1. Choose the Employment Information alternative region.

2. Select an ethnic origin. For accurate EEO–1 and AAP reporting, it is essential to select an ethnic origin for employees.
   
   See: Data for EEO–1 Reporting: page 17 – 3

3. Check the I–9 box when the Employment Eligibility Form I–9 for the employee is completed. Under the US Immigration and
Control Act of 1986, this must occur within three days of hire, or within 90 days for employees who have applied for the necessary documentation and are awaiting its receipt.

Note: By signing Form I–9, employees attest they are eligible for employment in the US. The employer also must sign the form, listing documents presented to verify the employee’s eligibility as a US citizen, a lawful permanent resident alien, or an alien otherwise authorized to work in the US.

4. Enter an I–9 Expiration Date if the employee’s eligibility to work in the US ends at a certain date, given in his or her documents.

5. For someone not a US citizen, select a visa type.

6. Select the person’s veteran status in the Veteran Status field.

To identify employees for inclusion in VETS–100 reporting, it is essential to select Disabled Veteran, Vietnam Veteran or Disabled Vietnam Veteran for each employee qualifying for one of these statuses.

See: VETS–100 (Federal Contractor Veterans Employment) Reporting: page 17 – 21

7. To identify an employee as a student, check the Student box.

8. To enter data for the New Hire report:
   - The New Hire Status field defaults to Include in New Hire Report, so that the next run of the New Hire report for the employee’s GRE will include this employee.
   - If the New Hire report should not cover this employee, select Exclude from New Hire Reporting. Optionally, select a reason for this exclusion in the Exception Reason field.
   - If this employee is currently obliged to pay child support, check the Child Support Obligation box.

Note: After a run of the New Hire report that includes the employee, the entry in the New Hire Status field automatically changes to Already Reported.

See: New Hire Reporting: page 13 – 32

9. After saving your entries in the Employment Information alternative region, enter a primary address for the employee. The window available for entering this address depends on whether or not your installation includes Oracle Payroll.

Note: In Oracle HRMS, every employee must have a primary address on record at all times. At sites using Oracle Payroll, the
start date of this address cannot be later than the hire date of the employee.

See Also

Entering People’s Addresses at Sites without Oracle Payroll: page 13 – 11
Entering People’s Addresses at Sites with Oracle Payroll: page 13 – 12

To enter office location information for a new hire or an existing employee:
1. Choose the Office Location Information alternative region.
2. Enter the office number for this office.
3. Enter the internal location of this office.
4. Enter the office identifier for internal mail.

To enter information for an applicant:
1. Choose the Applicant Information alternative region.
2. If the applicant’s resume is on file, check the Exists check box.
3. If the applicant’s resume is on file, select the date indicating when the resume was last updated.
4. Select the date up to which a file is to be maintained for this applicant.

To enter information concerning the background check for an employee:
1. Choose the Background Information alternative region.
2. Check whether the employee’s background check has been performed.
3. Select the date on which the background check was performed.

To enter rehire recommendation information for an applicant who was a former employee:
1. Choose the Rehire Information alternative region.
2. Check whether the former manager has recommended the applicant for rehire.
3. Select the reason for this recommendation.

► **To enter further name information:**
   1. Choose the Further Name Information alternative region.
   2. Enter one or more honors/degrees (BA, MBA, or JD, for example) which the employee has earned.
   3. Enter the name (perhaps a nickname) by which the employee prefers to be known.
   4. If the employee previously was known by a different last name, enter the previous last name.

► **To enter medical information for an employee:**
   1. Choose the Medical Information alternative region.
   2. Select the employee’s blood type.
      You cannot change this value once you enter it.
   3. Select the date of this employee’s last medical test.
   4. Enter the name of the physician who performed this test.

► **To enter other information for a person:**
   1. Choose the Other Information alternative region.
   2. Select the type of schedule the employee will work.
   3. Select the current status of the student.
   4. Enter the person’s current full time/part time availability to work with your company.
   5. Select the language the person prefers for correspondence.
      This language can differ from the person’s native language, depending on the nature of the correspondence.
   6. Check the Military Service check box if the person is employed in a military service in some capacity.
      The value of this field can impact benefits calculations.
   7. Check the Second Passport Exists check box if the person possesses multiple passports.

   **Note:** The Background Information, Medical Information and Rehire Information alternative regions appear only if your system administrator has enabled them for you.
Hiring

To hire an employee:
- When you enter a new person as an employee, he or she is automatically hired as of your effective date.

To hire an applicant:
1. Update the applicant assignment status to Accepted in the Application window.
2. Set your effective date to the applicant’s hire date and query the applicant in the People window.
3. In the Type field, select Employee. The Hire Date field displays your effective date.
4. Save your work.

Note: You cannot update the applicant assignment status to Accepted and change the Person Type to Employee on the same date, since these are both datetracked changes.

To rehire an ex-employee:
1. Set your effective date to the new hire date and query the ex-employee in the People window.
2. In the Type field, select Employee. The Hire Date field displays your effective date.
3. Save your work.

To cancel a hire:
- Query the employee in the People window and clear the Hire Date field. Then save.

The system warns you that any changes made to the person’s records after their hire date will be lost. You can choose whether to continue or cancel.

You cannot cancel a hire if:
- Oracle Payroll has processed the employee in a payroll run.
- The person’s type has changed since the hire date.
- New assignments have been created for the person after the hire date.
The person was initially entered on the system as an employee and therefore has no previous history as an applicant or contact. In this case you must delete the person’s records from the system using the Delete Person window.

See: Deleting a Person from the System: page 13 – 37

See Also

New Hire Reporting: page 13 – 32

Note: Telephone numbers you enter here are held separately from the numbers you enter in the Phone Numbers window. You have to enter and maintain them separately.

4. Save your work.

Entering People’s Addresses at Sites without Oracle Payroll

All employees must have one (and only one) primary address on record at any point in time, but can have an unlimited number of secondary addresses (such as Summer or Weekend).

To enter all primary and secondary addresses for employees and their contacts at Oracle HR sites that do not include Oracle Payroll, you use the generic Address window. This window permits you to select address styles appropriate both for the US and Canada, and other foreign countries as well.

It does standard validation of field entries (for example, for zip code length), but at sites without Oracle Payroll, no special validation of city or county names, zip codes, or other address elements.

Prerequisite

- Set up the address types you require, such as Summer or Weekend, as QuickCodes for the QuickCode Type ADDRESS_TYPE.

  See: Adding QuickCode Values: page 32 – 3

To enter a generic address:

1. Select a national address style.

   A window opens with the address format for the country you select.

   Note: Default address styles are predefined for many countries. You can change these defaults and can create address styles for other countries.
See: Changing Address Styles: page B – 9

2. Enter address information in this window and choose the OK button to return to the Assignment window.

The first address entered for someone is by default, the primary address. Employees must have one (and only one) primary address at all times, but can have any number of secondary addresses. However, they cannot have two secondary addresses with the same name at the same time.

3. Select an address type, such as Summer or Weekend.

4. To identify the person’s main address, check Primary. By default, the first address you enter is the Primary address.

At any time, only one address can be a primary address.

---

**Entering People’s Addresses at Sites with Oracle Payroll**

Oracle Payroll uses employees’ primary addresses to maintain federal, state and local tax rules for employees subject to US taxes. Therefore, these employees must have on record at all times, one and only one correct, primary US address with an open end date, that includes a valid city, state, zip code and county. This means that sites including Oracle Payroll must enter a new employee’s primary address using a date no later than the employee’s hire date.

The US–specific address window appearing on the menu at sites including Oracle Payroll accepts and fully validates entries of city, state, zip code and county for US addresses, and entries of city, province and post code for Canadian addresses. It is very convenient to use, because entry of only a zip or post code automatically brings up the city, county and state, or city and province, to which the zip or post code applies.

By default, the first address you enter for someone becomes the primary address. Employees must have one (and only one) primary address in effect at all times. There is no limit on the number of secondary addresses, such as weekend or summer addresses, you can enter for a person. However, a person cannot have two secondary addresses with the same name at the same time.

---

**Foreign Secondary Address Entry**

If you often enter foreign secondary addresses, ask your system administrator to add the generic address window to your menus. This
window permits you to select the correct address style for any country when making entries.

See: Entering People’s Addresses at Sites without Oracle Payroll: page 13 – 11

**Note:** At sites with Oracle Payroll, the generic address window does only standard validation for all but one national address style. For the US address style, it does the same full validation as entries made in the US–specific address window. However, it is more efficient for users at sites with Oracle Payroll to use the US–specific Address window to enter US and Canadian addresses.

### US and Canadian Address Entry

When entering US or Canadian addresses for employees and their contacts, use the US–specific Address window.

**Prerequisites**

- Set up the secondary address types you require, such as Summer or Weekend, as QuickCodes for the QuickCode Type ADDRESS_TYPE.
  
  See: Adding QuickCode Values: page 32 – 3

- Cities or towns with populations of 200 or less may not be included on the lists for US and Canadian address validation; if not, you must enter them in the database. To check whether a city or town name is in the database, query it in the Cities window.
  
  See: Adding a City for Addresses: page 13 – 14

**To enter a US or Canadian address with full validation:**

1. Set the effective date to the date the address takes effect.
2. In the Address lines, enter the street name and number, and any related information such as building name or apartment number.
3. If you know the US zip code or Canadian post code, enter it in the Zip Code field. For US addresses, this restricts the listing of cities, states, and counties to those valid for the zip code. For Canadian addresses, this restricts the listing of cities and provinces to those valid for the post code. You can then select this additional address information from short lists.

**Note:** For Canadian addresses, CN (for Canada) always appears in the State field, the province name appears in the County field, and the post code appears in the Zip Code field.
4. If you are unsure of the zip or post code, enter the city name. For US addresses, this restricts the lists of states, counties and zip codes to those valid for the city. For Canadian addresses, this restricts the lists of provinces and post codes to those valid for the city. You can then select this additional address information from short lists.

5. If you are unsure of both a zip or post code and the city name, for a US address enter the two-letter state abbreviation. This restricts the city, zip code and county lists to those valid for the state. For a Canadian address, enter CN in the State field. This restricts the city, post code and province lists to Canadian entries. Then select the additional address information.

6. Optionally, enter telephone numbers and select the address type. Check or uncheck the Primary box as required. Notice that a person must have a primary address on record before you can enter any secondary addresses for him or her.

7. If you know the last date this address will be effective for the person, enter it in the Date To field.

8. Save your work.

Adding a City for Addresses

A US or Canadian city or town with a population of less than 250 may not be entered in the HRMS database. Before entering the address of someone living in a city or town not in the database, you must add the city or town to the database using the Cities window.

1. In the State Name field, select the name of the state or territory in which the city is located. For Canadian cities, select Canada in this field.

2. In the County name field, select the county in which the city is located. For Canadian cities, select in this field the province in which the city is located.

3. Enter the city name in the City Name field.

4. If there is a single zip or post code for the city, enter it in the Zip Start field and leave the Zip End field blank.

5. If a range of zip or post codes applies to the city, enter the first code of the range in the Zip Start field, and the last code of the range in the Zip End field.

6. Save your work.
Adding Telephone Information

You can enter multiple telephone numbers for people in the HRMS database. To enter telephone information for a person, use the Phone Numbers window.

▲ To enter a telephone number:

1. In the Type field, select the type of the telephone device.
2. In the Phone Number field, enter the telephone number.
   Any format is allowed.
3. In the From field, select the start date for the telephone number.
4. In the To field, optionally select the date when the telephone number is no longer valid.
5. In the last field, optionally add the extension number.
6. Save your work.

Note: If you want to maintain a history of telephone numbers for this person, be sure to add a new entry for the new telephone number and enter an end date for the existing telephone number. If you do not want to maintain such a history, simply update the record for the existing telephone number.
Entering Pictures

You can store a picture associated with each person on your system, perhaps holding a photograph or digitized image of the person’s signature. These may be useful for approval or identification purposes. You must digitize the image and save it in one of the following file formats:

- BMP
- JFIF
- JPEG
- PCX
- PICT
- TIFF

You enter pictures in Oracle HRMS in the Picture window.

To enter a person’s picture in Oracle HRMS:
1. In the Picture window, choose the Load Picture button.
2. Enter the file path to locate the directory in which you saved the graphic file.
3. Highlight the filename and choose the OK button. The graphic is loaded in the format indicated by the filename. For example, a file called image.bmp would be loaded as a BMP file.

Entering Dependents, Beneficiaries and Other Contacts

Use the Contact window to hold information about an employee’s contacts, for example:

- people to contact in an emergency
- dependents
- beneficiaries of benefits such as insurance policies or stock purchase plans
- individuals receiving payment of a wage attachment deducted from the employee’s salary

A person entered as a contact can be one, some, or all of the above.

Prerequisite

- Set up any relationship types (such as spouse, child, or friend) you want to use as values for the QuickCode Type CONTACT.
To enter a contact:

1. Do one of the following:
   - Enter the name of a new person.
   - Select from a list of people already entered on the system.

2. If this contact is a dependent of the employee, a named beneficiary of the employee, or a recipient of the payment of a wage attachment from the employee, ensure that his or her social security number, gender, and birth date are all on record.

3. Optionally, select a relationship type for the contact.

4. If this contact is receiving a payment from the employee such as a court-ordered wage attachment, check the Payments Recipient box. This allows you to select this person on the Personal Payment Method window when entering a third party payment method for the employee.

   See: Making Payments for Wage Attachments (Oracle Payroll User’s Guide)

5. If this contact is a dependent of the employee, check the Dependent box. You can then establish dependent coverage for this person under one or more of the employee’s benefits that provide dependent coverage.

   See: Establishing Benefit Coverage for Dependents: page 10 – 16
6. If this contact is named as a beneficiary for one or more of the employee’s benefits, check the Beneficiary box. You can then record this person as a beneficiary for these benefits.

   See: Recording Beneficiaries for Benefits: page 10 – 20

7. Save your work.

8. To enter addresses for the contact, choose the Address button.

    Entering People’s Addresses at Sites with Oracle HR Only: page 13 – 11

    Entering People’s Addresses at Sites with Oracle Payroll: page 13 – 12
Competence Profiles, Qualifications, School Attendances and Work Choices

As you recruit new people and develop existing employees, you need to track their competencies and work preferences. This enables you to match them to projects and vacancies, develop succession plans, and organize further training and certification. In Oracle HRMS, you can record the following information:

- A competence profile – this is a list of the competencies held by a person and their level of proficiency in each competence.
- Qualifications, including details of individual subjects, grades, licenses, status of ongoing training and tuition fees.
- Attendances at educational establishments, such as schools and colleges.
- Work choices, including willingness to travel and relocate; preferred working hours, work schedule, and duration within post and preferred countries for international relocation.

You can enter this information when an employee first joins the enterprise, taking the details from their resume or from tests or interviews. You might update it after the employee successfully completes a training course, and after periodic assessments or appraisals.

You can either enter this information using standard Oracle HRMS windows or using the web–based Line Manager Direct Access.

Copying Core or Primary Assignment Competencies

Some competencies are important for all employees throughout your enterprise; others are required for particular jobs, positions, or organizations. If competencies have been entered as core competencies for your enterprise or as requirements against a person’s job, position, or organization, you can copy them to the person’s competence profile. Copying competencies not only saves you time from having to enter the details yourself, but it also ensures that you do not miss entering relevant competencies.

To assist you in entering applicants and evaluating employees against vacancies, you can also copy competencies from a vacancy. The system checks all the competence requirements of the organization, job and/or position for which the vacancy is defined. It enters these against the person so that you can record the person’s proficiency in each competence and then compare applicants against the vacancy’s requirements.
Managing Competencies Over Time

You can make changes to the competencies and proficiency levels your employees possess over time, enabling you to see both the latest and historical information. When you view a competence profile, you can choose whether to see just the current profile or all historical information, if you want to see changes in proficiency levels over time.

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.


Creating a Competence Profile

Use the Competence Profile window to create and update a personal competence profile.

When you open this window, you will see all competencies, past and present, held by the person. If you want to see only current competencies and proficiency levels, check the Current Competencies box.

To create a competence profile:

1. Select the first competence this person possesses.
   You can also automatically enter all competencies required for the person’s primary assignment or a vacancy, or the enterprise’s core competencies. See: To copy competencies from requirements: page 13 – 21.

2. Select the proficiency level at which the person performs the competence.

3. Enter the date from which the person possesses the competence at this level. For example, if the person gained the competence through a qualification, enter the date the qualification was gained. You can enter a date when the competence expires, if required.

4. In the Source of Proficiency Rating field, you can select the method by which the person gained the competence, such as training course or previous experience.

5. Select the method of certifying that the person attained the competence at the recorded level, such as by examination.
6. Enter the date when the person’s proficiency in this competence should be reviewed.

7. Continue to enter the competencies the person possesses, then save your changes.

▶ To copy competencies from requirements:

1. Choose the Copy Competencies button. A Copy Competencies window appears.

2. Do one of the following:
   • Check the Core Competencies box to copy all the competencies required throughout your enterprise.
   • Check the Primary Assignment Competencies box to copy all the competencies required in the organization, job and position to which the person is assigned.
   • Select a vacancy to copy all the competencies required in the organization, job and position for which the vacancy is defined.

3. Enter the dates between which the competencies are valid (you must have a From date, but you can leave the To date blank).

4. Choose the Copy button.
   You can now enter proficiency levels, certification methods, and so on for each of these competencies held by the person.

▶ To update a competence profile:

1. Check the current check box if you want to see only the current competencies the person possesses, otherwise leave this box blank.

2. Enter new competencies for this person, or update proficiency levels and other details for existing competencies.
   
   **Note:** If you update a proficiency level, enter the date when the new level was attained. Then, when you save your changes, you will see that the system keeps a record of the old proficiency level, ending the day before the start date of the new level.

3. Save your changes.

**Entering Work Choices**

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the
length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

You enter personal deployment choices in the Work Choices window, accessed from the People window.

**To enter work choices for a person:**

1. Check the relevant work capabilities boxes if the person is:
   - willing to work in all locations
   - willing to relocate
   - willing to travel
   - prepared to work in their current location only
   - willing to visit internationally

2. Select the length of time the person wants to stay in a role, for example, indefinite or two years.

3. Select the person’s preferred working hours (for example, 9.00 to 5.30), work schedule (the working days in the week or pattern of shifts), the proportion of full time hours available and any relocation preferences (for example, with family).

4. Check the relevant international deployment boxes if the person is willing to:
   - work in all countries
   - relocate

5. Select the countries in which the person prefers to work, and any countries in which they are not prepared to work.

6. Save your work.
Entering Qualifications

You can enter an employee’s qualifications when they first join the enterprise, and then update them after periodic assessments or appraisals or after completion of a training course.

Use the Qualifications window, accessed from the People window, to enter and update qualifications.

To enter qualifications:
1. Select the type of qualification this person possesses and the title of the qualification.
2. Select the status of the qualification, for example, whether training is ongoing or completed.
3. Enter the grade at which the person holds the qualification, if appropriate.
4. Select the establishment at which the person gained the qualification.
5. Enter the awarding body which bestowed the qualification, if you want.
6. Enter the dates between which the qualification is gained. You must enter a Start date but you can leave the End date blank (if the qualification is still incomplete).
7. Enter the date the qualification was awarded, if you want.
8. Enter the projected completion date the qualification is awarded, if relevant.
9. Enter the ranked position within the class, if relevant.
10. Enter any comments, for example, what percentage of the award was course work or examination, if you want.
11. Save your work.

To enter tuition fees for reimbursement:
1. In the Tuition Details alternative region, enter the amount and select the currency to reimburse the person.
2. Select the method of tuition, for example, day release.
3. Enter the method of reimbursement, for example, bank transfer to be paid when qualification is awarded.
4. Save your changes.
To enter training details:
1. Choose the Training Details alternative region.
2. Enter the amount of training completed. For example, enter 30 days completed of a training program that lasts 60 days.
3. Enter the total amount of training required to deliver the qualification.
4. Enter the units in which the training is measured, for example, days.

To enter license details:
1. Choose the License Details alternative region.
2. Enter the licence number, for example, a driving licence number.
3. Enter any restrictions, for example, licence not valid in certain states.
4. Enter the licence expiry date.

To enter subjects:
1. Enter the first subject the qualification comprises.
2. Select the status at which the subject is awarded, for example, whether training in the subject is ongoing.
3. Enter the dates between which the subject is studied. You must enter a Start date but you can leave the End date blank (if the subject is still incomplete).
4. If the subject forms a major part of the qualification, check the Major box.
5. Enter the grade at which the subject is studied, if you want.
6. Continue to enter further subjects until you have entered them all for the qualification, then save your changes.

See Also

Entering Schools and Colleges Attended

You can enter the school or college at which the person gained a qualification.
Use the School and College Attendances window, accessed from the People window, to enter attendance at an establishment.

► **To enter schools and colleges attended:**

1. Select the name of the school or college that the person attended.

2. Enter the dates of the attendance. You must enter a Start date but you can leave the End date blank (if the attendance is ongoing).

3. If attendance is full time at the school or college, check the Full Time box.

4. Continue to enter schools or colleges, if required, then save your changes.

See Also
Entering Special Information

Basic personnel information is handled in a fairly standard way from enterprise to enterprise. However, other types of information are recorded and used in quite different ways. Examples include training records, disciplinary records, competence, and medical records. Oracle HRMS does not restrict you to any predefined format for holding this information. You can set up your own user-defined fields for recording, analyzing, and reporting on whatever special information you require.

You set up each area of information that you want to handle separately as a Special Information Type. For example, you might define special information types for medical details and disciplinary records. You can enter a person's information under these sorts of headings in the Special Information window.

For entry of information needed for ADA and OSHA reporting, Oracle HRMS comes with the following three special information types already set up:

- ADA Disabilities
- ADA Disability Accommodations
- OSHA–Reportable Incident.

See:

ADA (Americans with Disabilities Act) Reporting: page 17 – 28
OSHA (Occupational Safety and Health Act) Reporting: page 17 – 34

Note: Your system administrator can create customized versions of the Special Information window, for entry of information for only one or a selected set of information types.
To enter special information for a person:

1. In the Name field, select the type of information you want to enter for the person.
2. In the Details block, click in the Detail field to open a window for entering information of this type.
3. Choose the OK button when you have completed your entries, then save your work.

See Also

Listing People by Special Information: page 13 – 28
Defining Special Information Types: page 28 – 10
Listing People by Special Information

To view a list of people who match a particular profile for one Special Information Type, use the List People By Special Information window.

**Note:** The system administrator can create customized versions of the List People By Special Information window so that you use each version for one information type only. For example, one version could be called List People By Technical Skills.

To list people by special information:

1. Select a Special Information Type.
2. Click in the Details field. A window opens prompting you for the details you have defined for this information type.
3. Enter values in the fields against which you want to match people, then choose OK. If you leave a field blank, it is not used in the matching process.
4. Choose the Find button.
Employees and applicants who match your selection criteria are listed in the folder in the lower part of the window. You can enter a query here to further restrict the list of people. If you have access to the Folder menu you can remove, rearrange, or resize the fields displayed.
Tracking People’s Roles and Activities

Table 13–1 lists the windows you can use to track the roles and activities of employees and applicants. These windows are described in context in other topics, as listed in the table.

You can also use the web–based Line Manager Direct Access to enter some information, such as assessments and appraisals, and to view a wide range of employee data, including employment history, roles (who they manage, supervise etc.) and absence history.

See: Web and Workflow Access: page 18–4

<table>
<thead>
<tr>
<th>Window</th>
<th>Used For</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment</td>
<td>describing the work role of an employee</td>
<td>The Employee Assignment: page 14–4</td>
</tr>
<tr>
<td>Application</td>
<td>describing the vacancy for which an applicant has applied</td>
<td>Entering Full Application Information: page 15–12 Entering Full Application Information (Oracle Human Resources User’s Guide)</td>
</tr>
<tr>
<td>Absence Detail</td>
<td>recording an employee’s absence from work</td>
<td>Entering Absences: page 26–14</td>
</tr>
<tr>
<td>Book Events</td>
<td>recording that an employee or applicant will attend an event. The event must be already defined in the Event Bookings window.</td>
<td>Managing Bookings and Attendance: page 27–3</td>
</tr>
<tr>
<td>Employee Review</td>
<td>scheduling and recording details of an employee’s review or other interview type</td>
<td>Employee Reviews: page 27–4</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>scheduling and recording details of an applicant’s interviews</td>
<td>Interviewing Applicants: page 15–17</td>
</tr>
</tbody>
</table>

Table 13–1 Other Windows for Personal Information

You can enter other work–related information for employees, such as salary and payment methods, after entering the employee’s assignment.

See Also

Managing Employment Information: page 14–2
Full Personal Details Report Set

To create printed reports of the personal information held for one person, you can run the Full Personal Details report set. It comprises four reports that meet employees’ rights to view their own personal details under data protection legislation:

- Full Person Details 1 reports on addresses and information entered in the People window, such as name, date of birth, nationality, and work telephone number.
- Full Person Details 2 reports on applications and applicant interviews.
- Full Person Details 3 reports on assignment information including periods of service, payment methods, and element entries.
- Full Person Details 4 reports on miscellaneous work information, including special information, absences, recruitment activities, and contacts.

If you do not need to see all this information for the employee, you can run individual reports rather than the report set. The Full Person Details report, Full Assignment Details report, and Full Work Details report are equivalent to reports 1, 3, and 4 in the report set, respectively. The Full Applicant Details report is equivalent to report 2 in the report set, but you can only run this as a separate report for an applicant, not an employee.

You run report sets from the Submit Request Set window.

To run the Full Personal Details report set:

1. In the Request Set field, select Full Personal Details.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the reports.
4. Enter the name of the person for whom you want to print the reports.
5. Choose the Submit Request button.

See Also

Employee Summary Report: page 14 – 34
New Hire Reporting

At present, many states require some or all employers to submit New Hire reports covering newly hired or rehired employees. Other states and Canadian provinces have already announced plans to implement new hire reporting programs, or are considering such plans.

A primary purpose of New Hire reports is to ensure that individuals legally responsible for making child support payments are in fact making these payments by means of pay garnishments. Some states also use new hire reporting to help in detecting abuse of assistance programs such as Workers Compensation and unemployment insurance.

Because garnishment administration is a responsibility of the payroll department, and because submission of copies of form W–4, Employee’s Withholding Allowance Certificate is often a part of new hire reporting, payroll departments usually are responsible for submitting the New Hire reports for the GREs in their enterprise. In most states, they must submit these reports within a certain number of days (ranging from 5 to 35) after a new employee’s start date. Employers failing to do so may be liable for penalties.

Report Coverage

States have different rules regarding the employees that new hire reporting must cover. Some states do not require coverage of employees who are below a minimum age, or whose pay or normal working hours in a specified time period fall below a stated minimum.

Data for New Hire Reports

In all states, these reports must display for each newly hired or rehired employee, the full name, social security number, and hire date. Some states require additional information, such as:

- employee addresses and dates of birth
- their jobs, salaries, hours normally worked per week, and full or part time employment category
- the availability to the employees, and their dependents, of employer–provided health care insurance plans
- whether employees currently have child support obligations.

To identify each GRE submitting New Hire reports, states require (in addition to the GRE’s name and address) its federal identification number (issued by the IRS), or its SUI identification number, or both
numbers. Entry of one or both of these numbers often occurs when the GRE is set up.

New Hire reports must also include the name, job and telephone number of the employee serving as the GRE’s contact for new hire reporting.

Setup Steps for New Hire Reporting

► To set up for New Hire reporting:

1. Ensure that a federal identification number and a SUI identification number, if appropriate, is on record for each GRE that submits New Hire reports.
   See:
   GREs: Entering the IRS Identification Number: page 2 – 30
   Entering Federal, State, and Local Tax Rules for GREs (Oracle Payroll User’s Guide)

2. Enter the name of each GRE’s contact person for new hire reporting.
   See: Entering a New Hire Report Contact for a GRE: page 13 – 33

3. When hiring or rehiring employees, indicate whether they
   • are to be included in or excluded from new hire reporting
   • have a legal obligation to pay child support.
   See: Entering New Hire Report Information for Employees: page 13 – 34

   See: Obtaining New Hire Reports: page 13 – 35

Entering a New Hire Report Contact for a GRE

For each GRE, you can maintain information about the contact person for New Hire reporting. Start this information entry from the Organization window.

Prerequisite

☐ Set up the GRE in your system.
To enter a GRE’s contact person for new hire reporting:

1. In the Organization window, query the GRE if it does not already appear there. With the cursor in Government Reporting Entity in the Organization Classifications region, choose the Others button and select New Hire Reporting.
2. Click in the field that appears in the Additional Organization Information window to open the New Hire Reporting window.
3. Select the name of the employee serving as the GRE’s contact for new hire reporting. The New Hire Report process finds this employee’s job title and work telephone number in the database and prints the contact name, title and phone number on the report.

Entering New Hire Report Data for Current Employees

Use the People window to start this information entry.

Prerequisite

- The system comes with these reasons for excluding a newly hired employee from the New Hire report:
  - Age less than state minimum
  - Wages less than state minimum
  - Hours worked less than state minimum

If you require other reasons, enter them for the QuickCode type US_NEW_HIRE_EXCEPTIONS.

See: Adding QuickCode Values: page 32 – 3

To enter New Hire reporting data for current employees:

1. Query the employee in the People window if he or she does not already appear there. Select the Employment Information alternative region.
2. The New Hire Status field defaults to null (no entry). If new hire reporting should cover the employee, select Include in New Hire Report, so that the next run of the New Hire report for the employee’s GRE will include this employee. If the report should not cover this employee, select Exclude from New Hire Reporting, and optionally select the reason for this exception.
After a run of the New Hire report includes the employee, the entry in the New Hire Status field automatically changes to Already Reported.

**Note:** When you implement Oracle HRMS and load your current employees into the database, the New Hire Status field defaults to null for them. The first run of the New Hire report for the state and GRE of current employees will include these employees unless you enter a value of Already Reported or Exclude from New Hire Reporting in the New Hire Status field for them.

These entries can be accomplished either manually or by means of a script your MIS staff or Oracle consultant can write in accordance with your specifications.

3. If this employee is currently obliged to pay child support, check the Child Support Obligation box.

4. Save your work.

---

**Obtaining New Hire Reports**

For these reports, states have varying data requirements and formatting requirements. The New Hire reports in Oracle HRMS are set up to meet each state’s data and formatting specifications.

**Attention:** All states except Tennessee permit submission of these reports as computer printouts. For Tennessee, you must copy the report information onto the state’s Form DES 230.11C.

Run New Hire reports from the Submit Requests window.

**Prerequisite**

- Complete the setup steps for new hire reporting.

  See: Setup Steps for New Hire Reporting: page 13 – 33

**To run a New Hire report for a GRE and state:**

1. In the Name field of the Submit Requests window, select New Hire Report. If the Parameters window does not open automatically, click in the Parameters field.

2. The As Of date that appears on the report defaults to the effective date. Change this default if necessary.

3. Select the GRE and state for which to produce the report.

   If the state is Iowa or Texas, also make entries in the fields Dependent Health Insurance and Waiting Period (Days).
4. For Iowa and Texas, enter Yes in the Dependent Health Insurance field if the employer offers health care insurance coverage to employees’ dependents, or No if coverage is not available to dependents.

5. For Iowa and Texas, if health care insurance is available to dependents, enter in the Waiting Period field the number of days after the employee’s hire date that dependents must wait before obtaining coverage. This field defaults to zero.

6. Choose Submit.

See Also

New Hire Reporting: page 13 – 32
Deleting a Person from the System

If you mistakenly save information in the People window, you can remove the person by selecting Delete Record from the Edit menu. Notice that you are prevented from performing this action if you have entered information about that person in other windows.

If you want to remove all records of a person, use the Delete Person window. Notice, however, that you cannot use this window to remove the records of an employee or ex-employee whom Oracle Payroll processed in any payroll runs.

To delete all records of a person:

- Query the person in the Delete Person window and choose the Delete Person button.

If there is a contact for the person you are deleting, there are two possibilities:

- If the only information held about the contact is the basic person details entered in the Contacts window, then the record of the contact is deleted.

- If there is other information held about the contact (for example, assignment or applicant information), the contact is not deleted. However, the record of their relationship to the person you are removing from the system is deleted.
The previous chapter focussed on the personal information you hold for all types of people. Employees require additional information on where they fit into your enterprise, and on their compensation and benefits.

This chapter describes the key types of employment information, how you hold them in Oracle HRMS, how you track changes in employment for employees, and how you can report and inquire about employment information.
Managing Employment Information

Table 14 – 1 below summarizes the information typically held for an employee, and how you can hold this information in Oracle HRMS.

<table>
<thead>
<tr>
<th>Information</th>
<th>How to set it up</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Title or Position</td>
<td>Assign the employee to work structures in the Assignment window.</td>
</tr>
<tr>
<td>Department</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Grade</td>
<td></td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter in the Grade Step Placement window; enter any special ceiling in the Assignment window.</td>
</tr>
<tr>
<td>Name of manager or position to report to</td>
<td>Use a position hierarchy or enter supervisor name in the Assignment window.</td>
</tr>
<tr>
<td>Salary</td>
<td>Assign to a salary basis in the Assignment window; enter amount in the Salary Administration window.</td>
</tr>
<tr>
<td>Medical, Dental and Vision Benefit Plans (without Oracle Payroll)</td>
<td>Define elements or initiate; enter coverage levels plus default employer and employee contributions for each level into Benefits Table; link elements; enroll employees by selecting their coverage levels in the Element Entries window.</td>
</tr>
<tr>
<td>Medical, Dental and Vision Benefit Plans (with Oracle Payroll)</td>
<td>Initiate plan deductions using amount rule Benefits Table; enter coverage levels plus default employer and employee contributions for each level into Benefits Table; link elements; enroll employees as above.</td>
</tr>
<tr>
<td>Other Benefits (without Oracle Payroll)</td>
<td>Define and link elements; make input value entries using the Element Entries window or MIX batch entry.</td>
</tr>
<tr>
<td>Other Benefits (with Oracle Payroll)</td>
<td>Initiate deductions to pay for benefits; link elements; make input value entries using the Element Entries window or PayMIX batch entry.</td>
</tr>
<tr>
<td>Pay Frequency</td>
<td>Assign to a payroll in the Assignment window.</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Accept the default from the Payroll to which the employee is assigned or select a method in the Personal Payment Method window.</td>
</tr>
<tr>
<td>Full time/part time status</td>
<td>Assign to an employment category.</td>
</tr>
<tr>
<td>Standard Work Day</td>
<td>Enter in the Assignment window or accept the default from the organization or position to which the employee is assigned.</td>
</tr>
</tbody>
</table>

Table 14 – 1 Employment Information
Table 14 – 1 Employment Information

Every enterprise needs to track the changes in employment information for each employee over the lifetime of their employment:

- Where a change affects a group, the human resource system must be able to effect that change for every individual in the group according to a set of rules.
- Where a change affects only a few individuals, the system must allow entry of changes for those individuals.

In Oracle HRMS, you manage these changes through the *employee assignment*:

- The assignment connects employees to your enterprise’s work structures and policies, so that changes to the structures and policies are reflected in the employee’s records.
- You can query groups of employees with similar assignments (such as all assignments on grade C2) and make changes for each employee in these groups.
- The assignment is datetracked to maintain a work history as the employee moves through your enterprise.
The Employee Assignment

The assignment is the central concept that relates employees to the structures in which they work, and the compensation and benefits for which they are eligible.

In Oracle HRMS, many of the activities you undertake in human resource management, such as vacancy management and budget planning, are based around assignments and not people. In particular, you enter all earnings, deductions, and other pay–related elements for the employee assignment, rather than the employee. This makes it possible to give an employee two or more assignments when this is necessary.

An employee must have a current assignment at all times. You record relocations, promotions, transfers and so on as changes to the existing assignment. These changes are datetracked so that you can view the history of changes to an assignment, and can make future–dated changes in advance.
Components of the Assignment

You can use the assignment to define more precisely the place of the employee in the enterprise, including his or her job, position, organization, location, grade, and supervisor. You can also assign the employee to any of the employee groups you set up using the People Group key flexfield, such as pension groups or unions.

You can assign employees to an employment category, such as Part Time – Regular or Full Time – Temporary. Your startup data includes four categories, and you can add others for the QuickCode Type EMP_CAT.

You can assign employees to a salary basis and maintain their salaries or wages using the Salary Administration procedure.

Requirements for Payroll Processing

At installations using Oracle Payroll to pay employees, each employee’s assignment must include these components:

• a GRE
• an organization with a physical location that is entered in the HRMS database
  See: Setting Up Site Locations: page 2 – 2
• a payroll
• an employment category

Additionally, there must be on record for each assignment:

• W–4 and other tax information
• a salary basis and an approved salary entry

Notice that a prerequisite for the establishment of employee tax information is entry of a primary US or Canadian residence address for the employee, and assignment of the employee to an organization having a location with a complete address.

See:

Entering US and Canadian Addresses: page 13 – 13
Setting Up Site Locations: page 2 – 2

See Also

W–4 and Other Tax Data for Employees (Oracle Payroll User’s Guide)
Using Multiple Assignments

Relocations, transfers, promotions and so on go on record as datetracked changes to employees’ existing assignments; you do not enter new assignments for changes like these.

However if your enterprise permits employees to work in two or more different capacities at once and thereby become eligible for different benefits, you can enter additional assignments for them.

For example, if a university professor of history also coaches the baseball team, receiving additional pay but retaining the same benefits, there is no reason to give him a second assignment. But if he becomes eligible for different benefits as a coach, it is best to give him a separate assignment for this work.

You can maintain multiple assignments for any employee. Oracle HRMS separately manages each assignment, together with its associated compensation and benefits. When an employee has more than one assignment, one must be designated as the primary assignment. By default, this is the first assignment the employee receives. You can change this default using the Miscellaneous alternative region of the Assignment window.

You can end all assignments except the primary assignment by entering a status change in the Assignment window. However to end an employee’s primary assignment you must terminate the employee, using the Terminate window.

To show that an assignment is part time, you use the employment categories Part Time – Regular or Part Time – Temporary. You could also set up a Full Time Equivalent budget, and weight each assignment as a fraction of a full time equivalent for the calculation of actual values.

Notice that when employees split their time between two departments performing the same job, or fulfill two different roles in one organization, you do not need to define two separate assignments to maintain accurate costing records. You can set up cost allocation to distribute proportions of one assignment’s payroll costs to different cost centers.

See Also

Human Resource Budgets: page 12 – 2
Identifying Employees and Assignments

Oracle HRMS uses two unique identifiers for employees:

- Employee Number
- Employee Assignment Number

Employee Number

The Employee Number uniquely identifies every employee in your Business Group.

An employee can have only one Employee Number. You decide how this number is to be generated when you define your Business Group:

- Automatic
- Manual
- National Identifier (for example, the US Social Security Number or the UK National Insurance Number)

If you choose automatic or national identifier number generation, the employee number, by default, remains the same for an employee who has multiple periods of service. If you choose manual number entry, you can update the number at any time.

The employee name and number appear together in people information windows, such as the People window and View Absence History window. In these windows you can select an employee by name or by employee number.

Employee Assignment Number

The employee assignment number uniquely identifies every assignment that exists within your Business Group. An employee can have one or more than one assignment, and therefore more than one assignment number.

The system automatically generates the assignment number, which is the same as the employee number by default. You can manually override the default assignment numbers the system generates. For example, you might want to use this number to store a payroll code.
If an employee has a second current assignment, the system also generates the second Assignment Number by default from the Employee Number, as in the following example:

<table>
<thead>
<tr>
<th>Employee Name</th>
<th>Samantha Green</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee Number</td>
<td>1012</td>
</tr>
<tr>
<td>1st Assignment Number</td>
<td>1012</td>
</tr>
<tr>
<td>2nd Assignment Number</td>
<td>1012-02</td>
</tr>
</tbody>
</table>
Entering a New Assignment

Enter new assignments in the Assignment window. You must hire applicants before you can create an employee assignment for them. The details of the employee assignment default from their accepted application.

To enter a new assignment:

1. Set your effective date to the start date of the new assignment.
2. Select the organization to which you want to assign the employee. By default, the employee has an assignment either to the Business Group organization, or to the organization to which he or she was an applicant. If a location is defined for the Business Group or other organization, it also appears as a default.

   **Note:** If you are using Oracle Payroll, the organizations to which employees have assignments must have on record, a location with a complete address including a city and state. The system uses this address to determine employees’ work locations for tax purposes.

   See: Setting Up Site Locations: page 2 – 2

   **Attention:** If you overwrite a new employee’s default assignment to an organization, a window appears asking if the change is an update or a correction. Select Correction. If you are using Oracle Payroll, it is especially important to select Correction, so that the work location for the employee’s tax records is correctly recorded.

3. Select a payroll if you are paying the employee using Oracle Payroll, or if you intend to record for the employee certain types of
compensation and benefits (represented on the system by nonrecurring elements).

**Note:** If Oracle Payroll is installed and you are an HR User, you cannot assign employees to payrolls. Ask your system administrator to change your HR:User Type profile option if you need to assign employees to payrolls.

4. Select a grade if you use grade rates or grade scales to determine the appropriate compensation levels for employees.

5. Select any other components included in this employee’s assignment (job, position, groups, employment category). If you are using Oracle Payroll to pay the employee, the assignment must include an employment category.

6. Select a Status for the assignment. By default a new assignment has the status Active Assignment (or an equivalent user status defined on your system).

   See: Assignment Statuses: page 28 – 5

7. Enter an Assignment Number to uniquely identify the assignment. By default, this number is the same as the Employee Number, for the employee’s first assignment.

8. Enter the information you want to hold in the alternative regions.

   By default, the first assignment entered for an employee is the primary assignment. To change this default for an employee with more than one assignment, select the Primary check box in the Miscellaneous alternative region.

   **Note:** You must associate all employee assignments (except any unpaid voluntary assignments) with a GRE, using the alternative region GREs and Other Data.

### GREs & Other Data Region

Use the GREs and Other Data alternative region to place the employee assignment in a GRE, and enter other information.

**To enter information in the window GREs and Other Data:**

1. Select the GRE (Government Reporting Entity) for the assignment.

   The GRE is the organization holding a federal Employer Identification Number (EIN) that is responsible for paying employees, withholding their taxes, and issuing the Form W–2, Wage and Tax Statement. Additionally, the GRE is responsible for providing certain government–mandated reporting, such as EEO–1 and VETS–100 reports.
2. If the employee must submit a timecard, select Yes in the Timecard Required field and select the name of the employee approving the timecard.

Oracle Payroll does not process pay for employees required to submit timecards who fail to do so.

3. You can select a work schedule for the assignment. This field may display a default work schedule for the employee’s organization.

Oracle Payroll uses the work schedule to prorate pay for the employee. By scanning the work schedule, the payroll run detects mid-period assignment start or end dates, and mid-period pay increases or decreases.

4. If this employee assignment is for shift work, select the shift regularly worked.

5. You can enter the spouse’s salary, which can be a state requirement for married couples to qualify for reduced rates if they are filing jointly.

6. Select Yes in the Legal Representative field if you send the W–2, Wage and Tax Statement form for this employee to his or her legal representative. A legal representative can be, for example, the employee’s custodian, parent, or attorney.

7. To override the usual Workers Compensation job code for the assignment, select the override code in the WC Override Code field.

See: Entering a WC Override Code (Oracle Payroll User’s Guide)

8. Entries in the remaining fields in this window (except Reporting Establishment) are required at sites with Oracle Payroll that are using Oracle Payroll to produce state quarterly wage listings.

See: Entering S Record Data for Employees (Oracle Payroll User’s Guide)

**Supervisor Region**

Enter the name and employee number of the employee’s personal supervisor.

**Note:** This information shows the personal supervisor for an employee and is not updated by the system. Use organization and position hierarchies to show management reporting lines.

**Note:** The Auto WGI uses this information.
Probation Period and Standard Conditions Regions

The probation period and standard work day information default from the employee’s position. If standard conditions are not defined for the position, they may default from the employee’s organization or Business Group.

Miscellaneous Region

The Internal Address adds address details (such as the floor or office number) to the location address.

You can select a reason for adding or changing the assignment. You define valid reasons as values for the QuickCode Type EMP_ASSIGN_REASON.

Check the Manager check box if the assignment is at the level of manager.

Check the Primary check box if it is the employee’s only assignment or main assignment.

Special Ceiling Region

A special ceiling progression point is the highest point to which the Increment Progression Points process can automatically progress the employee.

You can enter a special ceiling if the employee is assigned to a grade, and a grade scale is defined for this grade. This special ceiling overrides the ceiling defined for the grade scale.

Salary Information Region

Using the Salary Administration window, you can enter a proposed salary change for an employee, associate this change with a performance review, and accept or revise the change later. To administer an employee’s salary in this way, you first assign the employee to a salary basis in the Salary Information region.

You can also enter the frequency of salary and performance reviews.

Attention: If you change an employee’s salary basis to a basis that uses a different salary element, the employee’s existing salary element entry will be ended. Using the Salary Administration window, you should make a new salary entry for the employee, effective from the date of the salary basis change.
See Also

Salary Administration and Performance Reviews: page 9 – 2
Additional Employment Information: page 14 – 20
Changing Assignment Information

When an employee experiences changes such as a promotion, transfer, or move from full time to part time, you change a component of the assignment. A change to any of the assignment components produces the DateTrack prompt.

- If you choose *Correction*, Oracle HRMS overwrites the existing assignment information.
- If you choose *Update*, Oracle HRMS records the date and change, and retains the original information.

By changing your effective date on the system, you can see the employee’s assignment at any point in time. You can also view the changes made to the assignment over time using DateTrack History. DateTrack History shows the changes made to one assignment. Use the Assignment History window to view the history of all the employee’s assignments, both currently and in any previous periods of service.

Effects of Changing an Assignment

Changing any assignment component can have the following effects:

- The employee may lose eligibility for some compensation types, benefits or deductions, and gain eligibility for others. You receive a warning that the system automatically ends any unprocessed element entries for which the employee is no longer eligible.
- The employee may have a different level of access to Oracle HRMS, since the system’s security is based on assignment to work structures.
- If you change the employee’s grade when a grade step placement exists for the assignment, you receive a warning message that the placement will be date effectively ended and any future placements will be deleted. Also, the special ceiling point field is cleared.

  **Note:** If an assignment change causes the system to change element entries, you may not be able to save the change if a current or future pay period is closed. You must reopen the period or change your effective date to make the change.

Changing Primary Assignments

Over time, a secondary assignment may need to be elevated to a primary assignment. Most companies have requirements to show the history of changes in an employee’s record.
This process will create two historical records: one showing a secondary assignment that lasted from x day to y date, and the other showing that the primary assignment started as one set of components and then changed to another set of components (which are the same as the secondary assignment) as of a particular date.

To change a primary assignment:

1. Create a new assignment “B” as a secondary assignment.
   See Entering a New Assignment: page 14 – 9
2. Set an effective date for the assignment to become the employee’s primary assignment.
3. Change Assignment “B” to be the primary assignment by selecting the Primary checkbox in the Miscellaneous alternative region.

See Also

Assignment History: page 14 – 36
Viewing Datetracked Information and History: page 1 – 13
Updating and Correcting Datetracked Information: page 1 – 14
Ending an Assignment

Oracle HRMS does not permit an employee to exist in the system without an active assignment. That is, an employee must always have at least one active assignment at any point in time. This means that for an employee with just one active assignment, the only way to end the assignment is to terminate the employee, using the Terminate window.

See: Ending Employment: page 14 – 17

For employees with more than one active assignment, you can end all but one of their assignments by selecting an assignment status of End or Terminate in the Assignment window. Sites not using Oracle Payroll can use these two statuses to provide information. For example, End may mean that further pay processing cannot occur for the assignment, while Terminate may mean that further processing can occur. Alternatively, these sites can simply use the status End.

At sites using Oracle Payroll, the choice of End or Terminate controls the ability to include the assignment in a payroll run after the date the assignment ends, as explained in the procedure below.

To end one of many assignments:

1. Set your effective date to the actual termination date for the assignment.

2. Update the assignment status to End or Terminate Process Assignment (or the equivalent user status on your system):
   - Use Terminate Process Assignment (with a Payroll system status of Process) if further pay processing of the assignment is required after the date the assignment ends. This leaves the assignment’s final processing date open so that further processing can occur.
     
     It is often best to use this status, so that you can process any necessary adjustments to the final pay for the assignment.
   - Use End (with a Payroll system status of Do Not Process) if all pay processing for the assignment is finished. This makes your effective date the assignment’s final processing date, after which no further processing for the assignment can occur.

   Note: The End status is not recorded on the assignment; it causes the assignment to end as of the effective date of entry of this status.

   - To temporarily prevent pay processing for this assignment, use the status Terminate Assignment (with a Payroll system status of Do Not Process). When no further processing is required and you are ready to set a final processing date, update the status to End.
Ending Employment

If an employee is leaving your enterprise, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

If an employee is leaving your agency, you terminate him or her. This changes the person type to ex-employee and ends all assignments.

The ex-employee’s records remain in the database. You can reinstate, or rehire, the person to create a new period of service.

Since terminating ends all assignments, the system does not permit you to terminate an employee who has future-dated assignments.

**Note:** If you have mistakenly added someone to the database or you want to remove all records for an ex-employee, you can delete the person in the Delete Person window. You cannot delete an employee whom Oracle Payroll has processed in a payroll run.

See: Deleting a Person from the System: page 13 – 37

If you mistakenly hired an applicant, you can cancel the hire in the Person window.

See: Hiring: page 13 – 10

Terminating an Employee

You end employment in the Terminate window.

▶ To terminate an employee:

1. Optionally, enter the reason for the termination. You can define valid reasons as values for the QuickCode Type LEAV_REAS.
If you use Oracle Payroll and the employee is deceased, you must select the reason Deceased, for recording on the W–2 Wage and Tax Statement.

2. Enter the termination dates. Only the Actual date is required. This is the date when the employee’s person type changes to Ex–employee. The Notified and Projected dates are for information only. The Final Process date is a date after which no further pay processing for the employee can occur, if you are using Oracle Payroll.

At sites including Oracle Payroll, it is best to leave the Final Process date blank, so that you can make corrections to the final payment or make other payments to the employee in the future if this is necessary.

3. When the information is complete, choose the Terminate button to complete the termination.

Setup To Allow Processing After Termination

**Cancelling a Termination**

If the employee decides not to leave, or the date of leaving changes, you can cancel a termination. You can cancel a termination at any time provided that you have not rehired the employee. (You rehire an employee by changing his or her person type to Employee in the Person window.)

Oracle HRMS reopens the assignments previously closed down and gives each assignment the status it had before termination. It also restores other information to its state before termination. For example, it removes the end date put on recurring element entries for the assignment.

Notice, however, that any nonrecurring element entries that were deleted for processing periods after the termination date cannot be automatically restored. You must act to reenter these entries.

► **To cancel a termination:**
  - Choose the Reverse Termination button in the Terminate window.

► **To change the termination date:**
  1. Cancel the termination by choosing the Reverse Termination button.
  2. Enter a new Actual date and choose the Terminate button.
Terminations Report

Oracle HRMS includes a standard report showing the reasons why employees left your organization within a specified period.

You run reports from the Submit Requests window.

To run the Terminations Report:
1. In the Name field, select Terminations.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. In the Organization Structure field, select an organization hierarchy name, if you want to see terminations in a number of subordinate organizations. If there are multiple versions, select a version.
5. In the Parent Organization field, select the parent organization within the hierarchy whose subordinate organizations you want to see in the report.
   If you have not selected an organization hierarchy, use the Parent Organization field to enter the name of the organization for which you want to view terminations.
6. Enter the start and end dates defining the period in which you are interested.
7. Select at least one termination reason to include in the report.
8. Choose the Submit button.

See Also

Employee Movements Report: page 14 – 34
Additional Employment Information

Just as you can record additional information about people, such as their addresses, contacts, and skills, you can also record additional information associated with each employee assignment. The main items of information are as follows:

- If you are using Oracle Payroll, use the Tax Rules window to maintain W-4 and other required tax information.
  See: Tax Information for an Employee Assignment (*Oracle Payroll User’s Guide*)

- You can propose or approve a salary change in the Salary Administration window.
  
  **Note:** To pay employees using Oracle Payroll, they must have an approved salary on record.
  See: Entering Salaries and Salary Changes: page 9 – 8

- You can make entries to the earnings, deductions, benefits and other elements the employee is eligible for, using the Element Entries window.
  See: Making Manual Element Entries: page 7 – 41

- If you use a pay scale and progression point system, you can place the assignment on a pay scale using the Grade Step Placement window.
  See: Placing an Employee on a Grade: page 4 – 16

- You can select the cost centers or accounts to which the costs of the assignment should be allocated, using the Costing window.
  See: Costing Data at the Organization and Assignment Levels: page 11 – 9

- You can use the Assignment Budget Values window to specify the value of the assignment in terms of headcount, full time equivalent (FTE), or any other budgets you have defined.
  See: Human Resource Budgets: page 12 – 2

- For employees who have assignments to payrolls, you can select the methods by which the employee wants to receive pay for this assignment in the Personal Payment Method window.
  See: Entering Payment Methods for an Employee Assignment: page 14 – 22

- You can enter secondary assignment statuses for analysis and reporting, if these have been defined on your system.
See: Entering Secondary Assignment Statuses: page 14 – 24
Entering Payment Methods for an Employee Assignment

Your enterprise may pay employees by check, by direct deposit of funds into their bank accounts through the National Automated Clearing House Association (NACHA), or by a combination of these payment types.

Depending on the policies of your enterprise, you may enter several payment methods for an employee assignment, so long as these are valid methods for the assignment’s payroll. For example an employee may request that you use direct deposit to send 80% of her pay to a checking account, 10% to a savings account, and 10% to a credit union.

Employees with no personal payment method on record receive pay by the default payment method of their payrolls.

You enter payment methods for employee assignments in the Personal Payment Method window. You can also use this window to enter the payee for third party payments.

Note: As the GRE (Government Reporting Entity) is the organization that pays employees and withholds their taxes, you must associate every employee assignment with a GRE.

See: GREs and Other Data Region: page 14 – 10

Prerequisites

- Define all the payment methods available in your Business Group using the Organizational Payment Method window.
  See: Defining Payment Methods for the Enterprise: page 5 – 3
- Select at least one valid payment method for each payroll you define in the Payroll window.
  See: Defining a Payroll: page 5 – 6
- Assign the employee to a payroll.
- For third party payment methods, define the payee in the Organization window (using the classification Payee Organization) or the Contact window (using the relationship Payments Recipient).
To enter a personal payment method for remuneration:

1. Set your effective date to the date on which to begin paying the employee by this method.
2. In the Name field, select a payment method.
3. Enter a number in the Priority field to determine the order for Oracle Payroll to use each payment method. It uses the method with the lowest number first.
   If an employee with two assignments requests the same payment method for both, give them different priority numbers to determine their order of use.
4. Enter either the amount or percentage of the assignment’s pay to be paid by this method.
   If the total of the amounts you allocate to payment methods is less than the amount to be paid, Oracle Payroll uses the payment method with the highest priority number to pay the excess.
5. The Type field displays Cash, Check or NACHA. If the type is NACHA, open the Bank Details window for entry of information about the employee’s bank account.

NACHA Prenote Information for Oracle Payroll

For someone currently employed in your enterprise whose bank information NACHA has already verified, enter the verification date in the Prenote Information region. Oracle Payroll automatically checks the Issued box, and immediately uses this payment method to route payments through NACHA.

For a new employee with unverified bank information, leave the Issued and Date fields blank. Oracle Payroll pays the employee by check.
when it next processes pay for the employee, and sends a zero payment through NACHA. It enters this payment date in the Date field and checks the Issued box.

For a 10-day waiting period, it makes all further payments to this employee by check. If during this time the bank informs you of erroneous information, you correct the information and clear the Issued box. Then when next processing the employee, Oracle Payroll sends another zero payment through NACHA to restart the verification process.

When the 10-day waiting period passes with no notification of errors and no manual clearing of the Issued box, Oracle Payroll automatically starts making regular payments to the employee through NACHA.

► To enter a third party payment method:
1. Set your effective date to the date on which to begin making payments using this method.
2. In the Name field, select a third party payment method. Third party payment methods automatically receive priority 1 (the highest priority) and you cannot change this. You cannot split a third party payment between different payment methods; the Percentage field always displays 100%.
3. In the Payee region, select an organization or a person.
4. Save your work.

You can select this third party payment method in the Payee Details entry value when you enter a deduction to be paid as a third party payment.

Entering Secondary Assignment Statuses

Your implementation team may have created secondary assignment statuses for analysis and reporting of employee or applicant assignments.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.
To give a secondary status to an assignment:

1. Select the status and enter a start date.
2. You can also select a reason for giving the new status.
   When a status no longer applies, simply enter an end date.

See Also

Assignment Statuses: page 28 – 5
Inquiring and Reporting on Employment Information

Oracle HRMS provides a number of predefined inquiry windows and reports for employment information. You can also create your own inquiries and reports using QuickPaint or other reporting tools.

Listing Assignments

There are three predefined inquiry windows for producing lists of assignments that match criteria you enter:

- Assignments Folder
- List Assignments
- List People by Assignment

Assignments Folder

Using the Assignments Folder window, you can query lists of current assignments, past assignments, or both. You select the fields of assignment information you want to see, and position them in the order you prefer. For example, you can produce a listing of all current employees ordered by organization, and by grade within organization.

The system saves your inquiry and field formatting as a folder so you can rerun the inquiry at any time. You can make this folder available to all users, or save it as a private folder.
**Note:** The system administrator can create customized versions of the Assignments Folder window so that you use each version for one person type only.

The system administrator can also link this window in a task flow so that you use it to access other windows of employment information. Notice that if you select a past assignment in the folder, you cannot open other windows of employment information.

**List Assignments Window**

In this window, you can view *current* employees and applicants. If you enter the Job, Position, Grade, or Group fields, a window opens prompting you for individual segments of the flexfield. You can enter selection criteria in one or more segments. This means that you can search on *parts* of the job name, for example.
**List People by Assignment Window**

In this window you can choose whether to view current or former employees/applicants, or both. However, you must search on a whole Job, Position, or Grade name, not on segments of these flexfields.

To produce lists of assignments:

1. Select values in one or more fields in the top part of the window, and choose the Find button.

   The folder in the lower part of the window lists the assignments that match the selection criteria you entered.

2. You can enter a query in the folder to reduce further the list of assignments displayed. For example, you could run the query “C%” in the Full Name field to view the assignments of people whose names begin with C.

3. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Listing Employees by Organization

In the List Employees by Organization window, you can view lists of employees within one organization or within all organizations below a specified level in a hierarchy you select.

To list employees in several organizations:
- Select an organization hierarchy and select the highest organization in this hierarchy for which you want to list employees. Choose the Find button.

To list employees in one organization only:
- Leave the Organization Hierarchy field blank and select an organization. Choose the Find button.
  You can enter a query in the Employees block to further restrict the list of employees to be displayed.

Manager Field
The Manager field identifies any employee for whom the Manager check box is checked in the Miscellaneous region of the Assignment window.

If there is more than one manager in the organization you select, the Manager field displays the number of managers. You can view the names of these managers by choosing the List icon from the Toolbar.
Organization Field

If an employee belongs to more than one organization within the hierarchy you selected, the number of organizations appears in the Organization field. You can view the names of these organizations by choosing the List icon from the Toolbar.
**Listing Employees by Position**

There are two windows for viewing lists of employees by position:

- List Employees by Position
- List Employees by Position Hierarchy

**List Employees by Position Window**

To view employees in a single position, or in all positions corresponding to a job or organization, use the List Employees by Position window.

**To view employee names by position:**

1. Select any combination of an organization, job, or position.
2. Choose the Find button.

   The folder displays the positions that match your selection criteria, together with the holder’s name and employee number.

   If there is more than one holder for a position, the number of holders is displayed in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

**Note:** You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
List Employees by Position Hierarchy Window

To view lists of employees in a number of positions within a hierarchy, use the List Employees by Position Hierarchy window.

To view lists of positions within a position hierarchy:

1. Select a position hierarchy and the highest position in the hierarchy for which you want to list employees.

2. Choose the Find button.

   The folder displays all positions below the one you selected in the hierarchy. It also lists the employees who hold these positions.

   If there is more than one holder for a position, the number of holders appears in the Holder Name field. You can view the names of these holders by choosing the List icon from the Toolbar.

   **Note:** You can enter a query in the folder to reduce further the list of positions displayed. You can remove, rearrange, add, or resize fields in the folder if you have access to the Folder menu.
Assignment Status Report

Use this report to see a list of people assigned to particular organizations, jobs, positions and grades, with specific assignment statuses. If you select both applicants and employees as person types, the report prints out in two sections. Otherwise it prints for the type you select.

Run reports from the Submit Requests window.

To run the Assignment Status Report:

1. In the Name field, select Assignment Status Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Leave the Organization Structure field blank to see information about all organizations. Select an organization hierarchy name to see assignment statuses in a number of subordinate organizations.
5. If there are multiple versions, select a version.
   If the effective date lies between the version’s start and end dates, the report is effective as of this date. If it lies outside these dates, the report is effective as of the start date of the version you select.
6. Leave the Parent Organization field blank to see information about all organizations. Select a name in this field to see information on all subordinate organizations in the hierarchy.
   Note: You must enter a value in this field if you have entered a value in the Organization Structure field, and you must leave this field blank if you left that field blank.
7. Make entries in the Group, Job, Position, Grade and Payroll fields as required.
   If you leave all segments of the Group flexfield blank, you see information about employees in any groups. If you leave one segment blank you see employees with any value for that segment.
8. Enter Yes in the Primary field if you want to report on primary assignments only. Leave blank to include all assignments.
9. Select Employee, Applicant or Both in the Person Type field. This determines which sections of the report are printed.
10. Select up to four assignment statuses, or leave blank to list employees and/or applicants with any assignment status.
11. Choose the Submit button.
Employee Summary Report

This report is a current summary of information for an employee, covering addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries.

Run reports from the Submit Requests window.

To run the Employee Summary Report:
1. In the Name field, select Employee Summary.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Enter the name of the employee whose summary you want to see.
5. Choose the Submit button.

See Also

Full Personal Details Report Set: page 13 – 31

Employee Movements Report

There are two versions of the Employee Movements Report:
- Employee Organization Movements Report shows employee movements into and out of a particular organization or hierarchy.
- Employee Payroll Movements Report shows employee assignment changes to and from a particular payroll.

Both versions list the following movements: New Hires, Terminations, Transfers In, and Transfers Out. You can use this information to monitor employee assignment changes for turnover analysis.

Run reports from the Submit Requests window.

To run the Employee Organization Movements Report:
1. In the Name field, select Employee Organization Movements Report.
2. Enter the Parameters field to open the Parameters window.
3. Do one of the following:
• If you want to see information for a whole organization hierarchy, select the Organization Hierarchy name and version number, and leave Parent Organization blank.

• If you want to see information for one organization, select the organization name in the Parent Organization field, and leave Organization Hierarchy name and version number blank.

• If you want to see information for an organization and its subordinates in a particular hierarchy, select the name of the organization and the name and version of the organization hierarchy to which it belongs.

4. Select the period for which you want to see the information.

5. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

6. Choose the Submit button.

**To run the Employee Payroll Movements Report:**

1. In the Name field, select Employee Payroll Movements Report.

2. Enter the Parameters field to open the Parameters window.

3. Select the payroll and payroll period for which you want to see the information.

4. In the Employee Detail field, do one of the following:
   • Select Summary Only to see total numbers for each category of change.
   • Select Order by Assignment Number or Order by Employee Name to see a full listing of employee assignments for New Hires, Terminations, Transfers In, and Transfers Out. This information will be listed in the order you select.

5. Choose the Submit button.
Assignment History

Use the Assignment History window to view the history of all an employee’s assignments, both current and in previous periods of service.

To view an employee’s assignment history:

1. In the Current field, select Yes, No or All.
   - Yes selects the list of current employees.
   - No selects the list of ex–employees.
   - All selects the list of both current and ex–employees.

2. In the Name or Number field, select an employee or ex–employee and choose the Find button.

   The Service History region displays the employee’s final period of service. It shows three periods of time:
   - **This Period** shows the number of complete years and months worked in this period of service to date.
   - **All Periods** shows the number of complete years and months worked in all periods of service to date.
   - **Including Breaks** shows the total elapsed time (in complete years and months) from the employee’s initial hire date to date.

You can view previous periods of service by choosing Next Record from the Go menu.
Oracle Human Resources provides a comprehensive recruitment module enabling you to integrate all your recruitment processes, from identifying vacancies to hiring new employees.

Using Oracle Human Resources, you can set up your recruitment procedures exactly as your enterprise requires. In particular, you have flexible control over the following key areas:

- recruitment and selection procedures
- security of applicant information
- handling of bulk applications
- generation of standard letters to applicants at different stages of the recruitment process
The Recruitment Cycle

Within any recruitment function, there is a common cycle of tasks, illustrated in Figure 15–1. There are three main areas: preparation, selection, and appointment, supported throughout by the production of standard letters and reports.

- **Preparation** is concerned with the identification of a vacancy, the authorization to take some action, and running one or more recruitment activities.
- **Selection** begins with the receipt of applications and ends with the issuing of offer or rejection letters. You define your own stages of the selection process and track applicants through the stages.
- **Appointment** takes the applicant from the recruitment process to employee administration where the initial tasks include entering terms and conditions and payroll information. Oracle HRMS makes this simple since recruitment, human resource administration, and payroll management can all be handled from the same personal records.
- Each task in the cycle is supported by automation of the standard paperwork that accompanies any recruitment process.

An analysis of your own detailed working practices will help you to decide whether to use Oracle Human Resources at a basic or an
advanced level within each area. At the same time, you should identify the sequence of tasks performed by your users, from which you can derive one or more Recruitment task flows.

See Also

Recruitment Preparation: page 15 – 4
Selection Processing: page 15 – 10
Using Letters to Manage Recruitment and Enrollment: page 33 – 9
Recruitment Preparation

Selecting applicants for recruitment is an extended process. You have to plan and coordinate a series of steps from identifying vacancies to organizing recruitment events.

Identifying Staffing Requirements

Using Oracle Human Resources, you can define budgets to reveal the headcount requirements within your enterprise, and then raise requisitions for the vacancies you require. You might have prior authorization to maintain your headcount or you might need to get authorization when you identify the vacancy.
Oracle Human Resources lets you record and use the information you need to raise a requisition at the time you need it. This can be particularly useful where an applicant takes the initiative by making a speculative approach. Your authorized vacancy list is clear and up to date at all times.

You can view lists of vacancies of a particular status, or a selected organization, location, job, position, grade, group, recruiter, or recruitment activity.

**Skill Requirements and Specifications**

If you want to match applicants with skill requirements in the selection process, you can enter competency requirements for jobs, positions and organizations. You can then use the web–based suitability search to compare the competency profiles of your applicants against the requirements of the vacancy. You can also enter deployment factors (such as relocation and willingness to travel) against jobs and positions. In the same way, you can record the deployment choices of your applicants.

You can hold a person specification or a job description on the system as attachments or using user–defined fields (called *descriptive flexfield segments*). As with requirements, these can be held at both job and position level.

**Running Recruitment Activities**

The authorization to recruit normally results in a specific recruitment activity, such as an advertisement. This might be part of some shared recruitment activity, such as an advertisement for more than one vacancy. The shared activity, in turn, might be part of another recruitment activity, such as a Graduate Recruitment Campaign.
Recruitment Campaign 94/95
- Dates
- Planned Cost
- Contacts
- Actual Cost

Recruiting for
Organization
Job
Position
Grade

Figure 15 – 3
Recruitment Activities

Advising
- Dates
- Planned Cost
- Contacts
- Actual Cost

Graduate Intake
- Dates
- Planned Cost
- Contacts
- Actual Cost

Recruiting for
Organization
Job
Position
Grade

Newspaper
- Dates
- Planned Cost
- Contacts
- Actual Cost

College Event
- Dates
- Planned Cost
- Contacts
- Actual Cost

Recruiting for
Organization
Job
Position
Grade
Raising Requisitions for Vacancies

Use the Requisition and Vacancy window to record requisitions, vacancies, and openings within your enterprise. Notice that a requisition can be for one or more vacancies, and a vacancy can have one or more openings.

Prerequisites

- Use the QuickCode Type VACANCY_STATUS to define the stages through which vacancies pass from being first raised to being filled. Examples might be Authorized, Advertised, and Shortlisted.

To create a requisition and vacancy:

1. Enter the requisition and save it before beginning to define the vacancy.
2. Enter a name and number of openings for the vacancy.
3. Optionally enter a description and select a status.
4. You can select one or more assignment components to define the vacancy.
Defining Recruitment Activities

Use the Recruitment Activity window to define either single recruitment activities or groups of activities.

You can associate a recruitment activity with an organization and with one or more vacancies. You can record and monitor the cost effectiveness of any activity, or group of activities.

Prerequisites

- You can define types of recruitment activity as values for the QuickCode Type REC_TYPE.

To define recruitment activities:

1. Enter the details of the recruitment activity.
   You can enter the name of a ‘parent’ recruitment activity in the Within Recruitment Activity region, if the activity you are defining is part of a campaign.

2. Choose the Recruiting For button to select one or more vacancies to associate with the activity.
Viewing Vacancies

Use the View Vacancies window to see lists of vacancies for an organization, location, job, position, grade, group, recruiter, or recruitment activity. You can also see all vacancies of a particular status.

To view vacancies:

1. Enter selection criteria in any of the fields in the top half of the window.
   Leave all these fields blank to see all vacancies in your Business Group.

2. Choose the Find button to see the vacancies that correspond to the criteria you have entered.
   In the folder you can enter a query to further restrict the vacancies displayed. If you have access to the Folder menu, you can also rename, resize, and reorder the fields displayed.

See Also

Requisition Summary Report: page 15 – 22
Selection Processing

The selection process begins with the receipt of applications and ends either with the hiring of applicants into the vacancies to which they have applied, or the terminating of their applicant assignments. During the process applicants move through a number of stages, each of which is monitored, controlled, and documented as required.

Entering Applicants

Oracle Human Resources lets you record addresses, personal details, application information, competencies, qualifications, school and college attendances, and work choices for all applicants. Notice that you track an application as one or more assignments for the applicant, similar to employee assignments. This has several advantages:

- It speeds up hiring the successful applicant since most of the important information is already on the system.
- It makes it easy to track several applications from one applicant as separate assignments.
- It enables you to enter an application from an existing employee: you update the Person Type to Employee and Applicant (or your user name equivalent) and enter the application as an applicant assignment.

Reporting on Application Information

To get a comprehensive report about an applicant, you can run the Full Applicant Details report from the Submit Requests window.

To see the applicants who have applied for a particular vacancy, or group of vacancies, run the Requisition Summary Report.

See Also

Requisition Summary Report: page 15 – 22
Making Quick Applicant Entries

Use the Applicant Entry window to enter basic person information and a single assignment for an applicant. To make this window quick and easy to use, you can only enter one address and one assignment for the applicant. If you need to update this information or add further information, use the Person and Application windows.

To record an application quickly:

1. Enter the applicant’s name and an identifying number recognized by the system.
   
   **Note:** If your Business Group uses automatic number generation, the applicant number automatically displays when you save your entries in this window.

2. Select a status for the application. By default a new application has the status Active Application (or an equivalent user status defined on your system). All other fields are optional.

3. In the Further Information field, you can enter Ethnic Origin, Visa Type (for non–citizens eligible for employment in the US), I–9 information and Veteran Status.

4. To enter an address, select a national address Style.
   
   A window opens with the address format for the country you select. Enter the address lines and choose OK.
5. The Date Received defaults to your effective date, but you can change it. This is the date the applicant’s record will begin.

6. You can enter the name of the applicant’s current employer.

7. You can select a recruitment activity. If there is only one vacancy for the activity, the vacancy details appear automatically.

8. If you select a vacancy, applicant assignment information is displayed from the vacancy record. You can add to this information or change it. However, if you change it, the vacancy field clears.

9. If you do not select a vacancy, you can enter assignment information in the Vacancy Applied For region. If you do not enter an Organization, it defaults to the Business Group.

**Entering Full Application Information**

Use the People window and the Application window to enter an application if you need to do any of the following:

- record multiple assignments for an applicant
- enter Government Extra Information
- record more than one address for an applicant
- update applicant information

For other applications, you can use the Applicant Entry window.

**Prerequisites**

- If you want to use your own status names to record the stages of your selection process, enter user statuses for the predefined applicant assignment statuses.
  See: Tracking Applicant Progress: page 15 – 15

- If you want to hold reasons for giving a status to an applicant assignment, enter the valid reasons as values for the QuickCode Type APL_ASSIGN_REASON.
  See: Adding QuickCode Values: page 32 – 3
To enter an application:

1. Set your effective date to the date you want the applicant assignment to begin, such as the closing date for applications.

2. Enter personal information for the applicant in the People window. See: Entering a New Person: page 13 – 5

3. Open the Application window. If you change the Date Received, this changes the effective start date for the applicant. You can enter the date you expect to hire the new recruit.

   You cannot enter a Termination date in this window. You must use the Terminate Applicant window.

4. You can enter the name of the applicant’s current employer.

5. If the application is for a specific vacancy, select the recruitment activity and vacancy. Assignment information from the vacancy is displayed. You can add more assignment details.

6. Select an applicant assignment status and the reason for giving this status. The applicant assignment status is the key to processing the application.

7. Optionally you can enter information, in the alternative regions, about:
   - the recruiter who is responsible for handling the application
• the supervisor of the assignment
• the standard conditions and probation period for the assignment
• the source of the application, such as the type of recruitment activity, or the organization that recommended the applicant, or the employee who referred the application

Additional Application Information
If you want to hold further details of the applicant’s skills, experience, or current situation, you can choose how to do this when you implement Oracle Human Resources. For example:

• Enter qualifications, deployment choices, and a personal competence profile for applicants. You can then perform suitability matches on these people using the web–based Suitability Match option (part of Line Manager Direct Access).
  See: Competence Profiles, Qualifications, Schools Attendances and Work Choices: page 13 – 19
• Use attachments to hold free text information.
• Set up segments of the Additional Application Details descriptive flexfield to hold the information you require.
  See: Adding New Fields to Windows: page 31 – 2
Tracking Applicant Progress

The progress of all applicants through the selection process is controlled by applicant assignment statuses. Each stage of the selection process is identified by a single assignment status. It is by changing the status that you can record the progress of any applicant assignment.

Figure 15 – 4
The Applicant Assignment and its Status

Applicant Assignment Statuses

As with employee assignment statuses, there is a set of system statuses that are used in various internal processes:

- **Active Application**: This is the normal status of an application as it progresses through the selection stages.
- **Offer**: Use this status for your preferred candidate when an offer has been made.
- **Accepted**: Update the preferred candidate’s assignment to Accepted status when you are ready to hire him or her in the Person window.
• Terminate Application. Use this status to end an applicant assignment. If there is only one assignment for the applicant, you cannot change the status to Terminate Application. You must make the applicant an ex-applicant in the Terminate Applicant window.

Note: The Terminate Application status is not recorded on the applicant assignment; it causes the assignment to end.

On your system, you can give these statuses different names (called User Statuses), appropriate to your enterprise.

See: Defining Assignment Statuses: page 28 – 7

Using Primary Applicant Assignment Statuses

These statuses are Primary because they determine how the assignment is processed and handled by the system. An assignment must have one, and only one, primary status.

You can update an applicant assignment status in the following windows:

• Application
• Applicant Interview
• Terminate Applicant

When you change the status, you can enter a reason for the change. Define valid reasons as values for the QuickCode Type APL.Assign.Reason.

You can also change the status of a group of applicants in the Mass Update of Applicants window. For example, if you want to call 20 applicants to a selection test and to reject all other applicants for the vacancy, you can do this in the Mass Update of Applicants window.

Changing a primary applicant assignment status can trigger the generation of a standard letter.

Using Secondary Applicant Assignment Statuses

There may also be Secondary statuses set up on your system. You can use secondary statuses for analysis and reporting, but they are not used for processing.

See: Defining Secondary Statuses: page 28 – 8

You can give an assignment multiple secondary statuses. You enter secondary statuses in the Secondary Statuses window.

See: Secondary Statuses: page 28 – 6
Interviewing Applicants

Typically, you track applicant progress through a series of interviews and update the status of the application after each interview. You can define different types of interview (such as First Interview, or Selection Test) as values for the QuickCode Type APL_INTERVIEW_TYPE.

You can schedule these interviews and update the applicant assignment status using the Applicant Interview window.

You can report on applicants and their interview schedules using the Requisition Summary Report.

To schedule applicant interviews:

1. Select an interview type, and enter the date of the interview in the Start Date field.
   You can also select a location and enter times and an end date.

2. If you want to associate an applicant assignment status change with the interview, enter it in the New Status field. This creates a datetracked update to the applicant assignment.

   You cannot enter a status when:
   • there are future changes to the assignment
   • the interview date is the date when the active application status began
• you are updating an existing interview record

Other Events Windows

You can also manage events attended by multiple applicants, such as tests or presentations. Define types of applicant event as values for the QuickCode Type APL_EVENT_TYPE. Create the events and book applicants onto them using the Event Bookings window.

See: Setting Up Events: page 27 – 2

You can view all the events an applicant has attended or is scheduled to attend by querying the applicant in the Person window and opening the Book Events window. You can also enter new bookings here.

See: Managing Bookings and Attendance: page 27 – 3
Mass Update of Applicants

The Mass Update of Applicants window contains a folder in which you can view all applicants and their assignment components and status. You can query groups of applicant assignments and update them as a group. There are two types of mass update you can perform:

- You can refer a group of applicants from one recruiter to another. The recruiter is the person responsible for handling the application.
- You can change the status of the applicant assignments.

*Note:* If you use the RPA to process an appointment for an applicant, you must change the applicant’s status to Accepted. The effective date of an applicant must be at least one day prior to the RPA Appointment Effective Date.

> **To update a group of applicant assignments:**

1. Select Find from the Query menu to open the Find Applications window. Enter selection criteria for the group of applicants you want to update and choose the Find button.

2. Do one of the following:
   - If you want to update all or most of these applicant assignments, choose the Select All button. Then uncheck the Mark check box for any assignments that you do not want to update.
   - If you want to update less than half of this group of assignments, check the Mark check box for each assignment you want to update.

3. Choose the Update button.

4. In the Update window:
   - If you want to update the status of the selected assignments, select the new status.
   - If you want to refer these applicants to a new recruiter, select the name of the Recruiter.

5. Choose OK to effect the update.

Hiring Applicants

When you have made a job offer to an applicant and they have accepted, you update the applicant assignment status to Accepted. You
can change your effective date to the date you plan to hire the applicant, and change their person type to Employee. You change person type in the People window.

See Also

Hiring: page 13 – 10
Ending Applications

If you have rejected an applicant assignment, you can update its status to Terminate Application. However, an applicant must be left with one active assignment. To reject an applicant’s last assignment, you must terminate the applicant. This updates their person type to Ex-applicant.

You terminate an applicant in the Terminate Applicant window.

Prerequisites

- If you want to hold reasons for rejecting applicants, enter the valid reasons as values for the QuickCode Type TERM_APL_REASON.

To terminate an applicant:

1. Enter the termination date.
2. Enter the status Terminate Application, or your User Status equivalent.
   
   This is not required, but you might use it to trigger generation of a rejection letter.


   Note: This status is not recorded on the applicant assignment, so it is not displayed if you requery the termination.
3. If you want to record the reasons for rejecting applicants, select a reason.
4. Choose the Terminate button.
Cancelling a Termination

If you have terminated an applicant in error, you can cancel the termination in the Terminate Applicant window. Simply choose the Reverse Termination button.

**Note:** You cannot cancel a termination if there are any future changes to the applicant’s personal record.

Requisition Summary Report

Use this report to see lists of applicants and their interview schedules for:

- all vacancies in a requisition, or
- all vacancies associated with a recruitment activity, or
- vacancies in a particular organization, location, job, position, grade, and/or group, and vacancies of a selected status

You can further restrict the applicants listed in the report by specifying start and end dates for the applicant assignments, and by selecting an applicant assignment status.

Each page of the report lists the applicants for one vacancy. This is defined as a unique combination of assignment components (organization, location, job, position, grade, and group). The vacancy has a name if you have set up vacancies on the system using the Requisition and Vacancy window, but this is not essential for running the report.

You run reports from the Submit Requests window.

**To run the Requisition Summary Report:**

1. In the Name field, select Requisition Summary Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Optionally enter start and end dates to restrict the applicant assignments shown in the report.
5. To further restrict the scope of the report, you can select values in any of the other fields defining the vacancies to report on. Notice that you can select values for individual segments of the People Group key flexfield.
6. Choose the Submit button.
Today an increasingly important responsibility of the Human Resources function is the maintenance of information for and production of government-mandated HR reporting, such as EEO-1 and OSHA reporting.

This chapter presents an overview of the facilities available in Oracle Human Resources for producing these reports. The following chapter explains how to set up and produce specific reports.
Government–Required HR Reporting

Today employers must prepare a number of reports about their employees for submission to various government authorities, or for internal use to ensure legislative compliance. The purpose of several of these reports is to measure the extent to which various identifiable groups of people are obtaining and advancing in employment:

- **Equal Employment Opportunity (EEO) and Affirmative Action Plan (AAP)** reporting focuses on the employment and advancement of employees by their gender and ethnic origin.
- **Federal Contractor Veterans Employment (VETS–100)** reporting is concerned with the employment and advancement opportunities of disabled and Vietnam era veterans.
- **Americans with Disabilities Act (ADA)** reporting is concerned with employment opportunities for people with various types of disabilities, and employers’ provision of reasonable accommodations enabling these people to perform the essential functions of jobs or positions.

Other federal–level reporting, mandated by the **Occupational Safety and Health Administration (OSHA)**, is concerned with the extent and severity of work–related injuries and illnesses affecting employees.

To satisfy the requirements for these different reports, HR departments need the ability to maintain specialized information about employees and their jobs, and to group employees in different ways, for example, by their work location or establishment, or by their affirmative action plan.

Oracle Human Resources provides the means to organize and maintain the information needed for government–mandated HR reporting, and to produce EEO–1, AAP, VETS–100, ADA, and OSHA reports.

**Note:** Many states now require employers to submit New Hire reports, primarily to ensure that employees meet court–ordered child support obligations by deductions from their pay. New hire reporting is normally the responsibility of the payroll department.

See: New Hire Reporting: page 13 – 32

See Also

- EEO–1 (Equal Employment Opportunity) Reporting: page 17 – 2
- AAP (Affirmative Action Plan) Reporting: page 17 – 12
- VETS–100 (Federal Contractor Veterans Employment) Reporting: page 17 – 21
Some reporting places no restrictions on the employment category or assignment status of the employees to be covered. However other reporting, such as that for VETS–100 and ADA, must cover only non–temporary, full time or part time employees at a non–terminated assignment status.

As a means to identify these employees, you register for the Business Group as Reporting Categories, your employment categories that include non–temporary, full time or part time employees. You register as Reporting Statuses, your assignment statuses that include non–terminated employees.

See Also

Registering Reporting Categories and Statuses: page 16 – 13

Reporting Organizations

You often must issue separate reporting for each GRE in your Business Group. Sometimes you must further break down data for a GRE by the establishments (hiring locations, units, or work sites) where its employees are based. A GRE can include employees working in several different establishments, and conversely, a given establishment can include employees in several different GREs.

For reporting purposes, an establishment may be a single physical location, a complex of work sites in a locality, or even all the sites included in a relatively large geographic area. For OSHA reporting, there may be two or more separate establishments at one physical work location if distinctly different types of operations are carried out at the location. To represent establishments for reporting, you give organizations the classification Reporting Establishment.

A GRE whose employees all work at the same establishment is simultaneously a GRE and a Reporting Establishment. For GREs with employees at different establishments you define a number of separate
Reporting Establishments. To identify the establishment serving as the headquarters organization, you give a Reporting Establishment the additional classification of *Corporate Headquarters*.

AAP reporting requires breakdowns of employees by the affirmative action plans covering them, instead of breakdowns by establishment. To meet this requirement, you give organizations the classification *AAP Organization*, to represent individual affirmative action plans.

**See Also**

- Setting Up Reporting Organizations: page 16 – 15
- OSHA Establishments: page 17 – 35

**Establishment Hierarchies**

To determine for reporting purposes which employees belong to a particular GRE and reporting organization, you construct *establishment hierarchies*, and supply them as parameters to the processes that produce particular reports.

A typical establishment hierarchy has a GRE at the top, Reporting Establishments at the next level, and HR Organizations subordinate to the Reporting Establishments. Report processes normally count employees as belonging to the Reporting Establishment to which their HR Organizations are subordinate in an establishment hierarchy.
Looking at the example establishment hierarchy above, a report process with this hierarchy as a parameter counts the employees in the HR Organizations subordinate to the Thurso Mfg. Reporting Establishment as based at that establishment, and those in HR Organizations subordinate to Thurso Denver as based at that establishment.

**Establishment Overrides**

Report processes using establishment hierarchies can take exceptional cases into account. You can enter an override Reporting Establishment for any employee. When a process finds an override, it counts the employee as part of the override Reporting Establishment.

For example, if reports should include an employee in the count for Thurso Denver, even though he is currently assigned to an organization subordinate to Thurso Mfg, you simply enter Thurso Denver as his override establishment.

**Note:** The establishment override functionality does not apply to AAP reporting. This is because the fundamental units of AAP reporting are affirmative action plans, not Reporting Establishments.

**See Also**

Entering Establishment Overrides: page 16 – 23
Varieties of Establishment Hierarchies

For most government-mandated HR reporting, you set up for a given GRE either a single-establishment hierarchy, or multiple-establishment hierarchies. If you have multiple establishments, you may also need a headquarters hierarchy for the establishment representing your enterprise headquarters.

The same basic rule applies to all the establishment hierarchies you build (but not to the AAP hierarchies used for AAP reporting). This rule is:

**In a non–AAP establishment hierarchy, an organization classified as a Reporting Establishment can never be subordinate to another organization classified as a Reporting Establishment.**

This means that in an establishment hierarchy, a GRE/Reporting Establishment can be the top organization, or Reporting Establishments can be subordinate to a GRE (and optionally to HR Organizations). But a Reporting Establishment cannot be subordinate to another Reporting Establishment.

**AAP Establishment Hierarchies**

Establishment hierarchies constructed for AAP reporting are exceptional because this reporting is based on the affirmative action plans existing within a GRE. This means that in AAP establishment hierarchies:

- establishments appear as subordinates of AAP Organizations representing the affirmative action plans
- AAP Organizations (which may also be Reporting Establishments) can appear at various levels in the hierarchy, and can be subordinate to other AAP Organizations (which may also be Reporting Establishments).

See: AAP Hierarchies: page 17 – 13

**See Also**

Setting Up Establishment Hierarchies: page 16 – 21

The Single–Establishment Hierarchy

In some cases, all the employees of a Business Group/GRE or a GRE work at, or from, a single establishment, and you use a
single-establishment hierarchy as a parameter for production of an establishment report:

The top organization of this type of hierarchy can be either a Business Group/GRE or a GRE, but must also be classified as a Reporting Establishment.

Multi-Establishment Hierarchies

For complex enterprises with multiple GREs and Reporting Establishments, you build multi-establishment hierarchies. For certain types of reporting you also require a special headquarters hierarchy, to cover the employees working in the Reporting Establishment that constitutes the enterprise headquarters. This section discusses multi-establishment hierarchies; the one following discusses headquarters hierarchies.

The top organization in a multi-establishment hierarchy can be either a Business Group/GRE or a GRE.

Note: For reporting that requires a separate report on your headquarters establishment, the top organization of a multi-establishment hierarchy must not be the headquarters organization. A headquarters organization always belongs in a special headquarters hierarchy.

See: The Headquarters Hierarchy: page 16 – 10

An already existing organization classed as a GRE may be suitable for use as the top organization of a multi-establishment hierarchy. Alternatively, you can create a GRE for reporting purpose only, with a
name similar to that of an operational GRE, and the same IRS identification number as the operational GRE.

**Example Multi–Establishment Hierarchies**

For examples of multi–establishment hierarchies, we can look at the hypothetical corporation Swanson Inc. Its Business Group includes two GREs, the parent company Swanson Inc. and a subsidiary, MS Distributors Detroit. The enterprise employs workers at four separate establishments:

- company headquarters in Cleveland, Ohio
- one factory in a Cleveland suburb and another in Dayton, Ohio
- the MS Distributors warehouse and shipping center in Detroit, Michigan.

This table summarizes the distribution of the 4,000 employees of Swanson Inc., by GRE and Reporting Establishment:

<table>
<thead>
<tr>
<th>Reporting Establishment</th>
<th>Swanson Inc. GRE</th>
<th>MS Distributors Detroit GRE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Swanson Inc. Headquarters</td>
<td>500</td>
<td></td>
</tr>
<tr>
<td>Swanson Mfg.</td>
<td>1,500</td>
<td></td>
</tr>
<tr>
<td>MS Distributors Detroit</td>
<td>955</td>
<td></td>
</tr>
<tr>
<td>Swanson Dayton</td>
<td>1,000</td>
<td>45</td>
</tr>
</tbody>
</table>

*Table 16–1 Swanson Inc. Employee Distribution*

For reporting purposes, this enterprise needs two multi–establishment hierarchies, and requires a headquarters hierarchy. The multi–establishment hierarchies required are these:
When you run a report giving one of these hierarchies as a parameter, the report process includes as belonging in a particular Reporting Establishment, any employees assigned to that establishment, plus all the employees assigned to the HR Organizations subordinate to that establishment. The only employees in these organizations that are not covered are any that have establishment overrides entered for the other Reporting Establishment in the hierarchy.

Counting Establishment Employees

A report process can count of the number of employees in a particular Reporting Establishment, and alter its treatment of the establishment.
depending on the results of this count. For example, EEO–1 and VETS–100 reporting for establishments with fewer than 50 employees is different from that for larger establishments.

Looking at the example hierarchy above for MS Distributors, report processes with this hierarchy as a parameter are able to determine that the MS Distributors Detroit Reporting Establishment has fewer than 50 employees, and to produce the appropriate reporting for this establishment.

---

**The Headquarters Hierarchy**

For some reporting, such as EEO–1 and VETS–100 reporting, it is a requirement that multi-establishment enterprises identify one establishment as their headquarters establishment.

The headquarters of a multi-establishment enterprise is from a reporting standpoint, a special type of Reporting Establishment. If your headquarters establishment is a simple one that you can represent by a single organization, use this organization as a parameter for the Headquarters Report, and do not build a headquarters hierarchy.

However, if your headquarters consists of a number of organizations, you can build a headquarters hierarchy. The top organization of a headquarters hierarchy must:

- be classified as a GRE and a Reporting Establishment
- additionally have the classification Corporate Headquarters.

The top organization can also be an HR Organization to which employees have assignments, or you can create an organization for use only at the top of the headquarters hierarchy. Within a Business Group there is normally just one organization classified as the corporate headquarters.
When you give the headquarters hierarchy as a parameter for a report process, the report covers all the employees assigned to the HR organizations in the hierarchy.
Preparing for Government–Mandated HR Reporting

• In preparation for running the VETS–100 and ADA reports, you must register Reporting Categories and Reporting Statuses for the Business Group.
  See: Registering Reporting Categories and Statuses: page 16 – 13

• In preparation for all government–mandated HR reporting, you must set up one or more types of reporting organizations. These include:
  – Reporting Establishments
  – Corporate Headquarters
  – AAP Organizations

  See:
  Setting Up Reporting Organizations: page 16 – 15

• After setting up the reporting organizations you need, you can build establishment hierarchies and AAP establishment hierarchies that include these reporting organizations.

  See:
  Setting Up Establishment Hierarchies: page 16 – 21

• Before running EEO–1, VETS–100, ADA, or OSHA reports, you enter establishment overrides for individual employees as necessary.

  See: Entering Establishment Overrides: page 16 – 23

See Also

- Setup Steps for EEO–1 Reporting: page 17 – 5
- Setup Steps for AAP Reporting: page 17 – 16
- Setup Steps for VETS–100 Reporting: page 17 – 23
- Setup Steps for ADA Reporting: page 17 – 30
- Setup Steps for OSHA Reporting: page 17 – 36
Registering Reporting Categories and Statuses

You must limit the coverage of VETS–100 and ADA reports to employees who work either full or part time but are not temporary workers, and who have a non–terminated employment status as of the end date of the reporting period.

To establish the employment categories and assignment statuses of the employees that VETS–100 and ADA reporting must cover, you register Reporting Categories and Reporting Statuses for the Business Group:

- Reporting Categories are the employment categories including employees who work full or part time on a non–temporary basis.
- Reporting Statuses are the assignment statuses applicable to employees at a non–terminated status.

Start the registration of Reporting Categories and Statuses from the Organization window.

Prerequisites

- Define the operational Business Group of your enterprise.
  See: Creating an Organization: page 2 – 20
- Set up on the system the employment categories and assignment statuses of your enterprise.
  See:
  Components of the Assignment: page 14 – 5
  Defining Primary User Statuses: page 28 – 7

To register reporting categories for the Business Group:

1. In the Organization window, query the Business Group if it does not already appear there. With the cursor on Business Group in the Organization Classification region, choose the Others button. Select Reporting Categories.
2. Click in the first blank field in the Additional Information window to open the Reporting Categories window. Select an employment category to register that covers employees who are non–temporary, full time or part time workers. Choose OK to transfer your selection to the Additional Information window.
3. To register another employment category, repeat step one.
4. When you finish registering categories, save your work. Choose OK to close the Reporting Categories window and the Additional Information window.
To register reporting statuses for the Business Group:

1. In the Organization window, query the Business Group if it does not already appear there. With the cursor on Business Group in the Organization Classification region, choose the Others button. Select Reporting Statuses.

2. Click in the first blank field in the Additional Information window to open the Reporting Statuses window. Select a status to register that covers employees at a non-terminated status. Choose OK to transfer your selection to the Additional Information window.

3. To register another assignment status, repeat step one.

4. When you finish registering statuses, save your work. Choose OK to close the Reporting Statuses window and the Additional Information window.

See Also

Data for VETS–100 Reports: page 17 – 21
Data for ADA Reporting: page 17 – 28
Setting Up Reporting Organizations

A reporting organization is an organization that has, in addition to any other classifications, one or more of these classifications:

- Reporting Establishment
- Corporate Headquarters
- AAP Organization

Before defining reporting organizations, determine the establishment hierarchies your enterprise needs for government-mandated HR reporting. This will in turn determine the particular reporting organizations you must set up.

See: Varieties of Establishment Hierarchies: page 16–6

Reporting organizations that do not have the classification Corporate Headquarters may be subordinate to other organizations in establishment hierarchies. You can quickly place a subordinate reporting organization in a hierarchy by entering its parent organization as additional information for its classification.

Note: When a reporting organization is the top organization in an establishment hierarchy, you always place it in the hierarchy when creating the hierarchy in the Organization Hierarchy window.

See: Setting Up Establishment Hierarchies: page 16–21

Setting Up Reporting Establishments

Reporting Establishments for EEO–1 Reporting

Prerequisite

- Determine the establishment hierarchies and Reporting Establishments required for EEO–1 reporting.

See: EEO–1 Reporting: page 17–2

To define a Reporting Establishment: for EEO reporting.

1. Using the Organization window, either query an existing internal organization or create an internal organization with the appropriate name and location for this Reporting Establishment.

2. In the Organization Classifications region, select the classification Reporting Establishment for the organization and enable it. Save your work.
Note: The organization can have other classifications as well. If it does, add information for these classifications as necessary.

3. With the cursor on Reporting Establishment in the Organization Classifications region, choose the Others button and select Establishment EEO–1 Filing. Click in the Additional Organization Information field to open the Establishment EEO–1 Filing window.

4. Enter the unit number, which is the number the EEOC assigns to organizations that function as EEO–1 corporate headquarters or establishments. For new establishments of existing companies, leave this blank.

5. Enter the EEO–1 reporting name.

6. Enter the Standard Industrial Classification (SIC) code for this establishment. Until the EEOC assigns a 4-digit code to the establishment, add a zero after the third digit of the 3-digit code.

7. In Activity Lines 1 – 4, enter a brief descriptions of the establishment’s major business activities.

8. Enter Yes if this establishment employs apprentices, and Yes if this is a new establishment for which you have not previously submitted EEO–1 reporting.

9. Save your work. If this EEO–1 Reporting Establishment occurs as a subordinate organization in one or more establishment hierarchies, place it in these hierarchies using the Parent Organization window.

See: Putting Subordinate Reporting Organizations in Hierarchies: page 16 – 19

Reporting Establishments for VETS–100 Reporting

Prerequisite

- Determine the establishment hierarchies and Reporting Establishments required for VETS–100 reporting.

See: VETS–100 Reporting: page 17 – 21

To define a Reporting Establishment for VETS reporting:

1. Using the Organization window, either query an existing internal organization or create an internal organization with the appropriate name and location for this Reporting Establishment.

See: Creating an Organization: page 2 – 20

2. In the Organization Classifications region, select the classification Reporting Establishment for the organization and enable it. Save your work.
Note: The organization can have other classifications as well. If it does, add information for these classifications as necessary.

3. With the cursor on Reporting Establishment in the Organization Classifications region, choose the Others button and select Establishment VETS–100 Filing. Click in the Additional Organization Information field to open the Establishment VETS–100 Filing window.

4. Enter the unit number the US Department of Labor has assigned to this establishment for this reporting, and the name used for this establishment for VETS–100 reporting.

5. Save your work. If this Reporting Establishment occurs as a subordinate organization in one or more establishment hierarchies, place it in these hierarchies using the Parent Organization window.

See: Putting Subordinate Reporting Organizations in Hierarchies: page 16 – 19

Reporting Establishments to Represent Corporate Headquarters

When using multi-establishment hierarchies for reporting purposes, you may need to identify a particular Reporting Establishment as the headquarters establishment of your enterprise. To do this you set up a Corporate Headquarters organization, for use as the top organization in a headquarters hierarchy.

You normally classify only one reporting organization within a Business Group as the Corporate Headquarters organization.

Note: An organization classified as a Corporate Headquarters should also have the classifications GRE and Reporting Establishment. It can have other classifications as well.

See: The Headquarters Hierarchy: page 16 – 10

Prerequisites

- Determine whether you require a Reporting Establishment that is also identified as a corporate headquarters.

See:

EEO–1 (Equal Employment Opportunity) Reporting: page 17 – 2
VETS–100 (Federal Contractor Veterans Employment) Reporting: page 17 – 21

- Define an organization with the classifications GRE and Reporting Establishment that you can also use to represent your corporate headquarters in a headquarters hierarchy.
To define a corporate headquarters:

1. Using the Organization window, query the organization to be classified as a corporate headquarters, if it does not already appear there.

   Note: This organization always has other classifications as well, for which entry of additional information is necessary

   See: Creating an Organization: page 2 – 20

2. In the Organization Classifications region, select the classification Corporate Headquarters for the organization and enable it.

   There is no additional information to add for the Corporate Headquarters classification. The Corporate Headquarters organization is always at the top of a headquarters hierarchy, so you place it in this hierarchy when defining the hierarchy.

   See: Setting Up Establishment Hierarchies: page 16 – 21

Setting Up AAP Organizations

The hierarchies you build for AAP reporting must include AAP Organizations, to represent the affirmative action plans in effect in your enterprise.

See: AAP Organizations: page 17 – 13

To define an AAP organization:

1. Using the Organization window, either query an existing internal organization or create an internal organization with the appropriate name and location for this AAP Organization.

   See: Creating an Organization: page 2 – 20

2. In the Organization Classifications region, select the classification AAP Organization for the organization and enable it. Save your work.

3. Select the classification AAP organization in the Organization Classifications region. Choose the Others button and select AAP Organization. Click in the Additional Organization Information field to open the AAP Organization window. Enter the name of the affirmative action plan this organization represents.
Note: The organization can have other classifications as well. If it does, add information for these classifications as necessary.

See: Creating an Organization: page 2 – 20

4. Save your work. If this AAP Organization occurs as a subordinate organization in one or more AAP establishment hierarchies, place it in these hierarchies using the Parent Organization window.

Putting Subordinate Reporting Organizations in Hierarchies

Reporting organizations with the classification Reporting Establishment and/or AAP Organization may exist in subordinate positions in establishment hierarchies. There is a convenient way to place these organizations in hierarchies when you set them up. You can name the hierarchies and parent organizations of the reporting organization in the Parent Organization window, accessible from the Organization window.

Prerequisite

- Set up the establishment hierarchies in which to place the reporting organizations, and include in them the appropriate parent organizations.

See: Setting Up Establishment Hierarchies: page 16 – 21

To put a reporting organization in a hierarchy:

1. In the Organization window, query the reporting organization if it does not already appear there. Select Reporting Establishment or AAP Organization in the Organization Classifications region, choose the Others button, and select Parent Organization to open the Parent Organization window.
2. Select the hierarchy name.

3. Select the name of the parent organization to which the reporting organization is subordinate in this hierarchy.

4. To place the reporting organization in another hierarchy, repeat steps 2 and 3.

5. Save your work.
Setting Up Establishment Hierarchies

Establishment hierarchies include:

- single-establishment hierarchies
- multi-establishment hierarchies
- headquarters hierarchies
- AAP establishment hierarchies.

To create an establishment hierarchy, use the Organization Hierarchy window.

See: Creating Organization Hierarchies: page 2 – 37

Prerequisite

- Set up the top organization for the establishment hierarchy. The classifications required for this organization vary depending on the hierarchy type.

See:

Varieties of Establishment Hierarchies: page 16 – 6
Single–Establishment Hierarchies

To create a single–establishment hierarchy:
1. Determine the top organization of the hierarchy. It must be a GRE and a Reporting Establishment. It may be a Business Group/GRE.
2. Build the hierarchy by placing all the HR Organizations in the Business Group/GRE or GRE at the second and lower levels under the top organization.

Multi–Establishment Hierarchies

To create a multi–establishment hierarchy:
1. Determine the top organization of the hierarchy. It can be a Business Group/GRE or a GRE. It cannot be a Reporting Establishment or an HR Organization, and should not have the classification Corporate Headquarters.
2. Build the hierarchy by placing the appropriate establishments and the HR Organizations subordinate to the establishments at lower levels.
See: Multi–Establishment Hierarchies: page 16 – 7

Headquarters Hierarchies

To create a headquarters hierarchy:
1. The top organization is that classified as Corporate Headquarters. It must also have the classifications GRE and Reporting Establishment.
2. Build the hierarchy by placing all the HR Organizations in the headquarters organization at the second and lower levels under the top organization.
See: The Headquarters Hierarchy: page 16 – 10

AAP Establishment Hierarchies

To create an AAP establishment hierarchy:
1. Determine how best to place in the hierarchy your affirmative action plans, represented by AAP Organizations, and the organizations under each plan.
If the hierarchy is for one affirmative action plan only, the AAP Organization representing this plan should be the top organization. If the hierarchy covers two or more plans, the AAP Organizations for these plans can appear at any level of the hierarchy.

2. Build the hierarchy by placing all the organizations with jobs covered by an affirmative action plan, below the AAP Organization representing that plan.

See: Example AAP Hierarchy: page 17 – 13

## Entering Establishment Overrides

Use establishment overrides when employees who would normally be counted in one Reporting Establishment, should actually be counted as belonging to another in the same establishment hierarchy. Report processes with establishment hierarchies as parameters check whether Reporting Establishment overrides exist for the employees the hierarchies cover. If it finds overrides, it counts the employees as belonging to the override Reporting Establishments.

**Note:** Because the basic unit of AAP reporting within a GRE is its affirmative action plans (AAP Organizations), not its Reporting Establishments, you cannot enter establishment overrides for AAP reporting.

See: AAP Hierarchies: page 17 – 13

To enter an establishment override for an employee, use the window GREs and Other Data.
Prerequisites

- Decide which organizations you must define to your Oracle HRMS database as Reporting Establishments, and complete their setup.
  
  See: Setting Up Reporting Organizations: page 16 – 15

- Set up the establishment hierarchies you require.
  
  See: Setting Up Establishment Hierarchies: page 16 – 21

► To enter an establishment override for an employee:

- Select the override establishment in the Establishment field.
CHAPTER 17

Production of Government–Mandated HR Reports

This chapter discusses the data requirements, setup steps and procedures for production of:

- EEO–1 (Equal Employment Opportunity) reports
- AAP (Affirmative Action Plan) reports
- VETS–100 (Federal Contractor Veterans Employment) reports
- ADA (Americans with Disabilities Act) reports
- OSHA (Occupational Safety and Health Administration) reports.
EEO–1 (Equal Employment Opportunity) Reporting

Most private employers in the US must provide EEO–1 reports to the Joint Reporting Committee, in accordance with the Civil Rights Act of 1964, as amended by the Equal Employment Opportunity Act of 1972. Each GRE within an enterprise submits EEO–1 reporting for each establishment where it has employees.

Under EEOC (Equal Employment Opportunity Commission) rules, an establishment for EEO reporting is an economic unit, such as an office, factory, store, or mine, that produces goods or services at a single physical location. However, notice that establishments are relatively permanent locations from which employees who may work elsewhere are supervised, or from which they operate. If a GRE’s employees work at many different, relatively temporary sites, as in construction or transportation, each site is not necessarily an establishment.

The particular EEO–1 reports submitted for a GRE depend on whether it is a single-establishment or multi-establishment employer. To represent establishments for EEO–1 reporting you define Reporting Establishments. For multi-establishment enterprises, you also define a special type of Reporting Establishment, the Corporate Headquarters.

See:

Entering EEO–1 Information for the GRE: page 17 – 5
Setting Up Reporting Organizations: page 16 – 15

Single–Establishment Reporting

A single-establishment employer, that is, a GRE whose employees all work at or from the same establishment, needs to file only one report type, The Single–Establishment Employer Report (EEO–1 report type 1), which must be entered on Standard Form 100. You build a single-establishment hierarchy to use as a parameter for this report.

Multi–Establishment Reporting

Multi-establishment employers must submit a Consolidated Report entered on Standard Form 100, which summarizes EEO information for all employees in the enterprise. Multi-establishment employers can submit the other EEO–1 report types for which they are responsible as computer printouts, provided they exactly conform to EEOC formatting standards. These report types are:

• the Individual Establishment Report, required for each establishment having 50 or more employees.
• the **Headquarters Report**, required for the establishment identified as the headquarters of the enterprise. For a Business Group with more than one GRE, the Headquarters Report covers the employees in the GRE that functions as the parent corporation or holding company.

• the **Establishment Employment Listing**, showing the name, address, total employment and major activity of each establishment with fewer than 50 employees. Required if such small establishments exist.

You build multi-establishment and headquarters establishment hierarchies to use as parameters for these report types.

**See Also**

Varieties of Establishment Hierarchies: page 16 – 6

**Data for EEO–1 Reporting**

For this reporting, you must maintain certain personal information for employees, and *EEO job categories* for your jobs.

**Employee Gender and Ethnic Origin**

EEO–1 reports show by gender and ethnic origin, the number of employees working in each of nine job categories in a specified payroll period. So for EEO–1 reporting purposes, you must keep on record both the gender and the ethnic origin of your employees.

These are the relevant categories of ethnic origin:

- White (not of Hispanic origin)
- Black (not of Hispanic origin)
- Hispanic
- Asian or Pacific Islander
- American Indian or Alaskan Native

AAP reporting also uses these categories of ethnic origin.

**EEO Job Categories**

Each of your jobs must be associated with one of nine EEO job categories, and all your employees have assignments to jobs. AAP and VETS–100 reports also use these job categories.
The EEO job categories are:

1. Officials and Managers
2. Professionals
3. Technicians
4. Sales Workers
5. Office and Clerical
6. Craft Workers (Skilled)
7. Operatives (Semi–Skilled)
8. Laborers (Unskilled)
9. Service Workers
Setup Steps for EEO–1 Reporting

1. For each GRE, enter information necessary for submission of EEO–1 reports.
   See: Entering EEO–1 Information for a GRE: page 17 – 5
2. Enter an EEO job category for each job in your enterprise.
   See: Associating Jobs with EEO Job Categories: page 17 – 6
3. Ensure that each employee has a gender and ethnic origin on record, and has an assignment to a GRE and a job.
   See:
   Data for EEO Reporting: page 17 – 3
   Entering a New Assignment: page 14 – 9
4. Identify the types of EEO–1 reporting each GRE must submit.
   See: EEO–1 (Equal Employment Opportunity) Reporting: page 17 – 2
5. Determine the establishment hierarchies required for your EEO–1 reporting, and then identify and define the reporting organizations necessary for production of your EEO–1 reports.
   See:
   Varieties of Establishment Hierarchies: page 16 – 6
   Setting Up Reporting Establishments: page 16 – 15
   Setting Up Corporate Headquarters: page 16 – 17
6. Build the establishment hierarchies necessary for production of your EEO–1 reports.
   See: Setting Up Establishment Hierarchies: page 16 – 21
7. Manually enter any necessary establishment overrides for employees.
   See: Entering Establishment Overrides: page 16 – 23
8. Run the EEO–1 report processes.
   See: Obtaining EEO–1 Reports: page 17 – 8

Entering EEO–1 Information for a GRE

For each GRE, you maintain certain basic information for EEO–1 reporting. Start this information entry from the Organization window.
Prerequisite

- Set up the GRE in your system.
  See: Creating an Organization: page 2 – 20

To enter information for a GRE for EEO reporting:

1. In the Organization window, query the GRE if it does not already appear there. With the cursor in Government Reporting Entity in the Organization Classifications region, choose the Others button and select EEO–1 Filing.
2. Click in the field that appears in the Additional Organization Information window to open the EEO–1 Filing window.
3. Enter the EEO–1 Identification Number assigned by the EEOC.
4. Enter the GRE’s Dun and Bradstreet number, if it has one.
5. Enter the reporting name (a name used in EEO–1 reporting instead of the GRE’s full name).
6. Enter Yes in the Affiliated field if the GRE:
   - employs fewer than 100 employees, and
   - is affiliated with another company, or subject to centralized ownership or management, so that the group legally constitutes a single enterprise employing 100 or more employees.
7. Enter Yes in the Government Contractor field if the employer has a government contract or any federally assisted construction contracts, or serves as a depository of federal government funds.

Associating Jobs with EEO Job Categories

For EEO, AAP, and VETS–100 reporting, you must associate each job in your enterprise with an EEO job category.
To associate a job with an EEO category, start from the Job window.

**Prerequisite**

- Define the jobs that EEO-1 reporting covers.
  
  See: Defining Jobs: page 3 – 8

**To associate a job with an EEO job category:**

1. Query the job in the Name field if it does not already appear there. Click in the Further Information field to open the Further Job Information window.

2. In the EEO Category field, select the category for this job.
Obtaining EEO-1 Reports

To obtain information for entry of the Single-establishment Employer Report on Standard Form 100, run the EEO Individual Establishment and Headquarters Report. To obtain information for entry on this form of the Consolidated Report, run the EEO Consolidated Report.

Multi-establishment employers can submit the Headquarters Unit, Individual Establishment, and Establishment Employment Listing reports as computer printouts, if these printouts are formatted in exact accordance with the formatting rules of the EEOC. To ensure correct formatting, the EEOC requires submission of test printouts for review and written verification of acceptability. Oracle HR EEO-1 reports are all designed to accord with current EEOC formatting standards.

Direct questions on computerized reports to:

The EEO-1 Coordinator, EEOC – Surveys

PRINTSRP

1801 L Street, NW – Suite 9604

Washington, DC 20507

Telephone: 202–663–4985

Run EEO reports from the Submit Requests window.

Prerequisite

☐ Ensure that you have entered all information necessary for EEO-1 reporting.

See: Setup Steps for EEO-1 Reporting: page 17 – 5

To run a Single-Establishment Employer Report:

1. In the Name field of the Submit Requests window, select the name EEO Individual Establishment and Headquarters Report. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll Period Date, enter the effective date for which the report process should collect employee data.

3. In the EEO-1 Report Type field, select Single Establishment Employer Report – Type 1.

4. For the Organization parameter, a list appears of all the organizations in the Business Group that do not have the classification Corporate Headquarters. Select the organization whose name should appear on this report.
5. For the Organization Hierarchy parameter, a list appears of all the hierarchies existing in the Business Group. Select the one to use for this report.

6. Enter the Payroll Period Date of the last report you submitted as the Previous Audit Date. Choose OK, then Submit.

7. For report submission, copy the report results onto EEO Standard Form 100.

To run a Headquarters Report:

1. In the Name field of the Submit Requests window, choose the name EEO Individual Establishment and Headquarters Report. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll Period Date, enter the effective date for which the report process should collect employee data.

3. In the EEO–1 Report Type field, select Headquarters Report – Type 3.

4. For the Organization parameter, a list appears to validate the organization in the Business Group that has the classification Corporate Headquarters. Normally there is only one organization with this classification in a Business Group.

5. For the Organization Hierarchy parameter, a list appears of all the hierarchies existing in the Business Group. If you have built a hierarchy to represent your headquarters, select it from the list.

6. Enter the Payroll Period Date of the last Consolidated Report you submitted as the Previous Audit Date.

7. Choose OK, then Submit.

To run an Individual Establishment Report:

1. In the Name field of the Submit Requests window, choose the name EEO Individual Establishment and Headquarters Report. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll Period Date, enter the effective date for which the report process should collect employee data.

3. In the EEO–1 Report Type field, select Establishment Report – Type 4.

4. For the Organization parameter, a list appears of all the organizations in the Business Group that do not have the
classification Corporate Headquarters. Select the organization whose name should appear on this report.

5. For the Organization Hierarchy parameter, a list appears of all the hierarchies existing in the Business Group. Select the one to use for this report.

6. Enter the Payroll Period Date of the last Consolidated Report you submitted as the Previous Audit Date.

7. Choose OK, then Submit.

**To run a Consolidated Report:**

1. In the Name field of the Submit Requests window, choose the name EEO Consolidated Report. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll Period Date, enter the effective date for which the report process should collect employee data.

3. For the Organization parameter, a list appears of all the organizations in the Business Group that do not have the classification Corporate Headquarters. Select the organization name to appear on the Consolidated Report printout.

4. Enter the Payroll Period Date of the last Consolidated Report you submitted as the Previous Audit Date. Choose Submit.

5. For report submission, copy the report results onto EEO Standard Form 100.

**To run an Establishment Employment Listing Report:**

1. In the Name field of the Submit Requests window, choose the name EEO Establishment Employment Listing. If the Parameters window does not open automatically, click in the Parameters field.

2. For the Payroll Period Date, enter the effective date for which the report process should collect employee data.

3. For the Organization parameter, a list appears of all the organizations in the Business Group that do not have the classification Corporate Headquarters. Select the organization whose name should appear on this report.

4. For the Organization Hierarchy parameter, a list appears of all the hierarchies existing in the Business Group. Select the one to use for this report.

5. The entry in the Maximum Number of Employees field defaults to 49, which means the report will cover all establishments with 49 or fewer employees. You can change this default if necessary.
6. Choose OK, then Submit.
AAP (Affirmative Action Plan) Reporting

The US Federal Executive Order 11246 requires enterprises who are government contractors or subcontractors and have 50 or more employees, to establish affirmative action plans (AAPs) for women and ethnic minorities. The Office of Federal Contract Compliance Programs (OFCCP) of the US Labor Department, responsible for enforcing affirmative action laws, requires these enterprises to measure the effectiveness of their affirmative action plans by implementation of internal reporting.

To assist you with affirmative action reporting, Oracle HR provides two reports for your AAP plans:

- AAP–Workforce Analysis
- AAP–Job Group Analysis

These reports both display for each job an affirmative action plan covers, the EEO job category and a salary code indicating the job’s relative compensation level. Also the reports display for each job, the number and percentage of employees in the job by gender and by ethnicity (White / Black / Asian / Native American / Hispanic).

Workforce Analysis Report

This report shows by their line of progression, the jobs in the organizations an affirmative action plan covers. A line of progression is a set of related jobs, ordered from the lowest to the highest paid. This is an example line of progression for jobs in Sales:

Sales Assistant -> Salesperson -> Sales Team Leader -> Sales District Manager -> Sales Regional Manager -> Vice–president of Sales

The Workforce Analysis report displays the current totals of all employees and of ethnic minorities for each organization and for the entire affirmative action plan. It also shows the totals for each organization as a percentage of the plan totals.

Job Group Analysis Report

This report organizes the jobs an affirmative action plan covers by their job groups. A job group is a set of jobs related by virtue of similar levels of responsibility, compensation and opportunities for advancement. For example, the Regional Manager Job Group could include these jobs:

Sales Regional Manager – Regional Director, Human Resources – Regional Head, Finance – Production Manager – MIS Regional Manager
For each job group, the report displays the current totals of all employees and of ethnic minorities in its jobs. It also displays these totals for the entire affirmative action plan, and shows the jobs, and shows each job group’s totals as percentages of the plan totals.

AAP Organizations

AAP reporting differs from other types of government-mandated HR reporting in that the reports are issued for each affirmative action plan within a GRE, instead of the establishments within a GRE. While it can happen that an affirmative action plan covers all employees in one or several Reporting Establishments, plan coverage does not necessarily follow these boundaries.

For example, a plan may cover employees based in many different Reporting Establishments who all work in the same functional area, such as customer service or human resources. Another plan may cover a variety of employees based at different sites who all have the same job classification, such as Registered Nurse, Technician, or Machinist.

To represent the affirmative action plans in your enterprise, you set up organizations classified as AAP Organizations, entering for each the name of its plan. An AAP Organization can also be (but is not necessarily) a GRE, Reporting Establishment, and HR Organization. After defining AAP Organizations you place them in AAP establishment hierarchies.

AAP Hierarchies

AAP hierarchies differ from other establishment hierarchies in one important respect. Whereas in other establishment hierarchies one Reporting Establishment cannot be subordinate to another, in AAP hierarchies an AAP Organization, which can also be a Reporting Establishment, can occur at any level.

In other words, AAP Organizations can appear below other AAP Organizations in an AAP establishment hierarchy when this represents the reality of your enterprise, even if both organizations are also Reporting Establishments.

Example AAP Hierarchy

The following diagram is an example AAP Hierarchy.
This example AAP hierarchy includes these affirmative action plans:

- the **Swanson Dayton** plan, covering all the employees who work in the Swanson Dayton factory
- the **Management** plan, covering the employees who work in MS Distributors, Warehouse Management, Shipping Management, and Shipping’s administration
- The **Warehouse** plan, covering the employees in warehouse organizations below the management level
• The Dock Crews plan, covering the laborers that work on the loading docks.

To obtain the AAP reporting for one of these plans, you supply the hierarchy name and the particular plan name as report parameters.

Data for AAP Reporting

For this reporting you maintain the same information as that required for EEO–1 reports:

• employee gender and ethnic type
• EEO job categories for jobs

See: Data for EEO–1 Reporting: page 17 – 3

Additionally, for AAP reporting you jobs must have:

• salary codes, for which you use pay grades
• lines of progression. You determine and set up your lines of progression, and then associate the appropriate jobs with them.
• job groups. You determine your job group names, set them up, and then associate each job with its group.
Setup Steps for AAP Reporting

1. Ensure that each employee has an gender and ethnic origin on record, and has an assignment to a GRE and a job.

   See:
   
   Entering a New Person: page 13 – 5
   Entering a New Assignment: page 14 – 9

2. Determine salary codes for your jobs by selecting a grade to represent each salary code. If necessary, define grades to use as salary codes.

   See: Defining Grades: page 4 – 4

   Note: The purpose of the salary code is to indicate for AAP reporting purposes the relative average salary of a job. Salary codes do not determine the pay that employees receive.

3. Define lines of progression for the jobs your affirmative action plans cover.

   See: Defining Lines of Progression for Jobs: page 17 – 17

4. Determine the job groups that the jobs in your affirmative action plans belong to, and enter the job group names for the QuickCode type US_JOB_GROUPS.

   A job group consists of jobs with similar levels of responsibility, compensation, and opportunities for advancement.

   See: Adding QuickCode Values: page 32 – 3

5. Associate each job your affirmative action plans cover with an EEO category, if they are not already so associated. Also associate these jobs with a salary code, line of progression, and job group.

   See:
   
   Associating Jobs with EEO Job Categories: page 17 – 6
   Associating Jobs with AAP Reporting Information: page 17 – 18

6. Define an AAP Organization to represent each of your AA plans.

   See: Setting Up AAP Organizations: page 16 – 18

7. Determine the AAP hierarchies you require, and build them.

   See:
   
   AAP Hierarchies: page 17 – 13
   Setting Up Establishment Hierarchies: page 16 – 21
8. Run the AAP report processes.
   See: Obtaining AAP Reports: page 17 – 19

   **Note:** Because AAP reports cover individual AA plans rather than establishments, the Reporting Establishment override functionality available for EEO–1 and VETS–100 reporting does not apply to AAP reporting.

---

**Defining Lines of Progression for Jobs**

To define a line of progression for a series of jobs, you build entities called *career paths* in Oracle HRMS. Career paths are also useful for building lines of progression, or career path, involves these two steps:

- entering the name of the line of progression into the system as a career path name, using the Career Path Names window
- entering the jobs comprising the line of progression, starting from the job with highest status and remuneration and working down, using the Map Career Path window.

A job can appear only once in any line of progression.

**Prerequisites**

- Define all the jobs for which you are building lines of progression.
  
  See: Defining Jobs: page 3 – 8

- Determine the lines of progression into which your jobs fall.

**To define lines of progression:**

1. In the Career Path Names window, enter and save the names of the lines of progression you have determined for your enterprise.

2. Open the Map Career Path window. In the Name field, select the top job in a line of progression.
3. In the Career Path Name field, select the name of this line of progression.

4. In the Job Progression From block, select the job that is one level down from the job appearing in the Name field. Check the Down box. The window redispers with the selected job now appearing in the Name field.

5. Repeat Step 4 until you have entered all the jobs in the line of progression.

   To move back up the line of jobs, check the Up box.

6. Save your work.

**Associating Jobs with AAP Reporting Information**

To associate your jobs with salary codes, lines of progression, and job groups, start from the Job window.

**Prerequisite**

- Define all the jobs covered by your affirmative action plans.

  See: Defining Jobs: page 3 – 8
To associate jobs with AAP reporting information:

1. In the Job window, query the job in the Name field if it does not already appear there. Click in the Further Information field to open the Further Job Information window.

2. Select for this job its job group name, line of progression, and grade used for its salary code, in the Job Group, Line of Progression, and Salary Code fields, respectively.

Obtaining AAP Reports

Run report requests from the Submit Requests window.

Prerequisite

- Complete the setup steps for AAP reporting.

See: Setup Steps for AAP Reporting: page 17 – 16

To run the AAP–Workforce Analysis report:

1. In the Name field, select AAP–Workforce Analysis Report. Click in the Parameters field if the Parameters window does not automatically open.

2. Enter the effective date of the report. This date defaults to your session date.
3. Select the name of the affirmative action plan on which to report, and the AAP hierarchy to use.

4. For the report to cover only one organization, select its name in the Organization field.

5. For the report to cover only one line of progression, select its name in the Line of Progression field.

6. Choose Submit.

**To run the AAP-Job Group Analysis report:**

1. In the Name field, select AAP-Job Group Analysis Report. Click in the Parameters field if the Parameters window does not open automatically.

2. Enter the effective date of the report. This date defaults to your session date.

3. Select the name of the affirmative action plan on which to report, and the AAP hierarchy to use.

4. For the report to cover the jobs and employees in just one job group, enter its name in the Job Group field.

5. Choose Submit.
VETS–100 Reporting

Employers who fall under certain legislative guidelines must each year file VETS–100 reporting (the Federal Contractor Veterans Employment Report), to cover a one–year period. Its purpose is to help the US Department of Labor determine whether Vietnam–era veterans and disabled veterans from the Vietnam era and other periods, are benefiting from affirmative action in obtaining and advancing in employment.

You submit VETS–100 reporting for each GRE in your enterprise, broken down by the hiring locations within each GRE. To represent hiring locations you use Reporting Establishments and when necessary, Corporate Headquarters organizations.

If your enterprise includes just one hiring location you file one report for your entire Business Group/GRE, building a single–establishment hierarchy to use as a parameter for this report.

If you have multiple hiring locations, you file these reports:

- a **headquarters report** covering employees in the Parent Company, or headquarters organization, of your enterprise.
- **hiring location reports** covering your other hiring locations with 50 or more employees. These include:
  - **consolidated reports** listing by state, information about its hiring locations with fewer than 50 employees.

You build a headquarters hierarchy to use as a parameter for the headquarters report, and multi–establishment hierarchies, for the hiring location reports.

See: Varieties of Establishment Hierarchies: page 16 – 6

Report Contents

For the hiring locations in your enterprise, VETS–100 reporting shows:

- the numbers of Special Disabled and Vietnam Era Veterans you employ in each of nine job categories. These are the EEO job categories also used for EEO–1 and AAP reporting.
- the total number of new hires in the reporting period in each job category, together with the number of the new hires in each category who qualify as Special Disabled Veterans and Vietnam Era Veterans.

Data for VETS–100 Reports

VETS–100 reporting covers those veterans you employ at each hiring location in a GRE who meet these criteria:
• They qualify as Special Disabled Veterans or Vietnam Era Veterans, in accordance with the legal definitions of these categories.

• They work on a non–temporary, full time or part time basis.

• They have a non–terminated employment status as of the end date of the report period.

To record the veteran status of your employees, you select a veteran status when entering other personal information for them. To determine which of your employment categories cover non–temporary full time or part time workers, and which assignment statuses count as non–terminated, you register them as Reporting Categories and Reporting Statuses.

Special Disabled and Vietnam Era Veterans

A Special Disabled Veteran is one who, under laws administrated by the Department of Veteran Affairs:

• is entitled to compensation for a disability rated at 30% or more, or

• is entitled to compensation for a disability rated at 10% or 20% and has been determined to have a serious employment handicap, or

• has been discharged or released from active duty because of a service–connected disability.

A Vietnam Era Veteran is one who served more than 180 days of active military, naval, or air service, any part of which fell between 5 August, 1964 and 7 May, 1975, and:

• who was discharged or released with other than an dishonorable discharge, or

• was discharged or released from active duty because of a service–connected disability.
Setup Steps for VETS–100 Reporting

1. Ensure that Reporting Categories and Statuses are registered for your Business Group.
   Reporting Categories are those employment categories that cover non–temporary, full time or part time work. Reporting Statuses are those assignment statuses that cover non–terminated statuses.
   See: Registering Reporting Categories and Statuses: page 16 – 13
2. For each GRE, enter the information necessary for submission of VETS–100 reports.
   See: Entering VETS–100 Information for a GRE: page 17 – 23
3. Ensure that EEO job categories are on record for your jobs.
   See: Associating Jobs with EEO Job Categories: page 17 – 6
4. Ensure that all employees qualifying as Special Disabled Veterans or Veterans of the Vietnam Era have a veteran status of Vietnam Veteran, Disabled Vietnam Veteran, or Disabled Veteran, and have an assignment to a job, an employment category, and a GRE.
   See:
   Entering a New Person: page 13 – 5
   Entering a New Assignment: page 14 – 9
5. Determine the establishment hierarchies required for your VETS–100 reporting, and then identify and define the reporting organizations necessary for production of your VETS–100 reports.
   See:
   Varieties of Establishment Hierarchies: page 16 – 6
   Setting Up Reporting Organizations: page 16 – 15
6. Build the establishment hierarchies you need to obtain VETS–100 reporting for your enterprise.
   See: Setting Up Establishment Hierarchies: page 16 – 21
7. Manually enter any necessary establishment overrides for employees.
   See: Entering Establishment Overrides: page 16 – 23
8. Run the VETS–100 report processes.
   See: Obtaining VETS–100 Reports: page 17 – 25

Entering VETS–100 Information for a GRE

For each GRE, you must maintain certain basic information for VETS–100 reporting. Start this information entry from the Organization window.
Prerequisite

- Set up the GRE in your system.
  
  See: Creating an Organization: page 2 – 20

To enter information for a GRE for EEO reporting:

1. In the Organization window, query the GRE if it does not already appear there. With the cursor in Government Reporting Entity in the Organization Classifications region, choose the Others button and select VETS–100 Filing.

2. Click in the Additional Organization Information field to open the VETS–100 Filing window.

3. Enter the company number the US Department of Labor has provided to identify this GRE.

4. Enter the company name used for this GRE for VETS–100 reporting.
Obtaining VETS–100 Reports

Computer–generated reports are acceptable so long as they conform exactly to the formatting standards of the Office of Veterans’ Employment and Training. The Oracle HR VETS–100 reports are designed to accord with current formatting standards. To ensure the correctness of the VETS–100 report formatting, mail or fax a sample copy to this office in advance:

US Department of Labor, Office of Veterans’ Employment and Training
VETS–100 Reporting
649 Monroe St.
Montgomery, AL 36131–2446

Run report requests from the Submit Requests window.

Prerequisite

☐ Ensure that you have entered all information necessary for VETS–100 reporting.

See: Setup Steps for VETS–100 Reporting: page 17 – 23

To run a report for a single hiring location:

1. In the Name field of the Submit Requests window, select VETS–100 Veterans Employment Report. Click in the Parameters field if the Parameters window does not automatically open.
2. Enter the start and end dates of the period this report covers.
4. Select the name of the hierarchy to use for this report. If there is more than one version of this hierarchy, select the correct version number.
5. For the Organization parameter, select the name of the organization in the hierarchy that is the top organization of the portion of the hierarchy that this report should cover. The name and address of this organization appear on the report as the hiring location.
   For the Single Establishment Employer Report, this is likely the Business Group, and the top organization of the entire hierarchy.
6. The Display Totals and Display New Hires fields default to Yes.
   You can change one or both to No to prevent the display of totals and new hire information on the report.
To run a headquarters report for multiple hiring locations:

1. In the Name field of the Submit Requests window, select VETS–100 Veterans Employment Report. Click in the Parameters field if the Parameters window does not automatically open.
2. Enter the start and end dates of the period this report covers.
3. Select Headquarters Report as the report type.
4. Select the name of the establishment hierarchy to use for this report. If there is more than one version of this hierarchy, select the correct version number.
5. For the Organization parameter, select the top organization in the hierarchy. This organization should have the classifications Reporting Establishment and Corporate Headquarters (and often has other classifications as well).
   
   **Note:** For enterprises with more than one hiring location, the Parent Company name and address that appears on all the VETS–100 reports is always that of the organization classified as the corporate headquarters.
6. The Display Totals and Display New Hires fields default to Yes. You can change one or both to No to prevent the display of totals and new hire information on the report.
7. Choose OK, then Submit.

To run reports for locations with 50 or more employees:

1. In the Name field of the Submit Requests window, select VETS–100 Veterans Employment Report. Click in the Parameters field if the Parameters window does not automatically open.
2. Enter the start and end dates of the period this report covers.
3. Select Establishment Report as the report type.
4. Select the name of the establishment hierarchy to use for this report. If there is more than one version of this hierarchy, select the correct version number.
5. For the Organization parameter, select the name of the organization in the hierarchy that is the top organization of the portion of the hierarchy that this report should cover. The name and address of this organization appear on the report as the hiring location.
6. The Display Totals and Display New Hires fields default to Yes. You can change one or both to No to prevent the display of totals and new hire information on the report.
7. Choose OK, then Submit.

To run a listing of locations with less than 50 employees:

1. In the Name field of the Submit Requests window, select VETS–100 Consolidated Veterans Employment Report. Click in the Parameters field if the Parameters window does not automatically open.

2. Enter the start and end dates of the period this report covers.

3. For the Hierarchy parameter, select the name of the multi-establishment hierarchy to use for this report. If there is more than one version of this hierarchy, select the correct version number.

4. For the Organization parameter, select the name of the organization in the hierarchy that is the top organization of the portion of the hierarchy that this report should cover.

5. Select the state for which to produce the report, or leave blank for the report to print for each state with one or more establishments with less than 50 employees.

6. The Display Totals and Display New Hires fields default to Yes. You can change one or both of them to No.
### ADA (Americans with Disabilities Act) Reporting

The Americans with Disabilities Act (ADA) became law on 26 July 1990. It prohibits employers from discriminating against employees or applicants with disabilities who can perform the essential functions of a job with reasonable accommodation. Under ADA, people with disabilities are those:

- who have a physical or mental impairment that substantially limits one or more major life activities, or
- who have a record of such an impairment, or
- who are regarded as having such an impairment.

The ADA Report shows how your enterprise is responding to the requests of employees with disabilities for reasonable accommodations to permit them to carry out the essential functions of their jobs, without undue hardship to you as their employer.

### Report Coverage

The ADA report covers those employees in each of your establishments who work on a non–temporary, full or part time basis, have a non–terminated assignment status as of the report period end date, and have taken one or more of the following actions:

- **requested registration** as a disabled person.
- **provided information** about a type of disability they have.
- **requested accommodation** for a disability.

To determine which of your employment categories cover non–temporary full time or part time workers, and which assignment statuses count as non–terminated, you use the Reporting Categories and Reporting Statuses registered for your Business Group.

### Information for ADA Reporting

The report provides basic information (name, number, organization and job) about employees who have identified themselves as having a disability. You can register employees as disabled when entering other basic personal information about them.

When employees submit information about particular types of disabilities, you maintain this information using the ADA Disabilities window. The report presents this information, including any information in the form of comments.
Requests for Accommodations

Because the Americans with Disabilities Act encourages employers to make reasonable accommodations permitting employers with disabilities to work, Oracle HR provides the Disabilities Accommodations window for recording information about employees’ requests for such accommodations.

The ADA Report lists these requests with their request dates, reviewers, review dates and status (requested, approved, or denied). It also lists the cost of each approved accommodation, and the total cost of approved accommodations for each establishment.

Essential Functions of Jobs or Positions

The report can optionally display for each employee with a disability, the essential requirements of his or her job or position, providing that you maintain these requirements in the database.

See: Entering Job and Position Skill Requirements: page 3 – 17
Setup Steps for ADA Reporting

1. Ensure that Reporting Categories and Statuses are registered for your Business Group.
   Reporting Categories are those employment categories that cover non–temporary, full time or part time work. Reporting Statuses are those assignment statuses that cover non–terminated statuses.
   See: Registering Reporting Categories and Statuses: page 16 – 13
2. Ensure that registration of employees as disabled, and that entry of information about disability types and requests for disability accommodation, is complete. Registration of someone as disabled is accomplished by checking the Disabled box when you enter personal information about him or her.
   See:
   Entering a New Person (step 9): page 13 – 5
   Entering Information about Disabilities: page 17 – 31
   Entering Requests for Disability Accommodation: page 17 – 31
3. Ensure that each employee who is registered as disabled, who has provided information about a disability type, or who has requested a disability accommodation has an assignment to a GRE, a job or position, and an employment category.
   See: Entering a New Assignment: page 14 – 9
4. Identify the establishments within each GRE that you need for ADA reporting, and ensure that they are defined as Reporting Establishments.
   See: Setting Up Reporting Establishments: page 16 – 15
5. Determine and build, if necessary, the establishment hierarchies you need to obtain ADA reporting.
   See: Setting Up Establishment Hierarchies: page 16 – 21
6. To include information about essential job or position requirements in ADA reporting, ensure that you have entered these requirements for your jobs or positions.
   See: Entering Job and Position Skill Requirements: page 3 – 17
7. Manually enter any necessary establishment overrides for employees.
   See: Entering Establishment Overrides: page 16 – 23
8. Run the ADA report process.
Registering Employees as Disabled

When employees request registration as disabled, effect this registration by checking the Disabled box in the Person window when entering them in the system. They will then be listed on the ADA Report.

See: Entering a New Person: page 13 – 5

Entering Information about Disabilities

When employees provide information about a type of disability they have, enter this information in the ADA Disabilities window. Start this entry from the Person window.

To enter information about a person's disability type:

1. Query the person in the Person window if he or she does not already appear there. Choose the Special Info button to open the Special Information window.

2. In the Name field, select Disabilities. In the Details block, click in the Detail field to open the Disabilities window.

3. In the Type field, enter a brief description of the nature of the disability.

4. Optionally, enter more detailed information, such as the expected duration of the disability or the results of medical reviews, in the Comments window. To open this window, click on the paper clip icon in the toolbar.

5. Choose the OK button when you complete the entry, and save your work.

On the ADA Report, the information entered for employees appears under the heading Disability. Any comments entered also appear on the report.

Entering Requests for Disability Accommodation

When employees with disabilities request accommodations to help them perform the essential functions of their jobs, enter information
about these requests in the Disability Accommodations window. Start this entry from the Person window.

▶ To enter information about accommodation requests:

1. Query the person in the Person window if he or she does not already appear there. Choose the Others button, and select Special Info to open the Special Information window.

2. In the Name field, select ADA Disability Accommodations. In the Details block, click in the Detail field to open the ADA Disability Accommodations window.

3. In the Description field, briefly enter the accommodation requested, for example, Wheelchair ramp or Widened door. The Date Requested field defaults to the effective date.

4. In the Status field, select Requested, Approved or Denied to track the request status.

5. Optionally, enter the name of the reviewer of the request, and the date reviewed, in the Confirmed By and Date Confirmed fields.

6. For approved requests, enter the date of providing the accommodation, and its cost.

7. Optionally, add comments regarding the request using the Comments window. Click on the paper clip icon to open this window.

8. Choose the OK button when you complete data entry, and save your work. The information entered for employees, including any comments, appears on the ADA Report.

Obtaining ADA Reports

As ADA reporting is for your own use, there are no required formatting standards.
Run report requests from the Submit Requests window.

Prerequisite

☐ Ensure that you have entered all information necessary for ADA reports.

See: Setup Steps for ADA Reporting: page 17 – 30

▶ To run an ADA report:

1. In the Name field, select ADA Report. A window containing the parameters for this report appears.
2. The effective date will be the date of the report.
3. For the Organization Hierarchy parameter, select the name of the establishment hierarchy to use for this report.
4. To obtain the report for a particular employee, select his or her name or employee number.
5. To obtain the report for employees in a particular job and/or location, select the job or location name, or both.
6. Select Yes for the report to include a listing of the essential requirements for the jobs or positions of employees with disabilities.
7. Select Yes for the View Registered Disabled Only parameter for the report to include only those employees with disabilities whose personal information includes registration as disabled.
8. For the Sort By parameter, select Employee to sort by employee last name. Select Assignment to sort by job name, location, grade, position and employee name, in that order.
9. Choose OK, then Submit.
OSHA (Occupational Safety and Health Act) Reporting

The Occupational Safety and Health Act of 1970 and Title 29 of the Code of Federal Regulations, Part 1904 (29CFR Part 1904) require employers in certain industries to record and report on employees’ work–related injuries and illnesses. The Bureau of Labor Statistics (BLS) administers this record keeping and reporting, often in cooperation with state agencies. Employers must consult with these agencies to determine if they are subject to additional state–level recording and reporting obligations.

Employers in relatively high–risk industries such as construction, manufacturing, and health services, must keep OSHA records for each individual establishment on an ongoing basis, if they have a combined total of 11 or more employees working at one or more establishments.

Employers in other industries that normally are not required to keep OSHA records, must maintain these records when selected to participate in the Annual Survey of Occupational Injuries and Illnesses. The purpose of this survey is to produce national estimates of occupational injuries and illnesses for all employers.

For a full list of industries required to maintain and report on OSHA information, and detailed instructions about OSHA record keeping, consult the document A Brief Guide to Recordkeeping Requirements for Occupational Injuries and Illnesses. To obtain copies of this publication, contact your regional office of the Bureau of Labor Statistics or write to:

Bureau of Labor Statistics
Division of Management Systems (1220–0029)
Washington, DC  20212

OSHA Data

Information needed for OSHA reporting includes a description of each work–related injury or illness and the date, place and circumstances of its occurrence or onset, as well as information on its physical effects and its outcome. For a nonfatal incident, you also maintain data showing its effects on the employee’s ability to work.

The OSHA Form 200 report, Log and Summary of Occupational Injuries and Illnesses, is the vehicle for logging information about work–related injuries and illnesses during the year, and for presenting a summary of these injuries and illnesses at year end. An additional report, OSHA Form 101, Supplementary Record of Occupational
Injuries and Illnesses, provides further information about the cases logged.

**OSHA Establishments**

GREs with more than one establishment must maintain separate sets of OSHA records and reporting for each establishment. To represent these establishments and the employees within them, you use Reporting Establishments and establishment hierarchies.

Notice that for OSHA record keeping and reporting, clearly separate activities performed at the same physical location require treatment as separate Reporting Establishments. For example, if an enterprise has manufacturing facilities and sales offices in the same building, each activity constitutes a distinct establishment.

**See Also**

OSHA Categories of Illness: page 17 – 37
Setup Steps for OSHA Reporting

1. Ensure that entry of information on each incident of work–related injury or illness is complete.
   See: Entering Information about Work–Related Injury or Illness: page 17 – 36

2. Identify the establishments within each GRE that you need for OSHA reporting, and ensure that they are defined as Reporting Establishments.
   See:
   OSHA Data and Reporting: page 17 – 34
   Setting Up Reporting Establishments: page 16 – 15

3. Determine and build, if necessary, the establishment hierarchies you need to obtain OSHA reporting.
   See: Setting Up Establishment Hierarchies: page 16 – 21

4. Manually enter any necessary establishment overrides for employees.
   See: Entering Establishment Overrides: page 16 – 23

5. Run the OSHA report processes.
   See: Obtaining OSHA Reports: page 17 – 38

Entering Information about Work–related Injury or Illness

When employees suffer work–related injuries or illnesses, record information about these incidents in the OSHA–Reportable Incident window. Start this entry from the Person window.

To enter data on an OSHA–reportable incident:

1. Query the employee suffering the injury or illness in the Person window, if he or she does not already appear here. Choose the Others button, and select Special Info to open the Special Information window.

2. In the Name field, select OSHA–Reportable Incident. In the Details block, click in the Detail field to open the OSHA–Reportable Incident window.

3. For incidents of work–related injury, you must select the category Injury. Otherwise select the category appropriate for a work–related illness.
4. Enter a brief description of the injury or illness, for example: Amputation of 1st joint right forefinger; Strain of lower back; Electrocution—body.

5. Enter the incident date, and address including the number and street, city or town, state, zip code. Enter whether the incident occurred on the employer’s premises.

The employer’s premises include rest rooms, hallways and cafeterias, but not parking facilities or recreational facilities such as gyms, pools or ball fields, unless the employee was engaged in work–related activity there.

6. In the Activity field, describe what the employee was doing when injured or taken ill. In the Objects/Substances Involved field, list any tools, equipment or materials being used or handled.

7. Use the Comments window to enter a description of how the accident or exposure to illness occurred. To open this window, click on the paper clip icon.

8. In the Body Parts Affected field, enter the injury or illness and the body part, for example, Fracture of ribs; Dermatitis of left hand; Lead poisoning.

9. Indicate if the incident caused the termination or permanent transfer of the employee. If it caused missed work or restricted activity, enter the number of days missed or restricted.

Do not include the day of injury or onset of illness, or days the employee would not have worked in any case. For employees without regular work schedules, estimate the number of missed days.

10. If the injury or illness caused the employee’s death, you must enter the date of death. Entry of a date in the Date Deceased field signals that the injury or illness was fatal, and must be reported as such.

11. Enter the name and address of the physician attending the employee, and if he or she was hospitalized, the name and address of the hospital.

12. Choose the OK button when you complete data entry, and save your work. When you run the OSHA No. 200 and OSHA No. 101 reports, information entered in this window appears on one or both of these reports.

**OSHA Categories of Illness**

OSHA recognizes these categories of occupational illness:
• Occupational skin diseases or disorders. Examples are eczema, oil acne, chrome ulcers, chemical burns, etc.
• Dust diseases of the lungs. Examples are silicosis, asbestosis and other asbestos–related diseases, varieties of pneumoconioses, etc.
• Respiratory conditions due to toxic agents. Examples are pneumonitis, pharyngitis, rhinitis, acute congestion due to chemicals, dusts, gases or fumes, etc.
• Poisoning (systemic effects of toxic materials). Examples are poisoning by lead, mercury, cadmium, arsenic or other metals; by carbon monoxide, hydrogen sulfide or other gases; by benzol, carbon tetrachloride or other organic solvents; by insecticide sprays; by other chemicals such as formaldehyde, plastics, resins; etc.
• Disorders due to physical agents (other than toxic materials). Examples are heatstroke and other effects of environmental heat; frostbite and other effects of exposure to low temperatures; effects of ionizing radiation (isotopes, X–rays, radium); effects of nonionizing radiation (welding flash, microwaves); etc.
• Disorders associated with repeated trauma. Examples are noise–induced hearing loss; synovitis, tenosynovitis, bursitis; Raynaud’s phenomena; other conditions due to repeated motion, vibration or pressure.
• All other occupational illnesses. Examples are anthrax, brucellosis, infectious hepatitis, malignant and benign tumors, food poisoning, histoplasmosis, etc.

Obtaining OSHA Reports

Computer–generated versions of the forms OSHA No. 200 and OSHA No. 101 are acceptable, so long as they contain the same information and are as readable and comprehensible as the OSHA forms. The BLS advises employers using computer–generated forms to submit a sample report for review, to ensure compliance with BLS regulations.

Run report requests from the Submit Requests window.

Prerequisite

☐ Ensure that all information needed for OSHA reporting has been entered.

See: Setup Steps for OSHA Reporting: page 17 – 36
To run OSHA Form 200 or Form 101 Reports:

1. In the Name field, select OSHA Form 200 Report or OSHA Form 101 Report. A window containing the parameters for the report appears.

2. For the parameter GRE, select the name of the GRE for which you are running the report.

3. For the Organization Hierarchy parameter, select the name of the establishment hierarchy to use for this report.

4. Enter the start and end dates of the period this report covers. The period end date is the date that appears on the report.
Introducing Career Management Activities

This chapter describes how you can use the Career Management modules provided by Oracle Human Resources to develop the competence approach within your enterprise.
Introducing Career Management Activities

Oracle Human Resources is a radically different human resource application. Using conventional applications, performance management activities are often carried inconsistently across the enterprise. For example, the recruitment function may perform psychometric tests that define personal skills and behavior in one way, while the appraisal scheme uses an internally agreed but different definition of skills, and training classes record licenses and qualifications in another. Not only is this costly to your enterprise, but it also means that your human resource activities are carried out inconsistently.

What distinguishes Oracle Human Resources is that it’s built upon the emerging disciplines of performance management and the competence approach. This gives a single, unified model and language for traditionally different activities (such as appraisals, assessment, recording accomplishments, and such). By using this one approach, you can:

- operate more effectively at work
- perform key human resource management processes consistently across the enterprise
- achieve clearly defined business goals within a common framework

In this section, you’ll learn about the competence approach, and other key concepts and terms. Once you have an understanding of the concepts, you’ll be able to take full advantage of Oracle Human Resources easy-to-use tools to improve the capacity of your human resources to meet enterprise goals and objectives.

Advantages of the Common Competence Framework

A common framework for describing and assessing competencies speeds the deployment process within your enterprise. This is both cost-effective and desirable. Imagine how quickly your managers can respond to new challenges when they can identify and select employees and applicants on a common basis—they can also match employees and applicants with opportunities that arise across the whole enterprise. This ability to perform global deployment effectively, through a ‘virtual job market’, provides your enterprise with the competitive edge with deployment. Consider being able to create opportunities in the US and recruit globally using common terminology to build up teams with complementary skills.
Improving employee development and motivating employees are other important aspects of cost-effective human resource management. By surfacing enterprise goals and commonly valued skills and behaviors, you can ensure that employees develop not only technical and job-specific skills, but also broader skills that ensure they continue to be marketable within the enterprise.

Assessing the applicant or contractor pool is another key area where a common framework helps your enterprise to cut costs. With Oracle Human Resources, you can assess on an enterprise-wide basis, ensuring that an able candidate is not rejected because of a mismatch for one vacancy when other suitable vacancies exist, reducing recruitment overheads.

If your enterprise is 'knowledge-based' rather than skills-based (such as financial services or a software provider), a common approach also enables you to assess and use the competencies your employees possess to gain a competitive edge.

Attention: This software should not be used as the sole method of assessment for making judgements about hiring, performance or deployment. Your company may be held liable if you rely on incorrect computer data or computerized rules to make such judgements.

It is the customer’s responsibility to take all appropriate measures to comply with the Data Protection and Privacy laws of the countries in which they operate.

All personal information that you store or use with this software must be up to date, accurate and relevant. You should confirm the details of the restrictions that apply to the computerized storage and use of personal information with your own legal department or representative.

Career Management – A Fully Tailorable, Proactive Management Tool

Now that you have chosen Oracle Human Resources, you can take advantage of a fully tailorable, sophisticated and proactive management tool to handle your human resources activities. From assessments to appraisals, employee profiling and career development, you can find powerful and easy-to-use features that let you take control of your employee processes using the web, and intuitive graphical tools.

Information Infrastructure

Oracle Human Resources provides you with the advantages of an information infrastructure for common systems of performance
management across the enterprise. By providing a repository for all your employee and applicant competence and performance information, everyone within your enterprise can enter, review and integrate the information with that of other computerised applications, quickly and easily. Using the integrated Oracle Applications suite, you are able to answer such questions as “Did the introduction of the new incentive programme coincide with positive changes in manufacturing output?”, “Has the gap between required skills and accomplishments changed in salespeople, and has the change affected revenue?” and “How much did we spend per head on training, and how does this relate to improved performance?”.

Web and Workflow Access (LMDA and EDA)

Oracle Human Resources provides you with web and workflow–based access for many line manager and employee end–user activities through an intuitive, easy–to–use interface. Alternatively, you can perform many activities using standard Oracle HRMS windows.

We’ve looked hard at the administrative aspects of collecting, approving and acting on assessment and appraisal information and sought to automate these processes using Oracle Workflow. Our graphical Workflow designer enables you to change these processes to match your own requirements, and to change them at will to ensure that your administration is streamlined.

For a full description of all web and workflow–based access, and how to configure the application for the web, see: Oracle HRMS Applications for the Web Configuration Guide.

Line Manager Direct Access (LMDA)

Line Manager Direct Access (LMDA) enables line managers to perform sophisticated searches to identify people by skills, personal characteristics, applicant or employee information. The ‘person list’ generated from the search is used for processes such as graphical comparisons, group ranking, appraisals and assessments. Managers can save the list and use it many times, enabling them to easily access the people they deal with frequently.

Managers can perform a number of view and update activities on the group of people for whom they have secure access. This security mechanism is shared with the client server HRMS Application, and includes organization, position and payroll–based security.
Providing Views

Line managers can view information that can include a number of drill down stages. This enables line managers to view:

- graphical matches of competencies for a person compared with the requirements of an organization, job, position or other ad hoc choice
- graphical matches of a group of people for a given competence
- appraisal and assessment reviews
- ranked candidate lists matched against the requirements of an organization, job or position
- candidate application histories
- employment histories with drill down views to assignment details
- vacation balances
- contact and dependent details
- salary history information
- roles performed by a person: who they manage, supervise etc.
- absence histories
- employee movements by organization
- absences by organization.

Employee Direct Access (EDA)

Employee Direct Access (EDA) enables employees to access their own information and the relevant details for their contacts or dependents. For example, it enables employees to change their address or change their competence profile.

Which Activities are Available Using Windows, LMDA and EDA?

The following tables illustrate which setup and ongoing activities you can perform using standard Oracle HRMS windows, and which activities you can perform using Line Manager and Employee Direct Access. For some activities, you can use windows, LMDA and EDA.
Create Rating Scales
Create Competencies
Group Competencies
Define Competence Requirements
Use Competencies (with Oracle Training Administration installed)
Create Qualification Types
Create Schools and Colleges
Create Assessment Template
Create Appraisal Questionnaire
Create or Modify Appraisal Template

Ongoing Activities

Create a Person List (perform sophisticated searches to identify people by skills, personal characteristics, applicant or employee information)
Create and review appraisals and competence-based assessments, and transfer them to other participants using Oracle Workflow. Employees can perform self assessment and appraisal
Enter succession plan options for a person
Complete suitability matching (skills profiling)
Manage deployment constraints and requests expressed by employees, such as requests to relocate, or travel internationally. Employees can update their own work choices
Manage and update work choices for a job and position
Create and update competence profile. Employees can update their own competence profile
Enter, review and update qualifications, education, licenses and awards
Enter, review and update schools and colleges attended
View summary personal and employee data

Available Using:

Windows
LMDA
EDA
Configurable Web Interface

Our highly configurable web interface enables you to create templates for your appraisal and assessments to meet your unique needs. You can include your own questions, the competencies that are assessed and the method your users make ratings and weightings of competencies or objectives. So, although you are using a common language, you can tailor appraisals and assessments for different parts of your enterprise to ensure that competencies that apply to to small populations are assessed as well as 'core' competencies.

Most web pages supplied can be configured to change help text, page titles, corporate logos and navigation buttons, and so on. You can change pages to fit your corporate style and include your own pages alongside the supplied pages to provide a complete HR information repository for your employees.

Where it is essential to be able to define the fields included on a web page to customize it for your organization, such as defining an offer template for hiring candidates that includes questions about terms and conditions, Oracle Web Employees provides facilities to configure pages to your exact needs.

For more information, see: Oracle HRMS Applications for the Web Configuration Guide.
Defining Your Competence–Based Operation

The main reason Oracle Human Resources provides you with so much flexibility is that it has a highly configurable framework. This enables you to define all the components of a performance management system to meet the needs of your enterprise, and to change them at will. You can define competencies, behavioral descriptions, performance ratings, appraisal and assessment forms, multiple types of assessment, and organization, job and position requirements.

Because of this, you can set up the application to mirror exactly how your enterprise handles its human resource activities now, or in the future to meet new market opportunities, go through mergers or expand into new countries. To enable you to take full advantage of this flexibility, it is worth spending some time before you start to use Oracle Human Resources in identifying how you want drive your human resource operation.
Identifying Your Business Goals Before Implementing the Competence Approach

We suggest that the first thing you do before you set up the application is to produce an action plan. This helps you identify your enterprise’s strategic business goals and objectives you want the competence approach to address. It also helps you identify the processes required to meet and achieve those goals.

Business goals or objectives take many forms, but they usually define what has to be done within the enterprise. For example, ‘to build an oil
Defining Your Enterprises Competencies

We, at Oracle, recognise that you will want to develop competencies that best meet the needs of your own enterprise. So, rather than providing you with pre-defined competencies that may be too prescriptive or too general, we enable you to develop your own. You might want to ‘pilot’ a small number of easily definable and measurable competencies first (for example, anything that requires physical effort such as digging a ditch or typing a letter), ensuring that the definitions are meaningful and relevant before rolling them out widely within the enterprise. Once you have developed these first competencies, you can go on to define competencies that are much more complex and difficult to observe and measure (for example, anything that includes cooperation with other people). You can, of course, have a mixture of both.

Because you might want to group related competencies together (for example, all your core competencies), Oracle Human Resources enables you to create competence types. These groups of related competencies are useful, for instance, if you want to include all competencies in a job advertisement (because they are ‘hireable’), or which can be ‘delivered’ by formal training.

Defining Your Competence Requirements

To ensure your enterprise meets its current and future goals, you’ll need to identify your competence requirements. For example, if your enterprise’s goal is ‘to gain greater penetration in the applications market’, Oracle Human Resources enables you to quickly and easily identify the competencies that people within your enterprise need to possess and exhibit to meet that goal.

Defining your core (or management or leadership) competencies might be the first stage in developing a competence approach. These core competencies are identified as being required by every person to enable
your enterprise to meet its goals. In our example, the core competencies required to meet the goal *greater penetration in the applications market*, might include strategic thinking, quality orientation and customer awareness. With Oracle Human Resources flexibility, you can define these core competencies at the business group or organization level.

Then, once you have identified your enterprise’s core competencies, you might want to define individual job and position competencies later, for example, C++ programming, SQL*Plus, and such. The position automatically inherits the core competencies defined for the organization, saving you from having to enter them yourself!

The competence requirements held at business group, organization, job and position level are dated. With all this information at your fingertips, you can set them up for future requirements to perform analysis or resource projections for your enterprise. You can also project the impact of changes, such as reorganising and restructuring, and change them over time.

**Using Competence Profiles**

Using Oracle Human Resources to develop your core, job and position competence requirements enables you to compare what competencies the people within your enterprise possess, against those that are required. You need to do this as comparison is the main driver for most HR activities, whether deployment, reward, incentives, succession planning, and so on.

By having a profile of competence requirements, you can devise an appropriate assessment procedure, and assess individuals against the competencies for selection, qualification or training and development purposes.

See: Competence Requirements: page 20 – 2

**Designing Your Methods of Measurement**

Because of the flexibility of Oracle Human Resources, you are able to structure your competencies to design your methods of measurement to meet the needs of your enterprise. If most of the competencies within your enterprise are comprised of proficiency levels unique to individual competencies, you might want to create competencies with their unique proficiency levels. You would therefore have a number of equivalent systems for measuring performance. Alternatively, you can use the general method of measurement. Here, you do not hold the proficiency
level at the competence level, but you use a general rating scale and text to describe the competence in a general way. You can, of course, use a mixture of both.

Imagine the flexibility of being able to use a general method to measure your core competencies, for example, and an individual method to measure specific job and position competencies throughout your global enterprise.

Not only do we provide you with the flexibility to use different methods of measurement, but we also provide you with the flexibility to calculate the assessment scores in a variety of ways. For example, you might want to calculate the scores just by taking performance against the competencies into consideration. Alternatively, you might want to calculate the scores by taking performance, proficiency and weighting into consideration, and to apply the weighting to proficiency. With Oracle Human Resources, the choice is yours.

See: Creating Your Methods of Measurement and Creating Competencies: page 19 – 2

Assessments and Appraisals

Assessing and appraising your enterprise’s employees are key areas of human resources management. To ensure you have the right people in place at the right time, you’ll want to find out what competencies your employees possess, and at what level they demonstrate them.

You’ll also want to find out their aspirations, and set their short- and long-term objectives, for example, what an employee is expected to achieve in the next six months. These objectives not only prepare employees for their next position within a career plan, but they also translate enterprise objectives into individual performance and improvement goals and measures.

The reason you describe and assess measurable behavior is that much of it is amenable to change by outside intervention. You can affect certain competencies by recruiting them, others by practical or theoretical training. You can remove practical obstacles to competence by improving processes, resources or equipment. You can affect motivation by various types of incentive, whether monetary or opportunity based.

Assessment scores in Oracle Human Resources enable you to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions now, or in the near future. You can use the results of the Competence Gap processes to identify areas where you need to recruit or train employees, remove
practical obstacles to competence by improving processes, resources or equipment. You can also affect motivation by various types of incentive, whether monetary- or opportunity-based.

See: Assessing and Appraising Employees: page 22 – 2

Describing and Assessing Measureable Behavior

One of the major features of Oracle Human Resources is the ability to hold the accomplishments of your people, enabling you to compare them against the competence profile for job and position requirements. It also enables you to match them to projects, develop succession plans, and organize further training and certification.

See: Creating a Competence Profile: page 13 – 20

You measure and record a score of how the person has performed against each competence during assessment. This provides clear and accessible performance measures (Is the person demonstrating the specified behavior at the level defined? Does the person have the knowledge or skills required to operate effectively?). You hold applicant and employee accomplishments in a person’s Competence Profile. You can then use the assessment results to analyse what is required to get the people with the right competencies in place. You can do this by hiring people, developing or training them.

By measuring competencies grouped into an assessment (for example, a Managerial or Engineering assessment), you focus attention on the behaviors and proficiency or performance of individuals and their ability to get things done. (Do not worry about proficiency or performance here, we describe both in What Type of Assessment do you Want to Perform?: page 22 – 4).

See: Assessing and Appraising Employees: page 22 – 2

Suitability Matching

You might use assessment scores during a suitability search to fill a job or position. You can use powerful Suitability Search tools to search for and match the most suitable person to a job or position. This might be performed during recruitment, succession planning, and so on. You can search by:

- people
- jobs or positions

See: Suitability Matching: page 24 – 2
Perform Competence Gap Analysis

In future releases, assessments scores will be used by the Competence Gap processes. This will enable you to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions. You can analyse which competencies are required now, or in the near future.

The Competence Gap module graphically represents (by line or bar chart) the gap between a person’s, or group of people’s, competencies and what the enterprise requires.

Identifying Qualifications and Delivering Competencies

Competencies can have identified evaluation methods, such as a license, test or qualification. You can set up the qualifications that your enterprise recognises to include only the ones that you want in a person’s Competence Profile. You need to identify establishments that deliver the qualifications your enterprise recognises. These are then used to record where a person gained the qualification. Again, by keeping up-to-date and complete information, you are able to better forecast present and future requirements.

See: Creating Qualification Types: page 21 – 3
See: Creating Schools and Colleges: page 21 – 5

You can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. A training activity is an abstract term for any planned undertaking that improves a student’s competencies (qualifications, experience, and so on).

You can enter the competencies and proficiency levels that your training activities are expected to deliver using the Delivered Competencies window. You can then update a person’s Competence Profile after they have successfully gained the competence.

**Note:** You must purchase Oracle Training Administration (OTA) separately to use this functionality.

See: Using Competencies or Skills, *(Oracle Training Administration User’s Guide)*.

Career and Succession Planning

Once you have found out your employees aspirations, and set their short- and long-term objectives, you’ll want to prepare them for their
next position within a career plan. After all, now you have motivated your employees through your performance management system, you’ll want to keep them motivated by linking their own career aspirations to enterprise aspirations. By planning succession, you enable employees to see their future role within the enterprise, keeping them motivated, and you from lengthy and costly recruitment.

Not only does succession planning enable you to keep and retain your high-flyers, it also enables you to highlight, for example, roles requiring scarce technical or commercial skills. By being able to identify these early, you can develop these scarce skills within your enterprise and replace current employees in these positions, as required.

See: Career and Succession Planning: page 23 – 2

Work Choices

Using work factors, you can track an employee’s, applicant’s, contractor’s or ex-employee’s capacity to be deployed within the enterprise.

You can a person’s work choices, such as their willingness to travel or relocate, their preferred working hours and work schedule, and the length of time they would like to stay in their next post. You can then compare these choices with the work requirements of jobs or positions when you are planning redeployment.

See: Entering Work Choices for a Job or Position: page 3 – 18
See: Entering Work Choices: page 13 – 21

Career Management Extensible and User-Defined QuickCodes

You can add, disable, or change the meaning of QuickCode for use in career management activities.

See: User and Extensible QuickCodes: page 32 – 6
The QuickCodes specific to career management activities include:

Competence Types
Define the competence types as values for the QuickCode Type COMPETENCE_TYPE.

Qualification Types
Define the types of qualifications as values for the QuickCode Type PER_CATEGORIES.
Appraisal Web Page

- Define appraisal statuses as values for the QuickCode Type APPRAISAL_ASSESSMENT_STATUS.
- Define appraisal types as values for the QuickCode Type APPRAISAL_TYPE.

Competencies

Define the competence evaluation methods as values for the QuickCode Type COMPETENCE_EVAL_TYPE.

Work Choices

- Define time scales as values for the QuickCode Type PER_TIME_SCALES.
- Define work schedules as values for the QuickCode Type PER_WORK_SCHEDULE.
- Define working hours as values for the QuickCode Type PER_WORK_HOURS.
- Define the full time equivalents as values for the QuickCode Type PER_FTE_CAPACITY.
- Define relocation preferences as values for the QuickCode Type PER_RELOCATION_PREFERENCES.
- Define lengths of service as values for the QuickCode Type PER_LENGTHS_OF_SERVICE.

Qualifications

- Define subject statuses as values for the QuickCode Type PER_SUBJECT_STATUSES.
- Define subjects as values for the QuickCode Type PER_SUBJECTS.
- Define tuition methods as values for the QuickCode Type PER_TUITION_METHODS.

Competence Profile

- Define certification methods as values for the QuickCode Type CERTIFICATION_METHOD.
- Define proficiency sources as values for the QuickCode Type PROFICIENCY_SOURCE.
Understanding The Business Cycle

The HR activities that use the competence approach within an enterprise can be depicted as a cycle such as the one shown in Figure 18 – 2. The main stages in the cycle are as follows:

1. Define business goals.
2. Define competencies needed to meet those goals.
3. Decide where you want to hold competencies in the enterprise structure (organization, job or position).
4. Assess person’s current level of competencies (perform multiple proficiency assessments) and update competence profile.
5. Perform skills gap analysis against current or future org, job or position requirements for:
   • filling existing jobs
   • succession planning
   • effective deployment
6. Propose action to close skills gap (training, qualifications, licenses, awards) – see which training delivers competencies.
7. Agree actions with employee (during appraisal):
   - set goals and objectives
   - sets expectations about proficiency levels and behavior
   - confirms steps to close skills gap – training, qualifications, licenses, awards

8. Evaluate – review appraisal.
   Sets performance – whether has met expected standard, goals, and objectives – overall performance.
   
   **Next Steps:**
   - rewards
   - incentives
   - career options

   Prepare employees for next position within a career plan.
Designing Methods of Measurement and Creating Competencies

This chapter explains how you design your methods of measurement and develop competencies as part of your performance management system.
Designing Your Methods of Measurement and Creating Competencies

Developing competencies as part of your performance management system enables you to evolve definitions that match the culture and needs of your enterprise, without different parts of the enterprise expending time and effort in evolving similar definitions.

A common framework for describing and assessing competencies speeds up markedly the deployment process within your enterprise. This is both cost-effective and desirable. Look at how quickly your managers can respond to new challenges when they can identify and select employees and applicants on a common basis. They can also match employees and applicants with opportunities that arise across the whole enterprise. The ability to perform global deployment effectively through a ‘virtual job market’ provides your enterprise with the competitive edge with deployment.

What Are Competencies?

Oracle Human Resources defines the term ‘competence’ as measurable behavior, specifically “any measurable behavior required by an organization, job or position that a person may demonstrate in the work context”. So, a competence can be:

• a piece of knowledge (such as the names of all the rivers in China)
• a skill (such as an interpersonal skill, widget turning, soldering a joint)
• an attitude (such as a proactive approach to work)
• an attribute (such as absence of color blindness or perfect pitch)

By defining measurable behavior, you can indicate what a person (for example, an employee, contractor, applicant) within an enterprise can do. Identifying how a competence is exhibited in the work context ensures your approach is objective rather than subjective, adding to employee understanding of what is expected of them. It also ensures fairness and equality of employment. Competencies clarify what is needed from both teams and individuals, especially when a major change within the enterprise is going on.

Competencies, Proficiency Levels and Indicators

Examples of competencies exhibited in the work context might be ‘communication skills’, ‘erecting and dismantling scaffolding’ or
On their own though, these competencies do not give you the full picture. For example, a person may be able to demonstrate the competence erecting and dismantling scaffolding, but that does not tell you how proficient a person is in that competence. For example, do they erect and dismantle scaffolding as a beginner, or as an expert? Other areas of ambiguity might include exactly what behavior is being measured. For example, the competence communication skills might mean that a person has technical, oral and written skills, or that they have the ability to communicate well.

Because of the flexibility of Oracle Human Resources, you are able to structure your competencies to design your methods of measurement to meet the needs of your enterprise. If most of the competencies within your enterprise are comprised of proficiency levels unique to individual competencies, you might want to create competencies with their unique proficiency levels. You would therefore have a number of equivalent systems for measuring performance. Alternatively, you can use the general method of measurement. Here, you do not hold the proficiency level at the competence level, but you use a general rating scale and text to describe the competence in a general way. You can, of course, use a mixture of both.

### Proficiency

To enable you to fully express how a competence is exhibited in the work context, Oracle Human Resources enables you to identify the proficiency at which a competence is performed, and the associated behavioral characteristics displayed (known as behavioral indicators). You can use behavioral indicators for any description that tells you or other managers what to look for in the work context. The text description can include what tests to use, what behaviors to detect, what questions to ask (for example, in a critical incident interview), when to review, and so on.

Figure 19 – 1 illustrates the descriptions, proficiency level and behavioral indicators for the competence Communication Skills.
Structuring Your Competencies

Oracle Human Resources enables you to structure your competencies in two ways:

- **individual method**
  
  You can attach the individual proficiency levels to each competence

- **general method**
  
  You can use a general proficiency scale, and enter text to describe the competence in a general way

**Individual Method**

Figure 19 – 2 illustrates the competence Erecting and Dismantling Scaffolding using the individual method to structure your competencies. Notice the unique proficiency levels and behavioral indicators.
Competence (Erecting and Dismantling Scaffolding)

Individual Method with its Proficiency Levels (and Behavioral Indicators)

1 – Novice: Can provide assistance, as a member of a team, in the general fetching and carrying of scaffolding components

2 – Beginner: Can, as a member of a team, erect and dismantle basic scaffolds constructed from preformed aluminum components

3 – Intermediate: Can, as a member of a team, erect and dismantle scaffolds constructed from preformed steel components

4 – Advanced: Can, as a member of a team, erect and dismantle basic tube and clip scaffolds

5 Expert: Can, as a member of a team, erect and dismantle advanced tube and clip scaffolds

General Method

Alternatively, you can use the general method of measurement to structure your competencies. For example, you might decide to use a general method of measuring ‘expertise’, such as Expert, Intermediate and Novice. To do this, you could create a general rating scale, called Expertise, and hold the generic proficiency levels here. Figure 19 – 3 illustrates a general rating scale with generic proficiency levels defined.
Which Method Should You Use?

We suggest you employ the following strategy. Use the individual method if most of the competencies within your enterprise comprise of proficiency levels unique to individual competencies. Then, you can create competencies with their unique proficiency levels, providing your enterprise with a number of equivalent systems for measuring performance. Alternatively, use a general rating scale if a number of competencies within your enterprise have a common set of proficiency levels. You can then ensure consistency between measurements.

You can, of course, use a mixture of both, but whatever method you use, ensure that you give high numbers to high ratings (and low numbers to low ratings). You need to do this, for example, to ensure any bar charts you produce while performing competence gap analysis are useful.

Imagine the flexibility of being able to use a general method to measure your core competencies, for example, and an individual method to measure specific job and position competencies throughout your global enterprise.
General Rating Scales

Create general rating scales if you want to describe your enterprise’s competencies in a general way. With a general method, you do not hold the proficiency level at the competence level. Instead, you use a rating scale and text to describe the competence in a general way. Look at the benefits provided by this level of consistency of measurement during assessment and appraisal across your whole enterprise!

The Relationship Between a Common System of Measurement

Figure 19 – 4 illustrates the relationship between competencies, and a general proficiency rating scale in a common system of measurement.

We suggest that you use the same rating scale measurements throughout, if you decide to use the common system of measurement in your enterprise. For example, if you use rating levels of 1 to 3 for one rating scale, stick to this scale if you set up many scales with different proficiency levels.

Different Rating Scales

You can create general rating scales for:

- proficiency
- performance
- weighting (level of importance)
A proficiency identifies the level at which a person exhibits a competence. For example, a scaffolder might be proficient at using a drill, or that a person is proficient at drilling a hole. A performance identifies whether the person has achieved the proficiency, for example, can they drill well or not.

Creating Default Rating Scales

You can make a specific general rating scale the default if you are going to link this rating scale to many competencies.

Using Attachments

You can add attachments to the rating scales, if required, for example, you can attach a competence description or a video of the skill.

Creating Rating Scales

Use the Rating Scales window to create general rating scales.

To create rating scales:

1. Enter a name and description for the rating scale, for example, Expertise.
2. Select the type of rating scale to create, for example, performance, proficiency or weighting.

3. Click the Default Rating Scale box if you want to make this rating scale the default, otherwise leave this box blank.

4. Enter the first level and description for the rating scale. For example, enter 1 in the Level field and **Novice** in the Name field.

5. Enter the behavioral indicator for that level. For example, Meets expectations.
   
   You can enter up to 2000 characters for each behavioral indicator.

6. You can add attachments to the rating scales, if required, for example, you can attach a competence description or a video of the skill.

7. Continue to enter levels and description for the rating scale then save your changes.
Competencies

We recognise that you’ll want to develop competencies that best meet the needs of your own enterprise. So, rather than providing you with predefined competencies that may be too prescriptive or too general, we enable you to develop your own. You might want to ‘pilot’ a small number of easily definable and measurable competencies first (for example, anything that requires physical effort such as digging a ditch or typing a letter), ensuring that the definitions are meaningful and relevant before rolling them out widely within the enterprise. Once you have developed these first competencies, you can go on to define competencies that are much more complex and difficult to observe and measure (for example, anything that includes cooperation with other people). You can, of course, have a mixture of both.

All competencies are held at the person level, in the Competence Profile.

Some enterprises also group competencies by the methods used to improve them, such as hireable or trainable competencies, and still others by their use in the enterprise, for example, core or technical.

You will have previously identified how you want to structure your competencies; if you are using the individual method, you need to set up the proficiency levels for each competence you create.

Retrieving the Right Proficiency Levels

Once you set up proficiency levels for a competence, Oracle Human Resources retrieves the right proficiency levels for you when you (or other users) perform any of the following tasks:

- set up competence requirements
- create or update a Competence Profile
- perform an assessment

This not only saves you time, but also ensures that you always select the right proficiency level for the task you are performing

Driving Alerts

Use Oracle Alert’s automatic mail notification to keep you informed when an employee’s competencies need certification and renewal. This frees your time for more essential tasks. For example, use the competence Renewal Period to drive Oracle Alert—it compares the renewal period date with the date on the person’s Competence Profile, or the last training class delivering the skill.
Creating Competencies

Use the Competencies window to create competencies

To create competencies:

1. Select the New button in the Find window.
2. Enter a name and description for the competence.
3. Enter the dates between which the competence is valid. You must enter a From date but you can leave the To date blank. If you enter a To date, ensure that it is wide enough to cover any competence elements you may need to create.
4. If you want to use a general rating scale to measure the competence against, go to Entering a Rating Scale: page 19 – 11. If you want to measure the competence against specific proficiency levels, go to Entering Proficiency Levels: page 19 – 12.

To Enter a Rating Scale

1. Click the Scale radio button to use a rating scale to measure the competence against.
2. If you set up a default rating scale, it displays automatically for this competence, otherwise select one from the list. You can delete the defaulted rating scale and select another one, if required.
3. Select the Levels box if you want to check the proficiency levels for that rating scale, otherwise go straight to Entering Competence Details: page 19 – 12.

![Levels - Erecting and Demolishing Scaffolding](image)

**To enter Proficiency Levels**

1. Click the Levels radio button to enter proficiency levels and behavioral indicators for the competence.

2. Select the Levels button and enter the first proficiency level and description. For example, enter 0 in the Level field and No Skill in the Name field.

3. Enter the behavioral indicator for that level, for example, 'No knowledge/expertise of scaffolding'. You can enter up to 2000 characters for each behavioral indicator.

4. Continue to enter proficiency levels and behavioral indicators, then go to Entering Competence Details: page 19 – 12.

**To enter Competence Details**

1. Select the main method of evaluating the competence, for example, written examination or observation.

2. Enter how often you need to evaluate the competence. For example, enter 5 if you have to evaluate the competence every 5 years.

3. Select the measure to identify how often you need to evaluate the competence. For example, select Year if you evaluate the competence every 5 years.
4. Click the Certification Required box if you need a certificate to confirm possession of the competence, for example, if you need proof of a driving license.

If you click this box, when you or another user later indicates that a person possesses this competence (using the Competence Profile), you must enter the certification method and date.

5. Save your changes.

**Querying a Competence Using the Find Competencies Window**

When you navigate to the Competencies window, the Find Competencies window automatically displays in front of it.

► **To query a competence using the Find Competence window:**

1. Do one or both of the following:
   - Enter a full or partial query on the competence name.
2. Choose the Find button.

Oracle Human Resources displays the competence for you to check.
Competence Types and Groupings

Because you might want to group related competencies together, Oracle Human Resources enables you to create competence types. This flexibility enables you to create competencies displaying complex behaviors, for example, management skills, or you can split management skills into several competencies, such as communication skills, presentation skills and oral skills. The degree to which competencies are grouped in this way is up to you!

Note: If you do not group competencies into types, Oracle Human Resources groups them under the type of Others for you.

Once you have grouped your competencies into types (or Oracle Human Resources groups them under the type of Others), you use them on the assessment template, by indicating which competence types and related competencies you want to include in specific assessments.

Grouping Competencies is Useful

Grouping competencies is also useful, for:

• advertising a vacancy and you want to include all ‘hireable’ competencies on a job advertisement
• competencies for a team
• reporting purposes
• enabling easier access to particular competencies

You measure and evaluate behavior that a person demonstrates at the competence level, and not at the competence type level.

Figure 19 – 5 illustrates related competencies grouped by type Management Skills.
You can also group a competence into more than one competence type. For example, the competence Oral Skills can be grouped into both the Management Skills and the Interpersonal Relationships competence type.
Where Do You Create Competence Types?

You create the competence types using the QuickCode COMPETENCE_TYPE, then you group competencies into types using the Competence Type window.

Deleting or Adding Competencies into Types

Once you have used a competence type in HRMS (in an assessment, for example), you can query back and view it, but you cannot delete or add competencies to that type. This ensures that you cannot accidentally delete or add competencies to groups in use.
Grouping Competencies into Types

Use the Competence Types window to group competencies

Prerequisite

- Ensure that you have created the competence types you require using the QuickCode COMPETENCE_TYPE.

To group competencies into types:

1. Query back the competence type under which you want to group competencies.
2. Select the first competence to group within the competence type.
3. Continue to enter competencies to group within the competence type, then save your changes.
Defining Competence Requirements

This chapter describes how you can define your competence requirements to enable your enterprise to meet its current and future goals.
Competence Requirements

To ensure your enterprise meets its current and future goals, you’ll need to identify your competence requirements. For example, if your goal is ‘to gain greater penetration in the applications market’, Oracle Human Resources enables you to quickly and easily identify the competencies that people within your enterprise need to possess and exhibit to meet that goal.

Defining your core (or management or leadership) competencies might be the first stage in developing a competence approach. These core competencies are identified as being required by every person to enable your enterprise to meet its goals. In our example, the core competencies required to meet the goal greater penetration in the applications market, might include strategic thinking, quality orientation and customer awareness. With Oracle Human Resources flexibility, you can define these core competencies at the business group or organization level.

Once you have identified your enterprise’s core competencies, you might want to define individual job and position competencies later, for example, C++ programming, SQL*Plus, and such. You can then copy the core competencies (with or without proficiency levels) to your organizations, jobs and positions. You can also copy required competencies to and from organizations, jobs and positions, saving you from having to enter them yourself!

The competence requirements held at business group, organization, job and position level are dated. With all this information at your fingertips, you can set them up for future requirements to perform analysis or resource projections for your enterprise. You can also project the impact of changes, such as reorganisation and restructuring, and change them over time.

One–Time Profiles for Suitability Matching

Not only can you create profiles for organizations, jobs and positions, but you can also create one–time profiles for many purposes. For example, you can create one–time profiles for a variety of activities such as for team building using the Suitability Matching Web page. You can search for and rank candidates using this functionality.
Why Define Competence Requirements?

You can define your enterprise’s competence requirements at the following levels:

- business group
- organization
- job
- position
- one-time profiles (for suitability matching)

You define your core and job and position competence requirements to enable you to compare what competencies the people within your enterprise possess, with those that are required. You need to do this as comparison is the main driver for most HR activities, whether deployment, reward, incentives, succession planning, and so on.

By having a profile of competence requirements, you can devise an appropriate assessment procedure, and assess individuals against the competencies for selection, qualification or training and development purposes.

By having a template of required competencies, you are able to match and assess people against these requirements. As the required competencies are only the default, you use these as a starting point in the search, and can change them to widen or narrow down the search.

Retrieving Relevant Competencies

If you group all competencies required at business group or organization level, then each time you select a specific organization or job, the relevant competencies automatically display, saving you from having to select them each time.

You can hold competencies at position level, within the context of an organization and job. Then, when you later select a position, the relevant competencies for the organization, job and position are inherited and displayed. Alternatively, you can hold competencies at position level only, not within the context of an organization or job.

This is one of the important implementation decisions – whether to hold competencies at organization or job level, or to repeat them at position level.

If you need more information about identifying competence requirements, see Competence Types and Groupings: page 19 – 14.
Can You Copy Competencies?

You can copy the core competencies and proficiency levels to the organization, job or position, saving you time. You can then make changes to the competencies, if required, for example, change the proficiency levels, enter a grade, or change the dates between which the competence is valid.

You can also copy competencies and proficiency levels from organizations, jobs or positions to other organizations, jobs or positions. This enables you to quickly and easily to define your enterprise’s competence requirements.

Retrieving the Correct Proficiency Levels

When you are setting up your competence requirements for an organization, job or position, Oracle Human Resources retrieves the correct proficiency levels (defined when you created the competence). This ensures that you always select the right proficiency level for the competence.

Defining Essential Competencies and Different Grades

You can identify whether a competence is essential by an organization, job or position, or whether is optional. If you indicate that a competence is essential, when you later perform suitability matching, only the people who possess the competence at the specified proficiency level are retrieved in the search.

You can also identify different competencies for different grades, each with their accompanying proficiency levels. This enables you to keep a history of the competencies for an organization, job, position or grade over time.
Defining Competence Requirements – Core or Generic Competencies

Use the Competence Requirements window to define your competence requirements with core or generic competencies.

To define competence requirements (with core or generic competencies)

1. Select the business group for which you want to create competence requirements.
2. Select the Find button. Oracle Human Resources retrieves competencies if you have previously defined them as required for the business group, otherwise it retrieves nothing.
3. Press Clear Record after you have looked at the existing competencies.
4. You can now do the following:
   - Create Competence Requirements for the Business Group: page 20 – 5
   - Copy Existing Core Competencies to an Organization, Job or Position: page 20 – 6

Create Competence Requirements for the Business Group

1. Select the first competence.
2. Select the highest and lowest proficiency levels at which the competence is acceptable, if required.
If you are going to copy these requirements to an organization, job or position, you can choose not to copy these proficiency levels over.

3. Check the Essential check box if the competence is essential for this business group, otherwise, leave the box unchecked.

   **Note:** Only enter a grade if you are creating competence requirements for a job or position.

4. Enter the dates between which the competence is valid for this business group. You must enter a From date but you can leave the To date blank.

5. Continue to enter competencies for the business group, then save your changes.

**Copy Existing Core Competencies to an Organization, Job or Position**

1. Clear the details from the Business group before you copy the competencies.

2. Select the organization, job or position to which you want to copy the core competencies and press the Find button.

3. Select the Copy Competencies button. A Copy Competencies window appears.

4. Leave the Core Competencies box checked.

5. If you want to copy the proficiency levels, leave the Copy Levels box checked, and enter the dates between which the competence is valid (you must enter a From date but you can leave the To date blank). If you do not want to copy the proficiency levels, uncheck the box.

6. Select the Copy button, and Oracle Human Resources copies the competencies to the organization, job or position.

7. You can make changes to the competencies copied over, if needed, such as:
   - deleting any of the core competencies that are not required by the organization, job or position
   - changing the proficiency levels
   - checking or unchecking the Required check box
   - entering a grade (for a job or position only)
   - changing the dates between which the competence is valid

8. Save your changes.

9. You can now add further competencies for the organization, job or position, see Create Competence Requirements for the Business Group: page 20 – 5.
Copying Existing Competencies from an Organization, Job or Position

Use the Competence Requirements window to copy competencies from an organization, job or position.

**Copying the competencies from an organization, job or position**

1. Select the organization or job to which you want to copy the competencies. If you are copying competencies to a position, you must also select the organization and job to which the position belongs.

2. Select the Find button.
   Oracle Human Resources retrieves any competence requirements previously created.

3. Select the Copy Competencies button. A Copy Competencies window appears.

4. Uncheck the Core Competencies box. The organization, job and position fields are now active.

5. Select the organization, job or position from which you want to copy the competencies.

6. If you want to copy the proficiency levels, leave the Copy Levels box checked, and enter the dates between which the competencies are valid (you must enter a From date but you can leave the To date blank). If you do not want to copy the proficiency levels, uncheck the box.

7. Select the Copy button, and Oracle Human Resources copies the competencies.

8. You can make changes to the competencies copied over, if needed, such as:
   • deleting any of the core competencies that are not required by the organization, job or position
   • changing the proficiency levels
   • checking or unchecking the Required check box
   • entering a grade (for a job or position only)
   • changing the dates between which the competence is valid

9. Save your changes.

10. You can now add further competencies for the organization, see Create Competence Requirements for the Business Group: page 20 – 5.
Defining Competence Requirements – No Core Competencies

Use the Competence Requirements window to define your competence requirements with no core or generic competencies.

To define competence requirements (no core competencies)

1. Select the organization or job for which you want to create competence requirements. If you are creating competence requirements for a position, you must also select the organization and job to which the position belongs.

2. Select the Find button.

   Oracle Human Resources retrieves competencies if you have previously identified them as required, otherwise it retrieves nothing.

3. Select the first competence.

4. Select the highest and lowest proficiency levels at which the competence is acceptable, if required.

   If you are going to copy these requirements to other organizations, jobs or positions, you can choose not to copy these proficiency levels over.

5. Check the Essential check box if the competence is essential, otherwise, leave the box unchecked.

6. Select the grade (for a job or position only), if required.
7. Enter the dates between which the competence is valid. You must enter a From date but you can leave the To date blank.

8. Continue to add further competencies for the organization, job or position, if required.
Viewing Competencies at Organization, Job or Position

Use the Competence Requirements window to view competencies held at organization, job or position level.

To view competencies held at organization, job or position level:

1. Select the business group, organization, job or position for which you want to view competencies,
2. Click the Find button.
Chapter 21

Identifying Qualifications and Delivering Competencies

This chapter explains how you can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. It also describes how you can record qualification methods, such as a license or a test, and enter the qualifications that your enterprise recognises.
Identifying Qualifications and Delivering Competencies

Competencies can have identified qualification methods, such as a license or a test. You can enter the qualifications that your enterprise recognises to include only the ones that you want in a person’s Competence Profile.

Delivering Competences Through Training Activities (Oracle Training Administration)

You can deliver competencies at a specific proficiency level through training activities your enterprise (or an outside supplier) provides. A training activity is an abstract term for any planned undertaking that improves a student’s competencies (qualifications, experience, and so on).

You can enter the competencies and proficiency levels that your training activities are expected to deliver using the Delivered Competencies window. You can then update a person’s Competence Profile after they have successfully gained the competence.

*Note:* You must purchase Oracle Training Administration (OTA) separately to use this functionality.

See: Using Competencies or Skills, *(Oracle Training Administration User’s Guide).*
Creating Qualification Types

Competencies can have identified qualification methods, such as a license or a test, for example, a life-saving qualification or a degree. You can enter all the ones your enterprise recognises, this includes:

- all educational qualifications
- licenses
- awards
- honors

Not only can you enter different types of qualifications, but you can also rank them, if required. For example, you could rank a masters degree as 1, a degree as 2, ‘A’ levels as 3, and so on. You can also rank equivalent qualifications at the same level. For example, you can rank a degree and a BTEC Higher as level 2. This is useful, for example, if you later want to do an ad hoc query and find all people within the category of Education, with a qualification of 2 or above.

Prerequisites

You’ll need to enter the following QuickCode:

- Define the types of qualifications as values for the QuickCode Type PER_CATEGORIES.

![Qualification Types window](image)

Use the Qualification Types window to create your qualifications.

- **To create qualification types:**
  1. Enter the name of the qualification, for example, a Masters degree.
  2. Select the type of qualification, for example, educational, honorary.
3. Rank the qualification, for example, 1 for a Masters degree, if required.

4. Continue to enter and rank qualifications, then save your changes.
Creating Schools and Colleges

You need to identify schools and colleges that deliver the qualifications your enterprise recognises. These are then used to record where a person gained the qualification. If you have not automatically loaded these schools and colleges into Oracle Human Resources, you can enter them manually.

You can also record the different sites or locations that comprise an establishment. This is useful, for example, where an establishment has several sites, colleges, campuses or locations.

**Note:** Schools and colleges you enter are available to all Business Groups you create, therefore only load or enter them once.

Use the Schools and Colleges window to enter your establishments.

To create establishments:

1. Enter the name of the establishment.
2. Enter the name of the location.
3. Continue to enter establishments, then save your changes.
Assessing and Appraising People

This chapter explains how you set up Oracle Human Resources to enable you to assess and appraise your enterprise’s employees.
Assessing and Appraising People

An assessment is an information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. An appraisal is a ‘superset’ of recording opinions and setting and achieving objectives, plans, and so on.

Assessing and appraising your enterprise’s employees are key areas of human resources management. To ensure you have the right people in place at the right time, you’ll want to find out what competencies your employees (applicants, and so on) possess, and at what level they demonstrate them. This provides a snapshot that allows study, analysis, and evaluation.

By tightly integrating assessment and appraisal with the performance management process, both individual and enterprise performance are strengthened. You’ll find that your employees are more willing to change their behaviors as they feel committed to, and understand how their efforts make an impact on the big picture. So, using Oracle Human Resources, assessment and performance appraisal produces informed, motivated employees, committed to improving the effectiveness of their performance—in short, improving their productivity.
Competence–Based Assessments

An assessment is an information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. Through the web and workflow–based access, managers and employees can measure and record a score of how the person has performed against each competence. This provides clear and accessible measures, for example, ‘Is the person demonstrating the specified behavior at the level defined?’ or ‘Does the person have the knowledge or skills required to operate effectively?’

Some assessments will simply ask one or more people to rate a person according to some agreed scale, in other cases, questionnaires may be devised that ask about different aspects of the person’s work.

Proficiency– and Performance–Based Assessments

In Oracle Human Resources, we use the term proficiency–based assessment to express the perceived level of expertise of a person, in the opinion of the assessor, over a given period. For example, a person may demonstrate communication skills at Expert level. We use the term performance–based assessment, however, to measure an expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence.

Why is Measurement Useful?

Once you have measured how people have performed against each competence, and at what level, you are ready to record applicant and employee accomplishments in the Competence Profile. You can keep the profile up–to–date by entering results when an employee first joins the enterprise, and then after each assessment or appraisal. Through the web and workflow–based access, employees are involved in the process of planning, managing and reviewing their own progress.

Once your employee competencies and proficiency levels are held in Competence Profiles (and job requirements in their own profile), you can use the information to analyse visually which competencies a person (or group of people) possess, and which competencies are required by jobs or positions now, or in the near future. You can use the results of the Competence Gap processes to identify areas where you need to recruit or train employees, and so on. You can also affect motivation by various types of incentive, whether monetary– or opportunity–based.
Once you have assessed measurable behavior, you can change it!

**Templates for Different Assessments**

To enable you and other users to perform assessments using the web, Oracle Human Resources enables you to create assessment templates for all the different assessments your enterprise performs. Examples of the types of assessment you might want to perform include:

- 360 Degree (where a manager, direct or indirect reports, peers and customers provide feedback on aspects of a person’s performance)
- self-assessment (by employee or applicant)
- peer or team assessment
- job skills assessments (for example, Engineer Grade 1, Junior Typist, and so on)

Once you have created assessment templates, assessors can work online through Line Manager Direct Access to identify employee performance or proficiency. They can enter or update assessments, without your intervention or involvement being required.

**Tailoring the Layout**

Not only can you create templates for the different assessments, but you can also tailor the actual layout of the assessment page to meet the needs of your enterprise. For example, you can identify:

- the type of assessment you are performing, for example, performance or proficiency
- the competence types and competencies against which to assess, and the sequence in which you want them to appear.
- the instructions to be displayed to the assessor(s) or approver(s)
- how you want to calculate the total scores

**What Type of Assessment do you Want to Perform?**

You can set up assessment templates for each type of assessment you want to perform, for example, job skill assessments for Scaffolders, Engineers at Grade 1, Junior Typist, and so on. By measuring
competencies grouped into an assessment (for example, a Managerial or Engineering assessment), you focus attention on behaviors and the ability of an individual to get things done.

Another decision that you need to take is whether you want to perform proficiency or performance assessments. A proficiency assessment measures the expectation of the level to which a person exhibits a competence. For example, in an Engineering Grade 1 assessment you might assess that a person is proficient at using a drill, or that a person is proficient at drilling a hole. You also set future expectations, for example, that within the next 6 months, they will have achieved proficiency in milling. A performance assessment measures whether the person has achieved the proficiency, for example, can they drill well or not. You can also rank performance, for example, on a scale of 1–5.

You can create assessment templates for:

- Proficiency
- Proficiency and Performance
- Proficiency and Performance, with Weighting applied to Performance
- Proficiency and Performance, with Weighting applied to proficiency
- Proficiency with Weighting applied to proficiency
- Performance
- Performance with Weighting applied to performance

Because some enterprises will want to carry out performance assessments only (just rating that a person has achieved a specific competence), while other enterprises will want to carry out two step processes (proficiency assessments to set expectations first before assessing performance), Oracle Human Resources enables you to assess proficiency and performance, in a two stage process.

What Do You See?

By identifying the type of assessment you are performing in the template, users of the Web assessment pages only get the headings and fields to complete appropriate to that type of assessment. For example, if you want to create an assessment template for a Scaffolder, of the type Proficiency, they might get the following headings and fields to complete on the assessment Web page:
If you want to create an assessment template for a Scaffolder, of the type Proficiency and Performance, with Weighting applied to Performance, users might get the following headings and fields to complete:

If you want to create an assessment template for a Scaffolder, of the type Proficiency and Performance, with Weighting applied to Performance, users might get the following headings and fields to complete:

Identifying Proficiency Levels in the Assessment Template

When you are setting up templates for any type of proficiency–based assessment, you have previously identified the proficiency levels or a rating scale with which to measure competencies. So you do not need to identify the performance scale, Oracle Human Resources already knows it. If you are setting up templates for any type of performance–based assessment, you need to indicate the performance scale to use in the assessment.

Entering Instructions

You can also enter the instructions to be displayed to the assessor(s) or approver(s) completing the assessment on the web page.

You can format the text to appear exactly as you want it. You can enter up to 2000 characters for each assessment type.

Identifying Competence Types and Competencies in the Assessment Template

Once you identify the type of assessment you are performing, you’ll want to identify the competence types and competencies against which
to assess. When you are first setting up your assessment templates, all
the competence types and competencies you previously created within
your enterprise are available for you to select from.

Not only can you identify which competence types and related
competencies to include in the assessment, but you can also indicate the
sequence in which you want them to appear on the assessment page.
This gives you complete control over the layout. (If you do not sequence
the competencies or types, they appear on the assessment Web page in
the order they appear in the template).
Calculating Scores in the Assessment Template

When you perform an assessment for a person, you record a score against each competence (within the framework of a job or position). Oracle Human Resources gives you the freedom to calculate the scores in a variety of ways to fully meet the needs of your enterprise. For example, you might want to calculate the scores just by taking performance against the competencies into consideration, or you might want to calculate the scores by taking performance, proficiency and weighting into consideration, and to apply the weighting to proficiency. (You can of course, only apply weighting to performance or proficiency, not to both.)

To make it easier for you, we provide several assessment types for you to choose from. These are:

<table>
<thead>
<tr>
<th>Assessment Type</th>
<th>Calculates Score By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance</td>
<td>Performance</td>
</tr>
<tr>
<td>Proficiency</td>
<td>Proficiency</td>
</tr>
<tr>
<td>Proficiency and Performance</td>
<td>Proficiency x Performance</td>
</tr>
<tr>
<td>Proficiency and Performance, with Weighting applied to performance</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>Proficiency and Performance, with Weighting applied to proficiency</td>
<td>Proficiency x Weighting</td>
</tr>
<tr>
<td>Performance with Weighting applied to performance</td>
<td>Performance x Weighting</td>
</tr>
<tr>
<td>Proficiency with Weighting applied to proficiency</td>
<td>Proficiency x Weighting</td>
</tr>
</tbody>
</table>

We provide you with a couple of examples to illustrate how the scores vary, depending upon how you calculate them.

**Example 1: Proficiency with Weighting Applied to Proficiency**

Figure 22 – 3 illustrates the scores where an assessment based on proficiency, with weighting applied to proficiency.

![Figure 22 – 3](image)

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>5</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>Presentation Skills</td>
<td>5</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Oral Skills</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>
Example 2: Proficiency and Performance with Weighting Applied to Performance

Figure 22 – 4 illustrates an assessment based on proficiency and performance, with weighting applied to performance.

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Performance</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>5</td>
<td>2</td>
<td>5</td>
<td>10</td>
</tr>
<tr>
<td>Presentation Skills</td>
<td>5</td>
<td>3</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>Oral Skills</td>
<td>3</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Calculating the Total Score

You can choose one of two methods to calculate the total score for the assessment. You can also use these total scores to rank groups of candidates, for use in compensation.

You can choose to calculate the total score by:

- sum total
- average total

Figure 22 – 5 illustrates an assessment based on proficiency, with weighting applied to proficiency. The total score is calculated as a sum total.

If you calculated the total score as an average total instead (25 + 10 + 3, divided by 3), the total score would be 16 rather than 38.

<table>
<thead>
<tr>
<th></th>
<th>Proficiency</th>
<th>Weighting</th>
<th>Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication Skills</td>
<td>5</td>
<td>5</td>
<td>25</td>
</tr>
<tr>
<td>Presentation Skills</td>
<td>5</td>
<td>2</td>
<td>10</td>
</tr>
<tr>
<td>Oral Skills</td>
<td>3</td>
<td>1</td>
<td>3</td>
</tr>
</tbody>
</table>

Total Score 38

Changing or Deleting an Assessment Template

If a template is not yet in use, you can delete it, or you can make any changes to it that you require. For example, you might want to change the dates, or to include more competence types and competencies.
Oracle Human Resources prevents you from deleting template that are in use, or from making changes to important information. This provides a safeguard against accidental deletion or change. However, you can enter an end date to terminate an assessment template, if needed, or you can change non-important details, such as:

- the name of the template and description
- any instructions

You can tell if the template is in use, because once it is, the system automatically checks the Used by Assessment check box for you.

Creating Templates for Competence-Based Assessments

Use the Assessment Template window to create templates for competence-based assessments.

To create an assessment template:

1. Enter a name and description for the assessment you are setting up. You can enter up to 85 characters for the name.

2. Enter the instructions to be displayed to the assessor(s) or approver(s). For example, “Complete all parts of the assessment before passing it on to the next person in the chain”.

![Assessment Template Window](image-url)
You can format the text to appear exactly as you want it. (Do you write in HTML?) You can enter up to 2000 characters for each assessment type.

3. Enter the dates between which the assessment template is valid. You must enter a From date but you can leave the Until date blank.

4. Select the type of assessment template you are creating, for example, proficiency with weighting applied.
   When you are setting up templates for proficiency–based assessments, as you have previously identified the proficiency levels or a rating scale with which to measure competencies, Oracle Human Resources already knows it, so it greys out the Performance Scale fields. If you are setting up templates for any type of performance–based assessment, however, you need to indicate the performance scale to use in the assessment.

5. For any type of performance–based assessment, select the performance scale for use in the assessment.
   You can click the Performance Scale button to see the proficiency levels for that scale, if required.

6. Enter any comments in the Comments field, if required.

7. For all type of assessment, select the weighting scale for use in the assessment, if required.
   You can click the Weighting Scale button to see the level of importance, if required.

8. Enter any comments in the Comments field, if required.

9. Select the method for calculating the total score, by sum or average total.

10. Save your changes.

11. You can now select your competence types and competencies.
Selecting Your Competence Types and Competencies

1. Click the Competencies button to select the competency types and competencies to include in the assessment. Query back all competency types and competencies for you to select from.

2. With the first competence type displayed in the Competence Type field, scroll through them until the first competence type you want to include appears, then click the Used box.

3. You can also indicate the sequence in which you want the competence type to appear on the assessment in the Sequence field. (If you do not sequence the competence types, they appear on the assessment Web page in the order they appear here).

4. Continue to scroll through the competence types, indicating the sequence in which you want the competence type to appear until you have selected all the ones you want to include.

   **Suggestion:** We suggest that you select all the competence types you want to include first, before you select the competencies.

5. Click the Saved Competence Types Only box to retrieve in future only the competence types you are using. We suggest that you do
this, otherwise, you will have to scroll through all the competence types from which to select the competencies.

6. Save your changes, and requery the competence types you have selected. Only the competence types you have selected are now displayed.

7. With the first competence type and competencies for that type displayed, click the Used box for each competence you want to include in the assessment.

8. You can also indicate the sequence in which you want the competencies to appear on the assessment in the Sequence field. (If you do not sequence the competencies, they appear on the assessment Web page in the order they appear here).

9. Save your changes.

10. Continue to scroll through the competence types, selecting and saving competencies, and indicating the sequence, until you have selected them all.

11. You can click the Saved Competencies Only box to display only the competencies you have selected in future, otherwise leave this box unchecked.

12. You can leave the Saved Competence Types Only box checked to display only the competence types you have included in the assessment the next time you use this window, or you can uncheck the box to display all competence types.
Appraisals

In Oracle Human Resources, an appraisal is the part of the performance management process where the enterprise translates its corporate objectives into individual performance and improvement goals and measures. An appraisal is the whole process where a manager and person jointly evaluate the person’s performance, in terms of competencies, against the work they have been doing, as well as setting objectives and actions.

An appraisal links:

- into precise job definitions and enterprise objective setting
- training recommendations
- individual development plans for competence improvements and deployment preferences
- the pay system, in terms of making performance ratings which can be used as the basis for pay

An appraisal enables you to hold any additional data, such as a person’s strengths and weaknesses or any comments, to meet your enterprise’s needs.

Appraisals set the following:

- goals in terms of new work to be performed and new goals for existing work
- new performance criteria against which to appraise during the next review period
- action plans to improve the competencies required to carry out work (where the work has both required and desirable competencies to meet the performance criteria)

An appraisal can be linked to an assessment, or to many assessments, as part of the appraisal exercise.

Appraisal Templates and Questionnaire Pages

Oracle provides you with a Web–based interface for performing appraisals, and with a number of example appraisal templates that you can modify. We also provide you with an easy to use method of designing and formatting your own questionnaire pages for the appraisal. You can identify the questions to use in the appraisal, and the number, size and type of boxes in which to record the answers. You can
create as many different appraisal questionnaire pages as your enterprise requires.

You can create new pages directly or by copying questions from existing pages. For example, if you created an appraisal questionnaire page for junior grades within your group, you can copy these to a questionnaire for more senior grades, and just add the extra questions. This saves you time, and ensures that you don’t make mistakes.

**Appraisal Template**

You’ll also want to create your enterprise’s appraisal templates. You use the template to:

- provide instructions to appraisers about completing the appraisal, for example, what the reviewers should do
- identify which questionnaire (and questions) belong to which appraisal
- identify which performance rating scale to use

You can use one of the example appraisal templates we provide and modify them to suit your own needs, or you can create your own.
1. To create your questionnaire pages, see: Create Your Appraisal Questionnaire Pages: page 22 – 18
   - Creating the Questionnaire: page 22 – 23.
   - Assembling the Categories Within the Questionnaire: page 22 – 25.

2. To enter your appraisal quickcodes, see: User and Extensible QuickCodes: page 32 – 6

3. To create or modify your appraisal template, see: Creating or Modifying an Appraisal Template: page 22 – 31
4. To perform an appraisal, see the online help on the Appraisal Web page.
Create Your Appraisal Questionnaire Pages

We suggest that you first identify the text headings and questions that you want to appear on the questionnaire. You can sketch them out on some paper, playing around with the positions and formats before you enter them into the application. You can also identify how you want to record the answers. For example, do you want to record the answers as text or as ticks in checkboxes?

Example Appraisal Questionnaire Page

Figure 22-7 provides an example appraisal questionnaire showing text headings, questions and areas in which you might want to record answers.
Once you identify how you want the text, questions and answer areas specified, you are ready to create your appraisal questionnaire page.

For example, if you want the heading text *Overall Assessment*, *Areas for Development and Improvement*, *Strengths and Improvement Areas* and
Development Actions Resulting From Performance Review to appear on a questionnaire, you identify them as categories.

Notice that the text Strengths and Improvement Areas and Development Actions Resulting From Performance Review are minor headings under Areas for Development and Improvement. Although the four pieces of text are all headings (categories), you can treat these smaller, minor headings as sub–categories in Oracle Human Resources. Any category can act as a parent for child categories, which means that you can create headings with several levels.

The example below shows how categories and sub–categories (minor headings) are entered in the application to create the questions page illustrated in Figure 22 – 7.

Example

<table>
<thead>
<tr>
<th>Questionnaire</th>
<th>General Appraisal</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Category</td>
<td>Overall Assessment</td>
</tr>
<tr>
<td>Second Category</td>
<td>Areas for Development and Improvement</td>
</tr>
<tr>
<td></td>
<td>First Sub–Category: Strengths and Improvement Areas</td>
</tr>
<tr>
<td></td>
<td>Second Sub–Category: Development Actions Resulting from Performance Review</td>
</tr>
</tbody>
</table>

You can also enter helpful text alongside the category or sub–category, if you want. For example, you might want the text ´(Within next six months) to appear alongside the category Areas for Development and Improvement. This type of text is known as a sub–heading.

Questions and Your Answer Format

You’ll need to create the questions to use in appraisals. You can create default questions that you can use in lots of different questionnaires, for example, ´Please summarise your views of the appraisee’s performance against objectives’, or you can create unique questions to use in a specific questionnaire, for example, ´Does the person relate well to customers?’. You can, of course, have a mixture of both types of questions.

If you are creating default questions, you specify default text that you can make more specific for particular questionnaire you are using.
You’ll also want to define your answer format. By defining your format, you indicate how you want the answers to be recorded on the questionnaire. You have four choices:

- text
- text area
- checkbox
- options (a list of values)

Figure 22 – 8 illustrates the four different layouts you can choose to record your answers. You can mix layouts, and you can size and position your answers to suit your enterprise’s needs.

You can also include a help button next to the answer—then, when the appraiser clicks the help button, help text you define displays.

**Note:** If you want to use lists to record answers, you can use a lookup table to display the list of values, or your system administrator must enter a SQL Select statement to retrieve the list.
The Questionnaire

The categories, sub-categories, sub-headings, questions and answers are all held in a container called the questionnaire. It is this questionnaire that you link to the appraisal template.

Figure 22 – 9 shows an example questionnaire using text (categories and sub-categories), sub-headings, questions and answers.
Creating the Questionnaire

Use the Define Questionnaire page to create the questionnaire which contains the categories, sub-categories, sub-headings, questions and answer layouts.
For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 22 – 18.

To create the questionnaire:
1. In the main menu, choose Define Questionnaire.
2. Click the New button to create the questionnaire.
   Entry fields display for up to three questionnaires.
3. Enter the questionnaire name and description.
   In our example, enter General Appraisal, and General appraisal for all employees.
4. If you previously created a questionnaire containing similar categories and questions, you can copy the categories and questions to the new questionnaire. Select the questionnaire from the Copy From field and click the Save button.
5. When you’re done, click the Save button.

Creating Categories

Use the Manage Categories and Questions page to create and maintain the heading text you want to appear on your appraisal questionnaire.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 22 – 18.

To create categories:
1. In the main menu, choose Manage Categories and Questions.
2. Click the New button to create the categories (heading text and sub–headings).

   Suggestion: You can only create up to three categories at a time. Once you have entered the third category, click the Save button and click the New button again to enter further categories.
3. Enter the categories to include on the questionnaire.
   In our example, this is Areas for Development and Improvement, Overall Assessment, Strengths and Improvement Areas, and Development Actions Resulting From Performance Review.
4. Enter any special details or conditions in the Heading Text field alongside the category where you want it to appear.
In our example, ‘within 6 months’ appears alongside the category Areas for Development and Improvement.

5. When you’ve done, click the Save button.

---

**Assembling the Categories Within the Questionnaire**

Use the Assemble Questionnaire page to assemble the categories within the questionnaire. You can update the questionnaire, if required.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 22 – 18.

❖ **To assemble categories within the questionnaire:**

1. Select Assemble Questionnaire from the main menu.
2. Select the questionnaire you created within which you want to assemble the categories.
3. Click the New button to assemble the new categories.
4. Select the first category you want to display on the questionnaire in the Category Name field.
   
   In our example, this is Overall Assessment.
   
   **Note:** Do not enter a category in the Parent Category field unless you are entering minor headings (sub-categories). If you want to enter minor headings, see Entering Minor Headings: page 22 – 26.

5. Enter 1 in the Parent Display Order field if you want this category to be the first one displayed on the questionnaire.
6. Enter 1 in the Category Display Order field if you want this category to be the first one displayed on the questionnaire.
7. Leave the Display Category Header set to Yes if you want the category to be displayed on the questionnaire.
8. When you have assembled up to three categories, click the Save button.

❖ **To enter further categories:**

1. Click the New button again after assembling the previous three categories.
2. Enter details of further categories in the same way as before.
3. Increment the number in the Parent Display Order field by one to indicate the order in which you want the category to display on the questionnaire.

For example, enter 2 in the Parent Display Order field if you want the category to display second, enter 3 if you want it to display third, and so on. Enter 1 in the Category Display Order field as you want this category to be the first displayed for the second category.

In our example, select Areas for Development and Improvement (in the Category Name field), enter 2 (in the Parent Display Order field), enter 1 (in the Category Display Order field) and Leave the Display Category Header set to Yes.

4. Click the Save button when you have entered all the categories you want.

5. Click the Layout button to see all the categories for this questionnaire.

To enter sub–categories:

1. To enter minor headings (sub–categories), move to the next blank line and select the parent category under which you want to display the heading in the Parent Category Name field.

In our example, select Areas for Development and Improvement (because this is the category under which you want to display Strengths and Improvement Areas and Development Actions Resulting from Performance Review).

2. Select the sub–category you want to display beneath the parent category in the Category Name field.

In our example, select Strengths and Improvement Areas.

3. Leave the Parent Display Order field blank.

4. Enter the order in which this sub–category displays under the parent category.

In our example, enter 2 in the Category Display Order field. This is because the parent category (Areas for Development and Improvement) is the main heading and Strengths and Improvement Areas is second.

5. Leave the Display Category Header set to Yes.

If you have other sub–categories to include in the questionnaire, continue to enter them as described above, but continue to leave the Parent Display Order field blank, and increment the Category Display Order field by one.
In our example, select Areas for Development and Improvement in the Parent Category Name field then select Development Actions Resulting from Performance Review in the Category Name field. Leave the Parent Display Order field blank and enter 3 in the Category Display Order field. Leave the Display Category Header set to Yes.

6. Click the Save button when you have entered all the categories you want.

7. Click the Layout button to see all the categories for this questionnaire.

---

**Defining Answer Layout and Creating Questions**

Use the Define Answer Layout page to name your questions and to define how you want the answers to questions to be recorded. For example, you can create text answer boxes, checkboxes, and such. Once you have named your questions and defined your answer layout, you can create your questions.

For an overview of creating appraisal questionnaires, see: Create Your Questionnaire Pages: page 22 – 18.

**To define an answer layout:**

1. In the main menu, choose Define Answer Layout.

2. Click the New button to name your questions and to define the answer layout.

3. Enter the name of a question in the Question Name field. You can name them anything you like, but we suggest that you make them something meaningful.

   In our example, we named the questions:

   - HR1PLEASSUM (for ‘Please summarise your views of ……”

   - HR2OVERENTOBJ (for ’Overall Enterprise Objectives”

   - HR3BUSUNTOBJ (for ’Business Unit Objectives”

4. Enter the question in the Text field only if you are creating a default question, otherwise enter your questions later (described in Creating Questions: page 22 – 30).

5. Specify how you want answers to be recorded by creating any or all of the following:
• Text Areas: see page 22 – 28
• Text: see page 22 – 28
• Checkboxes: see page 22 – 29
• Options: see page 22 – 29

6. When you have finished defining your answer layout, see: To create questions: page 22 – 30

► **To create text areas:**

If you want text areas for recording answers:

1. Select Text Area as the HTML Type.
2. Enter the width and height of the text area. These are columns (in our example, we used a width of 60 and height of 5).
3. Select whether you the answer box to align to the left or right hand side of the questionnaire (select right for our example).
4. Optionally, you can enter any heading text that you want to display above the question in the Heading Text field.
5. Enter any field level help you want made available for the user.
6. Continue to enter any further text area boxes and click the Save button.
7. Continue defining your answer layout at Step 4: page 22 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

See: To create questions: page 22 – 30

► **To create text:**

If you want text for recording answers:

1. Select Text as the HTML Type.
2. Enter the width and height of the text box (a width of 15 and height of 1 is a good default)
3. Select whether you want the text box to align to the left or right hand side of the questionnaire.
4. Optionally, you can enter any heading text that you want to display above the question in the Heading Text field.
5. Continue to enter any further text boxes and click the Save button.
6. Enter any field level help you want made available for the user.
7. Continue defining your answer layout at Step 4: page 22 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 22 – 30

**To create checkboxes:**

If you want checkboxes for recording answers:

1. Select Checkbox as the HTML Type.
2. Leave the width and height fields blank.
3. Select whether you the answer box to align to the left or right hand side of the questionnaire.
4. Enter any field level help you want made available for the user.
5. Continue to enter any further checkboxes and click the Save button.
6. Continue defining your answer layout at Step 4: page 22 – 27 When you have finished defining your answer layout, create questions for your questionnaire.

   See: To create questions: page 22 – 30

**To create options with lists:**

If you want to use lists to record answers, you can either use a lookup table to display the list of values, or you must enter a SQL Select statement to retrieve the list. You can also use the list of values to link a person’s career path into the appraisal process. You do this by creating a list that contains the alternative career paths that can be selected for the person during their appraisal.

*Using a lookup table*

1. Select Option as the HTML Type.
2. Leave the width and height fields blank.
3. Select whether you the answer to align to the left or right hand side of the questionnaire.
4. If the question has a default value that is not defaulted from the list of values, enter a value.
5. If the question has a default value, select either the type of Value to use the value entered in the Default Value field. Alternatively, select SQL to use the value defaulted from a list of values and enter a Select statement to select the value in the Find field.
6. Enter any field level help you want made available for the user in the Field Level Help field.

7. Continue defining your answer layout at Step 4: page 22 – 27 When you have finished defining your answer layout, create questions for your questionnaire.
   See: To create questions: page 22 – 30

Using a SQL select statement
1. Enter the Select statement in the SQL Text field to retrieve the list of values. Enter the SQL
2. If you are using a lookup table to display the list of values, enter it in the Lookup Type field.
3. If you are using SQL to use the value defaulted from a list of values, enter a Select statement to select the value in the Find field.
4. Continue to enter any further options and click the Save button.
5. Continue defining your answer layout at Step 4: page 22 – 27 When you have finished defining your answer layout, create questions for your questionnaire.
   See: To create questions: page 22 – 30

Creating Questions

To create questions:
1. Select Assemble Questionnaire from the menu and select the questionnaire you previously created.
2. Click the Show Categories button to see the categories you assembled for that questionnaire.
   Note: You can click the Show Layout button to see the questionnaire layout at any time.
3. Click the Questions hypertext link alongside the category to add the first question. In our example, the question is HR1PLEASSUM.
4. You get a message to say that there are no questions associated with this category, so click the New button.
5. Select the first question.
6. If you are creating a unique question or overwriting the default question, enter the question text in the Text field.
   In our example, select HR1PLEASSUM, and enter the question text “Please summarise your views of the appraisee’s performance against objectives”
7. Select whether you want the question to align to the left or right hand side of the questions page.

In our example, the answer box is aligned to the right, so align the question left.

**Note:** Any text you enter in the Text field appears to the left of the answer box, whereas any text you enter in the Heading Text field appears above the answer area.

8. Return to the Update Profile Categories page and click the Questions hypertext link alongside the next category to create the question.

9. Click the New button.

10. Continue to enter questions as described, then press the Save button when you have finished.

11. Click the Show Layout button to check that you are happy with the questionnaire layout before you associate the questionnaire with the template.

---

**Creating or Changing an Appraisal Template**

Use the Appraisal Template window to create or modify an appraisal template.

You’ll need to enter the following QuickCodes for appraisals:

- Define appraisal statuses as values for the QuickCode Type APPRAISAL_ASSESSMENT_STATUS.

- Define appraisal types as values for the QuickCode Type APPRAISAL_TYPE.

If you do not want to use appraisal statuses or types in the appraisal, do not enter values for these QuickCodes. Users can ignore these fields on the appraisal web page.
To create an appraisal template:

1. Enter a name and description for the appraisal you are setting up. You can enter up to 85 characters for the name.
2. Enter the dates between which the appraisal template is valid. You must enter a From date but you can leave the To date blank.
3. Enter the instructions to be displayed to the appraiser(s) or reviewers(s). For example, "Complete all parts". You can format the text to appear exactly as you want it. You can enter up to 2000 characters for each appraisal type.
4. Select the questionnaire you previously created to use in the appraisal.
5. Select the performance rating scale to be used in the appraisal.
6. Save your changes.
CHAPTER 23

Mapping Career Paths

This chapter explains the different methods of handling your enterprise’s career and succession plans. It also explains how you can create and use career paths in career and succession plans.
Career and Succession Planning

Once you have found out your employees aspirations, and set their short- and long-term objectives, you’ll want to prepare them for their next position within a career plan. After all, now you have motivated your employees through your performance management system, you’ll want to keep them motivated by linking their own career aspirations to enterprise aspirations. By planning careers and identifying succession, you enable employees to see their future role within the enterprise, keeping them motivated, and you from lengthy and costly recruitment.

Not only does career and succession planning enable you to keep and retain your high-flyers, it also enables you to highlight, for example, roles requiring scarce technical or commercial skills. By being able to identify these early, you can develop these scarce skills within your enterprise and replace current employees in these positions, as required.

Modelling Career and Succession Plans

The flexibility provided by Oracle Human Resources means that you can handle your enterprise’s career and succession plans using one of two basic models. You can either base career progression on jobs or positions. If you are using the Web-based Line Manager Direct Access, you have additional features for holding succession plan information.

Figure 23–1 illustrates the different models you can select from.
Career Paths

A career path shows a possible progression to one job or position from any number of other jobs or positions (see Figure 23 – 2). Career paths must be based on either job progression or position progression. You cannot mix the two.

You can define as many career paths as you require, perhaps reflecting an individual’s career priorities (such as a Management Path and a Technical Path). You build career paths from the top down. You can only enter a job or position once in any career path.
Career paths based on job progression are built using the Map Career Path window. See: Defining Career Paths: page 23 – 7

Career paths based on position progression are built using position hierarchies. See: Creating Position Hierarchies: page 3 – 21

Modelling Career and Succession Planning Based on Jobs

If your enterprise’s career and succession planning is based upon jobs, you can use career paths to show possible progressions to one job from any number of other jobs.

Career paths are based on the structures of your enterprise rather than the people you employ. You may also want to record personal aspirations and progression paths for individual employees. There are several ways to do this.
Work Choices

You can use work choices to help identify a person’s career plan. Work choices indicate a person’s preference and capacity for work within the enterprise. The information you enter indicates availability for transfer, for working in other locations, and acceptable work day patterns. You can hold similar deployment information as requirements against jobs.

Appraisals on the Web

If you are using the Web–based Line Manager Direct Access, you can select a career path for a person as part of the appraisal process. When you create the appraisal questionnaire, you create a list of values that contains the alternative career paths that can be selected for a person during an appraisal.

Special Information or Attachments

If you are not using Line Manager Direct Access, there are other ways to hold information about successor jobs against a person. For example:

- You can define a special information type to hold time intervals (such as immediate, three years, five years) and job names. You can also use the Job Requirements window to record people’s names against each job for each time interval.
- An alternative approach is simply to record this information as text in comments or a word processed document attached to each employee’s record.

To model career and succession planning based on jobs:

1. Create the career paths and map career paths.
   See: Defining Career Paths: page 23 – 7
   Once you have created your career paths, you can derive personal progression from the person’s assignment to a job, and the job’s place within career paths.

2. Optionally, enter work requirements against jobs and enter personal work choices for your employees.
   See: Entering Work Choices for a Job or Position: page 3 – 18
   See: Entering Work Choices: page 13 – 21

3. Create your appraisal questionnaire and perform appraisals for employees (Line Manager Direct Access users only).
4. If you are not doing step 3, consider holding succession plan information against people as attachments or using a special information type. See: Defining Special Information Types: page 28 – 10

Modelling Career and Succession Planning Based on Positions

If your enterprise’s career and succession planning is based upon positions, you can create additional position hierarchies to show any type of progression. These might represent existing line management structures, or even cut across departmental or job–type boundaries. Career paths are based on the structures of your enterprise rather than the people you employ. You may also want to record personal aspirations and progression paths for individual employees. There are several ways to do this.

Work Choices

You can use work choices to help identify a person’s career plan. Work choices indicate a person’s preference and capacity for work within the enterprise. The information you enter indicates availability for transfer, for working in other locations, and acceptable work day patterns. You can hold similar deployment information as requirements against positions.

Succession Planning on the Web

If you are using Line Manager Direct Access, you can use the Succession Planning option on the Web. You can select a person’s next position(s), or view their current position and see who is to succeed to that position. See the online help for Line Manager Direct Access for further details.

Special Information or Attachments

If you are not using Line Manager Direct Access, there are other ways to hold information about successor positions against a person. For example:

- You can define a special information type to hold time intervals (such as immediate, three years, five years) and position names
against an employee. You can also use the Position Requirements window to record people’s names against each position for each time interval.

• An alternative approach is simply to record this information as text in comments or a word processed document attached to each employee’s record.

To model career and succession planning based on positions:

1. Optionally, create position hierarchies to show career paths, if you want to show typical career progression.
   See: Creating Position Hierarchies: page 3 – 21
   Once you have created the hierarchies, you can derive personal progression from the person’s assignment to a position, and the position’s place within the hierarchies.

2. Optionally, enter work choices against positions and enter personal work choices for your employees.
   See: Entering Work Choices for a Job or Position: page 3 – 18
   See: Entering Work Choices: page 13 – 21

3. If you use Line Manager Direct Access, use the Succession Planning option to record one or more next positions for each employee.
   Note: This option does not require you to have set up career paths using position hierarchies.

4. If you are not doing step 3, consider holding succession plan information against people as attachments or using a special information type.
   See: Defining Special Information Types: page 28 – 10

Defining Career Paths

You define career paths in the Career Path Names window and the Map Career Path window.
To define a career path:

1. Enter the names of the career paths you want to define in the Career Path Names window. Save the names.
2. Open the Map Career Path window. In the Name field, select the top job in the career path you are mapping.
3. Select the name of the career path in the Career Path Name field.
4. In the Job Progression From block, select all the jobs that are one level down from the top job in this career path.
5. To extend the career path from any one of these jobs, check the corresponding Down check box. The window is redisplayed with your selected job now showing in the Name field. You can move back up the career path by checking the Up check box.
6. Save your work.

**Lines of Progression for AAP Reporting**

Oracle HR includes a special use of career paths based on jobs. For the AAP–Workforce Analysis report, you build career paths for jobs to constitute the *lines of progression* this report requires. You define these career paths just as you would any others based on jobs.

See: AAP Reporting: page 17 – 12
This chapter explains how you use Oracle Human Resources to match your employees to posts and vacancies.
Matching People Using Web–Based Access

Career Management provides you with web–based access for many line manager and employee end–user processes. You can use the powerful web based tool ‘Suitability Search’ to search for and match the most suitable person to a job or position. This might be performed during recruitment, succession planning, and so on. You can search by:

- personal characteristics
- assignment characteristics and competencies
- a combination

In your search, you can identify which competencies are required and which are optional. You can also search for people with a proficiency level in a specific competence, at a required level and above (or below). Suitability Search then produces a list of all people who possess the required and optional competencies, at the level defined. For example, if you asked for people proficient in a competence at level 3 and above, the search will not include people below 3 in that competence in the search.

You can also rank any of the optional competencies, and the Suitability Search Match module then produces a list of all people (or jobs and positions) who possess the required competencies, and ranks those according to the rating given to the optional competencies.

In future releases, you’ll be able to include work choices in your search. These are factors that can affect an employee’s, applicant’s, contractor’s or ex–employee’s capacity to be deployed within the enterprise (or to customers). You can hold work choices at both job and position or at person level. Look at the flexibility Career Management provides by enabling you to identify, for example, that a specific job or position requires the incumbent to be able to work in any country, and the search returns only people who match that criterion.

Suitability searching also enables you to:

- match and rank people against a specific organization, job or position, for example, to fill a vacancy or to deploy a person
- match and rank people against a set of competencies, for example, to fill a vacancy or project
- match a person against organizations, jobs or positions, and rank them, for example, to define a person’s career path

Viewing the Results of Suitability Matches

You can view the results of the matching in three different ways:
• by rank order of matches for the whole group
• by individual results for each person
• by comparative results for each competence

How Suitability Matching Works

In the Competence Match Criteria window, you set the range of levels and the matching type for each competence.

Range of Levels

The range of levels determines whether a match can be made. You have three main choices in setting this range:

- to set both a low and a high level
- to set a low level but not a high level, or to set a high level but not a low level
- not to set a level at all

Setting both a high and a low level establishes an exact range for the match. If the person’s competence level is within the range this counts as a match. If it is either above or below the range there is no match.

To set just a low level for the competence means that any competence at or above this level counts as a match. To set a high level only means that any competence at or below this level counts as a match.

To set no level at all means that any score for this competence counts as a match.

Matching Type

The type of match you select can determine what effect a match or a non-match has on the person’s score as a whole.

If you select essential for any competence, a person who fails to score a match for this competence over the range you set will not appear in the ranked list at all. Even if the person scores matches for other competencies, the failure to score a match in this essential competence rules him or her out of the list.

If you select desirable, a person who fails to score a match for this competence and range will still be ranked if he or she scores matches in other competencies. If the person scores matches in no competencies he or she will not be listed.

If you select not required, the competence itself does not count for the competence matching exercise. For example, a person scores matches
with four competencies in the list. One of these competencies is marked ‘not required’. The person’s score is shown as three.
If you choose not to develop the competency approach to career management, you can, instead, hold skills information using Special Information Types. This was the recommended approach in earlier releases of Oracle Human Resource Management Systems.

This chapter explains how to use Special Information Types to hold and match skills information.
The Special Information Approach to Skills Matching

From Release 11, the recommended approach to holding and matching skills information is to define a framework of competencies. These provide the common language for a wide range of human resource activities including assessments, appraisals, employee profiling, career development, and recruitment. You can build up a wealth of skills information that can be maintained and used by employees and line managers themselves, using the web Direct Access interface.

However, Oracle HRMS continues to support the earlier approach to handling skills information, using Special Information Types. This is an alternative to the new competency approach.

Special Information Types are a flexible way to hold any additional information you require about people and, if necessary, to compare this information with the requirements of jobs or positions. For each Special Information Type you can define up to thirty fields to hold details of competences, professional qualifications, education, and valid experience. For each person, job, or position, you can make multiple entries for each Special Information Type.

For example, suppose you want to store details of technical skills. You could set up the following fields:

- Skills – with a list of valid values to control the vocabulary used to describe the skills
- Years Experience – to hold the number of years of experience in using the skills

You can display the fields you define in one or more of the following windows:

- Special Information, to record skills or experience for an employee or applicant
- Job Requirements, to hold skill requirements for a job
- Position Requirements, to hold skill requirements for a position
- Skill Provisions, to record the skills or qualifications provided by training activities in Oracle Training Administration

Using views and reports, you can then match people to posts, according to their skills or other attributes.
Tips for Defining Special Information Types to Hold Skills Information

- If you want to give different sets of people access to different categories of skills information, define each category as a separate Special Information Type. You can customize the Special Information window to display just one Special Information Type.

- If you want to match on a range of skills levels, it is easier to use numeric values. Use a description field to provide the meaning for each level. The description appears automatically when the number is chosen.

- You can use cross-validation to ensure that users enter correct combinations of segments. For example, you could ensure that when a language skill is entered, a fluency level is also selected.

- You can speed up data entry and minimize errors by defining an 'Alias' for common combinations of segment values. For
example, completion of a course might always give a specific certificate from a particular licensing body. A user could enter all of these values with a single Alias.

- If you want users to enter the precise title of a qualification (perhaps read from a resume), you cannot supply a list of values. However, consider providing additional fields with lists of values using broad terms such as ‘degree–level’ or ‘science’ to help users searching for information.

**Unstructured Information**

You may want to hold some skills information, such as resumes, as unstructured, free text information. You can store this information as attachments to the People and Special Information windows.

**See Also**

- Entering Special Information: page 13 – 26
- Entering Job and Position Requirements: page 3 – 17
- Defining Special Information Types: page 28 – 10
- Using Attachments: page 33 – 6
Viewing and Reporting Skills Matching Information

There is a standard skills matching report supplied with Oracle Human Resources. This report matches people against all the requirements you have entered for one job or position (held in Special Information Types).

The List People By Special Information window displays a list of people who match a particular profile for one Special Information Type.

See Also

Listing People by Special Information: page 13 – 28

Skills Matching Report

Using this report, you can match employees, applicants, or both against the requirements of one job or position (held in Special Information Types). You can select the closeness of the match you require.

You run reports in the Submit Requests window.

► To run the Skills Matching Report:

1. In the Name field, select Job and Position Skills Matching Report.
2. Enter the Parameters field to open the Parameters window.
3. Select the Job or Position to which you want to match people.
4. In the Person Type field, select who you want to match:
   - applicants, or
   - employees, or
   - both
5. Select the closeness of match you require from one of the following levels:
   - one or more essential skills
   - all essential skills
   - all essential and one or more desirable skills
6. Choose the Submit button.
To manage your employees’ absences from work, you must be able to:
  • identify the types of absence your enterprise recognizes
  • record the reasons, dates and times for projected and actual absences, and maintain records of time taken for each absence type
  • group related absence types together for reporting and analysis
  • set up and administer PTO accrual plans, whereby employees can accrue time off for vacation or sick leave as they put in time at work.

This chapter explains how to set up an effective absence recording system in Oracle HRMS, how to enter and obtain information about employee absences, and how to set up, maintain and report on plans for accrual of paid time off.
Absence Management

Employees take paid or unpaid time off from work for a variety of purposes, such as illness or injury, vacation, medical appointments, childbirth, death of a close relative, jury duty, labor representation, and professional activities. Maintaining information on employee absences for reporting and analysis is an important aspect of human resource management.

Many enterprises permit employees to accrue hours or days of PTO (paid time off) as they work, to use for sick or vacation leave. In such enterprises, setting up and maintaining PTO plans is another part of absence management.

See Also

Absence Types: page 26 – 3
Plans for Accrual of PTO: page 26 – 19
Absence Management Setup Steps: page 26 – 9
Entering Absences: page 26 – 14
Viewing and Reporting on Absence Information: page 26 – 16
Absence Types

Oracle HRMS provides a convenient way to maintain information about the various absence types your enterprise recognizes. To facilitate reporting and analysis of employee absences, you can distinguish between absence types and absence categories. An absence category is a group of related absence types, as for example:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Medical Leave</td>
<td>Medical Appointment</td>
</tr>
<tr>
<td></td>
<td>Illness or Injury</td>
</tr>
<tr>
<td></td>
<td>Work–related Injury</td>
</tr>
<tr>
<td></td>
<td>Work–related Illness</td>
</tr>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Unpaid Maternity/Paternity</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
</tr>
<tr>
<td>Personal Leave</td>
<td>Compassionate Leave</td>
</tr>
<tr>
<td></td>
<td>Personal Business</td>
</tr>
<tr>
<td>Professional Leave</td>
<td>Certification Classes</td>
</tr>
<tr>
<td></td>
<td>Meeting Attendance</td>
</tr>
</tbody>
</table>

Table 26 – 1 Example Absence Categories and Types

Also to assist with absence reporting and analysis, you can provide reasons to select from when recording employees’ time taken for an absence type. For example, if you need information to analyze the particular family–related responsibilities that cause employees to miss work, you can define reasons for absence types as follows:

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Family Leave</td>
<td>Paid Maternity/Paternity</td>
<td>Birth of a child</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Adoption of a child</td>
</tr>
<tr>
<td></td>
<td>Dependent Care</td>
<td>Child Care</td>
</tr>
</tbody>
</table>

Table 26 – 2 Example Absence Category, Types and Reasons
Setup of Absence Types

Setting up each absence type is essentially a two-step process. One step involves defining the type, that is, entering its name, and optionally selecting a category and reasons for it. The other step involves defining an element to associate with the type. This element serves two important purposes:

- It provides a way to maintain a running total of time taken for the absence type. When you record an absence for an employee, the amount of time taken goes as an entry to the input value of the element associated with the absence type.

  For example, if you record 8 hours of Compassionate Leave for an employee, the input value of the element for this absence type receives an entry of 8. If a second 4 hour absence of this type occurs the input value gets an entry of 4, which adds in for a total of 12 hours Compassionate Leave taken to date.

- It provides a way to restrict employee eligibility for the absence type. The links you build for the element establish which employees are eligible to use the type.

  For example, if the absence type Compassionate Leave is available only to full time employees, you link its element to the employment category Full Time.

See:

Overview of Elements: page 7 – 2
The Structure of Elements: page 7 – 3
Using Elements: page 7 – 6

To hold a single running total of time taken for two or more absence types, you associate all the types with the same absence element. For example, your absence category Personal Leave may include two absence types you need for certain reporting purposes, Compassionate

<table>
<thead>
<tr>
<th>Absence Category</th>
<th>Absence Type</th>
<th>Absence Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Elder Care</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Disabled Care</td>
</tr>
</tbody>
</table>

Table 26 – 2 Example Absence Category, Types and Reasons

Absence Elements: page 26 – 5
Leave and Personal Business. However, you require just one running total to be kept of employees’ time taken for both types of personal leave. In this case you simply associate both absence types with the same absence element.

**Note:** If you have a use for absence types for which you do not maintain running totals of time taken or time remaining, and which do not require any eligibility rules, you can define the type with no associated element.

Absence Recording: page 26 – 7

**Absence Elements**

Each element you define and associate with an absence type has an input value with either hours or days as its unit of measure. To maintain a running total of the hours or days a employee has taken for an absence type, this input value is said to hold an *increasing balance*.

**Increasing Balances of Time Taken**

As you would expect, an increasing balance for an absence type starts with no time entered, and increases as you enter employees’ hours or days absent. For example, if the absence type Compassionate Leave has an increasing balance, the balance starts from zero for each employee and increases by the number of hours entered for each absence of this type.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Hours in decimal format</td>
<td>(none)</td>
</tr>
</tbody>
</table>

Table 26 – 3 Example Element for the Absence Type Compassionate Leave

Increasing balances are appropriate for most or all absence types. For absence types for which your enterprise sets a maximum time allowed, the system issues a message when an entry of time absent exceeds this maximum, or Oracle Alert can notify you when an employee reaches the maximum time or takes excess time.

**See:** *Oracle Alert User’s Guide*

When defining an absence type for a PTO accrual plan, you give it an increasing balance that will show accrued time the employee has used. To see the amount of accrued time a plan participant has available for use as vacation or sick leave, you use the Accruals window.
Decreasing Balances of Time Remaining

If your enterprise sets a maximum time allowed for an absence type that is not connected to a PTO accrual plan, you have the option of setting up a *decreasing balance* for this type, instead of an increasing balance.

For example, suppose your enterprise allows certain employees 32 hours leave per year for professional development. The Professional Leave absence element can have a decreasing balance, and an initial entry of 32 hours.

<table>
<thead>
<tr>
<th>Input Value</th>
<th>Unit of Measure</th>
<th>Initial Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amount</td>
<td>Hours in decimal format</td>
<td>32</td>
</tr>
</tbody>
</table>

Table 26 – 4  Example Element for the Absence Type Professional Leave

If you record an employee absence of 4 hours for this absence type, the decreasing balance shows 28 hours still available to be taken.

Decreasing absence balances require more maintenance than increasing balances. They need a prorated initial balance entry for all eligible new hires throughout the year, and require resetting each year for all eligible employees.

Notice that an absence element cannot have both a decreasing and an increasing balance; it has one or the other.

Initializing an Absence Balance

Oracle HRMS provides two ways to initialize both increasing and decreasing absence balances at the year’s start, and to enter initial amounts of any decreasing balances:

- the Element Entries window, for individual employees
- the MIX batch entry facility, for batches of employees.

Alternatively, users can develop their own processes for resetting absence balances in a new year, and entering initial values for decreasing balances.

See:

Making Manual Element Entries: page 7 – 41
Making Non-Payroll Batch Entries Using MIX: page 8 – 3
Referencing Absent Time in Payroll Runs

You can reference absence time taken (amount of an increasing balance) or absence time remaining (amount of a decreasing balance) for absence types in formulas for earnings, deductions, or other items Oracle Payroll processes in payroll runs. When defining the input value to hold the absence balance for an absence type’s element, you can check the Database Item box. Entries to this input value then become database items that formulas for payroll calculations can access.

See: Elements and Formulas: page 7 – 21

Absence Recording

When you record an absence for an employee using the Absence Detail window, you must always select an absence type. This ensures that you always have on record, information about the nature of and reasons for the absence.

Dates and Times

In the Absence Detail window you can conveniently record for an employee either a projected or an actual start and end dates and times of a particular type of absence, as well as the date you receive notification of the absence. When an actual absence occurs in accordance with projected absence information already entered, you record this by simply clicking a button.

The system records an employee’s absences using the same calendar upon which the employee’s payroll is based. This means that all employees for whom you record absence information must have a payroll component in their assignments.

See: Components of the Assignment: page 14 – 5

Authorization and Replacement

When recording a projected or actual absence in the Absence Detail window, you can select both the name of an employee authorizing the absence, and of an employee replacing the absent worker.

Batch Entry of Accrued Time Taken

When employees report accrued sick or vacation time taken on their timecards, you can use PayMIX, instead of the Absence Detail window, to enter sick or vacation time taken together with other timecard data.
See: Recording Accrued Time Taken: page 26 – 31
Absence Management Setup Steps

To set up absence recording:

1. Define a nonrecurring absence element, with the Termination Rule Actual Termination and with at least one input value, for each absence type. Link this element.

   See: Defining and Linking an Absence Element: page 26 – 9

   **Note:** To set up an absence type for which you do not need to maintain a running total of time taken or remaining, and do not need eligibility rules, omit this step.

   To keep a single record of employees’ time taken for two or more different absence types, you can define one element only to associate with all the types.

   See: Setup of Absence Types: page 26 – 4

2. Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and your absence reasons as values for the QuickCode Type ABSENCE_REASON.

   You can select the same reason for different absence types.

   See: Adding QuickCode Values: page 32 – 3

3. Define each absence type, associating with the type its absence element.

   See: Defining an Absence Type: page 26 – 11

4. For an absence type with a decreasing balance, use the Element Entries window or the MIX batch facility to make initial element entries for employees eligible for the type.

   See:

   Making Manual Element Entries: page 7 – 41

   Making Non–Payroll Batch Entries Using BEE: page 8 – 3

---

Defining and Linking an Absence Element

Define an absence element in the Element window.

To define an absence element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.
2. Enter a name for the element, and select the classification Information.

   **Suggestion:** Give the absence element and its absence type the same name, or coordinate the element name with the type name. For example, for the absence type Compassionate Leave, name the element Compassionate Leave or Compassionate Leave Absence.

3. Select the processing type Nonrecurring, and the termination rule Actual Termination.

4. Check the Multiple Entries Allowed box to enable employees to have several instances of this type of absence in a pay period.

5. If this is an absence element for a PTO accruals plan, do not select Process in Run. Uncheck this box if necessary.

6. If employees must be a certain age or have served for a certain number of years to be allowed this absence, enter this information in the Qualifying Conditions region.

   **Note:** If this is an absence element for a PTO accrual plan, the plan setup relates length of service to accrued time off. Do not make an entry here for length of service.

7. If this is an absence element for a PTO accrual plan for which you may make batch entries using PayMIX, you must mark it so that it can accept these entries. To do this, click in the Further Information field and select a PayMIX category of Time for the element.

   This does not affect your ability to make manual entries to the element.

8. Save the element, then choose the Input Values button.

9. In the Input Values window, create an input value to hold the amount of time taken. Select units of Day, Hours in "HH" format, or Hours in Decimal Format (to one, two, or three decimal places).

   **Attention:** If this is an absence element for a PTO accrual plan, give the input value the name Hours or Days, to accord with the unit of measure of the plan. When you define the plan using the Accrual Plan window, this input value name appears in the Units field of the Absence Information region.

   For a PTO accrual plan whose units are Hours, the units you select for the input value Hours must be:

   - Hours in "HH" format, or
   - Hours in Decimal format (1, 2 or 3 places).
For an accrual plan whose units are Days, the units you select for the input value Days must be: Day.

Additionally, if you may make batch entries to this element using PayMIX, you must create an input value named Date Earned for the element, with units in the format DD–MON–YYYY. When you make entries to this element using PayMIX, the system supplies a date in this field.

The existence of this input value does not affect your ability to make manual entries to the element. When making manual entries, you leave this field blank.

See: PayMIX Timecard Entries: page 8 – 14

10. You can define minimum and maximum days or hours that can be entered in an absence record. If you do this, select what happens if these limits are breached:
   • Select Warning for the system to warn users but allow them to breach the limits.
   • Select Error for the system to issue an error message and prevent users from saving an entry that breaches the limits.

11. Save your work.

To link the absence element:

1. Set your effective date to a day on or before the start of the first payroll period for which you want to enter absences.

2. In the Element Link window, select the absence element.

   See: Defining Element Links: page 7 – 37

3. Select eligibility criteria for this absence element. If you want to make the element available to all employees, do not select any criteria.

4. Save the link. Then define the absence type associated with this absence element.

See Also

Defining an Absence Type

Use the Absence Attendance Type window to define an absence type for association with the nonrecurring element representing an absence.

Prerequisites

- Define and link the element for the absence type.
Define categories of absence types as values for the QuickCode Type ABSENCE_CATEGORY, and define your absence reasons as values for the QuickCode Type ABSENCE_REASON. You can select the same reason for different absence types. See: Adding QuickCode Values: page 32 – 3

To define an absence type:

1. Enter a name and category for the absence type.
   - **Suggestion:** Give the absence type and its associated element the same name, or coordinate the type name with its element name. For example, name the absence type for a PTO accrual plan Salaried Sick PTO Plan, and its associated element, Salaried Sick PTO Absence.

2. In the Associated Element region, select the element defined for this absence type. The name of the element’s input value that holds the time taken or time remaining for this absence type appears in the Input Value field, and the unit of measure for the input value appears in the Units region.

3. In the Balance region, select Increasing for each entry to the absence element’s input value to add to a running total of time taken to
date for this absence type. Select increasing balances for absence types for PTO accrual plans, and for most other absence types.

For absence types that have a set maximum amount of hours or days allowed, you may select Decreasing. In this case, each absence recorded reduces an initial balance entered for the absence type, to show time remaining to be taken for the type.

Decreasing balances require more maintenance. You must enter an initial balance amount for each new hire eligible for the absence type, and must initialize the balance for all eligible employees at the start of each year.

4. Optionally, select reasons that are valid for entries of this type of absence.

5. Save the absence type.

Absences Taken and Time Remaining for Accrued PTO

An employee’s net accrual of accrued time as of a given date, together with a record of accrued time used this year and unused time carried over from the previous year, is always available for review in the Accruals window.

See: Reviewing Employees’ PTO Accruals: page 26 – 33
Entering Absences

To enter projected or actual absences for an employee, use the Absence Detail window.

See: Absence Recording: page 26 – 7

Prerequisites

- Because the calendar holding absence records for an employee is the same as that of the employee’s payroll, the assignments of employees for whom you enter absence information must include an assignment to a payroll. The effective date of this assignment must be no later than the start of the current payroll period.

  See: Entering a New Assignment: page 14 – 9

- Similarly, the definition and linking of the element associated with the absence type must have occurred on or before the start of the current payroll period.

  See: Defining and Linking an Absence Element: page 26 – 11

To enter absences for an employee:

1. Select the absence type. The following information appears:
   - The category of the type.
• The occurrence of the new absence record you are entering. For example, if the employee has already incurred two absences of this type, the occurrence of the new record is 3.

• The running total of hours or days absent for the absence type. For absence types with increasing balances, this is the number of days or hours absent already recorded (in the past or future). For any types with decreasing balances, this is or the number of hours or days remaining to be taken.

• The number of days absence recorded for the absence type in the current calendar year.

• The name of the element that maintains each employee’s time taken or time remaining for this absence type.

2. Do one of the following:

• Enter projected dates for the absence. You can later copy them to the Actual Date fields by choosing the Confirm Projected Dates button.

• Enter actual dates and duration as days or hours, according to the units of the balance. For a duration in hours, you must enter start and end times, as well as start and end dates.

3. You can also select:

• reasons for the absence

• the employee authorizing the absence

• the employee who replaces the absent employee for the duration of the absence

4. Save your work.
Viewing and Reporting on Absence Information

For monitoring and analyzing recorded employee absences unconnected with a PTO accrual plan, use:

- the View Absence History window: page 26 – 16
- the List Employees by Absence Type window: page 26 – 17
- the Absences Report: page 26 – 18

For reviewing PTO plan participants’ accrued time earned and taken, use the Accruals window.

See: Reviewing Employees’ PTO Accruals: page 26 – 33

Viewing Absence History

Use the View Absence History window to view all absences for an employee.

To view absences for an employee:

- Select an employee then choose the Find button.
The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.

**Listing Employees by Absence Type**

Use the List Employees by Absence Type window to see all the absence records for a particular absence type, or category of types.

To list employees by absence type:

- Enter any combination of absence type, category, and start and end dates to define the absences to view. Choose the Find button.

The absences appear in the lower part of the window. Use the standard Folder features to select a subset of these absence records, and to choose the fields to see.
Absences Report

The Absences Report shows information about employee absences during a specified period. It can show absences:

- for an individual employee, or for all the employees in an organization
- for all types of absence, or as many as 10 selected types.

The report summarizes the information as totals for each absence type since the employee was first hired.

Run reports in the Submit Requests window.

To run the Absences Report:

1. In the Name field, select Absences Report.
2. Enter the Parameters field to open the Parameters window.
3. Enter the effective date for which you want to see the report.
4. Select either an organization or an employee.
5. Enter the start and end dates of the period for which you want to report absences.
6. You can choose up to 10 absence types for the report. To report on all types, leave the absence type fields blank. Choose OK.
7. Choose the Submit button.
Plans for Accrual of PTO

Accrual plans permit eligible employees to accrue PTO (paid time off) each year as they work, to use for vacation or sick leave. Oracle HRMS has no restrictions on the number of plans you can set up, each with its own units of accrued time (hours or days) and its own rules.

The system calculates accruals for all plans on a calendar year basis. That is, on 1 January of each year, accruals for that year begin. Accruals for new hires can begin on their hire date, six months after their hire date, or at the beginning of the next calendar year.

For all plans, participants’ payroll periods determine the frequency with which they accrue PTO. Employees on a monthly payroll accrue time each month, employees on semi-monthly payrolls accrue time twice each month, and so on. PTO accrual occurs automatically for each eligible plan participant on the last day of his or her pay period, independently of any payroll run.

For example, if employees on a semi-monthly payroll participate in a vacation PTO plan permitting the accrual of 84 hours per year, they accrue 3.5 hours on the last day of the year’s first pay period, say 15 January. They then accrue another 3.5 hours on 31 January, another 3.5 hours on 14 February and so forth.

Because accrual plans use employees’ payroll calendars to schedule accruals, the assignment of every employee participating in an accrual plan must include an assignment to a payroll.

Accrual Plan Structure

Just as elements constitute the underlying structure of absence types, so they provide the structure of accrual plans. To set up an accrual plan, you first set up absence recording for the plan, including an element to hold information about absences taken under the plan.

See: Absence Management Setup Steps: page 26 – 9

With absence recording in place, you can then enter information for setup of the accrual plan itself. This information includes:

- a start rule, to determine when employees can begin to accrue PTO under the plan
- length of service bands, which establish how PTO accrued under the plan increases with employees’ length of service.

In response to the information entered for plan setup, the system generates three elements for the plan:

- an element representing the plan (classification: PTO Accruals). You use this element to enroll participants in the plan.
Accrual Start Rules

Accrual plans differ with respect to the date from which they permit plan participants to start accruing PTO. In Oracle HRMS, the accrual start rule determines this date for a plan. The system includes these accrual start rules:

- Hire Date
- Beginning of Calendar Year
- Six Months after Hire Date

Enterprises have many different rules governing their accrual starts, so you may need start rules other than the three provided. You can either modify the existing rules, or add new ones.

Start Rule: Hire Date

For plans with this rule, participants’ accruals begin from the first full period following their hire date. For example, if the hire date of a participant on a semi-monthly payroll falls on the first day of either the first or second period in the month, PTO accrual starts as of that date.

If the hire date falls sometime after the first of the month but before the end of the first period, accruals start in the second period of the month. If the hire date falls after the first day of the second period but before its end, accruals start with the first period in the next month.

Start Rule: Beginning of Calendar Year

With this start rule, participants’ accruals begin from the start of the year following the year in which they are hired. This means that a participant with a hire date of 2 January 1996 and another with a hire date of 31 December 1996 both start to accrue time as of 1 January 1997.

Notice that the amount of PTO each accrues may not be the same, as accrual amounts often depend on employees’ length of service.

Period of Ineligibility

Plans with the start rule Hire Date or Beginning of Year can require participants to work for a period of time, perhaps three or six months,
before they are eligible to accrue PTO. If plan participants in fact take vacation or sick leave during this period, the system does not accept entry of this time against the accrual plan. Many enterprises set up an absence type for "approved but unpaid leave" to use for absences taken during periods of ineligibility.

The period of ineligibility is not applicable to plans with the start rule Six Months After Hire.

**Start Rule: Six Months After Hire**

For plans with this start rule, participants’ accruals do not begin until the first full pay period after the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 5 February 1996, completes six months of service on 5 August 1996, and starts to accrue PTO in the second period in August.

Notice that if people are hired on the first day of a period, their accruals begin with the pay period of the six–month anniversary of their hire date. For example, someone on a semi–monthly payroll who is hired on 1 February 1996 completes six months of service on 1 August 1996, and hence starts to accrue PTO in the first period in August.

**Length of Service and Accrual Amount Rules**

In Oracle HRMS, the *first day of the month of an employee’s hire date* is the default date from which his or her length of service is calculated for accrual purposes. For example, someone hired on 18 January 1997 completes one year of service on 1 January 1997, and someone hired on 31 December 1996 completes one year of service on 1 December 1997.

**Length of Service Override**

For individual accrual plan participants, you can override the default date from which a plan starts its length of service calculations. This is useful for managing exceptional cases that arise when, for example, employees who already have accumulated periods of service in your enterprise transfer from one place to another. You enter the date override when enrolling a participant in a plan.

See: Enrolling Employees in PTO Accrual Plans: page 26 – 30

**Length of Service Bands**

For many accrual plans, the time off that plan participants can accrue increases with their length of service. That is, *length of service bands*
determine accrual amounts. In addition, these bands can determine ceiling and maximum carryover amounts for plans that have these rules.

For each accrual plan in Oracle HRMS, you set up one or more length of service bands, supplying for each the hours or days of PTO that participants can accrue each year, together with any ceiling and maximum carryover of accrued time.

**Ceiling Rules**

The ceiling rule, found in some vacation accrual plans, sets a maximum amount of PTO an employee can hold at any time. When a participant’s accrued PTO reaches the ceiling, no additional time accrues. Accruals begin again only after the participant uses some accrued time.

**Maximum Carryover Rules**

Maximum carryover rules, found in both vacation and sick leave plans, set the maximum amount of unused PTO a participant can carry over from one year to the next.

**Carried Over and Residual PTO**

To manage the carryover to a new calendar year of employees’ unused PTO, you run the PTO Carry Over process at year end. This process first calculates participants’ net PTO as of the last day of the year’s last pay period. This calculation insures that this period’s accruals do not exceed any plan ceilings that may exist. The process then checks the maximum carryover permitted, to determine for each participant both the amount to carry over, and the amount of any residual PTO that cannot be carried over.

For employees with unused, accrued time to carry over, it enters this time on the element generated to hold carried over time for the plan. Similarly, for employees with unused, accrued time they cannot carry over, it enters this time on the element generated for the plan to hold residual time.
PTO Sale or Purchase

Your enterprise may have policies permitting accrual plan participants, under certain circumstances, to sell back PTO they have accrued but not used. You may also permit them to purchase additional PTO. Because such policies and rules are not standard across enterprises, Oracle HRMS has no method in place for managing PTO sale or purchase. However, you can design a method and define elements for doing this, customized to your own requirements.

See: Reviewing or Changing Net Accrual Calculations: page 26 – 27
Accrual Plan Setup Steps

To set up a PTO accrual plans:

1. Define and link an element for the plan’s absence type.
   See: Defining and Linking an Absence Element: page 26 – 9

2. If you expect to record accrued time taken under the plan using the Absence Detail window, define an absence type for the plan, associating its absence element with this type.
   If you expect to record accrued time taken using only PayMIX or the Element Entries window, it is not essential that you define an absence type for the plan.
   See: Defining an Absence Type: page 26 – 11

3. Define the accrual plan.
   See: Defining a PTO Accrual Plan: page 26 – 24

4. Set up length of service bands for the plan.
   See: Setting Up Length of Service Bands: page 26 – 26

Defining a PTO Accrual Plan

Use the Accrual Plan window to define an accrual plan.

Prerequisite

Before setting up the plan, set up a way to track absences taken under the plan. To do this you define and link an element for recording accrued time taken under this plan, and optionally, associate this element with absence type information.

See: Absence Management Setup Steps: page 26 – 9
To define a PTO accrual plan:

1. Enter the plan name, and select an accrual category of either Sick or Vacation for it.

   **Suggestion:** Coordinate the names of the accrual plan, the plan’s absence type if any, and the element used to record absences taken under the plan. For example, for the Hrly Vacation PTO Plan for your hourly workers, you could name the absence type and its element Hrly Vacation PTO Absence.

2. Select the start rule for the plan in the Accrual Start field. This rule determines the date on which a plan participant begins to accrue PTO.

   See: Accrual Start Rules: page 26 – 20

3. Select Days or Hours in the Accrual Units field. This selection must accord with the input value units selected for the element that records accrued time taken under this plan.

   See: Defining an Absence Type: page 26 – 11

4. In the Name field of the Absence Information region, select the element associated with the plan’s absence type. The name of the element’s input value that holds the entries or hours or days absent appears in the Units field.
5. If the start rule for this plan is Hire Date or Beginning of Year you can enter a period of ineligibility, during which a plan participant can accrue PTO but cannot use accrued PTO. For example, enter 3 in the Length field and select Calendar Month in the next field.

See: Period of Ineligibility: page 26 – 20

6. Save your work, and then set up length of service bands for the plan. Choose the Accrual Bands button to go to the Accrual Bands window.

Choose the Net Calculation Rules button to view or change the rules for calculating employees’ net PTO.

---

**Setting Up Length of Service Bands**

Use the Accrual Bands window to define length of service bands for an accrual plan.

**Prerequisite**

- Define the accrual plan for which you are entering length of service bands.

![Accrual Bands Window](image)

---

**To set up length of service bands for a PTO plan:**

1. For each length of service band applicable to this plan, establish the band’s duration by making an entry in the To field. The first band
starts from zero years of service. If it extends for five years, enter 5 in the To field. The system then sets the From field for the second band at 5, as the second band starts after five years of service.

For the last band you enter, in order to cover all participants with any length of service beyond the band’s From entry, enter 99 in the To field. For example, if your bands cover service of 0–5 years, 5–10 years and 10+ years, the third band’s From and To entries should be 10 and 99.

If length of service is not relevant for this plan, define one band only for it, with a From entry of 0 and a To entry of 99.

2. For each band, enter in the Yearly Accrual field the number of hours or days that participants whose length of service falls into this band can accrue each year. For example, if plan participants accrue 80 hours of vacation per year during their first five years of service (band 0 – 5), enter 80 in the Yearly Accrual field.

3. If a band does not permit participants to carry unused accrued time over to the next year, leave the Accrual Carryover field blank. Otherwise, enter in this field the maximum number of accrued, unused hours or days that participants at this band may carry forward.

See: Length of Service and Accrual Amount Rules: page 26 – 21

4. If a band has no ceiling that limits the total number of hours or days participants at this band can accrue at any one time, leave the Ceiling field blank. Otherwise, enter the ceiling number for the band.

5. Save your work.

When you do this, the system generates three new elements for the plan, one to represent the plan and one each to hold carried over and residual amounts of accrued, unused PTO. Define for these elements, the same links as those of the plan’s absence element.

---

**Reviewing or Changing Net Accrual Calculations**

The rules for automatic calculation of employees’ net PTO appear in the Net Calculation Rules window. Here the system displays the rules that carried over time adds to net PTO, and hours or days absent subtract from the net. You enter this window by choosing the Net Calculation Rules button in the Accrual Plan window.
The Net Accrual Calculation for Net Entitlement of PTO

The calculation dynamically adds up a plan participant’s regular accruals to date. Then it adds in any carried over PTO from the previous year, obtained from the plan’s Carried Over element, to produce the gross accrual to date.

The calculation next adds up all PTO taken to date, obtained from the entries in each period to the element of the plan’s absence type. It then subtracts the amount of time taken to date from the gross accrual to date, to obtain the net accrual to date.

\[
\text{Gross PTO accrual} = \text{Accrued PTO} + \text{PTO carried over} \\
\text{Net PTO accrual} = \text{Gross PTO accrual} - \text{PTO taken this year}
\]

If your enterprise allows employees to purchase additional PTO or sell unused PTO, you can define elements to record information about purchased or sold amounts, query them in the Net Calculation Rules window, and select for the elements’ input values, rules governing their addition or subtraction in the net accruals calculation.

Residual PTO

Notice that the system does no automatic processing of the entries of employees’ residual PTO. Your enterprise may want to use these entries to inform employees of accrued but unused time they may forfeit, or to make payments for part or all of this time.
Linking the Accrual Plan Elements

When you save your entries in the Accrual Bands window, the system creates three elements:

- An element (classification: PTO Accruals) representing the plan that has the plan name, for example, Hrly Vacation PTO Plan. Use this element to enroll employees in the plan.
- An element (classification: Information) to hold for each plan participant, any accrued, unused hours or days that can be carried over to the next year.
- An element (classification: Information) to hold each participant’s residual time, that is, any accrued, unused hours or days that cannot be carried over.

The Carried Over and Residual elements each have an input value Hours or Days (depending on the plan’s units), which automatically receive entries when you run the PTO Carryover process at year end.

For the three elements generated for each PTO accrual plan, you must build links that are the same as those of the plan’s absence element, whose name appears in the Absence Information region of the Accrual Plan window.

To link the accrual plan elements:

1. Set your effective date to the date the accrual plan goes into effect.
2. In the Element Link window, select one of the following:
   - the element representing the plan (for example, Hrly Vacation PTO Plan)
   - the plan’s Carried Over element (for example, Carried Over Hrly Vacation PTO Plan)
   - the plan’s Residual element (for example, Residual Hrly Vacation PTO Plan)
3. Select the same eligibility criteria for the element as those selected for the plan’s absence element. If you save a link without selecting any criteria, the element is available to all employees.
4. Save the link.

You are now ready to enroll employees in the plan, and record absences for plan participants when they use time they have accrued.
Maintaining PTO Plan Records

When a PTO accrual plan setup is complete, you enroll employees in their plans, and record their accrued time taken. At year end, you run the PTO Carry Over process to clear down each employee’s balance of unused accrued time, recording both unused time available for carryover, and residual time unavailable for carryover.

The net accrual calculation produces for an employee, his or her amount of accrued PTO at a given point in time. The results of this calculation are always available for review.

Enrolling Employees in PTO Accrual Plans

Enroll individual participants in an accrual plan by entering for them the element generated to represent the plan.

► To enroll participants in a PTO accrual plan:
  ■ Do one of the following:
    ■ For enrollment of an individual employee, perhaps as a part of the hiring process, enter the element representing the plan for him or her using the Element Entries window.
      See: Making Manual Element Entries: page 7 – 41
    ■ For enrollment of a batch of employees in a plan, perhaps a newly-developed plan, use the MIX batch entry facility.
      See: Making Non-Payroll Batch Entries Using MIX: page 8 – 3

If an accrual plan should calculate a participant’s length of service from a date other than the default date deriving from the plan’s start rule, give the plan a date to use for this participant when enrolling him or her.

See: Length of Service Override: page 26 – 21

► To override the date for calculating length of service:
  ■ When enrolling the participant, enter the override date in the input value Continuous Service Date of the element representing the plan. This entry overrides the default date derived from the plan’s accrual start rule.

Recording Accrued Time Taken

For PTO accrual plans associated with an absence type, you can use the Absence Detail window to record a plan participant’s accrued time taken.
See: Entering Absences: page 26 – 14

For plans not associated with an absence type, you can make entries for individual participants directly to the plan’s absence element, using the Element Entries window.

See: Making Manual Element Entries: page 7 – 41

If you are using Oracle Payroll you can make batch entries of hours of accrued sick or vacation time that employees have taken and noted on their timecards.

See: PayMIX Timecard Entries: page 8 – 14

Note: If you are using PayMIX to make entries from timecards of accrued time taken, ensure that standard links to all payrolls are in place for the elements Vacation Pay and Sick Pay. These elements are included in the system, and should receive standard links during the implementation of Oracle Payroll at your site.

Recording PTO Sold or Purchased

If your enterprise pays employees for time they have accrued but not used, or if you permit employees to buy additional time, you may decide to define your own PTO–related elements to record information about these transactions. In this case, you can enter these elements and select the rules governing the subtraction or addition of sold or purchased PTO in the Net Calculation Rules window.

Running the PTO Carry Over Process

Run this process at year end for each PTO accrual plan, to clear down participants’ balances of unused, accrued time. For each participant, the process stores time available for carryover to the new year on the plan’s Carried Over <plan name> element, and stores time they cannot carry over on the plan’s Residual <plan name> element.

Run the PTO Carry Over process from the Submit Requests window.

To run the PTO Carry Over process:

1. Select PTO Carry Over in the Name field. If the Parameters window does not open automatically, click in the Parameters field.
2. The date in the PTO Year Earned field defaults to the year before the current year. You can enter a different year.
3. Select the name and category of the accrual plan for which you are running the process.

4. The Reprocess All Participants field defaults to No, so that the process affects only those plan participants not previously processed for this year. To process all participants regardless of any previous processing, select Yes in this field.

5. When the entry of parameters is complete, choose OK. Choose Submit to submit the request.

The net accrual calculation for PTO includes carried over PTO in determining an employee’s accrued PTO to date. To set the net calculation rules, use the Net Calculation Rules window. To review an employee’s carryover of accrued time, use the Accruals window.

See Also

Reviewing or Changing Net Accrual Calculations: page 26 – 27
Reviewing Employees’ PTO Accruals

To view information on employees’ accrued PTO, use the Accruals window.

To view an employee’s net PTO accrual:

1. In the Assignments Folder, query the employee’s name. Choose the Accruals button to go to the Accruals window.

2. Query the accrual plan in the Name window. The field Net Entitlement displays the net accrued days or hours as of the effective dates that appear. If you allow maintenance of negative balances of accrued time at your installation and an employee’s time absent exceeds time accrued, the net entitlement appears as a negative number.

The Entitlement Details region shows the amounts of current accrued time, the accrued time carried over and accrued time taken used in the calculation of the net PTO accrual.

Attention: When reviewing employee accruals at year end, remember that:

- the last day of the final period of the current calendar year may fall between a date in late December and one in early January
- accruals for the new calendar year do not go on record until the last day of the first period of the new year
- carried over and residual PTO appear only after the PTO Carry Over process is run.
Oracle Human Resource Management Systems provides a full featured event management system in the form of Oracle Training Administration. However, Oracle Human Resources itself provides a simple way to record attendance at events and to schedule employee reviews. This chapter explains how to:

- set up events
- book employees and applicants onto events
- record information about employee interviews, such as disciplinary hearings and performance reviews
Setting Up Events

Oracle Training Administration provides all the power and flexibility you need to schedule, administer and track training events. For example, you can:

- control enrollments throughout the lifecycle of an event using event statuses, such as Planned, Full, and Closed
- manage waiting lists and allocate places by enrollment date, priority, status, or by organization or customer
- restrict enrollments to employees in specified jobs, positions or organizations
- group events into programs for coordinated enrollment and attendance tracking

See: Overview of Oracle Training Administration, *Oracle Training Administration User’s Guide*

In Oracle Human Resources, you can create events for employees or applicants in the Event Bookings window. While this window does not provide the powerful scheduling and enrollment features of Oracle Training Administration, it is useful for recording attendance at events.

**Note:** The system administrator can create customized versions of the Event Bookings window so that you use one version for employees and another version for applicants.

**Prerequisites**

- Define types of event, such as departmental meeting or marketing presentation, as values for the QuickCode Types EMP_EVENT_TYPE and APL_EVENT_TYPE.

**Suggestion:** You could set up the Additional Event Details descriptive flexfield to record booking statuses (such as Wait Listed, Confirmed, and Attended). This descriptive flexfield displays on the Event Bookings window, the Employee Review window, and the Applicant Interview window.
To create an event:

1. Select the type of event then enter the date, time, supplying organization, location, and contact name.
2. Save the event.
3. You can select attendees by name or number in the Bookings block of this window.

Managing Bookings and Attendance

You can view all the events a person has attended or is scheduled to attend in the Book Events window. You can also enter new bookings here.
Employee Reviews

You can use the Employee Review window to record information about any employee interview, such as a performance review, disciplinary hearing, or medical test.

To prepare for a performance review, you can view the employee’s:

- career history, using the Assignment History window
  See: Assignment History: page 14 – 36
- personal competence profile, using the Personal Competence Profile window if you are using Career Management, or the Special Information window, if you are recording skills information using Special Information Types
  See: Entering a Personal Competence Profile,
  See: Entering Special Information: page 13 – 26
- likely career paths or succession plans
  See: Career and Succession Planning: page 23 – 2

Line managers can use the web Direct Access interface to Career Management to complete assessment and appraisal templates for their employees.

Entering an Employee Review

You can record details of a review event using the Employee Review window.

Prerequisites

- Define the different types of employee interview you want to record, such as disciplinary hearings and performance reviews, as values for the QuickCode Type EMP_INTERVIEW_TYPE.
To enter a review for an employee:

1. Select an interview type, and enter a start date. The other fields are optional.
2. Save the review.
3. You can select reviewers by name or employee number. Save your work.
4. If you want to enter a performance rating for the employee associated with this review, navigate to the Salary Administration window.

Entering Performance Ratings

You can carry forward details from the Employee Review window to the Performance window (which opens from the Salary Administration window). In this window, you can enter performance ratings, schedule the next performance review, and, optionally, associate a salary change with a performance review.

Prerequisites

- Define a list of performance ratings as values for the QuickCode Type PERFORMANCE_RATING.
To enter a performance rating:

1. Select an existing review or enter a new review and its date.
2. Select a rating.
3. If you entered a time period for regular performance reviews in the Salary Information region of the Assignment window, the date of the next review appears automatically. You can change this date.

See Also

Entering Salaries and Salary Changes: page 9 – 8
This chapter focuses on three aspects of setup that affect how you record and track people in your system:

- **Person Types** – choosing the types of people you need to identify and the sorts of information you want to hold about each type
- **Assignment Statuses** – choosing statuses to track temporary or permanent departures of employees from your enterprise
- **Special Information Types** – designing fields to hold any special information, not provided by the main system, you want to hold about people, jobs and positions, and training activities
Person Types

In any enterprise there is a need to identify different groups of people. For each group that exists in your enterprise there may be different types of information you need to keep. You may also want to control access to the records of different groups of people.

There are three basic types of people for whom you maintain information in your human resource system. These are:

- Employees, both current and ex-employees
- Applicants, both current and ex-applicants
- External people

A special category of the External type is contact. A contact is someone associated with an employee or an applicant.

For example, people who are dependents of employees, people whom employees name as beneficiaries of certain benefits, and people whom employees list as their contacts in case of emergency are all entered as contacts.

Using Person Types

Oracle HRMS comes with a set of Person Types. You can change the names of these types when you install the system, and you can add your own subgroups of Person Types. For example, you might have two types of employee in your enterprise:

- Regular Employee
- Contractor

You can define these as subgroups of the Employee person type to:

- enable fast identification of these groups
- manage different kinds of personal information for each group
- change employees from Contractor to Regular Employee, without changing current work information

Note: Each employee’s assignment can be described by an employment category such as Full Time – Regular or Part Time – Temporary. So you do not use Person Types to distinguish the category of assignment.

In another example, you might want to distinguish between internal and external applicants for vacancies. You may also be involved in a redundancy program or a program of staff layoffs, and need to identify employees as preferred candidates for any vacancies. You can do this with the following subgroups of applicant:
Defining Person Types

There are eight Person Types recognized by the system, and identified by a system name. For each, there is a predefined user name. You can change the predefined name and you can enter other user names.

One user name must be the default. This is the name the system enters in certain circumstances if you do not select a Person Type manually. For example, when you hire an applicant, the system automatically updates the Person Type to the default user name for the system name ‘Employee’.

You enter user names for person types in the Person Types window.

First consider whether the existing user names are meaningful in your enterprise.

To change a user name for a person type:

- Delete the contents of the User Name field and type in your preferred name.

To map other user names to a person-type system name:

1. Select New Record from the Edit menu.
2. Enter a unique User Name and select the System Name you want to map on to.

Deactivating User Names

You cannot delete user names in use in the system, but you can deactivate them by unchecking the Active check box. Notice that you cannot deactivate a default User Name. You must first select another user name as the default.

Person Types and Information Management

The system uses its Person Types to control the type of information you can enter. For example, you cannot enter earnings or deductions for an applicant. You can use Person Types in the following ways:
To control access to people’s records on the system, according to their Person Type. For example, you might give all managers in a department access to employee records, but only give recruitment officers access to records of applicants and ex-employees.

Your system administrator can achieve this by creating customized versions of the People window.

See: Restricting the Data Displayed in a Window: page 31 – 3

When you set up your own fields to hold additional information, you can tie them to particular Person Types. For example, you might want a user-defined field holding visa information for foreign workers to appear for employees and applicants, but not for other people.

You can do this by setting up the descriptive flexfield on the People window.

See: Adding New Fields to Windows: page 31 – 2

**Suggestion:** If you want to define rules of eligibility for a compensation or benefits element based on the type of employee, you cannot use the Person Type directly. However, you can use Person Type in a formula to validate the values entered for an employee.

Also, consider whether you can meet your needs using the assignment status and employment category to control eligibility for compensation and benefits.

See: Components of the Assignment: page 14 – 5
Assignment Statuses

You use assignment statuses to track temporary or permanent departures of employees from your enterprise. Temporary departures include paid or unpaid leaves of absence that you may allow employees to take for a number of reasons.

Primary Statuses

There are four system statuses for employee assignments:

- Active Assignment, used to show that the employee is working in accordance with his or her usual conditions of employment
- Suspend Assignment, used to show that the employee is on leave of absence, but remains an employee of your enterprise
- Terminate Assignment, used to show that your enterprise no longer employs the person in that assignment. It can still be possible to make payments through Oracle Payroll for assignments at this status.
- End, used to end any assignment except the primary assignment for an employee with multiple assignments. This status causes a secondary assignment to end but is not recorded on the assignment.

On your system, you may give these statuses different user statuses appropriate to your enterprise. Each system status can have several user statuses related to it. For example, for the system status Suspend Assignment, you can have the user statuses Maternity Leave, Paternity Leave, and Military Leave.

These statuses are primary because they determine how the system processes and manages the assignment. An assignment must have one, and only one, primary status at a given time. You enter this status in the Assignment window.

See: Entering a New Assignment: page 14 – 9

Using Assignment Statuses to Control Compensation

When you define user statuses, consider how you will use them in reports, inquiries, and processing.

When you use a validation formula to validate entries to element input values, you can make the valid values for an entry dependent on the assignment status.

To use the statuses to control whether the payroll run processes an employee assignment, you choose a payroll status of Process or Do not
Process for each user status. Additionally, in Oracle Payroll you can set up your pay calculation formulas so that a status change also changes the formula used to calculate the employee’s pay. For example, an employee might receive half pay while on Military Leave.

See: Using Oracle FastFormula for Validation, Oracle FastFormula User’s Guide

**Additional Information:** Refer to your Oracle Payroll manual for information on the use of assignment statuses in the Formula Result Rules window to control the payroll formula that processes for an employee.

### Secondary Assignment Statuses

For analysis and reporting purposes, you can set up and use *secondary* assignment statuses, for both employee and applicant assignments. These statuses have no effect on assignment processing.

For example, suppose your primary status Maternity Leave applies to employees both when a child is born and when one is adopted, and you want to study its use in these two cases. To accomplish this you can set up the secondary statuses Maternity Birth and Maternity Adopt, and enter them for employees taking maternity leave.

You enter secondary statuses for an employee assignment or an applicant assignment in the Secondary Statuses window.

To enter reasons for giving secondary statuses to assignments, define valid reasons as values for the QuickCode Type EMP_SEC_ASSIGN_REASON (for employee assignments) and APL_SEC_ASSIGN_REASON (for applicant assignments).
Defining Assignment Statuses

You define both primary and secondary user statuses your enterprise uses for employee and applicant assignments in the Assignment Statuses window.

Defining Primary User Statuses

You can give your own user status names to the predefined system statuses. For example, for applicants you could use the user status “Rejected” for the system status “Terminate Application”. Oracle HRMS users see user statuses only.

You can also supply more than one user status for each system status. For example, for employees you can define several different user statuses for the system status Suspend Assignment, such as Maternity Leave, Paternity Leave, Disability Leave, Military Leave or Education Leave.

For applicants, you can track the stages of your selection process by means of user statuses. You can define user statuses such as Application Received, Application Acknowledged, First Interview, and Second Interview for the system status Active Application. These statuses can trigger production of standard letters.

See: Tracking Applicant Progress: page 15 – 15

To rename a user status:

- Delete the contents of the User Status field and type in your preferred name.

To supply additional user statuses for a system status:

1. Select New Record from the Edit menu.
2. Type in your user status, and select an HR System Status.
3. For an employee assignment status, also select a Payroll System Status. The payroll system status controls whether Oracle Payroll processes the assignment in a payroll run.
4. Save the new status.

   Note: For each HR System Status, you must have one default user status. The system automatically uses the default in certain situations. For example, when you create a new employee assignment, it automatically has the default user status corresponding to the system status ‘Active Assignment’. You can override this default.

You cannot delete a user status, but you can prevent its use by deactivating it. To deactivate a user status, uncheck the Active check box.

Defining Secondary Statuses

A user status associated with a system status is called a primary status because it determines how the system processes the assignment. You can also define secondary statuses not associated with a system status. You use secondary statuses for analysis and reporting, but not to control pay processing for assignments.

► To create a secondary status:
1. Select New Record from the Edit menu in the Assignment Statuses window.
2. Type in a user status and do not select a system status.
   The Type field displays Secondary.

Setup To Allow Processing After Termination

To enable payroll processing for employees after they leave your enterprise, in your system setup you must do the following:

- Use the Assignment Statuses window to make sure your system has a user status that corresponds to:
  - the HR system status of Terminate Assignment
  - the Payroll system status of Process

Your startup data includes the user status Terminate Process Assignment, which matches this definition. Use this status (or
your own equivalent status) when you terminate employment or end an assignment.
Defining Special Information Types

In Oracle HRMS, you use the Personal Analysis key flexfield to define any special information not provided by the main system that you want to hold about people, jobs and positions, and training activities.

You can define any number of instances of the Personal Analysis key flexfield. Each instance is called a Special Information Type. For example, you might set up types to hold performance reviews or medical details.

Each Special Information Type can have up to thirty fields (where each field is a segment of the flexfield). You can set up cross-validation to ensure that users enter correct combinations of segments. You can also speed up data entry and minimize errors by defining an ‘Alias’ for common combinations of segment values.

When you enable Special Information Types for your Business Group, you select how you plan to use each type.

In Oracle Human Resources, you can use Special Information Types for:
- job requirements
- position requirements
- personal information
- OSHA and ADA reporting

In Oracle Training Administration, you can use Special Information Types for:
- skills provided by training activities

Each Special Information Type can be used for one or more of these purposes. The options you select control the windows in which each Special Information Type appears.

In Oracle Human Resources, you can also customize the windows that handle Special Information Types to restrict them to just one Type, such as medical records. This is useful if you want to restrict access to particular types of information for security reasons, or to aid users’ efficiency by giving them access to just the information they require for a particular task.

Special Information Setup Steps

To set up Special Information Types:

1. Define each Special Information Type as an instance of the Personal Analysis key flexfield.
Setup for Personal and Assignment Information

See: Oracle Applications Flexfields Guide

2. Enable the Special Information Types you want to use in your Business Group and select how you want to use them.

3. Consider whether you want to create customized versions of the windows in which you can enter and display Special Information. These are the Special Information window and the List People by Special Information window.
   See: Restricting the Data Displayed in a Window: page 31 – 3

4. Design the task flows for entering personal information, which should include the Special Information window.

5. Design your navigation menus, including the List People by Special Information window (or your customized versions of it) and the personal information task flows.

6. Consider your special information reporting requirements. A standard Skills Matching report is supplied. This compares the special information, such as skills, held by employees and applicants with the requirements of a job or position.
   See: Viewing and Reporting Skills Matching Information: page 25 – 5

See Also

The Special Information Approach to Skills Matching: page 25 – 2

Enabling Special Information Types

Use the Special Information Types window to enable Special Information Types for the Business Group, and to select how you want to use them.

To enable Special Information Types:

1. Select the Special Information Types you want to use in your Business Group.

2. Enable each Type by checking the Enabled check box.

3. Check the other boxes to specify how you plan to use the Special Information Type. This makes it available in the list of values in other windows as follows:
• **Job**: in the Job Requirements window

• **Position**: in the Position Requirements window

• **Other**: in the Special Information window

• **Skill**: in the Skill Provisions and Search for Event windows in Oracle Training Administration

The information types ADA Disabilities, ADA Disability Accommodations, and OSHA–Reportable Incident are already enabled when you receive Oracle Human Resources, and ready to use for ADA and OSHA reporting.

See: OSHA Reporting: page 17 – 34
The HRMS system administrator looks after the day to day administration of the system. This chapter summarises the tasks performed by the system administrator and explains how to:

- set user profiles to predefine aspects of your users’ work environment
- enable the currencies used in your Business Group
The Role of the System Administrator

The system administrator takes responsibility for the day to day administration of one or more Oracle Applications.

Many jobs are more efficiently performed by one designated person. For example, the system administrator defines printers, and balances the system’s processing workload between online data entry and background processing, such as report generation.

A database management system can be conceptually divided into two parts: user applications and their underlying data structures. This division lends itself to two job categories: database administrator (DBA), and system administrator.

- An Oracle Applications System Administrator administers the user interface or applications side of the database management system.
- An Oracle Database Administrator or DBA administers the data the various applications enter, update, delete, and use for company business.

Ideally the system administrator should be someone from within the user group who knows how the system has been defined and can act as the first level of support for the application users. The system administrator role is clearly defined with a specific set of practical tasks to be carried out.

The HRMS System Administrator

For Oracle HRMS these practical tasks normally include:

- customizing the application, including setting up Key and Descriptive Flexfields. See:
  User Definable Key Flexfields: page B – 2
  User Definable Descriptive Flexfields: page B – 5
- imposing limits on what users can access through menus, security profiles, and responsibilities
  See: Setting up Security in Oracle HRMS: page 34 – 10
- defining audit requirements
  See: Setting Up AuditTrail: page 35 – 2
- setting up user profiles
  See: Setting User Profile Options: page 29 – 4
• defining the formats for displaying currency amounts
  See: Enabling Currencies: page 29 – 7
• setting up and maintaining QuickCode types and values
• installing printers and managing concurrent processing
  See: Oracle Applications System Administrator’s Guide
Setting User Profile Options

A user profile is a set of changeable options that affect the way your application runs. The system administrator can set user profiles at different levels:

- **Site level**: These settings apply to all users at an installation site.
- **Application level**: These settings apply to all users of any responsibility associated with the application.
- **Responsibility level**: These settings apply to all users currently signed on under the responsibility.
- **User level**: These settings apply to an individual user, identified by their application username.

Values set at a higher level cascade as defaults to the lower levels. Values set at a lower level override any default from a higher level.

*Suggestion*: Set site-level options first to ensure that all options have a default. If a profile option does not have a default value, it might cause errors when you use windows, run reports, or run concurrent requests.

You use the System Profile Values window to set profile options at each level for your user community. If you change a user profile option value, your change takes effect as soon as your users log on again or change responsibilities.
Application users can the Personal Profile Values window to set their own profile options at the user level. Not all profile options are visible to users, and some profile options, while visible, cannot be updated by end users. Any changes a user makes to his or her personal profile options take effect immediately.

List of User Profile Options

There are a number of User Profile Options that are of specific importance to HRMS system administrators. These are listed in Table 29 – 1 and Table 29 – 2. The only one of these options that a user can change is DateTrack:Reminder.

<table>
<thead>
<tr>
<th>HR Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR:Business Group</td>
<td>Business Group that is linked to the security profile for a responsibility. This option is used online to control access to records that are not related to organization, position, or payroll. This option is seeded at Site level with the start-up Business Group. It is view only. Values are derived from the HR:Security Profile user profile option.</td>
</tr>
<tr>
<td>HR:Security Profile</td>
<td>Restricts access to the organizations, positions, and payrolls defined in the security profile. This option is seeded at Site level with the view–all security profile created for the Startup Business Group.</td>
</tr>
<tr>
<td>HR:User Type</td>
<td>Limits field access on windows shared between Oracle Human Resources and Oracle Payroll. If you do not use Oracle Payroll, it must be set to HR User for all responsibilities. If you do use Oracle Payroll, you can give each Responsibility one of the following user types, depending on the work role of the holders of the responsibility: HR User, HR with Payroll User, Payroll User</td>
</tr>
<tr>
<td>HR:Query Only Mode</td>
<td>Restricts access to view–only for all HR and Payroll forms on a menu.</td>
</tr>
<tr>
<td>HR:Use Standard Attachments</td>
<td>Enables the facility to attach short text comments to records. Enables the attachment of multiple items of various types including OLE objects, Web pages, images, and word processed documents.</td>
</tr>
</tbody>
</table>

Table 29 – 1 HR User Profile Options
DateTrack:Date Security

Controls the way users can change their effective date:
- **All** (users can change to any date),
- **Past** (users can change to dates in the past only),
- **Present** (users cannot change their effective date),
- **Future** (users can change to dates in the future only)

DateTrack:Reminder

Determines whether the Decision window appears when a datetracked window opens:
- **Always** (the window always appears),
- **Never** (the window never appears),
- **Not Today** (the window appears only if the effective date is not the system date)

<table>
<thead>
<tr>
<th>DateTrack Option</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>DateTrack:Date Security</td>
<td>Controls the way users can change their effective date:</td>
</tr>
<tr>
<td></td>
<td>- All (users can change to any date),</td>
</tr>
<tr>
<td></td>
<td>- Past (users can change to dates in the past only),</td>
</tr>
<tr>
<td></td>
<td>- Present (users cannot change their effective date),</td>
</tr>
<tr>
<td></td>
<td>- Future (users can change to dates in the future only)</td>
</tr>
<tr>
<td>DateTrack:Reminder</td>
<td>Determines whether the Decision window appears when a datetracked window opens:</td>
</tr>
<tr>
<td></td>
<td>- Always (the window always appears),</td>
</tr>
<tr>
<td></td>
<td>- Never (the window never appears),</td>
</tr>
<tr>
<td></td>
<td>- Not Today (the window appears only if the effective date is not the system date)</td>
</tr>
</tbody>
</table>

Table 29–2 DateTrack User Profile Options

See Also

*Oracle Applications System Administrator’s Guide*
Enabling Currencies

Oracle HRMS allows you to use multiple currencies for entering information about employee compensation and benefits. You can also record your payment methods to employees in different currencies.

For example, if you have employees living and working temporarily in other countries, you might want to record specific earnings or deductions for these employees in local currencies. You might also want to pay these employees a fixed amount into a bank account in their home currency. The remainder you would pay in a local currency.

Your startup data includes the definitions of all world currencies. These definitions are shared by all Oracle Applications and are controlled by the system administrator responsibility. You enable those currencies you want to use in the Currencies window.

**Note:** You must enable at least one currency as the default currency for all information related to money in your system. This default is known as the *Base Currency* for your Business Group.

**To enable a currency:**

- Query the currency you want to enable and check the Enabled check box. Save your choice to enable the currency.

You can never delete a currency, but you can disable it.

**To disable a currency:**

- Uncheck Enabled, or enter an End Date for the currency.
This chapter introduces the inquiry and reporting tools you can use with Oracle HRMS. It summarizes the reports and inquiry windows that are supplied with Oracle Human Resources and Oracle Payroll. It also explains how you can create and run your own QuickPaint reports for fast online reporting on people and assignments.
Overview of Inquiry and Reporting Tools

Oracle HRMS provides a range of inquiry and reporting mechanisms to meet the needs of different users:

- inquiry windows (including folders)
- predefined reports that can be scheduled and grouped for periodic processing
- DateTrack History, to view the changes to datetracked information over time
- QuickPaint, to create your own online inquiries and reports about people and assignments

In addition, you can use Oracle Reports or other tools to write your own reports. You can register these with the system so that they can be run in the same way as the predefined reports.

You can extract mail merge information from the human resource database to send to your word processing system. For example, you might want to produce standard letters for applicants as part of your recruitment process.

It is also possible to download information from the human resource database to other tools for reporting or editing. For example, you can use Oracle Application Data Export (ADE) to download information to a spreadsheet.

See Also

Viewing DateTracked Information and History: page 1 – 13
Using Oracle HRMS with Spreadsheets: page 33 – 5
Using a Word Processor: page 33 – 13
Inquiry Windows and Folders

Oracle HRMS includes some inquiry windows to meet the most common online reporting requirements. In these windows, you typically enter selection criteria in the first block then choose the Find button to view a list of people, assignments, or other entities that match your criteria. Some of these windows use folders to display the information retrieved by your criteria.

Folders are online views that you can customize. By default, the folder block in an inquiry window displays all records matching your inquiry and all fields available within the folder. However, you can create your own folders to display a subset of these records and fields. You can also choose the field labels, their size and order, and the sort sequence of the retrieved records.

For example, in the Assignment Folder window, you could create a folder called Sales Employees by Grade. This folder has the query criteria Organization = ‘Sales’, and it is sorted by grade.

You can define public folders, which all users can view, as well as private folders for your own use.

<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments Folder</td>
<td>Lists of assignments in a folder</td>
</tr>
<tr>
<td>Employee Assignment Processes (Oracle Payroll)</td>
<td>All the assignment processes for one employee assignment, which you can view, retry or roll back, with further information on run messages, run results, balances, payment details and costing</td>
</tr>
<tr>
<td>Payroll Processes (Oracle Payroll)</td>
<td>All the payroll processes for one payroll for a specified period, which you can view, retry or roll back, with further details on assignment processes, run messages and costing</td>
</tr>
<tr>
<td>People Folder</td>
<td>Lists of people in a folder</td>
</tr>
<tr>
<td>Salary Management Folder</td>
<td>List of assignments with their current approved salary and proposed new salary</td>
</tr>
<tr>
<td>Position Occupancy Folder</td>
<td>Lists of people who have held a selected position, or are applying for it, and the dates of their occupancy</td>
</tr>
<tr>
<td>List Assignments</td>
<td>Assignments that match the assignment components you specify for current applicants, employees, or both</td>
</tr>
<tr>
<td>List People by Assignment</td>
<td>People whose assignments match the assignment components you specify for current or former applicants, employees, or both</td>
</tr>
</tbody>
</table>

Table 30 – 1 Inquiry Windows in Oracle HRMS
<table>
<thead>
<tr>
<th>Inquiry Window</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Employees by Organization</td>
<td>All employees assigned to one organization and, optionally, to all organizations below it in a specified hierarchy</td>
</tr>
<tr>
<td>Assignment History</td>
<td>The dates of assignments and periods of service for an employee who has had more than one assignment. NOTE: use DateTrack History on the Assignment window to see historical changes to one assignment</td>
</tr>
<tr>
<td>List Employees by Position</td>
<td>All employees assigned to a specified position or organization and job</td>
</tr>
<tr>
<td>Assignment History</td>
<td>Current holders of positions at and below a specified position in a position hierarchy</td>
</tr>
<tr>
<td>View Employee Grade Comparatio</td>
<td>The amount employees receive for a specified element as a percentage of the mid-value of their grade rate range</td>
</tr>
<tr>
<td>List Employees by Absence Type</td>
<td>All absences of a particular absence type or category within, optionally, a specified time period</td>
</tr>
<tr>
<td>View Employee Absence History</td>
<td>Periods of absence for a specified employee</td>
</tr>
<tr>
<td>List People by Special Information</td>
<td>All people for whom you have entered details about a specified special information type</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>All employee assignments receiving a specified compensation element within a given time period</td>
</tr>
<tr>
<td>View Element Entry History for Employee</td>
<td>The history of entries of one or more elements for an employee assignment</td>
</tr>
<tr>
<td>List Position Budget Variance</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for positions below a chosen position in a hierarchy</td>
</tr>
<tr>
<td>List Budget Variance by Organization</td>
<td>Variances between the number of actual position holders and the values entered in a specified budget for all positions in organizations at and below a chosen organization in a hierarchy</td>
</tr>
<tr>
<td>View Employee Benefits</td>
<td>View benefit plans on which an employee is enrolled and the coverage level and contributions for each plan</td>
</tr>
<tr>
<td>View Vacancies</td>
<td>Vacancies matching assignment components and other criteria you select</td>
</tr>
</tbody>
</table>

Table 30 – 1 Inquiry Windows in Oracle HRMS
Predefined and User Defined Reports

There are a number of predefined reports that you can use immediately without any further set up (see Table 30 – 2). They have a predefined format but you can choose which records to view by entering a set of parameters when you submit the report.

These reports run in batch mode: you submit them for processing in the Submit Requests window and can view their progress using the View Requests window. The requests are handled by a concurrent manager so you can continue working online while your request is processed.

You can schedule the reports to run regularly and you can group them with other reports and processes to run as a set. You can also control access to the reports and control their printing. For example, the system administrator might want to ensure that users in one location always print their reports on a local printer.

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Information Provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absences</td>
<td>Absence details for an employee or organization, for some or all absence types</td>
</tr>
<tr>
<td>Assignment Status</td>
<td>All employees, applicants, or both assigned to selected work structures</td>
</tr>
<tr>
<td>Current and Projected Progression Point Values</td>
<td>The expected results of running the Increment Progression Points process, that is, the projected point and value changes for a group of employees</td>
</tr>
<tr>
<td>Element Link Details</td>
<td>The eligibility criteria for an element or a group of elements</td>
</tr>
<tr>
<td>Element Result Listing (Oracle Payroll)</td>
<td>Run results processed for a particular element over a defined period, and run results for selected input values of each employee’s last assignment process</td>
</tr>
<tr>
<td>Employee Increment Results</td>
<td>The actual results of running the Increment Progression Points process, that is, progression point and value changes for a group of employees</td>
</tr>
<tr>
<td>Employee Organization Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected organization, or organization hierarchy</td>
</tr>
<tr>
<td>Employee Payroll Movements</td>
<td>New hires, terminations, transfers in and transfer out of a selected payroll</td>
</tr>
<tr>
<td>Employee Summary</td>
<td>Addresses, contacts, period of service, assignments, special information, personal payment methods, and element entries for a selected employee</td>
</tr>
<tr>
<td>Full Applicant Details</td>
<td>Applications and applicant interviews for one applicant</td>
</tr>
</tbody>
</table>

Table 30 – 2 Standard Reports in Oracle HRMS
## Table 30-2 Standard Reports in Oracle HRMS

You can create your own reports using Oracle Reports or SQL*Plus or another tool of your choice. You can register them with Application Object Library. This means you can run them from the standard Submit Requests window, and you can schedule them in report sets with other reports and processes.

### See Also

- Assignment Status Report: page 14 – 33
- Employee Summary Report: page 14 – 34
- Employee Movements Report: page 14 – 34
- Terminations Report: page 14 – 19
Employee Increment Results Report: page 4 – 19
Current and Projected Progression Point Values Report: page 4 – 18
Organization Hierarchy Report: page 2 – 39
Position Hierarchy Report: page 3 – 24
Absences Report: page 26 – 18
Reviewing Element Links: page 7 – 39
Tax Reporting (Oracle Payroll User’s Guide)
Reports on Pay Processing (Oracle Payroll User’s Guide)
Submitting a Request
(Oracle Applications User’s Guide)
Oracle Application Object Library Reference Manual
QuickPaint

QuickPaint is a powerful and flexible tool to design reports about assignments in the format you require. You can include the following sorts of information in a QuickPaint report:

- Personal information
- Contact information
- Assignment information
- Application information
- Compensation and benefit information
- Descriptive Flexfield information

Once you have designed a QuickPaint report, you and other users can run the report online for any assignment or set of assignments. You can view the results online or print them.
Defining QuickPaint Reports

You can design QuickPaint reports in the Define QuickPaint Report window.

In the Report Definition area, you can enter free text to introduce the report and to label the information that the report extracts from the database. You can also select database items, which are tags representing the information to be extracted from the database. When you run the report, the database item names are replaced by the appropriate data for the assignment or set of assignments for which the report is run.

You must be careful how you position the database items so that QuickPaint interprets them correctly and formats the report in the layout you require.

To define a QuickPaint Report:

1. Enter a name, and optionally a description, of the report.
   
   The Protected field is display only; some reports provided by localization teams are protected against edits.
2. In the Report Definition area, enter free text exactly as you want it to appear on the report.

3. To select database items, choose the Show Items button and run a query to display a list of database items, then select and copy items to the Report Definition area.

Notice that the database item name must begin with an ampersand (&). Names without an ampersand are treated as free text.

4. Save the report definition.

Positioning Items

If you want to add free text immediately after a database item, you must separate it from the database item with at least one space. Otherwise QuickPaint reads the database item as free text.

Both free text and database items appear in the report results on the line on which you painted them in the Report Definition area. They also generally appear in the column in which you painted them. However, it might be that the data replacing a database item name is long enough to push later items on the same line to the right.

For example, if you paint database items and free text like this:

```
&ASG_JOB       in &ASG_ORG
```

the report results print like this:

```
Technician     in Biochemistry
Scientific Officer in Biochemistry
```

Notice that, in the second result, the free text ‘in’ is pushed to the right and one space is entered before it.

If you know the number of the column in which you want text or a database item to appear, you can enter it like this:

```
&ASG_JOB       &32in &ASG_ORG
```

However, the text ‘in’ will still be pushed to the right if the preceding database item (&ASG_JOB) extends beyond column 32. If you would prefer the preceding database item to be truncated, paint the line as follows:

```
&ASG_JOB       &&32in &ASG_ORG
```

The report results will look like this:

```
Technician     in Biochemistry
Scientific Off in Biochemistry
```
If you want one space between two database items or between a database item and text, then paint them separated by a single space. The single space is always preserved. For example, this definition:

```
&EMP_FIRST_NAME &EMP_LAST_NAME
```

gives the following report results:

```
Alice Hollister
Ray Garcia
```

### Adding Conditions or Calculations to QuickPaint Reports

When you save a report definition, QuickPaint generates a formula to extract the information required by the report. You can view this formula in the Formulas window. To query the formula, enter the name of your QuickPaint report preceded by the prefix QP_.

Formulas generated from QuickPaint definitions do not contain conditional logic or mathematical computations. If you need these features, query the formula in the Formulas window and copy it. Edit the copy to add the logic you require.

**Attention:** You should not edit the original QuickPaint formula. Always edit a copy. Any edits of the original formula are overwritten if you change the report definition in the QuickPaint Report window.

### See Also

- Static Database Items: page C – 2
- Dynamic Database Items: page C – 19

Using Oracle FastFormula to Define QuickPaint Reports, *Oracle FastFormula User’s Guide*
Running QuickPaint Reports

You run QuickPaint reports from the Run QuickPaint Report window. You can run a report for one assignment or for a group of assignments.

Prerequisites

- To run a QuickPaint report for a group of assignments, you must first define an assignment set.

To run a report for one assignment:

1. Select the type Assignment.
2. In the Assignment region, select the assignment for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

When you run a QuickPaint report, the system runs the formula associated with the report. The first time you run a report, the
system may take several seconds to identify all of the related data and bring it back to the screen. All subsequent inquiries for other employees or applicants will run very quickly.

To run a report for an assignment set:

1. Select the type Assignment Set.
2. In the Assignment Set region, select the assignment set for which you want to run the report.
3. In the Report field, select the report you want to run.
4. Choose the Run Report button.
   The message line tells you when the report is complete.
5. Choose the View Report button to see the report results.

Customizing the Run QuickPaint Reports Window

Using the standard QuickPaint Report window, you can run the report for an assignment or an assignment set. The assignments can be held by current employees or applicants.

Your system administrator can create customized versions of this window to restrict the reports you can run and the people you can report on. A customized version might be subject to one or more of the following restrictions:

- report on one person type only (employees OR applicants)
- run one report only
- report on single assignments only, or report on assignment sets only

If the window is subject to the third type of restriction, it will look different to the standard version since it will contain either the assignment region or the assignment set region, but not both.

See Also

Restricting the Data Displayed in a Window: page 31 – 3
Creating an Assignment Set

There are two uses of assignment sets in Oracle HRMS:

- You can run a QuickPaint report for a set of assignments, rather than individual assignments.
- In Oracle Payroll, you can process subsets of the employees assigned to a payroll. Normally you initiate payroll runs and other post–run processes for one or more payrolls at a time. However, if you need to process smaller groups within a single payroll, you define an assignment set.

There are three ways to define the set:

- You can enter selection criteria, which the system generates into a formula. When you use the assignment set, Oracle FastFormula runs the formula to find the assignments that match the criteria. It checks all the assignments in the Business Group or, if you select a payroll when you define the set, all the assignments to that payroll. When you define the set you can also include or exclude individual assignments to modify the set created by the formula.
- You can select individually all the assignments you want to include in the set.
- You can start from a full set of all the employees in the Business Group or all the employees assigned to a selected payroll. Then you can exclude individual assignments from the set.

Use the Assignment Set window to define your set.

To define an assignment set using criteria for a formula:

1. Enter a unique name for the set.
2. Do one of the following:
   - If you are defining an assignment set for payroll processing, you must select a payroll. You cannot process an assignment set drawn from more than one payroll.
• If you are defining an assignment set for other purposes, selecting a payroll is optional. If you select a payroll, the formula generated from your selection criteria will select assignments from this payroll only. If you do not select a payroll, the formula will select assignments from the whole Business Group.

3. Save the new set and choose the Criteria button.

4. In the Assignment Criteria window, enter one criterion in each row, and join the criteria with AND or OR in the Condition field. Field details are as follows:

   No.: The sequence number of each condition in your rule. If you use sequence numbers that are multiples of 10, it will be easier to insert new conditions later.

   Condition: Leave the first row blank. Enter AND or OR for second and subsequent rows.

   Database Item: Select database items as variables for your definition. All database items are prefixed by an ampersand [&].

   Operator: Select operators to determine relationships between database items or values. The list of operators is shown in Table 30 – 4.

   Value/Database Item: Select database items for the second variable. Alternatively, you can enter a fixed value of the same type as the database item. Enter text values in single quotes.

   As an example, here is a definition for an assignment set of employees with salaries between 16,000 and 24,000:

<table>
<thead>
<tr>
<th>No.</th>
<th>Condition</th>
<th>Database Item</th>
<th>Operator</th>
<th>Value/Database Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>AND</td>
<td>&amp;SALARY_PAY_VALUE_ENTRY_VALUE</td>
<td>=&gt;</td>
<td>16000</td>
</tr>
<tr>
<td>20</td>
<td>AND</td>
<td>&amp;SALARY_PAYVALUE_ENTRY_VALUE</td>
<td>&lt;=</td>
<td>24000</td>
</tr>
</tbody>
</table>

   Table 30 – 3 Assignment Set Criteria

5. Save your criteria and choose the Generate button to generate the formula.

   You can view and edit the formula in the Formula window. Its name is the same as the assignment set name.

   See: Using Oracle FastFormula to Define Assignment Sets, Oracle FastFormula User’s Guide

6. If you want to include or exclude individual assignments from the set defined by your criteria, choose the Amendment button. Select the assignments you want to include or exclude from the set.
Note: The list of assignments you see in this window is either all the assignments in the Business Group or, if you selected a payroll, all the assignments to that payroll. It does not show the assignments matching your criteria since these are identified dynamically each time the formula runs.

7. Save the set.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Symbols</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equals</td>
<td>=</td>
<td>The condition is true if both expressions have exactly the same value. For text, the case of the expression must be the same. So, for example, ‘Smith’ is not equal to ‘SMITH’.</td>
</tr>
<tr>
<td>Not Equal</td>
<td>!=</td>
<td>The condition is true if the result of the first expression does NOT have the same value as the result of the second expression.</td>
</tr>
<tr>
<td>Greater than</td>
<td>&gt;</td>
<td>The condition is true if the first expression is alphabetically after, or has a numerically greater value, or a later date than the second expression.</td>
</tr>
<tr>
<td>Less than</td>
<td>&lt;</td>
<td>The condition is true if the first expression is alphabetically before, or has a numerically smaller value, or an earlier date than the second expression.</td>
</tr>
<tr>
<td>Greater than or equal to</td>
<td>&gt;=</td>
<td>The condition is true if either the greater than OR the equal to operator returns a true result.</td>
</tr>
<tr>
<td>Less than or equal to</td>
<td>&lt;=</td>
<td>The condition is true if either the less than OR the equal to operator returns a true result.</td>
</tr>
</tbody>
</table>

Table 30–4 Values in Operator Field

To define a set by including or excluding assignments:
1. Enter a unique name for the set.
2. If you are defining a set for payroll processing, select a Payroll.
3. Save the new set.
4. Choose the Amendment button.
5. Do one of the following:
   - If you want to create a small set of assignments, select Include in the Inc/Exc field and select all the assignments for the set.
   - If you want to start from the full set of assignments for the payroll or Business Group, select Exclude in the Inc/Exc field and select assignments to remove from the set.
Attention: Do not create a mixture of Include and Exclude rows if you have not entered criteria and generated a formula.

6. Save your set.
Custom Reports

The Custom Reports function provides a generic reporting capability that makes use of a single report to print out a custom definition. This report is called PERGENRP.

The report is registered as a concurrent process and prints, in landscape format, the contents of the temporary table PER_GENERIC_OUTPUT_REPORT.

This table contains the individual components of a custom report and is populated by the PL/SQL package PERGENRP.pkb, stored in $PER_TOP/admin/sql. This package is executed when you select the Generate Report button on the Custom Reports window.

To submit a Custom Report:

1. Navigate to the Custom Reports window.
2. Select the report by name.
3. Enter any parameters for this report.
4. Choose the Generate Report button

Attention: Parameter values are not validated until you choose the Generate Report button.

Creating New Report Formats

A special feature of Custom Reports is that you do not need to create multiple reports. You modify the generic package (PERGENRP.pkb) and report to provide additional formats and parameters.

Three sample report formats are provided, each with a different set of parameters:

- PERCS001 – Custom Report 1
  There is one parameter: Vacancy. The format in PERGENRP is Full Name of Applicant and Gender.

- PERCS002 – Custom Report 2
  Parameters are Vacancy and Gender. The format in PERGENRP is Full Name of Applicant in uppercase.

- PERCS003 – Custom Report 3
Parameters are Vacancy, Gender and Marital Status. The format in PERGENRP is *Full Name of Applicant, Gender* and then *Full Name* in uppercase.

You can edit the generic package to change:

- Report Title Page
- Header
- Footer
- Body Text

After you have modified the package, you need to register a new custom report, with the parameter set for that report. This is a task for the System Administrator.

▶ **To register a new Custom Report with parameters:**

1. Navigate to the Concurrent Programs window.
2. Enter the name of the Custom Report as the Program.
3. Enter a short name for the Custom Report.

   **Attention:** You must start the short name with PERCS. This will limit the list of values available to users in the Custom Report window.
Customizing Windows and Menus

As part of your implementation plan, you identify who will use Oracle HRMS, what information they require, and how they will use it. You can group together users with similar requirements and give them the same view of the system. For each group, you can:

- set up menus using structures and names that make sense to the users
- link windows into flows that the users follow to complete a task
- restrict the data they can view and edit in certain windows, so they only see what they need to see

These customizations provide security for your data and an efficient interface designed for your users’ needs.

In addition to these customizations for groups of users, you can customize windows for all users by adding data fields to hold additional information required by your enterprise.
Adding New Fields to Windows

The predefined fields in Oracle HRMS windows are designed to meet your core information requirements. However, like all enterprises, you may have special requirements that are best met by fields that you design yourself. Oracle HRMS provides a flexible mechanism called descriptive flexfields to enable you to add fields to windows.

Figure 31 – 1 illustrates the distinctive appearance of descriptive flexfields. When users click in a flexfield that you have set up, a window opens, displaying up to 20 segments that you have defined.

Defining Segments

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the flexfield window
- Context sensitive segments, which appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same zone.

For example, a segment to hold details of an employee’s disability might display only when the Disabled field contains the value Yes.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

See Also

List of Descriptive Flexfields: page B – 6

Oracle Applications Flexfields Guide
Restricting the Data Displayed in a Window

Many of the standard Oracle HRMS forms are multipurpose. For example, in the Person form, you can enter or view details of employees, applicants, contacts, or other person types that you have defined. In the Element Entries form, you can make entries for all the elements you have defined.

You may prefer to have multiple versions of these forms, each version being used for just one purpose. This approach restricts the list of values on certain fields and therefore provides for faster data entry. It also allows you to limit access to certain types of information.

For example, you might create a customized version of the View Element Entry History for Employee form that does not display the earnings elements representing salary, bonus, and commission. Most users’ menus would only give them access to this customized version of the form. For the small group of people authorized to view salary, bonus, and commission figures, your system administrator can define a menu function to allow access to the uncustomized form.

Table 31 – 1 lists the forms you can customize and the criteria you can use to restrict access to information.

<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Balance</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td>(Oracle Payroll form)</td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td>Define User Values</td>
<td>Table Name</td>
<td>User defined</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
<tr>
<td></td>
<td>Entry Type</td>
<td>Override</td>
</tr>
<tr>
<td>Event Bookings</td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td>List Employees by Element</td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

Table 31 – 1 List of Customizable Forms
### Table 31 – 1 List of Customizable Forms

<table>
<thead>
<tr>
<th>Form</th>
<th>Restrict By</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>List People by Special Information</strong></td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td></td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td><strong>Organization</strong></td>
<td>Organization Classification</td>
<td>List of Organization Classifications</td>
</tr>
<tr>
<td><strong>Payroll and Assignment Processes</strong></td>
<td>Action Type</td>
<td>List of Action Types (e.g. Run, Pre-payments, Reversal)</td>
</tr>
<tr>
<td>(Oracle Payroll form)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>People Folder</strong></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td><strong>People (PERWSEPI), People and Assignment (PERWSHRG)</strong></td>
<td>Person Function</td>
<td>Enter Employee, Enter Applicant, Hire people already on system</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td><strong>Position Occupancy Folder</strong></td>
<td>Employee or Applicant</td>
<td>Employee, Applicant</td>
</tr>
<tr>
<td><strong>Run QuickPaint Report</strong></td>
<td>QuickPaint Inquiry</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Person Type</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Assignments</td>
<td>Assignment Sets, Assignments</td>
</tr>
<tr>
<td><strong>Special Information</strong></td>
<td>Special Information Type</td>
<td>User defined</td>
</tr>
<tr>
<td><strong>View Element Entry History for Employee</strong></td>
<td>Element Set</td>
<td>User defined</td>
</tr>
<tr>
<td></td>
<td>Element Processing Type</td>
<td>Recurring, Nonrecurring</td>
</tr>
</tbody>
</table>

### Types of Data Restrictions

You can restrict the information that appears in a customized form by the following sorts of criteria:

- element type (recurring or nonrecurring)
- element set (user defined)
• person function (enter employee, enter applicant, hire someone on system)
• person type (user defined)
• special information type (user defined)
• organization classification
• employee or applicant
• QuickPaint Report (user defined)

If you want to restrict the data by a user defined information type, you must create it first:

• To restrict by element set, create the set in the Element and Distribution Set window.

• To restrict by QuickPaint Report, create the report in the Define QuickPaint Report window.

  See: Defining QuickPaint Reports: page 30 – 9

• To restrict by Special Information Type, define your information type as an instance of the Personal Analysis key flexfield.

  See: Defining Special Information Types: page 28 – 10

• To restrict by person types, define your user person types in the Person Types window.

  See: Defining Person Types: page 28 – 3

---

**Defining an Element or Distribution Set**

In the Element and Distribution Set window, you can select element classifications or individual elements to define a set. There are three types of set:

• Customization set: You can use a Customization set to restrict the elements that can be entered or viewed on a customized version of the Element Entries window.

• Run set: Oracle Payroll users can use a Run set to specify the elements to be processed in a payroll run.

• Distribution set: Oracle Payroll users can use a Distribution set to define the elements over which the costs of other elements are to be distributed.
To define an element or distribution set:

1. Enter a unique name for the set and select the Type: Distribution, Run, or Customization. Save your new set.

2. If you want to include all elements in a classification, choose the Classification Rules button.
   - In the Classification Rules window, select one or more classifications to include. Save the set and close this window.
   
   The elements in the classifications you choose are now listed in the Elements region.
   - If you want to exclude individual elements, place your cursor in the element’s row and choose the Exclude Element button.

3. If you want to include particular elements from other classifications, choose the Include Element button.
   - In the Elements window, select the element you want to include and choose the OK button.
   
   **Note:** After you include a particular element, you cannot go to the Classification Rules window and include the classification to which this element belongs.

4. Save your set.

5. If you want to see a list of the individual elements you have included or excluded from the set, choose the Element Rules button. The Element Rules window is view–only.
Defining Customized Forms

You can define customized versions of certain forms in the Form Customization window.

See: Table 31 – 1 List of Customizable Forms: page 31 – 4

Note: If you want to restrict access to query–only for a form, you do not need to create a customized version. Instead you create a new form function, setting the QUERY_ONLY parameter to YES.

See: Setting Up Query–only Access to Forms: page 31 – 19

To define a customized version of a form:

1. Select the name of the standard form in the Form to be customized field. All GUI Smart Client form names are prefixed by F4.
2. Enter the name of your new version in the Name field. This name is used when defining menus but it is not seen by users.
3. Select Enabled if you want the restrictions to come into effect. If you do not select this option, the customized version of the form behaves the same way as the standard version.
4. Enter the titles to appear in the new version of the form:
   - In the Standard Title field, enter the window title to be seen by users who can use the form for data entry and editing.
• In the Query Title field, enter the window title to be seen by users who have view–only access to the form.

5. Save your new version.

6. In the Restrictions block, select the Type and Value of the restriction you want to define. The types and values available depend on the form you are customizing.

Adding the Customized Form to a Menu or Task Flow

If you want to add the customized form to a task flow, you must create a Task Flow Node for it.

If the customized form is called directly from the Navigator window, your System Administrator must define a menu function to call the form with the customization. The System Administrator can add this function to any menu.

Note: If you want to use a customized version of the People form, People Folder, or Assignment Folder to start a task flow, you should define a new customized task flow node and then define a menu function to call the task flow.

See Also

Calling Customized Forms and Task Flows from Menus: page 31 – 20
Linking Windows in Task Flows

To complete many tasks, users need to use more than one window. For example, to hire a new employee, users typically go from the Person window, to the Address window, to the Special Information window, to the Assignment window, and so on.

You can link these windows together in a task flow so that the user can choose a button to bring up each window in turn without returning to the menu. The first window in the task flow defines the context of the subsequent windows. For example, if the task flow begins with the People window, all subsequent information is entered for the person you enter or query in the People window.

You can include customized forms in task flows. For example, you might create a customized version of the People window that handles applicants only. Then you could use this customization in a recruitment task flow.

Oracle HRMS supplies a predefined task flow that includes all the windows that you can use in task flows. It is designed as a simple structure to use during implementation, not as a recommended structure for users.

Figure 31 – 2
Sequential Task Flow

![Sequential Task Flow Diagram]

- Person window
- Address window
- Special Information window
- Assignment window
Windows You Can Use in Task Flows

You can create your own task flows using the windows listed in Table 31 – 2, or customized versions of them. Some of these windows require the context of an assignment. This means that either the Assignment window or the Assignments Folder window or the Application window (for applicant assignments) must appear above them in the task flow.

All task flows must begin with one of the following forms:

- People and Assignment (PERWSHRG)
- People (PERWSEPI)
- People Folder (PERWSFPE)
- Assignments Folder (PERWSFAS)
- Job (PERWSDJT)
- Position (PERWSDPO)

**Attention:** Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), the Assignment window opens more quickly from the People window. We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absence Detail</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Address</td>
<td>Person</td>
</tr>
<tr>
<td>Window</td>
<td>Context Required</td>
</tr>
<tr>
<td>-----------------------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Adjust Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Applicant Interview</td>
<td>Assignment (applicant)</td>
</tr>
<tr>
<td>Application</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>Assignment</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Assignment</td>
</tr>
<tr>
<td>Assignments Folder</td>
<td>None</td>
</tr>
<tr>
<td>Beneficiaries</td>
<td>Element entry</td>
</tr>
<tr>
<td>Book Events</td>
<td>Person (employee or applicant)</td>
</tr>
<tr>
<td>Competence Profile</td>
<td>Person</td>
</tr>
<tr>
<td>Contact</td>
<td>Person</td>
</tr>
<tr>
<td>Costing</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Covered Dependents</td>
<td>Element entry</td>
</tr>
<tr>
<td>Element Entries</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Employee Tax Rules (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>External/Manual Payments (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>People Folder</td>
<td>None</td>
</tr>
<tr>
<td>People</td>
<td>None</td>
</tr>
<tr>
<td>Personal Payment Method</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Person</td>
</tr>
<tr>
<td>Picture</td>
<td>Person</td>
</tr>
<tr>
<td>Position</td>
<td>None</td>
</tr>
<tr>
<td>Position Occupancy</td>
<td>Position</td>
</tr>
<tr>
<td>Qualifications</td>
<td>Person</td>
</tr>
<tr>
<td>QuickPay (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Reverse Payroll Run (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
</tbody>
</table>

Table 31 – 2 Windows You Can Use in Task Flows
### Table 31 – 2 Windows You Can Use in Task Flows

<table>
<thead>
<tr>
<th>Window</th>
<th>Context Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Salary Administration</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Salary History</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Schools and Colleges (Establishment Attandances)</td>
<td>Person</td>
</tr>
<tr>
<td>Secondary Statuses</td>
<td>Assignment</td>
</tr>
<tr>
<td>Special Information</td>
<td>Person</td>
</tr>
<tr>
<td>Terminate</td>
<td>Person (employee)</td>
</tr>
<tr>
<td>Terminate Applicant</td>
<td>Person (applicant)</td>
</tr>
<tr>
<td>View Element Entry History</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>Work Choices (Job or Position)</td>
<td>Job or Position</td>
</tr>
<tr>
<td>Work Choices (Person)</td>
<td>Person</td>
</tr>
<tr>
<td>View Employee Accruals</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>View Employee Benefits</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>View Employee Earnings &amp; Deduction Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>View Employee Tax Balances (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
<tr>
<td>View SOE (Oracle Payroll)</td>
<td>Assignment (employee)</td>
</tr>
</tbody>
</table>

### Defining Task Flow Nodes

Each form in a task flow is a node. There are predefined nodes for every form that you can include in a task flow. However, if you create a customization of one of these forms, you must create a node for the customization before you can include it in a task flow.

You create nodes in the Define Task Flow Nodes window.
To create a task flow node:

1. Enter a name for the node. You select this name when you create a task flow containing the node. It is not visible to users.

2. Select the form that you customized. Leave the Block field blank.

3. Select the customization that you created.

4. Save the new node.
Defining Task Flows

You define task flows in the Define Task Flow window. If there is a similar existing task flow, you can copy it to form the basis of your new flow.

Including the Assignment Window in Taskflows

Using the combined People and Assignment form (PERWSHRG), rather than the separate forms (PERWSEPI and PERWSEMA), means the Assignment window opens more quickly from the People window.

Attention: We therefore recommend that you use the combined form in any taskflow that requires both windows. The seeded taskflows use the combined form.

When users move down a task flow from the combined form, the Assignment window remains visible in the background. They can return to the Assignment window by closing their current window. Therefore you should not define a button to call the Assignment window.

However, if you are defining a task flow to the Assignment window from any window except the People window, you should use the Assignment form (PERWSEMA). In this case you may wish to add an Assignment button to any forms below the Assignment window in the taskflow. This allows users to return to the Assignment window without going back to the top window.

Prerequisites

- First create nodes for any form customizations you want to include in the task flow.
To define a task flow:

1. Enter a name for the task flow and save it.
2. In the Node block, select the name of the node that you want to be the first form in the task flow.
3. For this node, select the Top Node check box.
4. Create a new record in the Node block and select another node. You must create all the nodes for the task flow before you can begin entering the navigation paths between them.
5. In the Navigation Options region, for each node, select the other nodes to which you can navigate.
6. Enter a sequence number to determine the order in which the navigation options appear as buttons (from left to right) along the base of the window or as options in a navigation list.
7. Select the Button check box for the navigation options that should appear as buttons. There is a limit on the number of buttons that can appear on each form. This number varies from form to form. The other options are displayed in a navigation list when the user chooses a button labelled Others. Or, if there is only one other option, this form displays when the user chooses a button labelled Next.
8. There is a default label that appears on buttons or in the navigation list for every form. You can override this with your own label.
If the label in the Define Taskflow window appears blue, this is the default value. It is a dynamic default: if the seeded value changes (for example, as the result of an upgrade), the label will be updated automatically in all task flows where it has not been overridden.

If the label appears black, the default value has been overridden. To re-inherit the default label, clear the field.

9. To define an access key (or keyboard shortcut) for a navigation option, precede the appropriate letter in the label with an ampersand (&). For example, to use ALT+P (in the Microsoft Windows environment) as the access key for the Picture window, enter the label &Picture.

Note: Do not use the following letters since they are used on the Oracle Applications menu: A, E, F, G, H, Q, S, W.

There is no validation to prevent the same letter being used more than once for a group of buttons.

10. Save the task flow.

To copy an existing task flow:

1. Query the existing flow and choose the Copy To button.
2. Enter the name of the new task flow and choose OK.
3. Query your new task flow and edit it as required.

See Also

Calling Customized Forms and Task Flows from Menus: page 31 – 20
Setting Up Navigation Menus

Users access standard windows, customized windows, and the first window in a task flow through the menu structure displayed in the Navigator window. Each responsibility is associated with a single menu structure. Using Function Security System Administrators can further restrict access to individual menu options.

By defining menus with function security for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices
- restrict users to query-only access to some or all windows

Each responsibility you define must be linked to one root menu, which is the list of menu options displayed when the Navigator window first opens.
The Default Menu Structure

The AutoInstall program creates a default menu structure for your HRMS product. This menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menu structure.

Using function security you can use this default menu for any number of responsibilities and restrict access to the default menu options. You can also define any number of new functions and menus to restrict the access of other users. To view the hierarchy of menus you have defined, you can run the Menu Structures Report.

The supplied menus give you access to all of the available submenus. However, a number of seeded functions are not enabled on these menus. You need to add them for the responsibilities that should have access to these functions:

- **HR View Medical**
  This function causes the Medical Information alternative region to display in the People window.

- **HR View Background**
  This function causes the Background Information alternative region to display in the People window.

- **HR View Rehire**
  This function causes the Rehire Information alternative region to display in the People window.

- **Salary Administration: Approve**
  This function enables the user to approve salary proposals in the Salary Administration window and the Salary Management folder.

Suggestions for Structuring Menus

Menus can be structured in different ways:

- following a sequence of tasks, such as:
  1. Define a Requisition and Vacancy
  2. Define a Recruitment Activity
  3. Enter Applicant Information

- by type, such as inquiry windows, in which case the grouping is important but the sequence is not
When you define a new menu you should start by drawing it out on paper. This will help you to decide the best structure and the best prompts and descriptions. Work from the lowest level of sub-menu to the highest and define the root menu as the last step in the sequence.

You can define as many submenus as you require under each menu option. We recommend that you restrict the number of menu levels to three because a menu structure with more levels is cumbersome to use.

**Opening Multiple Forms**

In most Oracle Applications, you can open multiple forms from the Navigator window without closing the form you already have open.

**Attention:** You must disable this feature on a menu structure that accesses Oracle HRMS task flows. To prevent the confusion of working with multiple effective dates, you should also disable this feature if your menu structure accesses Oracle HRMS datetracked forms.

**To disable the Multiple Open Form feature:**

1. Add a Function type menu entry to the top-level menu referenced by your new responsibility.
2. Select the function whose User Function Name and Function Name are:
   - Disable Multiform, Multisession
   - FND_FNDSCSGN_DISABLE_MULTIFORM
3. Save your changes.

**See Also**

Default Navigation Menus for HR with Payroll Responsibility: page A – 2

Menus
*Oracle Applications System Administrator’s Guide*

Menu Report
*Oracle Applications System Administrator’s Guide*

**Setting Up Query–only Access to Forms**

You can restrict access to query–only for all HR and Payroll forms on a menu by setting the user profile option HR:Query Only Mode to Yes.
You can set this profile for individual responsibilities or users, or at the site or application level.

If you want to give query–only access to some forms and full access to other forms, set the HR:Query Only Mode profile to No and use the parameter QUERY_ONLY=Yes at form function level to restrict access to individual forms.

**Note:** You can set the parameter QUERY_ONLY=Yes for a form function that also launches a task flow. In this case, specify two parameters in the Form Function window:

- QUERY_ONLY=Yes
- WORKFLOW_NAME="taskflow name"

The entire task flow will be query–only, not just the first form.

To restrict access to query–only mode for an individual form:

1. In the Form Functions window, select the form and specify the parameter QUERY_ONLY=Yes. If you want to specify other parameters for this form function, separate them with a space.
2. Enter a user function name to identify your new function, and save it.
3. In the Menus window, select your new function instead of the supplied form function.

**Calling Customized Forms and Task Flows from Menus**

For certain options you must define menu functions that include a parameter in the Parameters field of the Form Functions window, as follows:

- If the menu entry calls a customized form, use the following parameter:
  
  HR_CUSTOMIZATION = "customization name"

- If the menu entry calls the first form in a task flow, use the following parameter:
  
  WORKFLOW_NAME = "task flow name"

- If the menu entry calls a form in query–only mode, use the following parameter:
  
  QUERY_ONLY=Yes

- If the menu entry calls the Define Rate form (PAYWSGEV), use the following parameter:
FORM_MODE = “grade” (for the Grade Rate window)
FORM_MODE = “spine” (for the Scale Rate window)

• If the menu entry calls the Payroll and Assignment Processes form (PAYWSACT – used in Oracle Payroll), use the following parameter:
  FORM_MODE = ”assignment” (for the Assignment Processes window)
  FORM_MODE = “payroll” (for the Payroll Processes window)

If you need to specify more than one parameter for a form function, separate the parameters with a space.
Quick Codes provide lists of valid values on certain fields throughout the system. For many types of code you can add your own values and change the values that are predefined. You can also set up your own types of QuickCode.

You can set up user tables to provide matrices of valid values that vary according to a factor such as age, or job, or number of years service. You can access these values from formulas, or your own forms or reports, using a supplied function.

This chapter explains how to set up QuickCode Types and how to add values to predefined QuickCodes. It lists the predefined QuickCodes to which you can add values. It also explains how to set up user tables and enter values for the rows and columns you define.
QuickCodes

Providing lists of valid values for certain items of information has two key advantages:

- It ensures that all users use the same terminology, which makes it easier to inquire and report on the information.
- It speeds up data entry because you can enter just enough to identify the value, and the system completes the entry.

In Oracle HRMS, a list of values is called a QuickCode Type. Each value comprises a code and a meaning. For example:

<table>
<thead>
<tr>
<th>QuickCode Type</th>
<th>Code</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>YES_NO</td>
<td>Y</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>N</td>
<td>No</td>
</tr>
</tbody>
</table>

The codes are used internally; users do not see them. There is a maximum of 250 QuickCodes for each QuickCode Type.

Predefined QuickCode Types

A number of QuickCode Types are included in Oracle HRMS. Some contain codes as startup data. You can never delete these codes, but you can change their meaning. For some QuickCode Types, you can also disable the codes that are supplied. Your ability to disable codes and add new codes is determined by the access level of the QuickCode Type:

- **User**: You can add codes and you can disable supplied codes.
- **Extensible**: You can add new codes, but you cannot disable supplied codes because the system uses them.
- **System**: You can neither add codes nor disable supplied codes. You can only change the meaning or description of supplied codes.

Table 32–1 lists the predefined QuickCode Types with an access level of User or Extensible.

You can also create your own QuickCode Types in the QuickCode Type window. These all have an access level of User.
Adding QuickCode Values

To add, disable, or change the meaning of a QuickCode, use the QuickCodes window.

1. Query the QuickCode Type to which you want to add a value.
   You cannot add values if the Access Level is System.
2. Enter a code and meaning. Optionally, enter a start and end date.
   If you do not enter a start date, the new QuickCode is valid immediately. If you do not enter an end date, the new QuickCode is valid indefinitely.

Removing QuickCode Values

You cannot delete QuickCodes after saving them, but you can stop them appearing in lists of values.

To remove a user defined QuickCode:

- In the QuickCodes window, do one of the following:
  - Disable the code by unchecking the Enabled check box if you want to prevent users selecting this value on any date.
  - Enter an end date if you want to prevent users selecting this value after a certain date.
• Change the meaning and description to create a replacement QuickCode.

If you disable the QuickCode or set an end date, users cannot select this value when they create new records. However, they can continue to see the value when they query records that contain it.

If you add, disable, or change the meaning of a QuickCode, users must log out and log back in again for your changes to take effect.
Defining QuickCode Types

You can create your own QuickCode Types to provide lists of values, for example to validate element entries.

Define the new type in the QuickCode Types window, then query it in the QuickCodes window to define the values that appear in lists.

To define a new QuickCode Type:

1. Enter the name and meaning of your new type.
2. Save your work.
3. Optionally, choose the Usages button and select other Oracle Applications in which you want to use this new QuickCode Type.
# User and Extensible QuickCodes

<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (absence)</td>
<td>ABSENCE_CATEGORY</td>
</tr>
<tr>
<td>Reason (for absence)</td>
<td>ABSENCE_REASON</td>
</tr>
<tr>
<td>Account Type (for bank details)</td>
<td>ACC_TYPE</td>
</tr>
<tr>
<td>Address Type</td>
<td>ADDRESS_TYPE</td>
</tr>
<tr>
<td>Reason (for application assignment status)</td>
<td>APL_ASSIGN_REASON</td>
</tr>
<tr>
<td>Type (event type for applicant)</td>
<td>APL_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (interview type for applicant)</td>
<td>APL_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>APL_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Appraisal and Assessment Status (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_ASSESSMENT_STATUS</td>
</tr>
<tr>
<td>Appraisal and Assessment Type (Appraisal and Assessment on the Web)</td>
<td>APPRAISAL_TYPE</td>
</tr>
<tr>
<td>State (Australian addresses)</td>
<td>AU_STATE</td>
</tr>
<tr>
<td>Blood Type</td>
<td>BLOOD_TYPE</td>
</tr>
<tr>
<td>Measurement Type (for budget)</td>
<td>BUDGET_MEASUREMENT_TYPE</td>
</tr>
<tr>
<td>Cash Analysis (for a cash payment)</td>
<td>CASH_ANALYSIS</td>
</tr>
<tr>
<td>Census Metropolitan Area (Canada)</td>
<td>CA_CMA</td>
</tr>
<tr>
<td>Province (Canadian addresses)</td>
<td>CA_PROVINCE</td>
</tr>
<tr>
<td>Method</td>
<td>CERTIFICATION_METHOD</td>
</tr>
<tr>
<td>User friendly names for cheque-ordering SQL statement</td>
<td>CHEQUE_PROCEDURE</td>
</tr>
<tr>
<td>User friendly names for cheque-writing SRW2 reports</td>
<td>CHEQUE_REPORT</td>
</tr>
<tr>
<td>Primary Evaluation Method</td>
<td>COMPETENCE_EVAL_TYPE</td>
</tr>
<tr>
<td>Competence Type</td>
<td>COMPETENCE_TYPE</td>
</tr>
<tr>
<td>Type (relationship of one person to another)</td>
<td>CONTACT</td>
</tr>
<tr>
<td>Type (of MIX batch control total)</td>
<td>CONTROL_TYPE</td>
</tr>
</tbody>
</table>

Table 32–1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reason (for element entry)</td>
<td>ELE_ENTRY_REASON</td>
</tr>
<tr>
<td>Reason (for employee assignment)</td>
<td>EMP_ASSIGN_REASON</td>
</tr>
<tr>
<td>Employment Category</td>
<td>EMP_CAT</td>
</tr>
<tr>
<td>Type (of employee event)</td>
<td>EMP_EVENT_TYPE</td>
</tr>
<tr>
<td>Type (of interview for employee)</td>
<td>EMP_INTERVIEW_TYPE</td>
</tr>
<tr>
<td>Reason (for secondary assignment status)</td>
<td>EMP_SEC_ASSIGN_REASON</td>
</tr>
<tr>
<td>Ethnic Origin</td>
<td>ETH_TYPE</td>
</tr>
<tr>
<td>System (job or position evaluation system)</td>
<td>EVAL_SYSTEM</td>
</tr>
<tr>
<td>Measurement In (type for EVAL SYSTEM)</td>
<td>EVAL_SYSTEM_MEAS</td>
</tr>
<tr>
<td>Type (of formula)</td>
<td>FORMULA_TYPE</td>
</tr>
<tr>
<td>Authority (for PAYE details)</td>
<td>GB_AUTHORITY</td>
</tr>
<tr>
<td>Bank Name</td>
<td>GB_BANKS</td>
</tr>
<tr>
<td>Certificate (for element NI)</td>
<td>GB_CERTIFICATE</td>
</tr>
<tr>
<td>Cheque Style</td>
<td>GB_CHEQUE_REPORT</td>
</tr>
<tr>
<td>County (UK addresses)</td>
<td>GB_COUNTY</td>
</tr>
<tr>
<td>Pension</td>
<td>GB_PENSION</td>
</tr>
<tr>
<td>Sequence (for the BACS process)</td>
<td>GB_SORT_SEQUENCE</td>
</tr>
<tr>
<td>Reason (for leaving)</td>
<td>LEAV_REAS</td>
</tr>
<tr>
<td>Marital Status</td>
<td>MAR_STATUS</td>
</tr>
<tr>
<td>Nationality</td>
<td>NATIONALITY</td>
</tr>
<tr>
<td>Name (of organization classification)</td>
<td>ORG_CLASS</td>
</tr>
<tr>
<td>Organization Type</td>
<td>ORG_TYPE</td>
</tr>
<tr>
<td>Category</td>
<td>PER_CATEGORIES</td>
</tr>
</tbody>
</table>

Table 32 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>FTE Capacity</td>
<td>PER_FTE_CAPACITY</td>
</tr>
<tr>
<td>Minimum Service</td>
<td>PER_LENGTHS_OF_SERVICE</td>
</tr>
<tr>
<td>Relocation</td>
<td>PER_RELOCATION_PREFERENCES</td>
</tr>
<tr>
<td>Status</td>
<td>PER_SUBJECT_STATUSES</td>
</tr>
<tr>
<td>Subject</td>
<td>PER_SUBJECTS</td>
</tr>
<tr>
<td>Work Duration</td>
<td>PER_TIME_SCALES</td>
</tr>
<tr>
<td>Tuition Method</td>
<td>PER_TUITION_METHODS</td>
</tr>
<tr>
<td>Work Hours</td>
<td>PER_WORK_HOURS</td>
</tr>
<tr>
<td>Work Schedule</td>
<td>PER_WORK_SCHEDULE</td>
</tr>
<tr>
<td>Rating</td>
<td>PERFORMANCE_RATING</td>
</tr>
<tr>
<td>Type</td>
<td>PHONE_TYPE</td>
</tr>
<tr>
<td>Reason (for grade step placement)</td>
<td>PLACEMENT_REASON</td>
</tr>
<tr>
<td>Status</td>
<td>POSITION_STATUS</td>
</tr>
<tr>
<td>Source of Proficiency Rating</td>
<td>PROFICIENCY_SOURCE</td>
</tr>
<tr>
<td>Reason (for salary proposal)</td>
<td>PROPOSAL_REASON</td>
</tr>
<tr>
<td>Units (qualifying units for probation period)</td>
<td>QUALIFYING_UNITS</td>
</tr>
<tr>
<td>Type (of recruitment activity)</td>
<td>REC_TYPE</td>
</tr>
<tr>
<td>Reason (for terminating application)</td>
<td>TERM_APL_REASON</td>
</tr>
<tr>
<td>Prefix</td>
<td>TITLE</td>
</tr>
<tr>
<td>Accrual Start</td>
<td>US_ACCRUAL_START_TYPE</td>
</tr>
<tr>
<td>Status of request for accommodation</td>
<td>US_ADA_STATUSES</td>
</tr>
<tr>
<td>Coverage Level (for medical, dental and vision benefit plans)</td>
<td>US_BENEFIT_COVERAGE</td>
</tr>
<tr>
<td>Status (of continued coverage)</td>
<td>US_COBRA_STATUS</td>
</tr>
<tr>
<td>Reason (for COBRA Termination)</td>
<td>US_COBRA_TERM_REASON</td>
</tr>
<tr>
<td>Category (within Earnings classification)</td>
<td>US_EARNINGS</td>
</tr>
</tbody>
</table>

Table 32 – 1 User and Extensible QuickCodes
<table>
<thead>
<tr>
<th>Field</th>
<th>QuickCodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category (within Imputed Earnings classification)</td>
<td>US_IMPUTED_EARNINGS</td>
</tr>
<tr>
<td>Category (within Information classification)</td>
<td>US_INFORMATION</td>
</tr>
<tr>
<td>Category (within Involuntary Deductions classification)</td>
<td>US_INVOLUNTARY_DEDUCTIONS</td>
</tr>
<tr>
<td></td>
<td>US_JOB_GROUPS</td>
</tr>
<tr>
<td>Filing Status for local income tax</td>
<td>US_LIT_FILING_STATUS</td>
</tr>
<tr>
<td>Exemption Reason (for excluding employee from New Hire report)</td>
<td>US_NEW_HIRE_EXCEPTIONS</td>
</tr>
<tr>
<td>Category (within Nonpayroll Payments classification)</td>
<td>US_PAYMENT</td>
</tr>
<tr>
<td>Category (of accrual plan)</td>
<td>US_PTO_ACCRUAL</td>
</tr>
<tr>
<td>Filing Status for state income tax</td>
<td>US_SIT_FILING_STATUS</td>
</tr>
<tr>
<td>State (US addresses)</td>
<td>US_STATE</td>
</tr>
<tr>
<td>Category (within Supplemental Earnings classification)</td>
<td>US_SUPPLEMENTAL_EARNINGS</td>
</tr>
<tr>
<td>Row Type (for Payroll Tables)</td>
<td>US_TABLE_ROW_TYPES</td>
</tr>
<tr>
<td></td>
<td>US_TAX_REPORT</td>
</tr>
<tr>
<td>Category (within Voluntary Deductions classification)</td>
<td>US_VOLUNTARY_DEDUCTIONS</td>
</tr>
<tr>
<td>Position of WC surcharge (after experience modifications and after premium discount)</td>
<td>US_WC_SURCHARGE_POSITION</td>
</tr>
<tr>
<td>Status (of a vacancy)</td>
<td>VACANCY_STATUS</td>
</tr>
<tr>
<td>Availability Schedule</td>
<td>WORK_SCHEDULE</td>
</tr>
</tbody>
</table>

Table 32 – 1 User and Extensible QuickCodes
User–defined Tables

You may need to set up your own tables in your Oracle HRMS system, to hold data such as wage codes, shift differentials, or the amounts of certain deductions. You can set up all the tables you require using the Table Structure window. Using Oracle FastFormula, you can write simple formulas for validating entries made in table columns.

Your Oracle HRMS startup data includes some predefined user tables that are either ready to receive entries, or that already have some entries.

**Attention:** You do not use the Table Structure window to set up tables holding information on medical, dental or vision benefit plans (benefits with the benefits classification Medical, Dental or Vision).

The Oracle HRMS database includes a special table, the Benefits Table, already set up to hold information on benefit plans with coverage levels, and the employee and employer contributions at each level. To enter information into this table you use the Benefit Contributions window.

See: Establishing Health Care Benefit Coverage and Default Contributions: page 10 – 12


Notice that the Oracle HRMS user–defined tables are different from the database tables of the Oracle Relational Database Management System. When you set up a user table, you define the rows as well as the columns, like a matrix. For example, you could set up a table showing bonus amounts (the column) against years of service (the rows).

Entering and Accessing Table Values

To enter values in tables, you use the Table Values window. Table entries and rows are both datetracked, so you can delete existing entries or rows, and add new ones, as of an effective date.

Oracle HRMS provides the GET_TABLE_VALUE function to access table values. You can yourself write formulas that include calls to this function, perhaps for QuickPaint inquiries. Also, it is easy for MIS personnel to write PL/SQL statements that call this function, to include in the code for a form or report process, for example.

The formulas for the predefined earnings types Regular Wages, Overtime, Shift Pay and GTL Imputed Income all include calls to this function, as do the formulas the system generates for deductions with the amount rule Payroll Table.
Row Types for Payroll Tables

Tables set up to hold deduction amounts are called payroll tables. You need a payroll table when the amount of a deduction varies in accordance with a factor such as employee age, pay or job class.

To initiate a deduction with the amount rule Payroll Table, you must establish a row type. The formula for the deduction uses the row type to help determine which row of the table to go to for each employee’s deduction amount. Your startup data includes three predefined row types: Age Range, Salary Range and Job Class. You can set up any additional types you require.

See Also

Setting Up Row Types for Payroll Tables, Oracle Payroll User’s Guide
Functions, Oracle FastFormula User’s Guide

Predefined User Tables

Oracle HRMS supplies the following tables, already defined using the Table Structure window:

COMPANY WORK SCHEDULES Table

This table has several commonly-used work schedules already entered in it, and you can add more. A work schedule shows the hours employees normally work each day from Monday through Sunday. For example, employees with the schedule 10–10–10–10–0–0–0 work 10 hours each day Monday through Thursday, and have Friday, Saturday and Sunday off.

Each column in this table holds a separate schedule, with each row holding the hours worked each day of the week for the schedule. For convenience, each column header names the schedule held in the column. For example, the header for the column holding the first schedule is 1 Schedule: 8–8–8–8–8–0–0.

GTL PREMIUMS Table

For use in Oracle Payroll, this table holds the cost of Group Term Life insurance premiums per $1,000 of coverage by age range, as maintained in the IRS Uniform Premiums table. The table rows hold
age ranges, and its single column holds the premium for each $1,000 of coverage for each age range.

Oracle Corporation provides you with updates to the GTL Premiums table, which your system administrator applies.

The predefined imputed earnings GTL Imputed Income references this table in its processing.

**SHIFT DIFFERENTIALS Table**

This table has no data already in it, but is ready for your data entry. Its rows hold the shift designators Day, Eve, Night and Split, representing the normal shifts employees work, and its columns have the same headings, for entry of differentials. You can add to or change the shift designators as necessary.

To look at examples of differentials entries, suppose day shift employees receive one and one-half times their regular pay when temporarily working the evening shift, twice their regular pay for the night shift, and three times their regular pay for the split shift. You enter 1.5, 2.0 and 3.0 as the differentials for day shift workers.

**Example Shift Differentials Table**

<table>
<thead>
<tr>
<th></th>
<th>D</th>
<th>E</th>
<th>N</th>
<th>S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day</td>
<td></td>
<td>1.5</td>
<td>2.0</td>
<td>3.0</td>
</tr>
</tbody>
</table>

The predefined earnings types Regular Wages and Shift Pay reference this table in their processing in Oracle Payroll.

**WAGE RATES Table**

This table has no data in it when you receive your system, but is ready for your data entry. Its rows hold rate codes, and its single column holds the rate matching each code. This example holds codes for rates associated with the operation of different types of equipment:

**Example Wage Rates Table**

<table>
<thead>
<tr>
<th>Rate Code</th>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>FL (forklift)</td>
<td>6.80</td>
</tr>
<tr>
<td>A3 (crane A3)</td>
<td>8.20</td>
</tr>
<tr>
<td>A7 (crane A7)</td>
<td>9.00</td>
</tr>
</tbody>
</table>

Oracle Payroll’s predefined earnings types Regular Wages, Overtime, and Shift Pay reference this table in their processing.
See Also

Setting Up User Tables: page 32 – 14
Setting Up User Tables

You set up user tables in the Table Structure window.

**Prerequisites**

- Plan what your table rows and columns will contain, and whether you will use formulas to validate table column entries.
- If you plan to use formulas to validate entries into the table columns, write these formulas and enter them in your database. See: Using Oracle FastFormula for Validation, *Oracle FastFormula User’s Guide*
- If you are setting up a payroll table holding amounts of a deduction, check whether you need to set up a row type for the table. See: Setting Up Row Types for Payroll Tables, *Oracle Payroll US User’s Guide*

![Table Structure window](image)

**To set up the structure of a table:**

1. Set your effective date to the date from which you want the table’s row labels to take effect.
2. Enter the table name.
3. For the table’s match type, select Match or Range. Select Match if each row is for one item, such as one job or one code. Select Range if each row is for a range of numeric values, such as an age range or a pay range.
4. If the match type is Match, select Date, Number or Text as the Key Units of Measure, depending on whether entries in the rows are dates (DD–MON–YYYY), numbers, or alphanumeric text.
   - If the table’s match type is Range, the Key Units of Measure automatically becomes Number.
5. Enter the row label as the Row Title.  
For example, if the table rows refer to rate codes, an appropriate row title would be Rate Code. If the rows refer to age ranges, you might use the title Age Range.

6. Save your work, and choose the Columns button to go to the Columns window.

![Columns window]

**To enter column labels:**

1. Enter labels for the table columns in the Name field. To add a new column to a table that already exists, place the cursor on the name of the column after which you want to enter the new column name, and choose Insert Record from the Edit menu to obtain a clear field.

2. If you are using formula validation for a column’s entries, select the name of the validation formula for the column.

3. Save your work and close the window. In the Table Structure window, choose the Rows button to go to the Rows window.
To enter row labels:

1. If the match type of the table is Match, enter the label for each table row in the fields under the heading Exact.
   If the match type of the table is Range, enter numbers representing the lower and upper boundary of each row’s range.

2. In the Sequence fields, you can optionally enter a number for each row label to determine the order in which it appears on a list in the Table Values window. Logical sequencing of row labels helps users enter table values rapidly and accurately.

3. When you are finished, save your work and close the window. Your table is now set up and ready to receive entries into its columns.
Entering Table Values

If you have set up user–defined tables, you can enter and maintain values in the Table Values window.

Note: The system administrator can create customized versions of the Table Values window so that you use each version for one user table only.

Prerequisite

Before you can enter values into a table’s columns, the table with its columns and rows must be completely set up.

To enter values into table columns:

1. Set your effective date to the date from which you want the entries to take effect.
2. Query the table name.
3. With the cursor in the Column Name field, use the up and down arrows to locate the name of the column in which you want to make entries.
4. In the Values region, select each row for which you want to make an entry. You select rows in the Exact field or the Lower Bound field, depending on the match type of the table.
5. For each row, make the appropriate entry in the Value field.
6. Save your work.
Integrating With Other Systems

Oracle Human Resources can be integrated with a number of Oracle and third party products. This chapter explains how to set up Oracle Human Resources to integrate with the following products.

- Oracle Payroll
- spreadsheets

It also explains how to attach text, images, OLE objects, and Web pages to individual records.
Using Oracle Human Resources with Oracle Payroll

Oracle Human Resources and Oracle Payroll are available for purchase together as the components of a closely integrated human resources management system. This system combines Oracle Human Resources and Oracle Payroll windows under a single menu structure, sharing windows and underlying tables wherever possible to eliminate redundant data entry, maintenance and storage.

For Oracle Human Resources or Oracle Payroll, you enter and maintain the same fundamental human resource information about your structure and operations, your employees and their assignments, and employee compensation and benefits. You then add the specialized information you need specifically for human resources or payroll management and administration.

Shared Information in Oracle HRMS

The common core of fundamental information used by both human resources and payroll managers and staff includes:

• **Your operational basics:**
  – payrolls with their calendars and pay periods
  – the currencies and methods of payment you use

• **Your organizational structure:**
  – internal organizations, such as companies, divisions, departments, work groups, or production team
  – external organizations of key importance to you, such as employment agencies, tax authorities, or union headquarters
  – organization location information, including addresses and telephone numbers
  – hierarchies showing the relationships between your organizations
  – any grade and grade scale structures you use

• **Your employees’ essential personal information,** such as:
  – name and address
  – marital status
  – birth date
  – nationality
- ethnic origin

- **Your employees’ current work statuses**, such as:
  - active assignment
  - on maternity leave
  - terminated

- **Your employees’ assignments to:**
  - internal organizations
  - grades, or grades and grade steps
  - groups having a compensation-related factor in common, such as membership in an insurance or pension plan or participation in an employee stock purchase plan
  - jobs, or jobs and positions
  - payrolls

- **Elements of your employees’ pay and benefits:**
  - *earnings* such as salary, wages, commissions, bonuses, allowances
  - *employer charges* such as employer contributions to legislatively-mandated or private insurance or pension plans
  - *deductions* such as contributions for union dues or employee stock purchase plans
  - *nonpayment benefits* such as vacation time or a company car

**Shared Windows in Oracle HRMS**

While many of the windows in your system relate exclusively to the human resources or payroll function, some include information relevant to both functions. These latter windows are *shared* windows.

Shared windows can include some information fields relevant to both human resources and payroll users, and other fields for information specific to either human resources or payroll users but not both.

**Using Shared Windows**

You can control the use of fields on shared windows by the value your system administrator gives to each user or responsibility for the HR:User Type profile option. The three valid values are:
• HR with Payroll User
• HR User
• Payroll User

Users with an *HR User* profile are restricted in their use of fields on certain windows. In particular:

• they do not see certain fields on the Element window, which are only required if you are processing elements

• they cannot assign employees to a payroll if both Oracle Payroll and Oracle Human Resources are installed
Using Oracle HRMS with Spreadsheets

Spreadsheets are commonly used in many enterprises to provide managers and other users with a powerful modelling and analysis tool. Often it is the ability to represent complex numeric data in a simple graphical format that makes them so popular.

You can use Oracle Application Data Export (ADE) to download information from the HRMS database to a spreadsheet for analysis and manipulation. For example, you can download data on current and proposed salaries for a group of employees. You can adjust the salary proposals in the spreadsheet, or enter new ones, and upload the revised data to the database. The ADE upload process reports any errors and ensures that only valid data is saved in the database.

To download information from a form to a spreadsheet using ADE, your system administrator needs to create a style in ADE. The style defines the form it is used for, the responsibilities that can use it, and the columns (or fields) to be downloaded. You determine which records are downloaded by running a query in the form before launching ADE.

A style for downloading salary proposals is predefined.

See Also

Application Data Export Online Help
Using Attachments

You can attach short comments, word processed documents, images, video, OLE objects, or Web pages to many records in Oracle HRMS. For example, you could attach a resume to an applicant record and a position description to a position record.

Each record can have one or more attachments, and you can copy attachments from one record to another. You can store the attachments in the database or in your file system.

You view or add new attachments by clicking the Attachments icon. By default, clicking the attachments icon displays a Comments window where you can enter text up to 2000 characters. This is the Comments facility available in earlier releases of Oracle HRMS. If you want to replace this facility with the ability to attach multiple items, ask your system administrator to set your user profile option HR:Use Standard Attachments to Yes.

The HRMS entities that support attachments are as follows:

- Absence
- Absence Type
- Address
- Application
- Assignment
- Balance (Oracle Payroll)
- Batch Header
- Benefit
- Booking
- Budgets
- Budget Version
- Calendar
- Career Path
- Cobra Coverage Status
- Cobra Enrollment
- Cobra Payment
- Consolidation Set (Oracle Payroll)
- Contact Relationship
• Customization
• Element
• Element Entry
• Element Link
• Element Set
• Event
• Grade
• Grade Rate
• Job
• Job Evaluation
• Job Requirement
• Letter Type
• Monetary Unit (Oracle Payroll)
• Organization
• Organization Payment Method
• Organization Hierarchy
• Pay Scale
• Payroll Process (Oracle Payroll)
• Period of Service
• Person
• Person Analysis/Special Information
• Personal Payment Method
• Position
• Position Hierarchy
• Recruitment Activity
• Requisition
• Salary Basis
• Salary Proposal
• Salary Proposal Component
• Secondary Assignment Status
• Special Information Type
• Status Processing Rules (Oracle Payroll)
• Vacancy
• Valid Grade
• WC Fund

See Also

Working With Attachments
Oracle Applications User’s Guide

Setting User Profile Options: page 29 – 4
Using Letters to Manage Recruitment and Enrollment

You can use standard letters to help you to manage your enterprise’s recruitment or enrollment activities. You do this by issuing standard letters to applicants (Oracle Human Resources) or to students (Oracle Training Administration), triggered by changes in assignment or enrollment status. For example, you can set up a standard enrollment confirmation letter that is triggered when a student’s enrollment status is set to Placed or you can set up a rejection letter that is triggered when an applicant’s assignment status is set to Rejected.

Here are a few examples of letters you can set up to help you to manage your enterprise’s recruitment or enrollment activities:

<table>
<thead>
<tr>
<th>Oracle Human Resources</th>
<th>Oracle Training Administration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgement letters (for all active applications)</td>
<td>Acknowledgement letters (for all requested enrollments)</td>
</tr>
<tr>
<td>Confirmation letters (for interviews)</td>
<td>Confirmation letters (for placed enrollments, including event joining instructions based on the date, venue, and trainers)</td>
</tr>
<tr>
<td>Reports for interviewers and schedules</td>
<td>Reports for trainers (listing the students to attend an event)</td>
</tr>
<tr>
<td>Offer and Rejection letters (for applicants)</td>
<td>Chase–up letters (for non–response or non–payment)</td>
</tr>
<tr>
<td></td>
<td>Acknowledgement letters (for cancellations)</td>
</tr>
<tr>
<td></td>
<td>Certificates (of successful course completion)</td>
</tr>
</tbody>
</table>
Setting Up Standard Letters

Oracle HRMS provides you with two different methods to create standard letters:

- Concurrent Processing
- Online:
  - using Oracle Application Data Export (ADE)
  - using Object Linking and Embedding (OLE) to generate Microsoft Word letters only

Which Method Should You Use?

Use the online method, ADE or OLE, if you want to generate and review your letters immediately.

Alternatively, you can use the concurrent processing method to set up your standard letters. With concurrent processing, you can generate and review your letters without interfering with the other work you perform at your terminal. You can control when a concurrent process runs and schedule long-running processes to run at times when the system is lightly loaded. Another advantage of using concurrent processing is that you do not need Windows 95, Excel or Lotus 123 installed.

See: Concurrent Processing: page 33 – 12

Using ADE

You can use ADE to generate standard letters and reports. ADE retrieves data and exports it to a data file that is merged with a standard word processed document. The word processed document includes all the merge fields required to merge the data and the standard text for the letter. ADE is fully compatible with Microsoft Word 6.

You can use ADE to generate standard letters for recruitment or enrollment by performing a mail merge from the Request Letter window in your application.

If you want to use ADE to set up your standard letters instead of using the concurrent processing method, refer to the ADE documentation.

See: Application Data Export (ADE) Online Help

Using OLE

You can use Object Linking and Embedding (OLE) to generate Microsoft Word letters instead of using ADE, if required.
Attention: In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

Concurrent Processing

There are two methods of using concurrent processing to set up your standard letters:

- Using word processors
- Using Oracle reports

Using Word Processors

You can use any word processor to produce standard letters from Oracle HRMS. If you use a word processor, you can submit a concurrent request in the Letter Request window to generate the mail merge file. When the concurrent request is complete, you can use your word processor’s mail merge facilities to create the merged letters.

See: Using a Word Processor: page 33 – 13

Using Oracle Reports

As an alternative to using a word processor to produce standard letters, you can use the Standard Letter and Label features of Oracle Reports. Use this method if you do not want to use word processors to print your letters (or if you do not have word processors).

See: Using Oracle Reports: page 33 – 27
Using a Word Processor

To create standard letters using a word processor, you need to extract the data you want to include in the letters from the Oracle HRMS database. To do this, you create a program, such as a SQL*Plus script, to extract the data, which is then stored in a Data file. You also write skeleton standard letters using your word processor.

Each time you run your SQL*Plus script, it extracts data to the Data file. You then use the mail merge features of your word processor to merge this data with the skeleton standard letters you previously prepared. This merging process creates the actual letters that you send out to students and applicants.

An overview of creating standard letters using a word processor is illustrated in Figure 33 – 1.
Which Word Processor?

Oracle HRMS supplies SQL*Plus script templates for use with MultiMate, WordPerfect and Microsoft Word. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus script templates (or Word documents) and modify them to create the standard letters you require.

If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online. You can generate Microsoft Word letters using OLE or Oracle Application Data Export (ADE). See: Setting Up Standard Letters: page 33 – 10.

If you are setting up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word), see Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect: page 33 – 14.

If you are setting up standard letters to be generated online for Microsoft Word, see Flowchart for Setting Up Standard Letters Using Microsoft Word: page 33 – 22.

Flowchart for Setting Up Standard Letters Using MultiMate or WordPerfect

Figure 33 – 2 illustrates the sequence in which you set up standard letters using the concurrent processing method with MultiMate or WordPerfect (or if you are using the concurrent processing method with Microsoft Word).
One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the content of your letters. Oracle HRMS supplies you with...
SQL*Plus scripts as templates to help you do this. You also need to identify the text that you want to include as the body of your letters.

The next decision you need to make is whether to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

Writing a SQL*Plus Script for MultiMate or WordPerfect

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to write your program to extract the data from the database.

Oracle HRMS supplies you with SQL*Plus scripts as templates. You can copy the SQL*Plus script templates and modify them to create the standard letters you require. Copy the SQL*Plus scripts from the server side sql directory of the HR product tree (consult your installation guide for details). The following example applies to HR—Oracle Training Administration does not provide template scripts—but we provide an example of a Confirmation letter SQL mail merge file.

Once you have written your script, save the file with the name PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it as a type of letter. See your Oracle Applications installation server guides for details of where the concurrent manager places the files.

The template scripts Oracle HRMS provides are:

<table>
<thead>
<tr>
<th>Scripts</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPMUK.sql</td>
<td>Example UK SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPMUS.sql</td>
<td>Example US SQL*Plus script for MultiMate</td>
<td>HR</td>
</tr>
</tbody>
</table>
To write a SQL*Plus script for MultiMate or WordPerfect:

1. Write a SQL*Plus script to select data from the database in a format your word processor can read and that is compatible with the standard letter.
2. Name the program PERWP*** (or OTAWP*** for OTA).
3. Save the program. (Consult your installation guide for details).

Registering the SQL*Plus Script for MultiMate or WordPerfect

You now need to register your SQL*Plus program with Oracle HRMS. You register your program so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP***). You must use this prefix for the system to recognise it as a type of letter.

You use the Concurrent Programs window to register your program (using a system administrator responsibility).

See: Concurrent Programs Window, Oracle Applications System Administrator's Guide

Linking the SQL*Plus Script With a Letter for MultiMate or WordPerfect

You need to link your SQL*Plus script with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the letter is then created automatically when an applicant is given an associated assignment status. For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status.
Define your standard letter types in the Letter window.

**To define a standard letter type:**

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the SQL*Plus script.

**For Oracle Human Resources:**
3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.
   
   When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the applicant is added to the list of people to receive the letter when you submit the request.

**For Oracle Training Administration:**
4. Select one or more enrollment statuses to create letter requests automatically for enrollments, and check the Enabled box.

   When an enrollment is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the enrollment is added to the list of people to receive the letter when you submit the request.

---

**Writing a Skeleton Letter**

You now need to write a skeleton letter using your word processor. Include the appropriate merge codes from the data source for the word processor you are using.

The mail merge feature of any word processor enables you to merge text from the data file you create into a standard letter. Each line in the data file contains the text to merge into one standard letter for one recipient.

Within the program, you can format the data and include the characters that are recognized as separators by your word processor.

A standard letter comprises standard text with a number of embedded variables in it. When you print the letter, the variables are replaced with specific items of data, such as name and address details for different people.
Figure 33 – 3
Merging Data with Standard Letters

Skeleton Letter

Merge Codes

Data File

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

&Business, &Addr1, &Addr2, &Post, &Date, &Reference, &Title, &LastName, &Position

Requesting Letters for MultiMate or WordPerfect

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters, Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the SQL*Plus script that you previously wrote and creates the data file for mail merge. (Consult your installation guide for details of the location Concurrent Manager places the output file).
You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.

You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

► **To submit an automatic letter request:**
  1. Query the letter you require in the Letter Name field.
  2. Ensure that the method is Automatic.
  3. Move to the Requested for block to query the applicants, events or students which have been entered automatically on this request, according to their status. You can add further names manually.
  4. Update the status from Pending to Requested.
  5. Save your changes.
     
     A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.
  6. You can query the request ID in the Concurrent Requests window and monitor its progress.

     **Note:** Consult your installation guide for details of the location Concurrent Manager places the output file.

► **To create a manual letter request:**
  1. Select the Letter Name for the letter type you want to request.
  2. Ensure that the method is Manual.
  3. Leave the status of the request as Pending.
  4. Save the changes.

**Adding the Names**
  5. Select the names to add:
     
     • Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.
       
       The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.
     
     • Select events or students or both (for Oracle Training Administration) in the Requested For region.
This depends on how the letter has been set up on your system. For example, an enrollment confirmation letter might be defined so that it is sent to all students with the status Confirmed who are enrolled on the event selected in the Requested For region.

6. Save the changes.

Changing the Status

7. Update the status from Pending to Requested.
8. Save the changes.

A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

9. You can query the request ID in the Concurrent Requests window and monitor its progress.

Note: Consult your installation guide for details of the location Concurrent Manager places the output file.

Merging the Data File With the Standard Letter MultiMate or WordPerfect

The last step is to merge the data in the Data File with your skeleton letters to create your standard letters. The merging of text and data files is normally carried out using the mail merge features of your word processor.

If you do not have access to the directory where the Data File resides (consult your installation guide for details of the location Concurrent Manager places the file), you need to transfer the mail merge files created by the concurrent process to your word processor before you can merge the data file with the skeleton letters.

Saving the Letters You Generate

If you are using a word processor to merge the data file, you need to save the merged letters you generate. If you do not save the merged letters, when you exit the word processor you lose the letters. You do not lose the data file or the skeleton letter, however.
Flowchart for Setting Up Standard Letters Using Microsoft Word

Figure 33 – 4 illustrates the sequence in which you set up standard letters using Microsoft Word.
If you use Microsoft Word as your word processor, not only can you use the concurrent processing method to produce your standard letters, but you can also generate letters online.

You can use either one of two methods:

- Generate Microsoft Word letters using Object Linking and Embedding (OLE)
- Application Data Export (ADE)

**Attention:** In future releases of Oracle HRMS, generating Microsoft Word letters using Object Linking and Embedding (OLE) will be replaced by ADE.

See: Application Data Export (ADE) Online Help

If you are setting up standard letters using the concurrent processing method, follow the same sequence as for MultiMate or WordPerfect.

If you are generating Microsoft Word letters using Object Linking and Embedding (OLE), see Writing a SQL*Plus Script for Microsoft Word: page 33 – 23

---

**Writing a SQL*Plus Script for Microsoft Word**

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Oracle HRMS supplies SQL*Plus script templates. It also supplies two sample Microsoft Word documents containing merge codes for the SQL*Plus scripts. You can copy the SQL*Plus scripts from the server side sql directory of the HR or product tree. (Consult your installation guide for details).

You can copy the word documents from the client–side directory [APPL_TOP]\PER76\LETGEN.

You can run the scripts on the server side and make them accessible to other users across the network, or you must copy them to a directory which is accessible from the PC, such as a network drive. You must also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

---

**Templates Provided**

The template scripts and Microsoft Word documents Oracle HRMS provides are:
To write a SQL*Plus script for Microsoft Word:

1. Write a SQL*Plus script to select data from the database in a format your word processor can read and is compatible with the standard letter.
2. Name the program PERWP*** (or OTAWP***).
3. Save the program. (Consult your installation guide for details).

<table>
<thead>
<tr>
<th>Scripts and Documents</th>
<th>Purpose</th>
<th>Used By</th>
</tr>
</thead>
<tbody>
<tr>
<td>PERWPOUS.sql</td>
<td>Example US Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.sql</td>
<td>Example UK Offer letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.sql</td>
<td>Example US Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.sql</td>
<td>Example UK Interview letter SQL mail merge file</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUS.doc</td>
<td>Example US Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPOUK.doc</td>
<td>Example UK Offer MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUS.doc</td>
<td>Example US Interview MS Word document</td>
<td>HR</td>
</tr>
<tr>
<td>PERWPIUK.doc</td>
<td>Example UK Interview MS Word document</td>
<td>HR</td>
</tr>
</tbody>
</table>
Generating a Microsoft Word Letter

You can generate the Microsoft Word letter online using the Letter Generation window. This window uses Object Linking and Embedding (OLE) to display the Microsoft Word letter. When you start Microsoft Word from this window, your standard letter is automatically loaded and ready to be merged with the mail merge file.

> To generate and merge a Microsoft Word document:

1. Select one of the following in the Letter region:
   - **Request** if you want to process a pending letter request that the system has created automatically for applicants, or that you have created manually in the Request Letter window. Select the name of the letter request.
   - **Custom** if you want to process a custom program that is not associated with a letter type.

2. Position the cursor in the Document field and choose the Browse button.

3. Select the Microsoft Word document that is your skeleton letter.

4. Position the cursor in the Merge field and choose the Browse button.

5. Select the extract program (such as a SQL script) that extracts data from the database to create the mail merge file.

You can run the scripts on the server side (consult your installation guide for details). Make them accessible to other users across the network, or copy them to each PC. You must also make the Microsoft Word documents accessible to other users across the network, or you must copy them to each PC.

6. Check View Generated Merge File if you want to examine the generated mail merge file before activating the Microsoft Word document then choose the Generate button to create the mail merge file.

   If the View Generated Merge File check box is checked, the file displays in the Windows Notepad application.


   The document displays in the Document Preview and Activation block.
8. Merge the data with the document.
   If the Microsoft Word document already contains mail merge fields, 
   the mail merge file you have generated is automatically loaded in 
   Microsoft Word.

9. You must open the merge file as the Data Source and insert the 
   merge fields in your document if the document does not yet 
   contain mail merge fields.

10. Save the document using the filename of your mail merge file, with 
    a .doc extension.

    **Note:** If you do not save the merged letters when you exit the 
    word processor you lose them.
Using Oracle Reports

You can create a report for each letter using Oracle Reports, or another tool of your choice. The report contains the skeleton letter text and Select statements specifying the data to be extracted from the Oracle database.

Figure 33 – 5 illustrates the sequence in which you set up standard letters using Oracle Reports.

Planning the Content and Layout

One of the first tasks you need to perform is to identify which data you want to extract from the database to include in your standard letters. You need to identify the select statements to use to provide you with the data as the content of your letters. You also need to identify the text that you want to include as the body of your letters.
The next decision you need to make is whether you want to associate your standard letters with student enrollment or applicant assignment statuses.

If you do want to link your standard letters to student enrollment or applicant assignment statuses, your next decision is to identify which student enrollment or applicant assignment statuses you want to trigger your standard letters. For example, do you want to link your standard enrollment confirmation letter to the status Placed so that the letter is triggered when you set a student’s enrollment status to Placed? Alternatively, do you want to link your standard rejection letter to the status Rejected so that it is triggered when an applicant’s assignment status is set to Rejected?

Writing the Report

Now that you have identified whether you want to associate the standard letters with student enrollment or applicant assignment statuses, you are ready to identify which data you want to extract from the database.

Write your skeleton letter text and Select statements specifying the data to be extracted from the Oracle database.

Registering the Report

You now need to register your report with Oracle HRMS. You register your report so that you can run it as a concurrent program. Name the file PERWP*** (or OTAWP*** for OTA). You must use this prefix for the system to recognise it.

You use the Concurrent Programs window to register your report (using a system administrator responsibility).

See: Concurrent Programs Window, Oracle Applications System Administrator’s Guide

Linking the Report With a Letter

You need to link your report with a letter and one or more statuses. In Oracle Human Resources, you can link one or more applicant assignment statuses with each recruitment letter. A request for the
letter is then created automatically when an applicant is given an associated assignment status. In Oracle Training Administration, you can link one or more enrollment statuses with each enrollment letter. A request for the letter is then created automatically when an enrollment is given an associated status.

For example, you can link your standard recruitment rejection letter to the status Rejected so that the letter is triggered when you set an applicant’s assignment status to Rejected.

Define your standard letter types in the Letter window.

▲ To define a standard letter type:

1. Enter a name for the letter in the Name field.
2. Select the Concurrent Program Name assigned by your System Administrator to the report.
3. Select one or more applicant assignment statuses to create letter requests automatically for applicants, and check the Enabled box.
   When an applicant is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the applicant is added to the list of people to receive the letter when you submit the request.
4. Select one or more enrollment statuses to create letter requests automatically for enrollments, and check the Enabled box.
   When an enrollment is given one of these statuses, a pending request for this letter type is created automatically. If a pending letter request already exists, the enrollment is added to the list of people to receive the letter when you submit the request.

Running the Report

When you, or other users, set the status for an applicant or enrollment that triggers your standard letters, Oracle HRMS creates a letter request automatically, with the status of Pending. It also adds the applicant’s or student’s name to the request. You can view the pending request and names through the Request Letter window.

Then, when you change the letter request from Pending to Requested, Oracle HRMS runs the report that you created.

You can add further names to the list manually, if required. For example, you might have a last minute acknowledgement letter to send.
You can also create manual letter requests. If you do, enter the status of Pending yourself, then enter all the recipients of the letter before changing the status of the letter to Requested.

**To submit an automatic letter request:**

1. Query the letter you require in the Letter Name field.
2. Ensure that the method is Automatic.
3. Move to the Requested for block to query the applicants, events or students which have been entered on this request automatically, according to their status. You can add further names manually.
4. Update the status from Pending to Requested.
5. Save your changes.

A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

6. You can query the request ID in the Concurrent Requests window and monitor its progress.

   **Note:** Oracle HRMS saves the data file (consult your installation guide for details).

**To create a manual letter request:**

1. Select the Letter Name for the letter type you want to request.
2. Ensure that the method is Manual.
3. Leave the status of the request as Pending.
4. Save the changes.

**Adding the Names**

5. Select the names to add:
   - Select employees or applicants (for Oracle Human Resources) to receive the letter in the Requested For region.
     
     The Assignment field displays the organization to which the person is assigned. You can view the other components of the assignment by choosing List of Values from the Edit menu.
   
   - Select events or students or both (For Oracle Training Administration) in the Requested For region.

   This depends on how the letter has been set up on your system. For example, an enrollment confirmation letter might be defined
so that it is sent to all students with the status Confirmed who are enrolled on the event selected in the Requested For region.

6. Save the changes.

Changing the Status

7. Update the status from Pending to Requested.

8. Save the changes.

A concurrent request ID number appears in the Concurrent Request field. When the Concurrent Manager has processed the request it changes the status to Completed.

9. You can query the request ID in the Concurrent Requests window and monitor its progress.

**Note:** Oracle HRMS saves the data file, consult your installation guide for details.
Employees’ personal and pay-related information is highly sensitive. You must be able to reliably secure this information from unauthorized access by users of your Oracle Applications.

Oracle HRMS gives you a flexible approach to controlling access to records, windows, and functions. This means you can suit each employee’s level of access to his or her work responsibilities. You can partition data by organization, position, or payroll.

Management of security is normally part of the system administrator’s role. This chapter explains how to secure information in Oracle HRMS.
Security in Oracle HRMS

You can control users’ access to human resources information by record, window, and function.

You can restrict access to records of applicants and employees assigned to certain work structures. For example, you can give department managers access only to the records of the employees in their own department.

Further, within a given department, you can control access to records of employees at or above a certain level. For example, you can give a department’s administrator access to all department employee records except those of the manager and assistant manager. You do this by defining security profiles.

You can use the same security profiles to restrict the records accessed by a reporting user, who runs reports against the system but does not have online access through the Oracle HRMS forms.

You can also restrict access to certain information types. For example, you can create customized versions of some windows to restrict access to certain elements and person types.

Another important area of security is control over information change. For each group of employees sharing a responsibility, you can set up a menu controlling the windows to which they have access. If it is important to know who makes changes to information in certain windows, you can enable full data auditing for these windows.

You can specify which processes and reports a user can use by setting up security groups.

Access Control through User Responsibilities

You control access to Oracle HRMS through responsibilities that you create and assign to users of the system. Users can sign on to Oracle HRMS only through the responsibilities you give them. So their responsibilities control what they can see and do in the system.

A responsibility always includes a security profile and a menu structure. It may also include a security group. Optionally, you can restrict access to specific sub–menus or functions in your chosen menu.

- Security profiles determine the organizations, positions and payrolls whose applicant and employee records responsibility holders can access.
- Menu structures and functions control:
the particular windows a responsibility holder can access

- whether he or she can perform data entry, change or deletion on these windows

You can produce customized versions of some Oracle HRMS windows. Each customized version allows access to a subset of certain types of information, such as person types, special information types, or elements. You define additional menu functions to call customized windows or task flows, and then you add these functions to a menu structure, which is linked to a responsibility.

- Security groups determine the group of processes and reports a responsibility holder can initiate. A security group is an optional component of a responsibility. If holders of a responsibility should not initiate any reports or processes, you do not include a security group in the responsibility.

For each responsibility, you must also define two user profile options:

- HR:Security Profile
- HR:User Type
Single and Multiple Responsibilities

You can develop as many different responsibilities as your enterprise requires. Typically, most employees need one responsibility only. However you can assign multiple responsibilities to users who need to:

- access applicant and employee records from two or more security profiles.
- use more than one menu structure to view or make changes to the records they can access.
- use more than one Oracle Application. For example, some people may use windows in both Oracle HRMS and Oracle General Ledger.
- access records for more than one Business Group. For example, an enterprise with international operations may have a US–based Business Group and a UK–based Business Group. A few of your employees might need access to both.

See Also

Setting User Profile Options: page 29 – 4

Security Profiles

The security profile attached to a responsibility determines which applicant and employee records are available to holders of that responsibility. You associate a security profile with work structures. The records of employees and applicants assigned to these work structures are then accessible to holders of the responsibility.

The work structures you can name in security profiles are:

- internal organizations and organization hierarchies. Organizations include structures like departments, sections, groups and teams. Each security profile allows access to one Business Group only.
- positions and position hierarchies. Positions are jobs performed within specified organizations, such as:
  - Clerk, Accounting Section (organization is Accounting Section and job is clerk)
  - Quality Control Technician (organization is Quality Control Group and job is technician)
- payrolls, such as Weekly Payroll, Monthly Payroll, or Sales Payroll.
Organizations and Organization Hierarchy

To set up a security profile that permits access to employee records of certain organizations only, you make use of organization hierarchies. You can build any number of additional hierarchies to meet your security requirements.

For example, suppose you build this Sales Organization hierarchy:

You can create a security profile that permits access to employee records throughout the sales organization. This profile references the Sales Organization hierarchy. It names the Sales Department as the highest organization in the hierarchy through which profile holders have access to employee records.

Next, you want the directors of the two sales regions to have access to all employee records in their region only. You create Eastern and Western Sales Director security profiles. These profiles also reference the Sales hierarchy. But, they name the Eastern and Western Regions, respectively, as the top organizations for these profiles’ access to employee records.

When you name an organization as the top organization, you specify whether it is inclusive or not. You must include the top organization if
you want holders of the profile to access records of people assigned to the top organization.

Positions and Position Hierarchies

After establishing limits on record access using organization hierarchies, you can further restrict access by means of position hierarchies.

Suppose, for example, within the Sales Department, you want to give the Sales Research Director access to her subordinates’ records only. You can start by building the following Sales Positions Hierarchy:

Now you create the Sales Research Director security profile. This profile references the Sales Positions hierarchy and names the Sales Research Director as the top position for access to employee records.
Security Profile: SALES RESEARCH DIRECTOR
Organization Hierarchy: Sales Organization
Top Organization: Sales Department
Position Hierarchy: Sales Positions
Top Position: Sales Research Director
Include Top Position: Yes

When you give the Sales Research Director a responsibility including this security profile, she can access the records of her subordinates. But, she cannot access records of:

- the VP or Associate VP of Sales
- the Regional Sales Director
- the Regional Sales Director’s subordinates.

As with organization hierarchies, you can specify that profiles do not include access to the top position.

Payrolls

The third way to restrict access to employee records is by payroll. For example, you can give payroll staff who work on the Sales payroll access to records of employees on this payroll only.

Controlling security by payroll assignment limits the employee records users can see and update on employee–related windows, such as those for employee information, and element entry.

Of course, if an employee assignment does not include a payroll, payroll security cannot apply to this assignment. Payroll security never applies to applicant records since applicants are not assigned to payrolls.

The windows for compensation definition are unrelated to any particular employee records or payroll assignments. Therefore limiting access by payroll does not affect users’ access to these windows.

See Also

Defining Security Profiles: page 34 – 13
Database Access Without Online Access

You may need to set up access restrictions for employees who never use Oracle HRMS windows and do not change database information, but do access the database. These individuals are reporting users. A reporting user can use Oracle reporting tools to access database information for reports. A reporting user can report on, or query, the information in the HRMS database, but cannot insert, update, or delete that information.

You can make any of your security profiles available not only for regular Oracle HRMS users, but also for reporting users. The security profile restricts a reporting user’s access to employee records in exactly the same way as it limits regular users’ access.

Menu Structures

Each responsibility includes a security profile to restrict users’ access to employee records. It also includes a menu structure to restrict the windows users can access, and what they can do on these windows.

By using different menu structures and functions for groups of users, you can:

- limit the range of information users can access for the applicant and employee records available to them
- improve users’ efficiency in using the system by reducing menu choices

Menu functions can include:

- standard windows, displayed in edit or view-only mode
- customized windows, on which you have restricted the range of data that can be displayed
- the first window in task flows that link a number of windows that are used in sequence to complete a task

The AutoInstall program creates the default menu structure for your Oracle HRMS product. You can run a report to produce a listing of this structure.

The default menu structure lets you access all of the windows for your system. Normally, only a System Administrator has access to the full default menus. You can define any number of new functions and menus to restrict the access of other users.
Security and Control

See Also

Setting Up Navigation Menus: page 31 – 17

Security Groups

When you build a responsibility for employees who must initiate reports or processes, you can attach a security group to the responsibility. The security group lists a group of processes and reports its holders can run. Holders of responsibilities with no security groups cannot run any processes or reports.

The seeded groups US/UK HRMS Reports and Processes give access to all predefined reports and processes.
Setting Up Security in Oracle HRMS

Figure 34 – 4 depicts the relationship between the security items you define when you set up security for Oracle HRMS.

The key definition is the responsibility, which allows access to the records specified by the security profile, using the windows specified by the menu structure, and the reports and processes specified by the report security group.

At most, one responsibility can see all records for one Business Group. When you create a new Business Group, a view–all security profile is automatically created. It provides access to all employee records, and all applicant records in the Business Group. The system administrator creates a responsibility that includes this view–all security profile, then assigns this responsibility to the users who are setting up the system. They in turn can set up security profiles for other users.

Figure 34 – 4
Security Definitions
To set up a new responsibility for Oracle HRMS:

2. Set up any new functions or menus required for the responsibility. For menu functions calling customized forms or task flows, you must enter a parameter in the Parameter field of the Form Functions window.
   
3. Define the new responsibility.
4. Create usernames and passwords related to the new responsibility. A username can be related to more than one responsibility.
5. Set the HR User Profile Options for the new responsibility. The options you must set are:
   • HR:Security Profile
   • HR:User Type
   You can set other User Profile Options.
6. Run the HRMS security processes
   
   See: Running the HRMS Security Processes: page 34 – 15

Security for Reporting Users

Reporting users do not have online access to the database through Oracle HRMS forms. They use Oracle reporting tools to prepare reports on the information to which their security profiles grant access.

All secure users connect to the APPS ORACLE ID. This is created when the system is installed. However, for reporting users, you should create one or more new reporting user ORACLE IDs and associate each with a restricted security profile.

The first step in this procedure is the job of the ORACLE database administrator. The other steps are normally done by the system administrator.

To set up a new reporting user:

1. Create a new reporting user ORACLE ID.
2. Register the new ORACLE ID with Application Object Library.
3. Using a view–all responsibility, define a security profile in the Security Profile window for the new ORACLE ID.
4. Run the HRMS security processes
   See: Running the HRMS Security Processes: page 34 – 15
Defining Security Profiles

Using a view–all responsibility, you can define security profiles in the Security Profile window.

Prerequisites

- If you want to associate a reporting user with the new security profile, the ORACLE database administrator must create a new reporting user ORACLE ID. The system administrator must register the new ORACLE IDs with the Application Object Library.

To define a security profile:

1. Enter a name for the security profile and select a Business Group. This does not need to be the Business Group you are logged on to.
2. If you want reporting users to be able to use this security profile, select the Reporting User name for the ID set up by the database administrator.
3. Uncheck the View All Employees and View All Applicants check boxes if you want to restrict access to these person types by organizations, positions, or payrolls.
4. To restrict access by organization, uncheck the View All Organizations check box. Select an organization hierarchy, and a
top organization. Check the Include Top Organization check box if you want to allow access to this organization.

5. To restrict access by position, uncheck the View All Positions check box. Select a position hierarchy, and a top position. Check the Include Top Position check box if you want to allow access to this position.

6. In the Payroll Security alternative region:
   - To give access to many payrolls, check the View All Payrolls check box, and uncheck the Include check box. Select the payrolls you want to exclude.
   - To give access to a small number of payrolls, uncheck the View All Payrolls check box, and check the Include check box. Select the payrolls to include.

7. Save your work.
Running the HRMS Security Processes

There are three HRMS security processes:

- Run the Grant Permissions To Roles process when you install Oracle HRMS, or when you upgrade the system.
- Run the Generate Secure User process when you create a new security profile that references a reporting user.
- Run the Security List Maintenance process every night.

You run these processes using a system administrator responsibility from the Submit Requests window.

Grant Permissions To Roles Process (ROLEGEN)

All reporting users in Oracle HRMS share access to a set of synonyms for tables. The synonyms are created by the Autoinstall process. You must run the Grant Permissions To Roles process to create the public grants to make those synonyms usable.

Run this process when you install Oracle HRMS, or when you upgrade the system. You must run this process before you run the Generate Secure User Process for the first time.

The process grants SELECT permissions to the role "hr_reporting_user". Permissions are not granted on the secured tables, but only on the secure views of those tables. All permissions previously granted to the role are revoked.

Generate Secure User Process (SECGEN)

This process grants permissions to new reporting users. It grants the "hr_reporting_user" role to the REPORTING_ORACLE_USERNAME specified in the security profile.

Run this process when you have created a new security profile that references a reporting user. In the Submit Requests window, select the name of the new security profile. This is the only parameter to the process.

Security List Maintenance Process (LISTGEN)

This process maintains the lists of organizations, positions, payrolls, employees and applicants that security profile holders can access. You should schedule it to run every night to take account of changes made during the day. If a disruption, such as a power cut, occurs while the
process is running, you can manually restart it from the Submit Requests window.

There is one required parameter for this process: Effective Date, which should normally be set to SYSDATE. You can also enter a security profile name to generate list entries for that security profile only.

**Attention:** LISTGEN should normally run when there are no users logged on to Oracle HRMS. Users attached while LISTGEN is running may experience unexpected results; for example, additional employees may become visible or previously visible employees may disappear from view.
AuditTrail provides a flexible approach to tracking the changes to your data. You can choose which data to audit and how long to keep the audit data. You can use the supplied audit report or design your own.

This chapter explains how to set up AuditTrail and how to report on audit data.
AuditTrail

AuditTrail lets you keep a history of changes to your important data: what changed, who changed it, and when. With AuditTrail, you can easily determine how any data row or element obtained its current value. You can track information on most types of fields, including character, number and date fields.

You enable auditing for audit groups. These are groups of tables and columns you want to audit, where you do not necessarily need to include all the columns in a given table. You typically group together those tables that belong to the same business process, such as employee compensation tables.

During implementation you need to decide:

- which tables and columns you want to audit
- how you plan to report on the audit data
- how long you want to keep the audit data active

Setting Up AuditTrail

Setting up AuditTrail is normally a task for the system administrator.

The first four steps must be done to enable auditing of any Oracle Applications table. They are explained in more detail in the Oracle Applications System Administrator’s Guide. The fifth step is required only for tables in the HR account.

To set up AuditTrail:

1. Have your database administrator grant SELECT privileges on SYS.DBA_TABLES to the APPLSYS account. Normally this step would already have been done as part of your installation or upgrade.

2. Select the tables you want to audit in the Audit Groups window, and select which columns in these tables you want to audit in the Audit Tables window.

   Note: You cannot audit LONG, RAW, or LONG RAW columns.

3. Select the registered ORACLE IDs you want to audit in the Audit Installations window.

4. Run the Audit Trail Update Tables process. You do this in the Submit Requests window for a System Administrator responsibility. This process:
• creates database triggers on your audited tables
• creates one shadow table for each audited table, to contain the audit information
• builds special views on non-datetracked tables, which you can use to retrieve your audit data for reporting

5. Run the Audit Trail Update Datetracked Tables process. You do this in the Submit Requests window for an HRMS responsibility. For each datetracked table, this process:
• creates an index on the shadow table
• creates the function `<tablename>_TT` and the procedure `<tablename>_VP`, which extracts information from the shadow table when you run the predefined audit report

**Attention:** You must rerun these processes any time you update any of your audit definitions.

### Disabling AuditTrail

You can disable the auditing of an audit group at any time by selecting a Disable state in the Audit Groups window.

**Suggestion:** If you are planning high volume transactions on an audited table, such as loading a batch of information from another system, consider disabling auditing for the table’s audit group. This will enable the batch loading to complete more quickly.

Before you restart auditing, you should archive your audit data, according to your business needs, and purge the shadow tables. You purge the tables by setting the audit group to Disable – Purge Table and running the Audit Trail Update Tables report. To restart auditing, you set the audit group to Enable Requested and rerun the Audit Trail Update Tables process and the Audit Trail Update Datetracked Tables process.

### See Also

Setting Up Release 10 AuditTrail  
*Oracle Applications System Administrator’s Guide*

Disabling AuditTrail and Archiving Audit Data  
*Oracle Applications System Administrator’s Guide*
For any non-datetracked tables, you can write a report that uses the views on the shadow tables to access the audit data. However, for datetracked tables, the information from the shadow tables must be extracted and written to the HR_AUDITS table and the HR_AUDIT_COLUMNS table before you can report on it.

The Oracle HRMS audit report performs this additional processing. You can use it as supplied or as an example of how to report on audit information. It can report on both datetracked and non-datetracked tables that have a numeric primary key.

**Note:** It can report on up to approximately 90 columns in datetracked tables and 80 columns in non-datetracked tables.

The report lists every change made to the table you select in the time period you specify when you run the report. You can restrict the reported changes to those made by a specified username. The changes are listed by date and time of the change. For each change, the report shows:

- the date and time of the change
- the user id who made the change
- the type of change
- the fields that changed and either their old values, or their new values, or both, depending on the type of change

Table 35–1 lists the 12 types of change and what information is shown in the audit report for each type.

<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal Insert (creates a non-datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>Normal Update (updates a non-datetracked record)</td>
<td>The old and new values for all fields that changed.</td>
</tr>
<tr>
<td>Normal Delete (deletes a non-datetracked record)</td>
<td>The non-null values in the record that was deleted.</td>
</tr>
<tr>
<td>DT First Insert (creates a datetracked record)</td>
<td>The non-null values in the new record.</td>
</tr>
<tr>
<td>DT Update (date-effectively ends the last row on a datetracked record and creates a new row)</td>
<td>The old and new values of all fields that changed, and the new effective end date on the old row.</td>
</tr>
</tbody>
</table>

Table 35–1 Transaction Types in the Audit Report
<table>
<thead>
<tr>
<th>Type of Change</th>
<th>Field Values Shown in the Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>DT Correction</td>
<td>The old and new values of all fields that changed, and the effective dates of the corrected row.</td>
</tr>
<tr>
<td>DT Replace</td>
<td>The non-null values in the rows that were deleted, the new effective end date on the row preceding the new row, and the old and new values of all fields that changed.</td>
</tr>
<tr>
<td>DT Insert</td>
<td>The old and new values of all fields that changed, and the new effective end date on the row preceding the new row.</td>
</tr>
<tr>
<td>DT Purge</td>
<td>The non-null values in all rows of the record that was deleted.</td>
</tr>
<tr>
<td>DT End Date</td>
<td>The new effective end date of the row.</td>
</tr>
<tr>
<td>DT All</td>
<td>The non-null values in the rows that were deleted, and the new effective end date on the last row.</td>
</tr>
<tr>
<td>DT Next</td>
<td>The non-null values in the row that was deleted, and the old and new effective end dates on the preceding row.</td>
</tr>
</tbody>
</table>

Table 35 – 1 Transaction Types in the Audit Report

To run the predefined audit report:

1. In the Submit Requests window, select Audit Report in the Name field.
2. Enter the Parameters field to open the Parameters window.
3. Select an audited table (that is, one in an audit group).
4. Select a value for the Initialization parameter:
   - **Yes** means that the report removes obsolete data related to your selected table from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.
   - **No** means that the report runs on the existing data in the HR_AUDITS table and the HR_AUDIT_COLUMNS table.
• **Refresh** means that the report removes *all* obsolete data from the HR_AUDITS table and the HR_AUDIT_COLUMNS table. It populate the tables with new values, then reports on these.

5. If you only want to report on the changes made by one user, enter the username.

6. Enter start and end dates to limit the time period for reporting audit information.

7. Choose the Submit button.

You can use the View Requests window to check the progress of the report.

### Designing Your Own Audit Report

If you want to design your own audit report, you can copy the supplied report and use it as the basis of your own version. The supplied report uses a dynamic SQL structure to retrieve information for the report, and an Oracle Report to format it.

### Dynamic SQL Structure

For a non–datetracked table, the dynamic SQL structure retrieves information and uses a private procedure to retrieve the new values for an update.

For a datetracked table, the dynamic SQL structure retrieves information from the function and procedure created for each datetracked table by the Audit Trail Update Datetracked Tables process:

- The `<tablename>_TT function identifies the type of datetracked transaction represented by each row of the shadow table.
- The `<tablename>_VP procedure gets new values from the shadow table for update and insert transactions. It writes these to the HR_AUDITS and HR_AUDIT_COLUMNS tables.

The dynamic SQL structure comprises several character strings, which are concatenated into one long string, then parsed and executed using the dynamic SQL generator. If you change a string, you must ensure that you do not exceed the text space allocated to it, as listed in the package header.

The structure is built up by identifying the audited table column information, which is retrieved from the FND_AUDIT_COLUMNS table. The logic varies depending on the data type being audited.
The package for the dynamic SQL is called py_audit_report_pkg. It is found in the script pyadyn.pkh/pyadyn.pkb.

**HR Audit Tables**

The HR_AUDITS table holds audit information about the transaction. The HR_AUDIT_COLUMNS table holds the changed column information for that transaction. The structure of these tables is as follows:

### HR_AUDITS Table

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>commit_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>current_session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>primary_key_value</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>sequence_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>session_id</td>
<td>number</td>
<td>not null</td>
</tr>
<tr>
<td>table_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>timestamp</td>
<td>date</td>
<td>not null</td>
</tr>
<tr>
<td>transaction</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>transaction_type</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>user_name</td>
<td>varchar2(100)</td>
<td>not null</td>
</tr>
<tr>
<td>effective_end_date</td>
<td>date</td>
<td>null</td>
</tr>
<tr>
<td>effective_start_date</td>
<td>date</td>
<td>null</td>
</tr>
</tbody>
</table>

### HR_AUDIT_COLUMNS Table

<table>
<thead>
<tr>
<th>COLUMN</th>
<th>TYPE</th>
<th>NULL</th>
</tr>
</thead>
<tbody>
<tr>
<td>audit_id</td>
<td>number(15)</td>
<td>not null</td>
</tr>
<tr>
<td>column_id</td>
<td>number(9)</td>
<td>not null</td>
</tr>
<tr>
<td>column_name</td>
<td>varchar2(30)</td>
<td>not null</td>
</tr>
<tr>
<td>new_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
<tr>
<td>old_value</td>
<td>varchar2(240)</td>
<td>null</td>
</tr>
</tbody>
</table>
Default Menus

This appendix shows you the default menu path for every window in Oracle Human Resources and Oracle Payroll. Refer to Chapter 31 Customizing Windows and Menus for information about setting up your own menu structures.

The first two sections show the structure of the default menus for the default responsibilities. The third section is arranged alphabetically by window title and shows how to find each window.
# Default Navigation Menus for HR with Payroll Responsibility

<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>People</strong></td>
<td>Enter personal and assignment information</td>
</tr>
<tr>
<td><strong>Enter and Maintain</strong></td>
<td>Enter people, assignments, and applications</td>
</tr>
<tr>
<td><strong>1 Person</strong></td>
<td></td>
</tr>
<tr>
<td>2 Address</td>
<td>3 Salary</td>
</tr>
<tr>
<td>2 Picture</td>
<td>3 Entries</td>
</tr>
<tr>
<td>2 Assignment</td>
<td>3 Tax Information</td>
</tr>
<tr>
<td>2 Special Info</td>
<td>3 Pay Method</td>
</tr>
<tr>
<td>2 Bookings</td>
<td>3 Costing</td>
</tr>
<tr>
<td>2 Absence</td>
<td>3 Grade Step</td>
</tr>
<tr>
<td>2 Contact</td>
<td>3 Budgets</td>
</tr>
<tr>
<td>3 Address</td>
<td>3 Secondary Status</td>
</tr>
<tr>
<td>3 Interview</td>
<td>3 Salary History</td>
</tr>
<tr>
<td>3 Secondary Status</td>
<td>3 Entry History</td>
</tr>
<tr>
<td>3 Budgets</td>
<td>3 Reviews</td>
</tr>
<tr>
<td>2 Competence Profile</td>
<td>3 QuickPay</td>
</tr>
<tr>
<td>2 Qualifications</td>
<td>3 Statement of Earnings</td>
</tr>
<tr>
<td>2 Work Choices</td>
<td>3 External/Manual Payment</td>
</tr>
<tr>
<td>2 Schools and Colleges Attended</td>
<td>3 Reverse Run</td>
</tr>
<tr>
<td>2 End Application</td>
<td>3 Adjust Balance</td>
</tr>
<tr>
<td>2 End Employment</td>
<td>3 Adjust Tax Balances</td>
</tr>
<tr>
<td>2 Phones</td>
<td>3 COBRA</td>
</tr>
<tr>
<td><strong>Events and Bookings</strong></td>
<td>Enter events and bookings</td>
</tr>
<tr>
<td><strong>Delete Personal Records</strong></td>
<td>Remove all records for any person</td>
</tr>
<tr>
<td><strong>Salary Management</strong></td>
<td>Manage salary details</td>
</tr>
<tr>
<td><strong>FastPath</strong></td>
<td>Enter personal and assignment information quickly</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>US Address</td>
<td>Enter address details</td>
</tr>
<tr>
<td>Picture</td>
<td>Enter pictures for a person</td>
</tr>
<tr>
<td>Special Information</td>
<td>Enter special information</td>
</tr>
<tr>
<td>Contact Information</td>
<td>Enter contact information</td>
</tr>
<tr>
<td>Event for Person</td>
<td>Book a training event</td>
</tr>
<tr>
<td>Phone Numbers</td>
<td>Enter phone numbers</td>
</tr>
<tr>
<td>Absence Information</td>
<td>Enter absence information</td>
</tr>
<tr>
<td>Application</td>
<td>Enter application details</td>
</tr>
<tr>
<td>End Application</td>
<td>End a person’s application</td>
</tr>
<tr>
<td>Assignment</td>
<td>Enter a person’s assignment details</td>
</tr>
<tr>
<td>Assignment Costing</td>
<td>Enter costing for an assignment</td>
</tr>
<tr>
<td>Assignment Budget Values</td>
<td>Enter budget values for an assignment</td>
</tr>
<tr>
<td>Grade Step Placement</td>
<td>Enter grade step placement details</td>
</tr>
<tr>
<td>Secondary Status</td>
<td>Enter a person’s secondary status</td>
</tr>
<tr>
<td>Pay Method</td>
<td>Enter a pay method</td>
</tr>
<tr>
<td>End Employment</td>
<td>End a person’s employment</td>
</tr>
<tr>
<td>Employee Review</td>
<td>Perform an employee review</td>
</tr>
<tr>
<td>Salary Review</td>
<td>Perform a Salary Review</td>
</tr>
<tr>
<td>Salary History</td>
<td>View a person’s salary history</td>
</tr>
<tr>
<td>Element Entry</td>
<td>Enter compensation and benefits for employee assignment</td>
</tr>
<tr>
<td>Benefits</td>
<td>View benefits details</td>
</tr>
<tr>
<td>Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>US Tax</td>
<td>View tax history</td>
</tr>
<tr>
<td>US Statement of Earnings</td>
<td>View statement of earnings</td>
</tr>
<tr>
<td>Employee Balance</td>
<td>View employee balances</td>
</tr>
<tr>
<td>Adjust Balances</td>
<td>Adjust balances</td>
</tr>
<tr>
<td>Taxes</td>
<td>View taxes</td>
</tr>
<tr>
<td>QuickPay</td>
<td>Run QuickPay</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Reverse Payroll Run</td>
<td>Run a reverse payroll</td>
</tr>
<tr>
<td>External Manual Payments</td>
<td>Enter external or manual payments</td>
</tr>
<tr>
<td>Recruitment</td>
<td>Manage recruiting</td>
</tr>
<tr>
<td>Requisition and Vacancy</td>
<td>Enter a requisition and any vacancies</td>
</tr>
<tr>
<td>Recruitment Activity</td>
<td>Enter a recruitment activity</td>
</tr>
<tr>
<td>Applicant Quick Entry</td>
<td>Quick entry of personal and application information</td>
</tr>
<tr>
<td>Mass Update of Applicants</td>
<td>Mass Update of Applicants</td>
</tr>
<tr>
<td>Request Recruitment Letter</td>
<td>Request a mailmerge file or a standard letter</td>
</tr>
<tr>
<td>Career Management</td>
<td></td>
</tr>
<tr>
<td>Rating Scales</td>
<td>Define general methods of measuring competencies</td>
</tr>
<tr>
<td>Competencies</td>
<td>Define competencies</td>
</tr>
<tr>
<td>Competence Types</td>
<td>Group competencies into types</td>
</tr>
<tr>
<td>Competence Requirements</td>
<td>Define requirements for enterprise, organizations, jobs and positions</td>
</tr>
<tr>
<td>Schools &amp; Colleges</td>
<td>Define name and location of training establishments</td>
</tr>
<tr>
<td>Qualification Types</td>
<td>Define, categorize and rank qualifications</td>
</tr>
<tr>
<td>Assessment Template</td>
<td>Select competencies and rating scale for an assessment</td>
</tr>
<tr>
<td>Appraisal Template</td>
<td>Select questionnaire and rating scale for an appraisal</td>
</tr>
<tr>
<td>Work Structures</td>
<td></td>
</tr>
<tr>
<td>Location</td>
<td>Enter locations</td>
</tr>
<tr>
<td>Organization</td>
<td>Enter organizational information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter information for an organization</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure organizations into hierarchies</td>
</tr>
<tr>
<td>Job</td>
<td>Enter job–related information</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>Enter job names</td>
</tr>
<tr>
<td>Path Name</td>
<td>Enter names for job career paths</td>
</tr>
<tr>
<td>Career Path</td>
<td>Enter career paths for jobs</td>
</tr>
<tr>
<td>Workers Compensation Codes</td>
<td>Enter WC codes for jobs</td>
</tr>
<tr>
<td>Workers Compensation Rates</td>
<td>Enter rates for WC codes</td>
</tr>
<tr>
<td>Position</td>
<td>Enter position–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter position names</td>
</tr>
<tr>
<td>Hierarchy</td>
<td>Structure positions into hierarchies</td>
</tr>
<tr>
<td>Mass Move</td>
<td>Enter details of a mass move</td>
</tr>
<tr>
<td>Grade</td>
<td>Enter grade–related information</td>
</tr>
<tr>
<td>Description</td>
<td>Enter grade names</td>
</tr>
<tr>
<td>Grade Rate</td>
<td>Enter rates and values for grades</td>
</tr>
<tr>
<td>Pay Scale</td>
<td>Create a pay scale of fixed progression points</td>
</tr>
<tr>
<td>Point Values</td>
<td>Enter values for progression points</td>
</tr>
<tr>
<td>Grade Steps and Points</td>
<td>Enter grade steps and fixed point values for each step</td>
</tr>
<tr>
<td>Salary Basis</td>
<td>Enter available salary bases for salary administration</td>
</tr>
<tr>
<td>Budget Calendar</td>
<td>Define calendars for headcount and position budgets</td>
</tr>
<tr>
<td>Budget</td>
<td>Enter headcount and position budgets</td>
</tr>
<tr>
<td>Status</td>
<td>Define employee and applicant assignment statuses</td>
</tr>
<tr>
<td>Recruitment Letter Type</td>
<td>Associate letter types with applicant statuses</td>
</tr>
<tr>
<td>Payroll</td>
<td>Enter information for payrolls</td>
</tr>
<tr>
<td>Description</td>
<td>Enter payroll groups</td>
</tr>
<tr>
<td>Consolidation</td>
<td>Define consolidation sets for payroll run results</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>Payment Methods</td>
<td>Define available payment methods</td>
</tr>
<tr>
<td>GL Flexfield Map</td>
<td>Map payroll costing to Oracle GL flexfield segments</td>
</tr>
<tr>
<td>Update Payroll</td>
<td>Update consolidation set or pay advice date</td>
</tr>
<tr>
<td>Run</td>
<td></td>
</tr>
<tr>
<td>Assignment Set</td>
<td>Define employee assignment sets</td>
</tr>
<tr>
<td>Element Set</td>
<td>Define element and distribution sets</td>
</tr>
<tr>
<td>RetroPay Set</td>
<td>Define retropay sets using balances and elements</td>
</tr>
<tr>
<td>Exchange Rates</td>
<td>Enter exchange rates for your base currency</td>
</tr>
<tr>
<td>Monetary Units</td>
<td>Enter monetary units for cash analysis and distribution</td>
</tr>
<tr>
<td>Compensation and Benefits</td>
<td>Enter information on compensation and benefits</td>
</tr>
<tr>
<td>Earnings</td>
<td>Activate and review earnings types</td>
</tr>
<tr>
<td>Tax Withholding Rules</td>
<td>Enter withholding rules for earnings</td>
</tr>
<tr>
<td>Deductions</td>
<td>Activate and review deductions</td>
</tr>
<tr>
<td>Element Description</td>
<td>Enter compensation and benefit information</td>
</tr>
<tr>
<td>Link</td>
<td>Enter eligibility rules for compensations and benefits</td>
</tr>
<tr>
<td>Benefit Contributions</td>
<td>Enter benefit contribution levels and values</td>
</tr>
<tr>
<td>Absence Types</td>
<td>Define absence types</td>
</tr>
<tr>
<td>Accrual Plans</td>
<td>Enter accrual plans</td>
</tr>
<tr>
<td>Write Formulas</td>
<td>Enter and modify formulas</td>
</tr>
<tr>
<td>Formula Results</td>
<td>Define what happens to formula results</td>
</tr>
<tr>
<td>Global Values</td>
<td>Enter global values for use in formulas</td>
</tr>
<tr>
<td>Balance</td>
<td>Enter balances with feeds and dimensions</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>Classification</td>
<td>Define additional element classifications</td>
</tr>
<tr>
<td>Wage Attachment Earnings Rules</td>
<td>Define Wage Attachments Earnings rules</td>
</tr>
<tr>
<td>View</td>
<td>View HRMS information</td>
</tr>
<tr>
<td>Histories</td>
<td></td>
</tr>
<tr>
<td>Employee Assignment</td>
<td>Employee assignment history</td>
</tr>
<tr>
<td>Absence</td>
<td>Employee absence history folder</td>
</tr>
<tr>
<td>Run Results</td>
<td>Employee run result history</td>
</tr>
<tr>
<td>Salary</td>
<td>Salary history for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Salary History</td>
</tr>
<tr>
<td>Entries</td>
<td></td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Entry History</td>
</tr>
<tr>
<td>Lists</td>
<td></td>
</tr>
<tr>
<td>People Folder</td>
<td>People folder</td>
</tr>
<tr>
<td>Assignment Folder</td>
<td>Assignment folder</td>
</tr>
<tr>
<td>People by Assignment</td>
<td>List people by assignment folder</td>
</tr>
<tr>
<td>Assignments</td>
<td>List assignments folder</td>
</tr>
<tr>
<td>Employees by Organization</td>
<td>List employees by organization folder</td>
</tr>
<tr>
<td>Employees by Position</td>
<td>List employees by position folder</td>
</tr>
<tr>
<td>Emps by Position Hierarchy</td>
<td>List employees by position hierarchy folder</td>
</tr>
<tr>
<td>Employees by Element</td>
<td>List employees by element</td>
</tr>
<tr>
<td>Employees by Absence Type</td>
<td>List employees by absence type folder</td>
</tr>
<tr>
<td>People by Special Information</td>
<td>List people by special information folder</td>
</tr>
<tr>
<td>Vacancies</td>
<td>View vacancies folder</td>
</tr>
<tr>
<td>Organization Budgets</td>
<td>View organization budget variance folder</td>
</tr>
<tr>
<td>Position Budgets</td>
<td>View position budget variance folder</td>
</tr>
<tr>
<td>MENU ENTRY</td>
<td>DESCRIPTION</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Grade Comparatio</td>
<td>View employee grade comparatio folder</td>
</tr>
<tr>
<td>Employee Benefits</td>
<td>View benefits for an employee assignment</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Benefits</td>
</tr>
<tr>
<td>Employee Accruals</td>
<td>View net accruals to date</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Accruals</td>
</tr>
<tr>
<td>Employee Balances</td>
<td>View employee balances for earnings and deductions</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Balances</td>
</tr>
<tr>
<td>Tax Information</td>
<td>View Employee Tax Balances</td>
</tr>
<tr>
<td>Tax Balances</td>
<td>View Employee Tax Balances</td>
</tr>
<tr>
<td>1 Assignment Folder</td>
<td>2 Tax Balances</td>
</tr>
<tr>
<td>Form 941 Information</td>
<td>View Form 941 Information</td>
</tr>
<tr>
<td>Payroll Process Results</td>
<td>View process results for a payroll</td>
</tr>
<tr>
<td>Assignment Process Results</td>
<td>View process results for an employee assignment</td>
</tr>
<tr>
<td>System Messages</td>
<td>View system level messages</td>
</tr>
<tr>
<td>Wage Attachment</td>
<td>View Wage Attachment</td>
</tr>
<tr>
<td>Exemption Rules</td>
<td>Define Wage Attachments Exemption Rules</td>
</tr>
<tr>
<td>Limit Rules</td>
<td>Define Wage Attachments Limit Rules</td>
</tr>
</tbody>
</table>

Processes and Reports

Submit Processes and Reports
Submit processes or run standard reports

View Requests
View any requests submitted for processing

View Reports
View reports online

Workflow Notifications
Workflow Notifications
In–Box

Define a QuickPaint Report
Set up the report layout

Run a QuickPaint Report
View or print the report for a set of people

Generate MS Word Letter
Generate MS Word Letter

Submit Custom Reports
Submit custom reports
<table>
<thead>
<tr>
<th>MENU ENTRY</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Information eXchange: MIX</td>
<td>Enter timecard and other information batches</td>
</tr>
<tr>
<td>Batch Element Entry</td>
<td>Enter, validate, and transfer element entry batches</td>
</tr>
<tr>
<td>PayMIX Entry</td>
<td>PayMIX batch entry</td>
</tr>
<tr>
<td>PayMIX Summary</td>
<td>PayMix batch summary</td>
</tr>
<tr>
<td>Other Definitions</td>
<td>Other Definitions</td>
</tr>
<tr>
<td>Person Types</td>
<td>Enter names for types of employees, applicants and other people</td>
</tr>
<tr>
<td>QuickCode Values</td>
<td>Enter values and meanings for QuickCode types</td>
</tr>
<tr>
<td>QuickCode Types</td>
<td>Define your own QuickCode types</td>
</tr>
<tr>
<td>Special Information Types</td>
<td>Join special information types to the current business group</td>
</tr>
<tr>
<td>Table Structure</td>
<td>Set up tables you require</td>
</tr>
<tr>
<td>Table Values</td>
<td>Enter table values</td>
</tr>
<tr>
<td>Time Periods</td>
<td>Define time period types for use in budget calendars</td>
</tr>
<tr>
<td>User Profile Options</td>
<td>Review your personal profile options</td>
</tr>
<tr>
<td>Formula Functions</td>
<td>Register your user defined functions</td>
</tr>
<tr>
<td>Security</td>
<td>Define security restrictions</td>
</tr>
<tr>
<td>Profile</td>
<td>Define security profiles to restrict record access</td>
</tr>
<tr>
<td>CustomForm</td>
<td>Define customizations to restrict information access in windows</td>
</tr>
<tr>
<td>Report Sets</td>
<td>Define sets to restrict report and process access</td>
</tr>
<tr>
<td>Task Flow Nodes</td>
<td>Define task flow nodes and customizations</td>
</tr>
<tr>
<td>Task Flow Definitions</td>
<td>Define task flows</td>
</tr>
</tbody>
</table>
Windows and their Navigation Paths

This topic shows the default navigation paths for all the windows in Oracle HRMS, as they are supplied. You can use taskflow windows directly from the menu, or from the People and Assignment windows.

The responsibility that you use determines which of these windows you can use and how you access them. Your system administrator sets up navigation menus and task flows for your responsibility. They may also create customized versions of some of these windows using different window titles.

AAP Organization

2. Enter or query an AAP Organization.
3. Choose the Others button and select AAP Organization.

Absence Detail

Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Choose the Others button and select Absence.

Or:
2. In the resulting Find window, query the person.

Absence Attendance Type

- Choose Compensation and Benefits –> Absence Types in the Navigator.

Accrual Bands

2. Enter or query an accrual plan name.
3. Choose the Accrual Bands button.
Accrual Plans
- Choose Compensation and Benefits → Accrual Plans in the Navigator.

Accruals
Do one of the following:
1. Choose View → Employee Accruals in the Navigator.
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Accruals button.
Or:
1. Choose People → Fastpath → Accruals in the Navigator.
2. In the resulting Find window, query the person.

Address
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Address button.
Or:
1. Choose People → Fastpath → Address in the Navigator.
2. In the resulting Find window, query the person.

Adjust Balance (Oracle Payroll only)
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Adjust Balance.
Or:
1. Choose People → Fastpath → Adjust Balances in the Navigator.
2. In the resulting Find window, query the person.
Adjust Tax Balances (Oracle Payroll only)

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Adjust Tax Balances.

Alter Effective Date

- Choose the Alter Effective Date icon from the toolbar.

Applicant Entry

- Choose Recruitment -> Applicant Quick Entry in the Navigator.

Applicant Interview

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.
4. Choose the Interview button.

Application

Do one of the following:

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an applicant.
3. Choose the Others button and select Application.

Or:

1. Choose People -> Fastpath -> Application in the Navigator.
2. In the resulting Find window, query the person.

Appraisal Template

- Choose Career Management -> Appraisal Template in the Navigator.

Assessment Template

- Choose Career Management -> Assessment Template in the Navigator.
Assignment
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
Or:
1. Choose People –> Fastpath –> Assignment in the Navigator.
2. In the resulting Find window, query the person.

Assignment Budget Values
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant or an employee.
3. Do one of the following:
   For an applicant:
   • Choose the Others button and select Application.
   • Choose the Budgets button.
   For an employee:
   • Choose the Assignment button.
   • Choose the Others button and select Budgets.
Or:
1. Choose People –> Fastpath –> Assignment Budget Values in the Navigator.
2. In the resulting Find window, query the person.

Assignment Criteria
1. Choose Payroll –> Assignment Set in the Navigator.
2. Enter or query an assignment set.
3. Choose the Criteria button.

Assignment History
• Choose View –> Histories –> Employee Assignment in the Navigator.
Assignment Processes
1. Choose View –> Payroll Process Results in the Navigator.
2. Enter or query a payroll process.
3. Choose the Assignment Process button.

Assignment Set
- Choose Payroll –> Assignment Set in the Navigator.

Assignment Statuses
- Choose Work Structures –> Status in the Navigator.

Assignments Folder
- Choose View –> Lists –> Assignments Folder in the Navigator.

Balance (Oracle Payroll only)
- Choose Compensation and Benefits –> Balance in the Navigator.

Balance Classifications (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Classifications button.

Balance Dimensions (Oracle Payroll only)
2. Enter or query a balance.
3. Choose the Dimensions button.

Balance Feed Control (Oracle Payroll only)
1. Choose Compensation and Benefits –> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Balance Feed Control button.

Balance Feeds (Oracle Payroll only)

Note: This instance of the Balance Feeds window lets you select more than one element to feed the balance.
2. Enter or query a balance.
3. Choose the Feeds button.

**Balance Feeds** (Oracle Payroll only)

Note: This instance of the Balance Feeds window lets you select more than one balance for the element to feed.

1. Choose Compensation and Benefits \(\rightarrow\) Element in the Navigator.
2. Enter or query an element.
3. Choose the Feeds button.

**Batch Entry Default Values** (Oracle Payroll only)

1. Choose Mass Information eXchange: MIX \(\rightarrow\) PayMIX Entry in the Navigator.
2. Choose the Defaults button.

**Batch Header**

- Choose Mass Information eXchange: MIX \(\rightarrow\) Batch Element Entry in the Navigator.

**Batch Lines**

1. Choose Mass Information eXchange: MIX \(\rightarrow\) Batch Element Entry in the Navigator.
2. Choose the Lines button.

**Beneficiaries**

1. Choose People \(\rightarrow\) Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Entries button.
5. Select the element representing the benefit for which you are entering a beneficiary.
6. Choose the Others button and select Beneficiary.

**Benefit Contributions**

- Choose Compensation and Benefits \(\rightarrow\) Benefit Contributions in the Navigator.
Book Events
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Bookings.

Budget
- Choose Work Structures -> Budget in the Navigator.

Budget Value Defaults
2. Enter or query a Business Group.
3. Choose the Others button and select Budget Value Defaults.

Budgetary Calendar
- Choose Work Structures -> Budget Calendar in the Navigator.

Business Group Information
2. Enter or query a Business Group.
3. Choose the Others button and select Business Group Information.

Career Path Names
- Choose Work Structures -> Job -> Path Name in the Navigator.

Cities
- Choose Other Definitions -> Cities in the Navigator.

City Tax Rules <Employee>
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.
5. Choose the Tax information button from the State Tax Rules <Employee> window.
6. Choose the Tax information button from the County Tax Rules <Employee> window.

**COBRA Benefits**
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Benefits button.

**COBRA Coverage**
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.

**COBRA Payments**
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Payments button.

**COBRA Statuses**
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select COBRA.
5. Enter or query a qualifying event.
6. Choose the Statuses button.
Columns
1. Choose Other Definitions -> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Columns button.

Competence Profile
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Competence Profile.

Competence Requirements
- Choose Career Management -> Competence Requirements in the Navigator.

Competence Types
- Choose Career Management -> Competence Types in the Navigator.

Competencies
- Choose Career Management -> Competencies in the Navigator.

Concurrent Requests
- Choose Processes and Reports -> View Requests in the Navigator.

Consolidation Sets (Oracle Payroll only)
- Choose Payroll -> Consolidation in the Navigator.

Contact
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
Or:
1. Choose People -> Fastpath -> Contact Information in the Navigator.
2. In the resulting Find window, query the person.
Control Totals
2. Choose the Totals button.

Costing
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Costing.
Or:
2. In the resulting Find window, query the person.

Costing Information
2. Enter or query an organization.
3. Choose the Others button and select Costing Information.

County Tax Rules <Employee>
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.
5. Choose the Tax information button from the State Tax Rules <Employee> window.

Covered Dependents
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Entries button.

5. Select the element representing the benefit for which you are entering a dependent.

6. Choose the Others button and select Dependents.

**Custom Reports**
- Choose Processes and Reports -> Submit Custom Reports in the Navigator.

**Database Items**
1. Choose Compensation and Benefits -> Write Formulas in the Navigator.
2. Enter or query a formula.
3. Choose the Show Items button.

**DateTrack History Change Field Summary**
- Choose the DateTrack History icon from the toolbar.

**Deduction** (Oracle Payroll only)
- Choose Compensation and Benefits -> Deductions in the Navigator.

**Define Function**
- Choose Other Definitions -> Formula Functions in the Navigator.

**Define QuickPaint Report**
- Choose Processes and Reports -> Define a QuickPaint Report in the Navigator.

**Define Task Flow**

**Define Task Flow Nodes**
- Choose Security -> Task Flow Nodes in the Navigator.

**Delete Person**
- Choose People -> Delete Personal Records in the Navigator.

**Earnings** (Oracle Payroll only)
- Choose Compensation and Benefits -> Earnings in the Navigator.
Earnings Entry (Oracle Payroll only)
2. Enter or query batch totals.
3. Choose the Details button.

Edit Formula
2. Enter or query a formula.
3. Choose the Edit button.

EEO–1 Filing
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select EEO–1 Filing.

Element
- Choose Compensation and Benefits –> Element Description in the Navigator.

Element and Distribution Set
- Choose Payroll –> Element Set in the Navigator.

Element Classifications (Oracle Payroll only)
- Choose Compensation and Benefits –> Classification in the Navigator.

Element Entries
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.

Or:
1. Choose People → Fastpath → Element Entries in the Navigator.
2. In the resulting Find window, query the person.

**Element Link**
- Choose Compensation and Benefits → Link in the Navigator.

**Employee Assignment Processes** (Oracle Payroll only)
- Choose View → Assignment Process Results in the Navigator.

**Employee Review**
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reviews.

Or:
1. Choose People → Fastpath → Employee Review in the Navigator.
2. In the resulting Find window, query the person.

**Employee Run Result History** (Oracle Payroll only)
- Choose View → Histories → Run Results in the Navigator.

**Employer Identification**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Employer Identification

**End Application**
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Application.

Or:
1. Choose People → Fastpath → End Application in the Navigator.
2. In the resulting Find window, query the person.
End Employment
Do one of the following:
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button and select End Employment.
Or:
1. Choose People → Fastpath → End Employment in the Navigator.
2. In the resulting Find window, query the person.

Entry Values
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Entries button.
5. Select an entry and choose the Entry Values button.

Establishment EEO–1 Filing
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Establishment EEO–1 Filing.

Establishment VETS–100 Filing
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Establishment VETS–100 Filing.

Event Bookings
Do one of the following:
- Choose People → Events and Bookings in the Navigator.
Or:
1. Choose People → Fastpath → Event for Person in the Navigator.
2. In the resulting Find window, query the person.
Exchange Rates (Oracle Payroll only)
- Choose Payroll -> Exchange Rates in the Navigator.

Exemption Rules (Oracle Payroll only)
- Choose View -> Wage Attachments-> Exemption Rules

External/Manual Payments (Oracle Payroll only)
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select External Pay.
Or:
2. In the resulting Find window, query the person.

Federal Tax Rules
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Federal Tax Rules

Federal Tax Rules <Employee>
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Tax Information button.

Form 941 Information
- Choose View -> Tax Information -> Form 941 Information in the Navigator.

Form Customization
- Choose Security -> CustomForm in the Navigator.
Formula
- Choose Compensation and Benefits -> Write Formulas in the Navigator.

Formula Result Rules (Oracle Payroll only)
- Choose Compensation and Benefits -> Formula Results in the Navigator.

Frequency Rules
1. Choose Compensation and Benefits -> Deductions in the Navigator.
2. Enter or query a deduction.
3. Choose the Frequency Rules button.

GL Map (Oracle Payroll only)
- Choose Payroll -> GL Flexfield Map in the Navigator.

Globals
- Choose Compensation and Benefits -> Global Values in the Navigator.

Grade Rate
- Choose Work Structures -> Grade -> Grade Rate in the Navigator.

Grade Scale
- Choose Work Structures -> Grade -> Grade Steps and Points in the Navigator.

Grade Step Placement
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Grade Step.
Or:
1. Choose People -> Fastpath -> Grade Step Placement in the Navigator.
2. In the resulting Find window, query the person.

**Grades**

- Choose Work Structures –> Grade –> Description in the Navigator.

**Input Values**

1. Choose Compensation and Benefits –> Element Description in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.

**Job**

- Choose Work Structures –> Job –> Description in the Navigator.

**Job Evaluation**

2. Enter or query a job.
3. Choose the Evaluation button.

**Job Requirements**

2. Enter or query a job.
3. Choose the Requirements button.

**Letter**

- Choose Work Structures –> Recruitment Letter Type in the Navigator.

**Limit Rules** (Oracle Payroll Only)

- View –> Wage Attachments –> Limit Rules

**Link Input Values**

1. Choose Compensation and Benefits –> Link in the Navigator.
2. Enter or query an element.
3. Choose the Input Values button.
List Assignments
- Choose View -> Lists -> Assignments in the Navigator.

List Budget Variance by Organization
- Choose View -> Organization Budgets in the Navigator.

List Employees by Absence Type
- Choose View -> Lists -> Employees by Absence Type in the Navigator.

List Employees by Element
- Choose View -> Lists -> Employees by Element in the Navigator.

List Employees by Organization
- Choose View -> Lists -> Employees by Organization in the Navigator.

List Employees by Position
- Choose View -> Lists -> Employees by Position in the Navigator.

List Employees by Position Hierarchy
- Choose View -> Lists -> Emps by Position Hierarchy in the Navigator.

List People by Assignment
- Choose View -> Lists -> People by Assignment in the Navigator.

List People by Special Information
- Choose View -> Lists -> People by Special Information in the Navigator.

List Position Budget Variance
- Choose View -> Position Budgets in the Navigator.

Local Tax Rules
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Local Tax Rules.
Location
- Choose Work Structures –> Location in the Navigator.

Map Career Path

Mass Move
- Choose Work Structures –> Mass Update in the Navigator.

Mass Move – Assignments
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Assignments button.

Mass Move – Messages
2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window and choose the Find button.
5. Complete the Mass Move – Positions window and choose the Assignments button.
6. Complete the Mass Move – Assignments window and close it.
7. From the Mass Move – Positions window, choose the Valid Grades button.
8. Complete the Valid Grades window and close it.
10. From the Mass Move window, choose the Execute button.
11. If the Status field shows In Error or Complete with Warnings, a Message button appears.
12. If the Message button appears, choose it to view messages in the Mass Move – Messages window.

**Note:** Alternatively, you can view messages for saved (but not yet successfully executed) mass moves as follows:

2. Enter the name of the saved mass move in the Description field.
3. When the Mass Move window is populated with data and the Message button appears, choose the Message button.

**Mass Move – Positions**

2. Complete the Mass Move window.
3. Save your work.
4. Choose the Positions button.
5. In the resulting Find Positions window, select or enter a Source Job and Source Position.
6. Choose the Find button.

**Mass Move – Valid Grades**

2. Complete the Mass Move window and save your work.
3. Choose the Positions button.
4. Complete the Find Positions window.
5. Choose the Find button.
7. Choose the Valid Grades button.

**Mass Update of Applicants**

- Choose Recruitment –> Mass Update of Applicants in the Navigator.

**Messages**

2. Choose the Messages button.
MIX Batch Entry Default Values (Oracle Payroll only)

2. Choose the Defaults button.

MIX Batch Header

- Choose Mass Information eXchange: MIX –> Batch Element Entry in the Navigator.

MIX Batch Lines

2. Choose the Lines button.

Multiple Worksite Reporting

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select Multiple Worksite Reporting

NACHA Rules

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select NACHA Rules

Net Calculation Rules

2. Enter or query an accrual plan name.
3. Choose the Net Calculation Rules button.

New Hire Reporting

2. Enter or query a GRE.
3. Choose the Others button.
4. Select New Hire Reporting
5. Click in the Additional Organization Information field.

**Organization**
- Choose Work Structures –> Organization –> Description in the Navigator.

**Organization Hierarchy**

**Organizational Payment Method**
- Choose Payroll –> Payment Methods in the Navigator.

**Parent Organization**
2. Enter or query an organization.
3. Choose the Others button and select Parent Organization.

**Pay Scale**
- Choose Work Structures –> Grade –> Pay Scale in the Navigator.

**PayMIX Batch Information** (Oracle Payroll only)
- Choose Mass Information eXchange: MIX –> PayMIX Entry in the Navigator.

**PayMIX Batch Summary** (Oracle Payroll only)
- Choose Mass Information eXchange: MIX –> PayMIX Summary in the Navigator.

**PayMIX Information** (Oracle Payroll only)
2. Enter or query a Business Group.
3. Choose the Others button and select PayMIX Information.

**Payroll**
- Choose Payroll –> Description in the Navigator.
Payroll Processes (Oracle Payroll only)

- Choose View -> Payroll Process Results in the Navigator.

People

- Choose People -> Enter and Maintain in the Navigator.

People Folder

- Choose View -> Lists -> People Folder in the Navigator.

Percentage

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Tax Information button.
4. Choose the Percentage button.

Performance

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee, and choose the Assignment button.
3. Choose the Salary button.
4. Choose the Performance button.

Period Dates

1. Choose Payroll -> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Period Dates button.

Period Types

- Choose Other Definitions -> Time Periods in the Navigator.

Person Types

- Choose Other Definitions -> Person Types in the Navigator.

Personal Payment Method

Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.

4. Choose the Pay Method button, or choose the Others button and select Pay Method.

Or:
2. In the resulting Find window, query the person.

**Personal Profile Values**
- Choose Other Definitions –> User Profile Options in the Navigator.

**Phone Numbers**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Others button.
4. Choose Phones.

Or:
1. Choose People –> Fastpath –> Phone Numbers in the Navigator.
2. In the resulting Find window, query the person.

**Picture**
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator
2. Enter or query a person.
3. Choose the Picture button.

Or:
2. In the resulting Find window, query the person.

**Position**
- Choose Work Structures –> Position –> Description in the Navigator.
Position Evaluation
2. Enter or query a position.
3. Choose the Evaluation button.

Position Hierarchy
- Choose Work Structures → Position → Hierarchy in the Navigator.

Position Occupancy Folder
2. Query a position.
3. Choose the Occupancy button.

Position Reporting To
2. Enter or query a position.
3. Choose the Reporting To button.

Position Requirements
2. Enter or query a position.
3. Choose the Requirements button.

Qualifications
1. Choose People → Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Qualifications.

Qualification Types
- Choose Career Management → Qualification Types in the Navigator.
QuickCode Type Usages
1. Choose Other Definitions –> QuickCode Types in the Navigator.
2. Enter or query a user–defined Type.
3. Choose the Usages button.

QuickCode Types
- Choose Other Definitions –> QuickCode Types in the Navigator.

QuickCodes
- Choose Other Definitions –> QuickCode Values in the Navigator.

QuickPaint Inquiry
2. Query a report that has been run.
3. Choose the View Report button.

QuickPay (Oracle Payroll only)
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select QuickPay.
Or:
2. In the resulting Find window, query the person.

Rating Scales
- Choose Career Management –> Rating Scales in the Navigator.

Recruiting For
2. Enter or query a recruitment activity.
3. Choose the Recruiting For button.
Recruitment Activity
- Choose Recruitment -> Recruitment Activity in the Navigator.

Reporting Categories
2. Enter or query a Business Group.
3. Choose the Others button and select Reporting Categories.

Reporting Statuses
2. Enter or query a Business Group.
3. Choose the Others button and select Reporting Statuses.

Request Letter
- Choose Recruitment -> Request Recruitment Letter in the Navigator.

Request Set

Requisition and Vacancy
- Choose Recruitment -> Requisition and Vacancy in the Navigator.

RetroPay Set (Oracle Payroll only)
- Choose Payroll -> RetroPay Set in the Navigator.

Reverse Payroll Run (Oracle Payroll only)
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Reverse Run.
Or:
1. Choose People -> Fastpath -> Reverse Payroll Run in the Navigator.
2. In the resulting Find window, query the person.

**Rows**

1. Choose Other Definitions –> Table Structure in the Navigator.
2. Enter or query a table.
3. Choose the Rows button.

**Run QuickPaint Report**

- Choose Processes and Reports –> Run a QuickPaint Report in the Navigator.

**Salary Administration**

Do one of the following:

1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Salary button.

Or:

2. In the resulting Find window, query the person.

**Salary Basis**

- Choose Work Structures –> Salary Basis in the Navigator.

**Salary History**

Do one of the following:

2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Salary History button.

Or:

2. In the resulting Find window, query the person.
Salary Management Folder
- Choose People –> Salary Management in the Navigator.

Scale Rate
- Choose Work Structures –> Grade –> Point Values in the Navigator.

Schools and Colleges
- Choose Career Management –> Schools and Colleges in the Navigator.

Schools and Colleges (Attended)
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Schools/Colleges.

Secondary Statuses
Do one of the following:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an applicant or employee.
3. Do one of the following:
   - For an applicant:
     - Choose the Others button and select Application.
     - Choose the Secondary Status button.
   - For an employee:
     - Choose the Assignment button.
     - Choose the Others button and select Secondary Status.

Or:
2. In the resulting Find window, query the person.

Security Profile
- Choose Security –> Profile in the Navigator.

Special Information
Do one of the following:
1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Special Info button.

Or:
1. Choose People -> Fastpath -> Special Information in the Navigator.
2. In the resulting Find window, query the person.

**Special Information Types**

- Choose Other Definitions -> Special Information Types in the Navigator.

**SQWL Employer Rules (1) (Oracle Payroll only)**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Employer Rules (1)

**SQWL Employer Rules (2) (Oracle Payroll only)**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Employer Rules (2)

**SQWL Generic Transmitter Rules (Oracle Payroll only)**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL Generic Transmitter Rules

**SQWL State-Specific Transmitter Rules (Oracle Payroll only)**
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select SQWL State Transmitter Rules
State Tax Rules
2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select State Tax Rules.

State Tax Rules <Employee>
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Chose the Tax Information button.

Statement of Earnings  (Oracle Payroll Only)
Do one of the following:
1. Choose View –> Assignment Process Results
2. Choose the SOE Report button.
Or:
1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query an employee.
3. Choose the Assignment button.
4. Choose the Others button and select Statement of Earnings.
Or:
2. In the resulting Find window, query the person.

Submit a New Request
2. Select Single Request or a Request Set.

Table Structure
- Choose Other Definitions –> Table Structure in the Navigator.
Table Values

- Choose Other Definitions -> Table Values in the Navigator.

Taxability Rules (Oracle Payroll only)

- Choose Compensation and Benefits -> Tax Withholding Rules in the Navigator.

Tax Balances (Oracle Payroll only)

1. Choose View -> Tax Information in the Navigator.
2. Choose the Tax Balances button.

Tax Rules

1. Choose People -> Enter and Maintain in the Navigator.
2. Enter or query an employee or applicant.
3. Choose the Others button and select Contact.
4. Choose the Tax Information button.

Update Payroll Run (Oracle Payroll only)

- Choose Payroll -> Update Payroll Run in the Navigator.

Valid Grades

2. Choose either Job -> Description or Position -> Description.
3. Enter or query a job or position.
4. Choose the Valid Grades button.

Valid Payment Methods

1. Choose Payroll -> Description in the Navigator.
2. Enter or query a payroll.
3. Choose the Valid Payment Methods button.

VETS–100 Filing

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select VETS–100 Filing.
**View Absence History**

- Choose View -> Histories -> Absence in the Navigator.

**View Earnings and Deductions Balances**

Do one of the following:

1. Choose View -> Employee Balances in the Navigator.
2. Select an employee assignment and choose the Balances button.

Or:

1. Choose People -> Fastpath -> Employee Balances in the Navigator.
2. In the resulting Find window, query the person.

**View Element Entry History for Employee**

2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the Entry History button.

**View Employee Dental, Medical and Vision Benefits**

1. Choose View -> Employee Benefits in the Navigator.
2. Run a query in the Assignments Folder window.
3. Select an employee assignment and choose the View Benefits button.

**View Employee Grade Comparatio**

- Choose View -> Grade Comparatio in the Navigator.

**View Run Messages** (Oracle Payroll only)

- Choose View -> System Messages in the Navigator.

**View Tax Balances**

Do one of the following:

2. Select an employee assignment and choose the Balances button.

Or:

1. Choose People -> Fastpath -> Tax Balances in the Navigator.
2. In the resulting Find window, query the person.
View Vacancies

- Choose View –> Vacancies in the Navigator.

W2 Reporting Rules

2. Enter or query a Government Reporting Entity (GRE).
3. Choose the Others button and select W2 Reporting Rules.

W941 (Oracle Payroll only)

- Choose View –> Tax Information –> Form 941 Information in the Navigator

WC Codes and Rates

- Choose Work Structures –> Job –> Workers Compensation Rates in the Navigator

Wage Attachment Earnings Rules

- Choose Compensation and Benefits –> Wage Attachments Earnings Rules in the Navigator.

Wage Attachment Exemption Rules


Wage Attachment Limit Rules

- Choose View –> Wage Attachment –> Limit Rules in the Navigator.

Work Choices (Job or Position)

2. Enter or query a job or position.
3. Choose the Work Choices button.

Work Choices (Person)

1. Choose People –> Enter and Maintain in the Navigator.
2. Enter or query a person.
3. Choose the Others button and select Work Choices.
Work Day Information
2. Enter or query an organization.
3. Choose the Others button and select Work Day Information.

Work Schedule
2. Enter or query an organization.
3. Choose the Others button and select Work Schedule.

Work Site Filing
2. Enter or query a Reporting Establishment.
3. Choose the Others button and select Work Site Filing.

Worker’s Compensation
- Choose Work Structures –> Job –> Workers Compensation Codes in the Navigator

Workflow Notifications
- Choose Processes and Reports –> Workflow Notifications in the Navigator
Key and Descriptive Flexfields

A flexfield is a flexible field that allows you to customize and extend Oracle Applications. Each flexfield has the characteristics of separate fields known as segments. There are two types of flexfield:

- Descriptive flexfields allow you to define additional information you want to record in the windows.
- Key flexfields are the mechanism by which you customize some important parts of the system.

Both types of flexfield have also been used by localization teams to customize Oracle HRMS for your legislation.

This chapter lists the flexfields in Oracle HRMS and summarizes what you need to set up.
User Definable Key Flexfields

In Oracle HRMS there are six user definable key flexfields, for each of which you can define up to 30 segments:

- Job
- Position
- Grade
- People Group
- Personal Analysis
- Cost Allocation

The Personal Analysis key flexfield is different from the others. You can set up an unlimited number of structures for this flexfield. Each separate structure can have up to 30 segments.

How the Key Flexfields Are Used

Oracle HRMS uses key flexfields in a number of distinct ways:

Unique Identifiers

The Job, Position, and Grade Name flexfields let you create a unique name, which is a combination of separate components or segments. You use these flexfields when you are defining the work structures that exist in your enterprise.

**Suggestion:** When you are defining your requirements for these key flexfields you should consider the following points.

The task of defining the segment combinations is normally restricted to one or two users only. Therefore, you may not need to use value sets, or cross validation rule options to control the values that can be entered.

The names that users see are made up of a combination of segment values. The segment values are displayed, not the meanings.

Avoid segments containing information that may change regularly. There is no history of changes to the combinations you create. For example, do not define minimum and maximum values for grades as segments of the Grade flexfield.
Analysis Information

The People Group and Personal Analysis flexfields let you add key information to records of employee assignments and people. You can use the individual segments of these flexfields to identify or report on specific groups of people.

Payroll Costing

The Cost Allocation key flexfield is used to collect and to accumulate costs associated with running a payroll.

What You Must Set Up

The key flexfields are central to Oracle HRMS, therefore you must create certain definitions before you can set up your Business Group.

Job, Position, And Grade Key Flexfields

- You can only define one structure per Business Group for each of these flexfields.
- You can define up to 30 segments within the structure.
- Use of these flexfields is optional, but almost all Oracle HRMS installations use job and grade. Positions are used most often in large, highly structured enterprises, such as those in the areas of government, education, and health care.
- You must define a structure name for these three flexfields before you can define a Business Group.
- You associate these structures with a Business Group in the Business Group Information window, which opens from the Organization window.

People Group Key Flexfield

- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You do not create separate combinations of segments for the People Group flexfield. You enter values for each employee as part of the employee assignment.
- You must define a structure name for this flexfield before you can define a Business Group.
You must define at least one segment for the People Group flexfield in order to be able to use the Assignment window.

**Personal Analysis Key Flexfield**

- You can create any number of structures per Business Group for this flexfield. Each one represents a Special Information Type.
- You can define up to 30 segments within each structure.
- You do not need to define any structures for the Personal Analysis flexfield before you can use Oracle HRMS.
- You link each structure to a Business Group in the Special Information Types window while you are logged on to that Business Group.
- You can customize windows to restrict access to specific Information Types, such as medical or disciplinary information.

**Cost Allocation Key Flexfield**

- You can only define one structure per Business Group for this flexfield.
- You can define up to 30 segments within the structure.
- You can control the levels at which users can enter cost information by using the flexfield qualifiers.
- You must define a structure name for this flexfield before you can define a Business Group.
- A number of windows in Oracle HRMS check for the existence of a valid flexfield structure for Cost Allocation. You must define at least one segment for your Cost Allocation flexfield.

**Creating Key Flexfield Database Items**

The *Create Key Flexfield DB Items* process turns data in key flexfields into database items that Oracle FastFormula can access. It is essential to run this process whenever you create or change the Grade, Job, Position, or People Group key flexfield definitions. Submit the process from the Submit Requests window.

**See Also**

*Oracle Applications Flexfields Guide*
User Definable Descriptive Flexfields

All window blocks in which you can enter information contain a user definable descriptive flexfield. You decide in which blocks you want to record additional information. Each user definable descriptive flexfield has 20 segments that you can define. After you define a descriptive flexfield, Oracle HRMS treats the segments as part of the window.

For each segment, you can define its prompt, the type of data it can contain, and the values a user can enter. You can provide a list or range of valid values. You also control the size and display characteristics of each segment and the order in which the segments appear.

You can define two types of descriptive flexfield segments:

- Global segments, which always appear in the window.
- Context sensitive segments, that appear only when a defined context exists. You can prompt the user to provide the context, or you can provide the context automatically from a reference field in the same block.

For example, a segment to hold information about an employee’s disability might appear only when the Disabled field is checked.

Attention: Some descriptive flexfields appear in more than one window. For example, the Additional Evaluation Details flexfield appears in the Job Evaluation window and the Position Evaluation window.

Check all of the windows that use a descriptive flexfield before you define any of the segments. This is especially important if you intend to make the flexfield context sensitive to another field. You must ensure that the reference field is present in all of the windows that use the flexfield.

Refer to Table B – 1 for a full list of descriptive flexfields in Oracle HRMS.
Creating Descriptive Flexfield Database Items

You can use descriptive flexfield segments in QuickPaint reports and formulas if there are database items for these segments. Table B – 1 marks the descriptive flexfields for which you can create database items. To do this you run the Create Descriptive Flexfield DB Items process. It is essential to run this process from the Submit Requests window whenever you create or change these descriptive flexfield definitions.

Note: The process can only create database items for global segments. It does not create database items for context–sensitive segments.

List of Descriptive Flexfields

The following table lists all the descriptive flexfields in Oracle HRMS.

<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Absence Details</td>
<td>Absence Detail, View Absence History</td>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Absence Type Details</td>
<td>Absence Attendance Type</td>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Address Details</td>
<td>Address, Applicant Entry, Contact</td>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Application Details</td>
<td>Applicant Entry, Application, Terminate Applicant</td>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Details</td>
<td>Applicant Entry, Assignment, Assignment History</td>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Assignment Status Details</td>
<td>Secondary Statuses</td>
<td></td>
</tr>
<tr>
<td>Additional Balance Type Information</td>
<td>Balance (Oracle Payroll only)</td>
<td></td>
</tr>
<tr>
<td>Additional Benefit Contribution Details</td>
<td>Benefit Contributions (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Booking Details</td>
<td>Applicant Interview, Book Events, Employee Review, Event Bookings</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1  User Definable Descriptive Flexfields
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Budget Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Budget Version Details</td>
<td>Budget</td>
<td></td>
</tr>
<tr>
<td>Additional Calendar Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
<tr>
<td>Additional Career Path Details</td>
<td>Career Path Names</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Benefit Details</td>
<td>COBRA Benefits (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Coverage Details</td>
<td>COBRA Coverage (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Payment Details</td>
<td>COBRA Payment (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional COBRA Status Details</td>
<td>COBRA Status (US only)</td>
<td></td>
</tr>
<tr>
<td>Additional Contact Relationship Details</td>
<td>Contact</td>
<td>CONTACTS_&lt;_SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Element Entry Information</td>
<td>Adjust Balance (Oracle Payroll only), Element Entries, View Element Entry History for Employee</td>
<td></td>
</tr>
<tr>
<td>Additional Element Link Information</td>
<td>Element Link</td>
<td></td>
</tr>
<tr>
<td>Additional Element Type Details</td>
<td>Element</td>
<td></td>
</tr>
<tr>
<td>Additional Evaluation Details</td>
<td>Job, Position</td>
<td>EVENTS_&lt;_SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Event Details</td>
<td>Applicant Interview, Employee Review, Event Bookings</td>
<td></td>
</tr>
<tr>
<td>Additional Grade Details</td>
<td>Grade</td>
<td>GRADES_&lt;_SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Job Details</td>
<td>Job</td>
<td>JOBS_&lt;_SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Letter Details</td>
<td>Letter</td>
<td></td>
</tr>
<tr>
<td>Additional Location Details</td>
<td>Location</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Information</td>
<td>Organization</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Payment Method Details</td>
<td>Organizational Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Structure Detail</td>
<td>Organization Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Organization Unit Details</td>
<td>Organization</td>
<td>ORGANIZATION_&lt;_SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Pay Scale Information</td>
<td>Pay Scale</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1  User Definable Descriptive Flexfields
<table>
<thead>
<tr>
<th>Descriptive Flexfield Title</th>
<th>Window Title</th>
<th>Database Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Pay Rate Details</td>
<td>Grade Rate, Scale Rate</td>
<td></td>
</tr>
<tr>
<td>Additional Payroll Details</td>
<td>Payroll</td>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Information</td>
<td>Budgetary Calendar, Period Dates (Payroll form)</td>
<td></td>
</tr>
<tr>
<td>Additional Period of Service Details</td>
<td>Terminate</td>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Period Type Information</td>
<td>Period Types</td>
<td></td>
</tr>
<tr>
<td>Additional Person Analysis Details</td>
<td>Special Information, List People By Special Information</td>
<td></td>
</tr>
<tr>
<td>Additional Personal Details</td>
<td>Applicant Entry, Contact, People, People Folder</td>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Personal Payment Method Details</td>
<td>Personal Payment Method</td>
<td></td>
</tr>
<tr>
<td>Additional Position Details</td>
<td>Position, Find Positions (Mass Move form)</td>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Position Structure Details</td>
<td>Position Hierarchy</td>
<td></td>
</tr>
<tr>
<td>Additional Recruitment Activity Details</td>
<td>Recruitment Activity</td>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
</tr>
<tr>
<td>Additional Requirement Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Requisition Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Administration Details</td>
<td>Salary Administration</td>
<td></td>
</tr>
<tr>
<td>Additional Salary Basis Information</td>
<td>Salary Basis</td>
<td></td>
</tr>
<tr>
<td>Additional Telephone Number Details</td>
<td>Phone Numbers</td>
<td></td>
</tr>
<tr>
<td>Additional Vacancy Details</td>
<td>Requisition and Vacancy</td>
<td></td>
</tr>
<tr>
<td>Additional Valid Grade Details</td>
<td>Job, Position</td>
<td></td>
</tr>
<tr>
<td>Additional Year Information</td>
<td>Budgetary Calendar</td>
<td></td>
</tr>
</tbody>
</table>

Table B – 1 User Definable Descriptive Flexfields
Descriptive Flexfields with Startup Data

Oracle HRMS supplies two predefined descriptive flexfields to hold address information in different styles for different countries. These are the Personal Address Information descriptive flexfield and the Location Address descriptive flexfield.

You can use these descriptive flexfields to add new address styles or to change the styles included in Oracle HRMS.

**Attention:** If you change the predefined styles, your changes will be overwritten when you upgrade Oracle HRMS. If you add new styles, your changes may be overwritten if new startup data contains address styles for these countries.

Changing Address Styles

Address styles vary between countries, so Oracle HRMS provides two descriptive flexfields that use context sensitive segments to hold each line of an address.

### Table B – 2 Address Styles in Oracle HRMS

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal Address Information</td>
<td>PER_ADDRESSES</td>
<td>Address, Applicant Entry</td>
</tr>
<tr>
<td>Location Address</td>
<td>HR_LOCATIONS</td>
<td>Location, Organization</td>
</tr>
</tbody>
</table>

The available address styles are defined as the contexts for these flexfields. The values used are the territory codes. These codes can be found in the FND_TERRITORIES table. You can have only one Address Style for each Territory in the FND_TERRITORIES table.

Address styles are provided as startup data in these flexfields. If you require additional address styles, you need to define a new context and segments.

To change the address style for any country, disable those segments you do not want to use. Then define new segments to record your own information. However, these changes will be overwritten when you upgrade Oracle HRMS.
Protected Flexfields

Oracle HRMS supplies two key flexfields and six descriptive flexfields that are predefined and protected. Your localization team defines these flexfields to meet the specific legislative and reporting needs of your country.

The protected key flexfields are the Soft Coded Legislation key flexfield and the Bank Details key flexfield.

Table B – 3 lists the protected descriptive flexfields.

<table>
<thead>
<tr>
<th>Title</th>
<th>Table Name</th>
<th>Window Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Further Element Information</td>
<td>PAY_ELEMENT_TYPES_F</td>
<td>Element</td>
</tr>
<tr>
<td>Further Assignment Information</td>
<td>PER_ASSIGNMENT_EXTRA_INFO</td>
<td>Assignment</td>
</tr>
<tr>
<td>Further Payment Method Information</td>
<td>PAY_ORG_PAYMENT_METHODS_F</td>
<td>Organizational Payment Method</td>
</tr>
<tr>
<td>Further Person Information (Datetracked)</td>
<td>PER_PEOPLE_F</td>
<td>People, Applicant Entry</td>
</tr>
<tr>
<td>Further Person Information</td>
<td>PER_PEOPLE_EXTRA_INFO</td>
<td>People</td>
</tr>
<tr>
<td>Further Job Information</td>
<td>PER_JOB_EXTRA_INFO</td>
<td>Job</td>
</tr>
<tr>
<td>Further Position Information</td>
<td>PER_POSITION_EXTRA_INFO</td>
<td>Position</td>
</tr>
<tr>
<td>Further Organization Information</td>
<td>HR_ORGANIZATION_INFORMATION</td>
<td>Organization</td>
</tr>
<tr>
<td>Further Location Information</td>
<td>HR_LOCATION_EXTRA_INFO</td>
<td>Location</td>
</tr>
</tbody>
</table>

Table B – 3 Protected Descriptive Flexfields in Oracle HRMS

Your localization team determines which of these flexfields are required for your legislation, and what segments they should contain. Ensure that you select the appropriate legislation code when you define your Business Group so that you can see these flexfields.

⚠️ **Warning:** Do not attempt to alter the definitions of these protected flexfields. These definitions are a fundamental part of Oracle HRMS. Any change to them may lead to errors in the operating of the system.

It is possible that Oracle HRMS will use other segments of these flexfields in the future. Therefore, do not add segments to any protected flexfield. This can affect your ability to upgrade your system in the future.
Soft Coded Legislation Key Flexfield

This key flexfield holds legislation-specific information. The legislation of your Business Group determines the flexfield structure that you see.

Each localization team defines a flexfield structure and uses qualifiers to define the level at which each segment is visible. Therefore, you may be able to enter information specific to your legislation at one or more of the following levels:

- Business Group – Organization window
- Payroll – Payroll window
- Employee Assignment – Assignment window

Bank Details Key Flexfield

This flexfield holds legislation-specific bank account information. The legislation of your Business Group determines the flexfield structure that you see. Each localization team defines a flexfield structure that allows you to record the bank account information relevant to your legislation. You enter this information in the Organizational Payment Method window and Personal Payment Method window.
This appendix lists the database items available to you in Oracle Human Resources for writing formulas and defining QuickPaint reports. The database items are grouped into two listings:

- Static Database Items
- Dynamic Database Items

Static database items are shipped with the system and you cannot modify them. Dynamic database items are created by Oracle Human Resources processes whenever you define new elements or other related entities.
Static Database Items

Static database items are shipped with the system and you cannot modify them.

Applicant Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APL_DATE_END</td>
<td>The date the application ended</td>
</tr>
<tr>
<td>APL_DATE_RECEIVED</td>
<td>The date the application was received</td>
</tr>
</tbody>
</table>

Table C – 1

Employee Assignment Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_ASSIGNMENT_SEQUENCE</td>
<td>This is used as a default for assignment number</td>
</tr>
<tr>
<td>ASG_DATE_FROM</td>
<td>The date from which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_DATE_TO</td>
<td>The date to which this assignment information is effective</td>
</tr>
<tr>
<td>ASG_EMPLOYMENT_CATEGORY</td>
<td>The employment category for the assignment</td>
</tr>
<tr>
<td>ASG_END_TIME</td>
<td>The standard end time for the assignment</td>
</tr>
<tr>
<td>ASG_FREQ</td>
<td>The frequency for which the assignment working hours are measured</td>
</tr>
<tr>
<td>ASG GRADE</td>
<td>The employee’s grade</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_FROM</td>
<td>The date from which this assignment grade information is effective</td>
</tr>
<tr>
<td>ASG_GRADE_DATE_TO</td>
<td>The date to which this assignment grade information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_GROUP</td>
<td>The employee’s group</td>
</tr>
<tr>
<td>ASG_HOURS</td>
<td>The standard number of working hours for the assignment</td>
</tr>
<tr>
<td>ASG_INT_ADDR_LINE</td>
<td>The internal address of the assignment</td>
</tr>
<tr>
<td>ASG_JOB</td>
<td>The employee’s job</td>
</tr>
<tr>
<td>ASG_JOB_DATE_FROM</td>
<td>The date from which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_JOB_DATE_TO</td>
<td>The date to which this assignment job information is effective</td>
</tr>
<tr>
<td>ASG_LAST_CHANGE_REASON</td>
<td>The reason the salary was changed</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_DATE</td>
<td>Last performance review date</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_LOCATION</td>
<td>Last performance review location</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_RATING</td>
<td>Last performance review rating</td>
</tr>
<tr>
<td>ASG_LAST_PERFORMANCE_TYPE</td>
<td>Last performance review type</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PAYROLL_NAME</td>
<td>The payroll name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_ID</td>
<td>The time period ID the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NAME</td>
<td>The period name the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROC_PERIOD_NUMBER</td>
<td>The period number the assignment was last processed</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_CHANGE</td>
<td>The proposed salary change</td>
</tr>
<tr>
<td>ASG_LAST_PROPOSED_SALARY_PERCENT</td>
<td>The proposed salary change as a percentage</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_CHANGE_APPROVED</td>
<td>Whether the last proposed salary change has been approved</td>
</tr>
<tr>
<td>ASG_LAST_SALARY_DATE</td>
<td>The last salary change date</td>
</tr>
<tr>
<td>ASG_LOCATION</td>
<td>The employee’s location</td>
</tr>
<tr>
<td>ASG_LOC_INACTIVE_DATE</td>
<td>The date to which the location information is effective</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_NEXT_PERFORMANCE_DATE</td>
<td>Next performance review date</td>
</tr>
<tr>
<td>ASG_NEXT_SALARY_DATE</td>
<td>The date of the next salary change</td>
</tr>
<tr>
<td>ASG_NUMBER</td>
<td>The assignment number</td>
</tr>
<tr>
<td>ASG_ORG</td>
<td>The employee’s organization</td>
</tr>
<tr>
<td>ASG_ORG_DATE_FROM</td>
<td>The date from which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_ORG_DATE_TO</td>
<td>The date to which assignment organization information is effective</td>
</tr>
<tr>
<td>ASG_PAYROLL</td>
<td>The employee’s payroll</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_FREQUENCY</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PERFORMANCE_REVIEW_PERIOD</td>
<td>The performance review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_PER_STATUS_DP</td>
<td>Personal status for the assignment (as of Date Paid)</td>
</tr>
<tr>
<td>ASG_POSITION</td>
<td>The employee’s position</td>
</tr>
<tr>
<td>ASG_POS_DATE_FROM</td>
<td>The date from which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_DATE_TO</td>
<td>The date to which this assignment position information is effective</td>
</tr>
<tr>
<td>ASG_POS_END_TIME</td>
<td>The standard end time for the assignment position</td>
</tr>
<tr>
<td>ASG_POS_FREQ</td>
<td>The frequency for which the assignment position’s hours is measured</td>
</tr>
<tr>
<td>ASG_POS_HOURS</td>
<td>The standard number of working hours for the position</td>
</tr>
<tr>
<td>ASG_POS_PROB_PERIOD</td>
<td>The probation period for the assignment position</td>
</tr>
</tbody>
</table>

Table C - 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG_POS_START_TIME</td>
<td>The standard start time for the assignment position</td>
</tr>
<tr>
<td>ASG_PRIMARY</td>
<td>Whether this is the employee's primary assignment (yes/no)</td>
</tr>
<tr>
<td>ASG_PROB_END_DATE</td>
<td>The probation period end date</td>
</tr>
<tr>
<td>ASG_PROB_PERIOD</td>
<td>The assignment's probation period</td>
</tr>
<tr>
<td>ASG_PROB_UNITS</td>
<td>The units of the assignment's probation period</td>
</tr>
<tr>
<td>ASG_REC_FULL_NAME</td>
<td>The full name for the recruiter</td>
</tr>
<tr>
<td>ASG_RELIEF</td>
<td>The relief position if the current position holder is absent</td>
</tr>
<tr>
<td>ASG_SALARY</td>
<td>The current salary for an employee</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS</td>
<td>The payment basis (i.e. frequency) for the assignment, e.g. monthly</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_CODE</td>
<td>The payment basis lookup code for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_BASIS_NAME</td>
<td>The salary basis name for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT</td>
<td>The display element name</td>
</tr>
<tr>
<td>ASG_SALARY_ELEMENT_VALUE_NAME</td>
<td>The display input value name</td>
</tr>
<tr>
<td>ASG_SALARY_GRADE_RATE</td>
<td>The display rate name</td>
</tr>
<tr>
<td>ASG_SALARY_RATE_BASIS</td>
<td>The salary rate basis</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_FREQUENCY</td>
<td>The salary review frequency for the assignment</td>
</tr>
<tr>
<td>ASG_SALARY_REVIEW_PERIOD</td>
<td>The salary review period for the assignment</td>
</tr>
<tr>
<td>ASG_START_DATE</td>
<td>The start date of the assignment</td>
</tr>
<tr>
<td>ASG_START_TIME</td>
<td>The standard start time for the assignment</td>
</tr>
<tr>
<td>ASG_STATUS</td>
<td>The primary status for the assignment</td>
</tr>
<tr>
<td>ASG_SUCCESSOR</td>
<td>The position name that will succeed into this position</td>
</tr>
</tbody>
</table>

Table C – 2
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASG SUP FULL NAME</td>
<td>The full name for the supervisor</td>
</tr>
<tr>
<td>ASG TYPE</td>
<td>Whether this is an employee or applicant assignment</td>
</tr>
<tr>
<td>ASG VACANCY</td>
<td>The name of the vacancy applied for</td>
</tr>
</tbody>
</table>

Table C – 2
## Contact Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_ADR_CITY</td>
<td>The name of the contact’s town or city</td>
</tr>
<tr>
<td>CON_ADR_COUNTRY</td>
<td>The name of the contact’s country</td>
</tr>
<tr>
<td>CON_ADR_DATE_FROM</td>
<td>The first date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_DATE_TO</td>
<td>The last date on which the contact can be contacted</td>
</tr>
<tr>
<td>CON_ADR_LINE_1</td>
<td>The first line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_2</td>
<td>The second line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_LINE_3</td>
<td>The third line of the contact’s address</td>
</tr>
<tr>
<td>CON_ADR_PHONE_1</td>
<td>The contact’s first telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_2</td>
<td>The contact’s second telephone number</td>
</tr>
<tr>
<td>CON_ADR_PHONE_3</td>
<td>The contact’s third telephone number</td>
</tr>
<tr>
<td>CON_ADRPostal_CODE</td>
<td>The contact’s postal code</td>
</tr>
<tr>
<td>CON_ADR_REGION_1</td>
<td>The first line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_2</td>
<td>The second line of the contact’s region</td>
</tr>
<tr>
<td>CON_ADR_REGION_3</td>
<td>The third line of the contact’s region</td>
</tr>
</tbody>
</table>

Table C – 3
### Contact Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_AGE</td>
<td>The contact’s age</td>
</tr>
<tr>
<td>CON_APP_NUMBER</td>
<td>The contact’s applicant number</td>
</tr>
<tr>
<td>CON_CURRENT_APP</td>
<td>Whether the contact is a current applicant (yes/no)</td>
</tr>
<tr>
<td>CON_CURRENT_EMP</td>
<td>Whether the contact is a current employee (yes/no)</td>
</tr>
<tr>
<td>CON_DATE_OF_BIRTH</td>
<td>The contact’s date of birth</td>
</tr>
<tr>
<td>CON_DISABLED</td>
<td>Whether the contact is disabled (yes/no)</td>
</tr>
<tr>
<td>CON_EMP_NUMBER</td>
<td>The contact’s employee number</td>
</tr>
<tr>
<td>CON_END_DATE</td>
<td>The date to which this contact information is effective</td>
</tr>
<tr>
<td>CON_FIRST_NAME</td>
<td>The contact’s first name</td>
</tr>
<tr>
<td>CON_FULL_NAME</td>
<td>The contact’s full name</td>
</tr>
<tr>
<td>CON_KNOWN_AS</td>
<td>The contact’s preferred name</td>
</tr>
<tr>
<td>CON_LAST_NAME</td>
<td>The contact’s last name</td>
</tr>
<tr>
<td>CON_MARITAL_STATUS</td>
<td>The contact’s marital status</td>
</tr>
<tr>
<td>CON_MIDDLE_NAMES</td>
<td>The contact’s middle names</td>
</tr>
<tr>
<td>CON_NATIONALITY</td>
<td>The contact’s nationality</td>
</tr>
<tr>
<td>CON_PERSON_TYPE</td>
<td>The contact’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>CON_RELATIONSHIP</td>
<td>The relationship of the contact to the employee</td>
</tr>
<tr>
<td>CON_SEX</td>
<td>The contact’s sex</td>
</tr>
<tr>
<td>CON_START_DATE</td>
<td>The date from which this contact information is effective</td>
</tr>
</tbody>
</table>

Table C – 4
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CON_TITLE</td>
<td>The contact’s title</td>
</tr>
<tr>
<td>CON_WORK_PHONE</td>
<td>The contact’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 4
## Employee Hire Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMP_HIRE_DATE</td>
<td>The employee’s hire date</td>
</tr>
<tr>
<td>EMP_LAST_PROCESS_DATE</td>
<td>The date the employee was last processed</td>
</tr>
<tr>
<td>EMP_LEAVING_REASON</td>
<td>The reason the employee left</td>
</tr>
<tr>
<td>EMP_TERM_ACCEPTED_BY</td>
<td>The person who accepted the employee’s notice</td>
</tr>
<tr>
<td>EMP_TERM_DATE</td>
<td>The employee’s termination date</td>
</tr>
</tbody>
</table>

Table C – 5

## Location Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_LINE_1</td>
<td>The first line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_2</td>
<td>The second line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_LINE_3</td>
<td>The third line of the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_POSTAL_CODE</td>
<td>The postal code for the assignment’s work address</td>
</tr>
<tr>
<td>LOC_ADR_REGION_1</td>
<td>The first line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_2</td>
<td>The second line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_REGION_3</td>
<td>The third line of the assignment’s region</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_1</td>
<td>The assignment’s first work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_2</td>
<td>The assignment’s second work telephone number</td>
</tr>
<tr>
<td>LOC_ADR_PHONE_3</td>
<td>The assignment’s third work telephone number</td>
</tr>
</tbody>
</table>

Table C – 6
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_CITY</td>
<td>The town or city where the assignment works</td>
</tr>
<tr>
<td>LOC_ADR_COUNTRY</td>
<td>The country where the assignment works</td>
</tr>
</tbody>
</table>

Table C – 6

Work Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_US_COUNTY</td>
<td>The assignment’s work county (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE</td>
<td>The assignment’s work state (US only)</td>
</tr>
<tr>
<td>LOC_ADR_US_STATE_CODE</td>
<td>The assignment’s work state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 7

Work Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOC_ADR_UK_COUNTY</td>
<td>The assignment’s work county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 8
## Payroll Details

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAY.PERIODS.PER.YEAR</td>
<td>The number of pay periods in the year</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_CUT.OFF.DATE</td>
<td>The cut off date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_DATE_PAID</td>
<td>The date the payroll was paid</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_DIRECT_DEPOSIT_DATE</td>
<td>The direct deposit date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_END_DATE</td>
<td>The end date of the payroll period</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_ID</td>
<td>The ID of the time period for the payroll</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_NAME</td>
<td>The period name for the payroll</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_NUMBER</td>
<td>The current period number for the payroll</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_PAY_ADVICE_DATE</td>
<td>The pay advice date for the payroll period</td>
</tr>
<tr>
<td>PAY_PROC.PERIOD_START_DATE</td>
<td>The start date of the payroll period</td>
</tr>
</tbody>
</table>

Table C – 9
### People Addresses

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_CITY</td>
<td>The name of the person's town or city</td>
</tr>
<tr>
<td>PER_ADR_COUNTRY</td>
<td>The name of the person's country</td>
</tr>
<tr>
<td>PER_ADR_DATE_FROM</td>
<td>The first date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_DATE_TO</td>
<td>The last date on which the person can be contacted at this address</td>
</tr>
<tr>
<td>PER_ADR_LINE_1</td>
<td>The first line of the person's address</td>
</tr>
<tr>
<td>PER_ADR_LINE_2</td>
<td>The second line of the person's address</td>
</tr>
<tr>
<td>PER_ADR_LINE_3</td>
<td>The third line of the person's address</td>
</tr>
<tr>
<td>PER_ADR_PHONE_1</td>
<td>The person's first contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_2</td>
<td>The person's second contact number</td>
</tr>
<tr>
<td>PER_ADR_PHONE_3</td>
<td>The person's third contact number</td>
</tr>
<tr>
<td>PER_ADR_POSTAL_CODE</td>
<td>The person's postal code</td>
</tr>
<tr>
<td>PER_ADR_REGION_1</td>
<td>The first line of the person's region</td>
</tr>
<tr>
<td>PER_ADR_REGION_2</td>
<td>The second line of the person's region</td>
</tr>
<tr>
<td>PER_ADR_REGION_3</td>
<td>The third line of the person's region</td>
</tr>
</tbody>
</table>

Table C – 10

### Home Address Details (US only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_US_COUNTY</td>
<td>The person’s county (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE</td>
<td>The person’s state (US only)</td>
</tr>
<tr>
<td>PER_ADR_US_STATE_CODE</td>
<td>The person’s state code (US only)</td>
</tr>
</tbody>
</table>

Table C – 11
## Home Address Details (UK only)

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_ADR_UK_COUNTY</td>
<td>The person's home county (UK only)</td>
</tr>
</tbody>
</table>

Table C – 12
# People Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_AGE</td>
<td>The person’s age</td>
</tr>
<tr>
<td>PER_APPLICANT_NUMBER</td>
<td>The person’s applicant number</td>
</tr>
<tr>
<td>PER_CURRENT_APP</td>
<td>Whether the person is a current applicant (yes/no)</td>
</tr>
<tr>
<td>PER_CURRENT_EMP</td>
<td>Whether the person is a current employee (yes/no)</td>
</tr>
<tr>
<td>PER_DATE_OF_BIRTH</td>
<td>The person’s date of birth</td>
</tr>
<tr>
<td>PER_DATE_VERIFIED</td>
<td>The date the employee last verified his or her personal data</td>
</tr>
<tr>
<td>PER_DISABLED</td>
<td>Whether the person is disabled (yes/no)</td>
</tr>
<tr>
<td>PER_EMP_NUMBER</td>
<td>The person’s employee number</td>
</tr>
<tr>
<td>PER_FIRST_NAME</td>
<td>The person’s first name</td>
</tr>
<tr>
<td>PER_FULL_NAME</td>
<td>The person’s full name</td>
</tr>
<tr>
<td>PER_KNOWN_AS</td>
<td>The person’s preferred name</td>
</tr>
<tr>
<td>PER_LAST_NAME</td>
<td>The person’s last name</td>
</tr>
<tr>
<td>PER_MAIL_DESTINATION</td>
<td>The person’s mail destination</td>
</tr>
<tr>
<td>PER_MARITAL_STATUS</td>
<td>The person’s marital status</td>
</tr>
<tr>
<td>PER_MIDDLE_NAMES</td>
<td>The person’s middle names</td>
</tr>
<tr>
<td>PER_NATIONALITY</td>
<td>The person’s nationality</td>
</tr>
<tr>
<td>PER_NATIONAL_IDENTIFIER</td>
<td>The person’s national identifier</td>
</tr>
<tr>
<td>PER_PERSON_TYPE</td>
<td>Type of person – employee or applicant, for example</td>
</tr>
<tr>
<td>PER_PREV_LAST_NAME</td>
<td>The person’s previous last name</td>
</tr>
<tr>
<td>PER_SEND_EXPENSES</td>
<td>Where to send the person’s expenses (home/office)</td>
</tr>
<tr>
<td>PER_SEX</td>
<td>The person’s sex</td>
</tr>
</tbody>
</table>

Table C – 13
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PER_TITLE</td>
<td>The person’s title</td>
</tr>
<tr>
<td>PER_WORK_PHONE</td>
<td>The person’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 13
## Recruiter Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REC_CURRENT_APP</td>
<td>Whether the recruiter is a current applicant (yes/no)</td>
</tr>
<tr>
<td>REC_CURRENT_EMP</td>
<td>Whether the recruiter is a current employee (yes/no)</td>
</tr>
<tr>
<td>REC_EMP_NUMBER</td>
<td>The recruiter’s employee number</td>
</tr>
<tr>
<td>REC_GRADE</td>
<td>The recruiter’s grade</td>
</tr>
<tr>
<td>REC_INT_ADDR_LINE</td>
<td>The recruiter’s internal address</td>
</tr>
<tr>
<td>REC_JOB</td>
<td>The recruiter’s job</td>
</tr>
<tr>
<td>REC_LOCATION</td>
<td>The recruiter’s work location</td>
</tr>
<tr>
<td>REC_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>REC_ORG</td>
<td>The name of the recruiter’s organization</td>
</tr>
<tr>
<td>REC_PERSON_TYPE</td>
<td>The recruiter’s person type – employee or applicant, for example</td>
</tr>
<tr>
<td>REC_POSITION</td>
<td>The recruiter’s position</td>
</tr>
<tr>
<td>REC_WORKPHONE</td>
<td>The recruiter’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 14
## Supervisor Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUP_CURRENT_EMP</td>
<td>Whether the supervisor is a current employee (yes/no)</td>
</tr>
<tr>
<td>SUP_DATE_FROM</td>
<td>The date from which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_DATE_TO</td>
<td>The date to which this supervisor information is effective</td>
</tr>
<tr>
<td>SUP_EMP_NUMBER</td>
<td>The supervisor’s employee number</td>
</tr>
<tr>
<td>SUP_GRADE</td>
<td>The supervisor’s grade</td>
</tr>
<tr>
<td>SUP_INT_ADDR_LINE</td>
<td>The supervisor’s internal address</td>
</tr>
<tr>
<td>SUP_JOB</td>
<td>The supervisor’s job</td>
</tr>
<tr>
<td>SUP_LOCATION</td>
<td>The supervisor’s work location</td>
</tr>
<tr>
<td>SUP_MANAGER</td>
<td>Whether the assignment is a managerial assignment (yes/no)</td>
</tr>
<tr>
<td>SUP_ORG</td>
<td>The supervisor’s organization</td>
</tr>
<tr>
<td>SUP_PERSON_TYPE</td>
<td>The supervisor’s person type</td>
</tr>
<tr>
<td>SUP_POSITION</td>
<td>The supervisor’s position</td>
</tr>
<tr>
<td>SUP_WORK_PHONE</td>
<td>The supervisor’s work telephone number</td>
</tr>
</tbody>
</table>

Table C – 15

## Date Information

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SESSION_DATE</td>
<td>The effective date from FND_SESSIONS</td>
</tr>
<tr>
<td>SYSDATE</td>
<td>The system date</td>
</tr>
</tbody>
</table>

Table C – 16
Dynamic Database Items

Dynamic database items are created by Oracle Human Resources processes whenever you define new elements or other related entities.

Element Database Items

When you define a new element, Oracle Human Resources runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the element name <ENAME> to each one. It also creates further database items for each pay and input value you use <INAME>.

Here is a list of database items created each time you define an element using the Element window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ENAME&gt;_BEN_CLASS</td>
<td>The element’s benefit classification</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLASSIFICATION</td>
<td>The element’s classification</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLOSED_FOR_ENTRY</td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_CLOSED_FOR_ENTRY_CODE</td>
<td>Yes/no flag: if yes, the element’s entries cannot be modified</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COSTABLE_TYPE</td>
<td>The element’s costable type (from lookup table)</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COSTABLE_TYPE_CODE</td>
<td>The element’s costable type (code values)</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_COUNT</td>
<td>The element entry count</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_END_DATE</td>
<td>The date to which this element is effective</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_INPUT_CURRENCY_CODE</td>
<td>The element’s input currency code</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_LENGTH_OF_SERVICE</td>
<td>The element’s qualifying length of service</td>
</tr>
<tr>
<td>&lt;ENAME&gt;_OUTPUT_CURRENCY_CODE</td>
<td>The element’s output currency code</td>
</tr>
</tbody>
</table>

Table C – 17
### Table C – 17

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_PROCESSING_PRIORITY</code></td>
<td>The element’s processing priority</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_AGE</code></td>
<td>The element’s qualifying age</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS_CODE</code></td>
<td>The qualifying length of service units (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_QUALIFYING_UNITS</code></td>
<td>The qualifying length of service units (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_REPORTING_NAME</code></td>
<td>The element’s reporting name</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_STANDARD_LINK_CODE</code></td>
<td>Yes/no flag: yes = standard, no = discretionary</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE</code></td>
<td>The element’s unit of measure (from lookup table)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_UNIT_OF_MEASURE_CODE</code></td>
<td>The element’s unit of measure (code values)</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_DEFAULT</code></td>
<td>The element’s default input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MIN</code></td>
<td>The element’s minimum input value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_MAX</code></td>
<td>The element’s maximum input value</td>
</tr>
</tbody>
</table>

In addition to the items above, Oracle Human Resources creates the following four items for elements defined with multiple entries *not* allowed:

### Table C – 18

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_ENTRY_VALUE</code></td>
<td>The element value</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_USER_ENTERED_CODE</code></td>
<td>Whether a value exists at the element entry level (yes/no)</td>
</tr>
</tbody>
</table>

Table C – 18
In addition to the common list above, Oracle Human Resources creates the following item for elements defined with multiple entries allowed whose input values are numeric (that is, hours, integer, money or number).

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_START_DATE</code></td>
<td>The start date of element</td>
</tr>
<tr>
<td><code>&lt;ENAME&gt;_&lt;INAME&gt;_END_DATE</code></td>
<td>The end date of element</td>
</tr>
</tbody>
</table>

Table C – 18

The units for `<ENAME> <INAME> ENTRY VALUE` are generated for both recurring and nonrecurring elements and are user-definable. Oracle Human Resources modifies the definition text to retrieve the entry value in the unit of measure as specified in the `pay_input_values_f` table.
Grade Rate Database Items

When you define a grade rate, Oracle Human Resources runs a process to create a number of related database items for it. To ensure easy recognition of these items, the process adds the grade rate name <NAME> to each one.

Here is a list of database items created each time you define a grade rate using the Grade Rate window:

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_&lt;NAME&gt;_VALUE</td>
<td>The grade rate’s value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MINIMUM</td>
<td>The grade rate’s minimum value</td>
</tr>
<tr>
<td>GRADE_&lt;NAME&gt;_MAXIMUM</td>
<td>The grade rate’s maximum value</td>
</tr>
</tbody>
</table>

Pay Scale Rate Database Items

When you define a pay scale rate, Oracle Human Resources runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the rate name <NAME> to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPINE_&lt;NAME&gt;_VALUE</td>
<td>The pay scale rates value</td>
</tr>
</tbody>
</table>
When you define descriptive flexfield segments you make them available for use in QuickPaint by running the Create Descriptive Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the descriptive flexfields listed below.

To ensure easy recognition of these items, the process adds the descriptive flexfield segment name `<SEGMENT_NAME>` to each one.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PEOPLE_&lt;SEGMENT_NAME&gt;</td>
<td>People descriptive flexfield database items</td>
</tr>
<tr>
<td>PAYROLLS_&lt;SEGMENT_NAME&gt;</td>
<td>Payroll descriptive flexfield database items</td>
</tr>
<tr>
<td>ASSIGNMENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Assignment descriptive flexfield database items</td>
</tr>
<tr>
<td>GRADES_&lt;SEGMENT_NAME&gt;</td>
<td>Grade descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence descriptive flexfield database items</td>
</tr>
<tr>
<td>ABSENCE_TYPES_&lt;SEGMENT_NAME&gt;</td>
<td>Absence type descriptive flexfield database items</td>
</tr>
<tr>
<td>PERSON_ADDRESSES_&lt;SEGMENT_NAME&gt;</td>
<td>Person Address descriptive flexfield database items</td>
</tr>
<tr>
<td>EVENTS_&lt;SEGMENT_NAME&gt;</td>
<td>Events descriptive flexfield database items</td>
</tr>
<tr>
<td>JOBS_&lt;SEGMENT_NAME&gt;</td>
<td>Jobs descriptive flexfield database items</td>
</tr>
<tr>
<td>CONTACTS_&lt;SEGMENT_NAME&gt;</td>
<td>Contacts descriptive flexfield database items</td>
</tr>
<tr>
<td>PERIODS_OF_SERVICE_&lt;SEGMENT_NAME&gt;</td>
<td>Periods of Service descriptive flexfield database items</td>
</tr>
<tr>
<td>RECRUITMENT_ACTIVITIES_&lt;SEGMENT_NAME&gt;</td>
<td>Recruitment Activities descriptive flexfield database items</td>
</tr>
<tr>
<td>POSITION_&lt;SEGMENT_NAME&gt;</td>
<td>Position descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>APPLICATIONS_&lt;SEGMENT_NAME&gt;</td>
<td>Applications descriptive flexfield database items</td>
</tr>
<tr>
<td>ORGANIZATION_&lt;SEGMENT_NAME&gt;</td>
<td>Organization descriptive flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 22
Key Flexfield Database Items

When you define key flexfield segments you make them available for use in QuickPaint by running the Create Key Flexfield DB Items process from the Submit Requests window. This process creates database items for each of the key flexfields listed below.

To ensure easy recognition of these items, the process adds the key flexfield segment name `<SEGMENT_NAME>` to each one.

Run this process for each of your Business Groups. If you define context-dependent key flexfield structures using `BUSINESS_GROUP_ID` as the reference field, the process creates database items for those flexfield segments as well.

`BUSINESS_GROUP_ID` is the only reference field that the Create Key Flexfield DB Items process supports.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GRADE_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Grade key flexfield database items</td>
</tr>
<tr>
<td>JOB_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Job key flexfield database items</td>
</tr>
<tr>
<td>POS_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Position key flexfield database items</td>
</tr>
<tr>
<td>GROUP_KF_&lt;SEGMENT_NAME&gt;</td>
<td>Group key flexfield database items</td>
</tr>
</tbody>
</table>

Table C – 23
Absence Database Items

When you define an absence type, Oracle Human Resources runs a process to create the following database item for it. To ensure easy recognition of this item, the process adds the absence type name `<ABSENCE_NAME>` to it.

<table>
<thead>
<tr>
<th>Database item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;ABSENCE_NAME&gt;_CUM_BALANCE</code></td>
<td>The cumulative balance for an absence type</td>
</tr>
</tbody>
</table>

Table C – 24
This appendix provides template SQL*Plus scripts to extract data to include in standard letters.
Template SQL*Plus PERWPOUK

<table>
<thead>
<tr>
<th>PERWPOUK.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHENEVER SQLERROR EXIT FAILURE ROLLBACK</td>
<td>This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>REM Define the MS Word mail merge record separator</td>
<td>REM Define the column width for returning query results</td>
</tr>
<tr>
<td>DEFINE ch=’’§”</td>
<td>COLUMN L1 FORMAT A2000</td>
</tr>
<tr>
<td>REM Define the column width for returning</td>
<td>SET PAUSE OFF</td>
</tr>
<tr>
<td>query results</td>
<td>SET FEEDBACK OFF</td>
</tr>
<tr>
<td>SET RECSEP OFF</td>
<td>SET HEADING OFF</td>
</tr>
<tr>
<td>SET VERIFY OFF</td>
<td>SET TERMOUT OFF</td>
</tr>
<tr>
<td>SET PAGESIZE 0</td>
<td>REM Insert session row</td>
</tr>
<tr>
<td>insert into fnd_sessions(session_id,</td>
<td>select userenv('SESSIONID'),</td>
</tr>
<tr>
<td>,effective_date)</td>
<td>to_date('&amp;2','DD-MON-YYYY')</td>
</tr>
<tr>
<td>select userenv('SESSIONID'),</td>
<td>from sys.dual</td>
</tr>
<tr>
<td>to_date('&amp;2','DD-MON-YYYY')</td>
<td></td>
</tr>
<tr>
<td>from sys.dual</td>
<td></td>
</tr>
</tbody>
</table>

This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. This enables the datetrack security views to be accessed for the session.

The &2 argument contains the current SQL*Forms session date.
You should produce this section exactly as you see it when you define your mail merge file.
/*REM Set length of the header
SET LINESIZE 220

REM Create the mail merge 'header' record
for MS Word
REM Note: SPOOL command commented out for
concurrent manager.
REM PC based solution required the
SPOOL command.
REM spool perwpouk.txt

This section has two functions:
1) To set the mail merge header linesize.
   This is dependant on
   the character length of
   all the mail merge
   items you want to
   use. In the example,
   the header linesize
   equates
   approximately to 220
   characters.
2) To enable the
   spooling of the SQL
   results.
   You must remove the
   REM keyword from
   the line that spools
   output to a file for the
   Microsoft Mailmerge.
   If you use concurrent
   processing to generate
   the data source file,
   Concurrent Manager
   creates the output file.

select 'address_line1'   ||&ch||
'address_line2'         ||&ch||
'address_line3'         ||&ch||
'town_or_city'          ||&ch||
'country'               ||&ch||
'postal_code'           ||&ch||
'applicant_title'       ||&ch||
'applicant_last_name'   ||&ch||
'position_name'         ||&ch||
'organization_name'     ||&ch||
'grade_name'            ||&ch||
'projected_hire_date'   ||&ch||
'recruiter_title'       ||&ch||
'recruiter_last_name'   ||&ch
from    sys.dual
/

This section defines
the mail merge header
information. These
are the mail merge
fields you integrate
with your word
processed letter. Each
mail merge field is
delimited by the
pre-defined &ch
character. Ensure that
the field size does not
exceed 40 characters
and that the field
name does not
include white spaces.
Do not forget that the
length in characters of
this selected row from
sys.dual is the
LINESIZE value you
specified above.

REM re-initialise the linesize to the
maximum 2000 varchar2 length
SET LINESIZE 2000

After selecting your
mail merge header
information, you must re-set the
LINESIZE to the
maximum to
VARCHAR2 size
which is 2000.
REM Mail merge interview query
select rpad(
    nvl(pa.address_line1,' ')
    ||&ch|
    nvl(pa.address_line2,' ')
    ||&ch|
    nvl(pa.address_line3,' ')
    ||&ch|
    nvl(pa.town_or_city,' ')
    ||&ch|
    nvl(ft.territory_short_name, ' ')
    ||&ch|
    nvl(pa.postal_code,' ')
    ||&ch|
    nvl(hl1.meaning, ' ')
    ||&ch|
    nvl(pp1.last_name, ' ')
    ||&ch|
    nvl(pos.name, ' ')
    ||&ch|
    pou.name
    ||&ch|
    nvl(pg.name, ' ')
    ||&ch|

    nvl(to_char(pappl.projected_hire_date,
        'fmDay fmddth of fmMonth YYYY'), ' ')
    ||&ch|
    nvl(hl2.meaning, ' ')
    ||&ch|
    nvl(pp2.last_name, ' ')
    ||&ch,
2000, '#') L1

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended. The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

from per_addresses pa,
fnd_territories ft,
hr_lookups hl1,
hr_lookups hl2,
hr_all_organization_units pou,
per_positions pos,
per_grades pg,
per_applications pappl,
per_all_people ppl,
per_all_people pp1,
per_all_people pp2,
per_all_assignments pasgl,
per_letter_request_lines plr
```sql
where           plr.letter_request_id
    = &1
and             pp1.person_id
and             pa.primary_flag
(*)    = 'Y'
and             pp1.person_id
(*)    = pp1.person_id
and             ft.territory_code
(*)    = pa.country
and             hl1.lookup_code
(*)    = pp1.title
and             hl1.lookup_type
(*)    = 'TITLE'
and             pasg1.assignment_id
(*)    = plr.assignment_id
and             pos.position_id
(*)    = pasg1.position_id
and             pou.organization_id
(*)    = pasg1.organization_id
and             pg.grade_id
(*)    = pasg1.grade_id
and             papp1.application_id
(*)    = pasg1.application_id
and             pp2.person_id
(*)    = pasg1.recruiter_id
and             hl2.lookup_code
(*)    = pp2.title
and             hl2.lookup_type
(*)    = 'TITLE'
/
REM Note: SPOOL command commented out for concurrent manager.
REM       PC based solution required the SPOOL command.
REM spool off
/
REM update the letter request_status from PENDING to COMPLETE
update per_letter_requests plr
set    plr.request_status = 'COMPLETE'
where  plr.letter_request_id = &1
and    plr.request_status = 'PENDING'
/
REM delete the session row created
delete from fnd_sessions fs
where  fs.session_id = userenv('sessionid')
and    fs.effective_date = to_date('&2','DD–MON–YYYY')
/
REM commit the changes
commit
/
exit
```

<table>
<thead>
<tr>
<th>Explanation</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>This section updates the letter request from Pending to Complete (as the example is for letter requests).</td>
<td></td>
</tr>
<tr>
<td>This section deletes the row inserted into FND_SESSIONS.</td>
<td></td>
</tr>
<tr>
<td>This section commits the changes and exits the SQL*Plus session.</td>
<td></td>
</tr>
</tbody>
</table>
This section defines the required SQL*Plus environment settings. You should produce this section exactly as you see it when you define your mail merge file.

```sql
insert into fnd_sessions (session_id, effective_date) select userenv('SESSIONID'), to_date('&2','DD–MON–YYYY') from sys.dual
```

This section creates a row in the Application Object Library table (AOL) FND_SESSIONS. The &2 argument contains the current SQL*Forms session date. You should produce this section exactly as you see it when you define your mail merge file.

```sql
REM re-initialise the linesize to the maximum 2000 varchar2 length SET LINESIZE 2000
```

After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.
```sql
/\select nvl(t.meaning||' '||p.first_name||' '||p.last_name, '')||&ch||
nvl(a.address_line1,' ') ||&ch||
nvl(a.address_line2,' ') ||&ch||
nvl(a.address_line3,' ') ||&ch||
nvl(a.town_or_city,' ') ||&ch||
nvl(a.region_1, '') ||&ch||
nvl(a.postal_code,' ') ||&ch||
nvl(t.meaning)||' '||p.last_name,' ')
from  per_addresses a,  
       per_people p,  
       per_letter_request_lines s,  
       hr_lookups t  
where  a.person_id (+)  
       = p.person_id  
       and p.person_id  
       = s.person_id  
       and p.title  
       = t.lookup_code (+)  
       and t.lookup_type (+)  
       = 'TITLE'  
       and s.letter_request_id  
       = &1  
/

update per_letter_requests r  
set r.letter_request_id = &1  
where r.letter_request_id = &1  
/update per_letter_request_lines rl  
set rl.letter_request_id = &1  
where rl.letter_request_id = &1

/commit
/exit
```

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.

This section updates the letter request from Pending to Complete (as the example is for letter requests).

This section commits the changes and exits the SQL*Plus session.
### OTA SQL*Plus Script to Produce Confirmation Letters

<table>
<thead>
<tr>
<th>OTA.sql</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>WHENEVER SQLERROR EXIT FAILURE ROLLBACK REM</td>
<td>This section defines the required SQL*Plus environment settings.</td>
</tr>
<tr>
<td>Define the MS Word mail merge record separator</td>
<td>You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>DEFINE ch=&quot;%'&quot; REM Define the column width for returning query results</td>
<td></td>
</tr>
<tr>
<td>COLUMN L1 FORMAT A2000 SET PAUSE OFF</td>
<td></td>
</tr>
<tr>
<td>SET FEEDBACK OFF</td>
<td></td>
</tr>
<tr>
<td>SET RECEP OFF</td>
<td></td>
</tr>
<tr>
<td>SET HEADING OFF</td>
<td></td>
</tr>
<tr>
<td>SET VERIFY OFF</td>
<td></td>
</tr>
<tr>
<td>SET TERMOUT OFF</td>
<td></td>
</tr>
<tr>
<td>SET PAGESIZE 0</td>
<td></td>
</tr>
<tr>
<td>REM Insert session row</td>
<td>This section creates a row in the Application Object Library table (AOL)</td>
</tr>
<tr>
<td>insert into fnd_sessions(session_id, effective_date)</td>
<td>FND_SESSIONS. This enables the datetrack security views to be accessed for the session.</td>
</tr>
<tr>
<td>select userenv('SESSIONID'),</td>
<td>The &amp;2 argument contains the current SQL*Forms session date.</td>
</tr>
<tr>
<td>to_date('&amp;2','DD-MON-YYYY')</td>
<td>You should produce this section exactly as you see it when you define your mail merge file.</td>
</tr>
<tr>
<td>from sys.dual</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
</tbody>
</table>
REM Set length of the header
SET LINESIZE 200
REM Create the mail merge 'header' record for MS Word
REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.spool xxxxx.txt

This section has two functions:
1) To set the mail merge header linesize. This is dependant on the character length of all the mail merge items you want to use. In the example, the header linesize equates approximately to 220 characters.
2) To enable the spooling of the SQL results. The spool file should match the name of the SQL file you are writing, but with a text file extension.

```
select 'student_title' ||&ch||
     'student_first_name'    ||&ch||
     'student_last_name'    
    ||&ch||
     'event_name'            ||&ch||
     'event_code'            ||&ch||
     'event_end_date'        
||&ch from sys.dual
/```

This section defines the mail merge header information. These are the mail merge fields you integrate with your word processed letter. Each mail merge field is delimited by the pre-defined &ch character. Ensure that the field size does not exceed 40 characters and that the field name does not include white spaces. Do not forget that the length in characters of this selected row from sys.dual is the LINESIZE value you specified above.
REM re-initialise the linesize to the maximum 2000 varchar2 length
SET LINESIZE 2000

REM Mail merge confirmation query
select rpad(
    initcap(nvl(d.delegate_title_mean-
    ing,‘’))
    ||’&ch||
    nvl(d.delegate_first_name,‘’)
    ||’&ch||
    nvl(d.delegate_last_name,‘’)
    ||’&ch||
    nvl(v.description,‘’)
    ||’&ch||
    nvl(d.event_activity_version_name,‘’)
    ||’&ch||
    to_char(d.course_end_date, ‘DD
    fmMonth YYYY’) ||’&ch,
    2000,’#’)
L1
    from ota_delegate_bookings_v
    d,
    ota_activity_versions
    v,
    per_letter_request_lines
    plr
where plr.letter_request_id = &1
and (plr.ota_booking_id = d.booking_id
or plr.ota_event_id = d.event_id)
and d.activity_version_id = v.activity_version_id
/

REM Note: SPOOL command commented out for concurrent manager.
REM PC based solution required the SPOOL command.
spool off

After selecting your mail merge header information, you must re-set the LINESIZE to the maximum to VARCHAR2 size which is 2000.

This section is the main SQL*Plus query that generates the mail merge field information. Note that the columns are merged together using the &ch character as the field delimiter. The RPAD function pads out the row of information with # for all white spaces. Without this function, mail merge cannot distinguish when a row/record has ended.

The SQL*Plus query in this example is generated from letter requests. Therefore the &1 argument is used to identify which letter_request_id is being generated.
<table>
<thead>
<tr>
<th>SQL Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{REM Update the letter request_status from PENDING to COMPLETE}</td>
<td>This section updates the letter request from Pending to Complete (as the example is for letter requests).</td>
</tr>
<tr>
<td>update per_letter_requests</td>
<td></td>
</tr>
<tr>
<td>\texttt{plr}</td>
<td></td>
</tr>
<tr>
<td>set plr.request_status = 'COMPLETE'</td>
<td></td>
</tr>
<tr>
<td>where plr.letter_request_id = &amp;1</td>
<td></td>
</tr>
<tr>
<td>and plr.request_status = 'PENDING'</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
<tr>
<td>\texttt{REM delete the session row created}</td>
<td>This section deletes the row inserted into FND_SESSIONS.</td>
</tr>
<tr>
<td>delete from fnd_sessions</td>
<td></td>
</tr>
<tr>
<td>fs</td>
<td></td>
</tr>
<tr>
<td>where fs.session_id = userenv('sessionid')</td>
<td></td>
</tr>
<tr>
<td>and fs.effective_date = to_date('&amp;2','DD-MON-YYY')</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
<tr>
<td>\texttt{REM commit the changes}</td>
<td>This section commits the changes and exits the SQL*Plus session</td>
</tr>
<tr>
<td>commit_the_changes</td>
<td></td>
</tr>
<tr>
<td>/</td>
<td></td>
</tr>
<tr>
<td>exit</td>
<td></td>
</tr>
</tbody>
</table>
A

Absence Types Categories of absence, such as medical leave or vacation leave, that you define for use in absence windows.

Alternative Regions Parts of a window that appear in a stack so that only one is visible at any time. You click on the name of the region to pop up a list of the other regions in the stack. Select the name of a region to bring it to the top of the stack.

Applicant A candidate for employment in a Business Group.

Appraisal A ‘superset’ of recording opinions and setting and achieving objectives, plans and so on. See also: Assessment.

Assessment An information gathering exercise, from one or many sources, to evaluate a person’s ability to do a job. See also: Appraisal.

Assignment An employee’s assignment identifies his or her role and payroll within a Business Group. The assignment is made up of a number of assignment components. Of these, organization is mandatory, and payroll is a required component for payment purposes.

Assignment Number A number that uniquely identifies an employee’s assignment. An employee with multiple assignments has multiple assignment numbers.

Assignment Set A grouping of employees and/or applicants that you define for running QuickPaint reports and processing payrolls. See also: QuickPaint Report.

Assignment Status For employees, used to track their permanent or temporary departures from your enterprise, and to control the remuneration they receive. For applicants, used to track the progress of their applications.

Base Currency The currency in which Oracle Payroll performs all payroll calculations for your Business Group. If you pay employees in different currencies to this, Oracle Payroll calculates the amounts based on exchange rates defined on the system.

Behavioral Indicators Characteristics that identify how a competence is exhibited in the work context. See also: Proficiency Level.
**Benefit**  Any part of an employee’s remuneration package that is not pay. Vacation time, employer–paid medical insurance and stock options are all examples of benefits. See also: *Elements*

**Block**  The largest subordinate unit of a window, containing information for a specific business function or entity. Every window consists of at least one block. Blocks contain fields and, optionally, regions. They are delineated by a bevelled edge. You must save your entries in one block before navigating to the next. See also: *Region, Field*

**Budget Value**  In Oracle Human Resources you can enter staffing budget values and actual values for each assignment to measure variances between actual and planned staffing levels in an organization or hierarchy.

**Business Group**  The highest level organization in the Oracle HRMS system. A Business Group may correspond to the whole of your enterprise or to a major grouping such as a subsidiary or operating division. Each Business Group must correspond to a separate implementation of Oracle HRMS.

**Cash Analysis**  A specification of the different currency denominations required for paying your employees in cash. Union contracts may require you to follow certain cash analysis rules.

**Compensation**  The pay you give to employees, including wages or salary, and bonuses. See also: *Elements*

**Competence**  Any measurable behavior required by an organization, job or position that a person may demonstrate in the work context. A competence can be a piece of knowledge, a skill, an attitude or an attribute.

**Competence Profile**  Where you record applicant and employee accomplishments, for example, proficiency in a competence.

**Competence Requirements**  Competencies required by an organization, job or position. See also: *Competence, Core Competencies*

**Competence Type**  A group of related competencies

**Consolidation Set**  A grouping of payroll runs within the same time period for which you can schedule reporting, costing, and post–run processing.

**Contact**  A person who has a relationship to an employee that you want to record. Contacts can be dependents, relatives, partners or persons to contact in an emergency.

**Core Competencies**  Competencies required by every person to enable the enterprise to meet its goals. See also: *Competence*
**Costable Type**  A feature that determines the processing an element receives for accounting and costing purposes. There are four costable types in Oracle HRMS: costed, distributed costing, fixed costing, and not costed.

**Costing**  Recording the costs of an assignment for accounting or reporting purposes. Using Oracle Payroll, you can calculate and transfer costing information to your general ledger and into systems for project management or labor distribution.

**Customizable Forms**  Forms that your system administrator can modify for ease of use or security purposes by means of Custom Form restrictions. The Form Customization window lists the forms and their methods of customization.

**Descriptive Flexfield**  A field that your organization can customize to capture additional information required by your business but not otherwise tracked by Oracle Applications. See also: *Key Flexfield*

**Effective Date**  The date for which you are entering and viewing information. You set your effective date in the Alter Effective Date window. See also: *DateTrack*

**Elements**  Components in the calculation of employee pay. Each element represents a compensation or benefit type, such as salary, wages, stock purchase plans, and pension contributions.

**Element Classifications**  These control the order in which elements are processed and the balances they feed. Primary element classifications and some secondary classifications are predefined by Oracle Payroll. Other secondary classifications can be created by users.

**Element Entry**  The record controlling an employee’s receipt of an element, including the period of time for which the employee receives the element and its value. See also: *Recurring Elements, Nonrecurring Elements*

**Element Link**  The association of an element to one or more components of an employee assignment. The link establishes employee eligibility for that element. Employees whose assignment components match the components of the link are eligible for the element. See also: *Standard Link*

**Database Item**  An item of information in Oracle HRMS that has special programming attached, enabling Oracle FastFormula to locate and retrieve it for use in formulas.

**Date To and Date From**  These fields are used in windows not subject to DateTrack. The period you enter in these fields remains fixed until you change the values in either field. See also: *DateTrack, Effective Date*

**DateTrack**  When you change your effective date (either to past or future), DateTrack enables you to enter information that takes effect on your new effective date, and to review information as of the new date. See also: *Effective Date*

**Deployment Factors**  See: *Work Choices*
Element Set  A group of elements that you define to process in a payroll run, or to control access to compensation information from a customized form, or for distributing costs.


Event  An activity such as a training day, review, or meeting, for employees or applicants.

Field  A view or entry area in a window where you enter, view, update, or delete information. See also: Block, Region

Form  A predefined grouping of functions, called from a menu and displayed, if necessary, on several windows. Forms have blocks, regions and fields as their components. See also: Block, Region, Field

Global Value  A value you define for any formula to use. Global values can be dates, numbers or text.

Grade  A component of an employee’s assignment that defines their level and can be used to control the value of their salary and other compensation elements.

Grade Comparison  A comparison of the amount of compensation an employee receives with the mid-point of the valid values defined for his or her grade.

Grade Rate  A value or range of values defined as valid for a given grade. Used for validating employee compensation entries.

Grade Scale  A sequence of steps valid for a grade, where each step corresponds to one point on a pay scale. You can place each employee on a point of their grade scale and automatically increment all placements each year, or as required. See also: Pay Scale

Grade Step  An increment on a grade scale. Each grade step corresponds to one point on a pay scale. See also: Grade Scale

Group  A component that you define, using the People Group key flexfield, to assign employees to special groups such as pension plans or unions. You can use groups to determine employees’ eligibility for certain elements, and to regulate access to payrolls.

Hierarchy  An organization or position structure showing reporting lines or other relationships. You can use hierarchies for reporting and for controlling access to Oracle HRMS information.

Input Values  Values you define to hold information about elements. In Oracle Payroll, input values are processed by formulas to calculate the element’s run result. You can define up to fifteen input values for an element.
K

Key Flexfield  A flexible data field made up of segments. Each segment has a name you define and a set of valid values you specify. Used as the key to uniquely identify an entity, such as jobs, positions, grades, cost codes, and employee groups. See also: Descriptive Flexfield

Leaver’s Statement  Records details of Statutory Sick Pay (SSP) paid during a previous employment (issued as form SSP1L) which is used to calculate a new employee’s entitlement to SSP. If a new employee falls sick, and the last date that SSP was paid for under the previous employment is less than eight calendar weeks before the first day of the PIW for the current sickness, the maximum liability for SSP is reduced by the number of weeks of SSP shown on the statement.

M

Menus  You set up your own navigation menus, to suit the needs of different users.

N

NACHA  National Automated Clearing House Association. This is the US system for making direct deposit payments to employees.

Nonrecurring Elements  Elements that process for one payroll period only unless you make a new entry for an employee. See also: Recurring Elements

O

Oracle FastFormula  An Oracle tool that allows you to write Oracle HRMS formulas without using a programming language.

Organization  A required component of employee assignments. You can define as many organizations as you want within your Business Group. Organizations can be internal, such as departments, or external, such as recruitment agencies. You can structure your organizations into organizational hierarchies for reporting purposes and for system access control.

P

Pay Scale  A set of progression points, which can be related to one or more rates of pay. Employees are placed on a particular point on the scale according to their grade and, usually, work experience. See also: Grade Scale

Payment Type  There are three standard payment types for paying employees: check, cash and direct deposit. You can define your own payment methods corresponding to these types.

Payroll  A group of employees that Oracle Payroll processes together with the same processing frequency, for example, weekly, monthly or bimonthly. Within a Business Group, you can set up as many payrolls as you need.

Performance (within Assessment)  An expectation of “normal” performance of a competence over a given period. For example, a person may exceed performance expectation in the communication competence. See also: Proficiency (within Assessment), Competence, Assessment
**Period Type**  A time division in a budgetary calendar, such as week, month, or quarter.

**Person Type**  There are eight system person types in Oracle HRMS. Seven of these are combinations of employees, ex-employees, applicants, and ex-applicants. The eighth category is 'External'. You can create your own user person types based on the eight system types.

**Position**  A specific role within the Business Group derived from an organization and a job. For example, you may have a position of Shipping Clerk associated with the organization Shipping and the job Clerk.

**Proficiency (within Assessment)**  The perceived level of expertise of a person in a competence, in the opinion of the assessor, over a given period. For example, a person may demonstrate the communication competence at Expert level. See also: *Performance (within Assessment), Competence, Assessment*

**Proficiency Level**  A system for expressing and measuring how a competence is exhibited in the work context. See also: *Behavioral Indicators*.

**Progression Point**  A pay scale is calibrated in progression points, which form a sequence for the progression of employees up the pay scale. See also: *Pay Scale*
Q

Qualification Type  An identified qualification method of achieving proficiency in a competence, such as an award, educational qualification, a license or a test. See: Competence

QuickCode Types  Categories of information, such as nationality, address type and tax type, that have a limited list of valid values. You can define your own QuickCode Types, and you can add values to some predefined QuickCode Types.

QuickPaint Report  A method of reporting on employee and applicant assignment information. You can select items of information, paint them on a report layout, add explanatory text, and save the report definition to run whenever you want. See also: Assignment Set

R

Rates  A set of values for employee grades or progression points. For example, you can define salary rates and overtime rates.

Rating Scale  Used to describe an enterprise’s competencies in a general way. You do not hold the proficiency level at the competence level. See also: Proficiency Level

Recruitment Activity  An event or program to attract applications for employment. Newspaper advertisements, career fairs and recruitment evenings are all examples of recruitment activities. You can group several recruitment activities together within an overall activity.

Recurring Elements  Elements that process regularly at a predefined frequency. Recurring element entries exist from the time you create them until you delete them, or the employee ceases to be eligible for the element. Recurring elements can have standard links. See also: Nonrecurring Elements, Standard Link

Region  A collection of logically related fields in a window, set apart from other fields by a rectangular box or a horizontal line across the window. See also: Block, Field

Report Parameters  Inputs you make when submitting a report to control the sorting, formatting, selection, and summarizing of information in the report.

Report Security Group  A list of reports and processes that can be submitted by holders of a particular responsibility. See also: Responsibility

Report Set  A group of reports and concurrent processes that you specify to run together.

Requisition  The statement of a requirement for a vacancy or group of vacancies.

Responsibility  A level of authority in an application. Each responsibility lets you access a specific set of Oracle Applications forms, menus, reports, and data to fulfill your business role. Several users can share a responsibility, and a single user can have multiple responsibilities. See also: Security Profile, User Profile Options, Report Security Group
Retry  Method of correcting a payroll run or other process before any post-run processing takes place. The original run results are deleted and the process is run again.

Reversal  Method of correcting payroll runs or QuickPay runs after post-run processing has taken place. The system replaces positive run result values with negative ones, and negative run result values with positive ones. Both old and new values remain on the database.

Rollback  Method of removing a payroll run or other process before any post-run processing takes place. All assignments and run results are deleted.

Salary Basis  The period of time for which an employee’s salary is quoted, such as hourly or annually. Defines a group of employees assigned to the same salary basis and receiving the same salary element.

Security Profile  Security profiles control access to organizations, positions and employee and applicant records within the Business Group. System administrators use them in defining users’ responsibilities. See also: Responsibility, User Profile Options

Special Information Types  Categories of personal information, such as skills, that you define in the Personal Analysis key flexfield.

Standard Link  Recurring elements with standard links have their element entries automatically created for all employees whose assignment components match the link. See also: Element Link, Recurring Elements

Task Flows  A sequence of windows linked by buttons to take you through the steps required to complete a task, such as hiring a new recruit. System administrators can create task flows to meet the needs of groups of users.

Terminating Employees  You terminate an employee when he or she leaves your organization. Information about the employee remains on the system but all current assignments are ended.

Termination Rule  Specifies when entries of an element should close down for an employee who leaves your enterprise. You can define that entries end on the employee’s actual termination date or remain open until a final processing date.

User Profile Options  Features that allow system administrators and users to tailor Oracle HRMS to their exact requirements. See also: Responsibility, Security Profile

Work Choices  Also known as Deployment or Work Factors. These can affect a person’s capacity to be deployed within an enterprise, such willingness to travel or relocate. You can hold work choices at both job and position, or at person level.

Work Structures  The fundamental definitions of organizations, jobs, positions, grades, payrolls and other employee groups within your enterprise that provide the framework for defining the work assignments of your employees.
Index

A
AAP reporting
data for, 17 – 15
hierarchies for, 17 – 13
organizations for, 16 – 18, 17 – 13
overview of, 17 – 12 to 17 – 14
setup steps for, 17 – 16
Absence categories, for absence types, 26 – 2 to 26 – 4
Absence elements
balances for, 26 – 5 to 26 – 7
definition and linking of, 26 – 9 to 26 – 11
Absence types
database items, C – 26
definition of, 26 – 11 to 26 – 16
listing by, 26 – 17
ABSENCE_CATEGORY, 26 – 9, 26 – 12
ABSENCE_REASON, 26 – 9, 26 – 12
Absences
authorization of and replacements for, 26 – 7
batch entry of, 26 – 7, 26 – 30
defining and linking elements for, 26 – 9
defining types of, 26 – 11 to 26 – 16
elements for, 26 – 4 to 26 – 7
employee’s history of, 26 – 16
initializing balances for, 26 – 6
recording of, 26 – 7 to 26 – 8, 26 – 14 to 26 – 15
referencing in payroll runs, 26 – 7
relief position, 3 – 12
reporting for, 26 – 18
reviewing, 26 – 16 to 26 – 18
setup for recording, 26 – 9 to 26 – 13
types, categories and reasons, 26 – 2 to 26 – 4
Accepted assignment status, 15 – 15
Accrual plans. See PTO accrual plans
Accrued PTO. See PTO
Active application assignment status, 15 – 15
Active assignment status, 28 – 5
ADA reporting
information for, 13 – 26, 17 – 28 to 17 – 31
overview of, 17 – 28
registering employees with disabilities, 13 – 6
setup steps for, 17 – 30
Address styles, B – 9
ADDRESS_TYPE, 13 – 11, 13 – 13
Addresses
floor or office numbers, 14 – 12
for work sites, 2 – 2 to 2 – 3
generic, for people, 13 – 11
validated, for people, 13 – 12
Affirmative action plans. See AAP reporting
Alerts, competencies, 19 – 10
APL_ASSIGN_REASON, 15 – 12, 15 – 16
APL_EVENT_TYPE, 15 – 18, 27 – 2
APL_INTERVIEW_TYPE, 15 – 17
Applicant assignment statuses, 15 – 15 to 15 – 18
mass update of, 15 – 19
reporting on, 14 – 33
secondary statuses, 15 – 16
user statuses for, 28 – 7
Applicant assignments, 15 – 10
Applicant Details Report, 13 – 31
Applicant information, 13 – 8
Applicant number, 13 – 5
Applicants
entering, 15 – 10
hiring, 15 – 19
interviewing, 15 – 17
listing, 13 – 3
mass update of status, 15 – 19
referring to another recruiter, 15 – 19
reporting on, 15 – 10, 15 – 22
skills matching, 15 – 5
terminating, 15 – 21
tracking progress of, 15 – 15 to 15 – 16
Application Data Export, 33 – 5
Appraisal
overview, 22 – 14
questionnaire, 22 – 14
creating, 22 – 18, 22 – 23
template, 22 – 15
creating or changing, 22 – 31
Appraisals, 18 – 12, 27 – 4
See also Performance reviews
Assessment
competence–based, 22 – 3
measuring competencies, 22 – 3
template, 22 – 4
calculating scores, 22 – 8
changing or deleting, 22 – 9
different types, 22 – 4
proficiency levels, 22 – 6
Assessments, 18 – 12
Assignment components
and element eligibility rules, 7 – 25
and element links, 7 – 6
and pay processing requirements, 14 – 5
Assignment Details Report, 13 – 31
Assignment reporting
Assignment Status Report, 14 – 33
Assignments Folder, 14 – 26
Assignment sets, 30 – 14
Assignments
See also Employee assignments
for applicants, 15 – 10
for employees, 14 – 4
verifying for a mass move, 3 – 31
Attachments, 33 – 6
Audit groups, 35 – 2
AuditTrail, 35 – 2
setting up audit groups, 35 – 2
Automatic element entry
HR example of, 7 – 28
payroll example of, 7 – 28
standard links for, 7 – 27
B
Background check information, 13 – 8
Balances, fiscal year, 2 – 27
Bank account information, B – 11
Bank information, for employees, 14 – 23
Base currency, 29 – 7
Batch element entry
BEE facility for, 8 – 3 to 8 – 11
PayMIX facility for, 8 – 12 to 8 – 13
Batch processing, generating letters, 33 – 12 to 33 – 15
BEE
for batch element entry, 8 – 2, 8 – 3 to 8 – 11
procedures for, 8 – 4
Behavioral indicators, competencies, 19 – 2
Beneficiaries
entering organizations as, 2 – 23
template of, 13 – 16 to 13 – 20
recording, 10 – 20 to 10 – 23
Benefit plans for health care
COBRA–eligible, 10 – 24
defining elements for, 10 – 6 to 10 – 8
dependent coverage under, 10 – 14
enrolling employees in, 10 – 14
initiating deductions for, 10 – 5 to 10 – 7
reviewing enrollment in, 10 – 14
Benefits
beneficiaries for, 10 – 4, 10 – 20
classifications for, 10 – 3
defining carriers of, 2 – 23, 10 – 2
defining elements for, 10 – 6 to 10 – 7
dependent coverage under, 10 – 16 to 10 – 19
enrolling employees in, 10 – 3
establishing eligibility for, 10 – 2
initiating deductions for, 10 – 5 to 10 – 6
overview of, 10 – 2
using elements to represent, 10 – 2 to 10 – 4
Benefits classifications
for COBRA–eligible benefits, 10 – 3
for elements representing benefits, 7 – 3
list of, 10 – 3
Benefits creation, 10 – 5
with Oracle Payroll, 10 – 5 to 10 – 6
without Oracle Payroll, 10 – 6
Benefits Table, entries for, 10 – 7, 10 – 12
Blood type, entry of, 13 – 9
Booking events, 15 – 18, 27 – 3
Budget value defaults, 2 – 27
BUDGET_MEASUREMENT_TYPE, 2 – 28, 12 – 3
Budgets
for people, 12 – 2 to 12 – 11
for salaries, 9 – 16 to 9 – 17, 12 – 5 to 12 – 11
in centralized management enterprises, 9 – 17
in devolved management enterprises, 9 – 17
in project based enterprises, 6 – 5
in rule based enterprises, 6 – 8, 9 – 16, 12 – 5
viewing variances, 12 – 9
Business Groups
additional information for, 2 – 24
defaults for, 2 – 27 to 2 – 28
defining, 2 – 20 to 2 – 24
key flexfields for, 2 – 4 to 2 – 6
representing companies in, 2 – 15 to 2 – 17
startup data, 2 – 7

C
Calendars
for budgets, 12 – 7
for employee absences, 26 – 7
for payrolls, 5 – 8
for PTO accrual plans, 26 – 19
Career Management, defining your enterprise competencies, 18 – 10
Career paths
defining, 23 – 8
naming, 23 – 5, 23 – 7, 23 – 8
Career planning, 18 – 14, 23 – 2 to 23 – 10
Careers, planning, 23 – 2
Categories of elements, 7 – 3
listing of, 7 – 8 to 7 – 15
Classifications of elements
See also Element classifications
for benefits, 10 – 3 to 10 – 5
primary, 7 – 8
primary and benefits, 7 – 3
Classifying organizations. See Organizations, classifications for
COBRA
Coverage Report, 10 – 32
Expiration Letter, 10 – 32
Grace Period Expiration Letter, 10 – 32
Notification Letter, 10 – 32
Payments Report, 10 – 32
COBRA continued coverage
premium payment schedules for, 10 – 31
receipt of premium payments for, 10 – 31
setting up, 10 – 30
standard letters relating to, 10 – 25
COBRA qualifying events
for employees and dependents, 10 – 24
recording of, 10 – 28
COBRA reports
COBRA Coverage, 10 – 25 to 10 – 34
COBRA Payments, 10 – 26
COBRA termination reasons
adding to list of, 10 – 27
in startup data, 10 – 27
COBRA–eligible benefit plans
administration of, 10 – 24
changing coverage status of, 10 – 29
employer responsibilities for, 10 – 24
recording qualifying events for, 10 – 28
College attendances, 13 – 19
Comments, 33 – 6
Common framework, competence approach, advantages, 18 – 2
Common paymaster, 2 – 21
Comparatio values for grades, 4 – 10
Comparing with accomplishments, requirements, competence approach, 20 – 3
Compensation and benefits
relating grades to, 4 – 3, 4 – 6
salary administration, 9 – 2 to 9 – 15
using elements to represent, 7 – 2 to 7 – 4

Competence approach
common framework, advantages, 18 – 2
controlling your operation, 18 – 8
identifying your business goals, 18 – 9

Competence gap analysis, 18 – 14
Competence profile, copying competencies, 13 – 19

Competence profiles, 13 – 19
Competence requirements
creating, 20 – 2
overview, 18 – 10

Competence types
creating, 19 – 16
deleting, 19 – 16

Competencies
a definition, 19 – 2
alerts, 19 – 10
behavioral indicators, 19 – 2
certification, 19 – 13
copying, competence profile, 13 – 19
core, 20 – 2
creating, 19 – 10
essential, 20 – 4
grouping, 19 – 14
leadership, 20 – 2
proficiency levels, 19 – 2
structuring, 19 – 4
general method, 19 – 5
individual method, 19 – 4
which method, 19 – 6

Competencies and OTA, 18 – 14
setting up Career Management, 21 – 2

Concurrent managers, 30 – 5
CONTACT, 13 – 16
Contacts, 28 – 2
extry of, 13 – 16 to 13 – 20
Contract staff, 6 – 12
CONTROL_TYPE, 8 – 4

Controlling your operation, Career Management, 18 – 8

Copying competencies, competence profile, 13 – 19

Core competencies, creating, 20 – 2

Corporate Headquarters
See also Reporting Organizations
defining, 2 – 23
hierarchies for, 16 – 10 to 16 – 15
Reporting Establishment for, 16 – 17 to 16 – 19

Cost Allocation key flexfield, 2 – 6, B – 4
cost centers in, 11 – 2 to 11 – 6
customizing segment names of, 2 – 8
detail overrides, 11 – 6
elements of, 11 – 2 to 11 – 6
qualifiers for, 11 – 11 to 11 – 13
setting of, 11 – 11 to 11 – 13
use of, 11 – 5 to 11 – 6

Cost centers
defining organizations as, 11 – 9
elements of cost allocation to, 11 – 18 to 11 – 19
for organizations, 2 – 16
in the Cost Allocation flexfield, 11 – 2 to 11 – 6

Costable types
for costing information, 11 – 7
for element links, 7 – 38

Costing
for organizations, 2 – 30
for payrolls, 5 – 8
salary budgeting, 9 – 16 to 9 – 17, 12 – 5 to 12 – 11

Costing information
examples of, 11 – 18 to 11 – 21
for assignments, 11 – 9 to 11 – 10
for element entries, 11 – 10 to 11 – 12
for element links, 11 – 7 to 11 – 9
for GL debits and credits, 11 – 8
for organizations and assignments, 11 – 9 to 11 – 11
for payrolls, 11 – 6
for projects, 6 – 4
for taxes, 11 – 14 to 11 – 16
PayMIX entry for, 8 – 14, 8 – 18
process for accumulating, 11 – 17 to 11 – 19
transfer to Oracle GL, 11 – 24 to 11 – 26

Country–specific features
address styles, B – 9
in key flexfields, B – 10
Currencies, enabling, 29 – 7
Current and Projected Progression Point Values Report, 4 – 18
Customizing
  Event Bookings window, 27 – 2
  List People by Special Information window, 13 – 3
  menu structures, 31 – 17 to 31 – 19
  People Folder window, 13 – 4
  People window, 13 – 4
  QuickPaint Report window, 30 – 13
  Special Information window, 13 – 26
  Table Values window, 32 – 17
  windows, 31 – 2, 31 – 3 to 31 – 8

D
Database items
  and payroll formula inputs, 7 – 21
  in QuickPaint reports, 30 – 10
  list of dynamic items, C – 19
  list of static items, C – 2
Date earned
  for PayMIX entries of PTO taken, 26 – 11
  of PayMIX entries, 8 – 15, 8 – 19 to 8 – 25
DateTrack, 1 – 9, 1 – 10 to 1 – 19
  changing datetracked information, 1 – 14 to 1 – 15
  Date Security user profile option, 1 – 11
  deleting datetracked information, 1 – 15
  Reminder user profile option, 1 – 12
DateTrack History, 1 – 13
DateTrack:Date Security, 29 – 6
DateTrack:Reminder, 29 – 6
Deductions
  batch entry for, 8 – 17 to 8 – 18
  classifications for, 7 – 11
  frequency rules for, 7 – 23 to 7 – 25
Deductions taken against a particular earnings, PayMIX entry to control, 8 – 14, 8 – 18
Deductions, pre–tax. See Pre–tax deductions
Define Rate form, modes, 31 – 20
Defining a health care plan element
  entry of processing information, 10 – 9 to 10 – 11
  ER and EE contributions, 10 – 10
  identifying the benefit carrier, 10 – 10
  prerequisites and steps for, 10 – 8 to 10 – 13
  setting up input values for, 10 – 10
  termination rule for, 10 – 10
Defining an element to hold information
  input value validation, 7 – 32
  processing rules, 7 – 33 to 7 – 35
  termination rule selection, 7 – 33
Dependents
  benefits coverage for, 10 – 3, 10 – 16
  entry of, 13 – 16 to 13 – 20
  stopping coverage for, 10 – 17 to 10 – 22
Descriptive flexfields
  creating database items, B – 6
  defining segments of, 31 – 2 to 31 – 4
  explained, 31 – 2, B – 5
  for address styles, B – 9
  list of user definable, B – 6 to B – 9
  protected, B – 10
Disabilities
  See also ADA reporting
    accommodation requests for, 17 – 31 to 17 – 32
    recording types of, 17 – 31
    registration of, 17 – 31
Disability leave, 28 – 7
Distributed costing
  example of, 11 – 19 to 11 – 26
  for employer charges, as overhead, 11 – 8 to
  11 – 10
Distribution set, for distributed costing, 11 – 8
Distribution sets, 31 – 5

E
Earnings and deductions, initiation and generation of, 7 – 5
Earnings types
  batch entry for, 8 – 17 to 8 – 18
  classifications and categories for, 7 – 10
  Regular Salary, 9 – 2 to 9 – 6
  Regular Wages, 9 – 2
Education leave, 28 – 7
EEO job categories, 17 – 3 to 17 – 5
EEO–1 reporting
  ethnic categories for, 17 – 3
  job categories for, 17 – 3
  overview of, 17 – 2 to 17 – 4
  setup steps for, 17 – 5
Effective dates, 1 – 9, 1 – 11
Element categories. See Categories of elements

Element classifications
  and processing priorities, 7 – 14 to 7 – 16
  for earnings types, 7 – 10
  for employer liabilities, 7 – 12
  for non–payroll payments, 7 – 11
  for non–tax deductions, 7 – 11
  for PTO accruals, 7 – 11
  for tangible items, 7 – 13
  for taxes, 7 – 12
  Information, 7 – 13
  table of, 7 – 8 to 7 – 11
Element definition, 7 – 4 to 7 – 6
  See also Element generation

Element entries
  automatic, using standard links, 7 – 27
  batch entry using BEE or PayMIX, 7 – 29 to 7 – 31
  for eligible employees, 7 – 27
  indirect formula results for, 7 – 29
  manual, for individual employees, 7 – 27, 7 – 41 to 7 – 43
  reviewing, 7 – 44
  standard links for automatic, 7 – 27
  supplying end dates for, 7 – 27, 10 – 3
  using salary administration, 7 – 27
  viewing a history of, 7 – 44
  viewing list of employees with, 7 – 45
Element generation by Oracle Payroll, initiation of, 7 – 5

Element links
  See also Links
  and eligibility rules, 7 – 25 to 7 – 27
  components of, 7 – 25
  costing information on, 11 – 7 to 11 – 8
  defining, 7 – 37 to 7 – 40
  report for reviewing, 7 – 39 to 7 – 40
Element processing priority, default values for, 7 – 14

Element sets, 31 – 5

Elements
  See also Element links, element entries
  batch entry of, 8 – 2
  classifications and categories of, 7 – 3, 7 – 8 to 7 – 15
  costing information for, 11 – 7 to 11 – 9
  creation of, 7 – 4
  database items, C – 19
  defining, for absence types, 26 – 9 to 26 – 11
  defining, for health care plans, 10 – 8
  defining, to hold information, 7 – 32 to 7 – 35
  eligibility rules for, 7 – 25 to 7 – 27
  entry of, 7 – 7
  formulas for, 7 – 4, 7 – 21 to 7 – 23
  generated, for PTO accrual plans, 26 – 19 to 26 – 20
  included in Oracle HRMS, 7 – 5
  input values of, 7 – 3, 7 – 16 to 7 – 20
  linking of, 7 – 6, 7 – 37 to 7 – 40
  manual entry of, 7 – 41 to 7 – 43
  nonrecurring, 5 – 2
  Oracle HR uses for, 7 – 2
  Oracle Payroll uses for, 7 – 2 to 7 – 4
  processing types of, 7 – 4, 7 – 23 to 7 – 25

Eligibility rules
  and element links, 7 – 6
  criteria used in, 7 – 25 to 7 – 27
  Email ID information, entry of, 13 – 6
  EMP_ASSIGN_REASON, 14 – 12
  EMP_EVENT_TYPE, 27 – 2
  EMP_INTERVIEW_TYPE, 27 – 4
  Employee assignment number, 14 – 10
  Employee assignment statuses, 28 – 5 to 28 – 6
  and payroll processing, 28 – 5
  element entries valid for, 28 – 5
  reporting on, 14 – 33
  secondary statuses, 28 – 6

Employee assignments
  allocation of costs for, 14 – 6
  and work structures, 14 – 4 to 14 – 19
  changes to, and DateTrack, 14 – 14
  components of, 14 – 5
  defining as primary, 14 – 12
  definition, 14 – 4
  ending all, 14 – 17 to 14 – 18
ending one of multiple, 14 – 16
entering, 14 – 9 to 14 – 13
history, 14 – 36
inquiring and reporting on, 14 – 26 to 14 – 36
manager–level, 14 – 12
numbers for, 14 – 7
payment methods for, 14 – 22 to 14 – 24
placing in GREs, 14 – 10
position based, 6 – 6
primary assignments, 14 – 6
project based, 6 – 2 to 6 – 6
using multiple assignments, 14 – 6
Employee groups, 5 – 10
People Group flexfield for, 2 – 5
Employee Increment Results Report, 4 – 19
Employee lists
by absence type, 26 – 17
by assignment components, 14 – 26
by assignment statuses, 14 – 33
by organization, 14 – 29
by personal information, 13 – 3
by position, 14 – 31
by position hierarchy, 14 – 32
by special information type, 13 – 28
Employee numbers, 13 – 5, 14 – 7
Employee Organization Movements Report, 14 – 34
Employee Payroll Movements Report, 14 – 34
Employee statuses, formulas for different, 7 – 22
Employee Summary Report, 14 – 34
Employer
charges, distribution of, 11 – 8
liabilities, classification for, 7 – 12
taxes, classification for, 7 – 12
Employment
hiring, 13 – 10
history, 14 – 36
Employment categories
adding new, 14 – 5
assigning employees to, 14 – 10
full time and part time, 14 – 5
in startup data, 14 – 5
Employment information
making changes to, 14 – 3
table of, 14 – 2
End assignment status, 14 – 16, 28 – 5
End Dates, removing, 1 – 16
Enterprise competencies, Career Management, 18 – 10
Entries. See Element entries
Essential, competencies, 20 – 4
Establishment hierarchies
and Reporting Establishments, 16 – 4
example of, 16 – 5, 16 – 6, 16 – 8
for AAP reports, 16 – 6, 16 – 22
for headquarters organizations, 16 – 10 to 16 – 15
for multi–establishment GREs, 16 – 7 to 16 – 10
for single–establishment GREs, 16 – 6
rule for, 16 – 6
setup of, 16 – 21 to 16 – 23
varieties of, 16 – 6
Establishments
See also Reporting organizations
for government reporting, 16 – 3 to 16 – 4
for OSHA reports, 16 – 3, 17 – 35
Ethnic origin
categories for, 17 – 3
detail of, 13 – 6
EVAL_SYSTEM, 3 – 14
EVAL_SYSTEM_MEAS, 3 – 14
Evaluation systems, 3 – 14
Event management, 15 – 18, 27 – 2
External organizations, 2 – 14, 2 – 17
classifications for, 2 – 23
defining, 2 – 20
F
Fiscal year, balances for, 2 – 27
Folders, 30 – 3 to 30 – 8
FORM_MODE, 31 – 21
Formulas
and employee statuses, 7 – 22
and Oracle FastFormula, 7 – 21
conditional logic in, 7 – 21 to 7 – 23
for element processing, 7 – 21 to 7 – 23
for payroll calculations, 7 – 21
for tax calculations, 7 – 22
for validation, 28 – 4
in payroll startup data, 7 – 22
indirect results and element entry, 7 – 29
processing rules for, 7 – 22
result rules for, 7 – 22
Free text information, 25 – 4
FREQUENCY, 2 – 29
Frequency rules, for recurring deductions, 7 – 23
Full Applicant Details Report, 15 – 10
Full Personal Details Report Set, 13 – 31
Further name information, 13 – 9

G
Gender information, entry of, 13 – 5
General ledger. See GL codes
Generate Secure User process, 34 – 15
Generated elements, pay values of, 7 – 19 to 7 – 21
Generating letters, batch processing, 33 – 12 to 33 – 15
GL codes
costs transfer to Oracle GL, 11 – 24 to 11 – 26
example of cost allocation to, 11 – 18 to 11 – 19
for federal taxes, 11 – 15
for state and local taxes, 11 – 15 to 11 – 17
in the Cost Allocation flexfield, 11 – 2 to 11 – 6
Government Reporting Entities. See GREs
Government–mandated HR reports
overview of, 16 – 2
preparations for, 16 – 12
Reporting Categories and Statuses for, 16 – 3
reporting organizations for, 16 – 3
Grade Name key flexfield, 2 – 4, 4 – 2, B – 3
Grade rates, 4 – 8 to 4 – 10
for salary proposal validation, 9 – 7
Grade scales, 4 – 12
Grade steps, 4 – 15
incrementing placements, 4 – 18
placing employees on, 4 – 16
Grades, 4 – 2 to 4 – 5
assigning an employee to, 14 – 10
comparatio values, 4 – 10
defining, 4 – 4 to 4 – 6
relating to progression points, 4 – 15
valid grades for jobs and positions, 3 – 16, 4 – 3
Grant Permissions To Roles process, 34 – 15
Graphics, 13 – 16
GREs
additional information for, 2 – 25
and common paymasters, 2 – 9
and Legal Entities, 2 – 9
and tax groups, 2 – 12
defining, 2 – 20, 2 – 23
functions of, 2 – 9
identification number for, 2 – 9, 2 – 30
NACHA information for, 5 – 5
placing employee assignments in, 14 – 10
Group Term Life premiums, predefined table for, 32 – 11
Grouping competencies, 19 – 14

H
Headcount, 12 – 2 to 12 – 11, 15 – 4
Health and safety requirements, for jobs or positions, 3 – 6
Hiring people, 13 – 10, 15 – 19
New Hire reports, 13 – 32 to 13 – 36
History, of assignments, 14 – 36
Honors, entry of, 13 – 9
Hot defaults
consequences of overriding, 7 – 35, 7 – 43, 10 – 11
for automatic updating, 7 – 35, 10 – 11
Hours of work, 14 – 12
entering defaults for, 2 – 8, 2 – 28 to 2 – 29
work schedules for, 2 – 31 to 2 – 33
HR Organizations
additional information for, 2 – 25
classification for, 2 – 20
HR User, profile option, 10 – 9
HR User Type, 33 – 3
HR: Business Group, 29 – 5
HR: Query Only Mode, 29 – 5
HR: Security Profile, 29 – 5
HR: Use Standard Attachments, 29 – 5
HR: User Type, 29 – 5
HR_CUSTOMIZATION, 31 – 20

Human resource management
- budgeting, 12 – 2 to 12 – 11
- career planning, 23 – 2 to 23 – 10
- cycle of functions, 1 – 4
- employee reviews, 27 – 4 to 27 – 7
- evaluating jobs and positions, 3 – 14 to 3 – 17
- integrating with payroll management, 1 – 3
- salary administration and performance reviews, 9 – 2 to 9 – 15

I
I–9 information, 13 – 7
- entry of, 13 – 6
- Identifying your business goals, competence approach, 18 – 9
- Implementation of HRMS
  - in hybrid enterprise structures, 6 – 10 to 6 – 12
  - in project based enterprises, 6 – 2 to 6 – 6
  - in rule based enterprises, 6 – 6 to 6 – 13
- Increment Progression Points process, 4 – 18
- Indirect results, costing elements with entries of, 11 – 7 to 11 – 9
- Information infrastructure, 18 – 3
- Input value entries
  - element level defaults for, 7 – 17
  - hot defaults for, 7 – 35, 7 – 43, 10 – 11
  - link level defaults for, 7 – 18, 7 – 26
  - units of measure for, 7 – 16
  - validation for, 7 – 16 to 7 – 18
- Input values
  - and formula inputs, 7 – 21
  - default entries for, 7 – 17 to 7 – 19
  - establishing, for Information elements, 7 – 34
- Inquiry windows, list of, 30 – 3
- Insurance carriers, defining, 2 – 22
- International relocation, employee preferences, 13 – 21
- Interviews
  - with applicants, 15 – 17
  - with employees, 27 – 4

J
J–9 information, 13 – 7
- entry of, 13 – 6
- Identifying your business goals, competence approach, 18 – 9
- Implementation of HRMS
  - in hybrid enterprise structures, 6 – 10 to 6 – 12
  - in project based enterprises, 6 – 2 to 6 – 6
  - in rule based enterprises, 6 – 6 to 6 – 13
- Increment Progression Points process, 4 – 18
- Indirect results, costing elements with entries of, 11 – 7 to 11 – 9
- Information infrastructure, 18 – 3
- Input value entries
  - element level defaults for, 7 – 17
  - hot defaults for, 7 – 35, 7 – 43, 10 – 11
  - link level defaults for, 7 – 18, 7 – 26
  - units of measure for, 7 – 16
  - validation for, 7 – 16 to 7 – 18
- Input values
  - and formula inputs, 7 – 21
  - default entries for, 7 – 17 to 7 – 19
  - establishing, for Information elements, 7 – 34
- Inquiry windows, list of, 30 – 3
- Insurance carriers, defining, 2 – 22

K
Key flexfields, 1 – 17
- Bank Details, B – 11
- Cost Allocation, 11 – 2 to 11 – 10
- creating database items, B – 4
- for country-specific information, B – 10 to B – 12
- Grade Name, 4 – 2
- in Oracle HRMS, 2 – 4 to 2 – 6
- Job Name, 3 – 5
- People Group, 5 – 10
- Personal Analysis, 2 – 5 to 2 – 6, 28 – 10
- Position Name, 3 – 5
- protected, B – 10
- setting up, B – 3
- Soft Coded Legislation, B – 11
- uses of, B – 2
L

Labor costs
See also Costing information
and the Cost Allocation flexfield, 11 – 2
example allocation of, 11 – 18 to 11 – 19
Leadership competencies, creating, 20 – 2
Legal entities. See GREs
Legislation Code, 2 – 27
Length of service bands
for PTO accrual plans, 26 – 21
setup of, 26 – 26 to 26 – 27
Letter
COBRA Expiration, 10 – 32
COBRA Grace Period Expiration, 10 – 32
COBRA Notification, 10 – 32
Letter generation, 33 – 9 to 33 – 13
Letters
 generating, batch processing, 33 – 12 to 33 – 15
setting up, 33 – 10
Link definition, 7 – 37 to 7 – 40
entering costing information, 7 – 38
entering qualifying conditions, 7 – 39
link level input value changes, 7 – 39
Links
See also Element links
components of, 7 – 25
for employee eligibility rules, 7 – 25
tax deductions, 7 – 25
reviewing, for an element, 7 – 39 to 7 – 40
rule for building, 7 – 25
standard, for automatic entry, 7 – 27
LISTGEN, 34 – 15
Location, entering for an office, 13 – 9
Locations, 2 – 2 to 2 – 3
assigning an employee to, 14 – 9
Lookups, 32 – 2

Managing change, 1 – 9
Manual element entries, completion of, 7 – 41
to 7 – 43
Marital Status information, completion of, 13 – 41
Mass Move, 3 – 25
deleting, 3 – 35
describing, 3 – 28
executing, 3 – 33
making decisions for, 3 – 26
managing your collection of, 3 – 35
preparing for, 3 – 26 to 3 – 28
prerequisites for, 3 – 26 to 3 – 28
reexecuting, 3 – 34
reviewing the results of, 3 – 34
status of, 3 – 34
summary of tasks, 3 – 28
Maternity leave, 28 – 7
Matrix management, hierarchies for, 2 – 35
Medical information, 13 – 9, 13 – 26, 28 – 10
Menu Structures Report, 31 – 18
Menus
default menu paths, A – 1
defining, 31 – 17 to 31 – 22
for security, 34 – 2, 34 – 8
query–only access, 31 – 19
Methods of measurement
overview, Career Management, 18 – 11
setting up Career Management, 19 – 3
Microsoft Word, 33 – 9 to 33 – 13
Military leave, 28 – 7
MIX facilities, for batch element entry, 8 – 2
Multiple Worksite reporting
filing information for, 2 – 26
GRE transmitter for, 2 – 26

N

NACHA
personal payment methods using, 14 – 22 to
14 – 24
prenote information for, 14 – 23
Name, entry of additional name information
for an employee, 13 – 9
Net Accrual Calculation, 26 – 27 to 26 – 28
New hire reporting, 13 – 32
  employee information for, 13 – 34 to 13 – 35
  GRE contact for, 13 – 33 to 13 – 34
  obtaining, 13 – 35 to 13 – 37
  setup steps for, 13 – 33
Nonrecurring elements, 5 – 2
  See also Processing type
  PayMIX for entries to, 8 – 17

O
Offer assignment status, 15 – 15
Office location, entry of, 13 – 8
Office number, entry of, 13 – 8, 13 – 9
Oracle FastFormula. See Formulas
Oracle Human Resources
  using with Oracle Payroll, 33 – 2 to 33 – 5
  using with spreadsheets, 33 – 5
ORACLE IDs, 34 – 11
Oracle Payroll, 33 – 2
ORG_TYPE, 2 – 14
Organization hierarchies, 2 – 34 to 2 – 41
  adding to, 2 – 31, 16 – 19 to 16 – 23
  creating, 2 – 37 to 2 – 41
  for matrix management, 2 – 35
  in security profiles, 34 – 5
  versions of, 2 – 36
Organization Hierarchy Report, 2 – 39
Organizations, 2 – 14 to 2 – 17
  adding to hierarchies, 2 – 25, 2 – 26, 2 – 31, 16 – 19 to 16 – 23
  additional information for, 2 – 24
  assigning an employee to, 14 – 9
  classifications for, 2 – 20, 2 – 23
  cost centers for, 2 – 16
  defining, 2 – 20 to 2 – 24
  deleting, 2 – 33
  entering site addresses for, 2 – 2
  external, 2 – 17, 2 – 20
  in project based enterprises, 6 – 3
  levels of internal, 2 – 14 to 2 – 16
  listing employees assigned to, 14 – 29
  used with position control, 3 – 4
OSHA
  Form 101 Report, 17 – 38
  Form 200 Report, 17 – 38
OSHA reporting
  establishments for, 17 – 35
  for fatalities, 17 – 37
  information for, 13 – 26, 17 – 34 to 17 – 36
  overview of, 17 – 34
  setup steps for, 17 – 36
OTA
  competencies, 18 – 14
  SQL*Plus script, D – 8 to D – 11
Other information, entering for an employee, 13 – 9
Overhead labor costs, distribution of, 11 – 19 to 11 – 25

P
Parent organizations, 2 – 31, 16 – 19 to 16 – 23
Part time assignments, 12 – 2
Part time employment category, 14 – 6
Paternity leave, 28 – 7
Pay periods, selecting, 5 – 7
Pay scales, 4 – 12
  defining, 4 – 13
  defining rates for, 4 – 14
Pay values
  and generated elements, 7 – 20
  enterable and non-enterable, 7 – 19 to 7 – 21
  purpose of, 7 – 19
  setup of, 7 – 35
  to hold run results, 7 – 19
Payee organization, defining, 2 – 23
Payment methods
  for a payroll, 5 – 8
  for employee assignments, 14 – 22 to 14 – 24
  for the enterprise, 5 – 3
PayMIX
  batch line dates, 8 – 19 to 8 – 21
  customizing segment names for, 2 – 8
  for batch element entry, 8 – 2
  for earnings and deductions entries, 8 – 17 to 8 – 18
  for entry of accrued time taken, 26 – 31
for payroll batch entry, 8 – 12 to 8 – 13
procedures for, 8 – 23 to 8 – 30
process for validation and transfer, 8 – 29 to
8 – 32
process review and correction, 8 – 31
routing to input values, 8 – 17 to 8 – 19
statuses for, 8 – 21
Payroll code number, 14 – 7
Payroll costs. See Costing information
Payroll formulas
See also Formulas
for element processing, 7 – 21 to 7 – 22
Payroll management, 1 – 3
cycle of functions, 1 – 4
Payroll runs, employee setup for, 14 – 5
Payroll tables, row types for, 32 – 11
Payrolls
assigning employees to, 14 – 9
check date, 5 – 7
cut off date, 5 – 7
defining, 5 – 6 to 5 – 11
deleting, 5 – 9
in security profiles, 34 – 7
scheduled run date, 5 – 7
using in HRMS, 5 – 2
Pension groups, 5 – 10
People folders, 13 – 3
People Group key flexfield, 2 – 5, B – 3
setting up, 5 – 10
to represent companies, 2 – 15 to 2 – 17, 5
– 10
People groups, assigning employees to, 14 – 10
Performance ratings, 27 – 5
Performance reviews, and salary proposals, 9 – 9 to 9 – 11
PERFORMANCE_RATING, 27 – 5
Period of service, 14 – 36
Person Details Report, 13 – 31
Person types, 28 – 2 to 28 – 4
Personal Analysis key flexfield, 2 – 5, 28 – 10, B – 4
Personal information
deleting, 13 – 37
entering, 13 – 4
entering special information, 13 – 26
entering unstructured information, 25 – 4
I-9, veteran, ethnic origin, 13 – 6
inquiring and reporting on, 13 – 3, 13 – 31
office location, mailstop, 13 – 8
tracking roles and activities, 13 – 30
Personal payment methods, NACHA or pay-
check, 14 – 22
PERWPOUK, SQL*Plus script, D – 2 to D – 5
PERWPWUk, SQL*Plus script, D – 6 to D – 9
Physician’s name, entry of, 13 – 9
Pictures, 13 – 16
PLACEMENT_REASON, 4 – 17
Planning succession, 23 – 2
Position hierarchies, 3 – 3
adding a new position, 3 – 12
creating, 3 – 21 to 3 – 36
creating new versions, 3 – 22
in security profiles, 34 – 6
Position Hierarchy Report, 3 – 24
Position Name key flexfield, 2 – 4, 3 – 5, B – 3
Positions
assigning an employee to, 14 – 10
contrasted with jobs, 3 – 2
defining, 3 – 11 to 3 – 14
entering valid grades, 3 – 16
evaluating, 3 – 14
in rule based enterprises, 6 – 6
listing employees assigned to, 14 – 31
representing jobs and positions, 3 – 2 to 3 – 7
salary budgets, 9 – 16, 12 – 5
skill requirements of, 3 – 17
source, 3 – 29
target, 3 – 30
viewing budget variance, 12 – 9
viewing occupancy, 3 – 20
work choices, 3 – 18
Pre–tax deductions, classification and catego-
ries for, 7 – 11
Predefined user tables, 32 – 11
Company Work Schedules, 32 – 11
GTL Premiums, 32 – 11
Shift Differentials, 32 – 12
Wage Rates, 32 – 12
Prefix information, entry of, 13 – 5
Prenote information, for NACHA payments, 14 – 23
Primary applicant assignment statuses, 15 – 16
Primary assignment statuses, for employees, 14 – 6 to 14 – 7, 28 – 5
Primary element classifications, 7 – 8 to 7 – 15
Primary reporting hierarchy, 2 – 34
Probation period, 3 – 11, 3 – 12
entering on assignments, 14 – 12
Processes
Costing, 11 – 22 to 11 – 24
Create Descriptive Flexfield DB Items, B – 6, C – 23
Create Key Flexfield DB Items, B – 4, C – 25
Generate Secure User, 34 – 15
Grant Permissions To Roles, 34 – 15
PayMIX Batch, 8 – 29
PTO Carry Over, 26 – 22, 26 – 31
Security List Maintenance, 34 – 15
Transfer to GL, 11 – 24 to 11 – 26
Processing type
of elements, 7 – 4
recurring and nonrecurring, 7 – 4, 7 – 23
Proficiency levels, competencies, 19 – 2
Progression points
defining, 4 – 13
entering special ceiling for, 14 – 12
relating to grades, 4 – 15
Project based enterprises, 6 – 2 to 6 – 6
Promotions, recording information about, 14 – 4 to 14 – 6, 14 – 14
PROPOSAL_REASON, 9 – 5
Proration of pay, work schedules for, 14 – 11
PTO (paid time off)
calculation of net accrued, 26 – 28
carry over process for, 26 – 31 to 26 – 35
manual or batch entry of time taken, 26 – 30 to 26 – 31
residual and carried over, 26 – 22
review of net time accrued, 26 – 33 to 26 – 35
sale or purchase of, 26 – 23, 26 – 31
PTO accrual plans
elements for, 26 – 19 to 26 – 20
enrollment in, 26 – 30
length of service factors, 26 – 21 to 26 – 24
maintenance of, 26 – 30
operation and structure of, 26 – 19 to 26 – 23
period of eligibility under, 26 – 20
setup steps for, 26 – 24 to 26 – 29
start rule options for, 26 – 20 to 26 – 21
Public sector, implementation in, 6 – 6 to 6 – 13, 9 – 16, 12 – 5
Purge, 1 – 15

Q
Qualifications, 13 – 19
Qualifiers, for the Cost Allocation key flexfield,
11 – 11 to 11 – 13
Qualifying conditions, failure to meet, 7 – 42
QUALIFYING_UNITS, 3 – 11
Query–only access to windows, 31 – 19
QuickCodes
access levels, 32 – 2
creating QuickCode values, 32 – 3
defining QuickCode types, 32 – 5
list of predefined types, 32 – 6 to 32 – 8
removing QuickCode values, 32 – 3
QuickPaint reports, 30 – 8
customizing, 30 – 13
defining, 30 – 9 to 30 – 11
running, 30 – 12 to 30 – 13

R
Rate codes, PayMIX entries for, 8 – 14 to 8 – 17
Rates
for grades, 4 – 8
for pay scales, 4 – 14
PayMIX entries for, 8 – 14
Rating scales, creating, 19 – 7
Re–hiring an employee, 13 – 10
REC_TYPE, 15 – 8
Recruitment
entering applicants, 15 – 10
identifying vacancies, 15 – 4
recruitment cycle, 15 – 2 to 15 – 3
running recruitment activities, 15 – 5
tracking applicant progress, 15 – 15

Recurring elements
See also Processing type
PayMIX for changes to, 8 – 17 to 8 – 20

Reference information, for a rehire applicant, 13 – 8
Regular, earnings, 7 – 10
Regular runs, scheduled date of, 5 – 7
Rehire information, 13 – 8
Reimbursements, classification for, 7 – 11
Relief position, to cover absence, 3 – 12
Relocation, employee preferences, 13 – 19
Reorganizing, positions and assignments, 3 – 25

Report
CObRA Coverage, 10 – 32
CObRA Payment, 10 – 32

Reporting Categories and Statuses, 16 – 3
registering, 2 – 8, 2 – 24, 16 – 13 to 16 – 15

Reporting Establishments
See also Reporting Organizations
additional information for, 2 – 26 to 2 – 33
for corporate headquarters, 16 – 17 to 16 – 18
for EEO–1 reporting, 16 – 15 to 16 – 18
for government reports, 16 – 3 to 16 – 4
for VETS–100 reporting, 16 – 16
overrides for, 16 – 5, 16 – 23 to 16 – 25

Reporting lines, 2 – 35, 3 – 3, 3 – 21

Reporting organizations
additional information for, 2 – 26 to 2 – 28
defining, 2 – 23
overview of, 16 – 3 to 16 – 5
setup of, 16 – 15

Reporting users, 34 – 8

Reports
AAP Job Group Analysis, 17 – 20
AAP Workforce Analysis, 17 – 19
Absences, 26 – 18
ADA, 17 – 32 to 17 – 34
Assignment Status, 14 – 33
CObRA Coverage, 10 – 25 to 10 – 27
CObRA Payments, 10 – 26

Cost Breakdown Summary, 11 – 22, 11 – 23
Current and Projected Progression Point Values, 4 – 18
defining, 30 – 6
EEO–1 Consolidated, 17 – 10
EEO–1 Establishment Employment Listing, 17 – 10 to 17 – 12
EEO–1 Headquarters, 17 – 9 to 17 – 11
EEO–1 Individual Establishment, 17 – 9
EEO–1 Single Establishment, 17 – 8
Element Link Details, 7 – 39
Employee Benefit Eligibility Listing, 10 – 15
Employee Benefit Enrollment Register, 10 – 15
Employee Increment Results, 4 – 19
Employee Organization Movements, 14 – 34
Employee Payroll Movements, 14 – 34
Employee Summary, 14 – 34
Full Applicant Details, 15 – 10
Full Personal Details, 13 – 31
list of, 30 – 5 to 30 – 7
Menu Structure, 31 – 18
New Hire, 13 – 32 to 13 – 36
Organization Hierarchy, 2 – 39
OSHA No. 200 and No. 101, 17 – 38
Position Hierarchy, 3 – 24
QuickPaint, 30 – 9 to 30 – 17
Requisition Summary, 15 – 22
Salary Review, 9 – 15, 12 – 4
security of, 34 – 9
Skills Matching, 25 – 5
Staffing Budget Details, 12 – 11
Terminations, 14 – 19
Vets–100 Consolidated, 17 – 27
VETS–100 Veterans Employment, 17 – 25 to 17 – 27

Requirements, comparing with accomplishments, competence approach, 20 – 3
Requisition Summary Report, 15 – 22
Requisitions, 15 – 7
Responsibilities, 31 – 17, 34 – 2
defining, 34 – 11
Restricting access to records
by menu structures, 31 – 17, 34 – 8
by organization hierarchy, 34 – 5
by payroll, 34 – 7
by position hierarchy, 34 – 6
by Responsibilities, 34 – 2 to 34 – 4
by security profiles, 34 – 4
from other tools, 34 – 8

Resumes, 25 – 4
entry of status information on, 13 – 8

Reviews
of salaries, 14 – 12
ROLGEN, 34 – 15

Rule based enterprises, 6 – 6 to 6 – 13
budgeting, 9 – 16, 12 – 5
Run results, and Oracle FastFormula, 7 – 21 to 7 – 27

Salary
relating to grades, 4 – 3
reporting on, 9 – 15, 12 – 4
ways to review, 9 – 2 to 9 – 4

Salary administration
for element entry, 7 – 27
for entry of salaries and wage rates, 9 – 2 to 9 – 15
setup of, 9 – 4 to 9 – 6

Salary bases, 9 – 5

Salary basis
assigning an employee to, 14 – 12
definition of, 9 – 6 to 9 – 7
for salary administration, 9 – 2

Salary budgets, 9 – 16 to 9 – 17, 12 – 5 to 12 – 11

Salary proposals, 9 – 2
approving, 9 – 11
correcting, 9 – 13
entry of, 9 – 8 to 9 – 9, 9 – 10 to 9 – 11
grade rates for validation of, 9 – 7

Scale rates, 4 – 14

School attendances, 13 – 19
SECGEN, 34 – 15

Secondary applicant assignment statuses, 15 – 16

Secondary assignment statuses, 28 – 6
adding reasons for, 28 – 6

Secondary statuses
defining, 28 – 7, 28 – 8
entering for employees or applicants, 14 – 24

Security, 34 – 2 to 34 – 9
creating Oracle IDs, 34 – 11
enabling currencies, 29 – 7
list of user profile options, 29 – 5 to 29 – 8
of reports and processes, 34 – 3, 34 – 9
restrictions by HR:User Type, 33 – 4
setting up, 34 – 10 to 34 – 12
setting user profile options, 29 – 4

Security groups, 34 – 3, 34 – 9

Security List Maintenance process, 34 – 15

Security profiles, 34 – 2, 34 – 4 to 34 – 7
defining, 34 – 13 to 34 – 15

Separate check payments, PayMIX entry for, 8 – 14 to 8 – 17, 8 – 18 to 8 – 25

Setting up
appraisals, 18 – 12
assessments, 18 – 12
standard letters, 33 – 10

Setting up Career Management
competencies and OTA, 21 – 2
methods of measurement, 19 – 3
suitability searching, 24 – 2

Shift differentials
PayMIX entry for, 8 – 14 to 8 – 17
predefined table for, 32 – 12

Shift worked, entry of regular, 14 – 11

Skills information, 13 – 26, 25 – 2
Skills matching, 15 – 5, 25 – 2 to 25 – 3
Skills Matching Report, 25 – 5

Social security number, as employee number, 14 – 7

Soft coded legislation, B – 11

Source positions, identifying, 3 – 29
Special ceiling points, 14 – 12

Special information types
enabling, 28 – 11
entering, 13 – 26
for ADA and OSHA reporting, 13 – 26
for disability information, 17 – 31
for OSHA-reportable incidents, 17 – 36 to 17 – 37
setting up, 25 – 2, 28 – 10 to 28 – 12
Special inputs elements, PayMIX entries for, 8 – 17 to 8 – 25
Spreadsheets, 9 – 17, 33 – 5
SQL*Plus script
OTA – for confirmation letters, D – 8 to D – 11
PERWPOUK, D – 2 to D – 5
PERWPWUK, D – 6 to D – 9
Staffing Budget Details Report, 12 – 11
Staffing budgets, 12 – 2 to 12 – 11, 15 – 4
Standard element links
See also Automatic element entry
examples of, 7 – 28 to 7 – 30
Standard letters, 33 – 9
Standard work day, 14 – 12
Status, of assignments, 28 – 5
Statuses, for letter generation, 33 – 9
Structuring competencies, general method, 19 – 5
Structuring your competencies, 19 – 4
individual method, 19 – 4
which method to use, 19 – 6
Subsidiaries, as Business Groups, 2 – 7
Succession planning, 3 – 12, 18 – 14, 23 – 2, 23 – 6
Suffix information, entry of, 13 – 5
Suitability searching
overview, 18 – 13
setting up Career Management, 24 – 2
Supervisor, entering on assignments, 14 – 11
Supplemental, earnings, 7 – 10
Suspected assignment status, 28 – 5
Suspense account, 11 – 6 to 11 – 7
System administrator, role of in OHR, 29 – 2

T
Tables, user-defined, 32 – 10
accessing values in, 32 – 10
entering values into, 32 – 17
payroll tables for deduction amounts, 32 – 11
setting up, 32 – 14 to 32 – 16
Target positions, identifying, 3 – 30 to 3 – 32
Task flows, 31 – 9 to 31 – 16
adding to a menu, 31 – 20
defining nodes, 31 – 12
Tax deductions
and Vertex Inc., 7 – 12
classifications and categories for, 7 – 12 to 7 – 14
links and entries for, 7 – 25
Taxes
costing, by jurisdiction, 11 – 15
costing, by tax type, 11 – 15
element classifications for, 7 – 12
federal, state and local, 7 – 12
maintaining information for, 2 – 9, 2 – 25
Template
PERWPOUK, D – 2 to D – 5
PERWPWUK, D – 6 to D – 9
Temporary cover, 3 – 12
TERM_APL_REASON, 15 – 21
Terminate application assignment status, 15 – 16, 15 – 21
Terminate assignment status, 14 – 16, 28 – 5
Terminating applicants, 15 – 21
cancelling a termination, 15 – 22
Terminating employees
adding to reasons for, 14 – 17
cancelling a termination, 14 – 18
procedure for, 14 – 17 to 14 – 18
processing pay after, 28 – 8
reporting on, 14 – 19 to 14 – 21
Termination, of employees, 14 – 17 to 14 – 18
Termination dates, 14 – 18
Termination rules, selection of, 10 – 10
Terminations Report, 14 – 19
Third party payments
defining a personal payment method, 14 – 24
payee organizations for, 2 – 23
Time Entry Wages element, for PayMIX time-card entry, 8 – 14
Timecard, entry of requirement for, 14 – 11
Timecards, using PayMIX to enter, 8 – 14 to 8 – 15
Title information, entry of, 13 – 5
Total Owed input value. See Total Reached stop rule
Training information, 13–26, 27–2 to 27–3
Transfers or relocations, recording information on, 14–4 to 14–6, 14–14
Turnover, reporting on, 14–34 to 14–35

**U**
- Union membership, 5–10
- Union pay scales, 4–12
- University attendances, 13–19
- User profile options, 33–4, 34–3, 34–11
- User statuses
  - defining, 28–7
  - for applicant assignments, 15–15
  - for employee assignments, 28–7
  - renaming, 28–7
- User tables, 32–10 to 32–11
  - See also Predefined user tables
- User type profile options, HR User, 10–9
- User–initiated deductions. See Deductions
- Users, creating, 34–11

**V**
- Vacancies
  - creating, 15–7
  - entering applications, 15–13
  - reporting on, 15–22
  - viewing, 15–9
- VACANCY_STATUS, 15–7
- Valid grades, 3–16
- Vertex Inc., tax calculations from, 7–12
- Veteran status, entry of, 13–7
- VETS–100 reporting
  - data for, 17–21 to 17–23
  - identifying employees for, 13–7
  - overview of, 17–21
  - setup steps for, 17–23
- Views, list of, 30–3
- Visa information, entry of, 13–7

**W**
- Wage rates, predefined table for, 32–12
- Web access, 24–2
  - career management, 18–4
- Web interface, configurable, Career Management, 18–7
- Windows
  - Absence Attendance Type, 26–11
  - Absence Detail, 26–14
  - Accrual Bands, 26–26
  - Accrual Plan, 26–24
  - Accruals, 26–33 to 26–35
  - ADA Disabilities, 17–31
  - Address (for Oracle Payroll), 13–13
  - Address (generic), 13–11
  - Alter Effective Date, 1–11
  - Applicant Entry, 15–11
  - Applicant Interview, 15–17
  - Application, 15–12
  - Appraisal Template, 22–31
  - Assignment, 14–9
  - Assignment Budget Values, 12–2
  - Assignment Criteria, 30–15
  - Assignment History, 14–36
  - Assignment Set, 30–14
  - Assignment Statuses, 28–7
  - Assignments Folder, 14–26
  - Batch Entry Default Values, 8–25
  - Batch Header, 8–4
  - Batch Lines, 8–4
  - Beneficiaries, 10–20
  - Book Events, 15–18, 27–3
  - Budget, 12–8
  - Budgetary Calendar, 12–7
  - Bulk Status Change, 15–16
  - Career Path Name, 17–17, 23–5, 23–7, 23–8
  - COBRA Benefits, 10–30
  - COBRA Coverage, 10–27
  - COBRA Payments, 10–32
  - COBRA Statuses, 10–30
  - Columns, 32–15
  - Competence Profile, 13–20
Competence Requirements (Core or Generic), 20 – 5
Competence Requirements (No Core or Generic), 20 – 8
Competence Types, 19 – 17
Competencies, 19 – 11
Costing, 11 – 22
Costing Breakdown, 11 – 22
Covered Dependents, 10 – 16
DateTrack History Change Field Summary, 1 – 13
Deductions Entry, 8 – 28
default navigation paths, A – 10
Define Task Flow, 31 – 14
Define Task Flow Nodes, 31 – 12
Delete Person, 13 – 37
Disability Accommodations, 17 – 32
Earnings Entry, 8 – 27
Element, 7 – 32, 10 – 8
Element and Distribution Set, 31 – 5
Element Entries, 7 – 42
Element Link, 7 – 37
Employee Review, 27 – 4
Entry Values, 7 – 42
Establishment EEO-1 Filing, 16 – 16
Establishments, 21 – 5
Event Bookings, 15 – 18, 27 – 2
Find Competence, 19 – 13
Find Person, 13 – 2
Find Positions, 3 – 29
Form Customization, 31 – 7
Grade Rate, 4 – 9, 31 – 20
Grade Scale, 4 – 15
Grade Step Placement, 4 – 16
Grades, 4 – 4
GREs and Other Data, 16 – 23
Job, 3 – 8
Job Evaluation, 3 – 15
Job Requirements, 3 – 17
Letter, 33 – 17
List Assignments, 14 – 27
List Budget Variance by Organization, 12 – 10
List Employees by Absence Type, 26 – 17
List Employees by Element, 7 – 45
List Employees by Organization, 14 – 29
List Employees by Position, 14 – 31
List Employees by Position Hierarchy, 14 – 32
List People by Assignment, 14 – 28
List People by Special Information, 13 – 28
List Position Budget Variance, 12 – 9
Location, 2 – 3
Map Career Path, 17 – 17, 23 – 8
Mass Move, 3 – 28
Mass Move – Assignments, 3 – 31
Mass Move – Positions, 3 – 30
Mass Move – Valid Grades, 3 – 33
Mass Update of Applicants, 15 – 19
Menu, 31 – 18
Net Calculation Rules, 26 – 27
Organization, 2 – 20
Organization Hierarchy, 2 – 37
Organizational Payment Method, 5 – 3
OSHA–reportable Incident, 17 – 36
Parent Organization, 2 – 31
Pay Scale, 4 – 13
PayMIX Batch Information, 8 – 23
PayMIX Batch Summary, 8 – 31
Payroll, 5 – 7
People, 13 – 5
People Folder, 13 – 3
Period Dates, 5 – 8
Period Types, 12 – 6
Person Types, 28 – 3
Personal Payment Method, 14 – 22
Picture, 13 – 16
Position, 3 – 11
Position Evaluation, 3 – 15
Position Hierarchy, 3 – 21
Position Occupancy, 3 – 20
Position Requirements, 3 – 17
Qualification Types, 21 – 3
Qualifications, 13 – 23
QuickCode Types, 32 – 5
QuickCodes, 32 – 3
QuickPaint Inquiry, 30 – 12
QuickPaint Report, 30 – 9
Rating Scales, 19 – 8
Recruitment Activity, 15 – 8
Request Letter, 33 – 19
Requisition and Vacancy, 15 – 7
Rows, 32 – 15
Salary Administration, 9 – 8, 27 – 5
Salary Basis, 9 – 6
Salary Management Folder, 9 – 11
Scale Rate, 4 – 14, 31 – 20
Schools and Colleges Attended, 13 – 24
Secondary Statuses, 14 – 24
Security Profile, 34 – 13
Special Information, 13 – 26
Special Information Types, 28 – 11
Submit Requests, 30 – 5
Table Structure, 32 – 14
Table Values, 32 – 17
Terminate, 14 – 17
Time Entry, 8 – 26
Valid Grades, 3 – 16
Valid Payment Methods, 5 – 8
View Absence History, 26 – 16
View Element Entry History, 7 – 44
View Employee Dental, Medical and Vision Benefits, 10 – 14
View Employee Grade Comparison, 4 – 10
View Requests, 30 – 5
View Vacancies, 15 – 9
Work Choices (Job or Position), 3 – 18
Work Choices (Person), 13 – 21
Work Day Information, 2 – 28
Work Schedule, 2 – 31
Word processors, 33 – 12
Work choices, 13 – 19
employee preferences, 13 – 21
jobs and positions, 3 – 18
Work day information, 2 – 28, 14 – 12
Work Details Report, 13 – 31
Work schedules, 2 – 31
and pay proration, 9 – 7
employee preferences, 13 – 19
entry for employee assignments, 14 – 11
predefined table for, 32 – 11
selecting for an employee, 13 – 9
Work structures, 1 – 7
and key flexfields, 1 – 17
dates, 1 – 9, 1 – 10
setup examples, 6 – 1 to 6 – 14
Workers Compensation
insurance carriers for, 2 – 23
override code for, 14 – 11
Workflow access, 24 – 2
career management, 18 – 4
WORKFLOW_NAME, 31 – 20
Reader’s Comment Form

Oracle Human Resources North American User’s Guide
A58334–01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this publication. Your input is an important part of the information we use for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most about this manual? What did you like least about it?

If you find any errors or have any other suggestions for improvement, please indicate the topic, chapter, and page number below:

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Please send your comments to:

Oracle Applications Documentation Manager
Oracle Corporation
500 Oracle Parkway
Redwood Shores, CA 94065
Phone: (415) 506–7000     Fax: (415) 506–7200

If you would like a reply, please give your name, address, and telephone number below:

________________________________________________________________________________________

________________________________________________________________________________________

________________________________________________________________________________________

Thank you for helping us improve our documentation.